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Chapter 1

INTRODUCTION

Thank you for purchasing Bar|Scan
®

.  In use since 1988, we believe Bar|Scan to
be one of the most comprehensive bar code enabled asset management system
available for mid tier markets.

By using Bar|Scan, you will save your company many man-hours and thousands
of dollars by just knowing what assets you have and where they are.

Bar|Scan largely automates the process of taking inventory thereby affecting a
large reduction in manpower cost.

By knowing what assets are not currently in use, and where they are located, you
can, many times, satisfy new requirements without having to purchase new assets.

When we talk about assets, we mean everything your company owns or leases,
and all items furnished by your customers or your employees.  This includes
everything from individual personal computers to large machinery, and both
capital assets and noncapital assets.  You can even track consumables or supplies.

Bar|Scan  will produce informative reports for all levels in your organization, from
a list of assets for which an individual is responsible to a list for a department, to
a list encompassing the entire company.  You can produce lists of assets currently
NOT being used so that the need to purchase may be avoided.

Bar|Scan is a complete Asset Management System.  As with any management
information system, before you implement the system, there are:

T  procedures to be established,
T  actions to be taken,
T  information to be disseminated,
T  responsibilities to be assigned,
T  and decisions to be made.

The next chapter in this manual provides a guide to most of these considerations. 
We strongly urge you to read and address the material in Chapter 2 - Suggested
Procedures before you start using Bar|Scan.
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MANUAL ORGANIZATION

This manual is presented in the order in which you will want to use the Bar|Scan
system.  Starting with Chapter 4, you will find the instructions for using the
different features of Bar|Scan.

The following is a list of the Chapters and a brief description of the contents of
each.

Chapter 2 - Suggested Inventory Procedures is a guide to the different
management considerations which should be addressed before the Bar|Scan
system is implemented.

Chapter 3 - Installing Software  tells you about the computer system
requirements and how to install Bar|Scan on your computer(s).

Chapter 4  -  System Overview shows you features of the Main Menu and
provides a brief description of each.

Chapter 5  -  Operating the System  provides instructions about cursor
movement, ways to input change and view data, and the attributes icons and
Function keys used when operating Bar|Scan.

Chapter 6  -  Asset Table provides instructions for entering and maintaining the
asset information.

Chapter 7  -  Catalog Table provides instructions for creating and maintaining
your catalogs.

Chapter 8 - Organization Table provides instructions for creating and
maintaining your organization structure codes and names.

Chapter 9  -  Location Table explains how to create, enter, and maintain your
locations.

Chapter 10  -  Report Table explains how to create, change, save, print, and
preview reports.
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Chapter 11  - Bar|Scan Mobile  provides the instructions for using our
application on your mobile device, including configuring and synchronizing with
the database.

Chapter 12  -  Transaction Table tells you all about the information that came
from your Handheld Computer, and what to do with it. 

Chapter 13  - Housekeeping provides instructions for the Bar|Scan utility
features.

Chapter 14  -  Import and Export provides instructions for using this feature to
record and export asset information to other systems such as an enterprise fixed
asset depreciation system.

Chapter 15  -  Work Order Table explains how to view, change, correct, or add
Work Orders associated with assets currently existing in the Bar|Scan system.

Chapter 16  -  User Defined Fields provides an explanation for the optional User
Definable Field Module, and it’s features.

Chapter 17  -  Multiple Company provides instructions for using the Multiple 
Company version of Bar|Scan that you may have purchased.

Chapter 18  - Bar|Scan SmartClient takes you through the Bar|Scan web
delivered client application that can be used to display and print your assets over
the internet or an intranet.

Chapter 19  -  Training with Demo takes you through the features of Bar|Scan
using a demo database.

Appendices  -  

Appendix A  -  In Case of Trouble provides instructions in case of  
computer hardware or software problems.

Appendix B  -  Imaging provides an explanation for the optional imaging
feature, explains placement of an imaging file. 
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Chapter 2

INTRODUCTION

This chapter presents suggested procedures that you may wish to take into
consideration prior to beginning your first Bar|Scan

®
 inventory. 

If you are inventorying a branch facility, we suggest that you have an on-site room
that can serve as your “control center” during the course of your inventory. 
Optionally, this would be an office or conference room with a telephone and/or
internet access for Bar|Scan support, and a printer.
  
Many things should take place before the physical inventory process can begin.

1. A complete work plan has to be developed.

2. Pre-printed Asset labels (bar code labels) have to be approved, ordered and
received.  In very few cases do we ever recommend that you print your own
labels.

3. Room Tags (optional bar code labels that are physically applied to your
locations) have to be decided upon, approved, ordered if they are being used,
and received.

4. If departmental or cost center information is being gathered during the physical
inventory, you will need a list of all of the departments, divisions, and unit
names in their organization.  This information is used to build out the
Organization table in the Bar|Scan system.  An electronic copy such as Excel
is more useful than a paper copy.

5. The Facilities Department should provide floor plans which clearly designate
the room divisions and the departmental information for each area.  This
information will be used to build out the Location table in Bar|Scan.  An
electronic copy is more useful than a paper copy.

6. If you wish to assign or link assets to personnel then you can identifies the
people which have  possession and/or is responsible for each asset.  You might
not want to link all assets to personnel.  For example, you may wish to only
link laptop computers.  An electronic list provided to you from your Personnel
Department can be imported.
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7. The Bar|Scan database should be prepared with the new Company information. 
Organizations, Personnel and Locations should be entered or imported into the
Bar|Scan system if the information is available.

8. Next, inventory supplies need to be procured, using the Initial Supply Checklist
near the end of this chapter.

9. If possible, an electronic copy of any assets descriptions can be imported to
populate Bar|Scan’s Catalog Table.  However, the descriptions must be
uniform and in sufficient detail to be useful.  Many times, it is better not to
import this information, but to start with a “clean slate”.  This may involve
taking digital pictures to aid in the development of the these descriptions which
we call the Catalogs.

9. Using a Mobile Device Configuration specifically tailored to your needs,
Locations and possibly Organizations, Personnel and Catalogs need to be
synchronized into the Mobile Device for the inventory staff to use during the
physical inventory.

When these things are done, the inventory crew will do a walk through.  Any
additional questions will be discussed during a short walk through of the site, i.e.,
Are there any leased items that should not be Tagged?

If no Catalogs are imported, when the walk through is complete, the inventory
crew(s) should gather their supplies and begin the Catalog process.  During the
Catalog process, the inventory crew members create descriptions for each unique
type of asset on Data Collection Sheets generated by Bar|Scan.

Once or twice a day the inventory crew members should photocopy their Data
Collection Sheets for the Project Manager.  Catalog data will be entered into the
Bar|Scan system from the photocopied Data Collection sheets.  The data will be
checked for inconsistencies.  If digital images are involved, these are matched to
the Catalogs and imported into Bar|Scan.  Then, Catalog Reports with bar codes
representing each Catalog can be printed or synchronized into the Mobile Device
for use during the remainder of the inventory process.

The inventory crew should begin the physical inventory of the Assets.  
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Reports should be printed to audit the accuracy of the inventory work as it is
completed.  All corrections and additions will be made to the data in the Bar|Scan
database.

Reports should be printed for management to review.  Changes to the data should
be made, if any are requested.  Then, final reports of the inventory should be
printed.

DEVELOP A WORK PLAN

For inventories involving more than a few thousand assets or inventory teams of
more than a few people, we recommend developing a Work Plan.

The Work Plan begins by providing an estimated time line, detailing
responsibilities of each party during each phase of the project.

We recommend that you develop a complete work plan detailing the roles and
responsibilities of each party during each phase of your inventory project.  For
larger inventories that may last several weeks, project management (PM) software
such a web based or desktop product may be helpful for this.

Once the project is approved, this work plan should be updated and provided to
Management for approval.  The work plan can then be used to track the progress
of a job (actual vs. projected) for budget purposes and evaluating performance.

The following page is a Sample Work Plan for your review.
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SAMPLE WORK PLAN

Activity JUNE JULY AUGUST

Install Bar|Scan
®

 software, and begin training June 18 �

Complete training June 20      �      

Order Bar Code Labels July 01 �

Project Meeting, finalize scope of work July 09 �

Receive floor plans and Dept. information from Facilities
Department July 13

      �

Receive Bar Code Labels (polyester or foil) July 20    �

Set up Control Center July 21      � 

Catalog assets July 21 - 23     

Inventory assets, and audit collected data 
July 26 - June 13

Provide reports for Management approval June 16  �

Return reports with any comments June 20            �

Make adjustments per Management’s request, if any, and
print final reports June 21 - 23

       

Train end users at your facility or via internet June 23 - 24

Deliver all hard copy reports, procedure manuals, and
maintenance documentation June 26

    
�

Bar|Scan will provide on-going telephone and email support
to Customer June 26

    
º 

 

Projected Dates  Actual Progress
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ASSET IDENTIFICATION

The Bar|Scan system requires the use of a unique identification number (numbers
and letters) to properly identify an asset.  If you don’t already have a system then
you MUST, before starting to use Bar|Scan, establish a company-wide, uniform,
asset numbering system.

If you are building a database of consumables or quantity inventory, then a unique
identification number is not required and you can skip to the Room Tag section. 

As with any numbering system, there are several considerations.

WHY DOES THIS HAVE TO BE CONSIDERED NOW?

To initially create the list of your assets, a bar-coded label will have to be affixed
to each asset.  You will have to obtain these labels with bar-coded numbers before
you start to enter assets into the Bar|Scan system.

The asset numbering system must be adequate to identify all of your current AND
future assets.  The length of the asset number is checked by the Bar|Scan system
each and every time a new asset is entered into the system.

Bar|Scan does allow variable length numbers to serve as asset numbers so in
special cases you can use serial numbers or other identifiers such as UID labels
as your asset number.

In any case, all that Bar|Scan really requires is that each label has a unique
identifier.  
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APPROPRIATE ASSET ID

Bar|Scan provides space for up to 80 characters for the Asset Number which can
be any combination of letters and numbers.  Bar|Scan also provides space for an
optional Secondary Asset Number (the default is 12 characters but can it be
stretched with the User Defined Fields Module).  Bar|Scan does not care about the
make-up of the identifier as long as each is unique and the appropriate length.

Bar|Scan also does not care which numbering system you wish to put in which
Asset Number entry, for example:

T You may put your new numbering system in the Asset Number entry and your
old property tag number in the Secondary Asset Number entry  (this is most
often the case).

T You may put your old numbering system in the Asset Number entry and your
new number in the Secondary Asset Number entry (you will have to make sure
each number is unique).

T You may choose to only use your existing asset numbers as the Asset Number
(each number must be unique and you will have to obtain bar-coded labels
corresponding to your existing numbers).

T If your old property tag numbers are not barcoded, you may choose to replace
all of them with your new numbers during the initial inventory using the
Mobile Device’s label replacement function.

T If all of your assets have serial numbers, you may choose to use your existing
serial numbers as the Asset Number.  This is not recommended if the serial
numbers are difficult to reach during an inventory, especially if the equipment
is racked with cabling obscuring a direct line of sight.

A word of caution if you decide to use a Secondary Asset Number, normally
Bar|Scan does NOT check this item for duplicate numbers.  While this may sound
like heresy, you can use the secondary number for any kind of number (e.g., a
manufacturer's part number) which may indeed contain duplicate numbers.  If
required, Bar|Scan can check any field for duplicates.
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Note on Asset Number Length: If you decide on an asset number length of six
(6), we recommend that it does not begin with two alpha characters.  This would
be the same format as the Bar|Scan Catalog Number and could cause confusion.

SMART NUMBERING SYSTEM

A smart numbering system assigns a meaning to one or more characters in the
number.

Bar|Scan neither assigns nor derives any special meaning from a smart numbering
system.  When Bar|Scan displays a list of asset numbers, the numbers will be
shown in the standard alphanumeric sequence.  Bearing this in mind, you may
design a smart numbering system in any manner.

Your existing numbering system may contain significant characters to indicate
whether the asset is owned, leased, customer furnished, or personal property. 
Sometimes characters are used to indicate if the asset is capitalized.

The decision to design a new, or use an existing smart numbering system or not,
is strictly a matter of your choice.  Keep in mind however, Bar|Scan can record
and can subsequently generate reports covering almost anything a smart
numbering system would provide.  For this reason, we generally recommend that
you forego a smart numbering system.

If you must use a smart numbering system, it will have to be designed before bar-
coded labels are obtained.  You will also have to formulate a specific procedure
defining what labels are affixed to what assets (a time-consuming and costly
process when you consider the additional effort required during the tagging
operation).  You might alternately consider color coded labels instead of a smart
numbering system.
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ASSET NUMBERING SCHEMES

If you don’t already have asset labels, the simplest asset numbering scheme is to
begin your asset numbering sequence with one.  If you have an eight-digit number,
your first asset will be "00000001".

Consider the following options only If you have special issues:

If you have more than one bar coding system in your company.  You may wish to
begin your asset numbering scheme with a leading alpha or numeric such as "FA"
for fixed asset.  Remember Bar|Scan does not use this information.

Alternatively, if you have subsidiary or sister companies that may adopt a fixed
asset system, you may wish to distinguish between then by leading your number
with one or two characters.  For example, Bar|Scan, Inc. tags may be "BS0001,” 
"BS0002,” "BS0003,” etc. or "BC0001,” "BC0002,” "BC0003,” etc. for Bar|Scan,
Inc. Corporate.

Another option used is to precede the number with the year of acquisition.  Label
all of your assets purchased in 1998 as "980001," "980002," "980003," etc.  Label
all assets purchased in 1999 as "990001," "990002,” "990003," etc.

The Bar|Scan software orders asset numbers based on a character method so
whatever method you choose; it is acceptable to have leading zeros or even asset
numbers of different lengths.

Don’t worry about not having enough digits in your number.  Because bar codes
are alpha-numeric, you can have about 500,000 combinations with just a 4
character number.

If you use Room Tags, the length of the Asset Number should differ from the
length of the Room Tag Number.  The Mobile Device can then verify that you
scan a Room Tag and not an Asset Tag and vice-versa.

WHAT IF I ALREADY HAVE ASSET NUMBERS OF VARYING LENGTH?

If you already have an asset numbering scheme and the asset labels do not all
contain numbers of a fixed length, you can instruct Bar|Scan to accept a variable
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length asset number on the desktop or in the Mobile Device.  Bar|Scan can operate
with a variable or fixed length asset number.  If you want all of your asset
numbers to be a fixed length, you will have to instruct Bar|Scan to pad the
numbers with leading zeros.  The amount of padding depends on the length of
your largest number.  For example, if the largest asset tag number is “550555",
then all asset tags will be padded to a maximum length of 6 digits.

WHAT ABOUT ROOM TAGS?

A Room Tag is a bar-coded label that identifies a specific location.  Once a set of
location codes has been entered into the Mobile Device, a bar-coded label can be
scanned and affixed somewhere in the room, e.g., a door jamb or server rack or
supplies shelf.  The label will now identify that specific combination of location
codes.

Bar|Scan provides space for up to ten characters for the Room Tag.  The
composition of the code has NO effect on Bar|Scan.  The length of the code you
determine should be consistent, i.e., if you establish a 5-character code it should
remain a 5-character code throughout the life of the system.  However, Bar|Scan
can also use a variable length Room Tag, if necessary but much of the Validation
capability of Bar|Scan is lost.

You may use Room Tags for some rooms and not for other rooms.  Bar|Scan does
not require that a Room Tag is associated with every location.

Bar coded Room Tags contribute to the speed and accuracy of the inventory
process.  It eliminates the necessity for entering the different location codes.

Room Tags are an optional part of Bar|Scan, i.e., if you wish, you may instead
record the specific locations using the different location codes and not use a Room
Tag.  The Room Tagging operation should be accomplished before initial asset
tagging, but can occur during initial asset tagging if desired.

ARE ROOM TAGS RIGHT FOR ME?

The Room Tag feature allows you to attach Region, Building, Floor, and Room
(or Pallet or Vault location identifiers) to a bar code label (Room Tag Number)
the first time you conduct an inventory of that area.  The next time you inventory
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that Room, you simply scan the Room Tag.  Bar|Scan will attach the appropriate
location information to the asset when the data is synchronized from the Mobile
Device into the Transaction Table.  Room tags are desirable for private offices and
on projects where Room is narrowly defined.  If the Room is a large cluster of
workstations, finding the Room Tag during the inventory may be more work than
it would be to find the Room name on a floor plan.  You may use Room Tags for
some Rooms and not for others.

Room Tags are an excellent choice for warehouse locators and are highly
recommended in this environment.

We recommend a Room Tag sequence that abbreviates the warehouse location
schema, for example:

BLDG: WHSE1
ROW: 05
BAY: 12
LEVEL: 3

Would use a Room Tag Schema:  1-05-12-3 (including hyphens).  So the Room
Tag label would be ‘1-05-12-3'.

We recommend that all Room Tags be of the same length so that the Mobile
Device can do length checking.  The Room Tag has a maximum length of 10
characters.

Customers can print Room Tags using their regular printer and slipcover or
laminate them and then adhere them to the bin or vertical post of a pallet.  For
example, if the pallet is 3 high, they would print 3 Room Tags per page and apply
to the left post.

For bins, a desktop Zebra Brand printer can be used with Bar|Scan.  Labels can
also be created using label making software.

In all cases the density of the label must be compatible with the Mobile Device. 
For example, long range labels require specific hardware which typically cannot
scan asset labels.
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Finally, while Room Tags are optional, they are the preferred method in a
Warehouse environment. 

If Room Tags are desired, we recommend that the Room Tag have a different
number of digits than the Asset label.  The Mobile Device will check for the
number of digits to prevent inventory personnel from scanning Room Tags as
Asset labels and vice versa.  

DUAL SEQUENCE LABELS

Dual Sequence Labels are bar code labels that are printed with two of each
number on a sheet or roll.  Server racks or Systems Furniture panels are good
candidates for Dual Sequence labels.

Computer Equipment in racks can be tagged twice with the same number, one tag
in front and one on the back.  This makes it easy for a technician to scan if they
are working on the front or the back, e.g. changing cables in a patch panel.

Systems furniture panels can be tagged twice with the same number, one tag for
the side rail and one under the top cap for scanning when in storage.  These
duplicate labels are not as wide as the typical label and usually do not have the
company name on them -- just the human readable number. 

You may want to consider ordering asset labels that have a duplicate label on
them.  System furniture panels can be tagged twice with the same number, one tag
for the side rail and one under the top cap for scanning when in storage.  The
second label can be ordered so that they are not as wide as the typical label, and
usually do not have the Customers name on them – just the human readable
number, making it easier to apply to thinner edges on panels.  This second human
readable number may also be placed on the P.O. for new assets that have yet to
arrive.  In this manner, the asset information can be entered while the paperwork
is at hand.  The human readable number will serve as a reminder to Tag the asset
with that bar coded number.

There is a variation of Dual Sequence labels called Split labels.  Finally, you can
also order triple sequence labels.

Suggested Procedures Page 2-11



Suggested Procedures

DESTRUCTIBLE BAR CODE LABELS

There are three types of labels we generally recommend for fixed assets --
polyester, polypropylene and destructible vinyl.  Polyester is the most widely used. 
Destructible vinyl and similar materials cannot be removed without destroying the
label -- this is a little more expensive but will prevent individuals from switching
tags. You can have your logo or a stylized name printed on the top of each label. 
Both polyester and vinyl can be color-matched to your system furniture if desired. 
Generally, there is no reason to color match or otherwise enhance labels for IT
equipment.

The three types of labels can be color-matched to your system furniture.  Light to
Light-Medium colors are usually printed with a black bar code and clear laminate
over the top.  These types of labels can be read with a standard scanner or imager.

Medium to dark colors may require a different process and will not match as
closely.  With Medium to dark colors, a white label with black bar code is
laminated with a carbon-free color laminate.  An infrared scanner should read
through the laminate.  Whenever these types of labels are used, a test sample
should be created before the order is finalized to insure that the labels can be read.

All asset or room tags should have the same number of digits.  Leading zeros are
used for smaller numbers in the series.  Care should be taken that the sample label
provided matches the number of digits you've requested.

ALUMINUM FOIL BAR CODE LABELS

We typically recommend polyester, polypropylene or destructible vinyl labels for
most applications.

Anodized aluminum labels are for harsh environments -- outdoors and industrial. 
In most indoor asset management applications, aluminum labels offer no
advantages over the other materials.

Occasionally, we may recommend Teflon labels.  These types of labels are
resistant to chemical abrasion and may be desirable in a hospital, laboratory, or
other location where chemical solvents are used.
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COLORED BAR CODE LABELS

Generally, there is no reason to color match or otherwise enhance labels for IT
equipment.

Bar code labels can be purchased in various colors.  While there are advantages
to white labels such as cost and visibility, it may not be the best choice for
aesthetic reasons.  For example, if you recently purchased a large amount of
Furniture in a tan tone, you can match the tone on the label.  This is usually done
by selecting a color from a PMS color guide (Pantone® Matching System Color
Chart) or submitting a paint sample to us.  We can then print the background in
this color.  Of course, for contrast, the bar codes usually will need to remain black. 
Specialty labels mimicking wood tones or displaying clear underlay may also
available.

In any case be careful to maintain contrast between the bar code and the
underlying color.  If there is a doubt as to the readability of the label, submit a
sample for testing to us.

Light to Light-Medium colors are usually printed with a black bar code and clear
laminate over the top. These types of labels can be read with our standard Mobile
Device.

Clear labels are also available.  These labels are polyester.  They are clear on the
edges, with a black bar code.  Behind the bar code, the background color is white;
it has to be white in order for the scanners to read the bar code.  

Medium to dark colors may require a different process and will not match as
closely.  With Medium to dark colors, a white label with black bar code is
laminated with a carbon-free color laminate.  An infrared wand or scanner should
read through the laminate.  Whenever these types of labels are used, a test sample
should be created before the order is finalized to insure that the labels can be read.

Today, Mobile Device come with different types of scanning technology such as
2-D Imagers or 1-D lasers and specialized labels my not be readable by all Mobile
Device models.
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ORDER BAR CODE LABELS

The next step is for Management to decide on a type of bar code label for Assets
and Room Tags (Room Tags are optional).  Bar|Scan, Inc. or your Bar|Scan Dealer
will work with you to develop specifications to meet your needs.  Samples can be
provided to assist you in your decision process.  The tags generally take two to
four weeks to be printed -- color-matching to systems furniture is available. 
Polyester, aluminum foil, plastic, and Teflon® coated labels are just some of the
materials available to you to provide a bar code label solution, regardless of
environment.

If Room Tags are desired, we recommend that the room tag have a different
number of digits than the Asset label.  The Mobile Device can then check for the
number of digits to prevent inventory personnel from scanning Room Tags as
Asset labels and vice versa.  The labels can begin with letters if that is desirable,
i.e., the Room Tags can begin with an "L" for location or an “R” for room.

Here are some label samples that incorporate the varies topics discussed

                                Sample Asset Tags

                                Sample Room Tag
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ORGANIZATIONAL RESPONSIBILITY OF ASSETS

Bar|Scan provides space for three items of information to identify what Division,
Department, and Unit (or cost center) has possession or is responsible for an asset.

These items are optional features of Bar|Scan; that is to say Bar|Scan does not
depend on the entry of these items to support other features.  However, careful
consideration and entry of these items will enable Bar|Scan to produce important
reports for the different organizations or cost centers within your company.

As an example, a particular department may be physically located on two floors
of three different buildings, and some of these locations may be sections within
the department.  Most department heads would appreciate being able to obtain
different reports about where assets are located, what assets are being used by
which sections within the department, etc.

Bar|Scan provides fields for three organizational levels.  Each field can contain up
to 12 characters.  We have named these levels:  division, department, and unit. 
You can rename the or add additional organizational information by using the
User Defined Fields Module.  These fields can be stretched Using the UDF
Module.

ORGANIZATION CODES

Once you have identified the different organizational levels and their names, you
will want to establish a set of codes to represent the different entries.  By using an
Organization Code, the inventory personnel may establish the Division,
Department, and/or the Unit responsible for an asset by simply scanning one code.
These Organization Codes are used when entering new asset information into the
system (either from the computer keyboard or the Mobile Device).

Organization Codes are up to six characters of your choice and can be the or cost
center.  You can stretch the organizational code length by using the User Defined
Fields Module.  You can then tell Bar|Scan what the code characters represent and
assign the names to the codes.  Bar|Scan can display the actual name of the
division, department, and unit on reports, with or without the Organization Code,
or the Organization Code can be printed alone to save space.
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SAMPLE ORGANIZATION STRUCTURES

Organization
Division                      Department                             Unit                         Code             
ADMIN HUMAN RES EMP. BENFTS 01A 2
ADMIN HUMAN RES PERSONNEL 01A 1
ADMIN INF. SVCS APP. SUPRT 01B 1
ADMIN INF. SVCS COMPUTER OPS 01B 2
ADMIN INF. SVCS DATA CONTRL 01B 3
ADMIN INF. SVCS TELECOMM 01B 4
ADMIN OFFICE AUTOMN MAIL 01C 1
ADMIN OFFICE AUTOMN PRINT SHOP 01C 2
ADMIN OFFICE AUTOMN RECORDS MGMT 01C 3
FINANCE ACCOUNTING ACCT PAY’BLE 02A 1
FINANCE ACCOUNTING ACCT REC’BLE 02A 2
OPERATIONS QUAL. CONTRL INSPECTION 03B 1
OPERATIONS QUAL. CONTRL PROD. CONTRL 03B 2
OPERATIONS SHIP/RECVG LONG TERM ST 03A 2
OPERATIONS SHIP/RECVG STAGING 03A 3
OPERATIONS SHIP/RECVG STORING 03A 1
SALES BUS DEVEL REMOTE OFFIC 03E
SUPPLY PURCHASING ORDER PROCES 09Z 9

DEMOCO
BAR CODE ASSET MANAGEMENT SYSTEM

{SYSTEM} ORGANIZATION REPORT - BY DIV, DEPT, UNIT

FILTER: ALL ORG CODES REPORT ORDER: DIVISION, DEPT, UNIT
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PERSONNEL RESPONSIBILITY OF ASSETS

Bar|Scan provides space for employee information to identify what person has
possession or is responsible for an asset.

The Personnel Table is an optional features of Bar|Scan; that is to say Bar|Scan
does not depend on the entry of personnel to support other features.  However,
careful consideration and entry of these items will enable Bar|Scan to produce
important reports for the different groups of employees within your company.

Most department heads would appreciate being able to obtain different reports
about which assets are assigned to or being used by various employees, etc.

Bar|Scan provides fields for information relevant to employees such as phone,
email, department, etc. You can rename the fields or add additional fields by using
the User Defined Fields Module.  These fields can be stretched using the UDF
Module.
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FLOOR PLANS FOR LOCATIONS

Even though you might have an electronic copy, you should acquire printed floor
plans for the areas to be inventoried, which indicate the Building, Floor, and
Room as well as the organization (departmental information) to be used
throughout the project.  

You can use the floor plans provided to enter or assist with the import of Location
information into the Location table in the Bar|Scan system.  

Floor plans are also very useful for your inventory personnel as a means of
"checking off" areas that they have completed during the Catalog process, the
Tagging process, as well as during the audit process.

TYPES OF LOCATIONS

One of the more important features of Bar|Scan is its ability to record and
maintain the physical location of each asset.  Before asset locations can be
recorded, location codes must be established to identify the various locations in
your facility.

In order to establish location codes, you should have a complete set of the most
up-to-date floor plan drawings (paper or electronic) for your facilities in order to
document location assignments.

Bar|Scan provides three different types of Locations.  

1.  Site Locations - most common type of location - used for buildings
2.  Pallet Locations - used in most warehouses
3.  Vault Locations - used for all vaulted storage items

The Site Location in Bar|Scan provides up to four levels of location.  We have
named them Region, Building, Floor, and Room.  You will want to develop a
location scheme which will cover all relevant locations within your company.  As
with most fields in Bar|Scan you can rename these fields, although we generally
advise against it.
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The Pallet Location in Bar|Scan provides five levels of location.  We have named
them Building, Row, Bay, Slot, and Level.

The Vault Location in Bar|Scan provides five levels of location.  We have named
them Building, Vault, Row, Bay,  and Level.

All of the three available types of locations have fields for: a Room Tag, a
Location Description, a Reference Organization, and the Square Footage of the
space.

Important: You do not need to use all levels of location.  If you determine that
you would like to track your assets only to the floor they reside on, but not to an
individual room, you may do so.  This is done by only completing the levels you
wish to track and leaving the others blank.

Unless you are warehousing your assets, you will use the standard location called
“Site”, Bar|Scan provides space for four different site codes as follows:

T  Region  - normally up to two characters
T  Building  -  normally up to five characters
T  Floor  -  normally up to five characters
T  Room  -  normally up to six characters

Each of the above codes can be letters, numbers, or a combination of both.  The
four different codes represent four different code levels, i.e., the Room is located
on the Floor which is located in the Building, which is located in the Region.

It is recognized that your company may currently have a location coding system
in place.  If so, it can be easily adapted to Bar|Scan.

The titles given to these location items are based on the most common usage in
the industry.  They can, however, be modified to suit your particular preference.

You may establish one, two, three, or four different code levels to identify a
specific physical location (usually one or two codes is insufficient for this
purpose).  You may use any of the four different items, just remember that
Bar|Scan will assume that they are different levels.
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If you do not have an existing location coding system, we recommend you
establish a coding system containing four levels.  If you intend to use less than
four levels, we strongly urge you to identify the Building, Floor, and Room.

It is desirable to establish codes consisting of characters that are meaningful,
particularly the Building and Room codes.  For example, unless it is customary
to refer to different buildings by a number, choose code letters that are somewhat
descriptive of the building, such as "ADMIN" for the administration building or
“603" as 603 Main Street.  The reports produced by Bar|Scan will be more easily
understood by personnel outside of your group.

When you have decided upon the location names or codes to be used, record the
codes on your set of facility floor plan drawings so the codes can be incorporated
the next time the drawings are revised.

Then, Location and Organization bar code menu lists are printed for inventory
personnel to use during the inventory or the information is synchronized into the
Mobile Device or both.  

Location & Organization Bar Code Menu Lists are not required.  However, if you
choose not to use them, we recommend that you do synchronized the location,
personnel and organization data from your desktop down into the Mobile Device. 
It has been our experience that when this information is hand entered into the
Mobile Device by hand, rather than being scanned or chosen from a pop-up in the
Mobile Device, there are significantly more inconsistencies and errors.

Important!  If you are planning to use Room Tags, you may only use one Room
Tag number for each Room.  All assets in a given area must be listed in the same
Room with the same Room Tag number.  Also, each Room Tag must be linked
to a unique location.  Note that this is different than using two Room Tags each
with the same number on two different entrances to the same room.

Page 2-20 Bar|Scan



Chapter 2

Here is a sample floor plan incorporating both location and organizational
information.
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STANDARDIZE TAG PLACEMENT

You will want to establish guidelines for the physical locations of the asset labels. 
There are four aspects which should be considered:

T  Consistency

T  Accessibility

T  Aesthetics

T  Vulnerability to Damage or Wear

Determine consistent label locations for the different kinds of assets.  This
location must be accessible to the Mobile Device’s camera or bar code scanner. 
RFID technology is the exception.

In addition to accessibility and consistency, the aesthetics of the assets must also
be considered when determining label locations.

Also consider placement locations which will not be prone to damage or wear.  

It is usually desirable to establish written instructions and illustrations of
recommended label locations in order to train inventory personnel.  Placing a label
on an asset and taking a digital photograph is a quick and easy way of
documenting your guidelines.

Typically, we recommend placing asset tags on personal computer and office
equipment on the top left side.  Racked equipment usually requires placement on
the front panel.  Files and pedestals that can be placed side by side should have
tags placed on the front.  Tags can be placed inside drawers only when a single
master key is available, otherwise it is not practical for locked items.  Tags for
other furniture items can typically be placed within easy reach, out of sight.

Here are some possible guidelines:
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We have more Tag Placement Guidelines in a separate document on your
Bar|Scan installation CD.
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CREATING CATALOGS

The Bar|Scan Catalog identifies and defines the different types of assets.  Each
asset will require a catalog number.

The Bar|Scan Catalog identification number consists of a two-character Category
number plus four digits to specifically define a particular kind of asset.  Bar|Scan
provides a list of Categories and their associated two-character codes.  You may
add additional categories if you wish.  The four-digit number is assigned by you.

Although not recommended, the two-character alpha and four-digit convention
can be changed.  If your discovery tool or enterprise asset management system
requires a different convention, you can modify both the formatting and the length
of the catalog number with the UDF module.

In addition to type, description, dimensions, manufacturer, manufacturer’s part 
number, and manufacturer’s tag number, Bar|Scan provides attribute fields that
can be used to further define a specific asset. 

Depending on the Category selected, from one to seven "Attributes" may be
identified for each Catalog number.  If you need more than seven, you can create
them by using User Definable Fields. 

You must determine the depth of definition you want each Catalog number to
represent.  For example, you could use a single Catalog number to be assigned to
ALL desks (with no further definition and no Attributes), or you could assign a
different Catalog number and Attributes for every different kind of desk.

Note that the less specific the Attributes are, the smaller the number of different
Catalog numbers that need to be assigned.  However, fewer Catalog numbers
mean that the information about the assets in your system will be less definitive.
Consequently, considerable care should be exercised when defining the Attributes
required for each Category in the Catalog.

Another consideration is the four-digit number itself, for a particular Category. 
You can assign meaning to one or more of the digits, e.g., numbers starting with
1000 means desks, 2000 means credenzas, etc.  But, because you can sort your
Catalogs by any field that is contained as part of the Catalog, we do not
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recommend taking the time to use this method.  Most often you will be assigning
the numbers sequentially.  

Refer to the Catalog Development Guidelines at the end of the Catalog chapter for
more information on properly defining your Catalogs.

CATALOG DEVELOPMENT

If you are not importing your initial Catalog information, to begin Catalog
development, data Collection Sheets for each Catalog Category (that are being
used) should be printed.  Data Collection Sheets are included in the Bar|Scan
Compact Disk (CD) in Word, or PDF formats.

If you are not importing your initial Catalog information, there are two traditional
ways to manually collect the information you require to populate your Bar|Scan
Catalog Table.

For IT Assets - Skip the initial Catalog process and collect only the descriptions
(manufacturer, type and model) as you do the physical inventory with the Mobile
Device.  You can either use the Data Collection Sheets or configure the Mobile
Device for a description field which will later be used to create the Catalogs.  As
the inventory progresses, these descriptions are converted into Catalogs and
downloaded into the Mobile Device with every synchronization.  Within a few
days, most of your IT assets will be available as Catalog pop-ups.

For Furniture Assets - During the Catalog process, the inventory personnel go
into the field and assign sequential numbers, by Category, to descriptions of each
unique item they encounter. (For example, SE = Seating, therefore the Catalog
Number for the first chair encountered will be SE0001, the next unique chair will
be SE0002, etc.)  The Project Manager may suggest a pattern for covering an area
or the best route for that day.

Note: Catalogs are only created for each unique type of asset.  Therefore, if you
encounter two or more identical chairs, they would use the same Catalog.  It is
only when one or more features of that chair is different, i.e., blue vs. green, that
a new Catalog is created.

The Project Manager may wish to divide the Catalog creation by Categories --
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Seating and Case Goods to one team, Systems Furniture and Tables to another,
Office and Personal Computer Equipment to another.  If multiple teams are going
to create Catalogs for the same Catalog Category, each team will need a separate
number series assigned to them, i.e., team one will use SE0001 through SE0099,
and team two will use SE0100 through SE0199.

Team leaders will determine the most efficient division of duties on their team. 
One team member may be measuring the asset and calling off the attributes while
the other team member is writing the Catalog information on the Data Collection
Sheets. 

Optionally, each unique asset can be photographed using a digital camera, with
its assigned Catalog Number written on a marker board next to the item -- for later
identification.  Once the Catalog information has been entered into the Bar|Scan
system, the pictures for each item can be linked to it’s Catalog in the Bar|Scan
system.  This will allow you to see the description information of the Catalog, 
click on the appropriate icon and see a digital image of that item.

Note: When taking digital pictures, remember that the direction of lighting, both
ambient and camera flash, may cause a glare off of the marker boards and black
metal items such as file cabinets.  We recommend two photos of each item are
taken, at different angles.  Bar|Scan can accommodate multiple images per
Catalog or asset.

Near the end of the shift, each Team Leader should replenish their daily supplies. 
If additional supplies are going to be needed the Project Manager should be told
before the stock is gone. 

Team Leaders should lock away all equipment including digital cameras, and
walkie talkies.  

Each day the Team Leader should give the Project Manager photocopies of the
Data Collection Sheets and their daily notes showing the Date, Building, Initials
of the Team members, and the number of Catalogs created that day.

Each Team Leader should note areas covered that day on the Project Manager's
Master Floor Plan using a colored highlighting pen.
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If you are using a digital camera, the Project Manager will upload and clear the
camera on a daily basis.

The Project Manager will enter the new Catalogs into Bar|Scan using the
photocopies of the Data Collection Sheets provided by Team Leaders.  Data
Collection Sheets which have been entered into Bar|Scan should be kept on hand
in case questions arise.  The Project Manager should identify inconsistencies in
data entry.  Inconsistencies, missing information, questions, and noted duplicates
should be communicated to Team leaders at the earliest opportunity. 

As each Category is completed, or more often depending on the number of
Catalogs, the Project Manager will print a Catalog Bar Code Menu Lists (a report
of all the Catalogs with the Catalog number in bar code format).  This report will
be used by the inventory teams during the Tagging process.
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INITIAL TAGGING PROCESS

The Inventory Tagging process is the initial entry of information for each asset in
your company into the Bar|Scan system.  Bar|Scan provides you a great deal of
flexibility in accomplishing this task.

Before starting the process, however, you will want to plan the operation to
establish the most efficient and appropriate methods for your organization.

In this section, we have attempted to identify the different considerations you must
decide upon before starting the actual Tagging process.

WHAT INFORMATION WILL BE INITIALLY RECORDED?

A primary consideration is the determination of the different items you wish to
initially enter into the system.

You will also want to decide if you are going to collect additional information
such as a Serial Number.

We recommend you produce a document defining what items of asset information
will be recorded, when they will be recorded (initially or later), and how they will
be recorded (using the desktop or the Bar|Scan Mobile application in your device). 
If any preprinted sheets containing bar-coded definitions are to be used,
instructions for their use should be included.

Overall, you will want to record bar-coded information and information that can
only be derived in the physical presence of the asset with the device.  Some of
these items are: the Asset Number, the Catalog Number, the Serial Number,   the
location information, for IT assets: the components that are attached to the asset
which cannot be identified with a discovery tool, for furniture assets: the condition
of the asset, etc.
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You will want to enter most of the initial asset information using the device. 
Subsequently you might perform an import and reconciliation of existing data,
however, your initial physical inventory is almost always the baseline for
comparison.

Some items, such as Catalog information (from the Data Collection Sheets), are
normally entered at the desktop.  You may also determine that you will want to
enter other items at the desktop.  Why is this?  By entering at the desktop, the
information is being filtered through the Project Manager who can make
comparative decisions and adjustments to the raw data prior to data entry.  A
human brain can spot these data items and is still the best  way to perform this
initial process.

Note that the Bar|Scan Mobile app in the device user records entries either by
scanning a bar code, using a downloaded pop-up list of choices, or by typing the
information on its screen or keyboard; it makes no difference to thedevice. 
Optionally,  you can generate preprinted sheets that contain lists of, for example,
location codes and their associated bar codes.  The location codes could then be
scanned from the preprinted sheets rather than a downloaded pop-up list of
choices or entering the codes on the keyboard.

Choosing from a downloaded pop-up list of choices, whenever possible, the
method of choice.  The most obvious reason is the level of accuracy.  However,
equally important is the speed of choosing from a pop-up list and therefore
scanning a preprinted sheet with bar codes might be faster under certain
circumstances.

The Bar|Scan system on your desktop provides the ability to globally add or
replace information.  Therefore, it is sometimes faster to change information at
your Desktop, rather than re-inventory whole areas.  For example, you have
moved all of the assets in a particular location to storage and you wish to update
the Status for all of these assets.  This is simply accomplished at the desktop by
selecting the group of assets in the location and changing the Status information
on all of the entries at once.
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WHAT IS REQUIRED FOR THE TAGGING PROCESS?

You will need to have a thorough understanding of the use of the Bar|Scan Mobile
app in our device.  You will need the following materials to complete the Tagging
process:

T  An accurate floor plan of the area for verification

T  The Mobile Device

T  The Catalog downloaded into the Mobile Device or as a Bar Code Menu 

T  The Location downloaded into the Mobile Device or as a Bar Code Menu
 
T Optional: The Organization and Personnel downloaded into the Mobile  Device

or as a Bar Code Menu

T  Bar coded labels (unless you are using serial number for the primary id)

T  Optional: a digital camera to record new Catalog or asset entries

T Optional: a Bar|Scan marker board to identify the Catalog number of the asset
as it is photographed

T General guidelines showing the preferred placement of the bar coded labels on
the assets

T  Instructions defining what information to record for each asset and what to do
in case of exceptions, e.g. missing serial number

WHO SHOULD DO THE ACTUAL TAGGING?

Generally, one person or a team of two people is sent to a particular area in your
facility with a Mobile Device to affix a bar-coded tag to each asset and to record
information about the asset.

It is most efficient to assign different tagging personnel to different groups of
assets.  The training is easier and the individuals can quickly become proficient
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with their items.

This approach has however, a potential drawback.  The disruption to personnel in
the different areas will be higher, e.g., one team tags desks and chairs, another tags
computer equipment, etc.

WHEN IS TAGGING ACCOMPLISHED?

Initial tagging can be accomplished most easily when areas are clear of working
personnel (e.g., nights and weekends).  But, you must make provisions for master
keys, sensitive equipment and areas that may not be accessible during off hours
(such as server rooms).

Aside from some obvious drawbacks, some of the information about Current
Ownership may be harder to obtain when there are no personnel available. 
Recording the name of the person using the assets can be very important when
trying to locate a specific asset, especially when the Room is large.

It is always desirable to inform people in the affected areas in advance of the
tagging operation.  This is especially true when you must tag assets during normal
working hours; you will want the cooperation of the individuals whose work
schedule you will be disrupting.  Notification by email alone might not be
sufficient.

TAGGING PROCEDURES

The Project Manager creates the Mobile Device Configuration in Bar|Scan which
when synchronized into the Mobile Device provides the prompts for all of the
information that is to be collected during the inventory.  

Team members should gather their daily supplies for Tagging.

Team Leaders should check the date, time and time zone in the Mobile Device,
and correct the information if necessary.

IMPORTANT! You must synchronize the Mobile Device at least once even
before you begin the inventory.  This is to download the pop-ups and properly
configure the list of prompts.
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The Project Manager may also divide the Teams by Categories; Servers and 
Telecom Equipment to one team, Office and Personal Computer Equipment to
another, Systems Furniture and Tables to another, etc.

If new Catalog Bar Code Menu Lists are ready, the Project Manager will distribute
them to the  inventory teams.

Next, the Project Manager should communicate to the teams where to start their
inventory process. Team leaders will determine the most efficient division of
duties on their team.  One team member may call out the information by looking
at the asset, while the other looks selects the Catalog number and enters the
information into the Mobile Device. 

If an Asset is incorrectly scanned and the information saved, it should be re-
scanned.  The Project Manager will review all duplicates to determine if a
duplicated scan can be deleted.

INVENTORY AN ASSET THAT HAS NOT BEEN CATALOGED

Additional furniture and new equipment catalogs may be required during the
tagging process.  This will not halt the tagging process.  Your personnel will
simply assign the next available catalog number in the particular category;
photograph the item, if it's furniture; and write down the additional information
required on New Catalog Data Collection Sheets.  They will then enter the catalog
number directly into the Mobile Device using the keypad. On a regular basis, this
information will be entered into the Bar|Scan system by the Project Manager and
new catalogs will be synchronized during an upload  and/or catalog bar code menu
lists will be printed for use during the inventory process.

EACH DAY

Each day the Team Leader should give the Project Manager photocopies of the
Data Collection Sheets used that day and Team notes including: the Date,
Building, and floor or area covered that day, and Initials of Team members.

Team Leaders will lock away all equipment including Mobile Devices (once
uploaded), cameras, and cell phones.
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At least once a day, the Project Manager will upload (send the data the inventory
crew has collected to the host computer) either by the USB connection or Wi-Fi. 
This data is transferred into the Transaction table for error checking and editing
before it can be moved to the Asset table.

The Project Manager should validate the Transaction table, to let the system check
for errors.  The Transactions which display error messages are referred to as “bad
transactions”.  While there may be an error according to the system, the
information may be correct.  A report of the “bad” transactions should be printed. 
Bad Transactions can be printed in a number of report formats, we suggest that
they be printed by location so that a physical audit can be performed, if necessary. 

Error messages, when displayed on the report, will appear directly beneath the
affected asset. 

Most error messages may be handled easily by entering additional items into the
system.  For instance, if the asset was inventoried and a label scanned and applied,
the Mobile Device holding the information is uploaded to the Transaction table. 
If the Catalog was created and assigned that day, and not yet entered into the
system, an error message will appear on that Transaction saying “Catalog number
is not on file.” Entering the Catalog into the system and re-validating is all that is
required to fix this error, if it was in fact a new Catalog.  If not, it may be a typo --
which shouldn't happen if team members are selecting from a pop-up or scanning
Catalog numbers from a bar code menu report.

Any assets that were Tagged twice (re-scanned) will be displayed with an error
message saying they are duplicate Asset Number.  The Project Manager will
review the database to decide if one of the scans is truly a duplicate that can be
deleted.  

Other typical errors include "Location Not in Location Table" which means that
the Location entered into the Mobile Device has not been entered into the
Location table.  These are usually new Locations that have not been supplied to
the Project Manager or typos -- which shouldn't happen if Team members
selecting from a pop-up or scanning Location bar code menu reports.  However,
if the floor plans are out of date or incomplete, these certainly can be new
locations.
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Another error is "Unknown Organization Code" which means the Organization
Code does not match any of the items in the Organization table.  The new
Organization needs to be added to the Organization table, or the Transactions
should be edited to reflect the proper Organization Code.  Remember that
collecting this information is optional and not always collected during an
inventory.

All errors should be reviewed carefully, and the Project Manager may need input
from Team members to determine action to be taken.  In most cases, the problems
can be handled by editing Transactions, without revisiting the site.

New Transaction Reports will be printed by Inventory Initials, Date, and Time,
and by Asset number or by location.  All Transaction reports should be kept,
chronologically.  The Project Manager will refer to Team members’ notes to make
any changes, edits, or deletions they may indicate.  All inconsistencies, missing
information, questions, and noted duplicates should be communicated to Team
Leaders at the earliest possible opportunity. 

The Project Manager prints all assets by Current Location and looks for
reasonableness.  Does every Desktop have a monitor or every office have a desk,
chair, file cabinet?  Next, the Project Manager prints all Assets by Asset Number
and looks for missing asset numbers, and odd numbers.

When Transactions have been corrected, validated, and printed, they can be
moved to the Asset table.  

The Project Manager will have the teams perform an audit of the inventory to
assure the work is as thorough and accurate as possible.  This is a very important
part of the process.

At the end of the inventory job, we recommend that you print three types of Asset
reports; one report by Asset Number, one by Catalog Type and Description, and
one by Current Location.  Management is asked to review these reports.  

Once Management has approved the database and any changes are made, if any,
the reports are rerun and the final database is installed on the User’s computer.
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KEEPING THE ASSET INFORMATION CURRENT

A decision will have to be made soon after Bar|Scan is installed and initial tagging
has been accomplished regarding the information on each asset.

T  Will we update the asset information to keep it current?

T  What is current?

T  What information will be kept current?

T  How much activity is required to maintain current asset information?

T  Who will be responsible for maintaining current asset information?

T  Who provides the updated information?

Bar|Scan has many features designed to promote the maintenance of asset
information at a regular and ongoing basis.  Older computerized asset systems
have not provided the ability to quickly find and update an asset or a group of
assets.  Consequently, an ongoing asset information update has not been a
consideration; it was just not done.

The features of the Bar|Scan system and the Mobile Device promote the
feasibility, and the desirability of an ongoing asset information update.

The three major asset information update activities are:

T Keeping track of the physical location of, and the organizational responsibility
for, the assets as they are relocated

T  Entering newly obtained assets

T Updating or interfacing assets with the accounting system or IS repository
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The ability to track the physical location (and the organizational responsibility) of
assets is one of the important features of Bar|Scan.  This can be accomplished
using either the Desktop or the Mobile Device portion of Bar|Scan.

At a minimum, we recommend that the assets involved in a formal planned
facility move be updated to show the latest physical location.  This can be
accomplished by directly entering the changes into the Desktop portion of
Bar|Scan, or by using the Mobile Device to record the assets and their new
location.

Other asset movements can be recorded as they become known or, at the least, the
location will be recorded during the next inventory.

FACILITY AND ASSET MOVES

There are many ways to handle the movement of assets within your facilities. 
Bar|Scan makes it easy to record a change to the physical location of any
particular asset or any group of assets.  As there are a number of reasons assets
move around in your facility, you will want to define the types of moves you will
want to record.  Some of the situations you will want to consider are:

T  Formal relocations which require facility layout drawings and construction

T Moves of groups of assets to nearby locations (relocation of a department or
group)

T  Movement of assets to and from storage

T  Movement of assets between departments (such as semipermanent loans)

T Movement of assets because of a break-fix or upgrade

T  Informal asset moves between individuals

Each of the above situations may indicate a somewhat different procedure.  You
may even choose not to record these movements at all but wait to record the
changes during the next physical inventory.
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We recommend you establish procedures to handle at least the first three items
above.  These situations usually involve  Facilities Management and you can
easily formulate simple instructions for recording the new locations when the
moves take place.

Procedures for the other kinds of moves will require the cooperation of the
different departments and individuals.  Formal procedures are usually more
difficult to formulate and considerably more difficult to implement.  You may
want to consider an informal procedure (such as, when you hear about it you
record it, otherwise the changes are recorded during the next inventory).

These considerations are governed by your company's policy and how determined
your company is about enforcing the policy.

HANDLING NEW ASSETS

Your company is continually acquiring new assets.  They can be purchased,
leased, provided by a customer, or in some cases, provided by an employee.

As these new assets are acquired, you will want to tag the asset, and record
information about the asset.

The procedure you establish will depend upon the nature and adequacy of your
current procedures for receiving material.  Many companies have a formal
receiving department which records the receipt of incoming material.  However,
many times, these same companies will have equipment or furniture delivered
direct to the individual or department requesting the asset.

Many times, notification of the receipt of new assets is left up to the requester. 
This may or may not be adequate depending on the nature or your organization.

The following paragraphs provide, in general terms, some possible methods,
considerations, and suggestions.

T If your company's IT or Facilities Department operates a storage area which is
used to receive and distribute ALL incoming assets, new assets can be tagged
in this area and locations can be recorded when delivered to the requester.
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Procedures for this situation are easy to formulate and easy to implement. 
However, a Facilities Department receiving function is not very often found in
companies.

T Many companies have a formal Receiving Department which handles all
incoming material.  In this instance, a procedure could be established to notify
the IT or Facilities Department whenever new assets are received.

Even in companies having a formal Receiving Department, it is common for
certain kinds of assets to be delivered directly to the requester.

T If your company has a (central) Purchasing Department that handles purchases
and leases of new assets, you may set up a procedure to obtain a copy of all
purchase orders that apply to new assets.

Usually a purchase order will identify the nature of the asset(s), a delivery date,
and the final destination within your company.  You can use this document to
plan the tagging operation.

T If your company uses a purchase requisition procedure, you may be able to
obtain copies when new assets are involved.  Similar to the purchase order, you
can use this document to plan the tagging operation.

T Many companies assign specific Accounting Department account numbers to
leases and purchases of new assets.  You may be able to periodically obtain a
report from the Accounting Department that will provide current information
about recently acquired assets.

T Customer and/or Government Furnished Equipment usually requires close
scrutiny (particularly Government Furnished Equipment).  Reports provided
by Bar|Scan will considerably enhance your company's image with your
customers when Bar|Scan is used to control these kinds of assets.

These assets are usually acquired and controlled by a specific department or
individual.  You should be able to set up a simple procedure for tagging these
assets when received.
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Most often, one procedure covering one of the previous situations will not handle
all of the different aspects of your organization.  The procedures you establish for
new assets will also depend on how current you want the information to be.  You
may, for example, choose not to record new assets at all; recording the
information during the next inventory (this is usually unacceptable).  You may
choose to establish specific procedures for certain types of assets, and rely on
informal notifications for other types of assets.

DISPOSAL OF ASSETS

Just as your company continues to acquire assets, it will also dispose of assets on
a regular basis.

Disposals, (or Salvage as it is called in the Public Sector)  can occur when assets
are sold, or when they are retired because of damage, obsolescence, or they are
just worn out.

Instead of removing (deleting) disposed assets from the Bar|Scan system, we
recommend the assets be retained in the system for a predetermined number of
years.

You can establish special Asset Location codes to identify disposed assets.  You
may want to have different codes for the different reasons for disposal (sold,
retired, obsolete, etc.).  For example, you could use a "ZZ" code in Region for all
disposed assets and then use other codes for Building to identify the different
reasons for disposal.  Note that the "ZZ" code would make it easy to EXCLUDE
these items on your regular asset reports.

You may want to consider using this information to plan a sale of unused assets. 
There are several information items recorded about the assets in Bar|Scan system
which can be used effectively for this purpose.

If you decide to use the Bar|Scan system to track these kinds of assets, you will
want to identify the different codes and information before you start to use
Bar|Scan.
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Another option that is easy to implement for large asset databases, or companies
with a high volume of turnover, is to create a separate “Disposal” Bar|Scan
database.  It is easy to move Asset from one Bar|Scan database to another.  By
implementing this option, you can easily retain years of information without a
significant effect on your “Active” database.  The database can even be set up in
a way that the “Active” and “Disposal” database contain shared information
(tables).

Finally, remember that if you are using Bar|Scan’s Activity Logging feature,
deleting an asset removes the record from the Asset Table but adds a record to the
Asset Log Table.

DESCRIBE THE REPORTS

The Bar|Scan reporting feature enables you to create reports of your own design. 
You can select which assets to print and in what order,  which columns should
appear, whether the fields are printed in human readable or bar code form, where
you want page breaks and subtotals.  You will decide the width of the columns on
the page, supply headings, and print portrait or landscape according to your
instructions.  Once the report is complete, you give it a name, and save it.  You
can also elect to have the report print or emailed in a variety of forms, including
Comma Delimited, XML, CSV, System Data Format, PDF, and Excel for
importing into other software packages.

THE SCOPE OF FINANCIAL INFORMATION AVAILABLE

Bar|Scan has purchase, lease, and disposal/sale information.  The system was
designed as a front-end to your fixed asset accounting system, not as an
accounting system itself.  However, if you do not have detailed tax reporting
needs, Bar|Scan may meet all of your accounting requirements.

Bar|Scan, Inc. does not provide specific accounting or tax advice.
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DESCRIBE HOW ASSETS ARE DEPRECIATED

Assets can be depreciated using the straight line method or other methods,
provided they are entered into a table.  Each asset can have its own start and end
dates for the calculation, number of months, and salvage value.  If you do not use
the Depreciation History option, Bar|Scan calculates depreciation in a fashion
similar to a spreadsheet -- if you choose one of the variables, it recalculates all the
depreciation fields.  The following fields are calculated and stored by the system:
base, monthly depreciation, remaining book, accumulated depreciation,
year-to-date depreciation.  If you use the Depreciation History option, Bar|Scan
will save all of your depreciation periods and does accept adjustments to
depreciation such as acceleration of remaining book value or change in
depreciation method.

BAR|SCAN CAN BE LINKED TO A FIXED ASSET ACCOUNTING SYSTEM

The Activity Log Interface creates a history of activity, behind the scenes, in
Bar|Scan for export to an accounting system.  You can control what types of
actions (add, delete, or change) and which fields will trigger an entry in the
activity log table.  The Activity Log can be generated for each major table and can
be exported as frequently as desired.  The output is a complete listing of any fields
you select, in a variety of formats that you can also select.  Bar|Scan has a
scripting feature that can automate the timing of the export or import.

If you are interested in a quicker export without logging or will only be doing
occasional exports, you may also export from each table directly or create an
ODBC link to exact information as required.

There are few limitations to interfacing the Bar|Scan system.  Most problems we
have encountered have been due to limitations in the customer's fixed asset
accounting software's ability to import new data and change only data.

CHECKLISTS AND SAMPLE MEMO

The following pages are items that you might find useful for your inventory.
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INITIAL SUPPLY CHECKLIST

____ A Computer  (laptop preferred) with the Bar|Scan program installed (or connected to
the network directly or with a remote access application such as those by Azure or
Citrix), and Wi-Fi connectivity or a USB communications cable and cradle for the
Mobile Device.  For larger projects, two or more computers networked

____ Optional One rolling cart per team (for team members to transport their items on)

____ Optional One shoulder bag per person or work aprons with deep pockets (for team
members to transport their items in)

____ One Mobile Device for each person or team, and a spare if possible

____ Cell phones or walkie talkies, one per Team, and one for the Project Manager.  At
least one member of each team should have a cell phone or walkie talkies, and the
phone numbers should be recorded on a list for the inventory crew and the Project
Manager.

____ An up-to-date inventory personnel phone roster (and email) for every person
participating in the inventory

____ Bar Code Tag Placement Guidelines, one for each team

____ A flash light, a mirror, and a tape measurer for each team, and a spare of each

____ Data Collection Sheets for each Catalog Category

____ Clip boards, at least one per person team

____ Pencils, black pens, yellow high lighters

____ Paper clips, binder clips (small, medium, and large), index tabs, Post its (small and
medium)

____ 8-1/2" x 11" ruled note pads for making notes 

____ Digital cameras if images are required
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INITIAL SUPPLY CHECKLIST PAGE 2

____ Letter and legal size manilla file folders for reports

____ One project file

____ Stationary for memos

Check for anything else that you may need for the job such as:

____ Optional Location and Organization bar code menu lists

____ Location (Maps)

____ Any special inventory instructions for this job

____ Paper for the printer

____ Other

When the inventory involves taking pictures, you will also need to prepare the following items
to be sent with the teams:

____ One digital camera and a camera bag for each team

____ One set of Bar|Scan marker boards, felt, and dry erase markers for each team, and a
spare set if possible.  These were provided in the Bar|Scan Supplemental Binder.

Suggested Procedures Page 2-43



Suggested Procedures

DAILY CHECKLIST

____ Data Collection Sheets for each Category with starting sequence on a legal clipboard

____ Mobile Device

____ Catalog Development Guidelines, a copy of the bar code tag placement guidelines, and
a copy of any Special Inventory Instructions

____ Optional Catalog Bar Code Menu List if the Catalogs were imported prior to the
inventory

____ Floor Plans (Map) with Organizations Displayed 

____ Optional The Organization downloaded into the Mobile Device or as a Bar Code Menu

____ Optional The Locations downloaded into the Mobile Device or as a Bar Code Menu

____ Asset and optional Room Tag Labels

____ A Flash Light(s) with Spare Batteries useful for reading serial numbers that cannot be
scanned

____ Optional A Tape Measurer(s) usually used only for furniture

____ Hand Mirror(s) useful for reading serial numbers that cannot be scanned

____ 8-1/2" x 11" Ruled Pad for making daily notes and Pens/Pencils

____ Cell phones or walkie talkie (if possible)

If you are taking pictures during this inventory, you will also need the following:

____ Digital Camera and possibly a Spare Battery

____ Marker Boards, Felt, and Dry-Erase Markers
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EMAIL or MEMO

DATE: ________________________

TO: All Employees

FROM: ________________________

RE: Equipment (or Furniture) Physical Inventory

On   date  , we will begin an inventory of all Equipment (or Furniture) in    Building(s)     .  The
members of the inventory crew will be wearing __________ (or badge) and have authorization to
access your equipment).

They will be applying bar code labels to company-owned Equipment (or Furniture), using Mobile
Devices to inventory these items.  In some cases, they will be photographing these items as well.

If you have any company-owned equipment that is stored in a closet or drawer, please reveal these
items to the inventory crew.

If you are using a personal computer in your office, they will ask you to save and exit the program
you are currently using.  Laptops must be placed on desktops and docked (or undocked). This
process will take between 10-15 minutes.  When they have completed the inventory, you can
return to your work.

If you have any general questions about the inventory, please contact me directly at phone:
____________ or email: _______________.  If you have technical questions concerning your
computer or the discovery process, contact __________________ at phone:
___________________ or email: __________________.

Your complete cooperation with these people will be greatly appreciated.
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AN EXAMPLE OF A CATALOG DATA COLLECTION SHEET

Bar|Scan provides a useful Catalog Data Collection sheet that can be printed prior
to your Tagging.  The Catalog Numbers are auto-generated.  Scanning the Catalog
and completing the form will assist in the Catalog data collection during your
inventory.  The report title is “New Catalog Data Collection Sheets Computers”.
The report can be modified to meet your Catalog collection requirements.

Do not reproduce or duplicate the Catalogs Numbers on these reports.  Doing so
may result in different items being assigned the same Catalog.
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INTRODUCTION

Before you attempt to install Bar|Scan on your computer, read ALL of the sections
in this chapter.

The topics covered in this chapter include the following:

 T Bar|Scan hardware requirements - the computer equipment you must have

T Configuring your computer system

T Installation instructions for the Bar|Scan System

T About the Demonstration System

T Backing up Bar|Scan

T Other Administrative Questions

BarScan has two main versions.  The installation process for each version is
similar.

Single User License - Although it may be installed on a server or desktop, the
single user version of Bar|Scan will ONLY allow a single-user to access it at a
time.  All of the Bar|Scan files MUST be installed on, and operated from, a single
computer, and only one user at a time.

Local Area Network (LAN) License - a LAN license can only be installed on one
(1) server.  It can be accessed from multiple computers on the LAN or Wide Area
Network (WAN).
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BAR|SCAN HARDWARE REQUIREMENTS

PERSONAL COMPUTER

The Bar|Scan recommended minimum system requirements are located on our
website on the Solutions Tab.

The direct URL is: 
https://www.barscan.com/software

There are 2 main sections, as follows:

Bar|Scan Software minimum system requirements

Bar|Scan SmartClient Software minimum system requirements

The SmartClient requirements are only applicable for this single module. 
If you are not installing the SmartClient, ignore these second requirements.
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PRINTER

Bar|Scan will work on any Windows compatible graphics page printer such as the
Hewlett Packard LaserJet series.  Many Zebra Brand printers can also be used to
print bar code labels.  Printing your own labels is generally for short term use only
and not recommend for asset labels.

BAR|SCAN MOBILE APPLICATION IN MOBILE DEVICES 

Bar|Scan has been tested on and is fully compatible with the following portable
Mobile Devices:

The Handheld Products Nautiz X6, the Zebra EC50, MC3300, and other Android
based phones and tablets.

Older devicess include the Motorola/Symbol MC55A0, MC5590, MC3000,
MC3100, MC3200, MC9000, MC9590 and MC9190 are still supported but we
no longer provide Bar|Scan application software upgrades to these devices.

The Bar|Scan Mobile app is Wi-Fi and cellular compatible.
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THE INSTALLATION OF BAR|SCAN

SERVER AND SINGLE USER SUMMARY

1.) Install the Bar|Scan Application Program.  The installation for both the
server and a single computer begin in the same manner.

2.) If you have a Local Area Network (LAN) or a Multiple Company version
of Bar|Scan, you do not need to access the server console.  Bar|Scan can be
installed from the client workstation’s desktop or a remote access
application. 

3.) If you are NOT using a remote access application such as Microsoft Azure
Cloud or Citrix XenApp and you will be using the Bar|Scan software on
more than one computer, then you will be following these instructions.

Install BarScan on the server and nothing on the local desktop except a
shortcut. There are several ways for the Mobile Device to communicate
with Bar|Scan, and this is discussed later. 

4.) If you are using a remote access application such as Microsoft Azure Cloud
or Citrix XenApp, then contact us for detailed installation instructions. 

Install the Bar|Scan Program 

These instructions are for installing the Bar|Scan program on any of the
compatible Windows Operating Systems.

Place the Bar|Scan CD into your computer’s CD Rom drive.  If your drive is
configured for autorun, then the  program should begin automatically.  You will
see a window similar to the one below.
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We expect the above window to appear automatically when you insert the CD. 
If for some reason it does not appear, and you see the following window instead,
select “Run BsInstallHelper.exe”.

To begin the setup of the Bar|Scan program, select Bar|Scan from the Install
portion of the window.  You will see a window similar to the following:
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Bar|Scan will search for a previous installation.  This may take some time on
larger networks.  When completed, you should see a panel like the one below

If you know where your previous Bar|Scan installation resides or you wish to
cancel the search, Canceling the scan does not abort the actual installation. You
then have the opportunity to specify the Bar|Scan installation location manually.
If you press the <esc> key you get this dialog. Say ‘Yes’, then it continues to the
point where you can specify your selected location

Bar|Scan select the default location as the local C: drive, but you can change it to
the network drive.
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When you are ready to proceed, click the Next button. 

The installer will begin, and will guide you through the installation of the
Bar|Scan program. 
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You will be shown a window similar to the one below:

Read the license agreement that is displayed. If you agree to the terms stated, click
I accept the terms in the license agreement, then click the Next button.

Or, if you do not agree, select I do not accept the terms in the license agreement
and the setup program will terminate.  
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You will see a box similar to the one below:

Your name and the name of your company will normally appear in this window.
If they do not, fill out the User Name and Organization as appropriate. Select
whether you want all users or just yourself to be able to use the program. 

Note: Users are designated as such in the Control Panel on your computer. It is
possible that you may be the only user, or you may share your computer.

If you select Anyone, and you add a user later, they will automatically have access
to the Bar|Scan program.

When done click the Next button.
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You will see a window similar to the one below:

This window gives you the option of installing Bar|Scan into the
C:\BARSCANW\ location or any other folder by selecting the Local or Network
buttons. If you want to install Bar|Scan onto your own computer or you know that
it will be put onto a permanently mapped drive, select Local.

Note: While UNC access is preferred, if a server is permanently mapped,
select the Local button, not Network.

If you want to install Bar|Scan somewhere else on the network and are not using
permanent drive mapping, select Network. Another way of deciding is that if the
installation location starts with a drive letter then select Local. If the installation
location starts with a double slash (showing a network resource) then select
Network.

If you are installing this software onto a server, you may need to change the
default destination to reflect your server’s hard drive.
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If you select the Local button, you will get a window similar to this:

To change the default destination folder simply edit the Folder name or navigate
to the desired folder using your mouse. Don’t forget that this dialog will only see 
local and mapped drives.

When done select Ok. If you want to go back to the original path select Cancel.
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Alternatively, you can select the Network button. You will get a window that
looks something like this:

Navigate to the desired folder then select Ok.
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The previous window should still be open.

Verify that the correct location is being displayed.  When you are ready to
proceed, click the Next button.
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If you are performing a new installation and if Bar|Scan detects a previous
installation as show below.

Cancel the installation and request assistance from Bar|Scan, Inc. or your local
Bar|Scan Dealer.
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At this point, you will see a window similar to the one below:

Click the Install button to continue the installation process.

Page 3-16 Bar|Scan



Chapter 3

You will se a window which demonstrates, using a slider bar, the progress of the
installation.
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When the installation is complete, you will see a window similar to the one below:

Bar|Scan has been successfully installed. During the installation, a bar code font
was automatically added to your list of fonts, so that you may print bar codes from
your computer.

You will see an icon has been added to your desktop. The icon should appear
similar to the one shown below:

You may access the Bar|Scan program by double-clicking this icon.
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Creating a Bar|Scan Icon

Once Bar|Scan has been installed, you will want to make an icon for your desktop. 
You will need to browse to the server’s drive where the Barscanw folder resides. 
Double-click  the icon for the Barscanw folder.  You will see a list of files such
as listed in the picture below.

Find the Barscanw.exe file, and use your right mouse button to click on it.  You
will see a drop down menu similar to the one below.  Select Create Shortcut from
this drop down menu.
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A new icon will be added to the Barscanw files.  When an icon is added in this
way, it will appear as the last item in the list.  Use the scroll bar to go to the
bottom of the list of files.  Left-click the shortcut icon and drag it to your
Windows desktop. 

Page 3-20 Bar|Scan



Chapter 3

Move your new icon to a desirable location on your Windows desktop.  You can
now easily access Bar|Scan by double-clicking this icon.

If you like, you can change the name that appears under the icon by clicking the
title, then typing a new title.  Click outside of the title area to save your changes.
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INSTALLING AND USING THE BAR|SCAN SMART CLIENT

Place the Bar|Scan Auxiliary CD into your computer’s CD Rom drive.  The
program should begin automatically.  Click on the Smart Client Install Guide
button as displayed on the screen below.

Adobe Acrobat Reader should open the Bar|Scan Smart Client Quick Install
Manual.  If you do not have Acrobat Reader installed, it is available from
www.adobe.com .

This manual describes the Bar|Scan Smart Client in a concise format.  This
manual describes the installation of the Bar|Scan Smart Client in a concise format. 
This installation requires knowledge of Windows Server software and does
require more experience to install than the Bar|Scan Application.  For more
detailed installation, browse to the documentation on the Bar|Scan CD.

The Bar|Scan Smart Client is installed by Clicking on the ‘Bar|Scan Smart Client’
Install button on the Bar|Scan CD.
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Using Microsoft ClickOnce deployment technology, the Bar|Scan Smart Client
can be installed throughout your environment for quick access to your Bar|Scan
assets.

This product is ideal for installations that require a large number of users that wish
to have simple access and reporting with limited editing.

This product is a Client/Server product separate from the Bar|Scan Application. 
However, it’s display is controlled by the Bar|Scan Application by modifying
existing and new fields on the User Defined Fields Tab.  Therefore, to customize
the Bar|Scan Smart Client requires the installation of the Bar|Scan Application
somewhere on the Network.

It does not require Bar|Scan to be installed on the same desktop PC.

Once installed, users can browse, sort, or print assets.  Filters can be assigned by
user password so that only assets in their area of responsibility are accessed.

An optional module allows editing of existing Asset information.
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INSTALLING THE BAR|SCAN DEMO COMPANY

The Bar|Scan supplemental CD contains a functional demonstration system called
Bar|Scan Demo.  To install this item, place the CD in your computer’s CD drive. 
The installation program should begin automatically.  You will see a window
similar to the one below.

Select the Bar|Scan Demo button from the panel.  The installation program will
begin.

From this point on the installation instructions are exactly the same as for the
standard Bar|Scan installation with one exception.. the default installation folder
is C:\BARSDEMO.

Important: If you change the installation folder be careful not to overwrite any
active Bar|Scan installations (typically C:\BARSCANW) as you may lose data.
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REPAIRING OR REMOVING SOFTWARE

If you need to repair non data Bar|Scan files or remove any of the Bar|Scan
software, you may do so by accessing your installation CD and selecting the
Install button for the item you wish to remove or repair.

You will see a window similar to the one below.

Note: You may access this same window by going to your Window’s Control
Panel and then selecting the Add or Remove Programs option.  When the Add or
Remove Programs window opens, select the software that you wish to repair or
remove.  Select the Change button.  You should see a window similar to the one
displayed above.
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Click the Repair or the Remove option, then click the Finish button.  

If you selected the Repair option, the repair process will begin immediately.  A
repair is basically a reinstallation of all non data files.  The registry entries,
runtime, the Bar|Scan program, fonts, menu entries and shortcuts are repaired. 
Files in Company, Sysuser, and User are not repaired. 

If you select to uninstall the software, the uninstallation process will begin
immediately.

All non data files installed by the package are removed.  The data files that are in
Company, Sysuser and User, or any companies that were added by a user are not
touched during this process.  
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CREATING A MICROSOFT AZURE BASED VIRTUAL MACHINE 

Creating a Microsoft Azure Cloud based Virtual Machine (VM) that can run the

Bar|Scan® bar code asset management system requires some planning.  Settings

depend upon the type of Bar|Scan installation desired.  Some of the possible

configurations are:

1. Standalone single classic VM instance.

2. Single VM instance with a network connection to your internal network.

3. VM acting as a Remote Desktop Server Host.

There are many other types of server configurations. You will have to decide

which is best for your organization.  This document does not claim to discuss all

of the various possible configurations, but rather, presents a simplified version of

one way of creating a VM that works. In addition, Azure currently has two

available portals available for creating and managing Azure resources.  Both the

new and classic portals can be used to create a successful Bar|Scan installation.

If at any time you have questions about this installation, please contact us at

info@barscan.com.  Additional resources can be found on the Microsoft Azure

website at: https://azure.microsoft.com
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BACKING-UP AND RESTORING BAR|SCAN DATA

There are many backup technologies in use today, ranging from cloud based

server backups to high transaction replication servers.  Which method is selected

is ultimately up to you. 

All of these technologies have the same goal, to reduce the cost of the loss of data. 

Losing data costs money in lost productivity and man-hours.  However, the

backup strategy needs to match the value and type of data. Some backup strategies

have a substantially larger ongoing cost that others while giving no substantially

greater protection of data due to either the nature of the data or the role of the data

in the company. 

Bar|Scan recommends the classical backup strategy of using a backup program to

back up Bar|Scan data folders on a daily, weekly, and monthly basis to another

server, backup device or cloud.  Bar|Scan is not a high transaction data system and

damage to data tables is most often confined to a single table set. Damage to

indexes can be corrected within Bar|Scan itself. In fact, standard inventory 

practice requires refreshing data from real data gathering in an ongoing manner.

This backup strategy means the maximum exposure to data loss is at most one day

of activity, even in the face of catastrophic data loss, such as an entire server

crashing.

The restoration of any file or information should only be done by someone

experienced in the operations of your computer  and only after the source of the

problem is identified.  Please contact Bar|Scan support before attempting a

restore.  Many times a full restore is not the best action and data can be fixed
with just a phone call.

email: techsupport@barscan.com

internet: www.barscan.com

US Telephone (800) 414-7226

Overseas Telephone (805) 777-0079

Always make a backup of your current data prior to any restoration from a
backup.
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It is worth mentioning that Bar|Scan does have built in systems for sending data

away to other locations. This is typically NOT for backup but rather for access

using a dispersed database model.  Do not rely on these for your backups.

Method #1 - Company Synchronization by Network Access

On a manual or timed basis a session of Bar|Scan can copy the changes in one

company to another company on the network. The target computer does not have

to have Bar|Scan installed. It is just a data repository. If it runs during the day,

user’s generally are not aware that it is running, but it can at times cause users to

wait while it sends data, since any tables sent must be locked to ensure data

integrity. This feature requires that a session of Bar|Scan be running, since it

cannot currently be activated using the Windows Task manager. The session will

need write privileges to the target server.

Method #2 - Company Synchronization by Email

On a manual or timed basis, Bar|Scan can send emails to another Bar|Scan system,

which, in turn, can load the data sent to it into its own data tables. This system is

valuable for keeping two non-connected databases synchronized, but is not very

effective as a backup system. It requires that Bar|Scan and Microsoft Outlook be

installed on both computers and either an operator or an automated process must

‘catch’ the data on the target computer and run Bar|Scan there to load it. Also,

while it is accumulating data to send, it must ‘lock’ its tables so that it is internally

consistent, so it is generally not done during normal working hours, although it

can be. It can be activated by the Windows Task manager.

Method #3 – Bar|Scan Proprietary Data Transfer files

Users can manually range a set of assets and export them to a data transfer file set,

saving them to any server where the user has write privileges. This can be done

at any time. It can be all items or just a few. However, it is currently a manual

process. This process is normally used to transfer reports and initialize tables,

onetime operations.
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Method #4 – The Bar|Scan Report Generator (exports)

Reports can be configured to send critical data either on a manual or timed basis.

They can be saved to files on a separate server or send as data files or PDF files

through email. Again, this process is somewhat awkward as a means of doing

backup, but is outstanding for getting critical information, especially by email, to

those who need it. It can be activated by the Windows Task manager.

Method #5 – Copy Company Database

An entire company can be copied to another server, either within Bar|Scan or

using the Windows file manager directly. Many customers use this simple strategy

to keep backups, that is, coping entire companies on a daily basis. If done within

Bar|Scan this is strictly a manual process. If done by File Manager, it can be

activated by the Windows Task Manger.

Method #6 - Bar|Scan Proprietary Formatted Export

This method is similar to creating reports.

Method #7 - Bar|Scan Company Database Export

This is also a manual process. Ranged items in any table can be moved or copied

to another company. This other company can be located anywhere on a network,

as long as it can be seen by the user and they have write privileges.
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Restoring Bar|Scan Data

By default all current information entered into the system by you is located on the

hard disk in one of the subfolders of the "\BARSCANW” folder.  If you have a

single-user system, this is usually the “COMPANY” folder but can be any folder

name of your choice.  However, you or your administrator may have created

additional companies and these may be literally anywhere on your network.

Note, “shared” files, such as the User, Catalog and Location files, are in the

“SYSUSER” folder. These files should be backed up as well.

Bar|Scan data files begin with the letters BS and end in the file extension DBF. 

They can reside anywhere on your hard disk since you control the Folder or Group

of  Folders in which they reside.  The Folders can be viewed through the Windows

File Manager or the Bar|Scan File/Open command.  It is not always sufficient to

Backup only the \BARSCANW folder on your computer or server.

To RESTORE only your company database:

T  Start Bar|Scan, access the File/Company/Close/All to close all companies.  

Exit Bar|Scan.

T  Restore the entire company or companies’ folder from your backup into the

Windows folder that you initially assigned to hold the company information. 

Also, restore any backed up shared files to the sysuser directory.

T  Start Bar|Scan, access the File/Company/Open and browse to the restored

company.  Select the company.

T  Access  File/Company/Housekeeping/Table Integrity.  Select the company you

just opened below in the Company list.    Click the OK button. 

T  If there are no warnings displayed by Bar|Scan during the process, then the

company was successfully restored.  If warnings were displayed, please contact

Bar|Scan Technical Support.
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To RESTORE the entire system:

T  Re-install the system using the Bar|Scan installation procedure.

T  If your database was in the “Company” Folder, send the contents of the

“Company” folder just created to the Windows Recycle Bin.

T  Start Bar|Scan, access the File/Company/Close/All, to close all companies.  

Exit Bar|Scan.

T  Restore the entire company or companies’ folder from your tape or diskettes

into the Windows folder that you initially assigned to hold the company

information.  Also, restore any backed up shared files into the sysuser directory.

T  Start Bar|Scan, access the File/Company/Open and browse to the restored

company.  Select the company.

T  Access File/Company/Housekeeping/Table Integrity.  Select the company you

just opened below in the Company list.    Click the OK button.

T  If there are no warnings displayed by Bar|Scan during the process, then the

company was successfully restored.  If warnings were displayed, please contact

Bar|Scan Technical Support.

Making backup copies of your Bar|Scan data is your responsibility.  We are not

liable for loss of information on your computer.  By loss we mean both

malfunctions of the hardware as well as deletion of your Bar|Scan data, either

intentional or unintentional.

If you currently do not have a backup system, at a minimum we suggest that you

download a copy of WINZIP at URL www.winzip.com

It can be a useful temporary backup, however, we do not recommend it for

permanent backups.  It is used primarily to speed the transfer of files when we

work on your computer remotely and to compress files for e-mailing purposes.
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Other Administrative Questions

Bar|Scan, Inc. maintains a Knowledge Base section on our website to address

specific operational issues in a question and answer format.  The page is

accessible from the Support tab located on our main page www.barscan.com

We recommend that all new users visit our Knowledge Base as it provides the

most up to date resource on software, hardware and operational issues.

Some of our more frequently asked questions from our Knowledge Base are

presented on the next few pages.

What are bar codes and how are they scanned?

Bar code can be thought of as a printed version of Morse Code.  To read the

information contained in a bar code symbol, light is moved across the symbol

from one side to the other.  The width of the bars and spaces is then translated by

the equipment into numeric and alpha characters.  There are a number of

symbologies or methods for translating bar code symbols.  The standard adopted

by most facility managers, computer and furniture manufacturers and furniture

dealers is Code39.

There are two types of portable bar code equipment used for fixed asset tracking -

fixed beam contact devices (contact wands) and moving beam non contact devices

(guns).  Contact wands have become obsolete and most portables now use

integrated guns.  The gun’s proximity to the symbol is a function of the density

of the symbol and the gun’s capabilities - typically 1" to 9" for the medium high

density labels used for fixed asset applications.

The mobile device is typically programmed to prompt inventory personnel

through the data collection process-asking for location, cost center, and

descriptive information.  The number of characters and lines of display on the

portable is important because it is used to give inventory personnel necessary

feedback during the inventory process.
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What barcode symbologies do you support?

Bar|Scan recommends the user of Code39 symbology which is accepted as the

industry standard for the asset management.  Most Mobile Device applications

also support Codabar, Code 129, and Interleaved 2 of 5 and more. Code39 is

alphanumeric and accepts all of the following characters:

0-9

A-Z (uppercase)

_ . $ / + % and “space”

It is well suited for field data collection and employed by all computer

manufacturers and most furniture manufacturers. 

I need to move Bar|Scan from one server to another, how do I do this?

If you only need to move the program and are not performing a program upgrade,

then this is a straightforward process that does not require the Bar|Scan

Installation CD.  This summary does not include the Bar|Scan Smart Client. If you

have installed the Bar|Scan Smart Client, please contact Bar|Scan technical

support techsupport@barscan.com in advance for any assistance that you may

require.

There are several issues that must be addressed:

1. Computer Privileges or Permissions. You will need to make sure that your

Bar|Scan group has exactly the same privileges on the new server location as it

does on the old server location. Do not reduce the level of privileges on the new

server.

2. Workstation shortcuts. All shortcuts on all workstations will need to be

pointed to the new location of the BarScanw.exe application. This can be done by

remoting into each PC.

3. Current default company within Bar|Scan. Each Bar|Scan user has a default

company that their account opens when they log in. The default company needs

to be changed from the company folder on the old server to the company folder

on the new server. This can be done in several different ways, but is typically done

by logging into Bar|Scan as the end user and then closing the old company on the
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old server (File-> Company-> Close) and then using the same login, opening the

new company on the new server (File-> Company-> Open).

Summary of how to perform the Move:

1. Obtain Bar|Scan master user credentials.

2. Schedule a time for the move and notify all users that Bar|Scan will not be

available.

3. Log into Bar|Scan using the master user credentials.

4. Turn on the global user lock. This locks out all users. Wait until there are no

more users logged in.  The Knowledge Base Article “How can I log everyone out

of Bar|Scan” explains this process.  You may have to contact people to have them

exit, so having phone numbers and/or emails can be useful.

5. Copy the entire \BarScanw folder containing all of the BarScan data and the

Bar|Scan program (BarScanw.exe) to the new server. This will typically mean

copying folder \\oldserver\BarScanw and all of its subfolders and files to folder

\\newserver\BarScanw. When completed, it is recommended that you rename

\\oldserver\BarScanw to something like \\oldserver\BarScanwOld so there will be

no confusion after the move.

6. Remote into each user workstation and create a new shortcut pointing to the

new location of the BarScanw.exe. It is typically easier to create a new shortcut

and then delete the old one rather than modifying the existing one. Make sure that

the ‘Start In’ folder is filled in and matches the ‘Target’ folder as shown on the

following page.
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7. In Bar|Scan, turn off the global user lock (see website Knowledge Base article

“Article “How can I log everyone out of Bar|Scan” previously referred to in this

article).

8. Log into Bar|Scan as each user each in turn. You will close all companies for

each user and then open the new default company on the new server. This is done

for each active user.  Note that you do not have to remote into the workstations to

do this, but you do have to open companies using the network URL. For example,

if your user’s default company is on server \\newserver and is in folder

C:\BARSCANW\COMPANY, you must open it using the path

\\newserver\BARSCANW\COMPANY.

9. Verify that the privileges for the Bar|Scan group are working properly.

10. You are done with the move.
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Do I need to be in the Administrator Group to install Bar|Scan on a Laptop or Desktop

Workstation? 

Yes, installation is the only time that Bar|Scan requires that the user be in the

Administrator group. Bar|Scan can be used in other groups if privileges are set

correctly. If Bar|Scan works properly in the Admin group but NOT in another

group, then it may be a privileges problem with the other group.

What are the Record Locking Priorities?

Record Locking is common in software applications that can be accessed by more

than one user concurrently in a Local Area Network (LAN).

Bar|Scan is designed to minimize record locking.  Therefore relevant records are

locked only when an update (write to disk) occurs.  There are two cases where the

user will encounter record locking.

T When a record is selected for updating, the information from the record is

copied to memory.  If another user access the same record, makes a change,

and writes the record back to disk, then the initial information that you

originally gathered is no longer accurate when you try to save the record.  You

are then notified by Bar|Scan if you wish to refresh the record.  Refresh means

-- Do you wish to get the new information that was written to the disk by the

other user.  If you respond "YES,” your changes are lost and you have an

opportunity to work with the new information.  If you respond "No,” your

changes are lost and Bar|Scan is ready to perform a new task.  Note that in

either case, any edits you have made are lost because another user changed the

record before you.

T You can experience a message that says "filename is in use by another,” where

filename is the file that you are attempting to access.  You are given the

opportunity to try and access the record again.  This message is not common

and can only happen when you and another user perform the same actions

simultaneously or the other user is performing a housekeeping function such

as restructure, or reindex.
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How does your system maintain data integrity in the event of a system failure? 

Simple system failures can typically be corrected by reindexing the database at the

File ...< Company ...< Housekeeping ...< Table Integrity Menu.  Select the

Company Database and press OK.

Describe the process of data recovery after a system failure. 

Hardware failures will typically require restoring data from back-up copies. 

Software failures can typically be corrected by a running a Table Integrity. 

Because of the structure of the Bar|Scan software, there is a minimal chance of

corrupting data during a system failure.

Describe how security control is implemented in your system.  Which features are

provided by the operating system and which are application software features?

Bar|Scan has password protection which controls database, menu access fields,

and functions within the system.

Bar|Scan's password system can restrict the above functions within each menu, as

required.  For example, one user can have the ability to Set and View Catalogs;

Add, Change, Delete and View Assets, but not access the serial number field. 

Another user could Set, Add, Change, and View Catalogs, Set and View Assets,

and have no access to the reports’ menu.

All users require full read/write and modify windows permissions allowing access

to all Bar|Scan directories and files.

Setup requirements are that there is one program directory and separate

subdirectories for each distinct asset database.  There are no special login script

requirements. Users need full access to all folders.

Page 3-38 Bar|Scan



Chapter 3

Describe the audit trail of database changes available on-line and/or printed.  How long

is the audit trail maintained?

The Activity Log Interface creates a history of activity, behind the scenes, in

Bar|Scan for export to your enterprise or accounting system.  You can control

what types of actions (add, delete, or change) and which fields will trigger an

entry in the transaction log.  The transaction log can be generated as frequently as

desired.  The output is a complete listing of the asset or other table records, in a

variety of formats.  Optional fields include, the type of action, and a time and date

stamp.  Format options include: Comma Delimited, Microsoft Excel, XML and

CSV.

The Activity Log Interface stores the data indefinitely subject to disk space and

archive procedures, which should occur on a regular basis.  Bar|Scan has an

Activity Log Archive function built in.  The Activity Log table can also be printed

using the Bar|Scan report generator.

Discuss the data dictionary provided by your system.

Bar|Scan does not contain a user-accessible data dictionary however, you can

export it or print it.  This is your actual data dictionary and will contain all of the

modifications made by you to the database, e.g. the addition of User Defined

Fields.   If you have more than one company database, the data dictionary may be

different for each company.

A sample report is included in Bar|Scan and can be found by selecting the ALL

Reports Icon. 

Additionally Chapter 14 - Import and Export of this manual includes a field

length chart of fields, including their type and length.
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What is the maximum number of concurrent users updating data?

There is no limit to the number of users updating data, but only one person can

update any particular record at any given time.

What limitations should we be aware of before purchase of bar code asset labels?

The asset number length must be between 5 and 80 digits.  The room tag length

must be between 4 and 10 digits.  The recommended symbology is code 3 of 9,

and we recommend that the density be between 7 and 9 characters per inch.  Two

dimensional bar codes such as UID Construct 2 can be scanned and supported on

the Mobile Devices that can capture 2D barcodes.  Bar|Scan, Inc. would be happy

to assist you in developing your specifications, at no charge.

I completed my annual inventory, how do I know what assets are missing?

After your inventory is completed and all Transactions have been moved to the

Asset Table, you can print a report (or create a SET command) to print all missing

assets. This report would have a filter with all assets that have an inventory date

OLDER than the first date of your annual inventory. These assets were not

scanned during the annual inventory. These are your missing assets. You can also

print a report of new assets only. New assets are those with no prior location.

How do I set up an ODBC connection to Bar|Scan?

The Knowledge Base section of our website discuss ODBC and OLE connectivity

in detail.

Page 3-40 Bar|Scan



Chapter 3

Can I design my own label including a logo?

Yes, you can design your own label. A sample label is included in the Bar|Scan

System reports. The Report name is “{System} Sample Labels”. You can access

the report designer by placing three exclamations in the beginning of the

“Optional Format File” field like this !!!. You will still need to include the format

file name. When you then select the Preview Button, the report designer will be

displayed similar to the example below:

This feature is for more advanced users with some layout experience in other

applications. You can also contact us if you would like us to create a label for you.
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INTRODUCTION

Bar|Scan is a complete Asset Management System.  As such, the system must:

T  Precisely define or describe each different kind of asset

T  Provide a way to identify each and every asset in your company

T  Identify a current physical location for each asset - optional but very useful

T  Provide a means to periodically take an inventory of the assets

T  Provide the ability to efficiently maintain the information recorded for each  
asset

T Provide the ability to interface with other software systems by importing and
exporting information or ODBC linking

T  Provide many different printed or exported reports containing the desired      
      information presented the way you want it

T  Identify the individual and/or the organization having possession of, and/or   
responsibility for each asset

This chapter will show you the different features of Bar|Scan and provide
information about the nature and purpose of each.

You will also be instructed about some of the ways to access and exit the different
features.

If you have installed the Bar|Scan system, you may experiment with the different
features in your sample database - Democo.  For instructions, see Chapter
Nineteen, Training With Demo.  Feel free to experiment with the Democo.
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STARTING BAR|SCAN

Double click on the Bar|Scan icon, and if you are not using Single Sign On (SSO)
you will see a window to welcome you to Bar|Scan as shown below.

Please type your User ID and press <Enter>, then type your Password and press
<Enter>.  Then press <Enter> again, or click on the Ok button.  You will then see
the Bar|Scan Windows Main Menu.

If you have just installed your system, or if you have not been given your own
User ID and Password by your Bar|Scan administrator, the default User ID is
MAS, and the default Password is MASTER.  Simply type MAS in the User ID
field, and press the Enter key.  The User ID and Password is not case sensitive. 
Type MASTER in the Password field, and then press the Enter key.  Then select
the OK button by pressing Enter again, or click on it with your mouse.

Note: The software version number for the software is listed at the top of this
screen, as well as on the Help drop down menu, under About Bar|Scan for
Windows.
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You can bypass the Welcome Screen by optionally using the Single Sign On
feature.  Using Bar|Scan Single Sign On (SSO), the Bar|Scan Login is replaced
with your current authenticated Windows or Active Directory account.

Single Sign On (or SSO) implementation is via an addition to the User Screen
under ‘Account Management’. Within this screen are three fields. Field “SSO
Allowed” enables/disables the function for the current user of the screen., “SSO
User ID” is basically the Windows User ID used to log in to Windows, and “SSO
Domain” is the Active Directory Domain of the user.

For SSO to be active, both the ‘SSO Allowed” must be checked ‘on’ and the ‘SSO
User ID’ field must be filled in with the user’s id. The ‘SSO Domain’ name is
optional. It is only needed if managements wants to specify that this particular
user must also be a member of the specified Active Directory Domain.

When a user logs into Windows, Windows makes available the current user name
to requesting programs such as Bar|Scan. If Active Directory is being used, the
User will not be allowed to log in to Windows unless they are using a permitted
Active Directory user id. After the user has logged into Windows and has been
authenticated by Active Directory, Bar|Scan will be available. When Bar|Scan is
started by a user Bar|Scan obtains the current user Id from Windows and compares
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it to its user table entries. If a matching ID is not found, the user is not
automatically logged in. If a matching ID is found within Bar|Scan, then the login
process continues with that specific user. If an Active Directory Domain is also
entered for the user within Bar|Scan, then Bar|Scan calls Active Directory through
an API to check to see if the ID is in the specified domain. If it is not, then the
user is not logged in. If it is, then the login process is completed and the user will
never see the Bar|Scan login screen.

Although Bar|Scan can consult Active Directory when authenticating users (if the
relevant fields are filled in) authorization for its many functions is currently too
complex for Active Directory in its current version. Since proper authorization is
obviously a requirement, management only within Active Directory is not possible
at this time. Because of these authorization requirements, users added and
removed from any Bar|Scan Active Directory domain will also have to be added
or removed from within Bar|Scan’s list of users. Bar|Scan itself manages
authorization of its functions. In other words, authentication and authorization of
Bar|Scan users is not possible within Active Directory alone but must be made in
coordination with Bar|Scan.

Additionally, Bar|Scan does not import or accumulate a list of Active Directory
users, but only checks the current user against Active Directory’s authentication
process.
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THE BAR|SCAN MAIN MENU

When you start Bar|Scan, you will be presented with the Main Menu as shown
below.

At the top of the window is a horizontal bar referred to as the Title Bar.  The Title
Bar as well as the Footer Bar at the bottom of the window will list what Company
Asset Database you have open.  

The first time Bar|Scan is started, no Company name will appear, as there will be
no Company Asset Database open until you open it.  As shown above, the icons
will be greyed out as well.
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You can open a company database by saying File, Company ...<, Open as shown
below.

When you attempt to Open a company as shown above, you will be shown a new
window that lists the databases that are in your Barscanw folder as shown below.
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Select the Democo to practice and learn the features of this software without fear
of ruining real data.  Highlight the Democo and select the OK button, or double
clicked on the Democo folder and you will be shown a window like the one
below.

Highlight the Democo.dbc and select the OK button, or double click the
Democo.dbc and the Demo database (called Democo) will open.

The Democo is a full working system containing sample information.  The
Democo will enable you to do the same things you can do with a live system. 
Learning on the Democo allows you to familiarize yourself with the features,
without the fear of creating problems.  You can: add, change, set, delete, or print
information.  All of the features perform exactly as they will when you enter your
real database.

We urge you to work with the Democo.  Try all of the different features using the
Training With Demo Chapter of this User Manual.  Use the company and data
until you are comfortable with all of the features.
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Note:  If you have a single company version of Bar|Scan, and you want to start a
new company, select File, Company ...<, Close, All.  When ready, you can select
File, Company ...<, Open and select the Company folder, and the Company
database inside of it.  You will begin by changing the Settings in this company to
match the specifications for your new company.  

We recommend working with the Democo, until you are familiar with the features
of the Bar|Scan program.

Immediately below the Title bar, the Feature Categories are listed as shown below. 
These Feature Categories allow you to access all of  the primary features of
Bar|Scan.  

As with most Windows compatible programs, simply click on the desired Feature
Category, and a drop down menu will appear, listing the Features.

When you select File, you will see a drop down menu.  You can select any of the
Features that are highlighted, such as Open, Company, or Exit.  Some of the
Features have additional menus that will appear when that Feature is highlighted 
signified by an arrow ( ...<) located to the right of the Feature, i.e., select File, then
Open ...<, then Asset ...<, Assets. 
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THE MAIN MENU CHANGES

When you open any panel or table, the Main Menu changes to accommodate
additional information on it.  If you left click on the title bar of a panel, and hold
the mouse button down, you can drag the panel to a new location, or click on the
minus sign at the top right to minimize the panel, allowing you to view anything
that was behind it.

When you open a panel,  you can left click on the title bar, and move it out of the
way, so that you could view the Main Menu.  If you do this, the Main Menu will
look slightly different, as shown below.
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THE FILE DROP DOWN MENU

You can access each of the Feature Categories’ drop down menu by pressing the
Alt key + the underlined letter, i.e., to access the File drop down menu, you can
type Alt + F, or by left clicking on the Feature with your mouse.  When you select
the Feature Category, File, you will see a drop down menu like the one below.

You can access any of the items on a drop down menu by left clicking on that
item, or by typing the underlined letter, once the drop down menu has been
displayed.

The Feature Category:  File, is used in order to open any company or table, as well
as to close them, Save, Cancel, Export, Import, and to exit the program.

Notice that to the right of some of the items on the drop down menu, there are
either arrows or keystrokes listed.  If there is an arrow, there are more items to
view that will appear when you select that feature.  If there is a keystroke listed,
such as Ctrl+S for Save, you can access the Save feature by typing the Control +
S key combination.  Some of the items from various pull down menus may appear
as “greyed out,” or all light grey in color.  This means that you do not have access
to these items.  This can happen for several reasons, i.e., it may not be applicable
at this time or it may be an optional feature that your company has not purchased.
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THE EDIT DROP DOWN MENU

The Edit drop down menu lists standard Edit items, as shown below.

You may Undo, Redo, Cut, Copy, Paste, Clear, Select All, Find, Replace, and set
your Personal Program Preferences.  Some of these items are listed specifically
for text edits, such as the find and replace features.  These items work on text,
such as in the notes field.
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When you select the last item on the Edit drop down menu, Personal Program
Preferences, you will see a table like the one shown below.

Just like it sounds, you can list your personal preferences for the items on this
table, or use the defaulted options.  

On the Sight tab, you can choose different colors for the Bar|Scan program.  

On the Sounds tab, you can select sounds and when they are made, for instance
if you want a beep to play  

On the Prompts tab, you may decide which prompts you want to have verified
before the action is carried out.  

On the Miscellaneous tab, you can choose if you want the entire directory path
displayed on the title bar instead of just the company name.
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THE VIEW DROP DOWN MENU

The View drop down menu is shown below.

This feature allows you to add shortcut icons, with or without captions, to your
Main Menu.

You can add shortcut icons to open Companies, Reports, Tables, or to access the
Import feature.  There are additional items listed here that allow you to turn this
feature off, or to add all of the icons to your Main Menu.

If you are consistently opening reports, for example, adding the Report Toolbar
to your Main Menu will allow you to access the different types of reports by
simply clicking on their corresponding icon(s).  The icons that are available to you
are shown below.  Placing your mouse pointer on each icon, without depressing
your mouse button, will make the program display a short description of that item.
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THE WINDOW DROP DOWN MENU

The Window drop down menu is shown below.

This item allows you to arrange all of the Bar|Scan windows that you have open. 
You can hide the window, hide all of them, or Cycle through them.  Cycle allows
you to bring to the front any  window that you have open, making it the active
window.  If you have several windows open, cycle will bring them to the front in
order.  The bottom item(s) list the table(s) that you currently have open.  As
shown above, for illustration purposes, we had only one table, the Location table
from the Democo company open.
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THE PANEL DROP DOWN MENU

The Panel drop down menu is shown below.

These features are directly related to the panel that you have open and active. 
Top, allows you to go to the first item, Bottom, allows you to go to the last item. 
Next and Prior items allow you to access the item that is next or the preceding
item.  Add allows you to add an item.  Delete allows you to delete a selected item. 
Find allows you to find an item an item meeting criteria that you specify.  Set
allows you to sort the items by any of the sorts that have been previously created. 
Range allows you to start a range, end a range, or clear any or all ranges.  Refresh
allows you to refresh the current panel.  Design Mode-User Defined Fields is used
when you have the UDF module, to launch the design mode for adding or editing
your User Defined Fields.
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When you select the Find feature, from the Panel drop down menu, you will be
shown a panel like the one below.

The items listed in the above window will change to reflect the panel that you
have open and active.  For example, if you have the Location table open and
active, and you select the find feature, the items listed on your find panel will be
location fields.

To use this feature, first select a table, then simply choose a field you wish to
locate.  Next, select an Operator, i.e., greater than, or equal to, and then choose a
Value.  In the above panel, we are searching in the Catalog Table for the first
catalog that has a Catalog Type that contains the word “BRIDGE.”  You can start
the find feature from the Current item highlighted on your active panel, or from
the top.
 
Click on the Find button, and the highlight bar on your active panel will move to
the first item that matches the criteria.  When an item that does match the criteria
is found, the Find button on the Find panel switches to say Find Again.  If
Bar|Scan does not find a match, you will be notified by a Not Found message
being displayed above the Find button, as shown above. 
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THE HELP DROP DOWN MENU

The Help drop down menu is shown below.
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The third item in the Help drop down menu, is Technical Support.  When you
select this item, you will see a window similar to the one below.

This item displays information about Bar|Scan, Inc.  The US address, telephone,
fax, website address and e-mail are listed here.

You can click on the website address to open your Internet Browser and be
directed to the Bar|Scan website.

Clicking on the e-mail address will open your email program and begin a new
email for tech support.

Optionally, using a text editor, your IT Department can add their contact
information into the text file \barscanw\sysdbf\bsglobal.xml and it will be
displayed in the panel shown above.
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The last item on the Help drop down is About Bar|Scan for Windows.  When you
select this item, you will see a dialog box like the one listed below.

This item will display information about the Bar|Scan system that you have on
your computer.  

Toward the top, immediately to the right of the word Bar|Scan, the Version
number is listed, as above it appears as v3.4.2 2022-09-27 (YYYY/MM/DD)
format in US - other formats by County).  The version number is also listed on the
sign on screen.

Next, it lists whom the product is licensed to, and if the license if for a Single
User or Multiuser (LAN) system.  It lists the current user, and the company path. 
It then lists the different items that are available when the system is purchased,
and check marks are placed in the items that are currently on your computer.
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If you are using the bsyspath.bini file to maintain a local copy of the Bar|Scan
application files (for networks with speed issues), and you launch the local copy,
then the System Base Path will display the word ‘Redirected’ at the end of the
network path.

If not then ‘Exe path’ will be displayed. 

The left button ‘Program Folders’ provides information for technical support.

The last item listed on the bottom right of this window, is Current Users.  This
feature allows those with a Multiuser system to view who is logged into Bar|Scan
at any given time.  A sample is displayed below.

When you are finished viewing the information, simply press the Ok button, and
the window will disappear.
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The center button ‘Performance’ provides information for technical support. The
Throughput test should be performed in coordination with Bar|Scan technical
support.  There are settings that should be turned on prior to the test.

 

Bar|Scan, Inc. maintains a Knowledge Base section on our website to address
specific operational issues in a question and answer format.  The page is
accessible from the Support tab located on our main page www.barscan.com

Use Throughput as your Knowledge Base key word or contact us.
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OPENING A TABLE 

When on the Main Menu, you can select any table.  When you wish to see the
assets that are listed in your system, simply choose the File (Feature Category),
then Open  ...< (Feature), then Asset  ...<, then Assets as shown below.

Alternatively, you may click on the Asset icon, and the Asset table will open.

Recall that you can add or remove the icon names by selecting the View Menu
and selecting to view with or without captions.
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THE TABLES

When you have selected File, Open ...< Assets ...< Assets from the Main Menu,
or, if you have clicked on the Asset icon, the Asset table will appear.  It will be
similar to the one shown below.

If you have selected the Table Tool Bar to display under the View feature, then
you can simply select the Assets icon to open the above table.  The icon is shown
below.
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THE BROWSE AND EDIT TABS

There are two main tabs at the top of this screen, the Browse and the Edit tabs. 
The Browse tab is selected by default. This tab is used to view the list of items
from the table you have selected.  You will also want to use the Range feature on
this tab, selecting the items for your range(s) here.  

On the Asset table that is shown, there is a third tab, the UDF tab.  This item will
only appear if you have the optional User Definable Fields module, and have
added at least one field to that particular table.

The Browse tab displays a list of items that are in your system.  Use the scroll bar
to scroll through this list.  You may also type the first character of the item you
wish to view to help expedite your task.
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Allow Edits

The browse tab allows you to view all of the items in a particular table listed one
under the other.  The Set feature allows you to sort the items on the browse panel
by any field contained in the table.  So, you can sort the items on the browse panel
to view the different fields, and look for items that may need editing.  As shown
below in the partial panel, there is a field called Allow Edits.

If you left click on the box next to this field, you can make edits while still on the
Browse tab.  In some cases, this may be faster and easier than going to the Edit
tab.  Let us say, for instance, that during an audit, you noticed that the Serial
Number for the keyboard listed last on the partial panel below, had been
incorrectly entered.  You could place a check mark in the Allow Edits box, as
shown below, and correct this error without ever going on to the Edit tab.

After you have made your edit(s), you will need to Save or cancel your edits
before you can exit this panel.  The Allow Edits box is listed on all Browse tabs,
and works in a similar manner for each table.  

Note: Allow Edits will not allow you to make changes to the first column.
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Seeking

As well as allowing edits, the top of each browse panel has another very useful
item, Seeking, as shown below.

Seeking allows you to type, and have the system go to the item you type, if it finds
it.  For instance, FA0 was typed above.  The system will find the first “F” and
display it.  Then, the system will find the first “FA” and will display it.  Then, if
you continue to type, you will be shown the first item that matches what you type. 
What you type is shown is displayed by the word Seeking.

You have to be in the first position of the first column for this to work, in our
example that would be before the letter F.  For every character that was matched,
the highlight bar (dark blue) covers the items that it found that match.

Important:  If you have moved the highlight bar to the right by typing, the next
time you try the seeking feature, you may think you are in the first position when
in reality the highlight bar is somewhere to the right.  If you are in the first column
and you type, and the system can not find something that you know is in your
column, use your left arrow to move the highlight bar back to the first position
again.

Note: If you have sound on your computer, you can force Bar|Scan to make an
audible noise when it does not find an item that matches in Personal Program
Preferences under the Edit feature.
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When you have selected the item(s), you wish to view in detail, select the Edit tab. 
You will see all of the information which has been recorded and entered for this
particular item.  

The table shown is the Asset table, but all of the tables work in a similar manner. 

On the Edit tab, you may view all of the information listed in the table, and make
edits when necessary.
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The Tool Bar

The Tool Bar located at the bottom of each Panel is pictured below.

This Tool Bar is shown on the bottom of all of the panels.  But, a couple of the
Panels have additional items in their Tool Bars, i.e., the Report Panel has a printer
shown on its Tool Bar.  Each item in the Tool Bars have a balloon description that
will appear when you hold your mouse on top of it.
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THE ASSET TABLE

The Asset’s Edit Panel, shown when the Edit tab is chosen, has a few unique
features.

The Edit  Panel will provide you with all of the information that has been entered
pertaining to the asset shown.  This information will be broken up into groups. 
The available categories for these groups are represented by the nine tabs listed
below.

The first two tabs, Asset and Inventory, are available to all users.  The Asset tab
is displayed by default.  The rest of the tabs may be greyed out (not accessible)
depending on the optional module(s) that your company has purchased.
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The Asset’s Edit Panel provides many features to assist you in finding and
displaying particular assets or groups of assets.  You can add new assets, change
the information recorded for both an individual asset or a group of assets all at
once, remove assets, or view the different assets.

We expect that the majority of the asset information will be initially entered into
the system using the Mobile Computer (a much more automated process).  

However, you will determine how additions, changes, and deletions will be
handled, i.e., using the Mobile Computer or the Asset table.

To return to the Main Menu, use your mouse to click the X on the top right-hand
side of the Asset Panel, or press the ESC key.  Note, if you have pending changes
or additions, you will be prompted to save or cancel them first. 

Hyper Links

On the Asset table, as well as most of the other tables in your Bar|Scan system,
there are red words that are underlined.  These are called hyper links.  They are
mouse sensitive areas you can access to jump from the page you are on, to the
topic that is underlined.  These areas are linked, so that you do not have to
manually go to the other table. 

When you left click on the underline of the hyperlink, the item that was above the
underline can be viewed and/or edited.  Asset Table Hyper Links are shown.  
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BAR|SCAN MOBILE APPLICATION

Information recorded with the Mobile Device is transferred to the computer with
this feature.  When you want to synchronize your Mobile Device, Change the
Settings for your Communications, or add, change, view, or delete Transactions,
you will want to select Mobile Computer on the Main Menu.  From the Main
Menu, select File, then Open ...<, Handheld Computer...<, followed by your
choice of Configurations, Transactions, Synchronize or Advanced Settings as
shown below.
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Mobile Device Configurations

From the Main Menu, select File ...<, then Open ...<, Handheld Computer...<,
Configurations, you will be shown the following Browse panel.

Make your selection according to the type of Mobile Device that you will be
using, and whether you will be using a USB cable, wi-fi, cellular service or an
email for your upload.

When you select the type of communication that you need to configure, and select
the Edit tab, you will see the following Edit panel for TCP (transmission control
protocol) communication.
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This Edit panel will allow you to select options for the upload of your Mobile
Device.  The defaults for the items are selected for you, but this feature allows you
to change the Computer’s Communication settings if you have special
communications needs.

The communication settings for the TCP and old legacy serial and connection are
independent from each other and are changed separately.
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Mobile Device Transactions

When information is transferred from the Mobile  Device to Bar|Scan on your
desktop, it is put temporarily into the Transaction table, so it can be checked and
corrected before being transferred into the Asset table.

From the Main Menu, select File, then Open ...<, Mobile Computer ...<,
Transactions, you will see the Transaction Browse Panel as shown below.

This panel lists all of the Transactions that are found in your Transaction table.  

An alternative method to opening the Transaction table would be to click on the
Transactions icon, if you have your Table ToolBar displayed.  The icon is shown
below.
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Edit Transaction Tab

Bar|Scan does extensive error checking on the information in the Transaction
table.  When errors are found, messages are associated with the different asset
records in the Transaction table.

This feature is used to correct problems with the asset records before they are
transferred into the Bar|Scan Asset table.  In addition, duplicate asset records can
be removed and new asset records can be entered.

If you choose the Edit Tab, you will see the following panel which gives you
access to all of the details that have been entered concerning your Transactions.

The Transaction table Edit tab contains five tabs of its own, unique to the
Transaction table, as shown below.

Each tab contains additional information about your transactions.
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In addition to the additional tabs, the Transaction table also has additional items
on the tool bar.

The buttons illustrated above, are positioned on the Transaction tool bar as the last
buttons on the right.  

The first button shown here is for people that have the imaging module.  This
buttons will allow you to view the image that has been associated with the asset,
catalog, signature capture or other images associated with a Transaction.  

Sometimes, the image would be associated with the Catalog, as each Catalog
represents a unique item.  You may, however, have an instance in which you want
the Catalog to be “generic,” and show an image for each Asset that uses this
Catalog.  For example, if you have several paintings by the same artist, and their
Catalog descriptions are identical, you may want to display an image of each
Asset, and have all of the paintings use the same Catalog.  Signature Captures for
Transactions or Work Orders are also displayed as images

The next button is the Validate Selected Mobile Computer Transactions button. 
So, if you have the Transaction table open to the Browse tab, and you have used
the F4 Range feature to range transactions, you can use this button to validate only
those transactions which are part of your range.  Or, if you do not have any
transactions ranged, clicking on this button will validate all of the transactions. 

The next button shown here, is the Move Selected Mobile Computer Transactions
to the Asset File button.  So, if you have the Transaction table open to the Browse
tab, and you have used the F4 Range feature to range transactions, you can use this
button to move only those selected transactions to the Asset table.  
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Mobile Device - Synchronize

This feature is used to prepare Bar|Scan to receive information and then record the
information sent from the Mobile Device.  From the Main Menu, select File, then
Open  ...<, Handheld Computer ...<, followed by Synchronize and you will see the
following window.

Alternatively, you can simply click on the Sync Handheld Computer icon if you
have your Import ToolBar displayed.

  

Depending on your Mobile Device, the information can be sent either through a
USB cable connected directly to the Mobile Device and the desktop computer, or
remotely by using a Wi-Fi connection, cellular service or an email account.
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There are 6 steps listed on the panel for beginning your first Configuration.  Once
you have completed these steps, Bar|Scan remembers your settings.

If you need to synch using a different configuration, or to select a different model
of Mobile Device,  select the down arrow next to the connection field, and you
will see a drop down menu that lists more connection choices as shown in the next
example.

For more information, see the instructions in Chapter 11, Bar|Scan Mobile.

Print Transaction Table

Before you can move any of the Transactions to the Asset table, you will be
required to print a report showing the asset records which have been transferred. 
This report serves as an audit trail for the new entries.

The report is also used to assist in correcting any errors occurring in the
transferred information.  This feature is accessed as part of the Reports table,
under Transaction Reports.

Note: You should validate all Transactions before printing them for the first time,
and validate again after any changes you make.

Page 4-38 Bar|Scan



Chapter 4

The Transaction Feature

When you open the Transaction table, and have it highlighted as the current table,
the word Transaction will appear as an additional Feature on the Main Menu. 
This feature is illustrated below.

When you click on the word, Transaction, you will see a drop down menu as
illustrated above.  This drop down menu will allow you to use several additional
items: Move, Validate, Range Duplicates, Adjust Duplicate Inventory Times, and
Remove Trailing Check Digits.
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Move (All or Selected Transactions)

Once an asset record has been validated for accuracy, the errors have been
corrected, and the information appears on a Transaction Report, it is ready to be
moved into the Bar|Scan Asset table.  This feature only moves the good (and
printed) asset records into the Bar|Scan Asset table.

You may select either Move All (good transactions) or Move Selected (good
transactions).  

To select only some of your transactions: select a Range of transactions while on
the Browse Tab of the Transaction table, and then choose the Move Selected good
transactions option as shown above.  

Once this feature has been selected, Bar|Scan will gather the information on the
transactions, and you will be shown a window that will allow you to start the
move process by selecting Begin.
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Validate (All or Selected Transactions)

Bar|Scan does extensive error checking on the information in the Transaction
table.  Validation is the term used for this error checking process.  When errors are
found, messages of each error type are associated with  their corresponding
records in the Transaction table.

This feature performs the actual validation, and if any errors are found,  messages
will be placed as part of the actual transaction, under the Problem Handlers tab.

 

You may need to validate the same transaction more than once, and you should
validate the Transactions after you have made all edits.  Once an asset record has
been validated, all of the errors must be corrected.  The easiest way to view these
errors, is to print a Transaction Report showing all of the “Bad” transactions, with
the actual error message(s) printed on the report.  Then, you may use this report
to determine what changes need to be made, and make these changes in the
computer.

Once the errors have been corrected, and the corrections have been saved, the
transactions have to be validated again, then printed out as a Transaction Report
again.   When all of these steps have occurred, the transactions are ready to
become Assets.
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Range Duplicates

From time to time you may upload a Mobile Computer that has had part or all of
the information in it uploaded before.  For instance, you upload a Mobile
Computer with 50 assets in it, and set it down.  Someone needs to use the Mobile
Computer, and comes up and takes it.  They inventory five items with it, and then
bring it back to you so that you can upload it.  The Mobile Computer now has 55
assets in it, and 50 of them have been uploaded before.

Upload the Mobile Computer as normal, checking to ensure the information goes
into the Transaction table, like normal.  Validate the transactions.  Make sure that
you do not have any transactions ranged.  Once the validation has been done, go
to the Transaction feature, and select Range Duplicates.  Immediately all of the
transactions are compared to each other, and  any “EXACT” duplicates will be
ranged for you, and you may safely delete them.

Any items that are duplicated that are not EXACTLY the same, will not be
ranged.  Therefore, it is safe to simply delete any items that are ranged with this
feature.  

This feature only checks for one duplicate.  This means, if you have uploaded part
of a Mobile Computer three times, the third duplicate will not be located.  So, if
you think there is a chance that you have uploaded any of the transactions a third
time, simply wait until you have used the Range Duplicates feature, and have
deleted those that were ranged.  Then, validate the transactions again.  Again
select the Range Duplicates feature.  If there are any items ranged for you during
this process, it is safe to delete them.
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THE CATALOG TABLE

The Catalog feature permits you to precisely define and describe each different
type of asset.

When wanting to view, add, change, or delete Catalogs, go to the Main Menu
select File, then Open ...<, Catalog ...<, then Catalogs as demonstrated in the panel
below.

System Overview Page 4-43



System Overview

The Catalog Browse Panel lists the Catalogs that have been entered into your
system.  The Edit Panel permits you to assign and define the different catalog
entries by adding to, changing, or deleting Catalogs.  The Catalog Edit Panel is
shown below.

Bar|Scan provides several different ways to define and describe different types of
assets.  First, there are predefined groups of assets identified by a two-character
Category (the first two characters of the Catalog number).  Next, a Type and
Description are entered.  

You can further define an asset type by entering the dimensions and/or a
Manufacturer.  Finally, you may enter more Manufacturer information, and 
attributes.
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Just how precise you want your Catalog entries, is entirely up to you.  You can
assign a Catalog Number which will be less precise and cover a relatively large
number of assets or more precise to cover a lesser number of assets.

To return to the Main Menu, use your mouse to click the X on the top right-hand
side of the Catalog Panel, or press the ESC key.  Note, if you have pending
changes or additions, you will be prompted to save or cancel them first. 

Next to the undo button on the tool bar, there is a small button as shown below. 

If you have the Imaging Module, this button is used to view the images that you
have in your Company Asset Database.  After you have uploaded the digital
images, you can click on this button to view them.  

You may print the images as part of your Catalog Reports, by adding this item as
a column.  Note: The image size defaults to one square inch in size, but you can
adjust the size to suit your own needs.
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THE LOCATION TABLE

This feature is optional in that Bar|Scan does not require the information to be
entered into the system.  However, we recommend you use this feature.  It will
provide you with the ability to produce reports for individual locations of assets.

In order to properly define the particular physical location for each different asset,
you will have to identify your company's location structure.  This is usually
entered from an existing floor plan, but can also be a future floor plan, or imported
from an Excel file, CAD drawing or database.

Also entered, is a reference to the Organization Code for that particular location. 
Please note that Organization Codes must be entered in the Organization table
before they can be referenced in the Location table. 

This feature permits you to enter several different levels of locations within your
company, as well as three different types of locations.  A bar coded room tag can
also be assigned to each location to simplify the re-inventory of your assets.  The
bar coded room tag can be linked to the location during the inventory with the
Mobile Device, and does not have to be entered in advance of the inventory.
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When you want to add, change, view, or delete Locations to be used in your
Company Asset Database, you will want to open the Location table.  From the
Main Menu, select File, then Open ...<, Locations, you will see the Location table. 
The Browse Panel is shown first, which shows all of the items listed in your
Location table.  

Alternatively, if you have opted to display the Tables ToolBar, you can click on
the location icon to open the above table.  The icon is shown below.
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Select the Edit tab, and you will see a panel like the one below.

This panel displays the information which has been recorded and entered for each
individual location level and optional bar code room tag.

You can add, change, delete, or view the Location Structure and the referenced
organization structure.

To return to the Main Menu, use your mouse to click the X on the top right-hand
side of the Location Panel, or press the ESC key.  Note, if you have pending
changes or additions, you will be prompted to save or cancel them first. 
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There are three types of locations: site, pallet, and vault.  When you select a
location type other than site, you will see that the location field names change as
shown below.

Notice that on this table, we chose Pallet as the location type.  The field names are
now listed as: Building, Row, Bay, Slot, and Level, instead of the Region,
Building, Floor, Room that are listed for the Site type of location.  The fields will
again be different when Vault is the type of location that is selected.  They will
change to list Building, Vault, Row, Bay, and Level.
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THE ORGANIZATION TABLE

This feature is optional in that Bar|Scan does not require the information to be
entered into the system.  However, we recommend you use this feature.  It will
provide you with the ability to produce reports for individual divisions,
departments, and units.  In order to properly define the particular department or
group which has responsibility for, and/or possession of each different asset, you
will have to identify your company's organization structure.  This feature permits
you to enter the names you wish to use to define three levels of organizations
within your company.  A code is assigned to simplify the recording of the
Organization Structure.

When you  want to add, change, view, or delete Organizations for your Company
Asset Database, you will want to open the Organization Panel.  From the Main
Menu, select File, then Open ...<, Organizations, you will see an Organization 
Panel.  The Browse Panel is shown first, which shows all of the items listed in
your Organization table. 
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Alternatively, you can select the Organization icon to open the panel shown
above, if you have the Table ToolBar on your Main Menu.  The Organization icon
is shown below.

Select the Edit tab, and you will see a panel like the one below.

This screen  displays the information which has been recorded and entered for
each individual organization level and code.  You can add, change, delete, or view
the Organization Codes and the information assigned to the Codes.

To return to the Main Menu, use your mouse to click the X on the top right-hand
side of the Organization Panel, or press the ESC key.  Note, if you have pending
changes or additions, you will be prompted to save or cancel them first.

Alternatively, if you have opted to display the Tables ToolBar, you can click on
the Organization icon to open the above table.  The icon is shown below.
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THE PERSONNEL TABLE

This feature is optional in that Bar|Scan does not require the information to be
entered into the system.  It will provide you with the ability to produce reports for
individuals.  In order to begin, you will need to key or inport your personnel list.

When you  want to add, change, view, or delete Personnel for your Company
Asset Database, you will want to open the Personnel Panel.  From the Main Menu,
select File, then Open ...<, Organizations, then Personnel.  The Browse Panel is
shown first, which shows all of the names listed in your Personnel table.
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Select the Edit tab, and you will see a panel like the one below .

This screen displays the information which has been recorded and entered for each
individual person.  You can add, change, delete, or view the Personnel detailed 
information assigned to each person.

Alternatively, if you have opted to display the Tables ToolBar, you can click on
the Personnel icon to open the above table.  The icon is shown below.

 

To return to the Main Menu, use your mouse to click the X on the top right-hand
side of the Personnel Panel, or press the ESC key.  Note, if you have pending
changes or additions, you will be prompted to save or cancel them first. 
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THE REPORT TABLE

When your Bar|Scan system arrives it will already contain many  reports that were
previously created and are labeled as System reports.  There are several different
purposes for the reports provided.

When you  want to add, change, view, or delete Reports in your Company Asset
Database, you will need to open the Report table.  From the Main Menu, select
File, then Open . . . <, Reports . . . <, followed by the type of report that you wish
to see.  If you wish to view all of the reports that are contained in your Company
Asset Database, you will want to select All as the type of reports you wish to view
as shown below.

When you have selected the items in the above panel, you will be shown the
Report Browse Panel, which shows all of the items listed in your Report table.
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You can also use the shortcut icons to open any of the reports.  To place report
icons onto your Main Menu, go to the Main Menu, then select View, then
Toolbars, then Report Toolbar.  The following icons will appear on your Main
Menu.

The icons shown above are shortcuts to the various types of reports.  Simply
pressing on the respective icon will allow you to go directly to that type of report. 

You will be shown the Reports Browse panel where you may select the specific
report that you wish to view.
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Select the Edit tab, and you will see a panel like the one below.

Notice the nine tabs for this panel.

These tabs represent the processes that make up a report.  What Tables the report
is based on.  What the reports are ordered by, filtered by, which columns are going
to print, if you need to have a column break on or a page break on, the layout of
the report, the header for the report, a title page for the report, and anything
involving the printing of the report.  Also, notice at the far right of the tool bar is
a printer and a preview icon as shown below.  These last two buttons are the
buttons that you will be using to print and/or to  preview your reports.
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Asset Reports

When you select this feature, you will be presented a Menu containing all of the
different Asset reports currently contained in the Bar|Scan system.

These reports will provide information about the assets currently recorded in the
system.

You can create a new report, change an existing report, remove an existing report,
or view the structure of an existing report.

Catalog Reports

This feature prints either a single page for each Catalog Number currently
contained in the Bar|Scan system, or a complete listing of the Catalog numbers
currently contained in the Bar|Scan system.

The purpose of the single Catalog Sheet is to permit you to create a Catalog book
which is portable and can be used when recording new asset information using
either the Asset feature, or the Mobile Computer.

The Catalog List is intended to be used with the Catalog book as a quick reference
to the Catalog book, and as a reference guide when recording new asset
information using either the Asset feature or the Mobile Computer.

Location Reports

This feature can print a bar coded location report to assist inventory personnel in
conjunction with the mobile computer during the course of the physical inventory.

Organization Reports

This feature prints a list of your organizations within your company currently
contained in the Bar|Scan system.
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Transaction Reports

A Transaction Report is required each time you transfer information from the
Mobile Computer into the Bar|Scan system in order to provide an audit trail.

Personnel Reports

This feature prints a list of your personnel within your company currently
contained in the Bar|Scan system.

Work Order Reports

When you select this feature using the PRINT mode, you will be presented a
Menu containing all of the different Work Order reports currently contained in the
Bar|Scan system.

These reports will provide information about the work orders and their associated
assets currently recorded in the system.

Work Orders are special reports in that they are disbursed and used for processing
activity associated with the Work Order Module.  They are not normally part of
management reporting.

You can create a new report, change an existing report, remove an existing report,
or view the structure of an existing report.

Location History Reports

When you select this feature using the PRINT mode, you will be presented a
Menu containing all of the different Location History reports currently contained
in the Bar|Scan system.

These reports will provide information about the location history of the assets
currently recorded in the system.

These reports give a different perspective on your assets and are especially useful
to report on turnover or movement.
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You can create a new report, change an existing report, remove an existing report,
view the structure of an existing report. 

Miscellaneous Reports 

There are a few types of reports that you may want to add to your company that
do not fit the traditional categories, therefore, a Miscellaneous category is
available.

Miscellaneous reports include colors, material files, condition and status codes,
ownership type, and attribute categories.

Miscellaneous reports can also be used to print bar code tags on Avery Label
stock.

ANY Table in Bar|Scan can be used for a report including the User Password
Tables.

All Reports 

All reports will be presented.
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SETS

Set is a powerful feature of Bar|Scan.  It allows you to order, filter, and display
any field in your database.  You can add customized Sets to perform extensive
review and editing quickly.  Review the Set capability carefully, it will be your
most effective edit tool.  

When you sort any of the information in any of your tables, you will be using the
Set feature.  You can access the Set feature from the tool bar on any panel, or from
the Main Menu, simply select File, then Open ...<, Sets, and you will be shown the
Sets Browse tab, as shown below.

Notice the two letters at the far left side of this list.  These letters represent the
table that the set is made for, i.e., AS is the abbreviation for the Asset table. 
When you select the Set feature from the Main Menu, you will be able to scroll
through all of the sets that you have in your Bar|Scan system.
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Select a set from the Browse tab, and then select the Edit tab, and you will see a
tab like the one below.

On this tab, you can add, change, save, and Generate a Set.  On the set shown
above, the word in the top left corner, is Asset, signifying that this particular set
is from the Asset table.  The set has Asset number listed as the item it is going to
sort by.  So, if you are looking at your Asset table, and you want to sort by Asset
number, this is the Set you would choose.

This Set feature is used extensively throughout Bar|Scan, and you should
familiarize yourself with its features.
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TABLE PROPERTIES

In order to select the properties of your tables, there is a Table Properties table. 
When you need to access this feature, go to the Main Menu, select File ...<, Open 
...<, Table Properties, and you will see a Browse Panel like the one below.
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Select a table from the ones shown on the Browse tab, and then select the Edit tab,
and you will see a tab like the one below.

On this tab, you may select fields that will be logged, decide if you are going to
allow imports, exports, or reports on this logged information.  You may add,
Change, or Delete the fields to be logged.  For more information on this feature,
please refer to the Import/Export chapter of this User Manual.

Also, by selecting the Directory Name field, you can specify where the
information is stored.  You may select to store the information in the Company,
or in the SysUser directory.  By storing the information in the Company, only that
Company can use the information.  By storing the information in the SysUser
directory, you are sharing the information with any other Company that also stores
their same table in the SysUser directory.  
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USER

The User feature is where all of the information for those using Bar|Scan is stored,
and edited.

It can only be accessed if you are a “Master User”.  To access this feature, go to
the Main Menu, select File <, Open <, Users.  If you are not a Master User, this
option will be greyed out and not accessible.

When you have opened the User Table, you will be presented with a Browse tab
as shown below.  It contains all your Bar|Scan User Passwords.

Select the initials that you wish to edit, and then select the Edit tab.

When your Bar|Scan system is first installed, the only user initials and password
that are installed are Mas, Master.  As shown here, this is the only set of User
initials listed, simply select these initials, and then select the Edit tab.
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As shown below, Bar|Scan has Basic Encryption available for the User ID, User
Name, and Password fields.  If used, these fields are stored in encrypted format
within the User Table.

This panel lists the user accessible tables in Bar|Scan alphabetically and the
available functions so that you may limit what information users can access
according to their User ID and Password.  

This is a comprehensive feature which allows you to limit the functions of a given
user so that they can, for instance, be able to view Assets, but they cannot make
changes or delete any of them.

Only a Master User can access this table, otherwise the word User on the Open
drop down menu appears “greyed out” and cannot be selected.

To the right of each Table name are the functions ‘Add’, ‘Change’, ‘Delete’, Set’
plus a few additional functions.  Here is what they do:
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‘Add’ – allows the user to add a new item either at the keyboard by using the
‘Add Blank’ Function or the ‘Add Template’ function.  It does not allow the user
to add new items by importing or adding from a Mobile Computer.

‘Change’ – allows the user to change any field on any existing item.  You can
limit the fields that the user can change on the “Protected Fields” tab.

‘Delete’ - allows the user to delete any item at the keyboard.  If you are using
Activity Logging, a record of the deletion is created when the user deletes the
item.

‘Set’ – allows the user to use the Set feature to reorder the items on the Browse
panel.  It is usually a good idea to check this even if you do not wish to allow the
user to edit or delete the item.  This gives the user more flexibility in viewing
items.

‘Move’ – allows the user to move items from the Asset Table to the Asset Table
of another company, e.g. “Salvage Company” and/or move items from the
Transaction Table to the Asset Table.

‘Begin’ – this option is only available in the Batch Operations feature of Bar|Scan. 
It allows the user to begin a Batch process.

Here are several important functions within the Company Work Area:

‘Open’ - allows the user to open a Single Company database provided the
Company is placed on the ‘Allowed Companies List (Companies Tab) OR not
placed in the ‘Denied List’.  This option should always be checked except under
special circumstances such as in combination with ‘Select’ below.

‘Select’ – allows the user to select one or more companies that have already been
opened.  Checking this option off is a quick way to keep a user in only one
Company.

‘Index’ – allows the user reindex after a problem has occurred on the hard disk. 
See Chapter 13 “Housekeeping” for more information on this function.
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‘Pack’ – allows the user to condense the data files.  See Chapter 13
“Housekeeping” for more information on this function.

‘Rename’ – allows the user to rename the Company Database.   Normally only
the Bar|Scan Administrator should rename a company since Bar|Scan remembers
the last Company name on a log-in.  This could also have an undesirable effect if
you are using the Bar|Scan HTML viewer or have other internet access to
Bar|Scan.  See Chapter 17 “Multiple Company” for more information on this
function.

‘Restructure’ – allows the user to Restructure the Company Database.  Normally
only the Bar|Scan Administrator should restructure a company since it can only
be performed when all other users are logged out. This function should always be
performed after adding or changing a UDF (User Defined Field) as well as after
installing a Bar|Scan upgrade.  See Chapter 13 “Housekeeping” for more
information on this function.

‘Synchronize’ – allows the user to access the Company Syncronization feature. 
Normally only the Bar|Scan Administrator should access this feature since it is an
advanced option.

’Key Field Widths’ - allows the user to change the length of special key fields in
Bar|Scan.  Normally only the Bar|Scan Administrator should access this feature
since it is an advanced option.
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The second tab of the User table will look similar to the one below.

As shown above, this panel continues to list some of the tables in Bar|Scan and
the available functions so that you may limit what users can access according to
their User ID and Password.  
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The third tab of the User table will appear similar to the one below.

As shown above, this panel lists some of the work area in Bar|Scan and the
available functions so that you may limit what users can access according to their
User ID and Password.

Here are several important functions within the Reports Work Area:

‘Print’ – allows the user to print (or export data such as an Excel file) reports.

‘Lock’ – allows the user to Lock and unlock reports.  Normally only the Bar|Scan
Administrator should Lock/unlock a report since reports, once correctly created
should not have to be changed.

‘Company List’ – allows the user to access one or more separate Bar|Scan
Company databases for joint reporting.

System Overview Page 4-69



System Overview

Here are several important functions within the Work Order Area:

‘Set allowed Work Order screen forms’ – allows the user to change the allowed
Work Order screens on the Company Settings Panel.

‘Auto Add New Work Order when Work Order is Saved’ – Adds a new blank
Work Order after the user presses save.  This eliminates the additional step of
pressing the Add Blank or Add Template button.

The fourth tab of the User table will appear similar to the one below.

This tab allows you to protect selected fields from a user according to their User
ID and Password.

Page 4-70 Bar|Scan



Chapter 4

Near the top, advanced users will want to check "off" the feature "Force User to
Save or Cancel newly added items before adding another.  This will increase the
speed of repetative data entry.

On the Left Side, you can select any field in Bar|Scan to add to this list.  Once
added, the field is “greyed out” on the appropriate panels and the data can be
viewed but not edited.  Tip: You can use the Windows Control key and Shift key
combinations to highlight a group of fields from the Pop-up selection to speed the
entry of items into this list.

On the Right Side, you can select how any field in Bar|Scan can be accessed.  For
example, you can limited access to choices displayed in a Pop-up selection.  This
could be useful to control data entry.

For example, you might want the User to only choose existing General Ledger
Numbers from a Pop-up selection and not allow the User to create their own.  Tip:
You can use the Windows Control key and Shift key combinations to highlight a
group of fields from the Pop-up selection to speed the entry of items into this list. 

The fifth tab of the User table will appear similar to the one below.
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This panel allows you to limit who can import and export data, and who can edit
the formats for imports and exports.  It displays three sections.  Here is what each
of them does:

‘Allow Import’ – allows the user to import data into Bar|Scan from three sources. 
A Data Transfer File is used to move information from one Bar|Scan system to
another.  Formatted data is usually used to communicate with other applications
such as Excel.  Mobile Computer uploads and file imports are files generated by
the Mobile Computer.

‘Allow Export’ – allows the user to export three different ways.  Note: Bar|Scan
can also export in other ways such as the Report Generator.

‘Formatted Import/Export’ – allows the user create new or edit existing
Formatted Import/Export Instructions.  Normally only the Bar|Scan Administrator
should access this feature since it is an advanced option.

The sixth tab of the User table will appear similar to the one below.
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This tab lists the last company that the User ID had accessed, and the date and
time of the last access.  Towards the bottom, you have two areas that allow you
to enter a list of companies that the user is denied or allowed access to.  You do
not have to fill out both of these areas.  For instance, if the user should have
access to all but one company, list one company in the denied companies box.  If
the user can only get to one company, list one company in the allowed companies
box.

You complete the section by selecting the Browse button on either the Denied or
Allowed List, or both.  The Company Code (not the Company Name) will be
inserted into the list.  You can also type the company codes in separating each by
a comma.

Normally only the Bar|Scan Administrator should access this feature since it is an
advanced option.

The seventh tab of the User table will appear similar to the one below.
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This panel allows you to limit which assets or work orders a person will be able
to view or access.  For instance, if you only want them to be able to see assets
from a current location, you can add a filter for current location equal to that
location.

Filters can be useful when you have different trades generating Work Orders.  For
example, you may have Installers and Help Desk personnel creating Work Orders
but there would be no need for them to see each other’s Work Order.

Filters can make it appear that Bar|Scan is operating slower.  This is because it
may take more time to display the appropriate filtered information on the Asset,
Work Order or Transaction screen.

You can use the Report Tab in association with the Report Group Field on the
Report Screen to control what reports a person will be able to view or access.
The Report Group field is a freeform field which has many possible uses.  It is not
linked to other Tables and it has no special formatting, therefore it can easily be
used as a filter.

So, data entered in the Report Group field in the Report Screen can be coupled
with a User Table filter.  For example, Users can be restricted to seeing only those
reports that match the User’s report filter.  Since the Report Group does not
actually contribute to the report itself, but rather is used to classify a report, it can
be used as a user filter no matter what the contents of the report are. 

Conversely, let us say that the Bar|Scan administrator wants to set up private
reports, in other words, the administrator wants individual users to be able to
create reports that no one else can see but they want everybody to be able to see
system and shared reports.  The Report Group field might be used for this.

Normally only the Bar|Scan Administrator should access the Table Filtering
feature since it is an advanced option.
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The eighth tab of the User table will appear similar to the one below.

This panel allows you to enter a default value for the Requested by or the
Destination locations for the Work Order table.  If the Destination is almost
always one location, you should enter that location here, and each time a work
order is made, the default location will appear.  The default can be changed by the
person creating the work order.

Normally only the Bar|Scan Administrator should access this feature since it is an
advanced option.
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The ninth tab of the User table will appear similar to the one below.

Account Management is used for advanced control of your User's passwords.

Here is Microsoft’s explanations for the various fields.  You can review these
explainations yourself by opening the Panels in your Computer’s Control Panel->
Admin-> Local Security Policy.   Then select the policy then select ‘Properties’.
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Max Password Age. <=Zero means no age limit.  Below is Microsoft's policy:
 

Minimum Password Age, except there is no password history enforcement. If the
value is <= zero (0) then it can be changed right away.  Below is Microsoft's
policy:
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‘Warning Period to change Password’ – 0 = disabled. If larger than zero gives
a warning prior to expiration of current password the designated number of days
ahead of time.

‘Minimum Password Length’ – 0-99  Required Length of password (not
implemented in version 2.8.1).

‘Password must be complex’ – If checked, the password must be at least 6
characters long, have at least one alphabetic character (A-Z), have at least one
digit (0-9), have at least one special non alphanumeric character (e.g. !$#%) and
not contain the users initials.

The Lockout Policies tab is displayed below.

‘Required Wait time after Lockout’ –If the user exceeds the maximum allow
login attempts, then his account will be locked the number of minutes specified
in the Required Wait Time after Lockout. Once the time has been passed, they can
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attempt another login. Zero (0) keeps the account locked until the administrator
unlocks it. Negative values allow immediate retry on the login, any other positive
values specify the amount of time to wait in minutes.

‘Time Login Count Remembered’ –If a user attempts to login and has at least
one failure and decides to abandon the attempt before being successful, the
number of attempts that have been made so far will be remembered for the amount
of time specified. If they try to login before the time is expired, the number of
attempts so far is remembered and the count continues from the last one made.
Once the time has elapsed, then the number of attempts so far is reset to zero.
There is no time limit on attempts value is <=0.

‘Max Allowed Login Attempts’ –The maximum number of tries allowed in one
session before the account is locked. Depending upon the ‘Required Wait Time
after Lockout’, the user may either be able to log in once the specified amount of
time has elapsed, or they may be permanently locked out until addressed by the
administrator.

When the user enters an incorrect password  for more than the maximum number
of login attempts, the password is disabled and the user is locked out.  The user
will be shown the following screen:

‘Account Inactivity Lockout’ – 0 = no inactivity lockout. If the account is not
used within the specified number of days (i.e., nobody logs in), the account is
automatically locked out until unlocked by the administrator.

‘Manual Lockout’ – The user is locked out until the check mark is cleared.

'Reset Lockout to allow User to Login' - This is used to unlock the user so that
the user can log back in.  It does not reset the parameters.
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The User Rights tab is displayed below.

‘Batch Login Allowed’ – This controls the ability for the User to login using the
Bar|Scan Scripting Feature.

‘Local Login Allowed’ – This controls the ability for the User to login using the
Main Bar|Scan Application.

‘Remote (SmartClient) Login Allowed’ – This controls the ability for the User
to login using the Bar|Scan SmartClient Application.
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The Login Status tab is displayed below.

Here is an example of how you can use this tab.  You can force someone to
change their password by setting the maximum password age to the standard
desired value, then changing their date of last login to one day before that. For
example, if the standard age is 42 days, select a date at least 43 days ago then
change the field ‘Password Last Changed (UDT)’ to reflect the date 43 days or
more ago.

System Overview Page 4-81



System Overview

The Single Sign on tab is displayed below.

You can bypass the Welcome Screen by optionally using the Single Sign On
feature.  Using Bar|Scan Single Sign On (SSO), the Bar|Scan Login is replaced
with your current authenticated Windows or Active Directory account.

Single Sign On (or SSO) implementation is via an addition to the User Screen
under ‘Account Management’. Within this screen are three fields. Field “SSO
Allowed” enables/disables the function for the current user of the screen., “SSO
User ID” is basically the Windows User ID used to log in to Windows, and “SSO
Domain” is the Active Directory of the user.

For SSO to be active, both the ‘SSO Allowed” must be checked ‘on’ and the ‘SSO
User ID’ field must be filled in with the user’s id. The ‘SSO Domain’ name is
optional. It is only needed if managements wants to specify that this particular
user must also be a member of the specified Active Directory Domain. 
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WORK ORDERS

The Bar|Scan Work Order Module allows you to place work orders for various
assets either specifically, by asset number, or generally, by catalog description. 
Each Work Order has a unique number, the name and telephone number of the
person placing the order, the name of the crew assigned the task, the division,
department and unit to charge, deliver to location, and notes/instructions regarding
the order.

As the work order is filled, each asset is scanned with its related Work Order
Number using the Mobile Computer.  When this information is uploaded to
Bar|Scan and moved to the asset file, it updates the Work Order status identifying
what portion, if any, is still incomplete.

From the Main Menu, select File, then Open  ...<, Work Orders as shown below.
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Alternatively, you can open the Work Order table by clicking on the Work Order
icon if you have the Tables Toolbar on your Main Menu.  The icon is shown
below.

When the Work Order table opens, the browse tab is displayed by default, and will
look similar to the one below.

As shown above, the Work Orders Browse screen contains a list of all of the
Work Orders that have been put into the system.

On this panel you can select which Work Order you want to view, change, use as
a template (although you can add a Work Order from a blank as well), or delete. 
Once you have selected a particular Work Order, click on the Edit tab to view the
details.
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Select the Work Orders Edit Tab and you will be shown a panel similar to the one
below.

Note that this Work Order Edit Panel has seven tabs of it’s own.  The Master Tab
is defaulted to open.  The Requested By and Deliver To tabs show where an item
was requested from and where it is going to.  The Instructions/Notes Tab is for
miscellaneous instruction notes.  The Batch Tab is for interfacing with a
Maintenance Management application.  The Bill of Materials tab is when linking
reserved assets.  The last tab is for perparing Service Orders (or detailed work
processing) for the mobile computer.

Line Items are shown at the bottom of the Master tab.  To add line items, the user
presses the Add Blank or Add Template button.  The system will automatically
supply a line number.  There are two basic types of line items which can be
entered -- a quantity of items, by catalog or a specific asset, by asset number.  The
system completes the catalog number field when a specific asset number is
selected.  You may select line items by catalog or specific asset.  You may also
select both on the same Work Order.
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As the work order is filled, each asset is scanned with its related Work Order
Number using the Mobile Computers.  When this information is uploaded to
Bar|Scan and moved from the transaction table to the asset table, it automatically
updates the Work Order Line Items table identifying what portion, if any, is still
incomplete.

When items are requested by quantity and catalog number, the system compares
the asset scanned to the line items by catalog number to determine which line item
to update.  The system then checks whether the current location matches the
deliver to location on the Master Work Order panel.  If it matches, the system
increases the Quantity Received total by one and if the Quantity Received matches
the Quantity Requested, it updates the line item as Complete.

This Display Screen shows that both line items are complete.  When all line items
are complete, the Work Order is ready to be closed.

When items are requested by specific asset number, the system simply compares
the current location of the asset to the deliver to location on the Master Work
Order Screen.  If they match, the system increases the Quantity Received to one
and updates the line item as complete.  If the location does not match, it increases
the Quantity Reserved to one and the line item remains incomplete.

This Display Screen shows that both line items are complete.  When all line items
are complete, the Work Order is ready to be closed.

Once all line items are complete, Bar|Scan will update the Work Order panel as
complete (Y) and will also show a Completed Date.

Bar|Scan also allows you to identify which Work Orders have been printed.

Like all modules with Bar|Scan, reports can be generated ordered or filtered by
any of the data elements contained within the Work Order Module.

In addition, some custom reports have been added to the Work Order reports.  The
custom Work Order Reports can not be changed or used as a template, but can be
printed out.
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RESERVED BILL OF MATERIAL

The Reserved Bill of Materials is optional.  A Work Order does not require the
use of the Reserved Bill of Materials.

The Reserved Bill Of Material is used so that assets will not be available for use
to build other groups or be moved to other locations.

TEMPLATES

The Templates table is where repetitive Work Orders are created and saved for
use.  For example, if machine needs annual maintenance or a delivery of supplies
is made weekly, you should use this feature to avoid reentering the same Work
Order more than once.
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THE COMPANY FEATURE

There are several features listed when you choose File ...<, Company, as shown
below.

Using this feature, you can make a new company database, open a company, close
a company, save the company, rename a company, select a company, search for
a specific field in any of your companies, or access the Housekeeping features.
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HOUSEKEEPING

When you need to access any of the Housekeeping features, select File ...<,
Company ...<, Housekeeping from the Main Menu, as shown below.

Housekeeping items control and affect the overall operation of the Bar|Scan
System.  In most cases, these items are only selected occasionally, and are briefly
discussed on the following pages.
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Table Integrity 

There are ten items listed on the Housekeeping drop down menu.  If you select the
first of these items, Table Integrity, you will see a window similar to the one
below.

The use of this screen and the Advanced Settings button shown above are
discussed in detail in the Housekeeping chapter of this User Manual. 

When you add a new company, and sometimes when you upgrade to a newer
version of Bar|Scan, you will have to access this table, select all of the  companies
on your system, and then select OK. 
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The Table Integrity (combination of Restructure and Reindex) is a maintenance
function that should be performed regularly.  Bar|Scan will periodically remind
you, if you are designated a Master User, when you  access the application.  

The functions should only be performed when there are no other users accessing
Bar|Scan.

You can check for other users' access by selecting Help ...<, About Bar|Scan for
Windows ...<, Current Users. 

Important: You should always peform a Table Integrity when restarting Bar|Scan
if your server unexpectedly powered off or you received a Bar|Scan error screen
such as the following example.
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When you click on the Advanced Settings button you will see a window similar
to the one below.

Restructure

This feature should only be selected by someone experienced in the operation of
the Bar|Scan system who is famliar with the normal housekeeping functions or
when there is an indication that there may be a problem with the system.

These features are also selected to update your data files after you receive and
install a program update or after you add, change or remove one or more User
Defined Fields (UDFs).

In either case, use of this feature is not required for day-to-day operation of your
Bar|Scan system.
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Pack

Do not do a pack if you are having other serious problems, contact Bar|Scan,
Inc. first for technical support.

This process is used internally by Bar|Scan.  You will not notice any difference in
the operation of Bar|Scan after you select this item (with one possible exception;
it may run faster).  Bar|Scan will notify you when it recommends a Pack.  It is
not necessary to perform a Pack right away but Bar|Scan will continue to notify 
you until the pack is completed successfully.

You will need to use the Pack feature as a regular part of your maintenance of
Bar|Scan.  You will be moving assets from the Transaction table to the Asset
table.  When you delete or move items that are stored in your Bar|Scan system, a
“copy” is first made of the item, and stored in the system.  This item is not visible,
but can be restored by a Technical support person, if necessary.  

This operation instructs Bar|Scan to eliminate the invisible copies of records that
have been moved or deleted.  

After selecting one or more companies on this table, you will need to select the
Pack operation.  

From time to time, you will want to select this item to permit Bar|Scan to remove
excess information and condense the data files.

ReIndex

This process is used internally by Bar|Scan.  You will not be able to see any
difference in the operation of Bar|Scan after you select this item.

Whenever something happens to lock up the computer, or you experience a power
failure, you will want to select this item to allow Bar|Scan to fix itself.  

From time to time, you will want to select this item to permit Bar|Scan to verify
that everything is correct and fix any problems.
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Refresh Tab

The items listed under Refresh are checkmarked to be refreshed only when you
have specific problems with tables.

Initialize Tab

This item replaces blank Organization Codes with the referenced Organization
Code from the Location table.  See Chapter 9, Location Table, in this User
Manual for more information.

Miscellaneous Tab

The items listed under Miscellaneous are checkmarked only when you have
specific issues or problems.  Please consult your Bar|Scan representative before
selecting these operations.  There may be times when you should not perform
these operations.

For a full description of the items listed please see Chapter 13, Housekeeping, in
this User Manual.
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Set Transaction Validation Messages

The next item in the Housekeeping drop down menu is Set Transaction Validation
Messages.  When you select this item, you will be shown a table similar to the one
below.

This table lists all of the items that the Bar|Scan program will check your
Transaction table for by default.  Some of the items may not be relevant to your
data, i.e., some items deal only with quantity inventories, and you may do your
entire inventory by the piece.

Bar|Scan uses the information inside of this table when validating the data in your
Transaction table.  Each of the items listed in this table would appear as an error
on the associated Transaction.  You can change the severity of the message from
an error to a warning, or disable the error altogether.  If you need to change the
severity of a message, double click the message with your mouse, and the second
column will change to say warning or disabled.

Note: Changing the message severity will NOT correct the data.  Please discuss
your wishes with Bar|Scan technical support before you disable or change the
severity of the error of a message.

Other Functions

The Other functions are discussed in detail in the Chapter 13 of this User Manual.
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THE IMPORT AND EXPORT FEATURES

The Import/Export features of Bar|Scan can provide you with four important
features.

% The ability to record and export asset information to other systems such as an
application using a software discovery tool or software licensing database.

% The ability to import information into Bar|Scan from another system either as 
a method to initially populate the assets, or as part of an ongoing process of
obtaining and updating Bar|Scan.

% The ability to export information from one company to another inside of
Bar|Scan, if you have a multiple company system.  The types of information
that you can export includes, but is not limited to: assets, catalogs, locations,
organizations, reports, and transactions. 

% The ability to set up and use the Activity Log which records events as they
occur.  These events can then serve as an audit trail, or, if desired can be
exported.  The Activity Log Export File created for your use can be in a
number of different formats including ASCII comma delimited, Excel, or
XML.  The Activity Log Export File can have any valid Windows filename
that you choose.
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When you select File  ...<, Export from the Main Menu, the following window
will appear.

The Export feature will allow you to export a Data Transfer File, to export
Formatted Data in a specified format, or in a multi company database, to export
a file from one company in Bar|Scan to another Bar|Scan company.

If you choose to export data, using Formatted Data, you will be able to select the
properties for your export.  Thus, you can for example, select to export using an
Excel format for use in an Excel spreadsheet.
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When you select File  ...<, Import from the Main Menu, the following window
will  appear.

As shown above, from this feature, you can synchronize your Mobile Computer,
import a file from another Bar|Scan company (if you have a multiple company
database),  Data Transfer File from another Bar|Scan system, or import data that
has been formatted from outside of Bar|Scan (such as an Excel file), or import
images (Imaging Module required).

For more information on these features, please see the Import/Export chapter and
Appendix B - Imaging of this User Manual.
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INTRODUCTION

A system designed to keep track of company assets must allow anyone to quickly
find a particular asset or group of assets.

Bar|Scan is designed with a specific purpose in mind; i.e., to permit you to quickly
and accurately enter new asset information, look up information, and update
existing asset information.

Bar|Scan provides the ability to quickly and easily create reports containing
specific groups of assets.

This section contains the instructions which will enable you to quickly and easily
operate the various features of Bar|Scan.

There is a set of videos on our website that can provide you with additional in
operating Bar|Scan.  These are titled Quickstart Overview Videos and can be
found on this page: https://www.barscan.com/support-videos

Please consider viewing or downloading these as part of your learning experience.
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OVERVIEW OF BAR|SCAN OPERATING FEATURES

The advantage of Bar|Scan is that even though there are many tables, the tables
were designed so that they all have common features that work in the same way. 
All of the common items on the tool bar work in the same way, no matter which
table you work on.  So, you can learn to use the add template button in one table,
and know that add template button works the same way in all of the other tables.

Bar|Scan was designed to minimize the number of keystrokes needed to enter and
work with your data.  Many features are available to make entering data less time
consuming, and keep it consistent.  

As you learn more about your system, you will realize that there are many items
that enable you to customize not only your Main Menu, but also the tables within
Bar|Scan.

Page 5-2 Bar|Scan



Chapter 5

CUSTOMIZING THE MAIN MENU

When you open Bar|Scan, you will be looking at the Main Menu.  By default some
icons on your Main Menu.  These icons are grouped onto Toolbars.  The various
toolbars can be accessed by going to the View Feature, then selecting Toolbars as
shown below.

There are seven different Toolbars available, and they can be displayed using only
icons, or icons with Captions.   

You decide which toolbars you would like to have displayed on your Main Menu. 
You can move them around with your mouse by left clicking the edge of the
toolbar, holding your mouse button down, and dragging the toolbar to a new
location on your Main Menu.  If your program is closed properly, the program will
remember your setup, according to your logon initials and password, and will
display your Main Menu the way you selected.
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Synchronization Toolbar

The Sync Toolbar is used to quickly access the Synch panel for uploading Mobile
Device information into the computer.  This Sync Toolbar is shown below.

This Toolbar is only helpful if you synchronize Handheld Computers.

Company Toolbar

The Company Toolbar is very useful if you have multiple databases, and will
appear similar to the one below.

By clicking on the open doors, you can open a new Company (database).  By
clicking on the closed doors, you can close the current Company.  By clicking on
the down arrow, you can select any other Company that is listed, as they are open
but not active.
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Message Toolbar

The Message Toolbar is part of the Scripting Feature in Bar|Scan.  The Scripting
Feature can control startup settings and actions in a Bar|Scan Initialization File. 
For example, scripting can login to Bar|Scan, change some information, perform
tasks such as print reports and then logout.  It can also, for example, perform a
task and then inform a user that the task was completed.  The Message Toolbar
is where this would be displayed.

Report Toolbar

The Reports Toolbar displays icons for the most common reports in Bar|Scan.  

This Toolbar has icons for the most common reports.  If you are only displaying
the icons, and not the Captions as shown above, you can place your cursor over
the appropriate icon, and a help balloon will appear to tell you what kind or report
the icon is for.
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Tables Toolbar

The Tables Toolbar displays icons for the most commonly used tables in Bar|Scan
as shown below.

Icons as shown are for the Asset table, the Catalog table, the Location table, the
Organization table, the Transaction table, the Personnel Table and the Work Order
table.  Click on any of the icons on this toolbar, and the appropriate table will
open.

Exit Toolbar

The Exit Toolbar will allow you to close the entire Bar|Scan program, and is
shown below.

As with many things in a Windows based program, there are several ways to do
the same thing.  Clicking on this icon would be the same as clicking on the X in
the top right of your Bar|Scan Main Menu, and will close the entire application.
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Personal Program Preferences

Another way to customize your Bar|Scan sessions is to select your own
Preferences.  You can do this by accessing the Personal Program Preferences
under the Edit feature as shown below.
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When you open the Personal Program Preferences table, you will see a table
similar to the one below.

Select what color the pages will be, and what color the ‘Tagged as changed’ items
will be.  Select sounds, and what events will trigger them.  Select what prompts
you will see, and if the Company path should be displayed instead of just the
name.

As with the Toolbars, Bar|Scan will remember your preferences according to your
logon initials and password.

In addition to these items, Bar|Scan will remember a few of your other choices,
but making the choices will not require you to open a table.  For instance,
Bar|Scan will remember what size your table was, the last time you had it open. 
It will remember the order you set for the columns inside of the tables. 

As you set the tables up the way you like them, Bar|Scan will remember your
choices, and try to keep them that way for you.  Bar|Scan will even remember the
width of the columns that you have selected (with the exception of the first
column which represents the table’s sort and will open at a defaulted width).
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THE TOOLBAR INSIDE YOUR TABLES

Once you open any table, you will see that there is a toolbar at the bottom, and
soon you will realize that most of these items appear on every table.  The items
common to any table are listed on the left, and the few tables that have additional
icons will display them to the right of the ones shown below.
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Saving Your Work

Bar|Scan makes you take an action to actually enter your work
into the system.  This allows you to review your work before it
is entered into the system and, possibly, overwriting and losing
existing information.  The Save (Ctrl +S) key combination or

clicking on the Save button shown above, actually enters the information into the
system.  

The cancel button also shown above, allows you to abort your activity without
disturbing existing information in the system.

Defining an Order and Filter:  -  The Set Feature

The SET feature allows you to sort a group of items which will be
displayed in a Browse window, or a selected group of items which will
be printed on a report.

As the number of assets on the system becomes very large (20 or 30 thousand is
common), scrolling through Browse windows to find a particular item could
become very time-consuming.  The SET feature "orders,”  “filters," and displays
items which are based on your current task.

Deleting an Item:  -  The Delete Feature

The DELETE feature allows you to delete an item which is being
displayed in a browse window.  

Because it is easy to sometimes press the wrong icon on a toolbar, and because
deletions are so final, we have made it a little more difficult to delete items.  To
delete an item, or a range of items, the items must be RANGED first.  Once the
desired items are ranged (accomplished by pressing the F4 button to begin and the
Enter key to end the ranging process) the items can be deleted.  If the items are not
ranged first, and you select the delete icon, you will see a message saying nothing
currently selected to delete.

Page 5-10 Bar|Scan



Chapter 5

Showing an Asset,  Catalog, or Signature Capture:  -  The Image Feature

The IMAGE feature allows you to view either an asset or catalog image
as well as a signature capture or image associated with another field for
the item which is being displayed in a browse or edit window.  

 
Bar|Scan can display single or multiple images for the same item.

The Imaging feature is explained in more detail in Appendix B - Imaging.

Print Preview:  - Printing a Selected Report

On most screens where the user can add, edit or delete information
there is a Report button. This button allows the user to print a report
directly from the screen. This button has a few special features directly
related to the fact that it knows what screen it is on.

Clicking on the button will display the default report to the screen in preview
mode. The user can change the default report at any time (see below). 

The user can change the default report by right clicking on the button and
selecting the desired default report. The list of reports displayed are those
specifically designed for the current screen, e.g., only Asset reports will be in the
list on the Asset screen report button. Of course, if there are no reports that apply
to the current screen there will be nothing to display in the list. In this case you
will have to create an appropriate report in the Report screen.

The Print Preview is capable of working with the Range Feature (F4). Right-click
the Print Icon to select or change the report. Next, range the items that you wish
to print. In the following example, only the eight items highlighted in the Range
will print.
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However, any existing filter in the report that you have chosen will also apply. 
Therefore, it is important to review and make sure that the filters that exist in the
report will not affect your range in an adverse way.  For example, if the report
already had a filter “Catalog Category = SE” then nothing would print since the
items select in the example are have Catalog Categories not equal to “SE”.

Expand or Collapse - The Expand or Collapse Feature

There are Several Panels in Bar|Scan where lists or history might be
displayed. Sometimes many records can be accumulated, more than can
displayed on the Edit Tab.  Clicking on the button expands or collapses
the screen so that more information can be displayed.
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Tracking the Characters You Type - The Seeking Feature

Bar|Scan analyzes the characters you type as you type them, and moves the
highlight bar to the corresponding area in a look up or browse window.  This
feature makes it easy to duplicate all or a portion of an existing entry thereby
speeding up the process and reducing typographical errors.

In this example, the cursor is placed at the far left column, before the first
character.  Then, EP was typed.  Immediately above the Catalog column, the item
“Seeking” is displayed, and beside it, in brackets, are the characters that were
typed.
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The highlight bar on the Catalog column displays the characters found, in the
order that they are typed.  First the system looks for the first E match, next the first
EP,  as it is being typed.  If a letter or number is not found, the cursor will stay on
the last character that was correct, signifying that no like item was found in the
list.

Note: In Personal Program Preferences, you can select to have a beep signify an
item can not be found.

Cursor Movement Keys 

Bar|Scan permits the use of all cursor movement keys to easily access the different
displays.  Several other special keys are also used to move the cursor.  These keys
operate in the same manner as many of the popular personal computer software
packages so that you can operate Bar|Scan without having to relearn the use of
these keys.

The Function Keys

Bar|Scan has assigned common activities to several of the Function Keys.  Where
possible, activities common to other personal computer software packages are
assigned to the same Function Keys (such as F1 for Help, and Ctrl + S for Save).

Abandoning Your Work

The X button at the top right of a window or the  ESC key is used to leave (escape
from) what you are currently doing and return to the previous menu or screen. 
Use either of these methods of closing a window after you have completed your
activities.

However, if you have pending additions or changes, you will be prompted to save
or cancel the pending additions or changes before you will be allowed to close the
open window.  Simply click on the desired button on the tool bar, to Save or
Cancel the pending additions or changes.  Once this has been completed, you may
close the window using the method of your choice.
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CURSOR MOVEMENT

Being able to quickly reposition the cursor or highlight bar is essential to any
system which contains a very large number of different records.

Bar|Scan permits the use of the normal cursor movement keys; i.e., the arrow
keys, Page Up and Page Down, and Ctrl + Home and Ctrl + End.  In addition, the
TAB and SHIFT TAB keys, the SPACE BAR, and the ENTER key can be used
to reposition the cursor or highlight bar.

Bar|Scan monitors characters as they are typed and repositions the cursor or
highlight bar based on the character.

The Arrow Keys

The simplest way to move the cursor is with the arrow keys:  right, left, up, and
down.

When a panel or a look up window is currently displayed, the arrow keys will
move the highlight bar up and down.  The right and left arrow keys become the
same as the up and down arrow keys respectively.

Prior (Page Up) And
Next (Page Down) Keys

The Prior (PgUp) and Next (PgDn) keys, as well as the two
buttons displayed above are used on the look up windows to
display the next or previous page of items from the list.

PgDn will move the cursor to the top of the next page, i.e., the highlight bar will
be positioned on the item following the last item on the currently displayed list of
items. PgUp will move the highlight bar to the top of the previous page.

If you are on the Edit tab of a table, PgUp and PgDn will display the next or
previous record in the table.
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Top (Ctrl + Home) and Bottom (Ctrl + End) Keys

The Ctrl + HOME key combination will move the
cursor to the first item in a table, a look up window list,
or a panel.  Ctrl + END key combination positions the
cursor on the last item.  The two buttons shown at left

side of this section, work in a similar fashion.

The TAB and Shift TAB Keys

The TAB and SHIFT TAB Keys operate similarly to the arrow keys when you are
at an Entry Screen or a Menu, i.e., TAB will move to the next item and SHIFT
TAB will move to the previous item.
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FUNCTION KEYS (F3 THROUGH F5)

Bar|Scan provides the use of several Function keys.  These keys may be pressed
at any time to display the information or initiate the activity provided by the key. 
If the activity is not allowed or there is no information to display, NOTHING will
happen.

F3  -  Next Screen

Some panels are not large enough to cover all of the information for a table, so
additional panels are used.  These panels are signified by tabs on the table.  These
tabs can be accessed by using the F3 (Next Screen) key. 

For instance: When you open the Location Browse tab, the Edit tab can be
accessed by pressing F3.  

If there are additional tabs on an Edit panel, F3 will take you to the next tab.  For
instance, on the Asset table, there are nine additional tabs, with Asset open by
default.  If you press the F3 key, the next tab, Inventory will be displayed.  If you
press the F3 key again, the third tab, Accounting will be displayed.
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F4  -  (Range)

The F4 (Range) key can be used when defining a range of items on a Browse 
panel.  F4 will only operate when on a Browse panel.  If pressed at any other time,
F4 will have no effect.

In order to define a range of items, move your cursor to the first item you wish to
include, and press F4.  The first item should change color.  The default range color
is green.  Press the up or down arrows to the last item you wish to include, all of
the items should now have a green background.  Press the Enter key to end the
Range.  The Browse panel will have a message saying how many items are
included in the Range as shown below.

Then, if you would like to range more items, go to the first item you want to
range, again press the F4 key, and then the arrow keys to select the items that you
want, and then the Enter key to end the Range.  Hint: You can also add items to
a range by double-clicking the item, in the first column, with your mouse.  To
cancel the range, press the Ctrl + F4 key combination.
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Note that you may also begin, end, or clear a Range from the Main Menu, by
selecting Panel . . . <, and then from the drop down list select Range . . .  <, Begin,
End, and/or Clear All as shown below.

Tip 1:  Double clicking an item in your browse window will also cause it to be
ranged. 

Tip 2:  When you are in the process of ranging several items that are not
consecutive, you press F4 and Enter.  Go to the next desired item, press F4 and
Enter.  If you press the F4 and accidentally range the wrong item, you can press
the F4 button again, and that last accidentally ranged item will no longer be
ranged.

Tip 3: Use Range Next when you wish to highlight a large group of items. 

The Last item “Problem Items” can be helpful in Technical Support.

The “Common Items found in this table and an external table to be specified”
feature allows you to range items in any BarScan table based on data in an
external file.  The external file must be in .CSV or .DBF format and the field must
be a key field in BarScan, e.g. Asset Number, Room Tag, etc.
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Here is an example scenario.  You have an Excel file with a large list of Asset
Numbers that you wish to delete in BarScan.  You do not want to delete all of
these assets manually.  This feature will allow you to delete them quickly.

To begin, the Excel file column title must be the same as the BarScan field name,
in this case asset_no.  Make sure that the column title is correct.  

Next, convert the XLSX file to a CSV file format by using the Excel export
feature.  Make sure the CSV file is located where BarScan can access it such as
your desktop and make sure that the CSV file is not open.  

Start BarScan and open the Asset Table.  Then from the Main Menu select  the
‘Common Items found….’ feature.  BarScan will ask for the location of the CSV
file.  Navigate and choose the file.  BarScan will next highlight all Assets that
match the list in the CSV file in a Range.  You can now delete the items in the
Range.
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F5  -  Look Up Window

This feature creates a window which lists information currently in the Bar|Scan
system.  When you are on a field and you need to enter data, you may right click
or press the F5 key, and you will see a dialog box like the one below. 

If you choose Look up Value, a look up window will appear to show you entries
that are currently being used in the system, or a list of available selections.  A
sample look up window is displayed below.

Click the item that you want to place in your field, and select the OK button.

Some of the Look up Windows will allow you to right click and resort the
information shown.
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Restore Original Value is valuable when you have noticed that you do not want
to change a field, but do not remember exactly what the field said prior to your
change.  This is sort of an “undo” one field at a time.  As when you make a lot of
changes before saving, clicking the Cancel Changes button on your toolbar will
cancel all of the changes since your last save.

Mark as Changed is a useful tool for changing all of the items in a range.  When
you have selected a range of items in order to change a particular field, it may be
that some of these records do not need to be changed.  For instance, you have 25
records, and most of them say IU for Status, and five of them say IS, and you want
to have all of them say IS.  You can range all 25, and if the one that is displayed
already says IS, place your cursor on the IS field, right click and select Mark as
Changed.  This will highlight the field as though you have changed it, and will
allow you to send that change to the rest of the 25 records as one global change.

Mark as Unchanged is just the opposite of Marked as Changed.  You may want
to use this when you want have changed several items on purpose, and then make
a change to a field by accident.  Marking the accidental change as Mark as
Unchanged will allow you to save the first legitimate changes, without saving the
accident.

Field Information can be used to determine the properties of any field in
Bar|Scan.  As displayed in the example below, the Organization Code field is a
Character Field of 6 in length.  Because the User Defined Fields Module and
rename and/or stretch and shrink fields, you might need to rely on this information
when designing an import or export.
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Changing the Browse Window

While on any Browse window, you can use your mouse to right click on the first
column as shown below.

When you right click on the first column the words “Order By” will appear, and
if you place your mouse on these words, a drop down list will appear, allowing
you to sort the information on this table using any of the Sets that have been
created.

Important: You can right click and select Order By on any window, even some
of the look up windows.  If you have selected the Set button from the tool bar, and
have chosen a set that had a filter, i.e., Bad Transactions Only, right clicking will
not erase that filter, but allow you to re-sort the data.
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You may also change the order of the columns in a Browse window.  Simply
place your mouse on a column header, and it will turn into a thicker black arrow.
Left click and hold the mouse button down, and drag the column to the left or
right.

The example shows the column Width is ready to be dragged to the left or right.
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You may also change the width of a column by placing your mouse on the line
that divides the columns (still in the shaded header area).  When the mouse pointer
changes into a plus shape with a double arrow, you may left click, hold the mouse
button down, and drag the edge of the column to the left or right.
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You may also change the height of a row by placing your mouse on the line that
divides the rows ( in the shaded area).  When the mouse pointer changes into a
plus shape with a double arrow, you may left click, hold the mouse button down,
and drag the edge of the row up or down.
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You can also display images on the Browse window as shown below.

Images can be associated with both Assets and Catalogs.  Optionally they can also
be signature captures or associated with other fields.  To display an image, right
click on either the field’s Column Header.  If you wish to view both the image and
the data, add the column to the Browse window twice.  You will have to expand
the how to see the image as shown in the example above.
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You can also change the font on the Browse window as shown below.

If you right click in the very left hand box you will see an item to change the font
on all columns.  Right Clicking on any title will allow you to change the font on
that column separately. 
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THE INSERT KEY

The Insert key, when used while in the data entry mode, will change your cursor
from typing mode to type over mode. 

CONTROL-I & CONTROL-D  KEYS

The Control + I key combination is the keystroke for the Add function.  Then, you
will need to select whether you want to add from a Blank or from a Template.

The Control + D combination is the keystroke for the Delete function.  

USING THE SPACE BAR
WITH DATA ENTRY

Do not use the space bar when entering information.

Using the space bar for "padding" is not necessary to "align" information that you
enter.  As a matter of fact, the space character is a valid bar code character and
will produce a different bar code for items proceeded with spaces than those
without spaces.

Bar|Scan will always align all numeric and alpha numeric information properly.

It will also properly order numeric fields.  For example, total cost of $501.00 will
always come after total cost of $500.00.

In a very few circumstances, the space character may be desired.  For this reason
Bar|Scan will allow you to pad with spaces.
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CONTROL KEYS

Control key shortcuts allow you to choose certain menu options without
displaying the menu look up.  All you need to do is press the control key
combination which is listed next to the desired option on the menu look up. 
Control key shortcuts are listed below.

Ctrl + A - Select All
Ctrl + D - Delete
Ctrl + I - Add
Ctrl + O - Open
Ctrl + S - Save Modification
Ctrl + Home - Top
Ctrl + End - Bottom

These Control Keys are time savers and may be useful to you if there are times
when you will not be using a mouse.
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If you have any table open besides the Main Menu, and you select Ctrl + F, you
will see a find panel that looks similar to the one below.

This is the same panel that you will see if you click on the Find button on the tool
bar.  

There is one exception.  If you are on a text file, such as in Work Orders on the
Notes area, and you select Ctrl + F combination, you will see the following.

This feature may be helpful when you need to search for a word or words in the 
dialog area.  This box will not be available unless you are on a text area.
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USING A MOUSE - RECOMMENDED

Bar|Scan is designed for use with a mouse or a standard keyboard.  All Bar|Scan
actions can be executed by either the keyboard or the mouse.

Although the program does not require a mouse, we recommend it for its
ease-of-use.  With the click of a button, a mouse can accomplish the equivalent
of many keystrokes on the keyboard.

If you have a mouse attached to your computer and have your mouse installed, a
pointer will appear on your screen when you start the program.  The pointer is an
arrow.

When you roll the mouse, the pointer moves.  You can position the pointer by
moving your mouse.  Clicking your mouse button will execute the action your
pointer is resting on.

Controlling the Look up Windows with the Mouse

Most of your work will start with the display of a table.  The information
contained in a table can be changed by using a look up window.  

The look up windows can be manipulated in several ways.  In addition to opening
and closing the look up windows, you can move and size them easily by using
your mouse.  

To move a look up window, place your mouse on the title bar, left click and hold
the mouse button down while you drag the window to a new position.
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A sample look up window is displayed below.

Like most windows, you can resize these windows by placing your mouse at the
edges of the window.  When your mouse pointer changes to a two headed arrow,
hold down the left mouse button and drag the mouse to where you want the edges
to be.

You can close the look up window by clicking on the X in the top right-hand
corner, or click on or select the Cancel button.
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To Open a Panel:

A panel can be opened in a variety of ways.  A panel is opened by clicking on the
File button, then by selecting the necessary items from the drop down menu, or
by pressing the Ctrl + O key combination will automatically open a drop down list
for you to choose from. When you open a panel, it becomes the front most panel
on your screen.

To Close a Panel:

When a panel is closed, you can no longer see its contents.  To close the active
panel, press the X at the top right corner, or select File, and then Exit, or finally
by pressing the ESC key.

To Move a Panel:

To move a panel to a new location, position the pointer on the panel title bar (at
the top of the panel), hold the mouse button down and drag the panel.  When the
panel is in its new location, release the mouse button.

To Size a Panel:

To change the size of a panel, click on  the "Maximize" in the top right corner of
a panel.  It should look like one or two windows.  Or, move your mouse to the
outside edges of the panel and when the mouse pointer turns to a two-headed
arrow, hold down the left mouse button, drag the edges until the panel is the
desired size, then release the button.  

There may be times when you need to see more of a look up window than will fit
on your monitor’s screen.  Bar|Scan gives you the ability to make the look up  
larger than you may be able to see at one time.  

In order to use this feature, place your mouse on the title bar of the look up
window.  Press your left mouse button, and hold it down, while moving the mouse
to the left.  This moves the entire look up window to the left.

Now, with the look up  as far to the left as possible, move your mouse to the right
outside edges of the panel and when the mouse pointer turns to a two-headed
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arrow, hold down the left mouse button, drag the edges until the panel is the
desired size, then release the button.  This process allows you to view parts of the
panel that used to be hidden.

To Maximize a Panel:

To Maximize a panel, click the Maximize button in the upper right corner of a
panel.  The panel expands to fill the screen.  To return the panel to its previous
size, click the Maximize button again.  

To Scroll a Panel:

"Scroll Bars" are located along the right edge of  panels.  Click the arrows at either
end of the "Scroll Bar" to move through the contents of a panel a little at a time. 
Click one time in the page up or page down region to move up one page or down
one page.  
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THE BAR|SCAN OPERATING FEATURES

The following section describes how to operate the various features of Bar|Scan. 
You will want to become familiar with these features before you attempt to use
the System.

THE BAR|SCAN LOOK UP WINDOW

Bar|Scan is designed to minimize the number of keystrokes required when you
operate the various features.

Bar|Scan eliminates keystrokes by featuring many look up windows that provide
specific information and choices appropriate to what you are doing at that time.

A look up window will contain either a list of choices from which to select, a
menu of different activities, or a list of information currently contained in the
system.

A look up window containing a menu requires you to move the highlight bar to
one of the activities and press ENTER.  You may also press ESC to make NO
choice and return to the previous screen.

The Feature Category “Panel” has a pull down where you will find the Range
feature, or you can select the F4 “Range” key to select a group of items from a list.
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Look up Windows Containing Multiple Columns

Many of the look up windows contain several columns of information.  One of the
columns, usually the first column, will be active.  The other columns are provided
for your information and reference.

To select an item, click on it with your mouse, or move the highlight bar to the
desired item using any of the cursor movement keys, and press ENTER.

Moving the highlight bar is accomplished by pressing the four arrow keys, the
PgUp and PgDn keys, and the Ctrl + HOME and Ctrl + END keys, (or you may
use the mouse).  See the subsequent section on "Cursor and Highlight Bar
Movement Keys" for some more information on the use of these keys.

The highlight bar signified by a bold box with the | to the left of it shows the
item that is currently selected.  It will move in accordance with characters you
type. See the subsequent section on "Tracking the Characters You Type" for more
information.

To close the window, click on the X at the top right corner, or the ESC key may
be pressed to be returned to the previous screen.
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Range (Function-4 Key)

The range feature permits you to select and mark a group of items from a look up 
window list.

The Range feature works only when you are permitted to select a group of items
from the list displayed in the look up window, or on a browse panel.

Select a group or range of items from the list as follows:

T  Move the highlight bar to the first item of the group and press F4 (Range) key
to highlight the first item.

T  Move the highlight bar to the last item of the group and press ENTER.

Bar|Scan will highlight all of the items in the group you have selected.  

Moving the highlight bar is accomplished by using the mouse, pressing the four
arrow keys, the PgUp and PgDn keys, and the Ctrl + HOME and Ctrl + END key
combinations.  Please look at the subsequent section on "Cursor and Highlight Bar
Movement Keys" for some more information on the use of these keys.

The highlight bar will also move in accordance with characters you type. See the
subsequent section on "Tracking the Characters You Type" for more information.

TRACKING THE CHARACTERS YOU TYPE - THE SEEKING FEATURE

This is one of the most important timesaving features of Bar|Scan. It is available
when your cursor is placed in the far left or very first position (prior to the first
character) of a field in a column or look up window.  If your cursor is not in the
first position, this feature may not work properly.

Generally, Bar|Scan will analyze the characters you type as you type them, and,
depending what you are doing, automatically select a menu choice or display
information in accordance with the characters entered.
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If you are selecting a menu choice, Bar|Scan may automatically make the choice
for you when enough characters are entered to distinguish it from all other
choices.

This feature is even more helpful when you are entering (or changing) information
on one of the Bar|Scan Entry panels.  You may wish to view a look up window
listing all of the information in the system for that particular item.  This is done
by using the look up window key (F5) or by right clicking on a specific field, and
then select Look up Value.  The highlight bar will move through the list in
accordance with the characters you type.

If the highlight bar, signified by a bold rectangle with a | to the left of it,  is over
an item that contains the rest of the characters you want, you can just press the 
Enter key, the rest of the characters will be entered for you.

The combination of typing characters, moving the highlight bar in the look up 
window, and pressing the right arrow key to enter characters provides a quick and
accurate method for making your selections and entries.

The explanation of this feature is considerably more complicated than actually
using it.  We urge you to experiment with its use; you will find it simple to use
and will save you a considerable amount of time.

For example: When viewing the Catalog table, place your cursor on the Catalog
Code field and right click or press the (F5) key.  Select Look up Value from the
menu list that will appear, a look up window appears for the item. The look up
window for the Catalog Code has many unique choices available and most choices
start with a different letter. Typing the first letter of the desired choice will cause
Bar|Scan to automatically go to the first choice starting with that letter.  

Another example: right click on the Manufacturer’s field or press the (F5) key,
and then select Look up Value, a look up window appears for the item.  Bar|Scan
will follow your keystrokes by highlighting existing similar items.  For instance,
if you are entering a manufacturer and you type the first two or three letters the
highlight bar in the window showing the list of manufacturers will move to the
first occurrence of those two or three letters.  If the correct manufacturer appears
in the window you can move the highlight bar to it and press ENTER to select the
manufacturer.  Further keystrokes are not required.
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DEFINING THE ORDER BY - THE SET FEATURE

As the number of assets in your system grows, it will take an increasing amount
of time to find a particular asset or group of assets.  To solve this, Bar|Scan
provides the SET feature which enables you to determine the order in which the
information will be displayed, and to specify a particular group of assets and
"filter" out the rest.

SET is provided as a part of all Query and Browse screens.  Select SET by
pressing the Set button on your tool bar as shown below.

Use this feature to change the item(s) that the information in browse panels is
sorted by.  If your want to sort the items on a browse panel by a specific field(s),
which is not listed in the previously created Sets, you may add your own Set.

Bar|Scan provides many sorting order levels.  However, most Sets are created with
only one, two, or three levels specified.  We suggest you experiment with several
different orders and levels to become familiar with this feature.

You can add a filter to your Set, but adding a filter to a Set will slow the  sorting
down, and may cause your table to open slower if the last Set you used before
closing the table had a filter. 

Choosing to sort by asset number will render any additional choices meaningless;
as each asset number is unique, no further sorting will take place.  If you want
your items sorted by asset number, always place this item as the last item to sort
by.

You can choose to sort all information in a table by any field that is in this table. 

Hint: There is one drawback to entering a large number of items in the Order By. 
The more items you have, the more time it will take initially to create the
associated index.  Fortunately, this is a one time process for the SET feature.
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When you press the Set Button, you will see a Set table similar to the one below. 

The information displayed inside the Set panel will change, depending on which
panel you were on when you pressed the Set button.  For the example shown
above, we were on the Catalog table.  You may choose any of the Sets listed on
the Browse tab, or select the Add/Change/Delete button, and create your own.  
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When you select the Browse Fields tab, you will see a tab like the one below.

The list on the left is a list of the fields that are available for you to add to the
Browse window.  The list on the right is the list of items that will appear as
columns on your Browse panel.

Add columns or delete them, then press the Apply button to ok a new browse list.
If you think you have made a mistake, or have just changed your mind about
changes you have made to a Set, you can use the Revert button. Press the OK
button, and the columns that you have chosen or added will appear on your
Browse panel.

Note: The same columns will appear for every set, with the exception of the first
column.  The first column always lists the item(s) that the set is sorted by.  For
instance: if you select the Asset # set, the first column will be Asset #, and all of
the columns thereafter, will be the ones chosen on the above panel.  A column,
therefore, may appear twice on the browse tab, if you have selected to sort by a
column that is listed on this panel as one of the columns.  You may choose to
move the columns around manually while on the Browse tab if this happens.
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When the Set button is pressed, you can  select the Add/Change/Delete button,
and you will be shown the Set table like the one below.

This table works like any other table in Bar|Scan; you can Add, Change, or Delete
Sets.

Note: You can Change or Delete {System} Sets but only after you unlock them.

To Add a new Set, select a Set that is similar to the one that you want to add. 
Click on the Add Template button, then, click on the Edit tab.  
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You will be shown a panel similar to the one below.

Type in a new name and a new title for your Set.  Next, you need to select the
field(s) that you want your information to sort by.  Select the Add or the Change
button, and a Look up Window will appear.  Select from this Look up Window
your choices for Fields, then close the Look up Window.  Review the Field(s)
listed.  If there are any Fields listed that you do not need, simply highlight them,
and select the Delete button.

The information will sort by Ascending order by default, but you may change the
direction of sort to Descending, if you prefer.  Then, select the Save button from
the Tool Bar.  

Note:  In order to use the new Set, you have to Generate the Set.  To Generate the
new Set, you have to be the only person in that Company in Bar|Scan, and you
have to close all other tables (besides the Main Menu).

Once you have closed all other tables, click on the Generate button.  The system
will give your new set a Tag number, which you can view on the bottom right of
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this Set Edit tab.  This number is used internally, and you do not have to
remember the number, but only to confirm that the Set has a number rather than
to say Dynamic.  Once your new Set no longer says Dynamic, the set can be used. 
Close this Set table. 

Optimizing Set Commands with Filters

By default, Set Commands with Filters do not use indexes for the filter criteria. 
However, they can be optimized to use indexes.  An index is a data structure that
improves the speed of look-ups and data retrieval.

The process to optimize a SET takes a few steps.  In summary, if you index by the
Filter items, the Set Command will display the filtered items much faster in the
Browse Screen.  Lets see an example.

Below is an Asset Set with Assets indexed by Location.  Because the Location
index is created when you press the Generate Button, the Assets will display very
quickly when this Set is selected.
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Now lets click on the Filter By Tab and add a filter as shown below.

The field to filter the Assets by is Warranty Expiration Date, a User Defined Field
(UDF) that was created for this database.  Bar|Scan did not previously have this
field so no indexes exist.  This will mean that the data retrieval will be slow.
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So, if we create an index for Warranty Expiration Date, the SET above will work
very fast.  The process is to create a New Set ordered by Warranty Expiration
Date.  An example is shown below.
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There is no need to add Filters as shown below.

To Summarize - if an index does not exist for a field and you use that field in a
Filter By Tab, the data will appear slowly in the Browse Tab.  To correct this,
create a new Set Command with the same field in the Order By tab.
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Chapter 6

INTRODUCTION

At the heart of the Bar|Scan system is the list of your assets, and the associated
asset information.

The Asset feature of Bar|Scan provides you with the ability to enter new assets,
view selected assets or groups of assets, change existing information on an asset
or group of assets, and remove an asset or group of assets.

Bar|Scan can also track consumables and non-tagged assets.  We call this a
Quantity Mode inventory.

There is a set of videos on our website that can provide you with additional in
operating Bar|Scan.  These are titled Quickstart Overview Videos and can be
found on this page: https://www.barscan.com/support-videos

Please consider viewing or downloading these as part of your learning experience.

Another part of the Asset feature permits you to identify a particular group of
assets from which to choose when viewing, changing, adding, or deleting.  This
is accomplished in two ways as follows:

T You may select the order in which the assets will appear.  They can be
displayed in order by any field or combination of fields.  Some common orders are
location, serial number, asset number, or catalog.  Selecting the order before you
begin your work greatly enhances your editing abilities.  The default order is asset
number.

T As your list of assets becomes large (twenty thousand or more assets are
common) this tool will "filter" out all but the group of assets you currently wish
to work on.

An important feature of the "filter" is that it may speed up your editing because
you can manipulate only the filtered assets and not every asset in the system.  We
recommend using the "filter" when working with large numbers of assets.  The
tool we have just described is called  SET.  It is discussed in more detail later in
this Chapter.
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The original entry of new assets and quantity inventory into the system is usually
accomplished using the Bar|Scan Mobile app in your Mobile Device.

When you want to view, change, add, or delete assets you will need to open the
Asset table.  From the Main Menu, select File, then Open ...<, then Asset ...<, then
Assets as shown on the following example.

Or you may click on the Asset Icon on your Table Toolbar.  The icon is displayed
below.

Once you have chosen Assets in either of the above manners, you will be shown
the Asset table.  
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Your Asset table will look similar to the one below.

On the Asset table, the Browse panel is selected by default.  
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The asset information on the Browse panel can be sorted by any field.  Go to the
first column on the left, and then press your right mouse button, and then select
the “Sort By” that will be displayed.  
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When you select the Order By, you will be shown a list of items that you can sort
the Asset table by as shown below.

There are a few differences between this item and the “Set” icon on the toolbar: 
the Set icon on the toolbar contains all sets that have been made, the Set icon
allows you to create new sets, and the sets created with the Set icon may contain
a filter.  

Once you have used a set that contains a filter from the Set icon list, right clicking
and selecting a new Order By will not clear that filter.
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For example, you may select a set for your Transaction table that lists only Bad
Transactions by Asset number.  Let’s say you want to re-sort those bad
Transactions by their Current Location.  If you right click on the first column,
select the Order By, and then select Location, the bad Transactions will re-sort by
their Location.  If you had selected the Set icon to sort the Transactions by
Location, the entire list of Transactions, both Good and Bad, would appear sorted
by their location.

Or select the Set button on the tool bar as shown below.

Select the field or fields that you want the Assets to sort by.  

This feature will give you the ability to look at all of the assets, pre sorted the way
you specify.  If you do not specify another sort, the default sort is by Asset
number.

CREATING A NEW ORDER AND FILTER - THE SET FEATURE

The SET feature allows you to order and optionally identify a smaller, more
manageable group of assets from which to select, i.e., only those assets in a
particular location or only those assets made by a particular manufacturer, etc.

As the number of assets on your system increases it becomes more time
consuming to look through the entire list of assets displayed on a look up window.

SET permits you to “order” your assets by any item in your table.  By sorting the 
assets by different fields, you can shorten your search time dramatically.

SET also allows you to change the columns seen in the browse window.
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Because SET offers almost endless possibilities for identifying groups of assets,
we strongly recommend that you experiment with different specifications to
become familiar with this feature.  Experimentation with SET will NOT cause any
change to the information recorded for any asset.  It merely specifies the sequence
of asset selection lists.

When you want to view your assets in an order other than by asset number, select
SET, by clicking on the icon shown below.

This button activates the Set feature, and a screen similar to the following will
appear.
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This Set Order and Filter tab, shows a list of Sets that are pre defined in the
Bar|Scan system.  You may select any of these to sort your table by the field(s)
listed.

You can, however, define additional Sets.  Click on the Add/Change/Delete
button shown above, and the Sets table will open.  Once on the Set table, you may
add, change, or delete your own sets.  

If you would like to see the browse fields, which are available for the predefined
Sets, add or remove a field, select the Browse Fields tab.

When you select the Browse Fields tab, you will be shown the following screen.

The first field on the Browse Fields tab, says Asset and there is a � to the right of 
it.  This signifies that the fields listed below are stored in the Asset table in
Bar|Scan.  If you need to access any of the other tables in your Bar|Scan system,
simply click on the down arrow, and a drop down list will appear, revealing all of
the other tables.  When you choose a different table, the fields listed below it will
change to reflect the available fields for the new table.
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On the left side of this screen there is a list of all of the available fields for the
Asset table that you may display in your Sets.  On the right side of this Browse
Fields tab, you will see the current fields that will be displayed for each Set.  

These fields are displayed for all of the different Sets, beginning in the second
column. The first column will display what the table is being sorted by.    
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Changing the Order of the Columns Shown in a Set

You can change the order the columns will appear using two different methods. 

The first method uses the Set and Field Selection table.  Click on the small grey
box next to the field name, and the cursor will change to a double headed arrow
as shown below.

Hold your mouse button down, and drag the field up or down.  When you click on
the Apply button, this window should close automatically, and the columns should
reflect the changes you have made.

When completed, press Apply to save your changes.

Page 6-10 Bar|Scan



Chapter 6

In order to better demonstrate this concept, select one of the pre defined Sets by
using the Set icon on the toolbar, and click on apply.  You will see the items in
your table sorted by the new criterion.  The columns that will appear will be the
same as selected on your Set Order and Filter tab with the exception of the first
column that is being used to display what the assets are being sorted by.

For the information displayed above, we chose the Serial number Set.  Notice that
the rest of the columns are still the same as they were when sorted by Asset
number, i.e., Catalog Category, Catalog Type, Catalog Description, Serial number,
etc.  The only column that changed was the sort by column, the first column
displayed.  A sort can contain more than one item.  But, no matter what the sort
of the list, the rest of the columns stay the same.

The second method of changing the order of the columns is to left click the top of
the column in the grey area that holds the name of the field, hold your mouse
button down, and drag the column to the left or right.  The columns will move to
fill in the gaps as you move your mouse.  This is a useful tool and much faster
than respecifying the columns for a Set.
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WORKING WITH IMAGES ON THE ASSET SCREEN

To view images on screens, all image viewing are consolidated under a single
button, ‘Images’.  Also of note, the list of images is categorized by folder and type
of image. Also, the listbox at the top will contain the folder and image filename.
Signatures that are not yet permanent are listed as ‘Pending’ signatures. Finally,
the listbox is expandable. You can grab the black bar immediately below the
listbox to make the list box larger or smaller. The image is appropriately resized.
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THE EDIT TAB

When you want to see the detailed information that has been entered into the
Asset table, you will need to select the Edit tab.  When you do, you will be shown
a screen similar to the one below.

Every item on this screen can be collected by using the Mobile Device as well as
entered at the keyboard.
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Note that this tab has ten tabs on it as pictured below.

Each of these tabs contains fields for information about the asset.  If, however,
your company has not purchased the optional Accounting module, you will not be
able to access all of the tabs shown above.

The first tab, the Asset tab, is open as a default.

At the onset of your inventory, you will configure the Mobile Device to prompt
you for information about the assets.  All of the information that appears on the
above tab can be collected with the  Mobile Device during the inventory.  
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The second tab on the Edit tab screen, Inventory, is shown below.

T  Scan Information - The Scan information on this screen also comes from the 
Mobile Device.  The user initials are entered into the  Mobile Device , and then
the inventory date and the inventory time are updated as each asset is entered into
the  Mobile Device .

The inventory Comments are displayed below the inventory time.  This field
correlates directly with the field in the  Mobile Device .  It is used for additional
information pertaining to the asset that can be gathered at the time of inventory,
such as the details of its condition, i.e., scratched.

T  Disposal/Sale - The Disposal/Sale fields are displayed next.  These include the
Disposal Date, the Type, Sales Value, Disposal Gain or Loss and a field for the
Buyer name.  Typically, your assets will remain in your system after their actual
disposal.  By using a “filter,” they can be included or excluded from your asset
reports.  The information displayed in the Disposal/Sale fields is entered into
Bar|Scan via the keyboard.  Be aware that the Disposal date does affect
depreciation.  This is discussed  further in the section A Word About Depreciation
in this chapter.

T  Remarks - The last section of this tab holds three remark fields.  These three
fields are available for any additional information that you would like to attach to
your assets, after the initial inventory via the keyboard.
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The third tab on the Edit tab screen, Accounting, is shown below.

This tab is available to anyone who has purchased the Accounting module.  Most
of the items on this screen are entered at the keyboard.  However, the Purchase
Order # can be collected in the  Mobile Device.  

T  Asset - The Asset information on this tab shows dates and basic information
on the initial purchase of the asset, and on the right there are three fields for
General Ledger numbers.  

The Archive Record Id is a Data Transfer Record Id.  If you do an Import or an
Export using a Data Transfer file or an inter-company transfer, all of the records
that are transferred (during that one transfer) are given the same Archive Record
ID.  You can not edit or enter a number in this field.  But, if the item has been
imported, a number is displayed for you.

You can print the Archive Record Id as a column in an Asset report.  All of the
Assets that were imported together will have the same Archive Record Id.  

For instance, let us say that you have three companies.  You need to transfer some
assets from Company A to Company B.  For some reason, you accidentally
selected Company C, and performed the transfer.  You could create a report with
the Archive Record Id and the Log Date and Log Time as columns.  With this
information, you could tell exactly which assets were imported together, and then
export them to the correct company.
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The fourth tab on the Edit tab screen, Basis, is shown below.

This tab is available to anyone who has purchased the Accounting module.  The
items on this screen are entered at the keyboard.

T  Valuation - shows information on all asset purchase costs and  salvage value.
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The fifth tab on the Edit tab screen, Depreciation has 3 sub tabs.  The first is
shown below.

This tab is available to anyone who has purchased the Accounting module.  All
of the items on this screen are entered at the keyboard.

T  Initial Depreciation - shows the date when depreciation was transferred, and
the accumulated depreciation at the date of transfer.  This is generally used when
beginning depreciation in Bar|Scan for assets that already had a depreciation
balance in another system.  For example, this could contain the depreciation taken
in another system just prior to the import of the asset into Bar|Scan.

T Ongoing Depreciation - Basically a method of cost allocation, depreciation
can be a complex issue and is used for many different purposes.
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T Depreciation Split - Basically a method of cost allocation between
departments, depreciation splits can also be a complex issue and is used for many
different purposes.

Bar|Scan can provide you with simple methods of handling depreciation expense. 
This is often adequate for issues such as charge-back to your departments, or
budget analysis.

If you are working with a collection of assets that are similar in nature, you are
using a group system of depreciation.  If you are working with a collection of
assets that are dissimilar in nature, you are using what is typically referred to as
a composite system of depreciation.

The Split button is optional and most be selected in the Company Settings Screen,
Depreciation/Currency Tab in order to be active.

Important: Bar|Scan is not capable of providing you with all of the features
required for tax reporting purposes.

As you can see, many items on this screen are calculated and not entered by the
user.
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The sixth tab on the Edit tab screen, Life, is shown below.

This tab is available to anyone who has purchased the Accounting module.  The
items on this screen are calculated by Bar|Scan.

T  Life - The depreciable life of an asset is theoretically based on its estimated
service life.  Practically speaking, the actual depreciation life is dictated by
financial or reporting requirements.

Bar|Scan shows the relevant number of months that depreciation was taken or if
the asset was idle at any time (not applicable for all depreciation methods).
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The seventh tab on the Edit tab screen, Lease, is shown below.

T  Lease - This tab can be used to track commonly recorded information.  If your
company is leasing assets, you may wish to add this information to Bar|Scan. 
Leased assets are normally not depreciated, so there is no depreciation information
entered.

In any case it is best to consult your accounting department for proper allocation
of this information.

The information on this table can be filled in per asset.  But, if you have a lease
number that involves many assets, and you do not wish to enter the information
for every asset that is concerned, you can enter the information into a separated
lease table.  This lease table is located by going to the Main Menu, select File,
then Open ...<, then Asset ...<, then Lease.  You fill the information for a lease on
that table one time, and then each time you find an asset that uses that lease, you 
manually fill the lease number in the tab shown above, and the rest of the
information will be filled in for you.
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The eighth tab on the Edit tab screen, Transfer, is shown below.

T  Organization Transfer - This tab shows the amount of depreciation taken at
the time the asset is transferred from one Organization to another.  It is refreshed
every time you change the current Organization Code.  Bar|Scan does not maintain
a history of transfer information.
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The ninth tab on the Edit tab screen, Depreciation History, is shown below.

T  Depreciation History - This tab shows the detailed Depreciation History for
any asset.  It is optional and can be started by checking the “Use Depreciation
History” button.  Many fields are maintained for each period including

The Period Number (in months)
The Depreciation Method used for the Period
The Period Type (usually monthly)
The Period Start Date
The Status (of the Asset during the period)
The Organization Code (organizational ownership at the time)
The Monthly Depreciation Amount
The Accumulated Depreciation
The Book Value Remaining
The Year to Date Depreciation
The Fully Depreciated Flag
The Periods Depreciated (taken)
The Periods Idle (not taken)
The Periods Remaining (periods left to depreciate)
The Period End Date
The Prior Organization
The General Ledger Number
The General Ledger Number #2
The General Ledger Number #3
The Depreciation End Date
The Fund Number
The Transfer Date
The Transfer Depreciation
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The Prior Accumulated Depreciation
The Prior Remaining Book Value
The Prior Periods Depreciated (number of)
The Prior Periods Idle (number of)
The Prior Periods (total)

The tenth tab on the Edit tab screen, Bill of Material, is shown below.

A set of features are available to allow  you to create, modify and move groups of
assets by selecting them using both a Catalog Component List or an Asset Bill of
Materials (BOM) List.  

With these features, you can move these groups as a whole, perform work on
these groups by means of a Work Order, reserve the components of these groups
by means of a Reserved Bill Of Material so that they will not be available for use
to build other groups or be moved to other locations.

You can also create Bar|Scan reports detailing these special catalogs, assets, and
components and their relationship.

Catalog Components, Asset Bill of Materials, Reserved Bill Of Materials and
Reporting are all discussed in more detail in this Chapter as well as the Catalog
and Work Order Chapters.
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SELECTING THE DESIRED TAB

Once you are on the first Asset tab, you can move from tab to tab of the Asset
table at any time by pressing F3 or use the mouse to click on the desired tab.  The
information entered on one screen will not be lost when you flip to the other
screen.

For  instructions about cursor movement keys, function keys, using the mouse,
and how to operate the look up windows, see Chapter 5 - Operating the System.

SELECTING THE ASSET

On the Browse tab move the highlight bar with the cursor movement keys or start
typing the desired Asset Number.  When the highlight bar is on the asset you wish
to display, press the Edit tab in order to view the details about this asset.

From the Browse panel, you can use the Panel pull down Range or the F4 key to
select a Range of assets to work with.  For specific instruction on using the Range
feature, see Chapter 5 - Operating the System.

When an asset has been selected, the detailed asset information can be viewed on
the Edit tab screen.

When an asset is displayed, you may move the cursor from item to item and right
click on any field, or use the F5 key, and select Look up Value to view the look
up window associated with each item.

If you are not editing a RANGE of assets, you may press PgDn to view the next
asset from the selection list.  PgUp will display the previous asset.  Ctrl + Home
key combination will display the first asset on the selection list and Ctrl +End will
display the last asset.

Press the X at the top right of the window or press the ESC key to return to the
Main Menu.  Note that if you have pending additions or changes that you will be
asked to save or cancel them before you are allowed to close the panel.
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CHANGING ASSET INFORMATION

From time to time you will want to change, correct, or add information associated
with assets currently existing in the Bar|Scan system.

In addition to changing information associated with an individual asset, the Range 
feature permits you to identify a group of assets, and make the same change to the
entire group at one time.

Bar|Scan will only permit you to make a change to the Asset Number if the new
number does NOT currently exist in the Bar|Scan system.  This is because
Bar|Scan will not allow assets duplicate asset numbers to be saved.

Move the highlight bar to the desired asset and select the Edit tab.  The
information for the selected asset will appear.

If you intend to make a group change by using the Range feature, first use the SET
feature to identify the particular group of assets you wish to change.

Use the Range feature to select the group.  Select the Panel pull down Range, or
press F4 and the asset that you are currently on will change color; the default
Range color is green, to show that it has been selected.  You can then use your up
and down arrow keys, the PgUp and PgDn keys, Ctrl +Home or Ctrl + End
combination keys, or your mouse to select additional assets for your range.  Once
the items that you have selected are all highlighted, press Enter, and then select
the Edit tab in order to make your change(s).

Tip 1:  Double clicking an item in your browse window will also cause it to be
ranged. 

Tip 2:  When you are in the process of ranging several items that are not
consecutive, you press F4 and Enter.  Go to the next desired item, press F4 and
Enter.  If you press the F4 and accidentally range the wrong item, you can press
the F4 button again, and that last accidentally ranged item will no longer be
ranged.
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Note: This is a powerful feature, as you can now actually select more than one
Range at a time.  While this can be a real time saver, care must be taken that all
of your Ranges are intentional. 

After you have made your changes, press the Save icon as shown above, or press
the Ctrl + S key combination to save the changed information.  

If you have selected a group of assets by using the Range feature, Bar|Scan will
ask you if you want to save the changes to the one asset, and then ask if you want
to also send this change to the entire group of assets.
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DELETING AN ASSET 

This feature completely removes assets from the Bar|Scan system.  Obviously,
caution should be exercised when using this feature.

Removing assets from the system is most often done due to erroneous entries.  We
generally recommend that, when assets are disposed of, the assets remain in the
Bar|Scan system for an extended period of time, identified by some method you
devise to indicate a "disposed of" asset.  

Hint: Some may prefer to create a “disposal” location.  This allows assets to be
scanned into “disposal” with the  Mobile Device.

Bar|Scan permits you to identify a group of assets which can be removed from the
system all at once.  Use the SET feature to first identify a particular group of
assets that you wish to remove.

To delete an asset, you must first Range the asset(s) by using the
Range feature, Press F4 and then  press Enter, then select the Delete
button on the toolbar.  

You will see a dialog box similar to the one below.

Naturally, if you have ranged more than one asset, the above dialog box will ask
you if you want to delete the correct number of assets according to that range.  If
you choose Yes on the box above, you will be shown a dialog box asking you to
confirm your choice for deletion.  Choose Yes on this box to execute the deletion. 
You will be shown a dialog box that will tell you that the Deletion is complete.

Note: Confirmation displays (i.e., Really delete the selected asset?) can be turned
off.  This feature is available under Edit, Personal Program Preferences, Prompts.
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ENTERING NEW ASSETS

Use the Add Blank or the Add Template button to manually enter new assets into
the Bar|Scan system.  It is expected however, the vast majority of your company's
assets will be entered into the Bar|Scan system using the Mobile Device.

If you choose Add Blank, a blank line will appear, simply choose the Edit tab, and
you may add information or make changes to this blank record.  Many of the entry
items have associated look up windows to assist you with your data entry.

You may use the TAB key, the arrow keys, the mouse, and the ENTER key to
move to the different items on the screen.  The PgUp and PgDn keys will display
information from the previous or next asset respectively.  To quickly access a new
tab within the Edit tab, use the F3 key.

For your convenience when adding a new asset, you may use a template.  When
Add Template is the method of choice, select an asset similar to the one you are
about to add.  After selecting a similar asset, select the Edit tab and the asset
information will be displayed and you can change the appropriate information to
reflect the new asset.  Many of the entry items have associated look up windows
to assist you with your entry.

Press the X at the top right of this screen or the ESC key to return to the Main
Menu.  Note: if you have pending additions or changes you will be prompted to
save or cancel them before you are allowed to close the Asset table.

SCANNING  NEW ASSETS

In addition to entering the information manually using the asset entry screen, you
can use the Mobile Device and scan bar coded labels.

It is important to note that the two methods complement each other, i.e., some of
the information could be entered using each of the methods to complete the
information for a particular asset.

The Mobile Device is most often used to take inventory and to enter several assets
(e.g., when you originally enter your assets).  However, it should also be used to
record new assets when they are received.
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 The Asset Table Information

The first tab on the Asset Table displays facilities related items.  There are fields
for:  departmental ownership, the name of the person using the item and their
telephone number, status, and condition for each asset.  In addition to the unique
asset number used in the Bar|Scan system, you are provided space to enter a
different ID number (Secondary #) and Serial Number for each asset.

THE FIRST TAB - ASSET

All of the information on the Asset tab can be entered manually or can be
collected by the Mobile Device.

Any of the items that appear in red and have a red underline are items that have
a hyperlink feature.  If you left click on these items, you will be able to view the
information for that item in a look up window.

To move quickly to the next tab, the Inventory tab, press the F3 key.
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Asset Number

A unique Asset Number is required for each asset entered into the Bar|Scan
system.  The number is established using a bar code label which is affixed to the
asset.  Each label contains a unique number and the bar code representing that
number.

There is one exception; it occurs when you are using the Quantity field.  This is
discussed later.

The Asset Number can be up to 80 characters in length.  The number need not be
a fixed length, since Bar|Scan can justify and pad numbers automatically. 
Therefore, for equipment only inventories, you can use serial numbers as asset
numbers.  If you do decide to follow this course, be aware of the disadvantages,
e.g. physical access. 

The number may be entered into the system using the Mobile Device, or
manually.

Since all asset numbers must be unique, when you are manually adding assets,
care needs to be taken that your new asset number is both unique yet similar to
those already in the system.  You may right click on the asset number or press the
F5 key and select look up value.  This will display all of the asset numbers already
being used. You may type the entire number, or you can move the highlight bar
to a similar number and press the right arrow key to enter numbers from the look
up window.  When this is done, press ENTER and change the digits to correspond
with a new Asset Number.

Bar|Scan is designed to monitor the new asset number as you enter it to make sure
you do not duplicate an existing number.  Most new asset numbers are assigned
sequentially, i.e., the next asset number assigned will differ only in the last one or
two digits.
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Catalog Information

The Catalog identifies and defines the nature of assets.  A Catalog Identification
Number consists of a two-character Category and a four-digit Number.  Bar|Scan
provides a list of predefined Categories to identify groups of like assets.  The
Catalog Numbers describes that specific type of asset.

The format of the Catalog (two-character Category and a four-digit Number) can
be modified using the User Defined Fields Module.  This is not recommended
unless for a specific purpose such as interfacing with a Legacy system.

Category

The Bar|Scan system provides a list of predefined general asset categories. 
Categories are used to quickly identify a particular group of assets with the same
general description.

When you press right click on this field or press F5, then select Look up Value,
a look up window similar to the one below will appear.

You may select one of the categories by entering the two letter code, using the
mouse, or by moving the highlight bar to the desired item and pressing ENTER,
or by clicking the OK button.
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You may also add a category of your own design.  You have to add the Category 
in the Catalog, Categories table.  Then, you have to add a valid catalog number
before you may use the Catalog (XX9999) in the Asset table.  Please see the
Catalog chapter in this User Manual for more information.

Catalog Number

The Catalog Number defines the specific asset description based on the different
choices established using the Bar|Scan Catalog feature.

The Bar|Scan Catalog feature permits you to define and assign numbers to
different assets in a way most meaningful to your organization.

When you right click on this field or press F5, then select Look up Value, a look
up list similar to the following will appear.

The above window will display existing Catalog Numbers for the Category
previously selected.

Select one of the Catalog numbers by moving the highlight bar to the desired
number and then press ENTER.
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After you select a Catalog Number, a Type and Description will be displayed on
the Entry Screen (if a Type and Description are listed as part of that Catalog).

As you can see from the Look Up list below, as in other Browse Windows, you
can Right Click on any Catalog (XX9999) or Asset Number column title and view
images, if they are available. 

Hint: If you cannot find the Catalog you want, you can hyperlink to the Catalog
table by clicking on the red underline.  Once in the Catalog table, add a new
Catalog, save the Catalog, and then use the new Catalog number in the Asset
table.

Type and Description

The Type and Description are automatically displayed for you when you enter a
valid Catalog number (if Type and Description are filled out in the Catalog table
for that particular Catalog).

You may however, not know the Catalog Number you want to use, and may use
these items to locate the Catalog Number.
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Hyperlink to the Catalog table.  Sort the information by Catalog type and
description by using the Set button on the tool bar. 

Use the seeking feature and the cursor movement keys to browse through the list
of items.  

If you find the correct item, note the Catalog Code (XX9999).  Return to the Asset
Display Screen and enter the Catalog Code.  

The correct Type and Description will be displayed, according to the Catalog
Code you have entered.

The length of the Type and Description fields can be modified using the User
Defined Fields Module.
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Quantity

Bar|Scan will allow you to track assets without the need to apply individual bar
code labels.  The Mobile Device can perform an inventory prompting for Quantity
instead of Asset Number.

You can use the Quantity inventory in both the TAG and TAKE mode of the
Mobile Device.

For more information on using the Quantity prompt with the Mobile Device, see
Chapter 11 - Bar|Scan Mobile.

The following briefly describes how the Quantity prompt works.  When the
Mobile Device is in Quantity Mode, asset numbers are not entered into the Mobile
Device, but created by Bar|Scan once the information is uploaded and validation
takes place.  These newly created asset numbers are called “Z numbers” because
the left most character of these asset numbers always begins with the letter Z.  The
numbering scheme is alpha numeric.  The asset number length is the same as your
normal asset number length.  

Bar|Scan will automatically keep track of what Z numbers have been used, and
continue the assignment at the next upload of quantity items.  

You simply need to enter into the Mobile Device: where the items exist, the
Catalog Code (XX9999), and how many items there are.  If you use the Purchase
Order number or other fields, they will also be considered when creating unique
Z numbers.

You determine which combination of fields will make a Z number.  This is done
on the Company Settings Screen on the Qty Assets Tab.  It is important to decide
this combination before entering your first items.

You may also collect additional information not related to the combination of
fields discussed in the prior paragraph.  Be careful that the information collected
reflects information about the entire group of assets.  For example, you may want
to collect condition.  You may want to enter the condition into the Mobile Device
as Good, but if you say Good, all of the items you are counting for that one
Catalog should be in Good condition.  
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The following is a sample of the asset numbering scheme that Bar|Scan uses:

ASSET # QUANTITY ROOM TAG
FIELD   FIELD         LOCATION CATALOG

Z00000 5 L00050 SE1054
Z00001 2 L00583 SE1089
Z00002 3 L00583 TA4100
Z00003 6 L00032 SE1054
   . .      .      .
   . .      .      .
   . .      .      .
Z00009 9 L00393 EP1003
Z0000A       20 L08092 EO1489
Z0000B        10 L09802 EO1489
Z0000C 5 L00033 TA4100

As you can see from the above example, Bar|Scan assigns a Z Number to each
combination of unique Location and Catalog (and other optional fields determined
by you).

Z Numbers are most often used in warehouse settings where you want to know
how many of each asset is located at each pallet location but do not want to bother
with the application of a bar code label.

You can put more than one kind of asset at a pallet location (different Catalog
numbers) and you can put the same kind of asset at more than one location.

When you perform a second inventory to update your existing Z numbers (TAKE
Mode with the Mobile Device without using a ‘From’ and ‘To’ Location), you
will enter in the actual quantity on hand.  For example, if there are 2 SE1054 items
located at Location L00050, enter 2 into the Quantity Prompt of the Mobile
Device.  When this information is Synchronized with the Bar|Scan system,
validated and moved from the Transaction to the Asset Table, the Current
Quantity will show 2.
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Bar|Scan maintains this accuracy by adding an adjustment entry into the Asset
Location History as shown below.

 

Note that this adjustment entry is only made for quantity inventory or ‘Z numbers’
and only in the case where the Mobile Device is configured with only one
location.

Because of the Transaction Validation process, you might need to change Error
46 from an Error to a Warning so that these Transactions will move.

Prior Label

The Prior Label field is used to show the old Asset label when you have had to
replace an Asset label with a new one.  

When doing a Take (inventory done on an asset that already has an existing bar
code label in the Bar|Scan system) with the Mobile Device, you may occasionally
find assets that have a worn or unreadable asset tag on them.  You can easily
replace this old tag, and still retain all of the history of the asset by doing a label
replacement.
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Simply scan the new asset number in the Mobile Device, then you will be
prompted to replace the bar code label, if you are replacing the label, simply
cursor up to respond Yes, and then scan or enter the old asset number.  Remove
the old asset label, and replace it with the new one.  When the information is
uploaded, and then validated, the history of the asset is saved with the new asset
number, and the old number appears in this Prior Label field.

Secondary Asset Number

This item is optional, provided to permit you to enter another identifying number
of your own choosing.

Often, the Secondary Number is used to record an asset number from an asset
numbering system in use prior to the installation of Bar|Scan or a second tag
applied by a different agency.

Bar|Scan can produce reports containing selected items and sort by the Secondary
Number.  This simplifies comparison and analysis with reports generated by
previous software applications.

Type the desired characters and press ENTER.

System Number

This item is optional and is used to record a number linking items together
creating a System.  For example, to link a Personal Computer with its components, 
i.e., Monitor and Printer, scan the Personal Computer’s bar code asset tag into the
System Number on the Mobile Device.  In this example, no matter how many
Personal Computers are in a particular location, you will be able to identify each
Computer System separately.

System Number can also be used to link other types of assets including
workstations and specialized equipment.

Type the desired characters and press ENTER.

Serial Number

This item is optional and is used to record the manufacturer's serial number of the
asset.

Note that many manufacturers now include a bar code label on their product
which will identify the product serial number. Bar|Scan permits you to scan this
code with the Mobile Device which will enter the serial number automatically.
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Normally, the Serial Number must be unique.  However, if you wish, you can turn
off the validation feature in Housekeeping and save assets with duplicate Serial
Numbers.  

Type the desired characters and press ENTER.

The Condition Table

This entry describes the current physical condition of the asset.  The following are
predefined responses:  Good, Fair, Poor, or Not Applicable.  You may, however,
add to, change, or delete these responses to meet your individual needs.  As with
other fields, the length of the code and response can be changed using the User
Defined Fields Module.

When you want to change, add, or delete valid responses for the Condition field,
you will need to open the Condition table.  From the Main Menu, select File, then
Open ...<, then Asset ...<, then Conditions as shown on the following example.
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You will be shown a screen similar to the following.

You may add new responses according to your needs.  You have an unlimited
number of possible choices.  A blank entry is also a valid response but you must
add it to the Condition table.  

When you need to add a condition response, simply select the proper condition,
choose add blank or add template, then select the Edit tab.  If you are changing a
condition, simply select the condition you wish to change, then select the Edit tab. 
An Edit tab, similar to the one below will appear.
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Note: You can synchronize these Conditions into the Mobile Devices.

While on the Asset table, and on the Condition field, you can right click or press
F5, and select Look up Value, a look up window similar to the one below will
appear.

You may either enter the appropriate letter(s), or move the highlight bar to your
choice and press ENTER.  If you are proficient in use of the system, you can enter
a Condition without using the F5 key by simply typing it into the field.
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The Status Table

This entry describes the current status of the asset.  There are some predefined
choices already listed in Bar|Scan.  You may, however, add to, change, or delete
these responses to meet your individual needs.  As with other fields, the length of
the code and response can be changed using the User Defined Fields Module.

When you want to change, add, or delete valid responses for the Condition field,
you can simply use the hyperlink feature to go to the Status table by clicking on
the red underlined word on the Asset table.  Or you can open the Status table from
the Main Menu, by selecting File ...<, then Open ...<, then Asset ...<, then Status
as shown on the following example.

Assets Page 6-43



Assets

When you select Status from the Main Menu, you will see a window similar to the
following.

If you need to add or change a Status response, simply select a like response from
the above list, and select the Edit tab.  You will be shown a window similar to the
one below.

On this tab, you may add a new code, or change an existing code.  Press the Save
icon on the toolbar, or the Ctrl + S key combination to save your new Status
response.
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You may add new responses according to your needs.  You have an unlimited
number of possible choices.  A blank entry is also a valid response but you must
add it to the Status table.  

If you are using the 445 Period Type of depreciation, you will want to add a Status
Code ID with a Status Description of IDLE.

Note: You should make sure that all of your Mobile Devices are configured to
have the same responses available as in the Status table.  Otherwise, when the
information is validated in the Transaction table, each record will display an error
message saying that the Status should be IU, IS, etc.

When you right click on the Status field or press F5, and select Look up Value, the
following look up window will appear.

This look up window will show you all of the existing Status responses that are
currently in your Bar|Scan system.  You may enter either the appropriate letters
(IU, IS, or NA), or move the highlight bar to your choice and press ENTER.  
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Organization Code

This code is used to identify the different combinations of Division, Department,
and Unit. 

The Division, Department, and Unit are associated with the Organization Code
inside the Organization table.  So, you may select an Organization Code in lieu of
entering the Division, Department, and Unit.  

When you move the cursor to the Organization field and right click or press F5,
and select Look up Value, a  look up window similar to the following will appear.

The information inside your window will reflect what has been entered into your
Organization table.  Move the cursor to the desired item and press ENTER.

When you select an Organization Code, the associated Division, Department, and
Unit will be automatically displayed on the Asset table below the Organization
Code field.

If you need to Add, Change, or Delete an Organization Code, you may use the
hyperlink feature to open the Organization table.  While on the Asset Table,
simply click on the red underline for the Organization code, and the Organization
table will open.

The Division, Department, and Unit entries are provided to permit you to identify
the different organizations which have possession and responsibility for the asset. 
You may identify from zero to three different organizational levels.  Your choice
for these entries will depend on the nature and structure of your particular
company.
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For example, the organization responsible for a particular Personal Computer
might be the West Coast Division, the Accounting Department, and the Accounts
Payable Section.

These entries permit you to describe assets for which the physical location may
not coincide with the organizational responsibility for the asset.  

Using the previous example, the A/P section may have the use of a mainframe
computer terminal which is the responsibility of the Data Processing Department.

As with other fields, the length of the Organization Code as well as the Division,
Department, and Unit can be changed using the User Defined Fields Module.
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Current Owner Information

The Ownership information identifies how the asset is owned or how it was
obtained: leased, purchased, customer furnished, etc.  To help identify specific
asset locations, the name and telephone number of the person using the asset can
be entered.

Owner Method

This entry identifies how the asset was acquired.  Bar|Scan provides several
different choices depending on how the asset was financed or otherwise obtained.

Place the cursor in the Owner Code field, right click or press F5, and select Look
up Value, a look up window similar to the following will appear.

You may select one of the choices, or press ESC to leave the entry blank.  
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The Ownership Table

If you want to add, change, or delete choices from this look up window, you will
have to open the Ownership table.  You can open the Ownership table by clicking
on the red hyperlink on  the Asset table, or by going to the Main Menu in
Bar|Scan, and select File ...<, then Open ...<, then Asset ...<, then Ownership as
in the following example.

You will be shown the following Ownership table.
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You may add, change, or delete the items listed according to your needs.

If you wish to delete an Ownership Method, simply Range the item on the Browse
tab, and press the Enter key.  Then, select the Red X delete button from the tool
bar.  

If you wish to add an Ownership Method, simply select a like item to the one you
want to add, and select the Add Template button on the tool bar.  Select the Edit
tab, and change the fields to display the new Ownership Method.  Save your
changes by clicking on the Save icon or press the Ctrl + S key combination.

If you want to change an item then select the response that you want to change,
then select the Edit tab which is illustrated below.

Change the information that is incorrect, and save your changes by clicking on the
Save icon or press the Ctrl + S key combination.

Page 6-50 Bar|Scan



Chapter 6

Name

This entry is most often used to identify the name of the person using (or
responsible for) the asset.

Some companies prefer to use the name of a supervisor or department head.

Place your cursor in the name field, right click or press F5, then select Look up
Value, a look up window similar to the following will appear.

You may select one of the names, or press ESC to leave the entry blank.

You may move the cursor to the desired part of the entry and type in the name
without using the look up window.  Bar|Scan will update the look up value
automatically when your new entry is saved.

The Name entry can be collected with the Mobile Device and is also saved as part
of the Location History Table.  Therefore, every time you use the Mobile Device,
you can collect a new name; the name previously scanned will be retained. 

We recommend that you open the Personnel Table and enter or import your names 
from your existing personnel list.  As with other fields, the length of the Name
field can be changed on the Company Settings Screen.  The Personnel Table has
additional Fields to hold employee related information such as their Employee ID
and email address. 

Hint:  think carefully before using the Name entry.  The more items you enter, the
more work it will be to maintain the accuracy of the system.  Because of churn
and turnover, it may require a lot of effort to maintain this item.

Telephone
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Bar|Scan permits you to enter the area code, telephone number, and extension
number of the individual responsible or using the asset.  You may enter any or all
of the numbers.

Move the cursor to the desired part of the entry and type in the numbers. 

You can change the default telephone format by accessing the Company Settings
Screen and modifying the existing Input Mask as shown below.

For example, the default is “(###)###-####:####”, if you were only interested in
the last five digits and did not have extensions, you could change the format to
“#:####’.
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CURRENT AND PREVIOUS LOCATIONS

One of the important features of Bar|Scan is the ability to define a specific
physical location for each asset.  The location information for each asset can be
viewed near the bottom of the Edit tab as shown below.

Bar|Scan also provides historical location information.  Previous locations may
be displayed by using the scroll bar at the right of the location.  All prior locations
are displayed sequentially.  You can scroll, using the arrow keys or mouse,
through all of the recorded previous locations.

You can customize your display by changing the order of the columns by clicking
on the title bar for that column,  holding the mouse button down, and dragging the
column to a new location.  The rest of the columns will move to fill in the space.

Each time an asset is moved, you will want to record the new location and move
the Current location to the Previous location.  The Mobile Device will do this
automatically.

An asset location is can have one of three types.  These are Site, Pallet, and Vault. 
Bar|Scan has named these four levels for the Site type of location:  Region,
Building, Floor, and Room.  The selection of these level titles is based on the most
common industry practice.  However, you may use a scheme which is appropriate
for your particular organization.  The important thing about a location code
scheme is that it will precisely locate any and all of your assets in all of your
company facilities.

The four location code entries are designed to be used in a hierarchy.  This means
the lowest level (the Room identification) is located within the next higher
location level (the Floor identification), which is located within the next higher
location level (the Building identification) which is located within the highest
location level (the Region identification).

Note that the number of levels used, the definitions of the different levels, and the
actual codes entered are defined by you and should be developed prior to entering
assets into the Bar|Scan system.
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You can optionally assign a Location Description to the four location codes as
well as a Bar Code Room Tag to assist the inventory process.  The Bar Code
Room Tag is usually placed on the door jamb, column, or other permanent
location during the course of your first inventory.

Bar|Scan also provides historical location information.  The most recent prior
location is displayed.  Previous locations may be displayed by moving the cursor
to the Location History button and then press ENTER.  A look up window will
appear showing all of the previous locations.  You can scroll up or down through
the list of previous locations if more than three locations exist.

Each time an asset is moved, you will want to record the new location and move
the Current location to the Previous location.  This is done automatically by use
of the Mobile Device.

Inserting and Deleting Locations

When an asset has been moved, the easiest and fastest way to document the
change is to do a physical scan with the Mobile Device.  But, it is possible to
change the information in the Asset table using the keyboard  to record the new
location.  You will need to perform the following steps.

Go to the location section of the Edit tab screen, then select the current location. 
Select the Add Template, or Add blank button to the left of the location.  Bar|Scan
will insert either a blank line or a template of the current location.  Simply edit
this location, making changes where necessary.

You may enter the new location information, right click on the current field or
press F5, and select Look up Value.  A look up window will appear showing all
of the valid locations from which to choose.

You may also remove the current or any previous location by positioning the
highlight bar over the location and pressing the Delete button, located on the left
of the location.  You will be asked to confirm your deletion choice.

If you have used a template to add the new asset, you will want to remove the
current and previous locations.  This is accomplished by positioning the highlight
bar over each location, and clicking on the delete button.

Alternatively, you can type a new location over the previous location, or use the
F5 key and choose Look up Value to list all locations and select a new location. 
Note that each site location is a combination of a Region, Building, Floor, and
Room.  If you change one of these items, you must select the appropriate
corresponding items.  Therefore, unless you are familiar with all of your locations,
the best way to add or change a location is by using the Look up Value.
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Region, Building, Floor, Room

Move the cursor to any of these items and right click on the field or press F5, then
select Look up Value, a look up window similar to the following will appear.

You can select from the list in the window to enter the rest of the location items
or you can press TAB to go to the next location item.

Most often, these codes will be entered by using the Mobile Device during a
TAGging or other inventory process.
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Room Tag

A Room Tag is a bar code label which is used to identify a specific location.  The
label is usually affixed to a door jamb leading into the particular area or room.

Here is how it works:  The first time a particular set of location codes is entered,
a Room Tag number is assigned to that location.  This can be accomplished  when
all five bar codes are scanned, Region, Building, Floor, Room, the Room Tag, and
the information is uploaded.  When all five codes are used together, the program
associates the information.  After that, when a Room Tag number is entered into
the system, the location codes will automatically be displayed without having to
scan them.

This feature will save you considerable time when you take inventory as you will
only need to scan the Room Tag rather than scanning it and the other location
codes, i.e., Region, Building, Floor, and Room.

If you wish to enter a new Room Tag number using the keyboard, first identify a
set of location codes.  Then type the Room Tag characters into the Room Tag field
and press ENTER.  Most often however, Room Tag numbers will be entered using
the Mobile Device.

Work Order Number

An entry is provided to record a Work Order Number associated with the asset. 
This can be manually entered.  If you have the Work Order Module, you will want
to use the Mobile Device to collect the Work Order Number generated when
Work Orders are entered.

If you do not have the Work Order Module, you may use the Work Order Number
field to enter a number which authorized moving the asset, i.e., a purchase order
number to a moving company, a purchase order number which ordered the asset,
an internal work authorization number, or a number used to identify a move.  The
Work Order Number can indicate when the asset was placed in service at the
current location.
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Description

The Location Description identifies more detailed information than can be
obtained by the Region, Building, Floor, and Room combination. For example,
a Location Description could be “Workstation Type 5 - Open - Disability
Accessible” or it could be as simple as “Conference Room - Large.”

The Location Description is not an independent item.  Rather, each Site Location
Description is linked to a Region, Building, Floor, and Room.

The Location Description is automatically entered when you select a particular 
Region, Building, Floor, and Room when that location has the description filled
out in the Location table.

You can move the cursor to the description field and type the appropriate
characters.  Or place the cursor in the Location Description field and right click
or press F5, and select the Look up Value, and then select a Location Description,
the corresponding Region, Building, Floor, and Room will also be changed.

The Location Description field in an Asset table, will work with and update the
entire Pallet or Vault type of location as well.

When you update the Description for a Pallet location, the Building, Row, Bay,
Slot, and Level will also be updated.

When updating the Description for a Vault location, the Building, Vault, Row,
Bay, and Level will also be updated.

Move By, Move Date, and Move Time

When adding an additional line to the Location History, this information is
automatically filled in for you, using the login initials, the current date, and the
current time.  If you would like to make changes, place your cursor in the field you
wish to change, and type in the new information.

Note: You are not allowed to enter a future date.  Because Bar|Scan relies on dates
to sort location history, entering a future date could have serious side effects, and
is therefore not allowed.

When the inventory information is entered using the Mobile Device, the system
automatically uses the current information entered into the Mobile Device. The
user’s initials, the date, and the time from the bar code reader should, therefore,
be checked EVERY time the Mobile Device is used.
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Managing the Arrangement of Asset Location History Columns on the Asset
Screen

When you select the Edit Tab on the Asset Screen, you are presented with details
about each individual asset.  The lower section is titled ‘Asset Location History’
and displays all locations where the asset was located during a physical inventory. 
In other words, this is the history of the asset’s location.

Most locations are added during the physical inventory process, however,
locations can be added or changed manually at the keyboard also.  For example,
if an asset was accidentally entered into the wrong location, you can correct the
mistake manually at the keyboard.

By default, there are many columns displayed and they are displayed in a
particular order.  This arrangement may not be suitable for every user.

There are six editing actions that can be performed on the columns.  These are:

1.) Move columns - You change the order of the columns in a Browse window. 
Simply place your mouse on a column header, and it will turn into a thick black
arrow. Left click and hold the mouse button down, and drag the column to the left
or right.

2.) Stretch or shrink columns - You may also change the width of a column by
placing your mouse on the line that divides the columns (still in the shaded header
area).  When the mouse pointer changes into a plus shape with a double arrow,
you may left click, hold the mouse button down, and drag the edge of the column
to the left or right.
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3.) Change font of columns - Place your mouse on a column header and right
click.  You will see a menu with three choices.  Font, Image and Remove.   Right
Clicking on any title will allow you to change the font on that column separately.
You can set the column to the default font or you can select a new font for the
column.  You can also change the font on all of the columns if you right click in
the very left hand box you will see an item to change the font on all columns as
shown below.

4.) Add images to columns - Place your mouse on a column header and right click. 
For most columns, you will see a menu with three choices.  Font, Image and
Remove.  By selecting Image, the data will be replaced by the image associated
with the data provided that the image exists in the image folder.  You may need
to expand the row height to see the image detail.

5.) Remove columns - Place your mouse on a column header and right click.  Place
your mouse on a column header and right click.  You will see a menu with three
choices.  Font, Image and Remove. 

6.) Restore columns - 

a.) If it is a regular BarScan field and not a Location History User Defined Field
(UDF) then Right click in the very left hand box you will see an item to change. 
Select ‘Data Columns’ then ‘Set to Default’. This will restore all missing
columns. 
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b.) If the field is a Location History User Defined Field (UDF) then the removal
of the column is only temporary in the Asset Screen. It will reappear every time
the Asset Screen is closed and reopened, since the ‘Visible in Detail’ checkmark
in the UDF definition takes priority.

Page 6-60 Bar|Scan



Chapter 6

THE SECOND TAB - INVENTORY

Scan Information

These entries are used to identify the person, date, and time of the last inventory. 
Usually this information will be entered into the Mobile Device during the
physical inventory and then loaded into the Bar|Scan system in the computer.

A field is provided for special comments regarding the asset.

Inventoried by, Inventory Date, and Inventory Time

These three items will be recorded by the person using the Mobile Device during
the inventory or tagging process.

Since these entries are collected by the Mobile Device, they cannot be changed
except through the location history line items.

Note that you are not allowed to enter a future date.  Future dates are marked as
errors in the Transaction Table.  Because Bar|Scan relies on dates to sort location
history, entering a future date could have serious side effects.

Comments

An entry is provided  to record a Comment associated with the asset.  This can be
manually entered or updated using the Mobile Device.

Most often, comments will be entered by using the Mobile Device during a
TAGging or other inventory process.  When you use the Mobile Device, they are
moved from the Inventory Information Area to this area.

Comments are often entered into the bar code recorder during an inventory. 
However, comments may be entered at any time using your keyboard.
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This item can be used to enter comments about any aspect of the asset, not just
comments about an inventory, i.e., scratched or dented.

Disposal/Sale

Disposal Date

The Disposal Date is the date that you choose to assign to the disposal, retirement,
or sale of your asset.  It can be derived from a disposal document.

Enter the date by moving the cursor to the desired item, typing the characters and
pressing ENTER.

The Disposal/Sale information that you enter does not remove the asset from the
Asset table.

See Disposal of Assets in Chapter 2 - Suggested Procedures for more information
regarding procedures you may wish to consider in handling disposal.

To remove an asset from the asset file you may use the Delete button in the tool
bar.  

Disposal Type

This entry identifies a Disposal Type for your asset.  It can be any single character
of your choice.  Since it is an optional item, it can also be left blank.

Move the cursor to the desired part of the entry and type a character.  Since this
is a single character, there is no need to press ENTER when finished.

Sales Value

The Sales Value can be any number that you decide to assign to the disposal or
sale of the asset.  It is an optional item and does not affect other information on
the screen.  Your accounting department may have guidelines it uses.

Buyer

The Buyer is optional information that you may enter to record who received the
asset upon disposal or sale.

Enter the Buyer by moving the cursor to the desired item, typing the characters
and pressing ENTER.
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Remarks

There are three independent lines of Remarks available.  They can be used in
conjunction or independently.  Remarks may be entered at any time.  They can be
used to enter comments about any aspect of the asset, not just financial comments. 
Each remark line can be printed independently by the Report Generator.

Enter remarks by moving the cursor to the desired item, typing the characters and
pressing ENTER.

As with other fields, the length of the Remarks field can be changed using the
User Defined Fields Module.

Important:  Remember to press the Ctrl + S key combination or the Save icon to
save your work prior to leaving the Asset Entry Screen.
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THE THIRD TAB - ACCOUNTING

Asset Information

Purchase Order Number

Bar|Scan permits you to enter any alphanumeric Purchase Order Number for the
asset or group of assets you are working with.

Move the cursor to the desired part of the entry and type in the number.  When the
entry is complete, press TAB or the Enter key.

The Purchase Order Number can also be collected with the Mobile Device.

Vendor

This entry identifies the vendor of the asset.

Move the cursor to the desired part of the entry and type in the desired
information.  When the entry is complete, press TAB.

The Vendor is normally not the Manufacturer of the asset, but the seller of it. 
However the list of Vendors will be stored in the Manufacturer table.

To change the Manufacturer, you may click on the red underline to hyperlink to
the Manufacturer table.  Once at the Manufacturer table, you may add, correct, or
delete a Manufacturer or Vendor.
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Purchase and Received Dates

The Purchase Date indicates when the asset was purchased.  Generally, it reflects
the date indicated on the Purchase Order number used to procure the asset(s).

The Received Date indicates when the asset was received by your company or
department.  It can be the date that the asset was delivered to the company or
when the asset was put into service by your department.

Whatever method you choose to specify the Received Date, it is best to be
consistent for all of your assets.

Enter these dates by moving the cursor to the desired item, typing the characters
and pressing TAB.

New Or Used

This entry identifies whether the asset was new or used at the time of purchase. 
Since it is an optional item, it can also be left blank.

Move the cursor to the desired part field and right click or press F5 and select
Look up Value.  A look up window will appear and you may select the appropriate
response.  You may type either N for New or U for used.  Since this is a single
character, there is no need to press ENTER when finished.  

General Ledger Numbers

There are spaces for three General Ledger numbers here.

The General Ledger Number is a number used to facilitate record keeping and
internal control of your companies' financial records.  Needless to say, in order to
control assets by General Ledger number, you will probably have to consult your
accounting department.

The General Ledger Number can be used as a Primary Link to your financial
accounting system.  Type the desired characters and press TAB.

As with other fields, the length of the General Ledger field can be changed using
the User Defined Fields Module.
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THE FOURTH TAB - BASIS

Valuation

Purchase Cost

The Purchase Cost indicates what was paid for the individual asset.  Generally, it
is the unit cost of the asset prior to the addition of other charges involved in the
procurement.

If the Purchase Cost information you have is for a lot or group of assets, you must
allocate a portion of the total cost to each asset.  If the purchased group consists
of all like assets, the cost can be divided evenly among all of the assets.

Alternatively, a “standard” Purchase Cost can be entered into the Catalog Table,
which can then update all new assets automatically when these assets are first
entered.  

Note: Placing the Purchase Cost into the Catalog only updates new assets.  It will
not update existing assets, nor will it override any information that is already in
the Purchase Cost field in your Asset table.  You may change the Purchase Cost
once the information is in your Asset table.

In any case it is best to consult your accounting department for proper allocation
of this cost.

Remember: if you are working on more than one asset and change any
information, all of the assets in your "range" can be updated.  This can be of
benefit if you want to assign a standard cost to a large number of assets.  For more
information on how to use the Range function, see Chapter 5 - Operating the
System.

Enter the Purchase Cost by moving the cursor to the desired item, typing the
numbers and pressing TAB.
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Tax

Tax normally is the amount of sales tax paid on the purchase of the asset.  Often
it is important to keep this amount separate from other costs so that it can be used
for quarterly sales tax reporting, or other financial requirements.

The Tax is not automatically calculated as a percentage of the Purchase Cost. 
Enter the Tax amount by moving the cursor to the desired item, typing the
numbers and pressing TAB.

Installation and Freight

The Installation and Freight Costs indicate what was paid for the delivery and
set-up of the individual asset.

If the Installation and Freight Cost information you have is for a lot or group of
assets, you must allocate a portion of the total cost to each asset.  If the purchased
group consists of all like assets, the cost can be divided evenly among all of the
assets.  In some cases, especially with systems furniture, the installation cost will
be one figure for an entire project.

In any case it is best to consult your accounting department for proper allocation
of this cost.

Enter the Installation and Freight Cost by moving the cursor to the desired item,
typing the numbers and pressing TAB.

Additional

Additional (Cost) is provided for those costs that are incidental or unique to your
particular situation.

Enter the Additional Cost by moving the cursor to the desired item, typing the
numbers and press TAB.

Total Cost

The Total Cost does not have a title, but is listed as the sum of the Purchase Cost,
Tax, Installation, Freight, and any additional costs that were entered.

The Total Cost is a calculated item of information.  This means that you do not
need to enter the sum of the costs, as it is automatically done for you.
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As mentioned before, the Total Cost is the cost for one asset only, if the cost
information you have is for a lot or group of assets, you must allocate a portion
of the total cost to each asset.  If the purchased group consists of all like assets, the
cost can be divided evenly among all of the assets.  In any case it is best to consult
your accounting department for proper allocation of this cost.

Salvage Value

The salvage or residual value is the estimated value of the asset at the end of its
useful or depreciable life.  This can be an estimate, but is most often based on an
accounting standard such as 10% of the Total Cost.

In any case it is best to consult your accounting department for proper allocation
of this value.

The Salvage Value is not automatically calculated as a percentage of the Total
Cost.  Enter the Salvage Value by moving the cursor to the desired item, typing
the numbers and pressing TAB.

Base Amount

The Base Amount is a function of two numbers: the total cost and the salvage
value.

The Depreciation Base is a calculated item of information.  This means that you
do not need to enter a number, as it is automatically done for you.

The Depreciation Base is the basis for calculating the depreciation expense.

Adjusted Base Amount

The above items are calculated items of information.  This means that you do not
need to enter these number, as it is automatically done for you.

They are a result of other entries made in the Depreciation portion of the data
entry screen.

You can specify that the Report Generator print this item in the same manner that
you can specify other items that you have entered.

Page 6-68 Bar|Scan



Chapter 6

THE FIFTH TAB - DEPRECIATION

Initial Depreciation

There may be times when you will have accounted for asset depreciation in
another system prior to your purchase of Bar|Scan.  When these assets are
imported into Bar|Scan for the first time, you have the option of recording the
Initial Depreciation so that Bar|Scan calculates the remaining depreciation on a
modified base.   This is discussed in more detail below.

Start Date

The Depreciation Start Date is the date that you choose to begin the depreciation
expense.  It does not need to be the same date as the purchase or received date. 
For simplicity, it is often rounded to the first day of the preceding month.

Whatever method you choose to specify the Depreciation Start Date, it is best to
be consistent for all of your assets.

Enter the date by moving the cursor to the desired item, typing the characters and
pressing TAB.

See a Word About Depreciation in this section for more information relating to
how Bar|Scan ignores the day of the month for depreciation purposes.

End Date

The Initial Depreciation End Date is the last date that your other system performed
its depreciation calculation on your assets.  This may or may not be the same date
as the date you import your assets into Bar|Scan.
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Accumulated

The Initial Accumulated Depreciation is the  calculated amount of depreciation
performed by your other system on the Initial Depreciation End Date discussed
above.

This information is normally imported.  Bar|Scan does not calculate this item.

Bar|Scan will calculate the remaining depreciation based on the information
contained in the Initial Depreciation End Date and Initial Accumulated
Depreciation fields.  For example, if an asset had previously been depreciated at
an accelerated rate, and you now specify straight-line, Bar|Scan will apply the
straight-line method only to the remaining balance and remaining months of
depreciation.

Method

You can enter the method of depreciation used prior to importing the assets into
Bar|Scan.  This information is static and not used by Bar|Scan for any calculations.

Note

You may enter any notes that may be relevant to the import, for example the file
name that was imported.

You can specify that the Report Generator print any of these items in the same
manner that you can specify other items that you have entered.
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Initialize Initial Depreciation

The Initialize Initial Depreciation Button is used to copy the current Value and
Depreciation fields into the Initial Depreciation Fields.  When you press the
button, you will see the following panel.

There are only a limited number of reasons to perform this function.  It is best to
consult with your Bar|Scan Administrator before performing this function as it has
important financial ramifications.
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Ongoing Depreciation

Method

There are many different methods available for depreciation of fixed assets. 
Standard accounting practices require that whatever method is chosen, it be
"systematic and rational.”

Because of its simplicity, the most widely used method for fixed assets at this time
is the Straight Line Method.  The straight line method is calculated as follows:

Total Cost minus Salvage Value
          Depreciable Life                      =  depreciation charge

The default Bar|Scan depreciation method is Straight Line.  Other methods can be
provided to you on a custom basis.

See a Word About Depreciation in this section for more information relating to
how Bar|Scan ignores the day of the month for depreciation purposes.

You can, however, use the down arrow, and select a method from the supplied
list.  If you need to add, change, or delete a method, you may click on the red
underline under Method to hyperlink to the Method table.
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The Method table is shown below.

The methods that have been entered here are samples.  You should discuss the
method that will be used at your facility with your accounting department.  Then,
you may use one of the methods shown here, or use one of these as a template
when adding your own method of choice.
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The Edit tab is shown below.

This template shows the method, a description of the method, how many years it 
should cover, an example of how much of a percentage should be calculated for
each year, what the percentages should total, and if it should use fiscal years.

Hint: If in your company settings show any month besides January, you should
click the checkbox by Use Fiscal Years.

Life (# Periods)

The depreciable life of an asset is theoretically based on its estimated service life. 
Practically speaking, the actual depreciation life is dictated by financial or
reporting requirements such as those required by the government.  Five year (60
months) and seven year (72 months) lives are typical for most fixed assets that you
will be tracking.

Bar|Scan requires the depreciation life be entered in number of months.

Enter the depreciation life by moving the cursor to the desired item, typing the
number of months and pressing TAB.
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Period Type

Bar|Scan supports both monthly and the 445 month period type.  Monthly is the
most widely used period of depreciation.  445 month is sometimes used when it
is important to synchronize to a weekly schedule.

The 445 month period type calculates depreciation only on months where the
equipment is being used.  To take advantage of this fact, you should add a Status
to the Status table equal to ID, IDLE.  

When assets are taken out of service, change their Status on the Asset table to ID,
IDLE.  When the item is placed back into service, change the Status back to IU,
IN USE.

Note:  If you plan to be able to scan this information into a Mobile Device,
remember that you have to add the new Status Code to the Configuration in the
Mobile Device, as well by synchronizing with Bar|Scan.

Use Half Year Averaging Convention

No matter when the item is placed in service, the Depreciation Start Date begins
the first day of the seventh month of the Fiscal Year.
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Start Date

The Depreciation Start Date is the date that you choose to begin the depreciation
expense.  It does not need to be the same date as the purchase or received date. 
For simplicity, it is often rounded to the first day of the preceding month.

Whatever method you choose to specify the Depreciation Start Date, it is best to
be consistent for all of your assets.

Enter the date by moving the cursor to the desired item, typing the characters and
pressing TAB.

See a Word About Depreciation in this section for more information relating to
how Bar|Scan ignores the day of the month for depreciation purposes.

Adjusted Start Date

For Straight-Line Depreciation, the Adjusted Start date is the Start Date rolled
back to the beginning of the month.  For 445 Depreciation, the Adjusted Start
Date is rolled back to the closest applicable month. 

Depreciation - Last Calculated Date

The Depreciation Last Calculated Date is the date for which you want to calculate
depreciation expense.  It can be a past or a future date and does not have to
coincide with the current date.

It does not need to be the same date as the purchase or received date.  For
simplicity, it is often rounded to the first day of the preceding month.

The date can be any date that you enter.  This means that you can look at historical
as well as future dates.

The computer does not update this date.  This must be done by you on an as
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needed basis.  You can update a group or all of your assets by using a "filter" as
described in the SET command.

See a Word About Depreciation in this section for more information relating to
how Bar|Scan ignores the day of the month for depreciation purposes.

End Date

The Initial Depreciation End Date is the last date that your other system performed
its depreciation calculation on your assets.  This may or may not be the same date
as the date you import your assets into Bar|Scan.

Period Start Date

For Straight-Line Depreciation, the Period Start Date is the same as the Adjusted
Start Date.  For 445 Depreciation, the Period Start Date is calculated. 

Period End Date

For Straight-Line Depreciation, the Period End Date is the same as the End Date. 
For 445 Depreciation, the Period End Date is calculated. 

First Fiscal Month

Assets are usually depreciated on an annual calender or fiscal basis.  The calendar
basis assumes that the year begins on January 1 and ends on December 31.  A
fiscal month can be any month in the year.  For example, If you choose to make
your first fiscal month April, then you would record the number 4 as your First
Fiscal Month.

Usually, you would record the First Fiscal Month globally for all assets.  This can
be done on the Company Screen.  See Housekeeping - Company for more
information on this.

You may record an alternate first fiscal month here if you have assets that you
would like to have a different fiscal month than the majority of your assets.

Fiscal YTD Depreciation

The Fiscal YTD Depreciation, is a calculated item of information.  This means
that you do not need to enter this number, as it is automatically done for you.

It is a result of other entries made in the Depreciation portion of the data entry
screen.

You can specify that the Report Generator print this item in the same manner that

Assets Page 6-77



Assets

you can specify other items that you have entered.

Base Amount

The Base Amount is a function of two numbers: the total cost and the salvage
value.

The Depreciation Base is a calculated item of information.  This means that you
do not need to enter a number, as it is automatically done for you.

The Depreciation Base is the basis for calculating the depreciation expense.

Adjusted Base Amount, Prior Accumulated Depreciation, Prior Remaining Book
Calc Date Monthly Depreciation, Remaining Book

The above items are calculated items of information.  This means that you do not
need to enter these number, as it is automatically done for you.

They are a result of other entries made in the Depreciation portion of the data
entry screen.

You can specify that the Report Generator print this item in the same manner that
you can specify other items that you have entered.

Calc Date Monthly Depreciation, Accumulated Depreciation, Remaining Book

The above items are calculated items of information.  This means that you do not
need to enter these number, as it is automatically done for you.

They are a result of other entries made in the Depreciation portion of the data
entry screen.

You can specify that the Report Generator print this item in the same manner that
you can specify other items that you have entered.

Fully Depreciated

The Fully Depreciated Flag is checked on by Bar|Scan once an asset has been fully
depreciated.  Its purpose is to supply a simple way of generating or printing a
report listing all assets that are or are not fully depreciated.
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Depreciation Adjustment

Depreciation Method Adjustments allow you to adjust the amount of an Asset’s
straight line depreciation above the regular depreciation for a given date range. 
Each of these adjustments can be stored in the Depreciation Methods Table and
used in the Depreciation of your Fixed Assets.

The adjustment that has been entered here is a sample.  You should discuss the
adjustments that may be used at your facility with your accounting department. 
The Edit tab is shown below.
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Depreciation Split

The Depreciation Split feature allows assets your to assign multiple Organizations
as “owners” of the asset for depreciation reporting purposes.

While historical depreciation information is not maintained by Organization, the
Split information can be used to calculate the percentage of cost allocation to each
Organization listed.

Bar|Scan can assign up to five Organizations.  A Sample Bar|Scan Asset System
Report which shows dollar and percentage allocation totals.
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Sample of Manual Adjustments to Bar|Scan depreciation:

Example One: “Catch Up Depreciation”.  What if asset is placed in service but
cost is not available for depreciation data entry until after month closes?  For
example, you issue a Purchase Order for a server.  A server is delivered and
installed at the beginning of June.  Vendor want to renegotiate price after delivery
due to unforseen circumstances.  Negotiations take 2 months.  You and Vendor
agree on $100,000.  June books are closed.  It is now August.

Asset has a 5 year life (60 months).  Monthly depreciation schedule should look
like this:

Month 1 (June): 0
Month 2 (July): 0
Month 3 (August): 4,999.99
Month 4-60: 1,666.66

Run Bar|Scan depreciation to get 2 months to post to the General Ledger.  Go into
Bar|Scan depreciation history and manually set month 1 and 2 to  zero.  Manually
triple current month.
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Example Two:  Paid 90% of the invoice.  Entered these amounts into Bar|Scan
and calculated depreciation.  Two months later pay an additional 10% (e.g.
installation cost).  So we want to Bump up 3rd month of life so that the first 3
months average to $30 and spread the final amout over the remainder of the
asset’s life.  For example: $2,700 (original invoice) $3,000 final invoice amount
(assume 10 periods).

Monthly depreciation schedule should look like this:

Period 1: $270
Period 2: $270
Period 3: $360
Period 4 to 10: $300

Entered asset with $2,700 cost, skipped two periods, entered $300 into
“Additional Cost” Field.  Manually changed “Deprec. Monthly” for that month to
$360.00. skipped 10 periods, recalculated.
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Example 3:

A Bank Branch will be closing prior to it’s expected lease termination.  The
remainder of Leasehold improvements need to be written off on an accelerated
schedule.  Original depreciation was according to the lease term, say 10 years but
now 3 years into the lease, management decides to close this Branch after 5 years. 
So you take the remainder of depreciation over the next 2 years.  The Depreciation
Schedule for a $100,000 improvement would look like this:

Year 1 - $10,000
Year 2 - $10,000
Year 3 - $10,000
Year 4 - $35,000
Year 5 - $35,000

Entered asset with $100,000 cost and 120 periods (5 years), skipped three years,
and calculated depreciation.  As expected, depreciated at $833.33 per month
($10,000 per year).  Changed “Life” to 60 periods and advanced periods. 
Bar|Scan increased depreciation to $2,916.67 per month as expected.

The prior three examples are for demonstration purposes only and are not meant
as accounting or tax advise.
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THE SIXTH TAB - LIFE

The items on this tab are general information items which are useful for
information and reporting purposes.  They are adjusted by Bar|Scan every time
additional depreciation is taken.

Last Period

The last period number is the last period that depreciation has been taken on an
asset.

Periods Depreciated

The periods depreciated is the total number of periods that depreciation has been
taken beginning with the start date.

Periods Idle

The periods idle is the number of periods that depreciation was not taken for the
asset.  Periods idle is normally used only for depreciable assets that depreciate
according to the work they do, as opposed to time that has expired. For example,
a printing press that has a life of one thousand press runs may not have
depreciation taken if it is idle in any particular month.

Periods Remaining

The periods remaining list the number of periods remaining until the asset is fully
depreciated.
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THE SEVENTH TAB - LEASE

Lease

If your company is leasing assets, you may wish to add this information to
Bar|Scan.  Leased assets are normally not depreciated, so there is no depreciation
information entered.  But, there is a Lease table for you to insert any standard
lease types.  If you fill out the information in the Lease table, and do a Look up
Value on the Lease number field, then most of the information on this table will
be filled out for you.

It is best to consult your accounting department for proper allocation of this
information.

Lease Number

Bar|Scan permits you to enter any alphanumeric Lease Number for the asset or
group of assets you are working with.  Move the cursor to the desired field.  If the
lease information that you are filling out is only for this asset, then simply type the
information onto this tab.  When the entry is complete, press ENTER.  

Important:  If you have filled out Lease information in the Lease table, then it is
imperative that you right click on this field and select Look up Value to fill in the
information.  In this manner, the rest of the information from the Lease table will
fill out the information from this tab.  If you simply type the Lease number, even
if it is identical, the rest of the information will not be filled out for you.
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Duration (months)

Most leases have a specific lease duration.  Enter any numeric duration in months
for the asset or group of assets you are working with.

If you filled in this information on the Lease table, when you use the Look up
value to select the Lease Number, this information will be filled in for you.

Ending

This may be the most important of the lease information you enter.  By entering
the Lease Ending Date for your leased assets, you can print timely reports showing
all leases that will end during the month, quarter, or other time frame. 

Total Amount

This information should be the same as the Total Cost from the Basis tab. 

Move the cursor to the desired part of the entry and type in the number.  When the
entry is complete, press ENTER.  Or, if you are using a Lease Number from the
Lease table, then this information will be filled in for you, using the information
from the Total Cost on the Basis tab.

Payment Per Month

Most leases have a specific fixed monthly payment.  Enter any numeric value for
the asset or group of assets you are working with.  This may be useful for future
budgeting purposes.

If you filled in this information on the Lease table, when you use the Look up
value to select the Lease Number, this information will be filled in for you.

Last Revision Date

Leases can sometimes be revised during their lease term.  If it is important to
record when these revisions occur, you may record this date here.  This date is
optional, and can only be filled out manually.
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Lessor

This field is for the company that the asset was leased from.  You may place your
cursor in the Lessor field and type the information.  

If you filled in this information on the Lease table, when you use the Look up
value to select the Lease Number, this information will be filled in for you.

Placed in Service

This item is used to specify when the asset was placed in service, which may
differ from the date it was received.  You may place your cursor in this field and
type the date in, or you may right click and use the calendar to fill in this field.

If you filled in this information on the Lease table, when you use the Look up
value to select the Lease Number, this information will be filled in for you.

Lease Factor

If your lease has a lease factor, rather than set monthly payments, you should type
the percentage into this field.

If you filled in this information on the Lease table, when you use the Look up
value to select the Lease Number, this information will be filled in for you.

Lease Calc Method

The Lease Calc Method field has a down arrow next to it, so that you may select
the type of lease factor you wish to use as shown below.
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You may select: Use Lease Factor, Use # of Months, or No calculation.

If you filled in this information on the Lease table, when you use the Look up
value to select the Lease Number, this information will be filled in for you.

Lease Calc Date, YTD Cost, Total Paid to Date

These items are not available to be filled out, but will display the calculations
according to the information that you have entered.

Important: The YTD Cost and the Total Paid to Date fields use the Last
Calculation Date that is listed on the Depreciation tab for their calculations.  
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The Lease Table

From the Main Menu, select File, then Open   ...<, then Asset  ...<, then Lease as
shown on the following example .
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You will be shown the following Lease table.

Your table will not have any data in it until you add data, but for this example we
have added data to our table.

When you select the Edit tab, you will see a table similar to the following.
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If you have a lease that pertains to many assets, you will probably want to add the
information of that lease into this table.

There are fields for: Lease Number, Lessor, (Date) Placed in Service, Duration
(months), End Date, Lease Factor, Calc Method, Total Cost, and Total Payment
per Month.

The Lease Number and the Lessor should be found on your Lease papers, simply
place your cursor in the corresponding field and type.  Both of these fields have
look up value lists, but these lists have no default values and will appear empty
at first and will only reflect your entries after that.

The Placed in Service date may not be the date that you actually receive the piece,
but rather the first day that the asset is used.

If you have a lease that is for a given number of set monthly payments, than the
number of months that the lease if for should be typed into this field.
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The End Date should be filled in next.  The End Date does not have to correspond
to the Placed in Service date.  If you have a 48 month lease, the end date should
be 48 months from the start of the lease.  You may place your cursor in the field
and type the date, or you may right click and select Look up Value.  When you
select Look up Value, you will be shown a calendar, similar to the one below.

Select the month by clicking the down arrow next to the Month field.  Select the
year by clicking the down arrow next to the Year field.  Click on the correct day
of the month, and then click the OK button.  The date field with reflect the date
you selected here.

The Lease Factor field appears next.  You may not need to fill this field out,
depending on the type of lease you have.  Your lease payment is calculated using
either the Lease Factor or the number of months.  Your lease may be for a specific
number of set monthly payments and therefore would not need a Lease Factor. 
Your lease may not have set monthly payments, rather the payments would be
calculated using the Total Cost and the Lease Factor.
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The next field is the Calc Method field.  When you click on the down arrow next
to this field, you will be shown a drop down menu similar to the one below.

Select the correct response, depending on the type of lease that you have.  

Fill in the Total Cost of the assets.  You will not be filling out the Total
Payment/Month field, rather your lease payment will be calculated for you,
according to the other fields you have filled in (provided you have filled out all of
the fields required for the calculation).
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THE EIGHTH TAB - TRANSFER

Organizational Transfer

When you select the Organization Transfer sub tab, you are presented with the
screen shown below.

Fund
Number

If the asset transfer requires the account to a particular fund or other reference
number, you may enter it here.

Enter the Fund Number by moving the cursor to the desired item, typing the
characters and pressing ENTER.

Transfer Date

The Transfer Date is the date that you choose to assign to the organizational
transfer of your asset.

Transfer Depreciation

The Transfer Depreciation amount is the original depreciable value of the asset at
the time the asset is transferred from one organization to another.

The Depreciation Base amount is automatically inserted into Transfer
Depreciation when you enter a valid date into the Transfer Date.

The Transfer Depreciation amount is not changed if the Depreciation Base amount
is changed subsequent to the transfer.
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THE NINTH TAB - DEPRECIATION HISTORY

Bar|Scan supports the creation and maintenance of complete depreciation history
“buckets” for all of your assets.  This tab allows you to turn this extended feature
on.  Unless you require the detailed period by period history, it is not necessary
to turn this feature on since it does require additional disk space and computer
time to keep track of the additional information.

You can turn this feature on later and Bar|Scan will generate all prior periods for
you.  Therefore, the calculations will be the same whether or not you use
Depreciation History initially or at a later date.

There are many columns of information displayed on this tab.  You can move
these columns so that they are arranged in any order that best suits your
requirements.  Once these columns are moved, their placement is retained until
you choose to move them again.  Since there are more columns than can normally
be seen on most PC screens, it is best to arrange them so that the most commonly
used columns appear towards the left.  Feel free to navigate to the right side to
examine all of the columns.

Use Depreciation History

Check this button on if you which to begin using the depreciation history feature. 
Bar|Scan will create an initial list of periods based on the depreciation 
information.  The list will be for only the specific asset or assets selected or
selected in your range.  If you wish to use depreciation history for all of your
assets, you will need to range them first.

Assets Page 6-95



Assets

Calculate

Press the Calculate button after you have selected Depreciation History to allow
Bar|Scan to calculate the initial depreciation.  You will also need to press
Calculate after inserting or removing a period.

Delete One

Press the Delete One button to remove a period.

Delete Selected to Last Period

Press the Delete Selected to Last Period button to remove all periods newer than
the period that you have indicated by your cursor position.  Remember that any
assets in the range will be affected.

The Depreciation Tables

There are two tables that hold depreciation information.  Both of these tables can
be accessed from the Main Menu by selecting select File, then Open ...<, then
Asset ...<, then Depreciation ...<, then Adjustments or Methods. 
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When you select the first table, Adjustments, you will be shown a table similar to
the one below.

From the Browse tab that is shown above you may select an item to change, or
add a blank or a template item, and then select the Edit tab.

There are three fields listed on this tab: a Start Date for the Adjustment, an End
Date for the Adjustment, and the Percent of Adjustment to Straight Line
Depreciation.

This table is used, not for depreciation, but to get a new figure above straight line
depreciation for replacement costs.

As your items get older, you may want to set up a fund in order to replace them
by their maturity date.  Rather than estimating a replacement cost, you could use
an actual percentage that the cost of replacement may appreciate during the life
of your asset.  So, to purchase a replacement by the end of an assets life, you may
want to figure the Straight Line plus, for instance, 3%.  

Using this table, you could have the system calculate the percentage above the
Straight Line depreciation amount, for the dates given.

You could then add this amount to your replacement fund, rather than estimating
how much you should add.
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The second depreciation table listed under Assets is the Depreciation Methods
table, which is shown below.  

Select one of the Methods listed on the Browse Panel to change, or use as a
template for adding a new method.  Then, select the Edit tab.
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When you select the Edit tab, you will be shown a panel similar to the one below.

On this table you may change the method you have selected, or add one of your
own.  

Note: The items that we entered listed in the Democo, are for demonstration
purposes, and will not appear in your own Company unless you add them

You enter the Method, and a description of that method, and how many years that
the method should cover.  You enter how much of a percentage should be used for
each year, and what percentage your yearly percentages should total.  For instance,
above we listed the percentage for the yearly total to be 100%.  But, not all
depreciation schedules will equal 100%, some totals may be more, and some may
be less.

If your total of yearly depreciations should equal 120%, and cover ten years, make
sure that when you add all of the percentages for each of the ten years that it
equals 120%.  For this is a table driven depreciation method, and it will follow the
percentages you lay out here.  Once you have entered and saved the information
on this table, your method will appear as an option for the depreciation method on
the Asset table.
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A Word About Depreciation

Basically a method of cost allocation, depreciation can be a complex issue and is
used for many different purposes.

Bar|Scan can provide you with simple methods of handling depreciation expense. 
This is often adequate for issues such as charge-back to your departments, or
budget analysis.

If you are working with a collection of assets that are similar in nature, you are
using a group system of depreciation.  If you are working with a collection of
assets that are dissimilar in nature, you are using what is typically referred to as
a composite system of depreciation.

Important: Bar|Scan is not capable of providing you with all of the features
required for tax reporting purposes.

Depreciation Calculations

Unless you enter a new depreciation method into the Bar|Scan depreciation
Method table, the depreciation from a given Start Date to a given Last Calc Date
is calculated in one of two ways depending on the calculation method specified
on Page Two of the Asset Display Screen:

'SL' = Straight Line Depreciation
'SLPPI'=Straight Line Depreciation +  PPI depreciation adjustment.  

Depreciation is calculated for both methods by first calculating the Accumulated
Depreciation from the Start Date to the Last Calc Date.
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Straight Line Accumulated Depreciation Amount

The straight line Accumulated Depreciation amount is calculated as follows
where:

Base =Purchase Cost + Tax + Installation + Freight + Additional - Salvage 
Value

Number of Periods = (Last Calc Date Year * 12) + (Month # of Last Calc Date) 
- (Start Date Year * 12) - (Month # of Start Date)  + 1

The month numbers are as follows:
January     = 1
February   = 2
etc.  . . . 
December = 12

Total # of Periods = Life (in months)

Beginning and Ending of Periods

Note that this calculation is performed with one period equaling one month, the
maximum Number of Periods allowed is the Life of the asset, and therefore the
maximum Accumulated Depreciation will equal the Base. Any Last Calc Date
specifying a month past the last month of the life of the Asset will still have the
maximum Accumulated Depreciation equal to the Base, as it will have been fully
depreciated. Since depreciation is calculated based on a period of one month, the
day of the month of both the Start Date and the Last Calc date do not matter, as
it is the Month of the dates that are used in the calculations.  For example, the
following date ranges yield the number of periods specified below.

Start Date Last Calc Date Number of Periods (Months)
01/01/2019 01/31/2019   1
01/31/2019 02/01/2019   2
01/15/2019 12/31/2019 12
01/01/2019 12/01/2019 12
01/05/2020 01/01/2021 13
01/16/2019 06/01/2019   6
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PPI Accumulated Depreciation Amount

PPI accumulated depreciation calculations at first appear more complicated but
actually follows the same general principals used in calculating the straight line
amounts.  The PPI Accumulated Depreciation Amount is calculated from the Start
Date to the Last Calc Date just like the straight line calculations.  However, how
much is accumulated over that date range is determined by performing a table
lookup into the Depreciation Adjustments table.  This table presently contains
three columns:

Start Date for Adjustment
End Date for Adjustment
Percent Adjustment to Straight Line Depreciation (PPI% per year)

An unlimited number of adjustments may be entered.  The Accumulated PPI
amount is just the sum of all of the individual PPI amounts over the Start
Date/Last Calc Date range and is calculated as follows:

For each entry in the table whose date range wholly or partially overlaps the range
specified from the Start Date to the Last Calc Date, obtain the individual PPI
amount by performing the following calculations:

1. Calculate # of periods the two ranges overlap (in months).
2. Calculate the PPI Depreciation Amount for the overlap:

PPI Amt = # periods overlapped * (PPI% per year/12) * Base 

(The PPI% per year is divided by twelve to obtain the percentage applied to each
monthly period.)

Repeat this for each entry in the table as stated above, accumulating individual
PPI Amounts into an Accumulated PPI Amount.

The Accumulated PPI amount is added to the Straight Line PPI amount to obtain
the Accumulated Depreciation displayed on the Bar|Scan Asset screen.
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Other Derived Values

Other values are derived as listed below.  If the method is 'SL' (straight line), the
Accumulated Depreciation is derived from the straight line calculation listed
above.  If the method is 'SLPPI' (straight line with PPI adjustment), the
Accumulated Depreciation is derived by summing the straight line and the PPI
adjustments as specified above.

Monthly Depreciation = Accum Deprec/Number of Periods
(See SL calc description above for description of Number of Periods)

Remaining Book = Base - Accum Deprec
(for SLPPI calculations, this can be a negative number.)

YTD Depreciation = Amount Depreciated in the Year of the Last Calc Date.

The YTD Depreciation is the accumulated depreciation in the year of the Last
Calc Date, starting from January to the month of the Last Calc Date itself (e.g., if
the Last Calc Date were 4/3/20 then the YTD Depreciation would be calculated
over a period of 4 months from January (1/20) through April (4/20)).

It is calculated based on the number of months that the life span of the asset
overlaps the YTD date range from January to the Last Calc Date.  For straight line
calculations, this is:

YTD Depreciation = (# Months overlap) * Base / Life

For 'SLPPI' calculations, the straight line amount is calculated first and then the
PPI Amount is added to it.  The Depreciation Adjustments table is again consulted
to obtain the PPI Amount and calculations are performed using the same method
detailed above(under PPI Accumulated Depreciation Amount), but the starting
date is January 1st of the same year as the Last Calc Date and the final date is the
Last Calc Date itself.

The YTD Depreciation will have a non-zero value only if the Last Calc Date is
within or before the last year of the life of the asset and the Last Calc Date's
month is equal to or after the month of the Start Date.
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Special Depreciation Problems

Several special problems develop in accounting for matters related to
depreciation. We have listed two that you should be aware of since they are
outside of Bar|Scan's capability.

T Partial Periods - depreciation is normally computed on the basis of the nearest
whole month.  Bar|Scan allows exact dates to be entered for the convenience
of the user. However, only the month and year are used to calculate
depreciation.  To the computer, the date "12/31/19" will give the same
depreciation result as the date "12/01/19" since they are both December of
2019.

Bar|Scan calculates the depreciation expense for whole month periods only. 
It does not matter if the date is the beginning, the end, or any day in the month.

T  Revision in Depreciation Rates - typically, changes in depreciation rates do 
not affect previously reported results.  Unfortunately, in order to accomplish
this, Bar|Scan would have to maintain an enormous amount of historical
accounting information on every asset.

Bar|Scan will not remember previously entered information once it has been
changed.

If the type of information that we just discussed is critical for you, we suggest that
you utilize software especially designed for fixed asset accounting.  If your
accounting department already has such a system, and you are using Bar|Scan for
charge back purposes, keeping old depreciation expense should not be of concern
to you.  In any case it is best to review all of the issue relating to using Bar|Scan's
depreciation capabilities with your accounting department.

Page 6-104 Bar|Scan



Chapter 6

Depreciation - Base

The Depreciation Base is a function of two numbers: the total cost and the salvage
value.

The Depreciation Base is a calculated item of information.  This means that you
do not need to enter a number, as it is automatically done for you.

The Depreciation Base is the basis for calculating the depreciation expense.

Depreciation - Life

The depreciable life of an asset is theoretically based on its estimated service life. 
Practically speaking, the actual depreciation life is dictated by financial or
reporting requirements such as those required by the government.  Five year (60
months) and seven year (72 months) lives are typical for most fixed assets that you
will be tracking.

Bar|Scan requires the depreciation life be entered in number of months.

Enter the depreciation life by moving the cursor to the desired item, typing the
number of months and pressing TAB.

Depreciation - Monthly, Remaining,
Accumulated, Year to Date

The monthly depreciation, remaining value, accumulated depreciation and
year-to-date depreciation are calculated items of information.  This means that you
do not need to enter these numbers, as they are automatically done for you.

They are the result of all of the other entries made in the Depreciation portion of
the data entry screen.

You can specify that the Report Generator print these items in the same manner
that you can specify other items that you have entered.
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A Special Note about Asset Depreciation and Disposal

An Asset's disposal date does affect depreciation.  The disposal date does affect
depreciation as follows:

If a disposal date is entered, depreciation is calculated only up through the month
of disposal, inclusive. Depreciation no longer accumulates for any month after that
(i.e. the monthly depreciation for all months after that is zero) and the Disposal
Gain (or Loss) is calculated as the Sales Amount minus the Remaining Book
value.

If you are using Depreciation History this means the following:

1. When a depreciation calculation is performed (i.e., a new Last Calc Date is
entered) the Depreciation History will always eventually contain the full number
of periods up to the Last Calc Date or the Life of the item whichever comes first.
(e.g. If an item has a life of 36 months then as the Last Calc Date progresses in
time it will eventually contain 36 entries in the Depreciation History.)

2. If no Disposal Date is entered for the item, as a new Last Calc Date is entered
each month, a new Depreciation History entry is generated that has the full
Monthly Depreciation amount for that month.

3. Any depreciation period dated after the month of the Disposal Date will have
a monthly depreciation amount of zero (0.00) when it is generated.

4. If a Disposal Date is entered after Monthly Depreciations have already been
generated, then all Monthly Depreciation Amounts after the month of the Disposal
Date are forced to Zero (0.00) when the Asset is saved.

For example, assume you have a $3,600 item with a life of 36 months as of
1/1/2021 with calculated deprecation through 12/1/21 of $1,200. You will have
12 entries in the Depreciation History, each with $100. If a Disposal Date of
6/1/21 is entered, all entries from 7/1/21 through 12/1/21 will have their Monthly
Depreciation changed from $100 to $0. Total Depreciation will change from
$1,200 to $600.
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However, the reverse is not true. If you readjust the Disposal Date a second time
so that the new Disposal Date is AFTER the original one, then any Monthly
Depreciations between them are not recalculated, they remain at zero (0). The
intervening months must either be manually re-entered or Monthly Depreciations
reset by un-checking then re-checking the "Use Depreciation History" check box
for that asset.

5. Since the item has been disposed of before being fully depreciated the 'Fully
Depreciated' check box is not set and remains unchecked (i.e. set to No), both in
the Asset screen and in the Depreciation History.
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THE TENTH TAB - ASSET BILL OF MATERIAL LIST

When you select the BOM sub tab, you are presented with the screen shown
below.

Bar|Scan has a set of features are available to allow  you to create, modify and
move groups of assets by selecting them using both a Catalog Component List or
an Asset Bill of Materials (BOM) List.  

With these new features, you can move these groups as a whole, perform work on
these groups by means of a Work Order, reserve the components of these groups
by means of a Reserved Bill Of Material so that they will not be available for use
to build other groups or be moved to other locations.

You can also create Bar|Scan reports detailing these special catalogs, assets, and
components and their relationship.

Asset Components can be traditional assets (each labeled with a unique asset
number) with a quantity assigned or Quantity items that we refer to as ‘Z’ number.

You can also have a mix of Assets and Quantity items in your Asset Component
list.  For example, a Server can have a UPS and several circuit cards that are being
tracked but not individually labeled.
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Furthermore, an Asset Component List can have several similar but different types
of items linked together.  For example, a Computer Workstation may have a
Desktop and 2 monitors of the same type (same Catalog) or different kinds of
monitors (different Catalogs).

The difference between Catalog and Asset Components is that Asset Components
refer to specific tagged assets or Quantity items.

Below is an example of linking specific tagged assets.

Let us look at how this Asset Component List used.  It can be used in different
ways.

First, scanning the primary asset will update all items’ Current Location to the
same.  In effect, moving one item to a new location moves them all as a group.

Second, the Asset Component List is used in the Bar|Scan Work Order Module. 
If you are preparing Work Orders, the Asset Component List is a method of
combining Assets for the Work Order process.  This is discussed in more detail
in the Work Order Chapter.

Assets Page 6-109



Assets

Third, an Asset Component List can provide a more intelligent database resulting
in more useful reports for planning or other purposes.

Finally, when making an Asset Component List, it can use the Catalog
Component List.  See the example below.  It is discussed on the next page.

 

In the example shown above, the primary Asset is a Workstation (Catalog
SY0001).  In the Bar|Scan Catalog Table, SY0001 has three Catalogs entered as
Catalog Components.  This particular example was previously used in the Catalog
Components section.  The three Catalog Components were SY1001, SY1004 and
SY4104.
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If you look carefully at the example on the previous page, the Look Up list is
filtered by these three Catalogs.  In other words, only Assets that have one of these
three Catalogs are displayed.

Bar|Scan will not force you to add exactly the same Quantity of Components into
the Asset Bill of Materials as there can be exceptions to the list, e.g. a corner
Workstations versus a center Workstation.

In cases where you need to further customize the Bill of Materials, you can also
add assets that are not filtered, however, these can only be entered by using the
‘Add Blank’ button.

Add Asset Issues

If you attempt to add an asset where the Catalog Number is not already in the
Catalog Tables Component List, you may do so, but you will first be shown the
message below. 

This is to make you aware that the Bill of Material List is not one that is defined
in the Catalog Table.  For example, a particular Computer Server may have a
specific list of Component Cards.  You might want to add a Component Card that
is not standard but the Server can accept it.  In this case select YES to continue to
enter the Asset.
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USER DEFINABLE FIELDS TAB

This tab is available for all of the users who have purchased the User Definable
Fields (UDF) module.   A sample UDF tab is displayed below, however the
information on your tab may appear different.

The tab will not appear, even if it you have the UDF module, until the first UDF
is added to your Asset Table.  You can access this feature, by going to the Main
Menu, select Panel, and then select Design Mode-User Defined Fields.

Your screen will be customized to meet your requirements.  The User Definable
Fields Module allows you to create a variety of different fields.  These fields are
fully utilized by the report feature and can be ordered, filtered, and printed.

You can optionally populate these fields with the Mobile Device.   Please see User
Definable Fields, Chapter 16, in this User Manual for more information.
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Find Problems

You can encounter unknown problems in any of your tables.  This may be due to
an import, or a change that you made in your validation rules which would affect
change that was made since the information was originally saved or a computer
problem like a database index that may have become corrupted because of an
inadvertent computer shutdown. 

Using the Advanced Validation Feature, you can create a new validation rule.  For
example, you can create a validation rule that adding an asset requires that the PO
format matches a format based on the Department that orders it.  While this is
acceptable, what about all of the assets that were added before you created this
rule?  These would be identified by using the Find Problems command.

Here is another example. If you had an index problem, the database could
encounter a time when it could not find the Location listed on the asset, when in
fact it existed in the Location table.  While this location problem would not occur
in a database that is functioning properly, it can happen if there is an index
problem. 

Normally, you would not know about this problem until you went to move a
Transaction for that same asset number.  If you suspect you may have problems,
or you simply want to make sure you do not, you can use the Find Problem feature
to look for problems in the table you have open.  

From the Main Menu, select Panel, then Problem Items as shown on the following
example.
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Find Next Item with a Problem

Now select Find Next Item with a Problem. When you select this feature, the
process will begin immediately.  You may check any table that you have open. 
The items that the system will check for will obviously vary depending on which
table is open.  But, each item is always checked as though it is a newly entered. 

Add Items with a Problem to the Range

You may want to work on many assets that contain the same problem.  Using the
Range Feature will accomplish this.  There are two choice ‘Starting with Current
item’ and ‘From the Top’.
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You may also note that the problem detail can be displayed on the Browse screen. 
Using the SET Feature, select the table ‘Universal Validation Rules’ and then the
column ‘Message’.  An example is shown below.

Refresh all Universal Validation Messages

This menu option rebuilds the set of validation messages for the table that you are
currently editing using the currently existing validation rules, both those built into
Bar|Scan and those specified by the user in the Universal Validation Rules table. 
It is recommended that this option be run for any given table under the following
circumstances.

1.) When you receive a program update to your current version of Bar|Scan.

2.) You have added, deleted or changed any of the Universal Validation Rules for
the given table. For example, if you added a new Universal Validation Rule that
required that the Asset table ‘Purchase Date’ to be filled in, you would not
immediately know which assets violated this rule. Running the ‘Refresh All
Universal Validation Messages’ menu item would rebuild the Message table, now
including the results of applying the new rule.

3.) You notice that currently existing items violate current Bar|Scan validation
rules. Running this menu item will put all of the validation violations into the
Universal Validation Message table so that they may be listed and considered
using reports, FIND, or the SET feature.
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Please note that currently this is an interactive command that must be performed
individually for each company and table of interest.  It may also take some time
for larger databases.  You will be presented with a warning message similar to the
one below.
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INTRODUCTION

The Catalog table is used to make a set of uniform descriptions for all of your
assets in the Bar|Scan system.  This feature permits you to assign a unique catalog
number and enter information about a particular type or group of assets.

You will want to establish and use some guidelines concerning the catalog entries
before you start to enter items into the Bar|Scan Catalog.  You should define, at
a minimum, how you will assign numbers to different types of assets, and what
additional attributes you wish to record for each different asset Category.

The Catalog begins with a Category and a Number.  Bar|Scan provides you with
a list of two-character Categories from which to choose.  The four-digit number
is assigned by you and can be assigned consecutively, or you can devise a
numbering system which is meaningful to you.

The format of the Catalog (two-character Category and a four-digit Number) can
be modified using the User Defined Fields Module.  This is not recommended
unless for a specific purpose such as interfacing with a Legacy system.

The Catalog table also provides a separate place to record information about the
different Manufacturers, Attributes, and Categories. 

Bar|Scan also provides Catalog Development Guidelines to assist you in your
Catalog creation process.  They are located at the end of this chapter. 

There is a set of videos on our website that can provide you with additional in
operating Bar|Scan.  These are titled Quickstart Overview Videos and can be
found on this page: https://www.barscan.com/support-videos

Please consider viewing or downloading these as part of your learning experience.

Catalogs Page 7-1

https://www.barscan.com/support-videos


Catalogs

When you want to view, change, add, or delete catalogs you will need to open the
Catalog table.  From the Bar|Scan Main Menu, select File, then Open . . . <, then
Catalog . . . <, then Catalogs as shown on the following example.

Or, if you have selected to have the Table Tool Bar (icons for all of the tables)
appear on your Main Menu, you may open the Catalog table by clicking on the
corresponding icon shown below.

Using either method, the Catalog table will open.
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THE BROWSE TAB

The Catalog table similar to the following will appear.

The Browse tab is selected by default.  This tab permits you to select catalogs,
then you can add, change, delete, set, and view the different Catalog entries.

Note that the Catalogs listed in the above screen meet the criteria previously
established by the Set feature.  In the illustration above, the Set is Catalog
Number.
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The Set Button

On the Catalog table, the Browse panel is selected by default.  The catalog
information on the Browse panel can be sorted by any field that is part of the
Catalog table.  Place your cursor in the first column on the left, press your right
mouse button, and then select the Order By that will be displayed, or select the Set
button on the tool bar as shown below.

This feature will give you the ability to look at all of the catalogs, pre sorted the
way you specify.  If you do not specify another sort, the default sort is by Catalog
number.

CREATING AN ORDER AND FILTER -  THE SET MODE

The Set feature allows you to order and identify a smaller, more manageable
group of catalogs from which to select, e.g., only those catalogs made by a
particular manufacturer, or only a specific type such as all of your desks, etc.

As the number of catalogs on your system increases it becomes more time
consuming to look through the entire list of catalogs displayed on a look up
window.

Set permits the “ordering” (or sorting) of your catalogs by any item in the
database.  This makes it easier to find catalogs.

Because Set offers almost endless possibilities for identifying groups of catalogs,
we strongly recommend that you experiment with different specifications to
become familiar with this feature.  Experimentation with Set will NOT cause any
change to the information recorded for any catalog.  It merely specifies the
sequence of catalog selection lists.
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When you want to view your catalogs in an order other than by catalog number,
select Set, by clicking on the button shown below.

This button activates the Set feature, and the following screen will appear.

This Set Order and Filter tab, shows a list of Sets that are pre defined in the
Bar|Scan system.  You can, however, define additional Sets.  Simply click on the
Add/Change/Delete button shown above, and the Sets table will open.  

However, if you would like to browse the fields that are available for the
predefined Sets, add a field, or remove a field, select the Browse Fields tab.
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When you select the Browse Fields tab, you will be shown the following screen.

On the left side of this screen there is a list of all of the available fields for the
Catalog table that you may display as columns on your Browse tab.  On the right
side of this Browse Fields tab, you will see the current fields that are displayed for
each Set.  These fields are displayed for all of the different Sets.  The first column,
however, displays what the Set is, therefore, what the table is sorted by. 

Respectively, each individual Set can have a filter set up to filter out items that
you do not wish to see.  Using a filter, however, will slow down the process, and
may cause your table to open very slowly if the Set you used last before closing
the table had a filter on it.

The Set feature is a powerful tool, and you should be experiment with it.  Notice
that the items that are chosen to be displayed from the right side of the above
screen can be moved to any order you desire while being displayed.  
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In order to better demonstrate this concept, select one of the pre defined Sets from
the Set Order and Filter Tab.  You will see the items sorted by different criteria,
but the columns (with the exception of the first column) remain the same.

The Category and Attribute #1 Set was chosen as the Set for the screen shown
above.  Notice that the rest of the columns are still the same as they were when
sorted by Catalog number, i.e., Catalog Type, Catalog Description, etc.  The only
column that changed was the sort by column, the first column displayed.  An
Order by (sort) column can contain more than one item, as in our example.  No
matter what sort used, the rest of the columns stay the same unless you change
them.  

You can also change the order in which the columns are displayed.  If you change
the order of the columns by moving a column to the left, the other columns will
adjust to fill in the spaces.
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Changing the Order of the Columns Shown in a Set

If a column is shown twice, you may not need or want to view it the second time. 
You can move the second column by clicking on its title with your left mouse
button, holding the mouse button down, and moving your mouse to the right or
left.  The columns will move to fill in the gaps as you move your mouse.  This is
a useful tool and much faster than respecifying the columns for a Set.

To move a column in a set, reposition your cursor to the grey area at the top of the
column, and your cursor will turn into a down arrow.  Left click, and hold the
mouse button down, while dragging your mouse to the left or right, and the
column of information will be moved, and the other columns will adjust to fill in
any space.  The cursor, being placed to move the column is displayed below.
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The SET feature works in conjunction with adding, changing, deleting, and
viewing catalogs, allowing you to order and identify a smaller, more manageable
group of catalogs from which to select, e.g., only those catalogs from a particular
manufacturer.

As the number of Catalogs on your system increases it becomes more time
consuming to look through the entire list displayed on a look up window.

Set enables you to “order” your Catalogs by any item in the Catalog File.  This
makes it easier to find particular Catalogs.

Set enables you to define a "filter" which will reject the Catalogs which do not
meet your specifications.  Set provides several "filter" items.

Further, you can define a "range" for a filter item by selecting and marking a block
when you are presented the list.

Finally, you can identify more than one filter and/or range to further reduce the
number of Catalogs to search.

Because Set offers almost endless possibilities for identifying groups of Catalogs,
we strongly recommend that you experiment with different specifications to
become familiar with this feature.  Experimentation with Set will NOT cause any
change to the information recorded for any Catalog.  It merely specifies the way
that the Catalogs will be sorted.
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If none of the Sets already created satisfy your needs, you can define a new Set. 
This is done by choosing the Set icon from the tool bar, then choosing the
Add/Change/Delete button, or from the Main Menu, select File . . . <, then Open
. . . <, then Sets.  You will see the following Sets table.

Select a set that is similar to the one you want to add, and then select the Add
Template or Add Blank icon from the tool bar.  Or, select the Set you want to
change.  Then, choose the Edit tab.  

Note: You cannot change System Sets.  If you want to change a System Set,
simply add a template of that Set, and then change the template.
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You will be shown a window similar to the one below.

If you are using a Set as a Template to add a new Set, the old set will appear on
this tab.  Type a new name for your Set.  Type a new Title, similar to the Set
Name.  In the Fields box, select a field, then, below the Fields box, select to Add,
Change, or Delete that field.  Add any field(s) that you would like to sort your
Catalog table by.  Make sure that you do not have any unnecessary fields listed
from a previous Set.

Select the Save icon from the tool bar, to Save your new Set.
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Note: In order to use your new Set, you must Generate it.  In order to Generate
a Set, you must be the only one in Bar|Scan (the only one in this company) and 
you must have all other panels showing the catalogs closed.  Close all panels
except the one shown above, and your Main Menu.  Then, select the Generate
button, located to the left of the Fields box.  You will know that your new Set has
been created when the item on the bottom right of the panel no longer says
Dynamic under the word Tag, but lists a number similar to this:  CU_00000015.
The example above lists CA_NO, but this is simply because it is a System set,
your new sets should list a CU_00000015 type of a number.

Once your Set has been Generated, you may close this panel.

Pressing the X at the top right of the window or the ESC key returns you to the
Main Menu.  Note if you have pending changes or deletions you will be prompted
to cancel or save these changes or deletions before you will be allowed to exit the
Set panel.

From the Main Menu, again open your Catalog table.  Once the Catalog table is
open, select the Set icon from the tool bar, and select your new Set.  Click on the
Apply button, and your table will sort according to your new Set.

For specific instructions about cursor movement keys, function keys, and how to
operate the look up windows, see chapter five of this User Manual, Operating the
System.
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THE EDIT TAB  

When you want to see the details of a Catalog, you will need to choose the Edit
tab. Choose a Catalog Number and press ENTER.  Then, select the Edit tab and
the Catalog Edit screen will be displayed, similar to the one below.

The Catalog Tab

On this panel, you may Add, View, or Change your Catalog entries.

You may simply start typing to change the existing Catalog, or select the Add
Blank or Add Template button from the tool bar to add a new Catalog.
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The tool bar at the bottom of the Catalog table is displayed below.

You may press the PgDn key, or the Next Item button to view the next Catalog
Number from the selection list. The PgUp key or the Prior Item button will display
the previous Catalog Number.  Ctrl  + Home key combination or the First Item
button will display the first Catalog Number on the selection list,  and the Ctrl +
End key combination or the Last Item button will display the last.  

You may use any of the following: Add Blank, Add Template, Save Selected
Items, and the Cancel Changes on the Edit tab.

In order to use the Delete Selected Item(s) icon, you must go to the Browse panel,
use the Range feature to select the desired Catalog(s) and press the ENTER key. 
Then, you can select the Red X (Delete Selected Item) icon.  You will be asked
to confirm your deletion.  

Note: You can select to turn off the confirmations in the Personal Program
Preferences section, listed on the Main Menu, on the Edit drop down menu.
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Viewing the Images

If you have purchased the optional Imaging Module for your Bar|Scan system,
then you have the ability to view the pictures of your items, and print them out
directly onto your catalog reports.

Once the Catalog has been entered, and you have one or more pictures in your
system and associated with it’s, you may use the Imaging button to view your
picture.  The imaging button is located on the tool bar, next to the Set button as
shown below.

Remember, you can also see the Image on the Browse Tab.

If you have an image for a catalog, and you are printing Catalog sheets, the image
will now automatically print inside the box.

You may choose to print an image as part of any other Catalog report also, by
choosing the Catalog Picture field as one of your columns.  The defaulted size for
this picture is one inch square, but the size can be  changed in the same manner
that you change the width of any other field.  Notice, the image size is defaulted
to a square, so, if you make the field three inches wide, your picture will print 3
inches tall.
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A Word on Bitmaps

The images that Bar|Scan prints out have to be in a bitmap (.BMP) format.  

If you import an image that is not a bitmap format, Bar|Scan will copy it, and
convert it to a bitmap image before it can print it out.  This copy and convert
process is done behind the scenes automatically and you would probably never
know it, except if you actually looked at the files using Windows Explorer and
notice their file extensions. 

The conversion process that Bar|Scan uses, supports most of the major formats. 

Images are discussed in more detail in Appendix B - Imaging.  
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Entering a New Catalog

You will need to add Catalogs to your Bar|Scan system on an ongoing basis.  In
order to add a Catalog, you may select the Add Blank Item or the Add Template
Item button from the tool bar.

What is the difference between Add Blank Item, and Add Template Item?  You
need to select Add Blank, for your first Catalog entry, as you will not have any
Catalogs to use for a template.  If you choose Add BLANK Item, and then select
the Edit panel, you will be shown the Catalog Edit panel and with no information
displayed in any of the entry fields as shown below.
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On this screen you may enter all of your Catalog information.  The number of
Attributes available will be displayed when you have chosen the Catalog
Category.

You have to choose Add Blank for your first Catalog, as you will not have a
template to use.  But, after you have entered at least one Catalog, it is not
necessary to add from a blank.  Adding from a Blank will always be available to
you, but it is most often desirable to select Add Template Item icon once you have
at least one Catalog in that Category.

Adding from a template Catalog is a time saver.  Often you can choose a Catalog
of a like item for your template, and only have to change the information that is
different for your new item, i.e., if you are adding a Laser Printer, selecting a
Catalog for a Laser Printer, you would only need to change the Catalog number,
the Model, Manufacturer, and Manufacturer’s Part Number, and at times the
Manufacturer may even be the same.  

Hint: Add Template Item is a useful feature, however you are required to change
the Catalog Number prior to saving the new catalog.

When on the Browse panel, move through the list of Catalogs until you find the
Catalog that you wish to use for a Template.  When the desired Catalog Number
is found, move the highlight bar over it and press ENTER or click on the Catalog
with your mouse.  Select the Add Template Item icon, and then select the Edit tab.
You will see all of the information that has been entered for this Catalog.  Simply
change all of the fields to match the information for your new Catalog, and Save
the new Catalog.  

You may choose Add Blank Item or Add Template Item from the Edit Screen
without returning to the Browse screen.  

Hint: Remember that you should always enter your initials and the current date
when entering new Catalogs.  When available, it is a time saver to use a Catalog
with the current date and your initials as your Template.

Press ESC to return to the Main Menu.  Note: If you have pending changes or
deletions, you will be asked to Save or Cancel the changes first before you are
allowed to exit this panel.
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Entering the New Information

After you have selected a blank screen or a similar Catalog number, the
information will be displayed and the cursor will be positioned for you to enter the
new Catalog Number.

You may use the arrow keys, the TAB key, the mouse, or the ENTER key to move
to the different items on the screen.  The PgUp and PgDn keys, as well as the
Previous Item and Next Item buttons, will display information from the previous
or next Catalog Numbers respectively.

Many of the entry items have associated look up windows to assist you with your
entry.  The following section will describe each item on the Catalog Entry Screen 
and provide instructions on how to enter the information.  See Chapter 5 -
Operating the System for general instructions on the use of the different features
and keys.

The Catalog Number

The Catalog Number consists of two parts, a two-letter Category, and a four-digit
number.

Bar|Scan provides a list of predefined Categories from which to choose.  But, you
may add a Category of your own, by going to the Main Menu, and select File, then
Open . . . <, then Catalog . . . <, then Categories.  This is discussed in detail later
in this chapter.

Each Catalog must have a four-digit number associated with the two letter
Category.  These numbers are assigned by you for each Category.  The numbers
can be assigned consecutively, or can be assigned a meaning, e.g., 1xxx could
mean servers, and 2xxx could mean printers, etc., for the EP (Equipment PC)
Category.
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You first need to enter a Category.  You may wish to view the available
categories.  If you want to see a list of the available categories, place your cursor
in the Category field and right click (or press the F5 key) and select Look up
Value.  You will be shown a look up window similar to the one below.

You may insert one of these values onto the Edit panel screen by selecting it and
then choosing “OK” or select the desired Category and press the ENTER key.  

Hint: Bar|Scan is shipped to you with a number of Categories already defined. 
You can, however, create as many new Categories as you wish.  This feature is
described for you later in this chapter.
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The screen will display the attributes which are appropriate for Category you have
selected as shown in the following example.

In the example, we selected the Catalog Category SE for Seating.  Notice there are
now seven attribute fields listed on the right, with a description of each next to the
empty field.
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Next, you will need to enter the four digit Catalog number.

Again, you may use your mouse to right click on this field or press the F5 key, and
select Look up Value.  You will be shown a look up window similar to the
following.

Note: Looking up the Catalog numbers that are already being used in your
Bar|Scan system may be helpful, but it is not possible to save two different
Catalogs with the same number.  So, even if you choose one of these numbers,
you will have to make a change to it before your Catalog can be saved.

You can use the above window to assist you so you will not duplicate an existing
number, and use the next available number.
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Type

You are requested to enter a name of the new Catalog item.  Bar|Scan provides
space for up to 10 characters for the Type.  Usually this name is one or two words
that generally describe the Catalog item.  Further and more detailed information
is entered using the Description and Attributes entries.

If 10 characters are insufficient, the length of the Type as well as other fields can
be modified using the User Defined Fields Module.

Your Bar|Scan system will arrive with some pre defined Catalog types in it.  You
may then add to, change, or delete items in this list.  When you want to view the
look up window for the Catalog type, right click on the type field or press the F5
key, select Look up Value, and you will be shown a look up window similar to the
following.

You may select a type from the above window or type a new one.  When finished
entering the type, press ENTER.  If you have elected to type in the item, and have
pressed <Enter>, Bar|Scan will check your look up list.  If the item you typed is
not in the look up list, you will be prompted to add it to the list.  Note: You will
not be able to save a Catalog that has a value in a field that is not in the look up
list. 

Note:  If the item you typed should be in the list, and you are prompted to save the
new item, you may have simply typed it differently.  For consistency, use the Look
up Value to select the one that already appears in the list.
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If the type is correct, respond Yes to save the new type.  It will be added to your
look up list for future use.

Description

This entry provides space for up to 19 characters which is used to further describe
the new Catalog item.

Your Bar|Scan system will arrive with some pre defined Catalog descriptions in
it.  You may then add to, change, or delete items in this list.  When you want to
view the look up window for the Catalog description, right click on the
description field or press the F5 key, select Look up Value, and you will be shown
a look up window similar to the following.

You may select a description from the above window or type a new description. 
When the entry has been completed, press ENTER.  Again, if the item you typed
is not already in the look up list, you will be prompted by a dialog box to add it
to the list.  If you respond “Yes” to this dialog box, your description will be added
to the look up list for future use.

Note: Using the Look up Value to search for the fields is also a good way to keep
from entering duplicate Catalogs.  By searching for a description, you may find
that you will keep your data much more consistent, and have much less chance of
duplicated information.
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Dimensions

For some assets, size is an important part of their description. Bar|Scan provides
space to enter the three dimensions:  Width, Depth, and Height.

Dimensions are entered in inches and fractions of an inch.  Three digits are
provided to permit entries of up to 999 inches.  Fractions are permitted, but care
should be taken to avoid getting too specific as it may cause duplicate catalogs
later on.  We recommend that fractions are rounded to the nearest 1/4".

After each entry press <ENTER> if the entire field is not filled.  If you fill the
entire field, your cursor will automatically move to the next field.

Most IT, Office Equipment or Telecommunications assets do not require the
collection of dimensions as this information is readily available from specification
sheets posted on the Internet should this be important at a later date.
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Manufacturer

Bar|Scan provides a list of many manufacturers from which to choose for each
Catalog Category.  You may then add to, change, or delete items in this list. 
When you want to view the look up window for the Catalog Manufacturer, right
click on the Manufacturer’s field press or the F5 key, select Look up Value, and
you will be shown a look up window similar to the following

Start to type the manufacturer's name or scroll the list to reach the desired
Manufacturer.  You may then select it from the list in the window and press
<ENTER> or the click on the OK button.

If the desired manufacturer is not displayed, you may simply type in the new
name.  

See the subsequent section Manufacturers for additional information on adding
to, changing, or deleting items from the Manufacturer’s table.
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Manufacturer's Part Number

Bar|Scan allows you to enter the Manufacturer's Part or Item number for each
catalog that you create.  This can be a very important item when exporting
information to other systems such as a furniture specification system.

If you use the Look up Value for this field, you may find that you already have a
Catalog entered with an exact part number.  In this manner, you can avoid entering
duplicate information.

Type the Manufacturer's Part Number in the window and press ENTER.

Manufacturer's Tag Number

Bar|Scan allows you to enter the Manufacturer's Tag Number for each catalog that
you create.

This can be a very important item when exporting information to other systems
such as a furniture specification system.

Type the Manufacturer's Tag Number in the window and press ENTER.

Manufacturer's Line Number

Bar|Scan allows you to enter the Manufacturer's Line Number for each catalog that
you create.

This can be used to group similar Catalogs along product line.  Often furniture
manufacturers will identify items by a tag number that is different from the Part
Number.  Reports can be printed for groups of items that match the tag number.

Type the Manufacturer's Line Number in the window and press ENTER.
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Attributes

Attribute fields are provided by Bar|Scan to further describe the asset being
cataloged.  Another purpose of the Attributes entries is to make sure that each
Catalog item describes something different.  The descriptions of some assets may
only differ by the color or material.

Important: Because of the vast number of different types and models of
Computer and Office Equipment, Attributes are usually NOT recommended for
these Catalogs.  Usually, it is best to create User Defined Fields in the Asset
Table.  This helps to keep the number of Computer or Office Equipment Catalogs
to a reasonable quantity.

The number of Attributes displayed will differ, depending on the Catalog
Category selected.  Also, the title for each Attribute will differ.  This is because
different Categories of assets are fully identified using different description
methods.

A look up window is available for each attribute.  Simply right click on the
attribute field or press the F5 key, select Look up Value, and a look up window
will appear to provide a list of choices.  You may select one of the choices, or you
may type a new one.

The following sample screen shows the Attributes provided for the Casegoods
(CG) Category.

The following section identifies the available Attributes for each Category and a
brief description of the information entered for each Attribute.
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Attribute Definitions

Each predefined Catalog Category has a different set of Attributes associated with
it.  The following identifies the default Attributes available for each Catalog
Category.

The Art, Artifacts, & Accessories (AA) Category provides space to identify the
following six Attributes:

Attribute #1 - Artist
Attribute #2 - Edition/Serial #
Attribute #3 - Material/Media
Attribute #4 - Title
Attribute #5 - Frame Color
Attribute #6 - Matte Color

The Cellular Telephone Equipment (CE) Category provides space to identify the
following four Attributes:

Attribute #1 - Category
Attribute #2 - Category
Attribute #3 - Subsidiary Account Number
Attribute #4 - Caution

The Casegoods (CG) Category provides space to identify the following seven
Attributes:

Attribute #1 - Drawer configuration; Left 
Attribute #2 - Drawer configuration; Center 
Attribute #3 - Drawer configuration; Right
Attribute #4 - Top Material
Attribute #5 - Top Finish
Attribute #6 - Base Material
Attribute #7 - Base Finish
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The Computer Software (CS) Category provides space to identify the following
three Attributes:

Attribute #1 
Attribute #2 
Attribute #3 

The Equipment - Audio/Visual (EA) Category provides space to identify the
following two Attributes:

Attribute #1 
Attribute #2 

The Equipment - Industrial (EI) Category provides space to identify the following
two Attributes:

Attribute #1 
Attribute #2 

The Equipment - Manufacturing (EM) Category provides space to identify the
following three Attributes:

Attribute #1 
Attribute #2 
Attribute #3 

The Equipment - Office (EO) Category provides space to identify the following
two Attributes:

Attribute #1 
Attribute #2
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The Equipment - Personal Computers (EP) Category provides space to identify
the following seven Attributes:

Attribute #1
Attribute #2
Attribute #3

 
The Equipment - Recording (ER) Category does not have any attributes.

The Equipment - Telecommunications (ET) Category provides space to identify
the following three Attributes:

Attribute #1 
Attribute #2 
Attribute #3 

The Equipment - Vehicles (EV) Category provides space to identify the following
three Attributes:

Attribute #1 - Model Year
Attribute #2 - Fuel
Attribute #3 - Feature

The Equipment - Warehouse (EW) Category does not have any attributes.

The Files and Storage (FS) Category provides space to identify the following six
Attributes:

Attribute #1 - Dwr/Drs
Attribute #2 - Pull Style
Attribute #3 - Feature
Attribute #4 - Material
Attribute #5 - Finish
Attribute #6 - Lock
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The Leasehold (LE) Category provides space to identify the following Attribute:

Attribute #1

The Lighting (LI) Category provides space to identify the following three
Attributes:

Attribute #1 - Fixture Type
Attribute #2 - Shade/Top Finish
Attribute #3 - Base Finish

The Seating (SE) Category provides space to identify the following seven
Attributes:

Attribute #1 - Arm Type
Attribute #2 - Upholstery Material
Attribute #3 - Upholstery Color
Attribute #4 - Base Type
Attribute #5 - Base Features
Attribute #6 - Base Material
Attribute #7 - Base Finish

The Supplies (SU) Category provides space to identify the following Attribute:

Attribute #1

The Systems Furniture Components (SY) Category provides space to identify the
following seven attributes:

Attribute #1 - Surface #1 Material
Attribute #2 - Surface #1 Finish
Attribute #3 - Surface #2 Material
Attribute #4 - Surface #2 Finish
Attribute #5 - Frame/Trim Material
Attribute #6 - Frame/Trim Finish
Attribute #7 - Powered
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The Tables (TA) Category provides space to identify the following seven
Attributes:

Attribute #1 - Top Style
Attribute #2 - Edge Style
Attribute #3 - Base Type
Attribute #4 - Top Material
Attribute #5 - Top Finish
Attribute #6 - Base Material
Attribute #7 - Base Finish
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Viewing and Selecting Attributes

You may wish to view the look up list for an attribute.  This will allow you to look
at the entire look up list, and view the way each attribute was entered.  With your
cursor on the space for that attribute, right click on the attribute field or press the
F5 key, and then select Look up Value.  You will be shown a look up window
similar to the following.

Note: the attributes will be different, depending on the Category you have chosen,
and which number of attribute the look up list is for.

To select an attribute from the list, you can start typing the characters of the item
you would like to use or use your mouse or arrow keys to move the highlight bar
to the desired item and press the ENTER key, or the “OK” button.
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Adding a New Attribute

When entering attributes, you have the option of simply typing them in.  (For
consistency in your database, we recommend that you view the attributes already
entered).  If you type an attribute which is not currently on the list (and press
ENTER), you will be shown a dialog box with a message similar to the following.

If you click All Categories, the new attribute will appear on the selection list for
all Categories, and if you click on Only SE the attribute will appear on a list
specifically for Seating.

If you answer N(o), the new attribute will not appear on the selection.  Note you
will not be able to save a catalog that has an attribute which does not appear on
the attribute list.  Instead, when you attempt to save the Catalog, you will see a
dialog box that tells you that one of your attributes is not in the attribute list, and
you will be given an opportunity to save it to the list.  If you do not save the new
attribute to the look up list, Bar|Scan will consider the field to be invalid, and will
not let you save the Catalog.

The reason it is not saved automatically, is for consistency’s sake.  If you often use
the “1-bx/1-f“ attribute for instance, and you type it “1 bx/1 f,” you will be
prompted to save the new one.  Knowing that you normally use this attribute, you
will know that it should already be in the list.  By selecting the Look up Value,
you will be able to select the attribute as it was previously entered into your
database.
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Transaction Rules

Bar|Scan allows you to create specific validation rules per Catalog.  

Normally serial numbers of all lengths are accepted.  If you wish to specify
lengths for a particular Catalog, you can enter the acceptable serial number lengths
here.  This is very helpful to avoid scanning mistakes such as placing the scanable
model number into the serial number field.

For example, most  IT manufacturers produce their equipment with a distinct
serial number series.  Most of the time, the series is consistent within the product
line.  For example, DELL might produce a Flat Screen Display with two serial
number lengths but only those two lengths.  You then enter 10 and 14 into the
‘Allowed Serial # Size” field for the Bar|Scan Catalog of the Dell Display.

Comments Required

Requiring Inventory Comments for particular Catalogs is also useful.  For
example, you might wish to ignore comments in your Mobile DeviceComputer
except when scanning Servers.  By indicating that Comments are required,
Bar|Scan will not allow blanks to be accepted for the Catalogs that you have
indicated.
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Revision History

Revised Date and Revised By fields are the last items on the left of this tab, as
shown in this partial panel below.

You should always change the date and initials on the Catalogs when you enter
new catalogs. 

Note: Make changes to a catalog and when saved, the date and initials will
automatically be changed to the current date and the initials of the person who
logged into Bar|Scan.

Type numbers for the date and press ENTER.  Then type your initials and press
ENTER.

When you are finished, you should save your changes by clicking on the Save
icon, or by typing the Ctrl + S key combination.
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Accounting Tab

The Accounting tab is shown below.

This information is entered on your Catalog table so that you do not have to hand
enter accounting information onto all of your Assets or Work Orders.  

To take advantage of this feature, the Catalogs are created before assets are
entered into the system.  Then, the accounting information is entered on this panel,
in the Accounting Initialization portion of this panel.  

When assets are entered and moved to the Asset table, this information is
duplicated on the Asset table, according to the Catalog used.
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Accounting Initialization

You can initialize any new asset Purchase Cost, Tax, Installation, Freight, and
Additional Cost by entering default cost information here.

When a new asset is entered, it will contain the cost information which is
displayed here.  This information can later be revised by you.  If you need to
change the accounting information for an asset after this information is placed in
the asset table, you can enter new information and save your changes.  Because
the information is only brought over from the Catalog table one time, when the
Asset is first entered into the Asset table, the system will NOT overwrite your
revised information.

For instance, if the purchase cost for SE1100 is $700.00, and you have entered the
$700.00 figure in on the Purchase Cost shown above.  When you inventory the
assets, and move them to the Asset table, your chairs will begin with a purchase
cost of $700.00.  But, you got a very good deal on two of them.  You can change
the accounting information on those two chairs to their $600.00 purchase cost,
without affecting any of the other SE1100 assets.  

Note: This information will not be entered onto any existing assets, only assets
entered after this accounting information.  
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Depreciation Initialization

You can initialize Depreciation by entering default depreciation information here.

When a new asset is entered, it will contain the depreciation information which
is displayed here.  This information can later be revised by you.  If you need to
change the depreciation information for an asset after this information is placed
in the asset table, you can enter new information and save your changes.  Because
the information is only brought over from the Catalog table one time, when the
Asset is first entered into the Asset table, the system will NOT overwrite your
revised information.
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Chargeback

The accounting items that appear on the right side of this panel are used to
calculate a price that may be charged to the customer.  You may not need this
feature, but it was designed for items that you order frequently for customers,
where the price fluctuates.  The partial panel of the accounting tab is shown
below.

Let’s say you order widgets to keep in stock for customers.  When you order them,
you enter the price you paid for the them, on the Transaction table.  

When you open the Catalog table, a new item will appear between the Panel and
Help Features on the Main Menu as shown below.
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When you select Catalog . . . <, Calculate New Average Price, this item uses all
of the purchase costs you have entered into the Transaction table, as well as those
in the Asset table (using the number of items you have in stock), to find an
average cost price. 

This new price will be entered as a new Purchase Cost on the left side of the
Accounting tab.  This new cost will be associated to any new assets that you enter
into the Asset table.

You decide and enter a Mark up % in the field provided.  This figure should be
the amount you need to “mark up” the price you pay to receive and store the
widget, and the price you will charge the customer.

Fill in the Unit of Issue describing the way the widget is sold, for example, each,
by the dozen, by the gross, etc.

If you select the Autocalc Charge/Unit, the new Charge/Unit will be filled out
automatically including the Mark up.

This information is not intended to be used in any of the Depreciation or
Accounting areas, but only displayed for you as the price that you can use as a
departmental charge back or that you can use for your customer if you are selling
your assets.

In summary, the Charge per unit’ exists in only two places: the Catalog and Work
Order Line Items. It is meant to be the amount that a customer is charged for an
item when the item is moved from your inventory into the customers possession.
It contains a ‘mark up’ that the vendor charges the customer. It is not involved in
Moves from the Transaction to the Asset tables and is not involved in any other
part of Bar|Scan.
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More on the Chargeback feature

The calculated average for a new Purchase Cost in the Catalog is determined
based on the following rules:

T All Location History entries with a room tag listed for exclusion in the
Company settings screen are excluded from averaging.

T All Location History entries with a Quantity less than one (1) are excluded from
averaging, as inventory withdrawals are not included in a ‘Cost’.

T All Location History entries that belong to an asset with a total quantity less
than one (1) are excluded from averaging as this asset is on back order (whether
or not some of the Location History quantities themselves are positive).

T A Zero value in the Location History Cost per Unit field means that it uses the
default Catalog Purchase Cost. Therefore when doing the averaging calculation
all Location History items with a Cost per Unit of zero are calculated as if they
have a Cost per Unit equal to the Catalog Purchase Cost. For example, if there are
four location history entries with Costs per Unit of 0,2,0,4 and the Catalog
Purchase Cost is 3, then this would be the equivalent of 3,2,3,4 in the averaging
calculation.

No change will be made if:

T The catalog is not being used in the Asset table.

T The resulting average is the same as the current Catalog Purchase Cost.

The averaging works for all assets, including ‘Z’ assets, as long as the monetary
amounts entered in the ‘Cost per Unit’ field of the Location History is actually a
cost per unit and the Catalog Purchase Cost is also a cost per unit number.
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The ‘Cost per Unit’ is what is paid for an item on a unit basis. It is generally
entered into the Transaction table as what is paid for an item when received so
that the value goes with a Location History entry once sent to the Asset table. If
the amount paid is the default Catalog Purchase Cost then the Transaction entry
should have a ‘zero’ value for ‘Cost per Unit’ indicating that the default Catalog
Purchase Cost is being used. 

The Transaction ‘Cost per Unit’ is not initialized with the value currently held in
the Catalog Purchase Cost. However, if the Cost per Unit is different from the
Catalog Purchase Cost then it needs to be hand entered so that it will be tracked
accurately. From a practical standpoint this generally means that customers either
always use the Catalog Purchase cost or always enter a Cost per Unit for each
Transaction. 

From time to time the operator will be instructed to adjust the amount charged to
customers who consume the item. This is the ‘Charge per Unit’ listed in the
Catalog and is either hand entered or automatically calculated FROM THE
CATALOG PURCHASE COST. This ‘Charge per Unit’ is the value that is then
entered into the Work Order line item Charge per Unit. The Catalog Purchase
Cost value comes either from a hand entry or an averaging calculation as
described above.

When doing reports that use Cost per Unit fields the Report Generator must know
how these fields are being used in the company. If the costs per unit are always
being entered into each Transaction and then moved up to the Location History
then use these fields when listing costs per unit and doing calculations with them
in reports. If Costs per Unit are not individually tracked in the Location History
but are only being entered into the Catalog as a Purchase Cost, then use that field
when doing reports. However, if a customer wants to ‘mix and match’ Catalog
Purchase Cost and Location History Cost per Unit values then the customer must
use the Location History Cost per Unit field with an adjusted expression that takes
the Catalog Purchase Cost when the Location History Cost per Unit is zero. To do
this change the Location History ‘Cost Per Unit’ ‘Expression’ entry (under
Properties) from: O_CPERU’
To:  IIF(LH.O_CPERU=0,CA. PL_COST,LH.O_CPERU) 

Be sure that at least one Catalog field exists in the report or they will get an error
when attempting to print.
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Components Tab

Bar|Scan has a set of features are available to allow  you to create, modify and
move groups of assets by selecting them using both a Catalog Component List or
an Asset Bill of Materials (BOM) List.  

With these new features, you can move these groups as a whole, perform work on
these groups by means of a Work Order, reserve the components of these groups
by means of a Reserved Bill Of Material so that they will not be available for use
to build other groups or be moved to other locations.

You can also create Bar|Scan reports detailing these special catalogs, assets, and
components and their relationship.

Catalog Components, Asset Bill of Materials, Reserved Bill Of Materials and
Reporting are all discussed in more detail in the following sections.

This is the Catalog Component List.  There are many columns of information
displayed on this tab.  You can move these columns so that they are arranged in
any order that best suits your requirements.  Once these columns are moved, their
placement is retained until you choose to move them again.  Since there are more
columns than can normally be seen on smaller PC screens, it is best to arrange
them so that the most commonly used columns appear towards the left.  Feel free
to navigate to the right side to examine all of the columns.
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When you choose the Edit Tab of the Catalog, you will see a Tab called
‘Components’.   If you have not yet added any components, you will be presented
with a screen similar to the following.

There are also several buttons on the right side such as ‘Add Catalog’.  The most
important one is the ‘Count’ Button which is explained below.

Count

Even though we are on the Catalog Screen, the Count Button can be used to
determine how many Component Assets are available to build the specified
Catalog.

All Assets in your Company Database are either a.) part of an existing assembly
or b.) are available to be used as an assembly. If they are not part of an existing
assembly, they can be used in new assemblies.
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For example, if a catalog SY0001 is a Furniture Workstation and is the assembly
of nine items (two Pedestals, three Overhead Storage Cabinets and five Panels)
and there are 22 Pedestals, 30 Overhead Storage Cabinets and 100 Panels in
inventory, you can potentially make ten (10) assemblies.

After you made ten assemblies, you would have no more Overhead Storage
Cabinets left (30 Overhead Storage Cabinets divided by 3 required per Furniture
Workstation = 10 total possible Workstations).

Based on the above scenario, when you pressed the Count Button, you would see
a dialog box like the one below.

If now you actually do build these 10 assemblies, You will have 2 pedestals,  
Zero Overhead Storage Cabinets and 50 panels left over.

If you later get in six more Overhead Storage Cabinets Assets and add them to the
Asset Table and then you were to press the count button again you would get a
value of 2, i.e., “There are currently enough unreserved assets available to
assemble 2 more catalog SY0001 Furniture Workstations”. 

In short, when you click on the ‘Count’, it examines all of the assets and
determines how many of this particular catalog can be put together using
‘unreserved’ assets. If it is already part of an assembly it can not contribute to the
count.
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Goto Master and Goto Component

These buttons are used when a Catalog is either part of an assembly or owns an
assembly.  If it has components and you select the component in the list to the left
then select ‘Goto component’, then the current asset becomes the one selected.
You move to that Catalog. Likewise, if you see a master Catalog in the list of
masters (see the Masters: None in the picture right above the list.) selecting the
‘Move to Catalog’ moves to that Catalog number. (Note that it is technically
possible to have more than one master.) Using these two buttons you can navigate
throughout a specific item and its components without going to the browse.

Using our example, of a catalog SY0001 Furniture Workstation and is the
assembly of nine items, the completed Catalog Component List would look
something like the screen below.  How was it determined which Catalogs were
needed to build this Workstation?  Bar|Scan has no intuitive knowledge of how
components are put together, therefore you must have the expertise either in
furniture, computers or other types of assets to build the Catalog Component List. 
If you do not have this expertise, consult your Bar|Scan Administrator for
guidance.
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As with all Look up windows in Bar|Scan that display more than one column, you
can right click and resort the information shown to improve your selection
process.  This is shown in the Screen below. 

The Bar|Scan Imaging Module can be very useful when working with Furniture
Components.  Images can be displayed on both the Browse Tab and Edit /
Components Tab.  Asset Images can also be displayed on the Asset Browse Tab.
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Below is an example of Catalog Images on the Browse Tab of the Catalog Table. 

How are Images displayed on the Browse Tabs of Bar|Scan?  You can display
images on Asset and Catalog
Browse Tabs by right clicking
on either the Asset # header or
the Catalog header as shown in
the example at the left.  The
Asset Number or Catalog
Number will be replaced with
the corresponding image.  If
there is no image available, it
will be blank.
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Changing Catalog Information

From time to time you will want to change, correct, or add information associated
with Catalog Numbers currently existing in the Bar|Scan system.

In addition to changing the information associated with an individual Catalog
Number, this feature permits you to identify a group of Catalog entries, and then
make the same change to the entire group at one time.

If you are a Master User (administrator) then Bar|Scan will permit you to change
a Catalog Number.  When you change the number, you are prompted to permeate
the change throughout the database. Typically you would reply YES to the
conformation prompt.  Below is an example:

Go to the Browse panel.  Select the first item that you wish to change, and press
the F4 (Range) key.  The item will be highlighted; the default highlight color is
green.  Go to the last item that you wish to change, and click on it or use the arrow
keys to highlight them as you go.  When all of the items that you wish to change
are highlighted, press the <Enter> key.  Then, go to the Edit panel to make your
change(s).  When you press the Save button or the Ctrl + S key combination, you
will be asked to confirm the change to the one Catalog that is displayed.  Then you
will see a message that asks if you would like to send the change(s) to all of the
items in the range.  If you select Yes, then all of the items will have been changed.
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When you have completed and saved the changes, all assets assigned the Catalog
Number being changed will immediately reflect the changes, i.e., if you changed
the spelling of the Manufacturer’s name, then all of the assets that are linked to
the Catalogs that you have changed will immediately show the change.

Deleting a Catalog Entry 

This feature completely removes Catalogs from the Bar|Scan system.  Obviously,
caution should be exercised when using this feature.  Removing Catalog Numbers
from the system is most often done due to erroneous entries.

Bar|Scan will NOT permit you to delete any Catalog Number currently assigned
to an asset.  

From time to time, you might want to delete a Catalog Number currently in use
(i.e., you may have two Catalog Numbers describing the same thing).  First, go to
the Transaction table,  change the Catalog Number on any asset that is using the
number you wish to delete.  Then, go to the Asset table and change the Catalog
Number on the assets containing the number you wish to delete.  After this is
done, no assets will be using this Catalog number, and you may then delete the
Catalog number.

Bar|Scan permits you to identify a single Catalog number or a group of Catalog
numbers which can be removed from the system all at once.  Use the F4 (Range)
feature to first identify a particular Catalog number or the group of Catalog
numbers that you wish to remove.  Press the Enter key to end your Range.

Select the Delete Items button from the tool bar.  It is pictured at
the left.  You will be shown a dialog box like the one below.
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If you choose, Yes, you will be shown another dialog box that asks, “Really delete
this 1 catalog?”  If you select Yes, you will see another dialog box that says,
“Delete Done.”  If your response to the above dialog box is No, the dialog box
disappears, and you  will remain on the browse panel.

Merging Catalogs

Over time it is possible to create several different Catalogs for the same item. For
example, you might have created (or imported) a Catalog EP0305 and EP4123
with the same or similar description.

While this does not affect the day to day operation of Bar|Scan, it is best to
remove the duplicates. Fewer duplicates results in less data being synchronized
into your Mobile Devices as well as better reporting.

There are several steps to remove or merge Catalogs. These steps are required
because Bar|Scan will not allow you to delete Catalogs that are being used, nor
will Bar|Scan allow you to change the Catalog Number. This is to maintain your
database integrity.

Follow these steps to remove or merge Catalogs:

1. Open the Catalog Table and identify the Catalogs that you wish to remove. We
recommend that you use a SET command to sort the data by type and description,
model number, or any other descriptive sort that makes sense for you. Duplicates
will be easily visible since they will be next to each other. Also, make sure that the
Catalog Category and Catalog Number are both columns being displayed on the
Browse Panel.

2. For each similar Catalog, decide which one you wish to keep and which one
you wish to discard. Write down, or enter into Excel their Catalog Numbers in 2
columns titled “Keep” and “Discard”.

3. Now we want to change all the Assets using the “Discard” Catalog number to
use the “Keep” Catalog Number. Open the Asset Table and use a SET Command
by Catalog Number. Make sure that the Catalog Category and Catalog Number are
both columns being displayed on the Browse Panel. Remember, you cannot edit
the first column which is the SET Command Column.
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4. On the Asset Screen, find the Catalog from the “Discard” column on your
notes. Use the Range Function to highlight all assets with this Catalog and change
all the Catalogs to the Catalog Number on the Keep column. Do this for all
Catalogs in your list. 

5. Finally open the Catalog Table and delete the Catalogs from the “Discard”
column. 

Optional: If you want to delete ALL Catalogs not being used, you can range all
of your Catalogs and press Delete. Only Catalogs not being used will be deleted.
Be careful about performing this function since you might want to have some of
these Catalogs for future assets.

THE THIRD TAB - UDF

The third tab of the Catalog table is for the User Definable Fields, and will be
accessible only if you purchased the optional User Definable Fields as part of your
system, and have entered at least one UDF.

Page 7-54 Bar|Scan



Chapter 7

If you have the UDF module, but have not yet created any UDFs in the Catalog
table, then this tab will not show up.  If you want to access the UDF tab, simply
go to the Main Menu while you have the Catalog table open, and select Panel,
then, select Design Mode-User Defined Fields.  The tab will then appear, and you
will be using the Design Mode, ready to create your first UDF.

Please refer to Chapter 16 of  this User Manual, User Defined Fields, for more
information on creating UDFs and using this feature.

CATALOG CATEGORIES

From the Main Menu, select File, then Open . . . <, then Catalog . . . <, then 
Categories, as shown on the following example.
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You will see the Categories table, similar to the one shown below.

To select a Category, either type the first letter, or move the highlight bar to the
item and press ENTER.  Then, select the Edit panel to add, change, or view the
details that were, and can be entered for a Catalog Category.

In addition to adding a Category, you also use the Category table to define how
many attributes appear, and how many characters an attribute will hold.
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This screen permits entry of a new Category, the Category name, and up to seven
Attributes.

You can decide how many attributes to associate with a Category, up to seven. 
You decide the name for the attribute, and the length of the attribute, as well as
the  name of the look up list.  

You may also make changes to existing Categories on this screen.

It can be a very valuable tool to have the ability to create additional Categories.
However, care should be taken to ensure that there is a simplicity to the Categories
involved, so that there is not more than one Category available for a particular
type of asset.
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Attribute Length

When filling out your attributes in the Catalog table, you may notice that you are
not able to print as many characters as you would like.  Twenty (20) is the
maximum number of characters available for any attribute, but the default length
may be smaller.  You may make the Attribute fields appear wider, up to twenty
characters wide, by accessing the Category that you are working on.  

Simply select the Category that you would like, and then select the Edit tab.

For instance, if you wanted to change the length of the attributes on the AA (Arts,
Artifacts, & Accessories) Category, you would select the AA Category on the
Browse panel, and then select the Edit tab. 

Attribute number one, is for the Artist.  The Input Length is set at 16.  Simply use
the arrows next to the 16 to enlarge this field, or make it smaller, depending on
your needs.

In order to get as much information on an asset report as possible, Bar|Scan will
print all twenty characters on a report, but they may automatically wrap to the next
line if the column width does not allow for the field to print all twenty characters. 
You may however, widen the columns on a report in order to view the entire field.

For more information on adjusting the width on the columns of a report, please
see Chapter 10 - Reports.

Hint: Contact your Bar|Scan Dealer if you must print more attribute information
than Bar|Scan has in it by default.  Perhaps, you may require a UDF - User
Definable Field.
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MANUFACTURERS

You will want to identify the manufacturers of the different types of assets in your
company.  In addition to the name of the manufacturer, Bar|Scan provides space
to enter other information about the manufacturer.  Occasionally, you will want
to identify the name of a vendor rather than the manufacturer, e.g., you might
purchase an item which has been assembled from products supplied by several
manufacturers.

From the Main Menu, select File, then Open . . . <, then Catalog . . . <, then
Manufacturers, as shown on the following example. 
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You will see the Manufacturer’s table, similar to the one shown below.

When you want to Add, Change, or View the details for any of these
Manufacturers, select that Manufacturer, and then select the Edit tab.  
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To select a Manufacturer, either type the first letter, or move the highlight bar to
the item and press ENTER.  Then, select the Edit panel to add, change, or view
the details that were, and can be entered for that Manufacturer.

The selected Manufacturer entry will be displayed.

You may press the PgDn key, or the Next Item button to view the next
Manufacturer from the selection list. The PgUp key or the Prior Item button will
display the previous Manufacturer.  Ctrl  + Home key combination or the First
Item button will display the first Manufacturer on the selection list,  and the Ctrl
+ End key combination or the Last Item button will display the last.  

You may use any of the following buttons: Add Blank, Add Template, Save
Selected Items, and the Cancel Changes on the Edit tab.

Press the ESC key to return to the Main Menu.  Note if you have pending
additions or changes, you will be shown a dialog box that asks you to save or
cancel these additions or changes before you are allowed to exit this panel.
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Entering a New Manufacturer

Add Blank Item, or Add Template Item both permit you to enter a new
manufacturer into the Bar|Scan system.  To select the Add Blank Item or Add
Template Item, simply click on their respective buttons on the tool bar.

If you choose Add Blank, a blank manufacturer display screen will appear.  If you
choose Add Template, you will be using the manufacturer that your cursor was on
for a template.

Press Esc to return to the Main Menu without selecting a manufacturer.  Note: If
you have pending additions or changes, you will see a dialog box asking you to
save or cancel the pending additions or changes before you will be allowed to exit
this table.

The Edit tab is divided into two sections, Addresses, and Catalog Categories.  The
left section, Addresses, permits you to enter the vendor or manufacturer's name,
contact, the address, the telephone, and the fax number.  The right side of the
Addresses tab has fields for alternate address information.  The Catalog
Categories tab will allow you to determine which categories the manufacturer
shows up for when you select the Look up Value.

All of the information for the Manufacturer’s table is very unique.  But, all of the
items on this screen have look up windows available which may be especially
useful to find any duplicate entries. 

The information other than the Manufacturer’s name is optional, but may be
entered for information purposes.  

Use the arrow keys, the Tab key, the Enter key, or your mouse to move to the
different fields of the screen and type in the new information.  
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Simply type in the new information, and then select the Catalog Categories tab as
shown below.

On this panel you can decide which Catalog Categories the Manufacturer will
display for.  Double click to Select/Deselect a Category.

Save the information you have entered by clicking the Save button on the tool bar
or by pressing the Ctrl + S key combination.
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Changing Manufacturer Information

From time to time you will want to change, correct, or add information associated
with manufacturers currently existing in the Bar|Scan system.

In addition to changing the information associated with an individual
manufacturer, this feature permits you to identify a group of manufacturers and
then make the same change to the entire group at one time when using the F4
Range feature.

From the Manufacturer’s browse tab, choose a manufacturer and press enter. 
Then, select the Edit tab.  The manufacturer you selected will then be displayed.

If you intend to change a group of manufacturers, use the F4 (Range) feature to
select the group.

You may now change the information listed for this manufacturer.  After you have
made your changes, press the Ctrl + S key combination or the Save button to save
the changed information.  If you have selected a group, Bar|Scan will ask you if
you want to send the changes to all of the Manufacturer’s that you have ranged,
and if you say Yes, it tell you how that these manufacturers were changed.

Removing a Manufacturer

This feature completely removes manufacturers from the Bar|Scan system. 
Obviously, caution should be exercised when using this feature.

Removing manufacturers from the system is most often done due to erroneous
entries.

Bar|Scan permits you to identify a group of manufacturers which can be removed
from the system all at once.  If you intend to delete a single manufacturer or a
group of Manufacturers, use the F4 (Range) feature to first identify and select the
particular manufacturer(s) you wish to remove.

To delete the selected manufacturer(s) once ranged, simply click on the Delete
button on the tool bar.  You will see a dialog box asking you to confirm the
deletion.
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THE ATTRIBUTE REFERENCE LIST TABLE

From time to time, you may wish to change or delete erroneous entries to your
attribute list.  To do this, you need to open the Attribute table.  From the Main
Menu, select File, then Open . . . <, then Catalog . . . <, then Attribute Reference
Lists as shown below.
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You will see the following Attributes Reference table.

This table holds all of the information that you would see when you use the Look
up Value for a Catalog Type, Description, or Attribute.  Some of the items such
as color are shared, and therefore do not list a Catalog Code.  If you need to add
a color that is specifically for only one Category, you can add it, and specify the
Category you wish to have it used on.

You may view or delete items on this Browse panel, or you may select one of the
attributes, and choose the Edit panel.  On the Edit panel, you may add, change, 
or view an attribute.
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When you choose the Edit panel, you will see a panel similar to the one below.

Make your new attributes available for only one Category by specifying a
Category, or to all Categories by leaving the Category field blank.  On the
example shown, the Credenza will be a Catalog Type for the CG-Case Goods
Category.

Deleting an Attribute

When you delete an attribute, it is removed from the selection lists.  It will NOT
be deleted from use in any Catalog.

To remove an attribute from the selection list, simply select the attribute on the
Browse panel, and highlight it using the Range feature.  Then, select the Red X
(delete button) from the tool bar.  A dialog box will appear to ask you to confirm
the deletion.

If you respond Yes, you will see a dialog box telling you that the deletion is
complete. 

Hint: For removing many items from the look up windows automatically, See
Rebuild Catalog Attributes in Chapter 13 - Housekeeping.
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SHARING CATALOGS

The Multiple Company Option allows Bar|Scan to maintain a separate Catalog;
or any other table for each Company that you create.  You have the ability to
import Catalogs from one company to another.

Because of the import capability, you can develop separate Catalog tables for each
line of furniture or type of equipment.

Alternatively, you can create a master Catalog table for all of your companies (or
projects).  Under this scenario, Catalogs are only ADDED to the master Catalog
table.

To do this, select File, then Open . . . <, Table Properties as shown below.
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When the Table Properties browse box appears, choose Catalog, then select the
Edit tab which is shown below.

Next to the Directory Name, there is a field with a down arrow.  Click on the
down arrow, and change your selection from Company to Sysuser, and Save your
selection.

Perform the same steps on the tables needed to support the Catalog Table.  These
are: Catalog Category, Catalog Component and Reference List Tables.  
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The Catalogs for this Company will now be shared by any other company that also
has this setting.  

You must now close Bar|Scan completely, and reopen it.  Check that you still
have the company that you want to share the list from open, and select to do a
Restructure to finalize the change.  Go to the Main Menu, select File  . . . <,
Company  . . . <, Housekeeping  . . . <, Table Integrity.  Select the Company(s) you
have changed, check Restructure, then click on the Ok button.

To implement this scheme for additional companies, when adding a new company
to Bar|Scan, perform the change to the Table Properties to reflect the Sysuser as
the directory for the Catalogs prior to working with the Catalogs.  

It is also advisable to share the Catalog support tables including Catalog Category
and Manufacturer.

Importing a Catalog

If you are not sharing a Catalog table between companies, you can Import a
Catalog from another Bar|Scan database if you have the Import/Export module. 
Then, only those Catalogs which do not already exist need to be created for any
new company.

It is important that the numbers used to create Catalogs differ from previously
created Catalogs.  While Bar|Scan has the ability to change the Catalog Number,
any photographs you have taken of Catalog items probably contain the Catalog
Number.  Obviously, it would be difficult to change these numbers.

For more information on how to import Catalogs, see Chapter 14, Import and
Export in this User Manual.
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STOCK LEVEL

When you want to view, change, add, or delete Stock Levels you will need to open
the Stock Levels table.  From the Bar|Scan Main Menu, select File, then Open .
. . <, then Catalog . . . <, then Stock Levels as shown on the following example.

The Stock Level table is useful for creating Asset Reports that show items that 
below a pre-determined reorder level.

Additionally, if you have the Work Order Module, you can let Bar|Scan
automatically create a Work Order for you to bring your items above the reorder
level.
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When you open the Stock Level you will see the browse table that will look
similar to the one below.

When you first select this table, there will not be any data in it.  You will have to
begin adding data by selecting the Add Blank icon, and adding the first item to the
Edit panel.  After you have added at least one item, you can use it as a template
for your next item.

As you can see, you can maintain a reorder level for each Region, Building,
Catalog Number combination.
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When you click on the Edit tab you will see a panel that will look similar to the
one below.

Enter the minimum reorder quantity and reorder level for every Location and
Catalog combination that you would like to track.  Typically, the stock level
feature is most useful when working with asset quantities and not with
individually tagged assets (where asset quantity always equals one).

Once you have added one stock level, you may use it as a template to add any
others.  
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Here is how you can use the Stock Level table to automatically create a Work
Order for you to bring your items above the reorder level.  When you open the
Work Oder table you will see the following Feature appear on your Main Menu.

You can select “Add Restocking Items” from the pull down when you wish to
have Bar|Scan add line items to the currently open Work Order.  The amount of
line items added will be based upon the Stock Level screen.
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When you select the Add Restocking Items, a dialog box similar to the following
will appear.

The dialog will vary depending on which Work Order you have open when you
select this item.

As mentioned before, this can be especially useful when you are tracking asset
quantities (or as we call them, “Z” numbers).

It can also be used when you are individually tagging assets.  The only difference
is that with individually tagged items, more lines are created on your Work
Orders, one line per asset.
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UPC CODES

Universal Product Codes (UPC or newer UCC-12) are generally not used in
traditional asset systems.  They are widely used in retail sales environments.  UPC
codes are usually only associated with tracking asset quantities.  For a background
on UPC we recommend that you contact GS1 US at http://www.gs1us.org/

When you want to view, change, add, or delete UPC Codes you will need to open
the UPC Codes table.  From the Bar|Scan Main Menu, select File, then Open . .
. <, then Catalog . . . <, then UPC Codes as shown on the following example.

The UPC Code table is designed to work in conjunction with the Mobile Device
as a substitute for the Catalog Number.  This is most useful when in Quantity
Inventory Mode as in the case for inventory consumables or supplies.  As with the
Stock Level table, this can be useful when you are tracking asset quantities or as
we call them “Z” numbers.

The UPC Code table is also designed to work in conjunction with the Work Order
module to assist with non-inventory items by allowing you to scan a Uniform
Product Code “UPC” instead of a Catalog Number to identify an item.
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You will see the UPC Codes table open, and a browse panel similar to the one
below.

As you can see, you can maintain one UPC Code for each Catalog that you enter.

When you first select the UPC Codes table, there will be no information in it. 
You will have to select the Add Blank icon to add your first item.  Once you have
saved at least one UPC Code item, you may use it as a template for all of your
other additions.

Catalogs Page 7-77



Catalogs

When you click on the Edit tab, you will be shown a panel similar to the one
below.

You can enter a UPC Code by either typing the code directly from the item or,
optionally scanning the information in with a wedge bar code scanner.  

Note: In order for the UPC Code information to appear in this field, you have to
have your cursor on this field when you scan the bar code.
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On the Shopping portion of the Work Order Screen, scanning a UPC Code with
a wedge scanner will fill in the appropriate Catalog Number for you.

Obviously, the UPC Code feature is designed to be used in a retail like
environment.

However, it is a very flexible feature.  We suggest that you consult with your
Bar|Scan dealer for more information on this feature should you feel that this may
be part of your Asset Management requirements.

Catalogs Page 7-79



Catalogs

CATALOG DEVELOPMENT GUIDELINES

CG-CASEGOODS

Casegoods is a term used to describe desks and their returns, table desks, and
credenzas. 

Beware!  Sometimes systems (modular) furniture components are used to create
desks and credenzas in private offices -- in these cases we catalog the components
under the Systems Furniture category - SY. 

Desk, Sgl Ped R       Desk, Table Desk

Desk, Dbl Ped Desk, Sgl Ped-R Return-R
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Desk, Dbl Ped  Armoire

       Credenza          Desk, Sgl Ped-R
                     Return-L

TYPE DESCRIPTION

DESK  A rectangular or oblong table or case especially adapted for writing or studying. 
Usually 28" or deeper (less than 28", may be a credenza). NOTE!  Systems
Furniture may have Desk Shells -- these are not Casegoods, they are Systems
Furniture (see discussion under Systems Furniture, Desk on page 31) 

Pedestal:  A case containing 2 or more drawers.

SGL PED-R/LOCK Single Pedestal.  Only one pedestal on the right
hand side.  May or may not have an attached return
(returns are usually cataloged separately). Indicate
whether it is locking or not (e.g. SGL PED-R/NO
LOCK)
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SGL PED-L/NO LOCK Single Pedestal.  Only one pedestal on the left hand
side.  May or may not have an attached return
(returns are usually cataloged separately). Indicate
whether it is locking or not (e.g. SGL PED-
L/LOCK)

DBL PED/LOCK  Double Pedestal.  Two pedestals (one on each side
of desk).  Indicate whether it is locking or not (e.g.
DBL PED/NO LOCK)

TABLE DESK Table Desk.  No pedestals, usually has a pencil
drawer.

RETURN-LH Left Hand Return.  A worksurface attached to the side of a single pedestal desk,
usually has its own legs or an end panel, may or may not have its own pedestal. 
RETURN-LH Left Hand Return.  When sitting at the desk facing forward, the
return is attached to the left side of the desk.  (Pedestal, if any, is on left as well) 

RETURN-RH Right Hand Return.  When sitting at the desk facing forward, the return is
attached to the right side of the desk.  (Pedestal, if any, is on right as well)

SGL PED-R/LOCK Single Pedestal.  Only one pedestal on the right
hand side.  Indicate whether it is locking or not (e.g.
SGL PED-R/NO LOCK)

SGL PED-L/NO LOCK Single Pedestal.  Only one pedestal on the left hand
side. Indicate whether it is locking or not (e.g. SGL
PED-L/LOCK)
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TYPE DESCRIPTION (continued)

CREDENZA A case that has a desk-like shell with pedestal or door configurations on either side
as well as in the center (some have a knee hole or open space in the center). 
Usually less than 28" in depth (more than 28", may be a desk).  May have shelving
or bookcases above worksurface (if separate component -- see Riser).  NOTE! 
Systems Furniture may have Credenza Shells -- these are not casegoods, they are
Systems Furniture (see discussion under Systems Furniture, Credenza on page 31) 

LOCK LOCK (or NO LOCK) Indicate whether credenza can be locked or
not.

RISER Usually rests on top of a desk or credenza containing open or closed shelves.  (look
for seams between desk/credenza top and riser -- if there are no seams do not
catalog separate. 

ATTRIBUTES

Left, Center and Right Drawer/Pedestal Configurations

1-BX/1-F 
2-BX
2-F
1-P/1-BX/1-F
2-DR
2-SLD

Note:  dash connects number of drawers with type of drawer, diagonal (/)
separates types of drawers.

P Pencil Drawer.  Usually a shallow (2-4" high) center drawer
(sometimes combined as the top drawer of the pedestal).

BX Box Drawer.  Usually 5"-7" high, used to store miscellaneous office
supplies.
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ATTRIBUTES (continued)

F File Drawer.  Over 9" high, made to store files vertically but may
contain other office supplies.

DR Door.  Door hinged on one side.

SLD Sliding Doors.  Sliding panel or door fitted into tracks.

OPEN Open.  No drawer is present.

Top or Base Material

LAMINATE Plastic laminate is a thin layer of plastic which may appear to look
like wood, a solid color, or textured.

WOOD Wood or wood veneer.

METAL Painted or unpainted metal.

Top or Base Finish/Color

COLOR/
FINISH Paint and laminated colors should be listed first, followed by L for

light, M for medium or D for dark (e.g. BLUE-L, BLUE-M, BLUE-
D).  Unpainted metal is typically CHROME.

If two colors, name most dominant color first (e.g. GREEN-
D/BLUE-M, YELLOW-L/GREEN-L).

If more than two colors, name most dominant color first followed
by MULTI (e.g. GREEN-D/MULTI, YELLOW-L/MULTI)
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ATTRIBUTES (continued)

Wood and Laminates which have a wood-like appearance are
typically described as follows:

OAK-L Pale Yellow/Golden Brown
OAK-M Medium Yellow/Golden Brown
OAK-D Dark Yellow/Golden Brown

MAHOGANY Dark Reddish/Warm Brown

WALNUT Dark Chocolate/Ash Brown

DIMENSIONS

Measure overall casegood size to closest 1/4".  Always display fractions (e.g. 32-1/4", 34-3/4",
16-1/2")

MANUFACTURER

Manufacturer name may be found inside a pedestal drawer or under worksurface.  If not able to
locate, list item with Manufacturer = {UNKNOWN}.
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EO-EQUIPMENT OFFICE

Office equipment includes all non-computer equipment including appliances,
facsimile machines, copiers, paper shredders, dictating equipment, and
microfiche/film equipment.

Cell Phones     TV     Copier     Facsimile

         Electric Typewriter       Refrig-Full Microwave
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  Refrig-Comp    Dishwasher             Range   Paper Shredder

TYPE DESCRIPTION
(See Below) Model Name/No. (or Part No. if no Model No.) -- look at plate on back of

equipment
   
SHREDDER 8020

TYPEWRITER  Self Correcting II 3040

FACSIMILE 8000
Look for 10-key pad for dialing telephone numbers)

COPIER 5030
Look for option buttons for number of copies, collate, staple, etc.

MICROFICHE 648x

REFRG-FULL 3089980983 
Full size refrigerator is more than 36" in height.  Note:  Attribute #1 should
reflect color (e.g. GOLD, WHITE) and Attribute #2 should reflect door
configuration (SIDE/SIDE, TOP-FREEZER, BOTTOM-FREEZER)
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TYPE (continued)

REFRG-COMP 6246   Compact size refrigerator is 36" or less in height.

MICROWAVE Ultra Fast 2000

ATTRIBUTES

Generally, attributes are not required.

DIMENSIONS

Generally, dimensions are not required for office equipment unless the item takes up floor space
(e.g. refrigerator, free-standing copier, etc.)  In which case, measure overall size to closest 1/4". 
Always display fractions (e.g. 32-1/4", 34-3/4", 16-1/2")

MANUFACTURER

Manufacturer is very important.  Always collect it on equipment (check plate on back on
equipment).

MANUFACTURER PART NO.

Also referred to as Model Name/Number or Part Number.  Note this separately even when
collected as part of the DESCRIPTION above.  Also, many types of equipment have model
numbers which are different from part numbers.  In which case, the model number goes in
DESCRIPTION and the part number goes in MANUFACTURER PART NO.
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EP-EQUIPMENT PERSONAL COMPUTER

Personal computer equipment includes the personal computer (often referred to
as the CPU - Central Processing Unit), Monitor, Printer, Plotter, External Drive,
Server, Scanner, Digital Camera, UPS, Modem, and Back-ups.

    Dot Matrix Printer          Color Laser Printer        Ink Jet Printer   Server

       
Removable Storage, Tape Backups

Computers Notebook

     

Monitors
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Plotters                   Scanner       Digital Camera

TYPE DESCRIPTION
(See Below) Model Name/No. (or Part No. if no Model No.) -- look at plate on back of

equipment
   
PERS COMP Dell XPS Tower

PORT COMP Dell Latitude 3580

MONITOR Dell 24 UltraSharp 
Beware!  if there is no CPU, a monitor may be a "thin client" to a Server
Computer in which case it would be under the MF category for Main
Frame Computer equipment as a THIN CLIENT.

PRINTER-LS  Dell Mono Printer B3460dn
(Laser) Prints images sheet-by-sheet, usually has a small paper tray like a copier,

no paper roller visible -- Beware!  if there's a 10-key pad, it could be a fax
machine.
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TYPE (continued)

PRINTER-IJ HP - DeskJet 3631 Wireless All-In-One Inkjet Printer  
Non-impact printer which "sprays" ink line-by-line, usually has "Ink Jet"
in its name.

PRINTER-DM OKI® Microline® 321 Turbo
(Dot Matrix) Impact printer which prints images line-by-line, usually has paper with

holes on border but not necessarily.

BACK UP Western Digital 16TB My Cloud EX2 Ultra 2-Bay Storage Server 
Look for hard disk drive like device.

UPS APC UPS 1500VA Smart-UPS with SmartConnect

ATTRIBUTES

Generally, attributes are not required.

DIMENSIONS

Generally, dimensions are not required.

MANUFACTURER

Manufacturer is very important.  Always collect it on equipment.

MANUFACTURER PART NO.

Also referred to as Model Name/Number or Part Number.  Note this separately even when
collected as part of the DESCRIPTION above.  Also, many types of equipment have model
numbers which are different from part numbers.  In which case, the model number goes in
DESCRIPTION and the part number goes in MANUFACTURER PART NO.   
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EV-EQUIPMENT AUDIO/VISUAL

Audio/Visual equipment includes slide and overhead projectors, stereo equipment,
video cassette recorders, televisions, microscopes, video cameras, and video
monitors.

Projector Digital Camera

DVR/DVD Recorder Personal Camcorder

Microscope    Professional Camcorder
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Portable DVD Player     DVD and Blu-ray Disc Player      

Lectern      CD Recorder Player

TYPE DESCRIPTION
(See Below) Model Name/No. (or Part No. if no Model No.) -- look at plate on back of

equipment

PROJ-OVRHD Epson PowerLite X27 XGA 3LCD 

PROJ-SLIDE Kodak 4200 Carousel

DVD PLAYER Magnavox HD DVR/HDD 1TB ATSC Tuner
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TYPE (continued)
       

VCR-VHS 4000 4-head VHS 
Note:  Attribute #1 should reflect tape size -- 1/2" is standard size of home
VCR, 3/4" is a commercial recorder.

STEREO-CD 490 Stereo Player 
Cassette Player

STEREO-POR M9721 Walker Plus 
Portable Stereo Note:  Attribute #1 should reflect features (e.g. CASSETTE, CD,

CD/CASSETTE)

STEREO-REC 8020 Stereo Receiver
Receiver

STEREO-SPK Bosk 590
Speaker

STEREO-TTB Techno Z09394
Turntable

TV Model 900
Look on plate in back for type -- maybe a monitor/receiver.

MON/REC Trace 400
Look on plate in back for type, or a channel selector -- maybe a television.

CAMERA/VID Handcam

CAMERA/35M 35 MM II Plus

ATTRIBUTES

Generally, attributes are not required.
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DIMENSIONS

Generally, dimensions are not required for audio visual equipment.

MANUFACTURER

Manufacturer is very important.  Always collect it on equipment in the Description field (may be
abbreviated) as well as Manufacturer field (check plate on back on equipment).

MANUFACTURER PART NO.

Also referred to as Model Name/Number or Part Number.  Note this separately even when
collected as part of the DESCRIPTION above.  Also, many types of equipment have model
numbers which are different from part numbers.  In which case, the model number goes in
DESCRIPTION and the part number goes in MANUFACTURER PART NO.
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FS - FILES/STORAGE

Includes files, bookcases, closets, storage cabinets, and safes.
         

        Bookcase          Safe          Lateral File Cabinet

   Microfilm File Cabinets   Lateral File Cabinets   Small Storage Cabinet
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  File Map File Storage Cabinet

TYPE DESCRIPTION

FILE A storage device used to arrange documents in a systematic manner for reference
purposes. 

LATERAL-2 Lateral File (most common). At least 24" wide,
allows files to be stored sideways.   Note overall
number of drawers (e.g. LATERAL-3, LATERAL-
4).

     
VERT-LTR-3 Vertical Letter File.  Usually 13"-16" wide, holds 8-

1/2 x 11" papers, files can only be stored facing
front.  Note overall number of drawers (e.g. VERT-
LTR-4, VERT-LTR-5).

     

VERT-LGL-4 Vertical Legal File.  Usually 17"-19" wide, holds 8-
1/2 x 14" papers, files can only be stored facing
front.  Note overall number of drawers (e.g. VERT-
LGL-3, VERT-LGL-5). 
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TYPE (continued)

MOBILE-3 Mobile File.  Moveable (on casters or wheels of
some kind), usually has some sort of hinged lid. 
Note overall number of drawers (e.g. MOBILE-2). 
Beware, if the mobile unit has box or pencil
drawers, it is considered a pedestal.

MAP-FLAT-10 Flat Map File.  Usually has a series of shallow (2"-
5" high) drawers to lay maps, blueprints, mylar, and
other documents flat.  Many times these cabinets
are stacked -- look for seams!

 
MAP-HANGING Hanging Map File.  A cabinet used to hang maps,

blueprints and other documents.  May have a top lid.

SORTER-10 Sorter for literature, stationary, or mail organization. 
Number of slots should be specified under
description (e.g. SORTER-9, SORTER-24,
SORTER-12).

ROLL Roll File.  Open box or grid which holds rolled
documents.

BOOKCASE Usually not as deep as a credenza (15" or less) with
fixed and adjustable shelves used for holding books,
binders or art.  If there are doors, they are usually
sliding.    

5-HIGH Indicate number of shelves high (e.g. 2-HIGH, 3-
HIGH, 4-HIGH)
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TYPE DESCRIPTION (continued)

STORAGE Includes Storage Cabinets (and Closets) and Safes.

CABINET Storage Cabinet.  A storage cabinet with door(s). 
Usually fitted with shelves, shelves and a closet, or
a closet.  

SAFE Safe.  Combination or key lock, reinforced walls
against theft or fire.  

ATTRIBUTES

No. of Drawers/Doors/Shelves

Indicate overall number of shelves and drawers, noting combinations from top to
bottom as follows:

Files:
1-FL/4-DWR  (LATERAL-5 with flipper door on top drawer and 4
drawers)
4-DWR (4 drawers)
1-SLD/3-DWR (LATERAL-4 with sliding doors on top and 3 drawers)

Bookcase:
2-SHELF
3-SHELF
4-SHELF
3-SHLF/2-DR (4 shelf bookcase with 3 open shelves and double doors
across the bottom shelf)

Storage Cabinets and Safes:
2-DR
1-DR
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ATTRIBUTES (continued)

Pull Styles

SLOT Slot.  Recessed drawer pull (5-8" wide).

FULL Full.  Recessed drawer pull across width of drawer.

HANDLE Handle.  Protruding hardware attached on both ends
or across length of handle. 

LEVER Lever. Protruding hardware attached on one end
only.

Feature

LIFT TOP Lift Top.  Hinged lid on mobile file.

TOP LAMIN Laminated Top, different from case.

PULLOUT SHLF Pull-out shelf in taller file cabinets which provides
a surface to review files.

Material

LAMINATE Plastic laminate is a thin layer of plastic which may
appear to look like wood, a solid color, or textured.

WOOD Wood and wood veneer.

METAL Painted and unpainted metal.
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ATTRIBUTES (continued)

Color/Finish
COLOR/
FINISH Colors should be listed first, followed by L for light,

M for medium or D for dark (e.g. BLUE-L, BLUE-
M, BLUE-D). Unpainted metal is typically
CHROME.  If two colors, name most dominant
color first (e.g. GREEN-D/BLUE-M, YELLOW-
L/GREEN-L).  If more than two colors, name most
dominant color first followed by MULTI (e.g.
GREEN-D/MULTI, YELLOW-L/MULTI)

Wood, Veneer and Laminates which have a wood-
like appearance are typically described as follows:

OAK-L Pale Yellow/Golden Brown
OAK-M Medium Yellow/Golden Brown
OAK-D Dark Yellow/Golden Brown
MAHOGANY Dark Reddish/Warm Brown
WALNUT Dark Chocolate/Ash Brown

Lock
LOCK Indicate whether it can be locked or not.

Y Yes
N No 

DIMENSIONS

Measure overall size to closest 1/4".  Always display fractions (e.g. 32-1/4", 34-3/4",
16-1/2").

MANUFACTURER

Manufacturer is often indicated on drawer pull, on side of drawer or inside of case.  Manufacturer
is important.
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SE - SEATING

All types of seating including chairs, sofas, guest and lounge seating.

     Conf/Guest Chair     Task Chair      Lounge Chair Drafting Chair
         4-Leg Base    5-St/C Base      3-Panel Base    5-St/C w/FootRing

Base

               Sofa, 3-Seat   Task Chair,       Love Seat
Open/T Arms
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Task Chair, Armless    Exec Chair     Stackable Chair Conf/Guest
 Med and High Back w/Sled base

       

TYPE DESCRIPTION  

CHAIR TASK/MD-BACK Task or Operation Chair.  Mid or Lower Back
Chair, usually has a star base.  Seat is typically
square or deeper than it is wide.  Usually has arms,
but not always, and they are generally not connected
to the back of the chair.

MD-BACK Seat back stops near shoulder
blades.

LW-BACK Seat back stops below shoulder
blades.

EXEC/HI-BACK Executive Chair.  High or Mid Back Chair, usually
has a star base.  Seat is generally more generous
than a Task Chair and usually has a high back. 
Always has arms, usually closed and connected to
the back of the chair.  Often upholstered in leather.

HI-BACK Seat back is high enough to rest
head.

MD-BACK Seat back stops near shoulder
blades.
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TYPE DESCRIPTION (continued)

CONF/GUEST Conference/Guest or Side Chair.  Often has a sled
base or 4 legs, sometimes have star base but no
castors.  Conf/Guest Chairs are usually found in
conference rooms and used as guest seating in
offices.

STACKABLE Stackable Chairs.  Most commonly found in
cafeterias, lunch rooms and training rooms. 
Typically not upholstered.  Sled base or 4 legs
which allow them to be stacked on top of each other
for storage when not in use.

  
FOLDING Folding Chairs.  Collapsible chairs found in

cafeterias, lunch rooms and training rooms. 
Typically metal frames with 4 legs that can be
collapsed for storage when not in use.

DIRECTOR Director Chairs.  Tall wood frame folding chairs
with canvas back and seat cover.

LOUNGE Reception or Lounge Chairs.  Generally, fully
upholstered lower chair with closed arms.

SOFA 2-SEAT Love seat or 2-seat Sofa. Name amount of seating
available (e.g. 3-SEAT, 4-SEAT, 5-SEAT)
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ATTRIBUTES

Arm Type

ARMLESS No arms.

CLOSED/UPHD Closed Arm.  Arm rest is solid attaching to seat back and
bottom.  Note if Upholstered.

CLOSED/PANL Closed Panel Sides.  Arm rest is solid panel to floor.

OPEN/SLOPE Open Slope Arm.  Arm rest begins at seat back and slopes
down to front side of seat bottom.

OPEN/T Open Arm, T-Style.  Arm rest is supported by a single
bar which extends from the side of the seat bottom to
the center of the arm rest.

OPEN/LOOP Open Arm, Loop Style.  Arms rest loops up from seat
bottom in front and then returns to seat bottom near
back -- does not attach to seat back.

OPEN/HANDLE Open Arm, Handle Bar Style.  Arm rest is supported by a
single bar which extends from the back part of seat bottom
to back of arm rest. 

OPEN/FRAME Open Frame Arm.  Arm rest is formed by a rectangle or
square frame which goes to seat bottom or to floor.
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ATTRIBUTES (continued)

Upholstery Material

FABRIC Fabric.
LEATHER Leather.
WOOD Wood or Wood Veneer.
METAL Painted or unpainted metal.
PLASTIC Molded plastic or urethane.
VINYL Vinyl (synthetic leather)

Upholstery Color/Finish

COLOR/FINISH Colors should be listed first, followed by L for light,
M for medium or D for dark (e.g. BLUE-L, BLUE-
M, BLUE-D).  Unpainted metal may be called
CHROME. Pattern Names and Color Names and
Numbers can often be obtained from labels on the
seat bottom of chairs.  

If two colors, name most dominant color first (e.g.
GREEN-D/BLUE-M, YELLOW-L/GREEN-L). If
more than two colors, name most dominant color
first followed by MULTI (e.g. GREEN-D/MULTI,
YELLOW-L/MULTI)

Wood and Plastic which have a wood-like
appearance are typically described as follows:

OAK-L Pale Yellow/Golden Brown
OAK-M Med. Yellow/Golden Brown
OAK-D Dark Yellow/Golden Brown

MAHOGANY Dark Reddish/Warm Brown

WALNUT Dark Chocolate/Ash Brown
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ATTRIBUTES (continued)

Base Type

5-ST/C 5-Star Base with Castors (4-Star Base with Castors (4-
ST/C).  Without Castors (e.g. 5-ST, 4-ST)

  SLED Sled Legs.  Sled style leg returns from front legs
connecting to back legs, if any.

PANEL Panel sides.  Solid panels extend from seat bottom (or
arm rest) to floor.

4-LEG 4 legs.  Straight legs extend from 4 corners of the seat
bottom.

Base Features

PN/S/T
M/S/T
S/T

Note:  diagonal (/) separates features.

PN Pneumatic adjustable seat height (seat rises when
lever is pressed).

M Manual adjustable seat height (seat height can be
adjusted by turning a knob or winding the seat).

S Swivel Seat.  Seat turns or rotates independently
from seat bottom.
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ATTRIBUTES (continued)

T Tilt.  Seat back (or entire seat) must tilt back --
much check for a lever to release tilt.

{N/A} If no special features are present, indicate not
applicable.

Base Material

PLASTIC Plastic may appear to look like wood, a solid color,
or textured.

WOOD Wood or wood veneer.

METAL Painted or unpainted metal.

Base Color/Finish

COLOR/
FINISH Colors should be listed first, followed by L for light,

M for medium or D for dark (e.g. BLUE-L, BLUE-
M, BLUE-D).  Unpainted metal may be described as
CHROME.  If two colors, name most dominant
color first (e.g. GREEN-D/BLUE-M, YELLOW-
L/GREEN-L).  If more than two colors, name most
dominant color first followed by MULTI (e.g.
GREEN-D/MULTI, YELLOW-L/MULTI)

Wood and Plastic which have a wood-like
appearance are typically described as follows:

OAK-L Pale Yellow/Golden Brown
OAK-M Med. Yellow/Golden Brown
OAK-D Dark Yellow/Golden Brown
MAHOGANY Dark Reddish/Warm Brown
WALNUT Dark Chocolate/Ash Brown
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ATTRIBUTES (continued)

DIMENSIONS

Measure overall width and depth of chair at its widest point.  Chairs whose height can be adjusted
should be recorded with a height of 0", other chairs should be measured from floor to top of seat
back.       

MANUFACTURER

Many chairs have manufacturers tag located on the seat bottom that will indicate the Manufacturer
and Part or Model Number.  Collect this information whenever it is present.
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SY - SYSTEMS FURNITURE

Systems furniture (sometimes called modular furniture) is a series of components
which are combined and recombined to make workstations or cubicles.  They can
be metal, wood, or laminate.

Desk, Sgl Ped-R Cubicle
Bridge, Modesty Panel,
Bullnose Wksf

      Wksf/Corner/Square edge

Desk, Sgl Ped-L, Bridge,
Credenza, Open, 2-dwr, 2-dwr
Riser-Lock, 4-dr

    Desk, Sgl Ped-R, Bridge,
    Wksf/Bullet, Riser-Lock, 2-dr
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Pedestals, 2-F, & 2-Bx/1-F  

TYPE DESCRIPTION  

PANEL Panel.  Wood, fabric, or glass panels (movable walls) that are used to create private
work areas and support other components.  Panels come in various heights and
widths and have different capacities for electrical cord and cable management. 

WOOD/FABRIC Wood on one side, panel on the other.

GLASS Glass.

FABRIC Fabric on both sides.

WOOD Wood on both sides.

PANELEND Panel End.  Wood, fabric or glass panels which support the end of a worksurface.

WKSURFACE
Worksurface.  A combination of flat surfaces which combine to make a
desktop/worksurface in the workstation.  They are usually (but not always) hung
or supported from a panel by cantilever bracket.
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OVERALL SHAPE/EDGE STYLE

RECT/BULLNOSE
BULLET/RADIUS
CORNER/SQ EDGE
TRANS/SQ EDGE

OVERALL SHAPE

RECT Rectangular or square worksurface.

BULLET Rectangular worksurface with rounded end --
sometimes referred to as a D-worksurface.  

CORNER Corner worksurface with straight or curved
front.  

TRANS Transaction worksurface.  Shallow worksurface
typically found in reception area at standing
height.
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TYPE DESCRIPTION (continued)

WORKSURFACE (continued)

EDGE STYLE

SQ EDGE Square Edge.  Edge is at a right angle (straight up
and down) with sharp corners.

RADIUS Radius Edge.  Similar to square edge in shape except
top and bottom edge are slightly rounded.

BULL NOSE Bull Nose.  Edge is full round curve (rounded) from
top to bottom.

T-MOLD T-Molding.  Similar to radius edge in shape but has
different plastic or wood trim that is attached from
within.  The cross section at left illustrates how t-
molding gets its name.

BEVELED Beveled Edge.  Edge is cut at an angle other than a
right angle (up and down). 
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TYPE DESCRIPTION (continued)

PEDESTAL Pedestal.  A combination of drawers that sits on the floor or is hung under a
worksurface.  Pedestal Configurations should be described from top to bottom as
follows:

1-BX/1-F 
2-BX
2-F
1-P/1-BX/1-F

Note:  dash connects number of drawers with type of drawer, diagonal (/)
separates types of drawers.

P Pencil Drawer.  Usually a shallow (2-4" high) center
drawer (sometimes combined as the top drawer of
the pedestal).

BX Box Drawer.  Usually 5"-7" high, used to store
miscellaneous office supplies.

F File Drawer.  Over 9" high, made to store files
vertically but may contain other office supplies.

PED-MOBIL Mobile Pedestal.  Same as pedestal above, except it has rollers or castors.

OH/STG Overhead/Storage.  Includes cabinets and open shelves that attach above
worksurface level.

FLIPPER CAB/2-DR Flipper Cabinet. Overhead storage hung from panels
above worksurface with a door that opens from
bottom, usually slides back into top of overhead
storage unit.  Specify number of doors (e.g.
FLIPPERCAB/1-DR) 
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TYPE DESCRIPTION (continued)

OPEN SHELF Open Shelf.  May have sides or simply a shelf that
is hung from panels above worksurface.  With
certain systems you may need to specify full or half
sides as follows:  OPEN SHELF-FULL SIDES or
OPEN SHELF-HALF SIDES.

TASKLIGHT Tasklight.  Typically the tasklight is attached below an Overhead
/Storage Bin or Shelf and provides light for the work area below.

TACKBOARD Tackboard.  A fabric covered board that attaches to panels or wall
track to provide tackable display surface.

FINISH POST Finish Post.  A panel post that serves as either a connector to
panels or a cosmetic finish strip to panel connections or a cosmetic
finishing strip on corners and straight connections.

CREDENZA Credenza Shells.  Some manufacturers of systems furniture offer
pre-fabricated credenza shells.  Others allow you to purchase
separate components in order to create a credenza-like case
(worksurface and end panels).  In both cases, pedestals are usually
ordered separately.  Most customers prefer that the cataloging
process (and subsequent tagging) reflect the way the product is
purchased.  Some prefer to have the components broken down into
end panels and worksurface.  The Project Manager will discuss
these options with the customer and make a determination.      

DESK Desk Shells.  Some manufacturers of systems furniture offer pre-
fabricated desk shells.  Others allow you to purchase separate
components in order to create a desk-like case (worksurface,
modesty panel and end panels).  In both cases, pedestals are
usually ordered separately.  Most customers prefer that the
cataloging process (and subsequent tagging) reflect the way the
product is purchased.  Some prefer to have the components broken
down into worksurface, modesty panel and end panels.
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ATTRIBUTES

Surface Material #1, #2 or Trim

LAMINATE Plastic laminate is a thin layer of plastic which may appear to look
like wood, a solid color, or textured.

WOOD Wood or wood veneer.

METAL Painted or unpainted metal.

GLASS Glass.  Usually only panels are glass (in finish note clear, smoke
or color)

Surface Finish/Color #1, #2 or Trim

COLOR/
FINISH Colors should be listed first, followed by L for light, M for

medium or D for dark (e.g. BLUE-L, BLUE-M, BLUE-D). 
Unpainted metal may be described as CHROME.

If two colors, name most dominant color first (e.g.
GREEN-D/BLUE-M, YELLOW-L/GREEN-L).
If more than two colors, name most dominant color
first followed by MULTI (e.g. GREEN-D/MULTI,
YELLOW-L/MULTI)

Wood and Laminates which have a wood-like
appearance are typically described as follows:

OAK-L Pale Yellow/Golden Brown
OAK-M Med. Yellow/Golden Brown
OAK-D Dark Yellow/Golden Brown

MAHOGANY Dark Reddish/Warm Brown

WALNUT Dark Chocolate/Ash Brown
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ATTRIBUTES (continued)

Power/Lock/Grommet

Panels (Powered or Non Powered):
Y Yes
N No
3+D Circuit (Usually only available by looking at

Mfr Part No.)

Overhead/Storage and Pedestals:

Lock.  Some overhead/storage bins and pedestals have their own
key lock and should be specified as locking or non-locking.

Y Yes
N No

Worksurfaces:  

Lock/Grommet

Y/N Has Lock/No Grommet
Y/Y Has Lock and Grommet
N/Y No Lock/Has Grommet
N/N No Lock or Grommet

Lock. Certain manufacturers make worksurfaces that are the
locking controller for pedestals.  The worksurfaces themselves
lock as opposed to the pedestals.  In this case, the worksurfaces
must be specified as locking or non-locking.  

Grommet. Grommets are holes in the worksurface fitted with a
snap-out cover that allows you to pass cords and cables through
the worksurface.

Other (Tasklights, Finish Posts, etc.):

Leave blank.
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DIMENSIONS

Measure overall actual size to closest 1/4".  Always display fractions (e.g. 32-1/4", 34-3/4",
16-1/2") .

MANUFACTURER

Manufacturer name may be found inside a pedestal drawer or case, or under top cap of panel.  
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TA - TABLES

Includes conference, computer, printer, occasional, phone, and work tables.

            Occasional Table     Drafting Table

   Occasional Table       Conference Table

               
 

          Work Table Occasional Table
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Conference Table Folding Table

TYPE DESCRIPTION  

TABLE CONFERENCE Conference Table.  Any table with room for
2 or more people to meet.

COMPUTER/RISER Computer Table.  Free standing work-
COMPUTER/SHLF surface with special accessories for
COMPUTER/KEYBDSHLF computers (e.g. keyboard drawer, riser, slot

for paper fee).  Generally, 30" wide or
wider.

WORKTABLE Work Table.  Similar to a computer table in
size but no special accessories for computer
equipment.

PRINTER Printer Table.  Small table with a slot for
paper or sheet feeder basket or shelf below
top surface.  Generally, less than 30" wide.

TYPEWRITER Typewriter Table.  Small table (often with
casters) with knee hole that has at least one
collapsible leaf.  Generally, 18-24" wide
without leaf extended.
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TYPE DESCRIPTION (continued)

TELEPHONE Telephone Table.  Small table with square
top --generally, 12x12".

DRAFTING Drafting Table.  Typically taller than
traditional worksurfaces with the ability to
tilt the worksurface.  Usually will have some
drawing arm apparatus at the top but not
always. 

OCCASIONAL Occasional Table.  Include coffee tables, end
tables, parsons or library tables of various
shapes and sizes.

FOLDING Folding Table.  Tables whose legs can be
collapsed or folded for storage.
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ATTRIBUTES

Top Style        Describes shape of top.

RECTANGLE 4-sides, width not equal to depth

SQUARE 4-sides, width equal to depth

ROUND perfect circle

OCTAGON 8-sides

PENTAGON 5-sides

OVAL oblong

BOAT shaped like a small boats hull, coming towards a point
at each end (may be not actually reach point)

     HALF MOON      half circle, straight on one side.

Edge Style

SQ EDGE Square Edge.  Edge is at a right angle (straight up
and down) with sharp corners.

RADIUS Radius Edge.  Similar to square edge in shape except
top and bottom are slightly rounded.

BULL NOSE Bull Nose.  Edge is full round curve (rounded) from
top to bottom.
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ATTRIBUTES (continued)

Edge Style (continued)

T-MOLD T-Molding.  Similar to radius edge in shape but has
different plastic or wood trim that is attached from
within.  The cross section at left illustrates how t-
molding gets its name.

BEVELED Beveled Edge.  Edge is cut at an angle other than a
right angle (up and down). 

Base Type

5-ST 5-Star Base.  Single Column towards floor, with 4,
5 or 6 legs extending for balance. (e.g. 4-ST, 6-ST) 

SLED Sled Base.  Sled style leg returns from front legs
connecting to back legs, if any.

PANEL Panel Base.  At least two solid panels extend from
top to floor.

X-PANEL X-Panel.  Two solid panels which intersect to form
base of table.

4-LEG 4-Leg Base.  Straight legs extend from 4 corners of
the top (or from 3 corners e.g. 3-LEG).

2-COLUMN 2-Column Base.  1 or more round columns extend
from top to floor (e.g. 2-COLUMN, 3-COLUMN).
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ATTRIBUTES (continued)

Base Type (continued)

CUBE Cube.  Sides of table meet and extend from top to
floor.

DRUM Drum. Solid cylinder, sides of table start at top and
extend to floor.

L-LEGS L-Legs.  Typically 2 legs, 1 on each side, similar to
a sled base chair -- found on computer and work
tables.  

T-LEGS T-Legs.  Typically 2 legs on each side with a shorter
horizontal base that forms an upside down T.

H-LEGS H-Legs.  Typically 2 legs on each side with a
shorter horizontal base with legs on each side
forming an H on the floor.

X-LEGS X-Legs.  Like a picnic table, typically 4 legs, 2 on
each side which connect near the corner, cross each
other at a mid point forming an "X".

DISK Disc Base.  Typically one column or post with a
single disk shaped base for balance.

SAW HORSE Saw Horse Legs.  Typically 4 legs, 2 on each side
which meet at a cross beam near the center of the
table and extend out towards the floor, below their
respective corners.
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ATTRIBUTES (continued)

Top and Base Materials

LAMINATE Plastic laminate is a thin layer of plastic which may appear to look
like wood, a solid color, or textured.

WOOD Wood or wood veneer.

METAL Painted or unpainted metal.

GLASS Glass.  (in finish note clear, smoke or color)

MARBLE Stone with a streaked or veined appearance.

GRANITE Stone with a granular appearance (typically grey to pink in color)

STONE Other types of stone.

Top and Base Color/Finish

COLOR/
FINISH Colors should be listed first, followed by L for light, M for

medium or D for dark (e.g. BLUE-L, BLUE-M, BLUE-D). 
Color/finishes include CHROME for metal and MARBLE or
GRANITE for stone.  If two colors, name most dominant color
first (e.g. GREEN-D/BLUE-M, YELLOW-L/GREEN-L).  If more
than two colors, name most dominant color first followed by
MULTI (e.g. GREEN-D/MULTI, YELLOW-L/MULTI)
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ATTRIBUTES (continued)

Wood and Laminates which have a wood-like appearance are
typically described as follows:

OAK-L Light Yellow/Golden Brown
OAK-M Med. Yellow/Golden Brown
OAK-D Dark Yellow/Golden Brown

MAHOGANY Dark Reddish/Warm Brown

WALNUT Dark Chocolate/Ash Brown

DIMENSIONS

Measure overall actual size to closest 1/4".  Always display fractions (e.g. 32-1/4", 34-3/4",
16-1/2") .

MANUFACTURER

Manufacturer name may be found underneath top.  If not able to locate, list item with Manufacturer
= {UNKNOWN}.
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Chapter 8

INTRODUCTION

The Organization and Personnel tables are an optional but very useful tool. 
Bar|Scan does not require the information in order to record and maintain asset
record information, but you might want to use at least some of the features.

There is a set of videos on our website that can provide you with additional in
operating Bar|Scan.  These are titled Quickstart Overview Videos and can be
found on this page: https://www.barscan.com/support-videos

Please consider viewing or downloading these as part of your learning experience.

THE ORGANIZATION STRUCTURE

The organization structure identifies the group, department, and division or cost
center which are responsible for each asset.

The implementation of this feature will enable you to provide meaningful asset
reports to the different organizations within your company, e.g., a complete list
of assets for which a particular department is responsible.

You will want to identify the organization within your company which has
possession and/or is responsible for each asset.

Bar|Scan provides the Organization Structure feature to identify the different
departments and groups within your company and assign a code which can be
recorded for each asset.

When you initially start using Bar|Scan you will have to determine the structure
of your organization and the names you wish to use to identify the different groups
in your company.

Bar|Scan provides three organizational levels.  We have named them Division,
Department, and Unit.  You will want to develop an organization structure which
lists the different groups within your company.  Note that Bar|Scan additionally
provides entries for the name and telephone number of the individual using,
and/or responsible for, the asset.
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You can change the names of the three organizational levels with the UDF
module.  Please refer to Chapter 16 of  this User Manual, User Defined Fields, for
more information on creating UDFs and using this feature.

When you have determined the structure and the names you want for each of the
groups, you will be required to assign a code for each.  The code is provided to
make it easier to record the different combinations when using the Mobile
Computer.

The code you assign may or may not be a meaningful number, it is simply used
to keep track of your organizational levels.

THE PERSONNEL STRUCTURE

The personnel structure identifies the people which have  possession and/or is
responsible for each asset.

The implementation of this feature will enable you to provide meaningful asset
reports to the different personnel within your company, e.g., a complete list of
assets for which a particular person is responsible.

You will want to identify the persons within your company which has possession
and/or is responsible for each asset.

When you initially start using Bar|Scan you will have to determine the format of
the names and what auxiliary information you wish to keep for your personnel.

Bar|Scan creates the full name of your personnel based on rules which you create. 
For example, you can a full name with last name then first name or the reverse. 
You will want to format the full name in a way that is most meaningful to your
company.  For most of our customers, this is making the full name by combining
last, first and middle initial - in that order.

You can change the names or stretch/shrink any of these fields.  Please refer to
Chapter 16 of  this User Manual, User Defined Fields, for more information on
creating UDFs and using this feature.

When you have determined the structure of the names you want for each of the
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groups, you will be required to build the full name field for each.  This is a menu
function in Bar|Scan.

THE ORGANIZATION STRUCTURE TABLE

When you want to view, change, add, or delete Organizations you will need to
open the Organization table.  From the Main Menu, select File . . . <, then Open 
 . . . <, then Organizations, as shown on the following example.

Or, if you have selected to place the Tables toolbar on your Main Menu, you can
simply click on the Organization icon which is shown below.
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The following Organization table will appear.

The Browse tab is selected by default.  This tab permits you to select
Organization(s), then you can add, change, set, and view the different
Organization entries on the Edit tab.

Note that the Organizations listed in the above screen meet the criteria previously
established by the SET feature.
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CREATING AN ORDER AND  FILTER -  THE SET MODE

The Browse panel is selected by default, on the Organization table.  The
Organization information on the Browse panel can be sorted by any field.  Place
your cursor in the first column on the left, and then press your right mouse button. 
The words “Order By” will appear, when you move your mouse over these words,
a drop down menu will appear and you may select a Set from that drop down
menu.  Or you may select the Set button on the tool bar as shown below.

This feature will give you the ability to look at all of the Organizations, pre sorted
the way you specify.  If you do not specify another sort, the default sort is by
Organization Code.

The SET feature works in conjunction with adding, changing, deleting, and
viewing your Organizations allowing you to identify a smaller, more manageable
group of organizations from which to select, e.g., organizations by Department in
only those Divisions of interest.

As the number of Organizations on your system increases it becomes more time
consuming to look through the entire list of organizations in the default order
displayed on a look up window.

SET enables you to define an “order" which displays your items in any order so
you may choose which is most effective for your current task.

SET also enables you to define a "filter" which will reject the locations which do
not meet your specifications.  SET provides several "filter" items.

Further, you can define a "range" for a filter item by selecting and marking a block
when you are presented the list.

Finally, you can identify more than one filter and/or range to further reduce the
number of locations to search.
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Note: Adding a filter to a Set may add a considerable amount of time to using the
Set.   Also, if the last Set that you use before closing a table has a filter on it, then
your table may open much more slowly the next time you open it.

Because SET offers almost endless possibilities for identifying groups of
Organizations, we strongly recommend that you experiment with different
specifications to become familiar with this feature.  Experimentation with SET
will NOT cause any change to the information recorded for any location or asset. 
It merely specifies the amount and the sequence of location selection lists.

When you select the SET icon, the following screen will appear:

This tab shows a list of Sets that are already created in Bar|Scan.  If you would
like to view the fields that will show up as columns when you are on the
Organization Browse tab, select any of the sets, and then select the Browse Fields
tab.
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You will be shown a screen similar to the following.

On the left side of this screen there is a list of all of the available fields for the
Organization table that you may display in your Sets.  On the right side of this
Browse Fields tab, you will see the current fields that are displayed as columns for
each Set.  These fields are displayed as the columns for all of the different Sets,
with the exception of the first column, which always displays the current Set.  

The Set feature is a powerful tool, and should be experimented with.  

Remember that the SET feature works in combination with the F4 (Range) key,
allowing you to make powerful, global edits with a minimum of keystrokes.  For
example, you can change all occurrences of “Finance” to “Accounting” with only
a couple of keystrokes if the information is properly SET.

For more information on the SET feature, refer to Chapter 5 - Operating the 
System.
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DISPLAYING AN ORGANIZATION STRUCTURE ENTRY

The Edit tab permits you to display the current information about a particular
Organization Structure code.  

From the Browse tab, choose an Organization Structure Code and press ENTER. 
Then, select the Edit tab.  The selected entry will be displayed.

ENTERING A NEW ORGANIZATION STRUCTURE

Add Blank and Add Template both enable you to enter new Organization
Structure codes and names into the Bar|Scan system.

While on the Organization Browse tab, move the highlight bar using the cursor
movement keys or mouse to go through the list.  When the desired entry is found,
move the highlight bar over it and press the <ENTER> key, selecting an
Organization.  Then, to select the Add Blank Item or Add Template Item, press
their corresponding button on the tool bar.  Next, select the Edit tab.  The
information for the Organization that you have selected will be displayed on a
screen similar to the one below.
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Entering the New Information

After you have selected a Blank screen or a similar Template screen, the
information will be displayed and the cursor will be positioned for you to enter the
new Organization Structure Code information.

You may use the arrow keys, the TAB key, the mouse, or the <ENTER> key to
move to the different items on the screen.

Each of the entry items has associated look up windows to assist you with your
entry.

Pressing the Esc key returns you to the Main Menu.  Note if you have pending
changes or deletions you will be prompted to cancel or save these changes or
deletions before you will be allowed to exit the Organization table.

Note: You do not have to return to the Browse tab in order to select Add Blank or
Add Template Organization.  You may simply press the corresponding icon on the
tool bar from the Edit tab, and then proceed to add your new Organization.

See Chapter 5 of this User Manual, Operating the System, for specific instructions
about cursor movement keys, function keys, and how to operate the look up
windows.

Generating Organizational Codes Automatically

You can let Bar|Scan generate a numeric organization code by putting a check
mark in the 'Automatically generate Organization codes' option within the first tab
of the Company screen. Once done, a newly added Organization entered in the
Organization Edit screen will have a numeric organization automatically
generated when saved.

To access the Company Screen , from the Main Menu, select File . . . <, then
Company   . . . <, then Housekeeping  <, then Settings.

Go to Tab #1 (Standard Options) and  put a check mark in the 'Automatically
generate Organization codes' option, press save. 

Organizations Page 8-9



Organizations

The Organization Structure Code

The Organization Structure Code is non structured, and up to six digits in length. 
To view the Organizations that are currently entered into your system you may
right click or press the F5 key while on the Organization field, and select Look up
Value.  You will be shown a look up window similar to the one below.

Note: The Organization codes shown above are all five digits in length.  This is
only a sample of one type.  Your Organization codes can be structured with or
without letters, with or without numbers, and from one to six digits in length.  

The Organization Codes that will appear in this look up window are those that
have already been used in your Bar|Scan system.  When creating new
Organization Codes, you must ensure that your new code does not match any of
the existing Organization Codes.
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Division, Department, And Unit

Once you have entered the Organization Code, you will be requested to assign
information to the Division, Department, and Unit.  The cursor will be positioned
for you  to enter the Division name.

To view the Divisions that are currently entered into your system you may press
the F5 key or right click on the Division field, and select Look up Value.  You will
be shown a look up window similar to the one below.

The Selection Window lists the existing Division Names.  Either move the
highlight bar to the desired name and press OK or press the Cancel button and
type a new Division name.  When the entry is complete, and you have pressed
ENTER, you will be positioned to enter or select the Department name.
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To view the Departments that are currently entered into your system you may right
click on the Department field or press the F5 key, and select Look up Value.  You
will be shown a look up window similar to the one below.

The Selection Window lists the existing Department Names.  Either move the
highlight bar to the desired name and press ENTER or press the Cancel button and
type a new Department name.  When the entry is complete, and you have pressed
<ENTER>; you will be positioned to enter or select the Unit name.
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To view the Units that are currently entered into your system you may press the
F5 key or right click on the Department field, and select Look up Value.  You will
be shown a look up window similar to the one below.

The Selection Window lists the existing Unit Names.  Either move the highlight
bar to the desired name and press ENTER or press the Cancel button and type a
new Unit name.  

Some caution should be observed when determining the name which will be
associated with a particular code.  Whereas Bar|Scan will NOT allow you to
duplicate an existing code, you may assign the same name to a different code.  For
example, you might inadvertently assign the same name to two different Division
Codes.  This is not as important with Department and Unit because you may well
want the same Department name in two different Divisions.

Simply enter the new information, and Save the information you have entered by
pressing the Ctrl + S key combination, or click on the Save button on the tool bar.
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ENTERING A BLANK
ORGANIZATION STRUCTURE

If you do not wish to have Bar|Scan validate the organization in your Transaction
Table, you may do so by entering a blank Organization Code.

Having a blank Organization Code in your computer as a valid response, will
allow those actually doing the inventory with the Mobile Computers to leave the
Organization Code blank.  When the information is uploaded into the computer,
and the Transactions are validated, those that have a blank Organization Code will
be considered valid.

To reject blank organization codes as a valid response, you must delete the blank
organization structure.

CHANGING ORGANIZATION STRUCTURE INFORMATION

From time to time you will want to change, correct, or add information associated
with Organization Structure names or codes currently existing in the Bar|Scan
system.

While on the Organization Browse tab, type the first digits of the code, or use the
arrow keys or the TAB key to move the highlight bar to the item you wish to
change, and press the <Enter> key.  Next, select the Edit tab.  You may now
change any of the information listed on this tab by simply typing in the new
information, or by using the Look up Value feature.   

When you have completed and saved the changes, all assets assigned the
Organization Structure Code being changed will immediately reflect the changes.
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DELETING AN ORGANIZATION STRUCTURE ENTRY

This feature completely removes an Organization Structure entry from the
Bar|Scan system.  Obviously, caution should be exercised when using this feature.

Removing Organization Structure entries from the system is most often done due
to erroneous entries.

Bar|Scan will not permit you to delete any Organization Structure entry currently
assigned to an asset.  You will however, want to update the Organization
information for each asset using the deleted Organization Structure entry.  

When you have used an Organization Code with erroneous data entered into it,
you will have to first add an Organization Code that has the correct data.

Next, go to the Asset table, and use the Set feature to correct the affected assets. 
Select Set, and then select the Organization Code Set.  This will sort all of your
Assets according to their associated Organization Code.  Next, Range all of the 
Assets that have the Organization Code that you wish to delete, and change the 
Organization Code on all of the selected Assets at one time.

Next, go to the Transaction table, and use the Set and Range features to change
all of the Transactions that use the Organization Code that you wish to delete.

Then, go back to the Organization table.  Move the highlight bar to the 
Organization Code that you wish to delete, and press the F4 key (Range feature.) 
Select the Delete button from the tool bar.  A dialog box will appear to ask you
to verify that you want to DELETE the Organization Code (Structure entry.)  If
you respond Yes, you will see another dialog box that will ask you to confirm
your choice.  When you respond Y(es), the Organization Structure entry will be
removed.
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ASSET RANGES

Asset Ranges is a feature that you can access by going to the Main Menu, select
File . . . <, then Open . . . <, then Asset Ranges, as shown on the following
example.

This item can be used to allocate ranges of asset tags in advance to a specific
department or to a specific company within Bar|Scan.
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When you select Asset Ranges from the Main Menu, you will see a table similar
to the one below.

The first time that you open Asset Ranges you will be shown a Browse panel that
does not have any information in it.  Select the Add Blank button from the tool
bar, and then select the Edit tab which is shown below.
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This feature will enable you to allocate out Asset labels, and keep track of whom
you gave them to by Company Code or by Organization Code.  List in this table
the first label and the last label of each group of assets, and then keep track of
whom you gave them to by Company Code or Organization Code.

You list a range of assets, and specify a Company and/or an Organization Code
for the range as shown below.

You would normally fill out this table to set up the range when you are issuing the
Asset labels.  

When the Asset labels are used during the course of an inventory, the user should
leave the Company Code and the Organization Code blank.  When the items are
validated in the Transaction table, the information for the Company Code and/or
the Organization Code from this table will be added to those Transactions.
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If an Organization Code is entered, then all items are validated in the Transaction
Table, and the Asset labels fall within the First and Last Asset number, and the
Organization Code does not match the Code entered, then the Transaction will
NOT MOVE into the Asset Table.

Note: If a different Organization Code or Company Code is used during the
course of the inventory, the Bar|Scan system will NOT treat it as an error, and will
NOT alert you of the differences.  Bar|Scan will only use this information to fill
in the two fields if they are left blank.
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THE PERSONNEL TABLE

When you want to view, change, add, or delete Personnel you will need to open
the Personnel table.  From the Main Menu, select File . . . <, then Open   . . . <,
then Personnel, as shown on the following example.

Or, if you have selected to place the Tables toolbar on your Main Menu, you can
click on the Personnel icon which is shown below.
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The following Personnel table will appear.

The Browse tab is selected by default.  This tab permits you to select Person(s),
then you can add, change, set, and view the different Personnel entries on the Edit
tab.

Note that the Names listed in the above screen meet the criteria previously
established by the SET feature.
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CREATING AN ORDER AND  FILTER -  THE SET MODE

The Browse panel is selected by default on the Personnel table.  The Personnel 
information on the Browse panel can be sorted by any field.  Place your cursor in
the first column on the left, and then press your right mouse button.  The words
“Order By” will appear, when you move your mouse over these words, a drop
down menu will appear and you may select a Set from that drop down menu.  Or
you may select the Set button on the tool bar as shown below.

This feature will give you the ability to look at all of the Personnel, pre sorted the
way you specify.  If you do not specify another sort, the default sort is by Full
Name.

The SET feature works in conjunction with adding, changing, deleting, and
viewing your Personnel allowing you to identify a smaller, more manageable
group of organizations from which to select, e.g., Personnel by Location in only
those Buildings of interest.

As the number of Personnel in your system increases it becomes more time
consuming to look through the entire list of names in the default order displayed
on a look up window.

SET enables you to define an “order" which displays your items in any order so
you may choose which is most effective for your current task.

SET also enables you to define a "filter" which will reject the locations which do
not meet your specifications.  SET provides several "filter" items.

Further, you can define a "range" for a filter item by selecting and marking a block
when you are presented the list.

Finally, you can identify more than one filter and/or range to further reduce the
number of locations to search.
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Note: Adding a filter to a Set may add a considerable amount of time to using the
Set.   Also, if the last Set that you use before closing a table has a filter on it, then
your table may open much more slowly the next time you open it.

Because SET offers almost endless possibilities for identifying groups of
Personnel, we strongly recommend that you experiment with different
specifications to become familiar with this feature.  Experimentation with SET
will NOT cause any change to the information recorded for any location or asset. 
It merely specifies the amount and the sequence of location selection lists.

When you select the SET icon, the following screen will appear:

This tab shows a list of Sets that are already created in Bar|Scan.  If you would
like to view the fields that will show up as columns when you are on the
Personnel Browse tab, select any of the sets, and then select the Browse Fields tab.
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You will be shown a screen similar to the following.

On the left side of this screen there is a list of all of the available fields for the
Personnel table that you may display in your Sets.  On the right side of this
Browse Fields tab, you will see the current fields that are displayed as columns for
each Set.  These fields are displayed as the columns for all of the different Sets,
with the exception of the first column, which always displays the current Set.  

The Set feature is a powerful tool, and should be experimented with.  

Remember that the SET feature works in combination with the F4 (Range) key,
allowing you to make powerful, global edits with a minimum of keystrokes.  For
example, you can change all occurrences of one Organization Code to another
with only a couple of keystrokes if the information is properly SET.

For more information on the SET feature, refer to Chapter 5 - Operating the 
System.
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DISPLAYING A PERSONNEL ENTRY

The Edit tab permits you to display the current information about particular
Personnel.  

From the Browse tab, choose an Name by clicking on it.  Then, select the Edit tab. 
The selected entry will be displayed.

ENTERING NEW PERSONNEL

Add Blank and Add Template both enable you to enter new Personnel and other
details into the Bar|Scan system.

While on the Personnel Browse tab, move the highlight bar using the cursor
movement keys or mouse to go through the list.  When the desired entry is found,
move the highlight bar over it and press the <ENTER> key, selecting an
Personnel.  Then, to select the Add Blank Item or Add Template Item, press their
corresponding button on the tool bar.  Next, select the Edit tab.  The information
for the Personnel that you have selected will be displayed on a screen similar to
the one below.
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Entering the New Information

After you have selected a Blank screen or a similar Template screen, the
information will be displayed and the cursor will be positioned for you to enter the
new Personnel information.

You may use the arrow keys, the TAB key, the mouse, or the <ENTER> key to
move to the different items on the screen.

Each of the entry items has associated look up windows to assist you with your
entry.

Pressing the Esc key returns you to the Main Menu.  Note if you have pending
changes or deletions you will be prompted to cancel or save these changes or
deletions before you will be allowed to exit the Personnel table.

You do not have to return to the Browse tab in order to select Add Blank or Add
Template Personnel.  You may simply press the corresponding icon on the tool
bar from the Edit tab, and then proceed to add your new Personnel.

See Chapter 5 of this User Manual, Operating the System, for specific instructions
about cursor movement keys, function keys, and how to operate the look up
windows.

Formatting the Full Name

Bar|Scan generates the Full Name by combining multiple separate name fields
according to rules that you create in the Company Settings Screen.

To access the Company Settings Screen , from the Main Menu, select File . . . <,
then Company   . . . <, then Housekeeping  <, then Settings.
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You will see the following Screen:

As you can see, there are many different ways to allow the formatting of the Full
Name field.
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If you elect to not use the Personnel Table and use free form Name entry as used
in Bar|Scan prior to version 2.8.2, you should set the Name Validation entry to
NONE as shown in the following screen:

Below are the fields that are currently designated as NAME fields. They are
checked against the Personnel Table’s Full Name field.

Asset Table:
Current Name (L_NAME field)
Name (OW_NAME field)
Prior Name (O_NAME field)

Asset Location History Table:
Name (O_NAME field)
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Mobile Computer Advanced Settings Table:
User Name (OWNER field)

Transactions Table:
Name (OW_NAME field)

Work Order Master Table:
Name-Requested By (OW_NAME field)
Name-Taken By (WM_TBNAME)

Any name in the list above that is edited is then verified against the ‘Fullname’
field in the Personnel Table based on one of the three settings in the Company
Settings Screen.  The three choices are:

NONE - This is the default setting.  No check is made against the personnel table.
The only use of the personnel table is as a popup resource to help populate name
fields.

NAMECHANGE - Name fields are checked for validity ONLY if they are
specifically edited or changed. For example, consider an Asset table item with two
invalid fields, the Catalog Number and Owner Name fields. If you only change the
Catalog Number field, you will get no message that the Owner Name is invalid
since you did not specifically edit the Owner name field. If you do specifically edit
the Owner name field and it results in a name that is not in the Personnel table
then you will get the invalid name message.

ANYCHANGE - Any change or edit to any field in a table will trigger all name
fields to be checked within that item.. For example, consider an Asset table item
with two invalid fields, the Catalog Number and Owner Name fields. If you only
change the Catalog Number field, you WILL get a message that the Owner Name
is invalid, even though you have not directly edited that field. 

When initially using the Personnel table it is recommended that this validation be
implemented in stages, first NONE, then NAMECHANGE, then when all names
have been cleaned up, progressing to the most stringent, ANYCHANGE.
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First Name, Middle Name (Initial), And Last Name

Begin data entry be entering the Names of your personnel.  The cursor will be
positioned for you  to enter the First Name.

To view any of the data currently entered into your system you may press the F5
key or right click on any of the fields, and select Look up Value.  You will be
shown a look up window similar to the one below.

The Selection Window lists the existing Last Names.  Either move the highlight
bar to the desired name and press OK or press the Cancel button and type a new
Last Name.  When the entry is complete, and you have pressed ENTER, you will
be positioned to enter or select the next field.

Uniqueness Value

If you have more than one person with the same name, you can use this field to
differentiate between the names.  Any numbers or words that you wish to use can
be entered into this field such as 1,2,3.   
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Based on the Name Format rules that you set in Company Settings, the
Uniqueness Value Field may or may not be combined into the Full Name Field.

Primary ID, Secondary ID, Tertiary ID and Email

These fields can be used for any information of your choice.  You can enter
Employee ID Numbers, Job Titles or emails.

Simply enter the new information, and Save the information you have entered by
pressing the Ctrl + S key combination, or click on the Save button on the tool bar.

Organization

The Organization allows you to assign an Organization to your Personnel. You
might consider this the Organization that is associated with each Person in the
table.  To view the Organizations that are currently entered into your system you
may right click or press the F5 key while on the Organization field, and select
Look up Value.  You will be shown a look up window similar to the one below.

Note: You can right click and resort the Look up in any order in order to find the
particular Organization that you would like to assign.

Bar|Scan does not use this field in any logical or validation feature.  This is simply
for reference information.
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Current Location

The Current Location allows you to assign a default Location to your Personnel.
You might consider this as the Location that is associated with each Person in the
table.  To view the Locations that are currently entered into your system you may
right click or press the F5 key while on any of the Location fields, and select Look
up Value.  You will be shown a look up window similar to the one below.

Note: You can right click and resort the Look up in any order in order to find the
particular Location that you would like to assign.

Bar|Scan does not use this field in any logical or validation feature.  This is simply
for reference information.
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LOAD ASSET OWNER NAMES

When you have the Personnel table open, the Main Menu changes slightly, so that
the Personnel Features are listed next to the Help as shown below.       

You can use this feature to Load (import)  all of the names from the Asset Table
or Popup Fields Table or another table of your choice into the Personnel Table.

The names are parsed according the rules entered into the Company Settings
Table and then loaded.  You can elect not to load the names from the Popup Fields
Table during this process.
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To begin this process click on “Load Asset Owner Names from other fields...”. 
You will be shown a window similar to the one below:

In the example above, we have chosen to load the Personnel table from existing 
names located in the Asset Table.

The format will be L,F,MI,U which is Last Name then First Name then Middle
Initial and finally unique.  The Uniqueness value keeps names from being
duplicated.
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Press the ‘(2) Load Names into list of Available names’ button as indicated on the
following window.

If you see more than one in the variation column, it means that Bar|Scan found
names that are similar with slight changes in punctuation as shown below:

If a name has only 1 variation, you can move it into the list on the right without
question.  If it has 2 or more variations manually examine them in the list at the
bottom of the panel to make sure that they really are the same person. Most of the
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time this will be true since only minor variations will display on this screen. 
Normally there should be very few multiple variations. Normally even those listed
can be combined, but it is safer to check.  If you believe that the variations are
actually different people then you will need to stop, exit and edit the source of the
names.

In other words, you will only have to do anything more than the above under two
circumstances.

1: The name gets put into the ‘Manual Adjustments’ tab.
2: One or more of the variations listed at the bottom are actually not the same
person as any of the others listed.

If either of the above is true, then you must edit the original names in the original
location, e.g., edit an Asset Location History name in the Asset screen.

Review the Available for Update Area.  Select the Names that you would like to
import using the Range Feature.  Range Buttons are available on the left side of
the screen for your convienence.  You can also Range using the traditional method
such as double-clicking and item.
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(3) Click on the right arrow ‘Move’ button to place the names in the list that will
be imported as shown below:

You will now see the names that you wish to import on the right hand portion of
the screen as shown in the next image.
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When you are ready Click on (4) ‘Update and Save’ button.

Once all of the above has been done, then you can consider doing a consolidation,
either manually or using the Suggested Consolidations menu item shown below.
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REBUILD FULL NAME

Bar|Scan generates the Full Name by combining multiple separate name fields
according to rules that you create in the Company Settings Screen.

You can use this feature to Rebuild the Full Name field from the individual name
fields.  The names are parsed according the rules entered into the Company
Settings Table and then loaded.   This can be useful if you decide to change the
rules.  For example, change all the Full Names from Last then First name to First
then Last name.

When you have the Personnel table open, the Main Menu changes slightly, so that
the Personnel Features are listed next to the Help as shown below.       

Next select Rebuild Full Name to begin the process.  You will be asked if you
wish to rebuild the all Full Names as shown in the window below.  Select Yes if
you wish to continue.
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CONSOLIDATE RANGE NAMES

Over time, names of individuals may have been entered differently into the
Personnel Table.  For example, TOM and THOMAS may have been entered as
the first name or a persons name may need to be changed, or last name changes,
i.e. marriage.

You can use this feature to Consolidating these names and have the consolidated
name replace the full name variations in the main tables, Asset, Transaction, etc.

When you have the Personnel table open, the Main Menu changes slightly, so that
the Personnel Features are listed next to the Help as shown below.

1) Range the names that you want to consolidate, including the name that all of
the names will be converted to.  Ranging a single name will consolidate the
variations within that name.

2) Place the cursor on the name that the name(s) will be converted to. If you are
consolidating just one name, keep the cursor on the single name.

3) Select the Personnel menu item to consolidate the names.

4) Bar|Scan will then present you with a list of all of the fullname variations of
these names that it can find in appropriate tables.

5) Upon your approval, it will replace all the names that it found in all appropriate
tables with the single fullname that you selected.
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Consolidating Personnel names may result in the inadvertent loss of name data if
not done with planning and care. This may be due to operator error, insufficiently
complex fullname name formats, different names that convert to the same name,
etc.  Please carefully examine the list of names and the name that they will
become before approving the consolidating operation.

SUGGEST CONSOLIDATIONS

Over time, names of individuals may have been entered differently into the
Personnel Table.  For example, TOM and THOMAS may have been entered as
the first name or a persons name may need to be changed, or last name changes,
i.e. marriage.

You can use this feature to Consolidating these names and have the consolidated
name replace the full name variations in the main tables, Asset, Transaction, etc.

Bar Scan will calculate groups of names to consider for consolidatation when
you select the 'Calculate Suggestions' button. It uses a modified SOUNDEX
algorithm, so not all suggestions will be valid.  Therefore use care when using this
feature. 

1. To begin, scroll up or down the list of suggested names on the left. When you
click on a name it becomes selected. Several suggestions for consolidation will
appear on the right.
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Here is an example.

2. Examine the list of names on the right. If two or more are actually the same
name but entered differently, put a check mark next to each of them. For example,
as shown above, is the last name PENNY and PENNY really the same person. 
The check mark means that it will be included for consolidation.

3. One of the names in the right column you have put a checkmark next to is the
name that they all should be consolidated to. Select that name in the right column,
then click on the 'Select Consolidation Name' button. That name should appear on
the left.

4. Once you are satisfied and decide that you want to consolidate this group, put
a check mark on the name in the left column to mark the group for consolidation.
You can do this as many times as you want.

5. Lastly, select the 'Consolidate' button to perform the consolidation for all of the
names with check marks.
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CHANGING PERSONNEL INFORMATION

From time to time you will want to change, correct, or add information associated
with Personnel currently existing in the Bar|Scan system.

While on the Personnel Browse tab, type the first digits of the name, or use the
arrow keys or the TAB key to move the highlight bar to the item you wish to
change, and press the <Enter> key.  Next, select the Edit tab.  You may now
change any of the information listed on this tab by typing in the new information,
or by using the Look up Value feature.   

When you have completed and saved the changes, you will be asked if your
changes should also be applied to the Asset Table.  In most cases you would reply 
by selecting YES.
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DELETING A PERSONNEL ENTRY

This feature completely removes Personnel entry from the Bar|Scan system. 
Obviously, caution should be exercised when using this feature.

Bar|Scan will permit you to delete any Personnel entry currently assigned to an
asset.  A delete will remove the personnel record from the Personnel Table but it
will not remove Personnel Names from the Asset Table or Transaction Table. 
This is the because the Asset Table contains a history of Locations and their
associated Personnel Names.  These names did exist in the past even though they
may no longer be applicable for present and future selections.

Removing Personnel entries from the system is most often done due to erroneous
entries.
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INTRODUCTION

The Location table in Bar|Scan is optional but very useful.  Bar|Scan does not
require the information in order to record and maintain asset record information,
but you probably want to use at least some of the features.

You can record an asset's physical location directly in Bar|Scan's Asset table
without using the Location table.  However, this means that locations are not
checked as "valid" and you will not have the ability to download locations into
your Mobile Device, which can be useful for your inventory.

There is a set of videos on our website that can provide you with additional in
operating Bar|Scan.  These are titled Quickstart Overview Videos and can be
found on this page: https://www.barscan.com/support-videos

Please consider viewing or downloading these as part of your learning experience.

THE LOCATION FEATURE

The Location Table maintains a list of valid physical locations for you to check
your asset inventory against.  Bar|Scan provides the Location table  to identify the
different locations within your company and optionally assign a bar code room tag
for each location.  You will want to identify  all of the locations within your
company which will contain assets.

If you do not wish to maintain this list and you can create just one “blank”
location, Bar|Scan will assume that any assets you enter into the Mobile Device
or an asset screen are located at the blank location, simply leave that field blank
in the Mobile Device also.

Alternatively, you can turn Location validation checking off.  This can be done by
selecting from the Main Menu, File, then Company . . . <, Housekeeping . . . <, Set
Transaction Validation Messages, and disabling the appropriate error message.

When you initially start using Bar|Scan you will have to determine the location
scheme you would like to use and whether you would like to use the room tag
feature.
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Bar|Scan provides three different types of Locations.  

1.  Site Locations - Most common type of Location - used for buildings
2.  Pallet Locations - used in most warehouses
3.  Vault Locations - used for vaulted types of storage

The Site Location in Bar|Scan provides four levels of location.  We have named
them Region, Building, Floor, and Room.  You will want to develop a location
scheme which will cover all relevant locations within your company.

The Pallet Location in Bar|Scan provides five levels of location.  We have named
them Building, Row, Bay, Slot, and Level.

The Vault Location in Bar|Scan provides five levels of location.  We have named
them Building, Vault, Row, Bay,  and Level.

All of the three available types of locations have fields for: a Room Tag, a
Location Description, an Organization, and the Square Footage.

Important: You do not need to use all levels of location.  If you determine that you
would like to track your assets only to the floor they reside on, but not to an
individual room, you may do so.  This is done by only completing the levels you
wish to track and leaving the others blank.

The selection of these level titles is based on the most common industry practice. 
However, you may use a scheme which is appropriate for your particular
organization.  The important thing about a location code scheme is; it will
precisely locate any and all of your assets in all of your company facilities.

As with other fields in Bar|Scan, you can rename these titles to best suite your
location scheme.
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THE LOCATION TABLE

When you want to view, change, add, or delete Locations you will need to open
the Location table.  From the Main Menu, select File, then Open . . . <, then
Locations . . . < as shown on the following example.

Or, if you have selected to add the Tables Tool Bar to the Main Menu, you can
click on the Location icon which is shown below.
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No matter which method you choose to open the Location table, you will see a
table similar to the following.

The Browse tab is selected by default.  This tab permits you to select Location(s),
then you can add, change, set, and view the different Location entries on the Edit
tab.

Note that the Locations listed in the above screen meet the criteria previously
established by the SET feature.  In the above example, the Set that was chosen
was Site Location.

You may press the Esc to return to the Main Menu.  

You can find specific instructions about cursor movement keys, function keys, and
how to operate the look up windows, in Chapter 5 - Operating the System.
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CREATING AN ORDER AND  FILTER -  THE SET MODE

On the Location table, the Browse panel is selected by default.  The Location
information on the Browse panel can be sorted by any field, go to the first column
on the left, press your right mouse button, and then select the words “Order By”
that will be displayed, or select the Set button on the tool bar as shown below.

This feature will give you the ability to look at all of the Locations; pre sorted the
way you specify.  

The SET feature works in conjunction with adding, changing, deleting, and
viewing to allow you to identify a smaller, more manageable group of locations
from which to select, e.g., locations by building will show you all of the rooms in
a particular building, and if you have more than one building, will then show you
all of the locations in the additional building(s).

As the number of locations on your system increases it becomes more time
consuming to look through the entire list of locations displayed on a look up
window.

SET enables you to define an “order" or to “sort”the items listed.  Use this feature
to sort your list in the order which you feel is most effective.

SET also enables you to define a "filter" which will reject the locations which do
not meet your specifications.  SET provides several "filter" items.  However,
adding a filter to your sort will slow down the initial query process, and may cause
your table to open much slower if the last Set that was used before closing the
table had a filter on it.

Further, you can define a "range" for a filter item by selecting and marking a block
of items that you wish to filter out.

Finally, you can identify more than one filter and/or range to further reduce the
number of locations to search.
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Because Set offers almost endless possibilities for identifying groups of locations,
we strongly recommend that you experiment with different specifications to
become familiar with this feature.  Experimentation with Set will NOT cause any
change to the information recorded for any location or asset.  It merely specifies
the amount and the sequence of location selection lists.

When you select Set, the following screen will appear.

This tab shows a list of Sets that are already created in Bar|Scan.  If you would
like to view the fields that will show up as columns when you are on the Location
Browse tab, select any of the Sets, and then select the Browse Fields tab.
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The Browse Fields tab will look similar to the one below.

On the left side of this screen there is a list of all of the available fields for the
Location table that you may display in your Sets.  On the right side of this Browse
Fields tab, you will see the current fields that are displayed for each Set.  These
fields are displayed for all of the different Sets, with the Set pertaining to only the
column by which the list is sorted (the first column). 

The Set feature is a powerful tool, and should be experimented with.  

Remember that the Set feature works in combination with the F4 (Range) key,
allowing you to make powerful, global edits with a minimum of keystrokes.
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From time to time, you may wish to add a new Set.  When on the Location table,
select the Set icon from the tool bar.  When the Set and Field Selection table
appears, select a Set, then select the Add/Change/Delete button.  You will be
shown a Set table similar to the following.

Select from this list, a Location Set, that is most similar to the one you want to
add, and select the Add Template icon on your tool bar.  Then, select the Edit tab.
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You will be shown an Edit tab similar to the following.

Note: System Sets may not be changed.  If you want a Set similar to a System Set,
use that Set as a template for your own.  In order to create a new Set, you must
have exclusive use of the files (be the only person in this Bar|Scan company
database).  

Type in a new Set Name.  Type in a new Title (this should be similar or identical
to the Set Name).  Go to the Fields box, and Change the fields listed to your new
choices, and Delete any additional fields that are not necessary for your new Set. 

Save your new Set.  Close any other tables that you may have opened, with the
exception of the Bar|Scan Main Menu.  

Then, select the Generate button.  Only after the Set has been saved and
Generated, may you use the new Set.

Close this table.  Open the Location table.  Select the Set icon from the tool bar. 
Select your new Set.  Your locations will be sorted by the criteria you specified.
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Displaying a Location Table Entry

The Location Edit tab permits you to display the current information about a
particular Location.  From the Browse tab, choose a Location and press ENTER. 
Then, select the Edit tab.  The selected entry will be displayed.

Selecting the Type of Location

You will need to select the type of Location that you will be using.  The next three
screens show the three types of locations that are available as default types in
Bar|Scan.  Select a Site location while on the Browse tab, then, select the Edit tab. 
If you have chosen a Site location, the information for the Site Location that you
have selected will be displayed on a screen similar to the one below.
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If you have chosen a Pallet location, the information for the Pallet Location that
you have selected will be displayed on a screen similar to the one below.

Notice that there are now five levels of location, and the names of the location
fields have changed.
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If you have chosen a Vault location, the information for the Vault Location that
you have selected will be displayed on a screen similar to the one below.

Notice that the manes of the location fields are different for Vault locations, than
they are for Site and Pallet.
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ENTERING THE NEW INFORMATION

Add Blank and Add Template both allow you to enter new Location(s) into the
Bar|Scan system.

While on the Location Browse tab, move the highlight bar using the cursor
movement keys or mouse to go through the list.  When the desired entry is found,
move the highlight bar over it and press the <ENTER> key, selecting a location. 
To select the Add Blank Item or Add Template item, click their corresponding
button on the tool bar.  Next, select the Edit tab.  The information for the Location
that you have selected will be displayed on a screen similar to the one below.

You may use the arrow keys, the <Tab> key, the mouse, or the <ENTER> key to
move to the different items on the screen.
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Each of the entry items has an associated look up window to assist you with your
entry.

To view the Location information that is currently entered into your system you
may right click while on the desired field or press the F5 key, and select Look up
Value.  You will be shown a look up window for that particular field, similar to
the one below for the location description.

The following sections in this chapter describe each of the different items on the
Location Display Screen and provide instructions on how to enter the information. 

See Chapter 5 - Operating the System for general instructions on the use of the
different features and keys.

Pressing the Esc key returns you to the Main Menu.  Note if you have pending
changes or deletions you will be prompted to cancel or save these changes or
deletions before you will be allowed to exit the Location table.
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The Location Information

As previously mentioned, one of the important features of Bar|Scan is the ability
to define a specific physical location for each asset.

The Location information consists of three sections, a physical location
corresponding to blueprint or drawing, an associated bar code room tag, and a
detailed location description.  In the following paragraphs we will discuss the first
section - physical location.

Bar|Scan provides three different types of Locations.  

1.  Site Locations - Most common type of Location - used for buildings
2.  Pallet Locations - used in most warehouses
3.  Vault Locations - used for all vaulted items

The Site Location in Bar|Scan provides four levels of location.  We have named
them Region, Building, Floor, and Room.  You will want to develop a location
scheme which will cover all relevant locations within your company.

The Pallet Location in Bar|Scan provides five levels of location.  We have named
them Building, Row, Bay, Slot, and Level.

The Vault Location in Bar|Scan provides five levels of location.  We have named
them Building, Vault, Row, Bay, and Level.

All of the three available types of locations have fields for: a Room Tag, a
Location Description, an Organization, and the Square Footage.
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The location code entries are designed to be used in a logical hierarchy.  To
demonstrate this concept, let us look at the four levels contained in the Site type
of location.  The lowest level (the Room identification) is located within the next
higher location level (the Floor identification), which is located within the next
higher location level (the Building identification) which is located within the
highest location level (the Region identification).

Note that the number of levels used, the definitions of the different levels, and the
actual codes entered are defined by you and should be developed prior to entering
assets into the Bar|Scan system.
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Room Tag

A Room Tag is a bar code label which identifies a specific location.  The label is
usually affixed to a door jamb leading into the particular area or room.

The Room Tag is used in lieu of the other location codes once a particular location
has been identified. This will save considerable time when you take inventory, i.e.,
you will only need to scan the Room Tag rather than entering the different codes.

Here is how it works for any of the different types of locations:  The first time a
particular set of location codes is entered, a Room Tag number is assigned which
will be used in place of the codes in the future.  After that, when a Room Tag
number is entered into the system, the location codes will automatically be
displayed for you.

If you wish to enter a new Room Tag number, first identify a set of location codes. 
Then type the Room Tag number characters and press ENTER.  Most often
however, Room Tag numbers will be entered using the Mobile Device.

Note:  If you are in a warehouse, you may not need to use a bar code room tag,
rather, you can enter a room tag number and print the bar code on a report which
then can be applied or laminated to the racking.

Bar|Scan can generate and print labels to almost all Avery label stock. Bar|Scan’s
report generator has a label generating function built-in.  A sample system report
can be found by opening the All Reports Icon.

Location Description

Bar|Scan permits you to enter a  lengthy Location Description for the physical
location codes that identify a particular location.

This is useful to further describe Locations, especially when you wish to
download locations into your Mobile Device or print this entry on Location
Menu Boards.
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The Location Description is used in the Asset table, and therefore, Assets can be
ordered or filtered by this description.  However, Bar|Scan makes no use of this
information when working with the Mobile Device.  It will not use this
information in a way as to change Mobile Device transaction information.

The Reference Organization

The Reference Organization consists of the same information as described earlier
in the previous chapter, a code that is linked to a particular Division, Department,
and Unit.

Bar|Scan permits you to enter any organizational information that already exists
in the Organization Structure File.

This is useful to further describe Locations, especially when you wish to
download this information into your Mobile Device or print this entry on
Location Menu Boards.

The fields have associated look up windows to select from.  Right click or press
F5 while on the desired field, and select Look up Value to display the look up
window.

When you view the look up window for the associated Organization Code, you
will see a window similar to the one shown below.
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Begin typing the characters for the desired Organization, or move the highlight bar
using your choice of the cursor movement keys to the desired Organization, to
highlight it.

  
When you have the desired entry highlighted, press the <Enter> key, or select the
Ok button, and the Organization information will appear on the Location table.

Care should be taken when deciding to associate an Organization with a particular
location.  Because the location is now entirely consisting of items belonging to a
certain department or division, does not mean that this location will always hold
only items for that department or division.  This may be especially true with
warehouses.

While you may associate the Organization with the Location, you want to ensure
that the Organization information will not be repeatedly changing.  For instance,
floor three of your building may be for payroll, and has been that way for many
years.  You do not plan on moving the department, and they are responsible for
all of the assets on their floor.  In this instance, it may be a real time saver to
include the Organization as part of the Location.

Whereas, in a warehouse building, row one, bay two, slot left, level two, may be
filled with items that belong to the All American Company today.  Next week,
you may need more space to accommodate this customer, move their items to a
larger location, and fill this bay with another company’s assets.  In this instance,
you would not want the Organization Code associated to the Location.  When the
inventory is being done, the Organization Code can be entered into the Mobile
Device, linking it to the assets themselves.  When the assets move, the
Organization Code will remain the same.

Using the Reference Organization Without the Mobile Device

You can use the Reference Organization to populate the Asset table without
collecting the Organization Code with the Mobile Device.  To perform this
operation, select File, then Company . . . <, Housekeeping . . . <, Table Integrity. 
Make sure the company you wish to do this on is selected, then check Initialize
Blank Organization Codes for Assets, and select the OK button to begin the
process.
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ENTERING A  BLANK  LOCATION

If you do not wish to have Bar|Scan validate the Location as it is being uploaded
from your Mobile Device, you may do so by entering a blank location record, and
saving it.  Then select this blank Location for all of your transactions.

To resume validation, you must delete the blank location record.

CHANGING  LOCATION  TABLE  INFORMATION

From time to time you will want to change, correct, or add information associated
with locations, room tags, or location descriptions currently existing in the
Bar|Scan system.

Important:  You can change location information even if it is being used by an
asset in the Asset File.  Obviously caution should be exercised when using this
feature.  Because the Asset File contains a history of locations, changing a
location will not automatically change locations in the Asset file.

With the Location that you selected displayed on the Edit panel, you may choose
to type in the new information, or right click or press F5 while on the desired
field, and select Look up Value to assist you.

If you type information that causes a conflict, e.g., you attempt to change a Room
Tag to one that already exists for another location, a dialog box similar to the
following will be displayed.

Note: the location on the Edit panel, should still be highlighted to show that there
are pending additions or changes.  As Bar|Scan has not saved the new information
because of the conflict.
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To confirm this, if you hit Esc, or try to close this box at this point, you will see
a dialog box like the one below.

Bar|Scan cannot save this information, until the conflict has been resolved.

After you have made your changes, save the information by pressing the Ctrl + S
key combination, or click on the Save button on the tool bar.

Press the Page-Up key or the Prior Location button from the tool bar if you want
to change the prior location.  Press the  Page-Down key or the Next Location
button if you wish to change the next location.  Remember that locations are
ordered and filtered according to your Set criteria.

Global Changes of Locations

The question that is asked asked is: Can I edit a location field or room tag in one
place and have Bar|Scan change it for me globally in my company?

The answer is yes you can. Changing location fields and Room Tags is not a
normal part of a typical inventory but we have made some changes to Bar|Scan to
make this task easier. Please be sure to read this note carefully before proceeding,
especially if you are sharing the location table among companies (table
properties).
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Bar|Scan has the ability to easily make global changes to location fields, including
the room tag. The new value of a location (including its room tag) can be made
to propagate to all like locations in the current company. This feature is available
only to Master Users. All the Master User need do is edit the location field to be
changed and then save it. Upon saving the change the Master User will be
prompted to confirm the change. Bar|Scan will then check all Assets, Transactions
and Work Orders for that location and then change it to the new value.

If you are doing a range you will be prompted for verification on each location
you have changed. It is important to realize that the "Default Requested By" and
"Default Destination" location for Work Orders specified in the User table are
NOT changed, neither for the current user nor any other user. These fields can and
should vary with both user and company and should not be changed based on one
company or one user.

After saying ‘Yes’  Bar|Scan  will scan for occurrences of this location in all tables
that access this location. For those tables that have it, it will be in the list. If this
location does not occur anywhere else, then you will not get any of the following
prompts, it will just save it.  Below is the first dialog boxe that you would see:
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It is also important to note that if you are sharing locations between multiple
companies that this automatic change is done only on the current company, not all
companies using the location changed. To change the location in the other
companies you will have to change them manually using standard ranging and
editing techniques.

If you select ‘No’, you get this dialog box. You only get it if you are a Master
User. I would not have added this except it is the only way to do certain types of
Location edits when trying to clean up locations.

If you see the message: Your changes affect other tables too

If a user receives one of the following error messages “Your Location changes
affect other tables too. You do not have the privileges to save.”

This message only occurs when one of the following are true:
1. The user is not set as a master user (administrator) in the User Table.
2. The user is editing an existing Location or Person in the Location or Personnel
screens.
3. The Location or Person the user is editing is already being used somewhere
else, such as the Asset table.
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Conversely, this message will not appear if the user is a master user, they are
adding a new Person or Location, or, if editing an existing one, the item being
edited has not yet been used anywhere else.  It doesn’t matter whether or not the
tables are shared with other companies.

Finally, you will get this message if you do not have the necessary privileges to
get the confirmation dialog.

DELETING A LOCATION TABLE ENTRY

This feature completely removes a Location entry from the Bar|Scan system. 
Obviously, caution should be exercised when using this feature.

Removing Location entries from the system is most often done due to erroneous
entries.

Bar|Scan will not permit you to delete any Location entry that is the current
Location for an asset.  You will need to first change all assets and transactions that
are using the Location entry that you wish to delete.

Go to the Asset table, and use the Set feature to display the assets by location. 
Type in, or go to and select any and all assets using this location, using the Range
feature if there is more than one.  Correct the information to display the correct
location for these assets.

Also, correct any of the transactions that use this location so that they refer to the
correct location.

Then, in the Location table, select the location(s) that you would like to delete
using the F4 (Range feature).  Then press the Ctrl + D key combination, or select
the Delete Selected Location button from the tool bar.  You will see a dialog box,
asking you to confirm the deletion.  If you confirm the deletion by selecting Yes,
then you will again be asked to confirm your choice.  If you again select Yes, the
selected location(s) will be immediately deleted.
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CHANGING LOCATION HISTORY VALIDATION

A reminder: Bar|Scan maintains a history of all of your asset inventories including
manual changes. This asset location history is validated against multiple
supporting tables such as the Location Table. If you have a high level of scan
activity or have a large number of edits to the supporting tables, activities such as
creating new Set Commands or performing a Table Integrity may take a long time,
or you may just not be concerned with older location information. You can choose
one of three amounts of validation that you wish Bar|Scan to perform.

Open the Company Settings Screen if you wish to modify the Location History
Validation Level.
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INTRODUCTION

The Bar|Scan Report feature provides many different predefined reports from
which to select.  These are called System Reports.  You can also create your own
reports.

As the number of assets recorded in the Bar|Scan system becomes very large, you
may want to report on only a selected group of assets.  Bar|Scan makes it easy to
select only certain groups of assets so only the desired information is included in
a report.

There is a set of videos on our website that can provide you with additional in
operating Bar|Scan.  These are titled Quickstart Overview Videos and can be
found on this page: https://www.barscan.com/support-videos

Please consider viewing or downloading these as part of your learning experience.

CREATING  YOUR  OWN  REPORTS

You can easily design your own reports, i.e., define the sort of the information,
edit column headings, and specify the information contained on the report.  You
assign a name to your report and the title will be displayed on the Browse panel.

A simple example would be a report showing all of the assets on a particular floor
or in a particular department, listed in order by the Catalog Type and Description. 

BAR|SCAN  SYSTEM  REPORTS

We have created several useful reports for you.  These are called System Reports. 
You may print all of these reports, but unlike the reports that you create, System
Reports cannot be changed unless you uncheck the locked button.  Even then, we
do not recommend that you change them since they are “refreshed” when you
upgrade Bar|Scan to a new version.  However, you can use System Reports as
templates for any new reports which you create.  These new reports can then be
changed.  All System Reports begin their name with "{SYSTEM}.”  
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THE  REPORT  FEATURE

When you want to view, change, add, or delete Reports you will need to open the
Reports table.  From the Main Menu, select File, then Open . . . <, then Reports 
. . . <, then a type(s) of a report as shown on the following example.

You have your choice of nine types of reports shown on the right-hand drop down
menu above.  If you want to choose more than one type of report, select the last
option, All.  This item will allow you to view a list of all of the reports that are
currently in your Company Database.

You may create (add) a new report.  Or, you can change, delete,  view, or print an
existing report.
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The first selection, Asset Reports, has a number of {System} reports and you can
create new reports of your own design.  Bar|Scan will enable you to print any of
the fields that exist in your Asset and all related tables.  

The second selection, Catalog Reports, has a number of {System} reports that
enable you to print either individual Catalog Sheet pages, a list of the items
currently contained in the Catalog table, or a Bar Code Menu List.  In addition,
you use the {System} reports as templates to create reports of your own design.

The third selection, Handheld Computer Transaction Reports, produces reports
from the Transaction table.  The Transaction table holds items which have been
transferred into the system from the Mobile Device.  You can use any of the
{System} reports as they are, or use them as templates to create your own reports.

The fourth selection, Location  Reports enables you to display or print a list or
bar codes representing all of the different locations.  You may print their
descriptions and the referenced organizations.  These reports are useful during a
physical inventory.  By scanning the bar codes on these reports, you can avoid
manually typing the locations into the Mobile Device.  You can print the
{System} reports,  or use them as templates to create your own.

The next selection, Location History Reports, produces a list of assets with
every location they have ever been recorded at, from a location point of view.  Use
these reports to answer questions like “How many assets have ever been in this
location?”  You can print the {System} reports,  or use them as templates to create
your own.

The next selection, Organization Reports, enable you to display or print all of
the organizations, and their associated information.  You can print the {System}
reports,  or use them as templates to create your own.

The next selection, Work Order Reports, enable you to display or print Work
Orders.  You can print the {System} reports,  or use them as templates to create
your own, with the exception of the two custom reports which will be covered
later in this chapter.
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The next selection, Miscellaneous Reports, allows you to add new reports that
do not fit into any other report type, for example, a list of conditions.  You can
print the {System} reports,  or use them as templates to create your own.

The next selection, All, enables you to display, change, add, view, or print all 
types of reports.  This selection enables you to select from all of the reports in
your Company Database.

Beyond these reports, you can add custom Reports to any and all of the report
types.  Custom reports are created (specifically for your company) by a computer
programmer who is familiar with the Microsoft Report Design Tool.  

We have added custom reports to the Work Order module for you to evaluate this
feature.  One custom report is called the GFS Work Order, and another is called 
Warehouse Pick List.  You may print these reports at any time.  But, you cannot
use these two reports as templates or change them in any way, except that you may
add a filter.  All other attempts to change these two reports will not allow them to
print properly.
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If you have selected the Report Toolbar from the View feature, then you can select
the type of report that you want to see, add, change, or print by clicking on the
respective icon.  The Reports Tool Bar is shown below.

Note: When you place your cursor over an icon without pressing your mouse
button, you will see the balloon help that will tell you which type of report the
icon is for.
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No matter which type of reports you select, you will see a Report table similar to
the following.

The Browse tab is selected by default.  This tab permits you to select Report(s),
then you can add, change, delete, set, and view on the Edit tab.

The information on your browse tab will vary, depending on the type of report you
select.

The reports are listed by table.  Shown above are Asset reports.  The report names
appear in alphabetical order.

While the Set button does appear in the tool bar for Reports, it is highly unlikely
that you would ever want to view the reports by any other order than report name. 
But, you can view the reports for different tables by selecting the Set button.

When creating a new report, always try to select a similar report from the
appropriate table to use as a template.
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THE TOOL BAR

The following items are all found on the tool bars of any of the tables.  When you
place your cursor on them, but do not click, you should be able to see a
corresponding balloon help, that will tell you what the button is as shown below.

Note:  In addition to the items on the tool bar as shown above, the Report table
has two additional buttons as shown below.
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CREATING A NEW REPORT 

The number of possibilities for different reports is essentially endless.  You will
likely receive requests from different individuals in your organization and you will
want to design new reports for them.

The Add Blank and Add Template buttons on the toolbar enable you to design
your own reports. Bar|Scan provides many {System} reports from which to
choose.  It is expected however, that you will want to customize the {System}
reports to satisfy your particular company's needs by using them as templates for
your own reports.

To select Add Template Report, or Add Blank Report, you can click on their
corresponding button on the tool bar, or use the pull down menu Under Panel, and
select Add, then select Template or Blank.

Add Blank will enable you to create the new report from scratch.  No existing
information will appear on the panels.

If you choose Add Template, you may choose an existing report to use as a
template for the new report while on the Browse Tab.

While on the Reports Browse tab, move the highlight bar using the mouse or
cursor movement keys to go through the list.  When the desired entry is found,
click on it to move the highlight bar over it and press ENTER, selecting a Report.
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ENTERING THE NEW INFORMATION

After you have selected a Template report, the information will be displayed on
the Edit tab, which will be similar to the one shown below.

Many of the entry items have associated look up windows to assist you with your
entry.  The following section will describe each item on the Report entry screens
and their associated look up windows.

You may use the F3 key, to move from tab to tab on this table.

Clicking on the X button in the top right-hand corner will close the Edit screen. 
Note: if you have pending changes or deletions you will be prompted to cancel or
save these changes or deletions before you will be allowed to exit the Report
table.
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DETERMINE HOW TO MAKE A REPORT

Each time you create a new report, you should review the information on each of
the eight tabs that are used to create your report, and make changes and additions
when necessary.  The nine tabs and their primary functions are listed below:

Report Base - used to define the main table or “base” of the report.  Optionally
used to join company databases for multiple company reporting or exporting.

Sort By - used to list how you want the information on your report to be sorted. 
This does not determine what prints, or which columns will print, or the order of
the columns on your report.

Filter By - used to filter out all of the information that you do not want to see on
your report.  

Columns - used to list items that you need to see on your report.  The fields that
you place here (top to bottom) will appear as columns (left to right respectively)
on your report.

Subtotal - use this item to determine any subtotals or page breaks that you want
on your report.

Layout - use this tab to list page orientation, font size, justification, line spacing,
and if you want a photo box on your report.

Header - list here the items that you want to print at the top of your report pages,
and mark what type of header you want, if you want the date time page numbers
and underlines to display on your report. 

Title Page - this item is optional, and can be used to create a Title Page for your
report, and to specify the font size.

Print - use this tab to specify where the destination for your report (your monitor,
a printer, or a file) the number of pages to print, and any items you want to be
prompted for, prior to each printing of this report.
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Before you can make a new report, you need to decide several things.  

1.  You need to decide what information you want to print on your report.  For
example, if this is a Transaction report, you will need to decide if you want all of
your transactions to print.  

2.  You should decide how you want the information sorted.

3.  You should decide if you wish to see detailed information, or if you wish to see
summary information only.

4.  You need to decide if you want any subtotal to show on your report.

5.  Finally, you should decide if you wish to print the report, email the report, or
send it to a file such as Microsoft Excel.

For example, decide how you want your report to sort.  If it is important to know
how many computers you have, and their models, you may want to sort your
report by Catalog Type and Catalog Description.  This would print all of your
Types together alphabetically (computers, monitors, etc.) then, it has subsets of
the descriptions, all of these also sorted alphabetically.  So, if you have 14
different types of Monitors, they will print together.

If you need to know how many Dell brand desktops are on this floor, you may
want to sort by Manufacturer, Type, then description. 

You may want to print the report sorted by Inventory Initials, Inventory Date, and
Inventory Time.  This would assist you in finding any errors that you may need to
clean up, as the information would print out in the order that it was inventoried.

You may want to sort your report by Asset number.  If you have placed the asset
tags on the items in numerical fashion, sorting your report by the Asset number
will allow you to see if any of the asset numbers are missing from the sequence. 
But, be careful when sorting by asset number, as every single asset number is
different.  Any additional attempt to further sort the information will be
meaningless.  If you need to sort by anything else, then you need to place the asset
number last on the Sort By.  
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You specify how you want the information to sort on the Sort By tab.  The
information will sort in the same order as you place the fields in the list.

Next, you specify what you want to print on the Filter By tab.  

For example, if your Transaction table holds asset information for four floors of
a building, and you only want to print information for floor three, you would need
to add a filter to that report.  The filter would specify that you only want floor
three to print, and would say, Current Floor = 03.  Now the report will only print
floor three.  

Important: Any time you are using a filter, always specify the field by using a 
right click and look up value.  Do not simply type the information in your filter. 
Typing the filter, rather than selecting a look up value, is the most common reason
for a report to not print because you may not type the information correctly.

If you want only the Dell items to print, you would want to add a filter specifying,
Manufacturer = Dell.

If you want every item to print except your Portable Computers, you would add
a filter specifying, Catalog Type <> PORT COMP.

It is normally not recommended to filter by an individual Catalog, or set of
Catalogs.  For example try not to add a filter specifying, Catalog (XX9999) =
CG1002.  This might work correctly now but over time new Catalogs are added
and sometimes Catalog descriptions change.

You can make a report that does not have any filters on it.  When you do not add
a filter, the information in the entire table will print.

You can have more than one filter on a report, but care needs to be taken that the
filters are limiting the information in a logical manner.  For instance, if you need
to see how many Portable Computers  you have in your whole building, specifying
the Catalog Type = PORT COMP is a good idea.  But, you would want to remove
a filter specifying the Manufacturer, or a specific floor.
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Finally, you need to specify if you need any subtotal, and what you want to
subtotal by.  This information is filled out on the Subtotal tab.

Care needs to be taken when deciding what you are subtotaling on, as it is most
often going to be one of the items that is specified on your Order By tab.  These
two items work in conjunction with each other.  Try to ensure that the subtotal
makes sense.  

For example, if you sort by Manufacturer, Type, and Description, you would not
want to subtotal by Catalog Number, as the end result of this report would not
make sense.  But, you may subtotal on Manufacturer.

If you sort by asset number, trying to subtotal by Catalog Type would not give you
the desired result.  But, if you sort by Catalog Type and asset number, you can
subtotal by Catalog Type.

The rest of the information: the columns, their order, their width, their titles, the
title of the report, the header, and the Title page are mostly cosmetic additions and
changes.  (There are a few exceptions, like counts and sums on more intricate
reports, but you will need to get used to these a little at a time).  For now, try to
focus on learning these few facts, and the reports will soon make sense to you.

If you are having trouble getting the desired result, call for technical support, and
your Bar|Scan representative will assist you.
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The Report Base Tab

The first tab of the Report table displays the name of the report, permits you to
select the main table or “base” of the report.  Optionally used to join company
databases for multiple company reporting or exporting.

The following illustration shows the items on the first tab, the Report Base tab.

Report Name

It is best to give your new report a new name by simply typing in the new name
in the Report Name field.  You may give your report any name you wish as long
as the name was not previously used.  The report name can be changed at any
time.

Enter any report name you desire and press TAB.
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Hint: Since you can print more than one report by using the F4, (Range) key, you
should alphabetize your report names so that you can easily range your most
commonly printed reports.

For Larger Organizations, you might also consider your department name in the
report, e.g. “IT DEPT - SMITH / ALL DELL SERVERS BY LOCATION”.  

See how this example provides a clear example of the purpose of the report.  It is
especially useful to know the SORT order of the report, in this case by location.

In any case, the more descriptive your Report Name is the better since ALL users
will have access to the reports that you create.

The Table Section

If you have selected to add your report from a blank, it will initially say that it is
a Miscellaneous type of report.  Notice the field to the left of the Report Name, 
displays the type of report that is being made.  This field represents the table that

the report is for.  If you click the ? button to the right of this field, you will see a
drop down menu similar to the one below.  

This drop down menu will display the tables that you can choose from, i.e., you
can select Asset, if you are creating an Asset report.  

Most of the time, if you are creating an Asset report, you will simply choose an
Asset report as your template, and this step will already be done.
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Report Group

The Report Group field is a freeform field which has many possible uses.  It is not
linked to other Tables and it has no special formatting.  If the report is unlocked,
anyone with privileges to modify a Report can set or change the Report Group
value.

The Report Group can be coupled with a User Table filter.  Users can be restricted
to seeing only those reports that match the User’s report filter.  Since the Report
Group does not actually contribute to the report itself, but rather is used to classify
a report, it can be used as a user filter no matter what the contents of the report
are.

Our Knowledge Base page on our website www.barscan.com offers more detailed
advice on using the Report Group feature.

The Companies Section

By default, this section is “greyed out” as most of your reports will probably not
require combining several complete Bar|Scan Company databases in one report.

Access to the Companies Section is controlled in the User Table.  Master Users
and selected others can access the User Table and change various password
settings.  If you are not a Master User, contact your Bar|Scan Administrator.

Add
If you wish to include one or just a few Companies in your report, you can use the
Add Button to select the Companies individually. If you right click on the
Company File name,
a window will
appear that you can
use to navigate to the
location of your
Company data.
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When you select the Company File Name, the Company Report ID will
automatically be completed for you.  Each Company must have a unique
Company Report ID.  Typically, it is not necessary to change the Report ID as
Bar|Scan can adjust this for you.  This is discuss on the next few pages.

Add Many

The Add Many button can be used to quickly add a group of individual companies
to your report selection.  When you select Add Many, you will be shown a Look
up similar to the one below 

Navigate to the root folder that contains all of the companies that you wish to add. 
In the example above, it is the barscanw folder.  Another common root folder is
the alldata folder.
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When you press the select button, Bar|Scan will gather all companies in all sub
folders and place them in the list as in the example below.

In this example, two Companies were selected.  You can continue to add more
companies by selecting the Add or Add Many buttons.  You can also remove a
Company by using the Delete button.
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Change

Change is used to change/edit a particular company in the list of companies. 
Select the Company that you wish to change and then press the Change Button. 
Typically, the is nothing that needs to be changed once the Company is selected. 
An example of the Change Pop-up is shown below.

Delete

Delete is used to remove a particular company in the list of companies.  Select the
Company that you wish to delete and then press the Delete Button.  This does not
delete any data, it only removes the company from your list.
 

Ascend

Ascend is used to order your companies in the list of companies.  This can assist
you when your company list is very long and you want to conform that it is
correct.  This is for appearance only and does not have any effect on the order of
the data in your report.

Descend

Descend is used to order your companies in the list of companies.  This can assist
you when your company list is very long and you want to conform that it is
correct.  This is for appearance only and does not have any effect on the order of
the data in your report.
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Adjust
Adjust is used to remove duplicate companies in the company list and makes sure
that each company has been assigned a unique Company Report ID which is
required for joining the companies for the report.

The only remaining difference in create a report for two or more companies is that
each pop-up will display an additional item.  The first item will now be the
company to be used for the selection.  An example with the additional Company
selection is presented below.
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The Sort By Tab

The second tab of the Report table displays the name of the report, permits you to
define the order the information will be printed in (what it is sorted by), as well
as to decide whether this order will be displayed in Ascending or Descending
order.

The following illustration shows the items on the second tab, the Sort By tab.

The information displayed will change depending on the report that you have
chosen for your Template.

You can Add, Change, or Delete items from the Order By list.
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You can also view or change the Properties of an item in the Sort By list, as show
below.

You can view or change the Expression for the field you selected.  This is a very
advanced feature.  This is the actual value of the field.  For instance, if you needed
to print and sort by a combination field such as Current Site Location, this item
would allow you to change this field so that only the Region, Floor, and Room 
(excluding the Current Building).  It is rare when you would have to use this
function.  Please contact your Bar|Scan dealer for more information on this
feature.

Finally, you can select a SQL Column Name Override, a feature for advanced
users.  If you understand SQL, this may be a feature that you would want to use. 
You can use this feature to make a special column name for an Expression
column.  For example, you could make an Expression that would print the day of
the week next to the date.  You can use the SQL Column Name Override to call
this column Day and Date.  

You can then use the SQL Name designed in the Columns tab, without having to
respecify what the column is.

Note: There is a 255-character limitation on the size of the fields for the
Expressions and the SQL Name Override.

Page 10-22 Bar|Scan



Chapter 10

Sort By

You use the Sort By tab to list how you want the report “ordered.”  This does not
determine what prints, or what columns print.  The Sort By only determines the
sort.  

You may enter many different items on which to sort the report.  Usually, two or
three items will be sufficient to print the report in the correct sequence.  

Choosing a sequence such as asset number will render any additional choices
meaningless; as each asset number is unique, no farther sorting will take place.

If you are asked for a report of all of the items in your building, you would
probably want to sort the report by current location (Current Region, Current
Building, Current Floor, Current Room) and perhaps by Catalog Type and Catalog
Description.

Hint:  The Sort By tab is used to designate how you want the information on your
report “sorted.”  The sort of the information does not determine what prints, or the
order of the columns that print.  

If you do not yet understand what is meant by sorting your information, select the
report {SYSTEM} DETAILED ASSET REPORT BY LOCATION, change the
Order By many times, and use the print preview button to see how the report
changes with each different sort.

Go to the Sort By list, and click on the Add button.  

If you choose Add, you will be using the look up window to add a field to the
bottom of the existing Sort By list.  All items added will automatically be placed
at the bottom of the list, and then can be moved up if desired.

If you click on an existing Sort By item to highlight it, then click on Change, you
will be using the look up window to replace the existing field with a new one.
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If you click on an existing Sort By item to highlight it, then click on the Delete
button, you will be deleting the current item.

If you have chosen the Add or Change button, you will be shown a look up
window similar to the one below.  

Note the very top field in this look up window, says “Asset.”  This field displays
the name of the table that the look up information comes from.  So, as in the
instance above, all of the fields of information being displayed in the look up
window come from the Asset table.
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However, you may select a different table by clicking on the ? button to the right
of this field.  You will see a drop down menu similar to the one below. 

For instance, let us say that you want to sort your asset report by Catalog Type,
and Catalog Description.  Instead of using the Asset table to select the items from
(which is the default for an Asset report), select the Catalog table.  After choosing
the Catalog table, the items listed in the look up window will originate in the
Catalog table. 

Take a few minutes and look over all of these choices.  When preparing your
report, you may use one or several of the tables.  

Once you have selected the proper table for your look up window, move your
mouse to the desired item and double click on it, or move the highlight bar to the
desired item and press the Add button.  The item selected will be placed in the
Sort By list.

Move the cursor to the next item you want to have displayed in the Sort By list, 
repeating the process until you have identified all desired sort levels.
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Once you have selected the Sort By fields, you may want to change the order in
which they appear.  This is easily done by moving your mouse over the small box
to the left of the item you want to move.  As shown, the assets for this report will
be sorted by the System number, and then, by the Asset number.

A small double headed arrow will appear on the box.  When this happens, press
and hold down your left mouse button, and you may drag the name of the field to
the new position.

The Sort By as shown will now sort by Asset number.  Again, since every Asset
number is unique, no further sort will take place, even if more items are listed in
the Sort By.

Remember to remove any items that you do not want to appear in your Sort By
that may be part of the template.

Ascending or Descending

Bar|Scan allows you to decide if  you want your report printed in ascending or
descending order on an item by item basis.  Normally, reports are printed in
alphabetical order (zero-9, then A-Z).  If you sort your report printed in
descending order, the report will be printed backwards (Z-A, then 9-zero).
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The Filter By Tab

The second tab is the Filter By tab.  You have already told Bar|Scan what you
want your report sorted by in the Sort By tab.  The Filter By section is used to tell
Bar|Scan to filter through all of the information, and to print only the items that
meet the criteria specified.

This feature permits you to identify one or more filters which can reduce the
number of items listed on the report.  You can use a filter to specify that you want
to exclude all information except that equal to the filter, or to exclude only the
information specified in the filter. 

On this tab you can add, change, or delete a filter.  

You can also press the Count button, to count the number of items that satisfy
your Filter By specifications.
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Print Prompt

To the right of the Filter section, there is a button that says Print Prompt.  This
button works in conjunction with the Print Prompts tab.  When you select to be
prompted for items on the Print Prompts tab, Bar|Scan will ask you, at the time
you print the report, to fill out the desired information, i.e., if you select Prompt
For Filter By, before you can print the report, Bar|Scan will show you all of the
filters in your report.  If, however, you also select this Print Prompt for one of the
filters, Bar|Scan will show you only that specific filter.

Advanced Features

Very advanced users familiar with SQL (Structured Query Language) can use
SQL Outer Join, Custom Join, and a SQL Having button on the Filter By tab.  If
you are familiar with the way SQL works, you may want to use these features. 
Most people will never need to run a filter this advanced.

If you are not familiar with SQL, you may need someone who is familiar with
SQL in order to use this feature.  Please contact your Bar|Scan dealer if you need
more information on this feature.

In order to better understand this feature, we need to review how Bar|Scan queries
the data for the report filters.  For example, If you are running a Transaction
report, with a filter of “Transaction, Catalog Code is equal to the Catalog, Catalog
Code,” Bar|Scan would normally give you only the information that is equal to
both.  

If it is an SQL filter, however, Bar|Scan would give you all of the information that
is equal to both, plus a list of all of the Transactions.  

This is a powerful tool, considering that if you have more than one SQL filter, you
can compare several different tables in Bar|Scan at the same time.  

If you know SQL well, you may opt to use the Custom Join option.  This feature
will allow you to force Bar|Scan to filter the way that you want, using two or more
SQL filters.
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SQL Having, works only in conjunction with the SQL Group By, which can be
found on the Subtotal tab.  SQL Group By works with groups of items, rather than
with individual assets.

Normally, Bar|Scan would gather the asset information by applying the filter to
see what information you do or do not want to see.  By using both SQL Group By
and the SQL Having features, you force Bar|Scan to gather the groups of assets,
before applying the filter.  With this feature, you can ask more for more detailed
reports, i.e., you could have Bar|Scan look for all rooms that have assets in them
with a value of more than $500.00 (provided you have entered the accounting
information), or to list all rooms with more than ten assets in them.

The Minimum, Maximum, Sum, and Count also work in conjunction with the
SQL Having, which only works when used with the SQL Group By.  By using one
of these items in conjunction with your SQL Having and SQL Group By, you will
be able to produce the Minimum and Maximum values, and perform Sum and
Counts on those reports.  You may also use the Reset button, to clear the filter of
the Minimum, Maximum, Sum, and Count items.

Again, if you are familiar with SQL commands, this feature may be one that you
will appreciate.  

If you are not familiar with SQL, you do not have to learn SQL to use Bar|Scan.

Or Button

The Or button replaces the AND join between filter items and replaces it with the
OR join.
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When you want to create a filter, click on the Add button, and you will see a
window similar to the one below.

The first field on the top left side of this window says Asset.  The fields listed
below it (in the list box) come from this table.  So, as on the screen above, there
are 164 “Asset” fields that you can choose from.  The number of the fields may
vary depending on the number of modules you have and the program version. 
Scroll down and select Current Building.

In the middle of the above window, you will see the field for the Operator, and 
two other choices, Value and Field.  

Value is selected by default.  Leave Value selected, and choose the Operator.  
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Click on the  ? button to the right of Operator field, and move the highlight bar
to the desired item.  Note, since you are trying to reduce the number of items in
your report by using a filter, you will want to select the items that you want to see,
or those that you do not want to see. 

For example, if you want to see only items on the items on the 9th floor of the 500
building, you might choose the Asset table, then choose the Current Building from
the list of fields.  On the Operator box, you will want to select the down arrow,
you will be shown a drop down box like the one below.

As shown, the choices for the Operator are: Contains, Less Than, Less Than or
Equal to, Not Equal to, Equal to, Exactly Equal to, Larger Than, Larger Than or
Equal, In the List of values, or Not in the list of values.  You will enter the Value
next.  For our example, we will want to choose Equal to from this drop down list.
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Then, you will need to enter a Value for your filter.  There is a look up value
available for your convenience, simply right click on the empty field, and select
Look up Value.  You will see a look up window similar to the one below.

The information in the preceding box will vary depending on the field you have
selected.  For our example, we would select 500.  Then, simply click on the Add
button to add the filter to our Asset Filter tab.

Then, click on the Add button, and make a new filter for Current Floor = 09.  The
finished filter would look like the one below.

By filtering on Current Building equal to 500, and Current Floor equal to 09, we
are telling Bar|Scan that we only want to see the items that are equal to our filter. 
In other words, the only assets that will appear on our report are those assets that
are currently located in Building 500, and only those on floor 09.  This type of
filter is based on the value within the database.  For example, Current Floor equals
09 is based on the value “09" in the asset table.
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The Filter By Operator, shown below,  has options for Contains, In List of
Values, and Not In List of Values.  An example of how these three operators can
be used follows.

Contains: For instance, you might want to use this operator when you want to
print a list of lateral file catalogs that have various descriptions, but all of the
descriptions contain the word Lateral.  To make this filter, you would go to the
Catalog table, select Catalog Description, Operator = $ (contains) Lateral.  

In: For instance, you might want to print a list of SE catalogs that have no
common value, and are not sequential.  To make this filter, you would go to the
Catalog table, select Catalog Category = SE, and the next line of your filter would
be to select the Catalog table, Catalog Number (9999), Operator = IN, and in the
Enter Value field place the actual Catalog numbers separated by commas:
1004,1015,1089.  Thus, the report would print only these Catalogs: SE1004,
SE1015, and SE1089.

You may have rooms numbered 100, 100A, 101, 101A, 102, and 102A in your
database.  It takes a special filter to get only rooms 100, 101, and 102 to print. 
Your filter would have to be, Current Room Operator=IN, and in the Enter Value
field place the following “100 “,”101 “,”102 “.  Notice that there are spaces after
the number, and before the quote marks.  
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Not In: You might want to print a list of SE catalogs, which excludes a few of the
catalogs.  To make this filter, you would go to the Catalog table, select Catalog
Category = SE, and the next line of your filter would be to select the Catalog
table, Catalog Number (9999), Operator = NOT IN, and in the Enter Value field
place the actual Catalog numbers separated by commas: 1004,1015,1089.  Thus,
the report would print all SE Catalogs except: SE1004, SE1015, and SE1089.

You do not have to limit your use of these Operators to only the Catalog table, as
they will work with all of your tables.  This feature will also work with any of the
fields, not just the Catalog Number.
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The order in which you filter “out” the information is important.  You want to
gradually filter out the information, until you have only the items left that you
want to see.  Filter out items in the order of size.  Since a building is larger than
a floor, always place a building filter before a floor filter.

If you select Field, then the message by the field on the right will change to say
Enter Value Field, and the list will change to display a list of fields as shown
below.

In this manner, you can force Bar|Scan to compare a field in one table to another
field in the same table, or to a field in another table.  

You can use this feature in many instances to compare fields.  For instance, you
might want to list all of the Serial Numbers in the Asset table that are equal to the
Serial Numbers in the Transaction table as in the example above.  
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To the left of the word Asset, is a down arrow.  Click on that down arrow and you
will see a drop down menu similar to the one below.

This drop down menu, allows you access to the rest of the tables that exist in your
Bar|Scan system.  If you are making a filter, and need to access the Catalog
Description, you will want to use the down arrow to select Catalog on the menu
shown above.  Then the fields, which are listed below it, will be those that are
contained in the Catalog table, and you can select Catalog Description.
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For instance, if you have the Accounting module, you  enter the default purchase
price for your items in the Catalog table.  During the year you might pay several
different prices for the same Catalog item, and enter the actual purchase price for
the assets in the Asset table.

By simply setting up the filter, you could have the computer compare the Catalog
purchase cost to the Asset purchase cost, and print a report of all the occurrences
where the default purchase price does not match the actual purchase price.

The completed filter would look like the one below.

In the above Pick Field, we have stated that we want to see all of the Purchase
costs (from the Asset table) that are not equal to the Purchase Costs in the Catalog
table.

Depending on your database, you might want to add another filter specifying that
you do not want to see any purchase costs that are equal to blank.
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Examples of Filters 

In the previous example, we were using a type of filter based on the value within
the database.  For example, Current Floor equals 09 is based on the value “09" in
the Asset table. 

You can create exception reports for items that are missing or have moved since
your last inventory. 

For instance, create an Asset Report of Current Locations in the Asset table which
do not equal the Prior Locations, you can determine items moved since the last
inventory.

Or  you could create a report of all assets with a current inventory date less than
the first date of your most recent inventory.  This would print all items, if any, 
were part of your old inventory, but are not part of your new inventory.

Or by comparing a field in the Asset table to a field in the Transaction table, you
could compare a change in the condition or status of an asset.  You could compare
a change in organization. 
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If you select Expression, then the message by the field on the right will change
to say Enter Value Field, and the list will change to display an area to enter an
expression as shown below.

Expressions are custom filters and are rarely needed.  Here is one example.   

You can make a Transaction Report filtered on only one problem number.  You
will need two filters in your Transaction report as follows:

TR.Problem Indicator = HAS PROBLEMS’
TR.Asset # = TR.ASSET_NO AND SUBSTR(PROBLEMS,x,1)=”1”

Where ‘x’ is the problem number. In the example below, problem 6 is “Duplicate
Asset Number”.  Below is the actual filter.
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below is another example of an expression.  This expression looks for the number
‘5' in the 9th position in the System # field.  For example, the System Number
‘0200444258' would meet the filter requirement.

Note that you first specify the system # field  then connect the expression you
want with an ‘and’, i.e. THE FIRST FIELD IN THE EXPRESSION IS THE
SAME AS THE ONE SPECIFIED IN THE LIST ON THE LEFT ONLY IN ITS
RAW FORM. Then an ‘and’. Then the expression that you want to filter on. For
example, for the System #:

AS.SY_NO AND SUBSTR(AS.SY_NO,9,1)="5"

In this case the ‘5’ is the value that you want and the ‘9’ is the position you want
to look at. It uses the SUBSTR() function

SUBSTR(cExpression, nStartPosition [, nCharactersReturned])

The parameters are:

cExpression -Specifies the character expression from which the character
string is returned.
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nStartPosition -Specifies the position in the character expression
cExpression from where the character string is returned. The first character
of cExpression is position 1. Note that if nStartPosition is greater than the
number of characters in cExpression, SUBSTR( ) returns an empty string
("").

nCharactersReturned -Specifies the number of characters to return from
cExpression. If you omit nCharactersReturned, characters are returned until
the end of the character expression is reached.

The Return Value is:

Character. SUBSTR( ) returns a character string. 
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The Columns Tab

The fourth tab, Columns, allows you to add fields that will appear as columns and
the order in which they will appear on the report.  Entry #1 will appear in the
leftmost column on the report followed by #2, #3, etc., across the report page.

Select the Columns tab, and you will see a tab similar to the one below.

Select the Add button to add new columns in the Specify Columns to Print area. 
You will see a look up window similar to the one below.
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The first box at the top of this look up window says the word Asset.  This
symbolizes the table where the fields, in the list below, are contained.  Therefore,
as in the above look up window, you can choose from 184 fields contained in the
Asset table.  

If you wish to access a different table in you Bar|Scan system, simply click on the
down arrow to the right of this field.  You will see a drop down list similar to the
one below.

The selections listed are for all of the different tables in your Bar|Scan system.  If
you need to access for instance, fields from the Location table, simply choose
Location here, by scrolling down the list with the scroll bar.  The list of fields
below it will change to allow selection of all of the fields in the Location table.
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Keep in mind that the order in which you print the columns does not affect the
order in which the report will sort.

As you add fields for columns, you will also want to keep in mind that all of the
items added to this list will initially appear at the end of the list.  You can use the
small grey boxes at the left of each item to move the items up or down.  This is
done by clicking on the small grey box, a small double headed arrow will appear,
and when it does, hold the button down, and drag the item to its new location.

Bar|Scan provides the ability to identify a single field which is a combination of
several individual fields for the following items:

%  Locations (both Current and Previous, short, and full)
%  Attributes
%  Organization Names

The Site Location combination field (Current Location or Previous Location)
contains the Region, Building, Floor, and Room fields.

The Attributes combination field (Attributes, All) contains all seven attribute
fields. 
The Organization combination field (Organization Description, Vertical or
Horizontal) contains the Division, Department, and Unit fields.
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Catalog Attributes Fields

Catalog attributes are a special case.  Different Catalog Categories have different
numbers of attributes associated with the Category (up to seven different attribute
fields).

You can identify from one to seven individual Attribute fields (Attribute #1
through #7) which will be listed in the file one after another on the same line. 
You can also select a combination field (Attributes, All) which will list all seven
Attribute fields.

Because of the variable number of Attribute fields and the considerable length of
seven fields, Bar|Scan provides an additional method for listing only the
appropriate Attribute fields.

Selecting Attributes, All will cause the Attributes fields to be listed in the file one
per line.  The number of lines for a particular Asset number will depend on the
number of Attributes associated with the Asset number's Catalog Category.

The first line of the Asset number entry will contain Attribute #1.  The next line
will contain only Attribute #2, and the third line will contain only Attribute #3,
and so on depending on the number of Attributes associated with the particular
Asset number.

The second and third lines (up to seven lines) will position the Attribute field
directly underneath the Attribute field on the first line and fill the balance of the
line with the space character (ASCII character 32).  
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Printing an Image

If you have the imaging module, you can print a picture or multiple pictures of an
asset right on your report.

Notice, the image size is defaulted to a square, so, if you make the field three
inches wide, your picture will print a three-inch square (three inches wide by three
inches tall).

The images that Bar|Scan prints are in a bitmap (.bmp) format.   If Bar|Scan finds
an image that is not a bitmap format, Bar|Scan will copy it and convert it to a
bitmap format.  When possible, using a bitmap image to start with is the best
option.

To view images in reports, you have two choices.  The Asset Picture field can be
used to print the first images found.

To view signatures and all other images associated with a field, select the field in
the ‘Columns’ and edit its properties.  Below is an example of either choice for
the Asset # field. 
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Within the ‘Properties’ dialog there exists a property for showing images:
“Related Images. Show:”.  Select the desired option. ‘Images’ shows the actual
image, ‘Filenames’ shows, not the image, but the full filename path of the image.
‘None’ shows nothing and is the default.
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IMPORTANT: Do not select either ‘images’ or ‘filenames’ in this images
property if you are using a custom format file generated by a previous version of
Bar|Scan. Any totals or counts WILL BE WRONG. Selecting these properties
generates a temporary table during the report with the image information (a Table
that did not exist in a previous version of Bar|Scan). Due to the nature of how
Bar|Scan references this table, depending upon how many images there are per
line, ALL column calculations are multiplied by the number of image lines.
Format files generated by this version are compatible. 

A few items to remember:

1. When setting a field’s properties to list images, the field needs to be one of
the key fields that have images associated with them: A person’s name, asset #,
catalog or work order. The different tables have different field names for these,
but as long as it is one of these it should display. Other fields simply won’t list
anything. (Strictly speaking, this is not true, but to do so requires manually
renaming the image or signature file.)

2. In reports, the images property will list only existing, permanent images.
Once a transaction has moved to the Asset table, then the signatures associated
with that transaction become permanent image files in the IMAGES subfolder, so
they will display with just this. However, when reporting on the Transaction table
before a move, these images are not yet permanent and do not yet exist as files.
This means that Signatures will not be shown in the Transaction report unless the
‘Signatures’ field is one of the fields listed in the report. Additionally, the
‘Signatures’ field must have its properties changed to show the images, otherwise
it will just show the signature count. In brief, add the ‘Signatures’ field to the
Transaction report and set its ‘Related Images” property to show “Images”.
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Let us now look at the features that are represented by the boxes at the right of the list of
columns to print.

Print the Bar Code Equivalent - If you did not have a bar code printing in a
field, this would place one there.

Print Plain text - No Bar Code - If you had a bar code printing in a field, this
would remove the bar code.

Print the Minimum Value of this Column - will allow you to print a Minimum
Value for the entire column.

Print the Maximum Value of this Column - item will allow you to print a
Maximum Value for the entire column.

Print the Sum of the Values in this Column - will allow you to print a total in
a column (total quantities) or in a financial field (used for dollar amounts).

Count how many Occurrences there are in this Column - is used to give you 
the number of times the item appears (will not count quantities if they exist).
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Plus Sign - this item is used to add the current column to the prior column.  Both
the current column and the prior column must be a number or a financial field
(used for dollar amounts).

Minus Sign - this item is used to subtract the current column from the prior
column.  Both the current column and the prior column must be a number or a
financial field (used for dollar amounts).

Multiply Sign - this item is used to multiply the current column by the prior
column.  Both the current column and the prior column must be a number or a
financial field (used for dollar amounts).

Divide Sign - this item is used to divide the current column by the prior column. 
Both the current column and the prior column must be a number or a financial
field (used for dollar amounts).

Clear the Column of Min, Max, Sum, and Count Commands - This item will
remove from the column all of the Min, Max, Sum, and Count Commands

Note: Always use Sum if you want a total in a monetary column, or when
quantities are involved.

The Sum feature will print a total for the number of the item you identify each
time the value of the item changes.

Some caution should be exercised when identifying the totals you wish displayed. 
For example, if you select Asset #, a total (of 1) will be printed after each line on
the page.  Usually this is NOT what is desired.

Many times, it is desirable to coordinate this feature with the Page Break feature,
showing a total each time a page break occurs, selected on the next tab, Subtotal.
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The Properties Button

If you need to change anything about your column, you will want to access the
Properties box by clicking the Properties button located beneath the columns box. 
When you select the Properties button, you will see a window similar to the one
below.

In this box you can select to: print a blank instead of a value, enclose the printed
value in a box, select a default value, or to not print a column by checking the
appropriate check box. 
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You can change the name of the column (what actually prints at the top of the
column) by typing a new name in the Header field.  

You can make the column wider or thinner by adjusting the inches of the Column
Width.

You can choose the column alignment, both for the header and the data.

You can view or change the Expression for the field you selected.  This is a very
advanced feature.  This is the actual value that prints, not the header.  For
instance, if you needed to print a combination field such as Current Site Location,
this item would allow you to change this field so that only the Region, Floor, and
Room would print (excluding the Current Building).  It is rare when you would
have to use this function.  Please contact your Bar|Scan dealer for more
information on this feature.

You can select a different font.  

Finally, you can select a SQL Column Name Override, a feature for advanced
users.  If you understand SQL, this may be a feature that you would want to use. 
You can use this feature to make a special column name for an Expression
column.

For example, if you wanted a list of locations that were sorted by the number of
pieces at that location, you could use the SQL Column Name Override to
accomplish this.  You could add a “quantity of assets” column in your columns,
select this “quantity of assets” column and then click on the Sum button.  You can
use the SQL Column Name Override to call this column NUMBER.    

You can then use the SQL Name designed here in the Sort By tab, without having
to respecify what the column is.  So, on your Sort By tab, put in an erroneous item
to sort by, select this erroneous item then use the SQL Name Override option to
change that field to be your new NUMBER.  

This report now forces Bar|Scan to total the items in the field, before sorting the
information on your report, so that your report is being sorted by the total number
of items in each location.
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Note: There is a 255-character limitation on the size of the fields for the
Expressions and the SQL Name Override.  A SQL Name cannot contain spaces.

The Background Color Condition allows a printed field to be colorized based on
its value. The condition expression is evaluated when printed and the background
color of the individual value is set at that time. There are two of these so that there
can be two different colors based on two different conditions. (e.g., negative
values can be red, values above a minimum value can be green., etc.)

Here is an example. This will highlight the Asset # in red if its value is more than
$5000 but its depreciation life is less than 36 months. It will highlight in orange
if there is not total cost entered.
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The Subtotal Tab

The fifth tab on the Report table is Subtotal.  When you select this item, you will
see the tab as shown below.

This list tells Bar|Scan what you want to break (or subtotal) on.  Normally, you
will want to total (or break on) an item that is listed in your Subtotal. 

On this tab, you can Add, Change, or Delete the items that you will Subtotal On.
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When you select the Properties button for the Subtotal On items you will be
shown a box similar to the one below.

You may turn the first few items are turned on and off by clicking on the
appropriate checkbox.  You can enclose the printed value in a box.  You can print
headers for the top of each one of the Subtotal group (each one of the subsets). 
You can force the headers to be repeated at the top of each page.  

Print leading message with this ‘Subtotal’ group.  This item allows you to print
leading messages for a subtotal on group.  This is useful when you have more than
one subtotal on, and you want leading messages for only one of these groups.

You can change the Header (the actual name of the column) by typing in a
different name in the Header field.
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You can view or change the Expression for the field you selected.  This is a very
advanced feature.  This is the actual value that prints, not the header.  For
instance, if you needed to print a combination field such as Current Site Location,
this item would allow you to change this field so that only the Region, Floor, and
Room would print (excluding the Current Building).  It is rare when you would
have to use this function.  Please contact your Bar|Scan dealer for more
information on this feature.

Note: There is a 255-character limitation on the size of the fields for the
Expressions and the SQL Name Override.  A SQL Name cannot contain spaces.

Page 10-56 Bar|Scan



Chapter 10

You can select a different font by right clicking in the report font field.  You will
see a window similar to the one below.

The text color and background color fields can be changed by left clicking in the
appropriate field to access the windows color pallette, and select a color.  The
color pallette is displayed below.
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To the right of the list for the Subtotal, there are eight items:  Page Break, Trailing
Message, Line Message, Trailing Blank Line, SQL Group By, Reset, Summary
Report, and No Duplicates.  

To make a Page Break, you need only  to place an item in the list, highlight it,
and then click on Page Break.  A page break is used to group items on your report. 
This feature will cause the report to skip to the next page each time a change is
detected on one of the items defined by this feature.  

Some caution should be exercised when identifying the Page Break items.  For
example, if you select Asset #, only one asset will be printed on each page. 
Usually this in NOT what is desired.

A Trailing Message is used to specify what items are being totaled, and lists a
total of the number of records that are listed on its own line.  

A Line Message gives the description of what is being totaled in your report, on
the same line as the count or sum would appear, but lists no total of its own.

A Trailing Blank Line can be added to your report by clicking on this button. 
This means that after each total and subtotal, a blank line will be inserted.  This
feature may make it easier to find and read the totals on some reports.

SQL Group By is a feature for our advanced users.  It is the SQL (Structured
Query Language) version of a summary report.  The differences are internal, the
number of items that the computer has to deal with is significantly reduced when
using this feature in conjunction with an SQL Filter By.

When a summary report is printed, all of the information is still gathered in detail,
but the user ends up seeing only one line per item, and a total.  When an SQL
Group By is used, the items in the SQL Filter By are gathered, with one record for
each type of group.  Then the groups are queried.  The output is only one record
for each item that satisfies all of the criteria, and a count similar to the summary
report. 

No Summary Line allows you to print a Summary report, but not print a separate
Summary Line for each subtotal. This item will give you only a grand total for any
monetary sums (if any) and a grand total for the subtotal.
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Reset does exactly that, it resets the items back to having no subtotals, or Page
Breaks, or message.

The next item on this tab is Summary Report.  This item is used when you want
the totals for all of the items in a report, but you do not need to have all of the
details on the items.  I.e., If you have fifteen hundred items on the third floor, and
you want to know how many of these items are chairs, but you do not need to
know what type of chair, then you will want to use this item.  Simply set up the
report to give you a list of all of the items on the floor, Ordering by Catalog Type,
choose the columns that you wish to see, and then click on the box next to
Summary.  You will receive a report in Summary form. 

Important: If you are printing your report in Excel format, the Summary function
will work, but when the information is sent to Excel, the Summary portion will
be lost, and your items will print in detail form.  If you need to print a Summary
type of report, yet you need to export the information to Excel, a SQL Group By
report will be your best choice.  Contact Bar|Scan technical support if you need
assistance with your report. 

The Last item on the right, No Duplicates, forces your report to look for unique
items (taking into consideration all of the criteria specified on your report).

If, for instance, you wanted to run a report of Catalog Type and Descriptions, your
Sort By could be by Catalog Category.  So, if you specified that you wanted no
duplicates, you would get a report that listed one record each time it found a
change in any of the three items:  Category, Type, and Description.  But, only one
record would be printed for each time the items were all found to be the same.  

If you had 40 desks, 20 of them were single pedestal, right-hand desks, and 20 of
them were double pedestal desks, for these particular items, you would get two
records on your report.  Notice, no totals would be listed, unless you specified a
count.
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The Layout Tab

The sixth tab on the Report table is the Layout tab.  When you select it, you will
see the tab as shown below.

On this tab, you can enter an Optional Format File, this is used for Custom
Reports.  This can be used to modify the layout of a Bar|Scan report to fit an
existing form or to look like a form.  Consult your Bar|Scan dealer before entering
information into this field.

You can change the font, the font size, and its appearance in the Report Font field. 
You can change the size of the Bar Code Font in the Bar Code Font field.

The Print Photo Box is used for making a box for photos at the bottom of the
Catalog Sheets.  Simply click on the box to toggle between checked for Yes, or
unchecked for “No.”

You may change the orientation of the paper used when you print the report by
simply clicking on either Portrait or Landscape.

The Line spacing can be adjusted by clicking on either the up or down arrow to
the right of the field line spacing field.   Next is the Report Justification.  You can
select the down arrow next to the field to change from the default of Center to Left
or Right justification.
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The last field on this tab is Margins.  Only change Margins for offset or binding
purposes or if information is being cut off at the edges.  Your Windows
compatible printer is controlling  the maximum page size, not Bar|Scan.

The Header Tab

The seventh tab on the Asset table is the Header tab.  When you select this tab,
you will see the tab as shown below.

On this tab, you have the options of changing the information displayed on the
report including the main header for the report, the Header Style, whether or not
the report will have a date, a time, a page number, or underlines for data entry.

Report Titles

This feature permits you to enter up to three separate lines defining the report and
its purpose.  The information will be automatically centered for you.

The information entered is entirely up to you.  Usually, at a minimum, you will
want to assign a report title.

The two items; Left and Right will be placed on the same line of the report.  The
text you enter for Left will be positioned on the left and the text entered for Right
will be positioned on the right of the report.

Reports Page 10-61



Reports

Place your mouse on the first blank field and right click or press F5,  you will see
a look up window like the one below.

There are several special items provided by Bar|Scan that you may use in any of
the five report title lines, some of the special items are shown in the look up
windows.  The look up window for the second line of the report titles will look
similar to the one below.

You may use one of the predefined items from this list, or simply fill in the second
line by typing in your own words.
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The look up window for the third line of the report titles will look similar to the
one below.

You may use one of the predefined items from this list, or simply fill in the third
line by typing in your own words.
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Some Examples of Special Item That Will Print

~as.ac_disrm1~ Asset Comment #1 will be printed

~cat_code~ The actual Catalog Code being printed

~cat_num~ The actual Catalog Number being printed

~cat.type~ The actual Catalog Type being printed

~cur_comnam~ The actual Company Name you gave the company

~re.re_name~ The name that is given to the report when it is saved           

The items that have terms beginning with and ending with the tilde symbol “~”
are macros.  These macros contain the field name of the data that will be printed
by using the macro.  For example ~MV_PARTNO~ is the field name for the
Catalog’s Manufacturer Part Number.

We suggest that you experiment with these special items on you reports.  For
example, if you use the ~cur_comnam~ instead of typing the company name, and
the name of your organization changes, you will only need to make the change
once by renaming the company instead of on each report.

Again, the information entered for all items is entirely up to you.  Often, these
areas are used to identify the sequence of the report and the filters used by the
report.
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The next item will print on the left-hand side of the fourth line of the title box. 
Here you may type in any information that you desire.  But, we suggest that you
use this space to specify what the filter for the report is.  If you go to the field
specified as Left, right click or hit the F5 button, and select Look up Value, you
will see a box like the one below.

The next item will print on the right-hand side of the fourth line of the title box. 
Go to the fifth field, on this tab, and right click or hit the F5 key, and then, select
Look up Value, and you will see a dialog box like the one below.

Again, you can use this space for any information that you want, but we suggest
filling this space with information explaining what the report was Sorted By.

Placing the Filter by and the Sort by on the Report title box will allow all who
view the report the advantage of knowing these things without having to guess,
and can make recreating the report much easier.
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The Title Page Tab

The eighth tab on the Report table is the Title Page tab.  When you select this tab,
you will see the tab as shown below.

It is not necessary to complete any information on this tab.  This Tab can
optionally print a cover page for your report.  You can either type information into
the text area or cut and paste information from another application.

A sample text has been included in the above example.

You can change the font of the entire page.  You cannot change the font of an
individual line nor insert graphic files.
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The Print Tab

The ninth tab on the Report table is the Print tab.  When you select this tab, you
will see the tab as shown below.

The Print tab, has four additional tabs of its own.  The first tab, is the Destination
tab, as shown above.

On the destination tab, you have the several options.  First, select whether you
want to send the print job to a printer, send as an email attachment, or save it as
a file.  If you select Printer, the first field to the right is displayed for you to select
a specific printer.  The defaulted printer is “Default,” but you may select another
printer.  Simply place your cursor in the Printer field box, and right click or press
the F5 key, and choose Look up Value, you will see a look up value window
similar to the one on the following page.

There are two check items at the bottom of the screen.

Always Preview - check this if you would like to always have a preview occur
before a print or export.  If you are printing a report on a regular basis, we
recommend that this not be checked.

Force report output even if no data - if your filters leave Bar|Scan with nothing
to print or export, you will be presented with the message ‘No items match your
crieria’ and no report is printed or exported.  If you still would like a report or
export showing that there are no items, then check mark this item.
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The look up value box shown previously will list all of the printers that are listed
in your computer’s Windows folder.  

You may send the report to a file on the disk drive to be stored for later printing. 
Output file is for the name of the file that will be stored on the disk.  

See your computer system operator for instructions about file names.

If you select a file for the destination of your report, then you will need to fill out
the three fields to the immediate right, the Output File, the File Format, and the
Verify Overwriting Existing Files.
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If you place your cursor on the Output File field, and right click or select the F5
key, then select Look up Value, you will see a window appear where you can
choose a file from any of those listed on your computer.

Bar|Scan has four tilde variables for use during report exports. These variables
allow reports to send report files to the current company folder and to the Bar|Scan
SYSUSER folders. These should be used with caution as it is possible to
overwrite Bar|Scan or user data. These are:

#1. CUR_COMPATH - Contains the full path of the current company with a
trailing backslash. For example, for company

C:\BARSCANW\DEMOCO\DEMOCO.DBC 
it is

C:\BARSCANW\DEMOCO\ <INCLUDING THE TRAILING SLASH>
                                                
#2. CUR_SYSUSER - Contains the full path of the SYSUSER folder with a
trailing backslash. For example, for installation

C:\BARSCANW 
it is

C:\BARSCANW\SYSUSER\ <INCLUDING THE TRAILING SLASH> 

#3. CUR_MYDOCUMENTS - Contains the full path of the My Documents
folder. 

#4. CUR_MYDESKTOP -  Contains the full path of the Desktop folder. 

These make it easier to design a single ‘file export’ report across multiple
companies. This is typically needed when interfacing with third party software
systems. Here is a sample screen of a typical use of CUR_COMPATH within the
DEMOCO company. The CUR_SYSUSER variable is used similarly.  Here is an
example:
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In the previous example, this report will be sent to the file on your desktop called
BARSCAN.XLSX.

You must follow these rules to use them properly and safely:

1. They must be used within a tilde expression (i.e. in an expression between two
tildes) within the report’s ‘Output File’ field.  If the report is being printed or
exported some other way, such as to a printer or through email then the file
destination will be ignored.

2. Care must be exercised not to overwrite any Bar|Scan data files or even your
own data files placed in Bar|Scan folders.

The File Format field has a drop down menu, which you may access by simply
clicking on the down arrow to the right of that field.  The drop down menu is
shown below.

Note that there is again a scroll bar located to the right of this drop down menu,
so this is only a partial listing of the types of files that you can use for your output.

If you will be sending a report using email, you will needs to have Microsoft
Outlook installed on your computer. Bar|Scan does not support other email clients.

You can redirect any report to any email recipient.   Select the ‘Print’ tab on the
report, then the ‘Destination’ tab.  Select ‘Email’ on the left, enter the target email
account and file format (XLSX in this case).  You you wish this report to always
go to this email address, then ‘save’ the report. The next time it prints it will
automatically be emailed when ‘printed’.  If it is just a one- time event, you do not
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have to save it, just ‘print’, then when it is done being emailed, you can cancel the
changes.  If you need to send it to multiple email accounts, select the ‘Dest List’
first then add each of the accounts you want to send it to.

File Format

You may choose from twenty-two different report formats CSV, DELIMITED,
DOC, FDOC, FODS, FODT, FOXPRO, FRTF, HTML, MHT, ODS, ODT, PDF,
PLAN, RTF, SDF, SIF, TEXT, XL5, XLS, XML and XPS.

CSV
The comma-separated values (or CSV) file format is a delimited data format that
has fields separated by the comma character and records separated by newlines.
Fields which contain a comma, newline, or double quote character or which start
or end with whitespace, are enclosed in double quotes. If a field's value contains
a double quote character it is escaped by placing another double quote character
next to it. The CSV file format does not require a specific character encoding, byte
order, or line terminator format.

DELIMITED
ASCII comma, quote delimited is the most popular personal computer export and
import format.  The information is converted to ASCII format which means that
it can be read by even a word processor.  The items are separated by commas. 
Alpha numeric items (which can contain both letters and numbers) are also
enclosed with quotation marks.  Choose from Delimited with Blank, Delimited,
or Delimited with Tab.

MICROSOFT WORD DOCUMENT FORMATS
Microsoft Word Document - absolute layout (or DOC) format
Microsoft Word Document - flow layout (or FDOC) format 
Open Office Writer Format - absolute layout (or RTF) format  
Open Office Writer Format - flow layout (or FRTF) format

Word documents documents have two output options – “Absolute positioned
layout” and “Flow layout”. The generated documents often look the same, but the
algorithms behind these options are completely different. The absolute positioned
layout always looks like the original report, but is hard to edit and bigger in size.
The flow layout may not always look exactly the same, but it is a 'real' Word

Reports Page 10-71



Reports

document - easily editable, with styles, page headers and footers, paragraphs and
tab stops, which is also shorter in size and faster to open. 

OPEN OFFICE DOCUMENTS
Open Office Calc Spreadsheet - absolute layout (or ODS) format 
Open Office Calc Spreadsheet - flow layout (or FODS) format
Open Office Writer Format - absolute layout (or ODT) format  
Open Office Writer Format - flow layout (or FODT) format 

OpenOffice is using the OASIS Open Document Format (ODF) for Office
Applications, which is also supported by a variety of other office applications
including StarOffice, KOffice, and IBM Workplace. XFRX generates the file
formats natively, so OpenOffice doesn’t have to be installed on the computer
where the document is generated. 

FoxPro
This is Microsoft’s Visual FoxPro 9.0 native file format. This format is typically
used to interface with another database.

HTML DOCUMENT FORMATS
HTML document with included graphics (or MHT) format
HTML document (or HTML) format

HyperText Markup Language is the predominant language for web pages.  This
format is typically used to post to a website.

PDF DOCUMENT
Portable Document (or PDF) Format is a file format created by Adobe Systems
for document exchange.  It is now an open standard and a popular standard
because it encapsulates the information to properly display a document making it
independent of  application software hardware and operating systems.

PLAIN
Plain Text (or PLAIN) Document contains no format definitions at all.  No  fonts,
graphics, lines, page breaks, etc. are included.
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SDF
System Data Format - txt -  is an industry standard for file formats and could be
used when sending the report to a file which will be transferred to a different
computer.  

SDF puts the different fields into a disk file one field after another; the lengths of
the individual fields determine the position of the field on each line in the file. 
Each line (record) in the file can contain number fields.  However, the total
number of characters in one line may not exceed 253.  One line in the file (a
record) can contain only the information associated with a single Asset number
(with one exception, see the Attributes Fields section below).

Whenever the SDF output method is selected, several Bar|Scan report features are
disabled; Show Options, Page Description, Portrait and Landscape definitions,
Report Titles, Page Break On, Print Totals for Change In, and Report Header
Style.

The Bar|Scan system contains many fields, all of which cannot be included in a
single SDF report file.  You may select fields which, when all of the characters for
each field are totaled, contain less than 253 characters.

The number of characters for each field is shown in the table below.  Note that the
field lengths may be changed as new features are added to Bar|Scan. 
Consequently, we recommend you allow some flexibility regarding field length
in programs that will use the information.

Some fields will contain fewer characters than are allocated to the field.  These
fields will be filled with trailing space characters (ASCII character number 32). 
The first character in a field will be left justified.

SIF
This is Standard Interchange Format.  It’s derivative, CAPSIF, is sometimes used
in the furniture sales industry.  Each line of the CAPSIF begins with a two-
character op-code, followed by an equal sign (=). followed by the data associated
with the code.  In all cases with Bar|Scan the data associated with these codes is
less than 60 characters long.  Only one type of information is specified for each
line in the CAPSIF file.
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The following is a detailed description of each of the CAPSIF codes used by
Bar|Scan.  The first five are used to define the specification file as a whole.

SF= Specification File name (drive:\path\filename.ext) as saved in Bar|Scan
ST= Specification Title, saved in Bar|Scan as the optional destination description
L1= User Label 1, saved in Bar|Scan as the Report Title # 1 line
L2= User Label 2, saved in Bar|Scan as the Report Title # 2 line
L3= User Label 3, saved in Bar|Scan as the Report Title # 3 line
PN= Product Number, saved in Bar|Scan as the Manufacturers Part #
PD= Product Description, saved in Bar|Scan as the Catalog Type and Description
MC= Manufacturer Code, saved in Bar|Scan as the Manufacturer Name
QT= Quantity, saved in Bar|Scan as the Quantity
TG= Tag #, saved in Bar|Scan as Manufacturers Tag #
GC= Catalog Number, saved in Bar|Scan as Catalog      
ON= Attribute Numbers 1 through 7, saved in Bar|Scan as the Attribute Names
OD= Attributes 1 through 7, saved in Bar|Scan as the Attributes

When creating a SIF report, there are some rules that you must follow in order to
successfully generate a SIF file.  These are rules associated only with the SIF
Standard and not Bar|Scan reporting.  They are as follows:

1. Make sure that all required Catalog Category fields are included under
Columns, and included only once. A user may not realize that they must include
these fields. These fields are listed below

CC.# Attributes
CC.Attribute #1 Caption
CC.Attribute #2 Caption
CC.Attribute #3 Caption
CC.Attribute #4 Caption
CC.Attribute #5 Caption
CC.Attribute #6 Caption
CC.Attribute #7 Caption

CC is the Alias to the Catalog Category table

2. Make sure that all Catalog Attribute fields are included, and again include them
only once. These fields are listed below. 
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CA.Attribute #1
CA.Attribute #2
CA.Attribute #3
CA.Attribute #4
CA.Attribute #5
CA.Attribute #6
CA.Attribute #7

3. Be careful how you specify the catalog (xx9999).  You may not use catalog
codes or numbers from two different tables in your report. A common mistake is
to put CA.Catalog(xx9999) in the list of Columns and to order by
AS.Catalog(xx9999). These need to be both either CA or AS, but not CA and AS.
You must include separate specifications of Catalog Code(XX) and Catalog
Number(9999) somewhere in your report.

Following these rules will minimize the most puzzling messages when trying to
create SIF reports.

TEXT
Straight Ascii Text Format - txt - provides only the characters available in the
IBM Extended ASCII character set and is most often used when your printer is not
a Laser printer.  When printing to a file, it will preserve header and page break
information.  This is not the case with Delimited files.

XLS
Use XLS to export a Microsoft Excel version 2 spreadsheet.    Each column in the
spreadsheet refers to a field; each row in the spreadsheet refers to a record.  A
.XLS extension is assigned if you do not include a file extension.

XL5
Use XLS to export a Microsoft Excel version 5 spreadsheet.    Each column in the
spreadsheet refers to a field; each row in the spreadsheet refers to a record.  

Choose one of the available file formats by a clicking on it with your mouse, or
pressing the associated hot key, or use TAB to move to the button and press
ENTER.
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If you are not sure of the format required for your application, choose ASCII
Comma/quote delimited.

XML
The Extensible Markup Language (XML) is a way of describing data. An XML
file can contain both coding and the data too, as in a database. It is a simplified
subset of Standard Generalized Markup Language (SGML). Its primary purpose
is to facilitate the sharing of data across different systems, particularly systems
connected via the Internet. Languages based on XML (for example, Geography
Markup Language (GML), RDF/XML, RSS, Atom, MathML, XHTML, SVG,
XUL, MXML, EAD, Klip and MusicXML) are defined in a formal way, allowing
programs to modify and validate documents in these languages without prior
knowledge of their particular form.

XPS
The XPS [XML Paper Specification] is a document specification developed by
Microsoft.  To be able to preview the XPS document, you need an XPS document
viewer. If you are running Windows Vista you already have one as it is included
with .NET Framework 3.0. 
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The Destination List feature may include a particular printer or file name, or you
may use the Prompt For feature to enter a file name.

The Destination List was designed so that you may list two or more destinations,
and a copy of this report will go to each destination every time it prints.

For example, you may use this feature to print a report, and to email a copy of it
to your colleague as well.  

Once listed in this manner, the report will print to both the printer and to your
email application every time it prints, until you change the Destination List.  It is
important, therefore, if you are printing the report as a file that you specify that
you want to “Verify overwriting existing files” by placing a check in the
appropriate check box as shown above.
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When you select Destination List and click on the Add or Change button, you will
see a window similar to the following.

When you select File, the window shown above will change to appear like the one
below.

When you select Email, the window shown above will change to appear like the
one below.

Use any of these windows to build your destination list.
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Keep in mind that you can use the right click on the Output File to browse your
network and place the result anywhere, including your Desktop, as shown in the
example below.

If you are using the Email format, right clicking will present you with your email
address from your Microsoft Outlook Contacts.  This function is not compatible
with other email applications.

Verify overwriting existing files

This prompt will only appear when you send the report to a file.  We recommend
that you always use this feature. 
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Print Preview

Immediately under the File option, is the phrase ‘Always Preview’ with a box next
to it.  Simply check this box if you want to Preview your report on your screen
when you wish to preview before printing.  Even though the report is only being
printed onto your screen, Bar|Scan still considers this a print function.  If you use
this function, each time you select the print icon, your report will be sent to your
screen for you to preview.   You may choose to print the report from the preview,
or choose to exit the preview without printing it.

A Word About Report Previews

The Preview feature is one of the largest time savers in Bar|Scan, as you can  see
the way your report will look, without having to print a single page.  On the
preview page you can determine if any of the column widths or the Headers of
those columns need adjustments.  

If you need to make adjustments, simply exit the preview by going to the preview
tool bar as shown below, and click on the icon of the open door.

You can use the print preview feature to browse through your information without
printing it out, or, you if you find that your report looks the way you want it, you
may click on the last button to print the report.

Note: If you have selected to preview your report, then print it from the preview,
ALL of the pages will print even if you have selected only certain pages to print.
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The second tab on the Print tab, is Pages tab, as shown below.

The Pages tab permits you to choose to print all of the pages, or a single page, or
a range of pages.  If you wish to print the entire report, select All.  If you wish to
print only one page, or a range of pages, select Pages, then, simply type in the
corresponding number(s) for the page(s) that you would like to print.  If you are
planning to print a range of pages, enter the page numbers separated by a dash.

Note: If you select to Preview your report, then print from the Preview, ALL of
the pages of the report will print, regardless of your choice on this page.  If you do
not want to print the entire report, yet you still want to preview the report, preview
it, and close the preview.  Change the report so that preview is not selected.  Then,
print the report, and the pages you selected will be the only ones that print.
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The third tab on the Print tab, is the Prompts tab as shown below.

This tab permits you to select items that you will be prompted for before the report
can be printed.  

You may want the person selecting the report to make some decisions about the
report before it is printed.  This feature is optional and will direct Bar|Scan to
include one or more prompts.

The selection window provides eight choices: Filter By, Mark as Printed,
Destination, Header Style, Location Histories, Orientation, Summary Report, and
Windows Printer Settings.

If you select Filter By, the person requesting the report will be prompted to select
a specific filter before printing this report.  This is useful, for instance, when you
are printing a report that you use often, but find yourself changing the filter as you
go.  By prompting for the filter by, you can avoid having multiple reports wherein
the only difference is the filter.

If you select Mark as Printed, the person requesting the report will be prompted
to Mark the items as printed.  This item is used specifically in conjunction with
Transaction and Work Order reports.  The Transaction table requires that each
item be printed, and that they are marked as printed before it will allow you to
move the items to the Asset table.  This item will allow you to automatically be
prompted for the marking of the Transactions as printed.  Also, the Work Order
table requires that the work orders be printed before they can be completed.  This
item allows you to automatically mark the Work Orders as having been printed.
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If you select Destination, the person requesting the report will be prompted to
identify where the report is to be sent each time the report is requested.  This can
be useful if you have more than one printer or would like to choose a printer on
your network when it comes time to print the report.

If you select Header Style, the person requesting the report will be prompted to
identify which type of header style the report will use.  This is useful if you are
printing to laser and non laser printers since laser printers can use a box header
style and most non laser printers cannot.  This choice is often made in conjunction
with Destination.

If you select Orientation, the person requesting the report will be prompted to
identify the page Orientation each time the report is requested.  If Orientation is
NOT selected, the report will be oriented as specified by the Page Design entry. 
Orientation choices are Landscape or Portrait.

If you select Summary Report, the person requesting the report will print in a
summarized format.  It will not print every asset in the database.  Summary
Reports should be used in conjunction with Print Totals For Change In.  See the
section titled Summary Report later in this Chapter for more information.  

You may wish to create Summary Reports with additional fields for information
purposes only.  These reports differ from normal detailed reports by not listing
every individual asset meeting the report criteria.

For example, you can subtotal on Catalog Number and print Catalog Type,
Catalog Description, and Attributes for information purposes.

When you choose the Summary feature, Bar|Scan will print only the last record
before a subtotal, for information purposes, along with quantity subtotals for the
field indicated with Count, or for dollar amounts indicated with Sum. 

If you select Windows Printer Settings, the person requesting the report will be
prompted with the Windows printer setup box.  On this box, you may change the
paper size and other Windows options.
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The last tab on the Print tab, is the Values tab as shown below.

This tab permits you to create and store information temporarily for use in your
report.   When the report is printed, this information is discarded.  We call the
place to store this information Memory Variables.

There are many reasons to use temporary information.  For example, a number to
calculate a sales tax rate, a title for a report, an items that you will be prompted for
before the report can be printed.

Below is an example of a Memory Variable that can print on the report.  See how
this is used in the completed example above.

  

To print the approval on the Titles Page, the string would be:
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Bar|Scan understands the following date keywords for reports.

x_BegOfMonth x_EndOfMonth x_BegOfYear
x_EndOfYear x_FiscalBegOfYear x_FiscalEndOfYear
x_BegOfLastYear x_EndOfLastYear x_FiscalBegOfLastYear
x_FiscalEndOfLastYear X_ToDay

Upper/low case doesn’t matter. For example, when specifying the value field you
could enter as follows:

This might give a prompt as follows (if today is June 11, 2013):
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PRINTING A REPORT

Once you have your report the way you want it to look, you can choose to print the
report.  Simply select the report that you want to print, and then select the Printer
icon on the tool bar.

You are asked if you want to go ahead and print the report.

If you select NO, you will be returned to the Reports Menu.

If you answer YES, the report will immediately be compiled and sent to the
printer, to your monitor for a preview,  or to a file, depending where you directed
the report to be sent.

After you answer YES and the print process has started, you may press ESC to
stop the process.

If you answer CANCEL, you will stop this report from being printed and you will
proceed to the next report that was previously selected.  If this report was the last
or only report selected, you will be returned to the Reports Menu.
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An Example of a Report Error

At times, you may create a report, that seems logically sorted, filtered, and
formatted, but may give you an error message when you attempt to print it.

When you create and save a report, Bar|Scan does not check if it is logical.  This
process takes place when you begin the print process, and Bar|Scan begins the
gathering and comparing of information.  Below we have illustrated a type of
message that you may receive when you have saved a report, and are attempting
to print it.  

This message can be caused by a couple of things.  The message is there to let you
know that Bar|Scan cannot do what you have specified.  The information that you
asked for when you created it, and the query of information needed to meet your
criteria do not match.

You may have specified a filter that asks for a Numeric field, and specified a
value with alpha characters, when typing in your data rather than using a look up
value.  Or, you may have specified a particular Field and then not entered a value
at all, so the value would be listed as blank.  Bar|Scan will allow you to save both
of these reports, because it doesn’t check for the report to be valid until you select 
print.  
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CHANGING A REPORT

From time to time you will want to change, correct, or add information associated
with a report currently existing in the Bar|Scan system.

Bar|Scan will permit you to make a change to the Report Name also.  This is
useful to alphabetize the reports.

From the Browse Tab, select the report by clicking on it, or use the cursor
movement keys to move the highlight bar to the desired report and press ENTER. 
Then select the Edit tab.

You may now change any of the information related to the selected report.

Remember that System Reports cannot be changed.  However, you can use them
as templates for any new reports which you create.  These reports can then be
changed.

After you have made your changes, click on the Save button in the tool bar or
press the Ctrl + S key combination to save the changed information.

DELETING A REPORT

This feature completely removes a report from the Bar|Scan system.  Obviously,
caution should be exercised when using this feature.

Removing reports from the system is most often done when a report has been
superseded or is no longer appropriate.

To delete a report, select it on the Browse tab.  Then, use the range feature to
highlight that report.  Care should be taken to ensure that this report is the only
report selected in your range.  Then, simply click on the Delete button on the tool
bar, or select delete from the Panel drop down menu.

You will be asked to confirm your choice.
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IMPORTING AND EXPORTING A REPORT

There are two ways to import and export a report using the Bar|Scan system.  One
way is to exchange reports from company to company within your  Bar|Scan
system.  The other is to exchange reports with other Bar|Scan systems, perhaps
within your own company, but not on your network.

Bar|Scan reports are really just computer instructions for Bar|Scan to use when
you print a report.  These instructions can be saved (exported) in a file which can
then be brought back in (imported) to the Bar|Scan System.  The file can contain
instructions for one or more individual reports.

If you have a multiple company system, transferring report formats between two
companies is as simple as opening both companies, highlighting the existing
report in the Report table, then going to the Main Menu, select File, then Export
. . . <,  to Company.  A window will appear, and you can browse to the company
that you want to send the report file to.

If you need to transfer a report format to another office that is not on your
network, you can access the Import and Export feature from the Main Menu, when
you have the Report table open.  From the Main Menu, select File, then Export 
. . . <, then Data Transfer File.  Select the name of your report, and export it as a
file that can be placed on a floppy disk.  

After receiving the report, the person needing the report would select File, then
Import . . . <, then Data Transfer File.  A window will appear for them to browse
to that particular report.

Please see Chapter 14 of this User Manual, Import and Export for more
information on this feature.
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Adjusting the Look of your Reports

Some of the time when you create a new report, you may have more information
selected than will fit on the page.  When this happens, you will see a message
similar to the one below.

If you have selected the print preview feature, you can view the report before
printing a hard copy.  By doing this, you can determine if making the widths of the
columns smaller will allow the report to fit onto the page, without eliminating
information.

If you feel that an adjustment to the widths of the columns is enough to allow the
rest of the information to fit onto the page, then, you can go to the columns tab of
this report.  Select the column that you wish to change the width of, and then
select the Properties button.  When it opens, there is a field that says Column
Width (inches).  You may type in a decimal figure to represent the width that you
would prefer, making the column wider, or thinner.

If you select the ‘Yes and Clean’ button then Bar|Scan will remove columns for
you until the report fits on the page.  A note is put in the report footer
documenting that this action was taken as shown in the example below:

Reminder: you can also change the title of the column on a report.  To change the
title of the column, click on the column you wish to change the title for, and click
on the Properties button.  You can now type in what you wish the title to print. 
A comma placed in this field will cause the next portion of the title to be printed
on a different line.
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CATALOG REPORTS

From the Main Menu, select File, then Open . . . <, then Reports . . . <, then
Catalog.  You will see a window that lists all of the Catalog reports that are in
your Company Asset Database.    

System Reports

System reports are those reports supplied to you as part of the Bar|Scan System. 
Bar|Scan provides three different types of System Catalog reports.  

The Bar Code Menu List provides you with a current list of different Catalog
items which are printed in order of Catalog Type.  It is the best way to
demonstrate Bar|Scan's ability to print bar codes on your printer, and they can be
used as part of the inventory process.

The Catalog List feature permits you to print a report containing the items
currently in the Catalog table, with no bar codes.  You can print a report
containing one, a group, or all Catalog items.  You can select this report in order
either by Catalog number, or by Catalog Type.

Catalog Sheets are provided to record the information for a single Catalog item. 
The sheet also provides space for a photograph or image of the item.  You can
select Catalog Sheets in order either by Catalog number, or by Catalog Type.

You require both a printer and the Imaging Module in order to print images stored
on your computer. 

The New Catalog Data Collection Sheets provide you with a form to assist in the
collection of new Catalogs for entry into the Catalog File.
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TRANSACTION REPORTS

After information is transferred from the Mobile Device into the Bar|Scan system
it stays in a Transaction table until it is validated for accuracy.  Bar|Scan does
extensive error checking on this information before it is accepted into the system.

The system reports produced by the Transaction Report feature provide both an
audit trail and a list of errors that can be corrected before the information is
entered into the Asset table.

Unless checked OFF on the Company Settings Screen, this report MUST be run
and validation MUST be accomplished, and the items MUST be marked as
printed BEFORE the information can be moved into the Asset table.

From the Main Menu, select Bar Code Transaction as the type of reports that you
wish to access.  Select the report that you would like to access from the Browse
panel, and then select the Edit tab.

If you print one of the System Bar Code Transaction reports, you will be asked if
you want to mark all of the Transactions as printed.   Answer N(o) ONLY if you
are reprinting the Transactions and you are certain no new transactions have been
added, and no changes have been made, since the last time the Transactions were
printed.

After you respond Y(es) to the above question, the Bar|Scan system will process
the information, and mark all of the transactions as printed.  During this process,
messages will be displayed to inform you of the progress of the processing.

Remember: Unless you disabled this feature, transaction reports MUST be printed
and validation MUST be accomplished, and the Transactions MUST be marked
as printed BEFORE the transaction information can be moved into the Asset
table.
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LOCATION REPORTS

After you have entered your organizations into the Organization table, or have
decided to not use them, and have entered the locations into Bar|Scan, it is easy
to print your location reports.  You will use the directions at the beginning of the
chapter to set up the report screens.  After you have these screens set so that your
report will print the way you want it to, then you need to tell Bar|Scan what to
print.

Hint:  Location Reports are not needed to do your inventory if you used the
Room Tag feature of Bar|Scan and have already applied Room Tag labels to your
locations and have previously associated the labels to locations by using the
Mobile Device, or by entering the Room tag numbers into the Location table. 
They are also not needed if your download all of your locations into your Mobile
Device. 

From the Main Menu, select Location as the type of reports that you wish to
access.  Select the report that you would like to access on the Browse panel, and
then select the Edit tab.  

You can look over the information on what is to print to make sure it is correct,
and if it is, you can select Yes to begin printing this location report.  If you answer
Yes, the Location Report will immediately be compiled and sent to your monitor
(if you selected preview), to the printer, or to a file.  If you answer No, you will
be returned to the Report selection window.

Remember, if you answer Yes, and you need to stop the report, you may press
ESC to stop the process.
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LOCATION HISTORY REPORTS

These reports are similar to Asset reports in that they can provide useful
information about the location history of the assets currently recorded in the
system.

These reports give a different perspective on your assets and are especially useful
to report on turnover or movement.

Basically, use these types of reports to ask questions like “what has moved in or
out of a location?”.  For example, what assets have been returned to my repair
location or what assets have been shipped from my warehouse?

Remember that just like an Asset report, these reports can be defined to report
changes for a particular time period by using the Filter feature.  For example, what
assets arrived at my receiving area during the month of January?

ORGANIZATION REPORTS

After you have entered your organizations into Bar|Scan, you may print 
Organization reports.  You will use the directions at the beginning of the chapter
to “set up” the report screens.  After you have these screens set so that your report
will print the way you want it to, then you need to tell Bar|Scan what to print.

Hint: Organization reports are not necessary to do an inventory since organization
items can be included in the Location Report or downloaded into your Mobile
Device.

From the Main Menu, select Organization as the type of reports that you wish to
access.  Select the report that you would like to access on the Browse panel, and
then select the Edit panel.  You can look over the information on what is to print
to make sure it is correct, and it is you can select Yes to go ahead and print this
Organization report.  If you answer Yes, the Organization Report will immediately
be compiled and sent to the printer.  If you answer No, you will be returned to the
Report selection window.

Remember, if you answer Yes, and you need to stop the report, you may press
ESC to stop the process.
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PERSONNEL REPORTS

After you have entered your personnel into Bar|Scan, you may print Personnel
report screens.  After you have these screens set so that your report will print the
way you want it to, then you need to tell Bar|Scan what to print.

Hint: Personnel reports are not necessary to do an inventory since a list of names
can be  downloaded into your Mobile Device.

From the Main Menu, select Organization then Personnel as the type of reports
that you wish to access.  Select the report that you would like to access on the
Browse panel, and then select the Edit panel.  You can look over the information
on what is to print to make sure it is correct, and it is you can select Yes to go
ahead and print this Personnel report.  If you answer Yes, the Personnel Report
will immediately be compiled and sent to the printer.  If you answer No, you will
be returned to the Report selection window.

Remember, if you answer Yes, and you need to stop the report, you may press
ESC to stop the process.
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WORK ORDER REPORTS

The Work Order reports provide you with a high level of control over your list of
assets.  Work Orders work in conjunction with  the Mobile Device to allow you
to control both the movement of assets, as well their inventory status.

Reports can provide information on pending, active, completed, and late Work
Orders.  They can be printed in any order including Priority, Crew Assignment,
Due Date, and Work Order Number.

You can have custom, or specially formatted Work Orders printed.  Several have
been provided with Bar|Scan.  These are saved as formatted files in the Reports
folder.

Important: In order to get maximum utilization from the Work Order reports,
you must have the Work Order Module.  You must also tag your assets and build
your asset file prior to implementation of work orders.  It would be difficult to
receive and process orders for assets if they were not yet in your asset file.  The
original entry of new assets into the system is usually accomplished using the
Mobile Device.

COMPONENT REPORTS

Component Reports typically require columns from more than one Table.  Below
are the relevant Tables to choose from in the Bar|Scan Pick Fields List.

Asset Component - This is a mandatory column required to link the Parent asset
to the component.  You will need to select the Asset Number from this table in all
reports.  You can set the column properties so that the Asset Number does not
print.

Asset Component Asset - This Table contains all of the Asset Information of the
component.  It is the same type of information that the parent has, e.g. serial
number, owner name, etc.
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Asset Component Catalog - This Table contains all of the Catalog Information of
the component.  It is the same type of information that the parent has, e.g. type,
description, manufacturer, etc.  

Asset Component Location History - This Table contains all of the Location
History Information of the component.  It is the same type of information that the
parent has, e.g. current building, prior building, etc. 

Asset Component Organization - This Table contains all of the organization
Information of the component.  It is the same type of information that the parent
has, e.g. org code, division, etc.

All of the above Tables are related to the Asset Bill of Materials.  The next two
tables are related to the Catalog Components as shown on the following example.

Catalog Component - This is a mandatory column required to link the Parent
Catalog to the component.  You will need to select the Catalog (XX9999) from
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this table in all reports.  You can set the column properties so that the Catalog 
does not print.

Catalog Component Catalog - This Table contains all of the Catalog Information
of the component.  It is the same type of information that the parent has, e.g. type,
description, manufacturer, etc.

All of the above Tables are related to the Catalog Components.  The next two
tables are related to the Reserved Bill of Materials as shown on the following
example.

Reserved Bill of Materials - This Table contains all of the Reserved Bill of
Materials items other than the Line Items, e.g. Purchase Order #, Requesting
Organization, Date Completed, etc.

Reserved Bill of Materials Line Item - This Table contains all of the information
in the Line Items, e.g. Asset #, # Requested, etc.
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MISCELLANEOUS REPORTS

This category holds any reports that do not fall into the other categories.  These
may include the list of valid conditions, Manufacturers, Attributes, etc.

ALL REPORTS

This option allows you to access any and all of the different reports that are
contained in your Company Asset Database.

Although no examples are provided as System Reports, you can create a report on
any Table in Bar|Scan, even the User Table.  Reporting on Bar|Scan Tables is
controlled in the Table Properties Table.  For more information on how to make
Tables available for reporting, see Chapter 4 - System Overview.
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PRINTING BAR CODE LABELS

Custom Designed Labels

Answer:  Yes, you can design your own label. A sample label is included in the
Bar|Scan System reports. The Report name is “{System} Sample Labels”. You
can access the report designer by placing three exclamations in the beginning of
the “Optional Format File” field like this !!!. You will still need to include the
format file name. When you then select the Preview Button, the report designer
will be displayed similar to the example below:
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You must save the format file during or upon completion of any edits that you
make in the report designer.  To do this press File then Save As which is shown
in the following example:

You should navigate to the barscanw\report folder to save the format file.

While we cannot cover all the features of the report generator, basic functions
include the ability to add or remove individual fields, move fields, justification
within the field, stretch or shrinking the field areas and so forth.

This feature is for more advanced users with some layout experience in other
applications. You can also contact your Bar|Scan Dealer if you would like them
to create a label for you.
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Avery Label Stock

Bar|Scan’s report generator has a label generating function built-in. However, you
may wish to invest in better quality pre-printed labels for durability and
readability. A sample system report can be found by opening the All Reports Icon.

Bar|Scan is preloaded with the specifications for many popular Avery labels. An
Avery label is selected by specifying the following in the Optional Format File
text box of a report:

LABELS:AVERY XXXX

Where XXXX is the specification of the Avery label that you desire.

Since labels have very little space for printing, a report normally consists of only
one or two fields and you must also pay attention to your default font size.  Note
that the designator LABELS is followed by a colon, then the word AVERY. There
are no spaces until after the word AVERY, then a space separates it from the label
number that you want. The following is a complete list of the Avery labels that
Bar|Scan will recognize: 4143, 4144, 4145, 4146, 4160, 4161, 4162, 4163, 4166,
4167, 4168, 4169, 4240, 4241, 4249, 4250, 4251, 4253, 4254, 4255, 4256, 4257,
4258, 4259, 4266, 5095, 5096, 5097, 5160, 5161, 5162, 5163, 5164, 5165, 5167,
5196, 5197, 5198, 5199-F, 5199-S, 5260, 5261, 5262, 5266, 5267, 5383, 5384,
5385, 5386, 5388, 5389, 5395, 5660, 5662, 5663, 5883, AVERY 5895, 5896,
5897, EAL 04, L7160, L7161, L7162, L7163, L7164, L7165, L7166, L7167,
L7562, L7563, OML 101, OML 102, OML 103, OML 104, OML 105, OML 202,
OML 203, TAB1 102.36, TAB1 107.23, TAB1 107.36, TAB1 107.49, TAB1
89.23, TAB1 89.36, TAB2 107.23, TAB2 107.36, TAB2 89.23, TAB2 89.36 
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You can also use Bar|Scan to mailmerge Avery type labels.  There are several
ways to create Avery labels. Here is just one of them. Try the following steps:

1.) Using Bar|Scan, create a report with one or more columns, the columns you
wish to place on the Avery Label. 

2.) On the print tab select File as the destination. and on the File Format box,
Select Delimited as your format. Unless you specify a unique file name, the file
is barscan.txt and is located in your barscanw folder. 

3.) Close Bar|Scan and open Microsoft Word or any other word processor that has
mail merge capability.

4.) If you use Microsoft Word, you can now use the Word mailing labels feature
with mail merge to create the labels you wish. Begin by selecting Tools . . . < Mail
Merge from the Word main menu. Then select create "mailing labels". Then select
Get Data. When Word asks for the data source, use the delimited file you created
in step 2 above. Several standard Avery label sizes are supported. Word's mail
merge helper can step you though the process if you need help. Remember that
you also need to format your bar codes correctly, see "how to create barcode
menus" on this page.

If you plan on producing a large number of labels or would like Bar|Scan to
produce labels directly on a regular basis, your Bar|Scan Dealer can design a
custom Format File for you.  Most Format Files can be designed in only a few
hours.
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THE BAR|SCAN® MOBILE©

The following are instructions for the Bar|Scan® Mobile© for the Android
Operating System.  The Bar|Scan Program Version is 1.0.0 or greater.  The
hardware includes but is not limited to: Zebra Technologies EC50, MC3200,
Nautiz X6, and your smart phones and tablets.

Bar|Scan Mobile is compatible with Android version 9 (pie) and newer.  The
application may run on older Android versions, but it is not supported.

Your Android hardware may have certain features or manufacturers specific
qualities that may make the application incompatible with your device.  Therefore,
you may wish to install the application for testing prior to activating your Bar|Scan
Mobile subscription.

Talk to your IT department. This step is often skipped, and that’s a mistake. Get
them on board to ensure you have the right Wi-Fi networking and security policies
in place.

Determine your acceptable use policy for the device, especially around
photographs, social media and device security. There’s a good chance you already
have one and need to review and tweak it for the new use case.

INTRODUCTION 

Android based mobile computers are portable, PDA format computers that are
using versions of the Android operating system and typically require an imager,
scan engine or camera that scans or decodes bar coded information, Wi-Fi,
Cellular, or USB connectivity to permit bidirectional communications with
Bar|Scan on the PC host is also required.

There is a set of videos on our website that can provide you with additional
information for operating Bar|Scan.  These are titled ‘Quickstart Overview
Videos’ and can be found on this page: https://www.barscan.com/support-videos

Please consider viewing or downloading these as part of your learning experience.
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Installing Bar|Scan Mobile

The android mobile application (APK) can
be obtained from Bar|Scan, Inc. or your
Bar|Scan Dealer.  Copy the application to
your device’s download folder or desktop
then click to install.

If you receive any  security warning  that
your device, smart phone or tablet is not
allowed to install the Bar|Scan application
or “unknown applications from this
source” then open your device’s Settings
Screen and select the ‘allow the app
installation’.  Depending on your version
of Android, the steps may vary.

Typically this is done by selecting your
Settings Icon.  Tap the search icon within
this screen.  Type  “Unknown” into the
search.  When found, select ‘Install
Unknown Apps’.  Then select or use the
slide bar to turn on ‘Install unknown Apps’. 

You will now see a screen similar to the
one at the right top.

Click on Install and a screen similar to  one
at the bottom right will appear.
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Licensing the Bar|Scan Mobile

Once installed, Bar|Scan® Mobile© can be used immediately with sample data that
is included.  The sample data is correlated with the sample BarScan database on
the desktop called DEMOCO and is discussed in the Bar|Scan User Manual
Chapter 19 - Training With Demo Database. 

If the device was not supplied by us, we recommend that you test the application
prior to performing a real inventory.  Make sure to test the barcode capture, using
your camera or imager to make sure that it functions and can read a barcode.  If
you have assets with two dimensional (2D) barcodes, please do a capture test on
these also.

Because of the number of
different Android operating
systems and platforms, we
cannot guarantee compatibility
with all hardware.

The only function that the
unlicensed Bar|Scan® Mobile©

cannot do is synchronize with
t h e  B a r | S c a n  d e s k t o p
application.  For this you will
need to obtain a subscription
from us.

Once you have completed your
testing and are ready to license
the application, select Tools
from the About menu then the
LEGAL tab as shown at the
right:
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Select ‘REQUEST NEW OR UPDATED BARSCAN LICENSE’ a the bottom of
the LEGAL Panel.  The application will create an email using your installed email
application.

You will need to complete the section highlighted below in the email before
sending the email.

Your device will show you a message if no email application is installed or the
email application is not setup.  Install your email application and try again.
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Bar|Scan, Inc. will reply to your request via email with a permanent unique device
license file (file extension .rdi) for you to copy to your desktop BarScan (
\barscanw\sysdbf\ folder).  Once completed, start BarScan on your desktop and
use the Synchronization feature with the device’s BarScan Mobile application and
it will be recognized as a fully functional active device.

Wi-Fi Capability

Most devices, smart phones and tablets are Wi-Fi  capable, meaning that they that
have a built-in form of wireless local area networking (WLAN) based on the IEEE
802.11 specifications.

The Wi-Fi technology is independent of the Bar|Scan Mobile.  As long as the
network and hardware are in place and operable, Bar|Scan can send and receive
information between the device and the Bar|Scan database residing on the host
server or host PC.  If you use Wi-Fi, we suggest that setup an instance of Bar|Scan
on your server utilizing our Scripting Feature to automatically launch Bar|Scan
and have it ready to synchronize.

Cellular Capability

Typically, you would use your Wi-Fi connection to synchronize your phone or
tablet with your BarScan database.  When there is no Wi-Fi connection available,
you can use your cellular service to synchronize.

Keep in mind that you do not require an ‘always on’ Wi-Fi connection since you
have downloaded your asset and pop-up information into your device.  So,
connecting via Wi-Fi or cellular service is only necessary when you need to
synchronize.

There is a setup process that is required before you can begin.  You will need to
setup a Virtual Private Network (VPN).  Next, you will add the network to you
phone or tablet in settings (Settings-> Network-> VPN).  Once completed, you
will be able to synchronize the device.  Note that many business already have a
VPN enabled so do check with your IT Staff prior to setting up your connection.
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USING BAR|SCAN MOBILE

If you have ever used an Android phone, you are probably familiar with the basic
features of a device, smart phone or tablet.  If you have never used one before, you
should refer to the product reference guide that came with your device.  Items
such as power and memory management, and using other pre-installed
applications are not covered in this Chapter.  This chapter will concentrate on the
Bar|Scan Mobile software.

You should know how to turn the device on, charge or change the battery, and any
other actions related to setting up the device, i.e., calibrate the screen, set the time
and date (if not automated), connect to your Wi-Fi network or it’s cradle or USB
cable.  If you feel uncertain about any of these features, please refer to the
manufacturer’s product reference guide that came with the device.

Your device accepts information “hand entered” by the user as well as information
captured by it’s camera or scanned with it’s laser scanner.

Turn the device on by pressing the power button and select the BarScan Mobile
application.

When selecting the scan icon (shown at right) in the
application’s TAG or TAKE screen, hold the unit at a distance
that brings the bar code into focus, ensuring that the camera or
scan beam covers the entire bar code.  Depending on the model
of your device, a sound may indicate a successful scan.

Your device is initially used very extensively to tag all of your company's assets. 
After this initial activity, the device will be used to both “Tag” assets as they are
acquired, and to “Take” your company's periodic asset inventory when the
inventory needs to be updated.  The device will hold information for thousands
of items.

You can synchronize and download a significant portion of your Bar|Scan
inventory data into the device.  How much you download is dependent on the new
information that you wish to collect, the memory and processor speed of the
device, and the wait time needed to display the information that you require to
perform your inventory.
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A user can create configurations for the inventory process at any point on the PC
portion of Bar|Scan. These configurations are then downloaded into the device
when the desktop and device synchronize.  In addition the user can download
various Bar|Scan Tables such as Asset, Catalog, Organization, Location and
Owner Names into the device.  This means that Bar|Scan bar code menus do not
need to be printed for these items except when the menus are more convenient.

When using Bar|Scan, the windows you see on the screen of the device are
collectively called “Dialogs”.  The very top of the Dialog is called a Menu bar. 
The Menu Bar will display the title of the Dialog; such as “Inventory-Tag”.

Battery Life

If your device’s battery is draining quickly, try adjusting the power.  There are
several settings that can be adjusted to help conserve power. The general ideas
are: lower screen brightness and turn off settings like NFC, Bluetooth® and Wi-Fi
when not in use.

These adjustments are all done from the Android settings and are documented in
the manufacturer’s reference manual.

No Bar|Scan Data Loss Due to Loss of Power

For the device models referenced on page one of this Chapter, if your device loses
power, both your Bar|Scan application program and the data that you collect are
permanently saved.  

Once you charge or change the battery, Bar|Scan Mobile will continue working
normally with one possible exception.  In the case of some smart phones or
tablets, if the device does not have access to cell or data service, it’s clock may not
be reset.  In this case, you will want to set the clock manually before using
BarScan Mobile. 

For the devices not referenced on page one of this Chapter, the ability to save your
data  is a function of the device itself, what kind of memory is installed, and the
user backup plan.
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CONFIGURE

Bar|Scan Mobile is specifically prepared (configured) to prompt you for certain
information about each asset.  When you use Bar|Scan to inventory an asset, the
data that you will collect can be customized to meet your company’s
requirements.  Most often you will be collecting the location possibly including
the organization, or department information, and personnel for the asset.  You will
collect a Catalog Category and Number (the assets description), the Asset
Number, and then any other data that may be pertinent for that asset, i.e., serial
number, and perhaps a comment about that item.

More often than not, you will want to change the prompts that are turned on by
default.  You can change the items that you will be prompted for by creating a
new configuration in your Bar|Scan desktop program.

If this is the first time you are using the Bar|Scan program, you will need to review
the default Device Configuration on the desktop portion of Bar|Scan.

Start Bar|Scan on your PC workstation.  From the Main Menu of Bar|Scan select
File -< Open -< Handheld Computer -< Configurations.
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Select the “{SYSTEM} ANDROID MOBILE” configuration.

When you select the Edit Tab on Configure, you will see a screen similar to the
following:

We strongly recommend you use the Add Template feature to create a new
configuration from any System Configuration and not change the system
configuration.

Note that there are five tabs on the Edit Screen.  They are labeled Tag, Take,
Custom Pop-ups, General and Work Orders.  Each section can be independently
edited to customized the prompts for each type of inventory.
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There is also a section at the top of the screen which contains your TCP
Communications settings (discussed earlier).  The device uses only the TCP
Upload Method and not serial port settings.  Therefore you use either Wi-Fi or can
plug the device into any available USB port.

It is not necessary to tell Bar|Scan where the cradle or cable is plugged in. 
Bar|Scan will automatically locate the device.

Important: You can create and save multiple configurations for each of your
devices and/or Company databases.  In this way, each device can contain a
different configuration and a different set of downloaded information from various
Bar|Scan Tables such as your Location, Catalog or Asset Table.  Note that the
device can contain only one Configuration at a time.

Default Prompts

The following items are selected for a Tag by default: Inventory Initials, Room
Tag, Region, Building, Floor, Room, Organization Code, Accessible (Y/N), Asset
#, Catalog, Serial #, Status, Condition, Purchase Order #, Name, and Inventory
Comments.

The following items are selected for a Take by default: Inventory Initials,  Room
Tag, Organization Code, Accessible (Y/N), Room Tag, Asset #, Status, Condition, 
Name, and Inventory Comments.

Note: Bar|Scan Mobile was designed with the intent that the user would most
likely be using a “Site” location type.  If you are doing an inventory that is to use
a Vault or a Pallet type of location, make sure that you change your configuration
to download the appropriate prompts.
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Configuring Tag

Tag and Take are each configured independently.  Let’s start by concentrating on
configuring the Tag function as seen in this area of the Configuration screen:

The Bar|Scan fields in the list are the questions that will be prompted for by the
device. In this example, the device will begin by asking for the Inventory Initials,
the Current Region, Current Building, etc.

The order that the prompts are shown is also the order in which the device will
prompt.  You can change the order of the prompts by dragging the individual
prompts up and down in the list.

There are also five buttons below the list: Add, Cycle, Delete, Properties, and
Copy Prompts.  Let us discuss these now.
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Add

If you click on the Add button, a Look up window similar to the one below will
appear.

You may select one of the prompts by using the mouse, or by moving the
highlight bar to the desired item and pressing ENTER, or by clicking on the ADD
button.  The <shift> and <Control> keys can be used to add multiple prompts.

Cycle

Once you save an asset, the Bar|Scan program in your device can be configured
to cycle back to any prompt during your physical inventory.  Most users will want
to cycle back to Catalog in “Tag” mode and cycle back to Asset # in “Take” mode. 
However, this can be changed.  For example, you may not wish to cycle back to
Catalog if all items in your inventory have the same description.  In this case you
will want to cycle back to Asset #.  Another example, if you have only one asset
per location, you may want to cycle back to Room Tag. 

If you click on the Cycle button, window similar to the one below will appear.
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The cycle icon will be placed in front of the prompt where the device will cycle
back to.  You can change the cycle point by selecting another prompt and pressing
the cycle button.

Delete

Delete will remove any prompt that is highlighted.  There is no confirmation.

Properties

If you click on the Properties button, a box similar to the one below will appear.

You may turn the first three items on and off by clicking on the appropriate
checkbox.

You can instruct the device that a blank response or “blank field” is ok.  For
example, in the above box, the “blank field” is not checked which means the
Asset Number prompt requires a response.
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You can also accept “Partial fields”.  For example, in the box, the Asset Number
is set to 0 (autocalculate).  This means that the device will only accept a bar code
if it is the length specified on your Company Settings screen.  If you check “Must
have something (1 or more characters)”, then the device will accept any length of
Asset Number up to the length specified on your Company Settings screen.

The opposite of “Must have something (1 or more characters)” is “Must fill Entire
field”.  Checking this box means that the device requires the entire field to be
completed.  In the above box, the Asset Number requires a response of exactly the
number of characters specified on your Company Settings screen.

Source of Default Value

There are two choices for a default value as the response to a prompt. You can
enter a default value on this screen which will be used in the device or you can
keep the value from the prior asset entered.

Default Value

You can enter a default value to appear in the device.  For example, if you would
like to have a default response for the Name prompt of “UNASSIGNED”, type it
in here.

There is a special case “NOW” and ‘TODAY’ which will input the current date
a n d  t i m e ,
depending upon
the type of field.  If
the field is a date
field, these will
insert today’s date
as the default.  If
the field is a time
field, it inserts the
time.  Of course,
NOW looks better
with a time field
and TODAY looks
better with a date.
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Advanced Validation (not available in Android devices)

This feature allows a list of different validations for a single field based on the
value of a field in the field list.  Because Advanced Validation is a feature that
will not be used in most configurations, it is discussed in detail at the end of this
section (before the Mobile section).

Field Prompt (Change the Name of a Prompt)

You can change the name of a prompt that appears in the device.  For example,
if your inventory personnel are used to calling the Asset Number a bar code, you
could change the words ‘Asset Number’ to say ‘Bar Code’.  

Simply type in the new name into the Field Prompt.  For example, if you wanted
to change the System # prompt to say Old Inv. #, simply highlight the System #
prompt in the list and select Properties.  Then type “Old Inv. #” into the Field
Prompt. 

Note: changing the name of the prompt will not change the properties of the
prompt, it will only change the name that appears for that prompt on the device
during a Tag or Take.  It also does not change the name in the Bar|Scan program
on your Personal Computer.  This can be changed by using the User Defined
Fields (UDF) Module on the PC.

Field Name Override

You can select a Field Name Override, a feature for advanced users.  If you
understand SQL, this may be a feature that you would want to use.  You can use
this feature to make a special type of data entry function such as combining two
fields.

Field Width

This is where you can change the maximum width of a  response that will be
accepted in the device.  If you enter “0” (zero), the maximum width is determined
by Bar|Scan according to the length set in the PC portion of the Bar|Scan database.

The field width of the field can be changed by using the User Defined Fields
(UDF) Module on the PC.
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Expression if AutoCalculating

This field contains the Bar|Scan field that will be used to Autocalculate the Field
Width.  Do not change this information unless you are an advanced user.  For
advanced users: you can modify the result of the entered information such as
trimming or formatting the entered information.

Replace and With

These two fields are used together to change the bar code information after it has
been captured.  For example, this is useful for removing Check Digits from the
scan.  You can right click to choose a number of formatting functions that are
available as in the example below.

Signature (not available in Android devices)

There are four signature options.  The default is ‘No Signature’.  By making
another selection, you can incorporate a signature with any prompt.  For example,
you can obtain a signature for a Purchase Order, User Name or for a comment.

Copy Prompts to Take

Once you have completed the “Tag” tab, you might want to use your work as the
basis of your “Take” tab.   Press this button to copy your configuration to the Take
tab.  After this is completed, you will most likely want to edit the Take Tab as
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normally there will not be the need to collect the same number of fields.  For
example, the Catalog and Serial Number are usually not collected in the device
during the Take mode.

Configuring Take

Tag and Take are each configured independently.  Now that we went through the
process of configuring the Tag function we can proceed to the Take function as
seen in this area of the screen:

The Bar|Scan fields in the list will be prompted for by the device.  In the above
example, the device will begin by asking for the Inventory Initials, the Current
Room Tag, etc.

The function buttons on this screen are identical to those discuss in the previous
section on Tag.  Just repeat the process for Take

Normally there will not be the need to collect the same number of fields.  For
example, the Catalog and Serial Number are usually not collected in the device
during the Take mode.
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A note about Company Code Prompt

If you are using a Single Company Database, you will not need this feature.  If you
are using two or more Company Databases, and are running two or more
inventories concurrently, you may use this feature to designate which Company
the inventory information is for by entering a Company ID here, up to seven
digits.  For more information on this feature, refer to Chapter 17 in the Bar|Scan
User Manual - Multiple Database.

A note about Location Fields Type

The prompts for locations in the device will be different according to which type
of location you choose.  The type of location most widely used will be the Site
location.  You must keep your location field selection to the following choices:
Current Region, Current Building, Current Floor, Current Room, and/or Current
Room Tag.

The following is a list of the prompts that can be used if you choose the Pallet
type of Location: Building, Row, Bay, Slot, and Level.

The following is a list of the prompts that can be used if you choose the Vault
type of Location: Building, Vault, Row, Bay, and Level.

Note: Do not mix location types in your prompts.  The Bar|Scan program was
designed with the intent that the user would most likely be using a “Site” location
type.

Region

Region is a two digit field that denotes a given area for the inventory site, i.e.,  the
abbreviation for the state.  This field can be filled in by selecting the response
from a pop-up list that was downloaded from the PC during the last
synchronization, cappturing the information from a menu with the device, or by
hand entering the information using the stylus and keyboard.  Remember that if
2 digits is not enough for your needs, all fields can be stretched using the  Key
Fields tab in the Company Settings Screen or by using the UDF module.

Finally, any location field is optional.  If you do not require the use of the Region
field, then you do not need to add it to the prompts.
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Building

This field allows you to enter a building description for this asset (a maximum of
5 characters), most often a name or the address number.  This field can be filled
in by selecting the response from a pop-up list that was downloaded from the PC
during the last synchronization, capturing the information from a menu with the
device, or by hand entering the information using the stylus and keyboard.

Floor

This prompt permits you to enter the floor number for this asset (a maximum of
5 characters).  We suggest that floors one through nine be entered with a leading
zero so that the information will sort correctly, i.e., floor is 01, or 02.  This field
can be filled in by selecting the response from a pop-up list that was downloaded
from the PC during the last synchronization, capturing the information from a
menu with the device, or by hand entering the information using the stylus and
keyboard.

Organization Code

This prompt permits you to enter a code up to six characters or numbers in length
to signify departmental information for an asset.  This field can be filled in by
selecting the response from a pop-up list that was downloaded from the PC during
the last synchronization, capturing the information from a menu with the device,
or by hand entering the information using the stylus and keyboard.

Room 

This prompt permits you to enter up to six digits in length to specify a room or
area for an asset.  This field can be filled in by selecting the response from a pop-
up list that was downloaded from the PC during the last synchronization,
capturing the information from a menu with the device, or by hand entering the
information using the stylus and keyboard.

Pallet and Vault Location Types

If you are using Pallet or Vault Locations, you will probably have your warehouse
or storage space set up with Room Tags.  You would only prompt for Room Tag
and use the other location prompts only in the Pop-ups for reference purposes.
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The following is a list of the prompts that will be different if you choose the Pallet
type of Location:  Building, Row, Bay, Slot, and Level.  The following is a list of
the prompts that will be different if you choose the Vault type of Location: 
Building, Vault, Row, Bay, and Level.  The additional location prompts for Vault
and Pallet types are: Vault, Row, Bay, Slot, Level.

Accessible (Y/N)

This field permits you to enter information in the device to indicate if a room
could be entered for inventory purposes, or not.  If the room was occupied or
locked, for instance, a user could select “No” at the Accessible prompt.

After you select “No”, you will proceed to the next location.  The device will
upload a record indicating that the space was not Accessible.  This list can then
be printed or synchronized back into the device for a subsequent inventory.

Usually you would never use this prompt in a warehouse inventory as locations
are always Accessible.  

Note: If you turn this prompt off, the system will automatically assume and mark
all of the Transactions to be accessible.

Room Tag

This screen permits you to enter the bar code tag number for this room or area. 
You should be able to capture the Room Tag or select it from a pop-up, although
it is possible to hand enter the information using the stylus and the keyboard.

Prior Locations and Inventories Using Quantities

The device allows you to document both a Prior Location, as well as a Current
Location for your assets.  There are two sample configurations showing this
feature.  They are titled:

{SYSTEM} CONSUMABLES USING CATALOG 
{SYSTEM} CONSUMABLES USING UPC   

You do not need to use the Prior Location fields when doing a Tag or Take,
except when doing a quantity “Z number” type of inventory.  
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You need to configure the device to prompt you for the following information in
order to do a TAG inventory using Quantities:

• A Current Location for the assets. This can be as simple or as detailed as
you like, but remember it has to be a valid location, entered into the
Location table.  Remember, this can be just a Room Tag.

• A Catalog Category and Number (XX9999)
• A Quantity of Assets (the number of items that are being inventoried)

For example, I need to inventory 7 connectors in my building at 123 Main Street,
Anywhere, CA.  I enter the Catalog information, as Catalog SY1001.  The
information entered into the device for this TAG with Quantities:  Region = CA,
Building = 123, Floor = 01, Room = 102, (or Room Tag), Catalog Category and
Number = SY1001, Quantity = 7.  

If I do a Take to move three of the above connectors to a new location, I would
need to enter the location I am moving them from, the location I am moving them
to, the Catalog Category and Number, and the Quantity of Assets.  So, for a Take
using Quantities, I would need to configure the device for the following prompts:

• A Current Location for the Assets (the location I want the items to move
to).  Remember, you can use just a Room Tag if desired.

• A Prior Location for the Assets (the location the items are moving from). 
Remember, you can use just a Room Tag.

• A Catalog Category and Number (XX9999)
• A Quantity of Assets (the number of assets that are moving)

Following our earlier example, and moving three of the connectors to room 102A,
I would enter into the device:  Region = CA, Building = 123, Floor = 01, Room
= 102A, Prior Region = CA, Prior Building = 123, Prior Floor = 01, Prior Room
= 102, Catalog Category and Number = SY1001, Quantity = 3.

Once all of the information is in the Asset table, my inventory would show that
I had seven connectors in room 102, and that three of them moved to room 102A.
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Notice a couple of differences when performing an inventory using quantities:

1.  You DO NOT enter an Asset Number!  This information is provided by the
Bar|Scan software once the items have been uploaded.  The Asset Number will
appear as a number that begins with the letter Z.  The first of its kind for a
database that uses six digit Asset Numbers would be Z00001.  By not entering an
Asset Number, you are forcing Bar|Scan to keep the numbers straight for you, and
you never have to worry about what Asset Number it uses, you only have to keep
track of the locations the assets move from, locations the assets move to, the
Catalog Number (XX9999), and the number of assets that move.

2.  You enter a Prior Location as well as a Current Location for all Takes. 
When you deal with large quantities, and a few of the items move, it is a hassle
to keep track of how many are left.  By entering a Prior Location as well as a
Current Location (along with the Catalog Number and Quantity that move) you
make Bar|Scan subtract how many items have moved from the current number of
items in that location.  Therefore, if you have 1,243 items in room one, and move
15 of them to room two, you don’t have to count or know how many are still in
room one.  Bar|Scan will subtract the number of items from its total, and display
how many are still in room one, as well as how many now appear in room two.

The list of location items that you can select for Prior Location information is the
same as you can select for Current Locations.  Therefore, we are not limiting you,
or specifying which items you need to select.  Use the Prior Location items that
are specific for your inventory needs, i.e., if you use Site Locations, you need only
select Prior Region, Prior Building, Prior Floor, Prior Room, and possibly Prior
Room Tag.  If you use a Vault Type of Location, obviously your prompts would
be different to reflect the Vault specifics.  If you use more than one Location
Type, you may leave them all on, and select Prior Location Type to specify which
location fields that you want to use.

Your choices for Prior Location fields are:  Prior Location Type, Prior Region,
Prior Building, Prior Floor, Prior Room, Prior Vault, Prior Row, Prior Bay, Prior
Slot, Prior Level, Prior Room Tag.

3.  You must enter a Catalog Number even during the Take mode.
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Catalog

This field is required for a Tag, but normally not used on a Take.  This field must
be "exactly" 6 characters (2 alpha and 4 numeric).

Under exceptional circumstances such as validating existing Catalogs, you may
wish to turn Catalog on for a Take.  Also, the field width and formatting of the
field can be changed by using the User Defined Fields (UDF) Module on the PC.

Asset #

This prompt allows you to enter the asset number (a maximum of 80 characters). 
The asset number can be entered by capturing the appropriate bar code with the
scanner or camera, or it can be manually entered using the stylus or the keyboard.

During a Take, you can capture an existing asset number and have Bar|Scan show
you selected information about the Asset such as it’s Catalog information, last
assigned, owner name, last inventory date, last inventory location, etc.  This is
what we refer to as an Audit Scan.  The set up for the Audit Scan is discussed later
in this Chapter in Custom Pop-Ups.

Normally, you will want to capture actual bar code labels for the asset number. 
However, you can substitute serial numbers for asset numbers if you are doing an
IT exclusive database.  Keep in mind that in normal office environments, the
serial number is often difficult to reach.  This is not a problem in a warehouse or
distribution environment.

Note: you can configure your device to capture either the serial # or the asset #
and have either of these populate the other asset fields in your configuration.  In
other words, either number can be the primary field for your assets.

Quantity of Assets

When you configure the device to use the Quantity prompt, it will replace the
Asset Number prompt.  This type of inventory is most useful for consumable
inventories where asset tags are not applied.

Please see Quantity Inventories for more information on how to use this feature.
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Serial #

This field permits you to enter a Serial Number for this asset, (a maximum of 25
characters).  The Serial Number can be entered by entering numbers and letters
on the keyboard with the stylus, or by capturing an appropriate bar code with the
camera or scanner.  Normally, you would not have this information in a pop-up.

Note: you can configure your device to capture either the serial # or the asset #
and have either of these populate the other asset fields in your configuration.  In
other words, either number can be the primary field for your assets.

The field width of the field can be changed by using the User Defined Fields
(UDF) Module on the PC.

Status

This field has two-digit codes that are downloaded from the PC portion of
Bar|Scan into the program and are available on a pop-up list.  To access the pop-
up list simply click on the right-hand side of the screen, next to the word Status. 
You will be shown all of the choices that have been synchronized, and you can
simply select your choice from that list by tapping on it with the stylus.

You can change the two-digit codes to three or four-digit codes.  Actually you can
go up to a twenty-five digit code by accessing your Company Settings screen on
your PC.

Condition

This field has two-digit codes that are downloaded from the PC portion of
Bar|Scan into the program and are available on a pop-up list.  To access the pop-
up list simply click on the right-hand side of the screen, next to the word
Condition.  You will be shown all of the choices that have been synchronized, and
you can simply select your choice from that list by tapping on it with the stylus.

You can change the two-digit codes to three or four-digit codes.  Actually you can
go up to a twenty-five digit code by accessing your Company Settings screen on
your PC.
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Purchase Order #

This field will permit you to enter a Purchase Order number into it via the
keyboard and the stylus.  Normally, you will want to configure this field to  retain
the information until you change it, or until you change locations.  This is done
in the Field Properties Box and selecting “Keep value from prior asset entered”
as previously discussed.

Normally, you would not have this information in a pop-up.

The field width of the field can be changed by using the User Defined Fields
(UDF) Module on the PC.

Name

This field will permit you to enter a Current Owner or User Name into it via the
keyboard and the stylus or from a pop-up.  The name is also stored as part of the
information stored in the Asset’s Location History.

Normally, you will want to configure this field to  retain the information until you
change it, or until you change locations.  This is done in the Field Properties Box
and selecting “Keep value from prior asset entered” as previously discussed.

The field width of the field can be changed by using the User Defined Fields
(UDF) Module on the PC.  

The name is often used in conjunction with a signature (not available for
Android).

Telephone Number

This field will permit you to enter a Telephone number  via the keyboard and the
stylus or pop-up.

Normally, you will want to configure this field to  retain the information until you
change it, or until you change locations.  This is done in the Field Properties Box
and selecting “Keep value from prior asset entered” as previously discussed.
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The field width of the field can be changed by using the User Defined Fields
(UDF) Module on the PC.

 
Inventory Comments

This prompt allows you to enter a comment for this asset (a maximum of 12
characters).  The inventory comments are also stored as part of the information
stored in the Asset’s Location History.

Normally, you will want to configure this field to  retain the information until you
change it, or until you change locations.  This is done in the Field Properties Box
and selecting “Keep value from prior asset entered” as previously discussed.

The field width of the field can be changed by using the User Defined Fields
(UDF) Module on the PC.

Other fields

We have just covered the most commonly used fields for collecting asset
inventory information.  You can use many additional fields, either User Defined
Fields that you create or other fields that already exist.

As the User Definable name implies, you decide what that field should be called
and what type of field it is. 

For instance, if you would want to collect a Maintenance Code, you could use a
User Definable Field to collect this information.  You first create  the UDF in the
Transaction Table and when completed, add it to the Tag and Take lists.

Custom Pop-Ups

As described elsewhere in this manual it is you, the user, who decides what
prompts appear in the device screen, both for TAGS and TAKES. Data is entered
into each of them in one of three ways:

T capture a bar code label with the camera or scanner.
T 'type' the information using the soft keyboard (see "Using the Keyboard

Button"), or
T select a value from a pop-up or dialog.

Page 11-26 Bar|Scan



Chapter 11

Pop-ups are lists of values synchronized down from the PC, giving the user the
ability to select from a pre-configured list. This helps avoid typographic errors and
provides consistency in data.

Default Pop-ups

When creating the list of TAG and TAKE prompts that is to be loaded into the
device, Bar|Scan automatically creates pop-ups for the following fields:

T Catalog
T Room Tag (Current, Prior)
T Condition
T Status
T Organization Code
T Owner Name

In other words, if you include any of these fields in your TAG or TAKE lists, they
will automatically have pop-ups set for them...the user will be able to tap on the
data field, see a list of allowed values, then select one.

You many feel that the default pop-ups do not meet your requirements, e.g., you
may need a pop-up for a User Defined Field (UDF) or you do not want to force
the user to a limited set of values for one of the default prompts or the list of
columns in one of the pop-ups may be different than what is desired. Whatever the
reason, you have the option of turning off all default pop-ups and creating your
own set of custom pop-ups. Please note that it is one or the other. If you choose
custom pop-ups then all of the default pop-ups are turned off and you must create
ALL of the pop-ups that you want, even those that formerly appeared for the
default fields.

Setting up your Custom Pop-ups

The following instructions for setting up your custom pop-ups require that you be
at the 'Custom Pop-up' section of the Device Communications Parameters screen.
To do this, enter the following menu options on your PC.
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The Custom Pop-ups screen consists of two lists and a check mark: the Pop-up
Fields (on the left), the Pop-up Columns (on the right) and the 'Use the Custom
Pop-ups' checkmark above the left list.

Pop-up Fields

The Pop-up Fields on the left are the list of fields for which you want pop-up
responses. For example, if you enter an 'Organization Code' into the Pop-up Fields
then any 'Organization Code' appearing in the TAG list will have a pop-up. It is
the same for the TAKE list. Any 'Organization Code' appearing in the TAKE list
will have a pop-up.

What if 'Organization Code'
appears in only one of the TAG or
TAKE lists? What if it doesn't
appear at all? That's ok! Any Pop-
up field not used is simply ignored. 
This allows you to configure pop-
ups for many fields just once, then
use them for a variety of different
TAG and TAKE prompt lists.
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In addition to this, each pop-up field has an 'enabled' check mark next to it. By
default, any prompt added to the 'Pop-up Field' list is enabled when first added.
However, it can be disabled by highlighting the prompt then clicking on the
'Enable/Disable' button. If a field is disabled, it is as if the Pop-up Field doesn't
exist at all. For example, if the 'Organization Code' mentioned above is disabled,
even though 'Organization Code' may appear in the TAG list or the TAKE list the
user will not have a pop-up value available. They must manually enter a value
using the keyboard or use the camera or scanner.

Use the ADD and DELETE buttons below the list to add and remove entries in the
Pop-up Field list.

Pop-up Columns

The 'Pop-up Columns' list is found on the right side of the screen. It defines the
columns of data that will appear in the device for each pop-up. If you click on one
of the Pop-up Fields on the left, you will see the list of Pop-up Columns on the
right change accordingly. If you have not yet defined any columns for a given
Pop-up Field, the pop-up columns list on the right will be empty. Note that until
you select or click on one of the Pop-up Fields, the Pop-up Columns list will be
empty.

The first field in the Pop-up Columns list corresponds to the first column on the
device, the next to the second column, etc. It is important to remember that the
value in the first field is what will be used to 'fill in' the value in the TAG or
TAKE prompt list. Any additional columns are for the benefit of the user in
selecting the value in the first field.
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Use the ADD and Delete buttons below the list to add and remove entries in the
Pop-up Columns list.

Additionally, the Pop-up Columns have a limited set of properties that may be
adjusted. These may change depending upon the Pop-up Column itself. You may
access the properties of a Pop-up Column by clicking on the entry then clicking
on the Properties button. You will get a dialog that has the editable properties.

Filter Value Specify a value that the column must equal. If filled in, the list of
values available to the pop-up must also satisfy the value in the filter.  This filter
is not as sophisticated as the filter found in Reports or Sets.

What you enter in the filter box will depend on the kind of filter you need.

• If you need a simple filter where the pop-up column should equal a single
value.  In this case, simply enter the value in the field. Bar|can
automatically uses the pop-up field as the left side of the filter expression.
For example, if the Pop-up Column is Catalog Code and you want only
those catalogs that have Catalog Code ‘AV’, then enter only ‘AV’ (without
quotes) into the filter box. Internally Bar|Scan create the expression
‘Catalog Code=”AV”’. It puts the quotes around the value for you if it
needs them. 

• If you need to use a comparison operator other than the default ‘equal’
sign.  In this case you need to enter a single tilde character (~) followed by
the operator and then an expression. An expression means that it has to be
between quotes if it is a string. If it is a number enter the number without
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quotes. For example, if your pop-up column is Catalog Type and you want
all catalogs except those that are of Catalog Type ‘MONITOR’, you would
enter the following in the filter box.

              ~<>”MONITOR”

The tilde tells Bar|Scan this is an expression with an operator. The operator
“<>” is a ‘Not Equal’ operator. It tells Bar|Scan how to compare it to the
pop-up field. The value tells it, in this case, what not to equal. Note that the
value has to be between quote marks since it is a character value.

• If you need to filter on a value but the field you want to filter on is not in
the list of pop-up fields.  In this case you must use the double tilde operator
(~~) followed by the entire expression from beginning to end. For example,
you must use this if your Catalog Number pop-up lists only fields Catalog
Code, Catalog Number, Catalog Type and Catalog Description but you
only want those catalogs that come from a particular manufacturer. The
manufacturer is not one of the fields listed, yet you still want to filter on it.
To do this you will need to do the following.

 
Display the properties box in one of the pop-up fields (in this case it
doesn’t matter which one). Enter the following:

              ~~CA.MV_NAME=”HP”

The double tilde tells Bar|Scan that this is a FULL EXPRESSION and to
ignore the pop-up field. The expression stands entirely on its own. The
‘CA.MV_NAME’ is the name of the field you want to filter on. In this case
it is the Catalog Manufacturer field. Please consult the field lists in the
manual to get the actual database fields names, or you can go to the field
itself on the screen, right click on it and select ‘Field Information’. You
will see the database field name there. The comparison operator in this case
is the ‘=’ sign. The value it must match is manufacturer ‘HP’. Again, note
that since the value is a character string it must be between quote marks.
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• If you need to filter on a more than one value such as two Catalog
Categories so that you can download Catalogs from more than one
Category, you can specify a connector such as OR , AND such as in the
following example.

OR logic sample: ~~CA.CAT_CODE="EN" OR CA.CAT_CODE="EP"

AND logic sample: ~~CA.CAT_CODE<>"EN" AND CA.CAT_CODE<>"EP"

The image below describes the OR sample.
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Field Caption Specify the column header text that appears at the top of each
column in the pop-up.

There is very little room on some device screen, such as a phone, so making the
columns as narrow as possible yet still legible is important. You can contribute to
this by abbreviating the column headers. For example, if the column is
'Organization Code', then the column header will normally be 'Organization Code',
the exact same words. But you can narrow this by giving it a new column header,
such as 'OrgCode'. To do this you would click on the 'Organization Code' column,
then click on the 'Properties' button. The Properties dialog will appear. Enter the
value 'OrgCode' (without the quotes) into the Header field. Then click on the OK
button. Now the 'Organization Code' columns will have 'OrgCode' as its header.

Fill In Specify information for Bar|Scan to fill in (or display) when you perform
a capture.  This is what we refer to as the Audit Scan.

For example, it would be beneficial to capture an existing asset number during
your annual inventory (Take Mode) and have the serial number, Catalog
Description, last known Status, Condition and User Name Displayed.

Would it also be beneficial to have this information populate existing fields so
that they only need to be edit if something has changed?  For example, capturing
an Asset label will display the last known User Name.  It will then complete the
new prompt for User Name.  You will only need to change the User Name if the
asset has been assigned to a new user.

Below is an example of the User Name Fill In section. 
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Below is an example of a number of fields that will be displayed when an Asset
label is captured.  Notice that some may have a ‘Tag/Tag=Y/Y’ after the Pop-up
column and some do not.  The ones displaying the “Y” will fill in the
corresponding prompts on either TAG, TAKE, or both.

The list of fields in TAG and TAKE can be filled in automatically by picking one
of the available values in a pop-up. A TAG or TAKE field is specified to have a
pop-up by putting the same field name in the list of ‘Pop-up Fields’ within the
‘Custom Pop-ups’ tab. The pop-up itself has one or more columns. The first
column will always be used to fill in the TAG or TAKE field that the pop-up is
designed for. The pop-up can have more than one Pop-up Column. You can
specify these extra columns to be either for display only or to be able to ‘Fill In’
other fields in the TAG or TAKE field list.
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If specified as ‘Fill In’ fields, the value from the pop-up item selected will
automatically scan the list of TAG or TAKE fields and look for the same field. If
found, it will automatically fill it in. The only exception to this is if the TAG or
TAKE field is ABOVE THE CURRENT FIELD. In that case, you will get a
prompt asking if it is ok to fill in the data. For example, if the pop-up has the
fields “Building, Floor” and the current TAG field is Floor, you will get a prompt
as follows: “Current Building is above the current prompt. Really overwrite its
data?”

Occasionally you will see the “Sql Column Name Override” prompt. This is for
advanced users. Do not touch this unless you have consulted directly with
Bar|Scan Technical Support. This will not show up on all fields.

Turning Custom Pop-ups On and Off

To use custom pop-ups, put a check mark in the field "Use the Custom Pop-ups
defined here instead of the Default Pop-ups”.  If this is unchecked the Default
Pop-ups will be used, even though there are Custom Pop-ups defined.
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THE BAR|SCAN MOBILE MAIN MENU

Turn the device, smart phone or tablet on by pressing the power control button. 
If your device has a stylus, retrieve it from the unit.  Tap the Bar|Scan App Icon
with the stylus or you finger.

Be patient, the app will take a few seconds to launch.

You will be shown the Bar|Scan Welcome Screen which will appear similar to the
one shown below.
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Tap the Menu button.  This is the icon that consists of three parallel horizontal
lines (displayed as /).   You will now see the Bar|Scan Flyout Menu as shown
below:
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You will see five items the menu screen:

T HOME - This button takes you back to the Home Screen.

T TAG inventory - Tagging is the activity that initially identifies the asset by 
applying a bar code label and recording information about the asset.

T TAKE inventory - Periodically, after the initial Tagging, you will Take an
inventory of the assets to update their location, condition, etc.

T SYNCH - Use this button to communicate and share information with the     
     Bar|Scan desktop application including your inventory data.

T TOOLS - This button displays three additional screens (4th optional screen)   
   described in the next few paragraphs.
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SETTINGS

Synchronization

You can specify the synchronization settings that you wish to use for Bar|Scan.  
Unless you are instructed to do so, do not modify the Synchronization settings.

T IP Address - This button allows you to enter the IP address that allows
communication between your smart phone or tablet and the desktop Bar|Scan. 
For most users, you would enter the same IP address that you see on your
desktop’s Bar|Scan Synchronize Handheld Screen.
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T Port No. - This button allows you to enter the TCP Port address that allows
communication between your smart phone or tablet and the desktop Bar|Scan. 
For most users, you would enter the same Port address that you see on your
desktop’s Bar|Scan Synchronize Handheld Screen.

T Default Sync Selection - This allows you to change what information is taken
from your Bar|Scan company database and copied to the device.  Two choices
become important when:

1: Lookup tables are large. You can select the ‘Inventory Only’ to do a
quick Synchronization.
2: There are problems with the look ups and they need to be reloaded,
especially for debugging in the field. “Inventory, Prompts, Lookups’ or
‘Inventory Only’ can be selected if you just want to skip the problem and
continue doing the inventory.

These choices allow a user to make a choice based on immediate circumstance.

Inventory, Prompts, Lookups - this is the default.

Inventory Data Only - Only the inventory data is sent, the lookups are not
downloaded. This is a much faster synchronization. Lookup files are massive
compared to the inventory file. Megabytes vs kilobytes. Syncing Lookup tables
can take a long time. This allows for a faster work flow since most of the time
lookups do not change much.

T Last Sync Time - This displays the last date and time that a synchronization
took place.

Note on Remote and Cloud Systems: Bar|Scan can communicate through a
Remote Desktop Application, Cloud computing or Virtual Private Network (VPN)
with the device.  Consult the Knowledge Base Page of the Bar|Scan website at:
www.barscan.com for the latest information and setup instructions for these
options.
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User Options

You can specify the (Global) User Options that you wish to use for Bar|Scan. 

T Fill in additional lookup fields - There are three choices available.  With
‘Ask Permission’ Bar|Scan will stop and ask you to confirm the  ‘Fill In’
prompts affected by your barcode capture or data entry.  This is what we
call an Audit Scan.  You have a option to not fill in or fill in without
asking.

T Extra Lookup Information - Extra columns are displayed when this is
selected.
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T Application color scheme - There are multiple schemes to choose from to
meet your personal preference.

T Advanced functions - This adds extra menus, buttons, and functions.  This
should not be necessary for most Bar|Scan users.

T Continuous Bar Code Scanning - Turn on only in certain situations when
the Mobile Configuration is designed for this type of inventory.  For
example, after entering the location, capture asset bar code labels one after
another.

T Beep on Bar Code Scan - Turn on to help you verify that your capture was
successful.  The volume is controlled by your device.

T Maximum Time Difference Allowed - When a synchronization is
performed, the time difference between the server and the device is
checked.  If the difference is greater than this, you will be notified.

Application
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All of the information in these sections is for identification and troubleshooting
and is mostly collected by Bar|Scan from your device.

T Applications - This section displays the version information for both
Bar|Scan Mobile and the Bar|Scan Desktop Application (once you
complete your first synchronization).

T Device - This section displays more information about your device, smart
phone or tablet.
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DATA

When you tap on the word DATA or swipe a screen left or right to the DATA
screen, you will be shown a dialog box that will display your Data options, similar
to the one below.

You are presented with several options.

T SELECT ‘LIVE” OR ‘SAMPLE’ - Use this to toggle between using Live
Data and Sample Data by clicking on the area.

 
T DELETE INVENTORY ONLY - This button deletes all of the inventory
items that have been collected. Please Select SYNC and send your inventory to
the Bar|Scan desktop company database before you clear (unless you were doing
test items).
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T SHARE INVENTORY ONLY -  This button allows you to email or
message your raw inventory date.  This is useful when your Bar|Scan PC is not
ready to synchronize or you need to share when requested by technical support.

T RE-GENERATE SAMPLE DATA - This loads fresh sample data matching
the Democo Database.  Refer to the Bar|Scan User Manual Chapter 19 - “Training
With Demo Database” for more information on how to use this sample data.

This button DOES NOT affect or delete all of the inventory items (Live Data) that
has  been collected. 
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LEGAL

The Legal Information Screen is shown below.

Use the LEGAL screen to review the Bar|Scan License Terms as well as other
License terms for this application.

T Permanent Unique Device Name - This button allows you to enter the
Device Name for your smart phone or tablet so that this license can be
uniquely distinguished.  If the Licensing Section shows ‘REQUEST
BARSCAN LICENSE’ then see the prior section ‘Licensing the Bar|Scan
Mobile’.

T Company - This is the entity granted the Bar|Scan license.
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T Bar|Scan Administrator Name, Email, Phone - These items are the contact
information for the Bar|Scan license.

MISC

If you check ‘Advanced Functions’ on the Settings Screen, you will see a
Miscellaneous Screen.  The information on this screen is only for technical
support.
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Using the Keyboard

The Keyboard is available for you to enter responses to the prompts.  When you
tap on any prompt, your QWERTY keyboard should appear as illustrated below.

If you need to enter letters or any of the symbols shown on this keyboard, tap on
the corresponding character with your finger or the stylus that came with your
device.

When you are finished entering the characters, click on the Done key or minimize
the keyboard.
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TAG and TAKE Menu Options

When you have selected TAG or TAKE, you can select additional menu option
by tapping on the Menu button at the top right.   This is the icon that consists of
three parallel horizontal dots (displayed as ! ).

The options will appear as shown below.

  

The list will vary depending on what action you are performing.

Set continuous bar code scanning - Turn on only in certain situations when the
Mobile Configuration is designed for this type of inventory.  For example, after
entering the location, capture asset bar code labels one after another.
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Reset to default values - There are two choices for a default value as the response
to a prompt. You can enter a default value on this screen which will be used in the
device or you can keep the value from the prior asset entered.

Validate data - This will perform a validation prior to your selecting SAVE.  This
can be useful when you have a Configuration with many prompts or complex
validation rules.

Set Cycle Point - This will make your current field (field name) your temporary
new cycle point, After data is saved, the cursor will cycle back to this prompt.
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Pop-up choices for Downloaded Bar|Scan Fields

As discussed in the Configure Section of this Chapter, a  number of fields can be
downloaded into the device.  Because of the large amount of memory in the
device, thousands of lists and items can be downloaded.

On any prompt that includes the download, you can select three methods for data
entry.  The first is the keyboard, the second is the pop-up, and the third is the
scanner or camera.

The Pop-up can be selected by tapping on the magnifying glass as shown below:
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When you tap in the response area, your Pop-up selection will appear similar to
the following:

When you tap on any of the choices, the item will be entered as the selection.

Leaving a prompt blank is sometimes desired.  There are two things that need to
be considered for a blank response.

• The Configuration that is downloaded must allow a blank.  Remember that
when a prompt is added to the Configuration, you have the option of
making a response mandatory.

• The corresponding table in Bar|Scan must include a blank.  For example,
if you wish to choose a blank Condition or Status code, you must first
create a blank code on the PC portion of Bar|Scan.
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Changing the Order of the Pop-Ups 

Any pop-up which displays more than one column can be sorted in order of any
column to assist you in locating the correct response.

For example, clicking on the Department column title will then resort the list
according to Department as in the example below:

If you have many columns, you can swipe left or right to see columns that are not
on your screen.

Double tap the item to select it.
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You can also Search or Filter widen or narrow the columns by clicking on the
three parallel dots (displayed as !) at the top-right portion of the screen.

You will now see the Bar|Scan Flyout Menu as shown below:

T Search - when you select this option, a Find dialog box will appear.  After
you type in your search, Bar|Scan will search all fields in the pop-up.  If
found, it will then be highlighted for you.  To close and exit the search,
select the search option again.

T Filter - when you select this option, a blank row will appear at the top of
the pop-up list.  Enter your filter criteria in any one of the Pop-up fields.
Bar|Scan will filter all items in the pop-up.  If nothing matches your filter
criteria, nothing will be displayed.  To close and exit the filter, select the
filter option again.

T See Detail - when you select this option, you are presented with all of the
fields download into the device for this prompt in a vertical fashion.  For
example, in the case of the Personnel Table, you will see the email,
assigned location, First Name, Middle Name, Last Name, etc.

T Scroll to Current Selection - when you select this option, the device will
scroll to the selection.  This can be useful if you made a selection but
continued to browse up or down the pop-up list.
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Label Lengths

Your Asset and Room tag lengths are configured on the PC portion of Bar|Scan. 
There is a label length setting on the device which only available if you check
‘Advanced Functions’ on the Tools-> Settings Screen.  The setting is located on
the Tools-> Data Screen.

Below is an example:

Text and Display Settings

Fonts, display size, brightness and other settings are not controlled by Bar|Scan
Mobile.  Open and use your device’s settings app to adjust these items.
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Error Handling

Bar|Scan will validate your data prior to saving or when requested, according to
the rules that you assigned when you created the device configuration in the
desktop portion of Bar|Scan.

Error or warning messages will appear in RED as shown in the example above. 
Once you make the necessary corrections, your data can be saved.
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TAG

Select the Bar|Scan Flyout Menu.  Select the Tag button to begin a Tag inventory
as shown below.

A Tag inventory is used to inventory an asset or assets for the very first time.  

The prompts that you will see on your Tag Menu will differ based on the device
configuration that was downloaded into your device.
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The Tagging features in the device are designed specifically to cycle over and
over.  This means that once you have finished recording the information for one
asset, you are automatically positioned to start recording the next asset.

The Label Replacement item should not be necessary during a Tag.  This item is
used during a Take inventory when an Asset Label that was applied during a Tag
is worn, damaged, or peeling off.  By entering both the old and a new Asset
Number, you make the system keep all of the old asset information and replace the
asset number, yet retain the old asset number for reference purposes.
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TAKE

Select the Bar|Scan Flyout Menu.  Select the Take button to begin a Take
inventory as shown below.

A Take inventory is used to update information for an asset that already has a bar
code label or asset number on it.  It can also be used to update information in
quantity inventories.
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The prompts that you will see on your Take Menu will differ subject to the
Configuration that was downloaded into your device.

The Take inventory features in the device are designed specifically to cycle over
and over.  This means that once you have finished recording the information for
one asset, you are automatically positioned to start recording the next asset.
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Fill In

As mentioned in the configuration section of this Chapter, you can specify
information for Bar|Scan to fill in (or display) when you perform a capture.  This
is what we refer to as the Audit Scan.  This feature is optional and can be turned
on or off in the Tools section - Settings tab - of the Mobile Application.

This is very useful for a number of reasons previously discussed.  When you use
the Fill In feature and you capture the specified bar code, you will see a dialog box
similar to the following.

Tap on the Yes button to fill in the desired fields or No to abandon the fill in for
this selection.
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Label Replacement

When you select the Label Replacement Menu item, you will see a form similar
to the one below.

You can capture the bar code if it is still readable, or using the keyboard, enter
the old asset label number.  When finished, tap the OK button to be returned to the
Take screen.

You will see the note below the Asset # prompt showing the label that will be
replaced as displayed below.
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Performing a Synchronization

When you are ready to do a synchronization, your device is ready to go if you
have Wi-Fi.  If you are connecting via USB, you should set the device into the
cradle, ensuring that the cradle’s cable is hooked to the correct port in the back of
your computer.  Go to the Bar|Scan Main Menu of the device.

You should initiate the synchronization from the computer by clicking on the
Synch Icon on the Bar|Scan Main Menu as illustrated below.

Or select  File, then Open . . . <, Handheld Computer. . . <, then Synchronize as
shown in the example below.
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Select either of the two methods and you should be shown the synchronize dialog
box as shown below.

Select the Configuration that you would prefer to use.  In the example shown
above we selected the “{SYSTEM} ANDROID MOBILE APPLICATION”
Connection.   Then, click on the Begin button.  The words “Ready to Begin” that
are shown on the bottom of the box above will change to say “Initializing,” and
then to “Waiting for Connection”.  Once the words Waiting for Connection
appear, tap on the Synch button on the device’s Bar|Scan Main Menu.
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Bar|Scan will perform all bi-directional communication necessary.  When you
select Sync, you will be shown a dialog box on the device that looks similar to the
one below.

Press the ‘SYNC NOW’ button.  You will be shown a changing dialog on the
device that displays the status.  When completed, you will see a message similar
to the one below.
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The Bar|Scan message below that appears on your desktop can serve as your
confirmation.  The number of items will vary according to the amount of
inventory collected.  

The desktop Bar|Scan will remain ready for another synchronization.  If you do
not wish to synchronize another device, click on the Cancel button to cancel the
synch, and then click on the Close button to close the upload dialog box.

It is important that your device has an accurate date, time and time zone setting. 
Bar|Scan appends this information to every inventory capture.  Therefore, when
you perform a synchronization, Bar|Scan checks the device’s date with your
desktop computer’s date and if they are different by more than the maximum Time
Difference Allowed (in the Bar|Scan Mobile Tools Menu), then the Bar|Scan will
warn you with a message prompt.  

Unfortunately, because of Android’s security settings, Bar|Scan cannot adjust the
date, time nor time zone, so it is important to regularly check these in your device
before an inventory.

For Additional Information

You can obtain more information on using the Bar|Scan Mobile on our website
in both the Support Videos and the Knowledge Base sections of our website.  I
website password is required which can be requested by sending an email to:
techsupport@barscan.com .
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INTRODUCTION

The Bar|Scan Mobile Device records the asset information which will be transferred
to, and entered into the Bar|Scan system.

There is a set of videos on our website that can provide you with additional in
operating Bar|Scan.  These are titled Quickstart Overview Videos and can be found
on this page: https://www.barscan.com/support-videos

Please consider viewing or downloading these as part of your learning experience.

To ensure the information being received from the Mobile Device is correct,
consistent, and free from errors, Bar|Scan checks and rechecks the asset information
to ensure the validity of the information before it can be transferred to the Asset table.

In addition, Bar|Scan provides several steps which permit you to verify the accuracy
of the recorded information.

The information transferred from the Mobile Device is temporarily placed in what we
call a Transaction Table.  This table will hold the information transferred from the
Mobile Device until you indicate that the information is correct.

Normally, the process is accomplished as follows:

T Optionally verify the Mobile Device’s Communications parameters are set
correctly using Mobile Device Configurations.

T Transfer the information from the Mobile Device to the Transaction table using the
Mobile Device Upload feature.  Information can be transferred via the USB or Wi-
Fi on most devices.  Windows Mobile 5 or greater devices can also send data via
Microsoft Outlook.

T Validate and optionally print the information in the Transaction table using the
Print feature while in the Transaction Reports table.

T Use the Edit Transaction table features to correct any discrepancies (validation
is automatic for corrected records).
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T Optionally Print the Transactions using the Transaction Reports table, to list the
information and produce a final record (an audit trail) of the assets you are going
to enter into the Bar|Scan system, and Mark them as printed.

T Transfer the information to the Bar|Scan system using the Move feature to move
the Transactions to the Asset Table.

While the previously mentioned process may appear to be a step-by-step procedure
for a single transfer of asset information, Bar|Scan is designed to permit you to
accomplish any or all of the above tasks when it is appropriate for you.

You may, for example, make one or several transfers from a Mobile Device all at once
or at different times, each transfer is just added to the Transaction table.  You  may
process the asset records into the Bar|Scan system one at a time, several at a time, or
large groups at a time.  You can also hold asset records in the Transaction table  for
later processing.

BAR|SCAN MOBILE DEVICE CONFIGURATIONS

Before you upload, you may want to look at and/or change the configuration settings
on your computer.  To get to the Configuration table, go to the Main Menu.  Select
File . . . <, then Open . . . <, Handheld Computer. . . <, then  Configurations as shown
below.
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When you select Configurations from the Handheld Computer pull down, you will be
shown another menu like the one below.

This Browse tab lets you select the Mobile Device type and connection, and then you
may select the Edit tab to view or change any of the communications options.  Most
of the time, the default settings will NOT need to be changed.

Hint: Once you select a configuration, it will remain your configuration until you
select a different configuration.  Therefore, in most cases, it is only necessary to select
the configuration one time.
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Configuration Name

Each configuration option is given its own name.  The Default Pocket PC
Configuration is the Bar|Scan supplied template for you to create your own
Configuration for all Windows CE, Pocket PC or Windows Mobile Computers.

Hint: If you have many users uploading on your network you can create several
configurations and name them for your users, i.e., Jackie’s connection.

Upload Method

There are two possible upload methods, TCP and serial.  On the Zebra MC3200 there
is one additional method, USB.

The TCP method supports all bar code equipment using Windows Mobile Device
Center including the Pocket PC, Windows CE and Windows Mobile Computers.

Serial methods are used for all older handhelds that attach to a serial or USB port and
do not use WMDC.  These include the Legacy Symbol PDT3100, SPT1500, 1550
1700, or 1800 series.
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EDIT TRANSACTION TABLE

Bar|Scan will check the information from the Mobile Device extensively once the
information is in the Transaction Table, in a process you initiate by selecting to
Validate the data.

This feature helps to point out any discrepancies or errors, making it easier for you to
correct the data before you transfer the asset records into the Asset table.

When Bar|Scan checks the information and finds an error on a particular asset record,
an error message will be associated with that asset record, and will NOT be removed
until you correct the problem.

When you wish to view or change information in the Transaction Table, go to the
Main Menu, select File, then Open . . . <, Handheld Computer. . .  <, then Transactions
as shown in the example below. 

Or you may click on the Transaction Icon on your Table Toolbar.  The icon is
displayed below.
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THE BROWSE TAB

You will be shown a Transaction table similar to the following.

Note:  The above will display the information according to the Set that is currently
selected in the Set feature. 

Also notice that one of the columns in the Browse Tab is “Problem Indicator”.  This
column informs you when there are potential errors in the items that need to be
corrected before the item can move to the Asset Table.  In the example above, there
are two different problems; “Location not in Location Table” and “Catalog Number
is not on file”.   If the Problem Indicator column is not displayed on your Browse Tab,
you can use the Set Feature to rearrange the columns.
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You will notice that the tool bar at the bottom of the panel has four buttons specific
to the Transaction table as shown below.

Two of these buttons offer you a second way to validate and move selected
transactions.  The other method of moving and validating transactions, would be to
use the Main Menu Transaction pull down a menu.  The ‘default’ buttons allows you
to change the screen mode to ‘Check Out’.
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Signature Capture

The signature capture is a special type of image and can be reviewed in the
Transaction table.  Because there is still an editing and validation process, Bar|Scan
does not yet create a final jpeg file yet.  In other words, there is no image file
transferred from the Mobile Device to the desktop and there is no image file for the
signature while the data is still in the Transaction table.

Since the signature file is an original capture, there is also no ability to edit or change
it.  As shown below, selecting the ‘Images’ Icon in the Bar|Scan toolbar will display
any image, including signatures. 

To reiterate, existing images related to the record will be displayed as well as any
signatures currently held in the Transaction table. 

Signatures are temporary image files generated for viewing inside the Transaction
Table. Signatures do not become permanent image files until during the Move from
the Transaction to the Asset Table.
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While editing Transactions, all signatures are contained in a single signature field
called ‘Signatures’. This field can be selected in the Browse List and Set Command.
The number displayed is how many signatures are in the signature field.  In the
example below, there is one signature per asset.

 

When Validation and Editing are completed, move the Transactions to the Asset table
as you would for any inventory. Once moved, a permanent image of the signature is
generated into the IMAGES subfolder.

If the image needs to be a shared image among all companies it must be manually
moved to the ‘SYSUSER\SHAREDIMAGES’ subfolder.

If at a future time anyone finds it necessary to recreate the signature/transaction, you
can import the backup Mobile Device file as usual.  These are stored in the READER
subfolder.

Both the transaction and its related signatures will be loaded. Additionally, the image
also contains metadata within the image itself that can be retrieved, including the
Asset #, Work Order # and original stroke information.
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Check Out

The last item shown on the Transaction table tool bar says Default, and has a down
arrow next to it.  For most of our customers, this item can remain at the default. But,
by pressing the down arrow, you will see the words Check Out.  This item is used
mainly by warehouses, in conjunction with stationary readers; readers that are
permanently plugged into the computer system.

This type of reader does not need to be uploaded, as the information automatically
goes into the Bar|Scan Transaction table.

The Check Out mode was designed to only track Takes, with a minimal amount of
information.  When Check Out is selected, the Edit tab will change to show only the
Asset number, Name and the Destination Room Tag as shown below.

However, the information of scans done in this manner are included along with the
regular Transactions, not in a special table.
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The Range Feature

When you have the Transaction table open, the Main Menu changes slightly, so that
the Transaction Features are listed next to the Help as shown below.           

You can use this feature to Move Transactions, Validate Transactions, Range
Duplicates, Adjust Duplicate Inventory Times or to Remove Trailing Check Digits.

From time to time you may Synch a Mobile Device that has had part or all of the
information in it Synchronized before.  For instance, you Synch a Mobile Device with
50 assets in it, and set it down.  Someone needs to use the Mobile Device, and comes
up and takes it.  They inventory five items with it, and then bring it back to you so that
you can Synch it.  The Mobile Device now has 55 assets in it, and 50 of them have
been Synchronized before.

Synch the Mobile Device as normal, checking to ensure the information goes into the
Transaction table, like normal.  Make sure that you do not have any transactions
ranged.  Validate the transactions.  Once the validation has been done, go to the
Transaction feature, and select Range Duplicates.  Immediately all of the transactions
are compared to each other, and  any “EXACT” duplicates will be ranged for you, and
you may safely delete them.
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Any items that are duplicated that are not EXACTLY the same, will not be ranged. 
Therefore, it is safe to simply delete any items that are ranged with this feature.  

This feature only checks for one duplicate.  This means, if you have Synchronized part
of a Mobile Device three times, the third duplicate will not be located.  So, if you
think there is a chance that you have uploaded any of the transactions a third time,
simply wait until you have used the Range Duplicates feature, and have deleted those
that were ranged.  Then, validate the transactions again.  Again select the Range
Duplicates feature.  If there are any items ranged for you during this process, it is safe
to delete them.

Adjust Duplicate Inventory Times

This feature applies only to the legacy Symbol PDT3100 because it’s internal clock
is only accurate to the nearest minute.  Other supported Mobile Devices have internal
clocks that are accurate to the nearest second.

From time to time you may synch a Mobile Device that has scanned an asset at two
places within the same minute, or, you have multiple Mobile Devices that scan the
item at two places at the same time.  This may occur in a warehouse environment
where assets are rapidly moving from dock to pallet rack and back to dock.  If this
occurs, the “Adjust Duplicate Inventory Times” feature can be used to adjust the time
by automatically adding a second to the time of the second scan.  This feature requires
you to Range the assets in question.  It is best to use a Set Command which also
orders the assets by Inventory Time, and allows you to review the assets side by side,
before you apply this feature.  

Trailing Check Digits

If you are scanning the shipping labels associated with your assets, often the
manufacture will add a check digit to the serial number or other key information on
the label.

A check digit is an extra digit which is derived from the number and added to the end
for use in error detection.  The problem is that the digit is usually not on the bar code
serial number on the asset.  Therefore the serial number scanned on the shipping label
will be different from the serial number scanned on the asset.  This feature removes
the check digit.
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CREATING AN ORDER AND FILTER - THE SET MODE

On the Transaction table, the Browse panel is selected by default.  The transaction
information on the Browse panel can be sorted by any field.  Place your cursor in the
first column on the left, press your right mouse button and select Order By from the
dialog pop-up, or select the Set button on the tool bar.

The SET feature allows you to identify a smaller, more manageable group of
transactions from which to select, e.g., only those asset records with a problem.

The SET feature operates in the same manner throughout the Bar|Scan system.  See
the Chapter 5 - Operating the System for details about the operation of the SET
feature.

When used with the Edit Transaction File feature, SET provides several additional
filters as follows:

T  You may select one or more of the different Inventory Methods.

T Either good asset records or records which have problems (indicated on the
Problem Indicator).

You may use the Set feature by selecting the Set icon from the tool bar.  You may also
order, or sort, the information by right clicking on the first column of the browse
panel, and selecting Order By, and then a Set.

Important:  If you have selected the Set button from the tool bar, and have chosen
a set that had a filter, i.e., Bad Transactions Only, right clicking will not erase that
filter, but allow you to sort the information in another manner.

Transaction Table Page 12-13



Transaction Table

THE EDIT TAB

The Browse panel allows you to select an asset record, and the Edit panel displays the
information from the Transaction Table about a particular asset.  

On the Browse panel, click on the desired record with your mouse, or move the
highlight bar with the mouse or cursor movement keys, or start typing the desired
Asset Number.  When the highlight bar is on the asset you wish to display, press
ENTER, and then select the Edit tab.

You can also use the Panel pull down Range, or the F4 key, to select a Range of assets
to work with.  Simply go to the first asset that you would like to range, and press the
F4 key.  Cursor up or down until you reach the last asset that you would like to
include in your range, and press the Enter key.  You may repeat this step to set more
than one range at a time.

For more instructions on using the Range feature, see Chapter 5 - Operating the
System.
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After an asset record has been selected, the Edit Tab will show the asset record
information similar to the following sample.

You may use your tab key to move from field to field on this panel.  Right click on
any field, or use the F5 key, and select Look up Value to view the look up window
associated with each item.

You can press the X at the top right of the window, or press the ESC key to return to
the Main Menu.
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The Transaction Edit tab has five tabs of its own.  The first tab is the Asset tab, as
shown below.

This tab displays information about the asset that can usually be collected in the
Mobile Device at the time of the physical inventory, such as secondary number,
system number, serial number, condition, status, cost per unit, organization, owner,
the name field, and the phone number.  It also has additional spaces for the Purchase
Order number and the Work Order number.

Note that several of the items such as Condition and Status are highlighted and
underlined, this represents that each contains a hyperlink to their corresponding
choices in another part of Bar|Scan.  Simply click on the underline under Condition,
to be taken to the Condition table.

The Cost per Unit field is an optional item, used if you are using the Cost Averaging
and accounting fields in Bar|Scan.  This item can be entered using one of the Mobile
Device’s UDF fields, or it can be entered at your computer.  This field should contain
not only the purchase cost of an item, but also including all costs to get it to you.
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The second tab that appears on the Transaction Edit is the Inventory tab, as shown
below.

This tab shows the information from the set up of the Mobile Device: what inventory
method was used, the initials date and time of the inventory, the inventory comments,
the Company, and the Mobile Device file that the information is stored in after the
upload.

Tag or Take

This item tells you how the information was recorded in the Mobile Device. When
you select an asset record, the information in this entry will appear to show you what
inventory method was selected on the Mobile Device when the information was
recorded.

The number of selections available depends on your Mobile Device model.  Normally,
from two selections are available on the Mobile Device; TAG, TAKE.

You may use the down arrow on the right side of this field to change the selection if
necessary.

Changing the Inventory Method can either fix or cause problems.  Read the following
Sections before you make a change.
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Tag

TAG (inventory) is used by the Mobile Device to initially record the information for
a new asset.  When this method is selected, Bar|Scan will assume that the asset is
completely new and there is NO existing asset in the system with that Asset Number.

Use caution when changing the Inventory Method.  If an asset has been TAGged and
you change the method to TAKE (inventory) an error message will be generated for
the asset if there is NO currently existing asset in the Bar|Scan system.  If there is an
existing asset in the system, the information in the Transaction table will REPLACE
the existing information for that asset; thus you could lose information if the Asset
number was recorded incorrectly.

Take

TAKE (inventory) is used by the Mobile Device to record inventory information about
existing assets.  When this method is selected, Bar|Scan will assume there is an
existing asset in the system.  If not, an error message will be associated with that asset
record in the Transaction File.

Unknown

When there is not enough information to determine if the items inventoried were done
in a Tag or Take mode, they are placed in this category.  This is usually due to an error
in the transmission of Mobile Device information.

Mobile Device File

Every upload is named and stored as a separate file for backup purposes.  These are
collectively located in your Company Name/Reader folder.  The Mobile Device are
automatically numbered by Bar|Scan.  Once the number reaches 999, they are recycled
and the older files replaced.

These files can be imported into the Transaction Table at any time by selecting from
the Bar|Scan Main Menu: File < Import < Mobile Device < File and browsing to the
file you wish to import.  Select the file either by file number or by the date and time
of the file.
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A backup of each synch is saved in the company\reader folder.  This can be useful if
Transactions are accidentally deleted since these file scan be easily imported into the
Transaction Table.  They also provide extra diagnostic information when there are
Mobile Device problems.

The file name structure is:

HandheldBackupFolder + "BSHHXL_" + HandheldID + "_" + KeyName + 
"_" + Date + Time + ".txt"

Where:

HandheldBackupFolder =  Handheld Folder (the ‘Reader’ folder)

HandheldID = The ID number of the specific handheld receiving the download.
KeyName = The type of file being sent to the handheld. E.g. “bslookupsv2” = the
quick lookup data, for example “bslookupsv2info” = Descriptive information about
the bslookupsv2 data.

Mobile Device ID

Every upload can be traced back to the Mobile Device that collected the Transactions. 
The Mobile Device ID is the unique device ID in GUID format.  This ID can be found
in the Computer’s Setting Screen.

This can be useful in helping to diagnose problems that might be related to hardware
or software malfunctions.
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The third tab that appears on the Transaction Edit is the Location tab, as shown below.

This tab lists the Current location of the asset as it was entered into the Mobile
Device.  The fields listed will be determined by the type of location that was entered
into the Mobile Device.  The above example displays a Site location.

Bar|Scan will permit the user to identify items in quantities.  So, if you have many of
the same item, and these items are not going to have an actual bar code placed on
them, you can still account for them in your database.  However, it is necessary to use
Room Tags in order for this feature to work properly.

If this item was inventoried using a quantity mode, the Mobile Device would not ask
for an asset number.  When inventorying assets in a Tag mode, the Mobile Device
would ask for a Room tag, a Catalog number and a quantity.  If the items were done
in a Take mode, the Mobile Device would prompt you for the current Room Tag, the
Destination Room tag, Catalog number, and the quantity.
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When the quantity mode has been used to do a Take, and both Room Tags are entered
into the Mobile Device, the prior location will be listed on the tab above, as well as
the current location.

Hint: Unless you are doing a Quantity Mode inventory do not enter information into
the prior location, it will not change an Asset’s Location History.

The fourth tab that appears on the Transaction Edit is the Problem Handlers tab, as
shown below.

This tab has fields for the information about the asset label, if it was replaced, and if
so what the new and old asset numbers were.  It has a check box for a response from
the Mobile Device if the location listed was accessible.  Next there is a space for you
to put the transaction on hold, so that it cannot be moved to the Asset table.

The large section in the middle of this tab is used to list any problems that Bar|Scan
has detected during the validation process.  You have the option of ordering these
error messages by number or by description.  Finally, on the bottom right of this tab,
there is a place that will show if these assets have been marked as Printed.

This feature is designed to assist in defining and correcting problems with the asset
records transferred from the Mobile Device.

This section of the Edit tab provides several items which are used to provide you with
the information to correct  problems with asset records after they have been
transferred from the Mobile Device.
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Replace Asset Label

When TAKING (updating) your inventory, you may encounter some bar coded asset
labels that are damaged or placed in the wrong location on the asset.

When you encounter a damaged Asset Number label, you can instruct the Mobile
Device that you wish to do a label replacement.

If the label replacement feature was used in the Mobile Device, and you upload, then
look at the Problem Handler’s tab, a check mark will have been placed next to the
Replace Asset Label field, and a new and old Asset number will be displayed.

New Asset Number

When TAKING inventory, you may encounter Asset Number labels that are damaged
or missing.  As discussed above, the Mobile Device permits you to assign and record
a new bar coded label for the asset tag by using the Replace label prompt after
scanning the new asset label.

The Replace Label command in the Mobile Device will put the new asset number into
the Asset number field, as well as placing the old asset number in the Old Asset
Number field.

While Bar|Scan will make an automatic replacement of Asset Numbers when it finds
them, it is important to note that, when you assign a new Asset Number, there MAY
also be an existing asset in the system with another number (a duplicate).  If this is the
case, you should make every effort to find the Old Asset Number and delete it.

For more information on replacing labels with the Mobile Device, refer to Chapter
11 - Bar|Scan Mobile.

Old Asset Number

When TAKEing inventory, some of the bar coded asset labels may be damaged or
missing. 
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In the Mobile Device, use the Replace Label command when you need to replace a
damaged asset tag with a new one.  This command can only be used at the Asset
prompt in TAKE.

You will be prompted for Old Asset Label.  Bar|Scan will automatically place the
Asset Number field in the Transaction File with the New Asset Label, and display the
old asset number if you have entered it into the Mobile Device. 

For your convenience, a report containing only those asset records with these
problems can be produced by using the Transaction Report feature.

While replacing a label does not create a transaction problem, other problems may
still occur.  These problems must be corrected before Bar|Scan will permit the asset
records to be transferred into the system.

Location Accessible

One of the optional questions asked by the Mobile Device when you TAG and TAKE
inventory is; "Is the Space Accessible?".  If the space in inaccessible, you should
select ‘No’ at this prompt.  When the information is transferred to the computer,
Bar|Scan will contain the location and it will be marked as inaccessible.

Spaces can be not accessible for a variety of reasons such as a conference in session
in a conference room or the office may be locked.

This feature is designed to save time during the TAKEing and TAGging of inventory. 
The person using the Mobile Device can record a location and move onto the next
location.  Later, a report can be produced containing the non-accessible locations and
provisions can be made to access the assets all at once, rather than disrupting the
inventory process each time an inaccessible location is encountered.

After you print your report, in most cases you will delete asset records that have been
marked as Not Accessible since these are not real assets but simply place holders. 
Remember that Bar|Scan will NOT permit any asset record designated inaccessible
to be inadvertently entered into the asset file.
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Hold This Asset

There will be many occasions when you will not be sure of the validity of the
information transferred from the Mobile Device.  This feature will hold the asset
record in the Transaction table until you release it, even if No Problems Exist.

Use this feature when you wish to have certain asset records checked and verified. 
You can produce a report containing only the asset records on Hold by using the
Transaction Reports table.  You can then provide the report and a Mobile Device to
have someone verify the asset records.

If N(o) is entered, the asset will NOT be held in the Transaction table when the asset
record has NO problems.  If Y(es) is entered, the asset record will be held in the
Transaction table even if no problems exist.

The forth tab that appears on the Transaction Edit is the Location tab, as shown
below.

This tab contains information collected as part of the Work Order or Service Order
Feature of the Handheld.

Page 12-24 Bar|Scan 



Chapter 12

When using Work Orders or Service Orders, the Main Menu screen of the handheld
will always display the total number of Assets inventories by the number of Tags and
Takes.

If Work Orders have been synchronized into the handheld then the fifth tab of the
Transaction Table will contain the results of the information entered in the Service
Mode.

Change Errors to Warnings

There might be occasions when Bar|Scan’s validation generates an error that you
might wish to override.  For example, you might wish to ignore the message “Serial
Number Mismatch” because you are replacing an incorrect serial number with a
corrected serial number.  You can change the message to a warning so that the
Transaction will move to the Asset Table.

For permanent changes to validation, you can adjust the validation messages on the
Transactions Validation Error Messages Screen which is discussed in more detail in
Chapter 13 -  Housekeeping.

ENTERING A NEW ASSET

Use the Add Blank or the Add Template button to manually enter new assets into the
Bar|Scan system.  It is expected however, the vast majority of your company's assets
will be entered into the Bar|Scan system using the Mobile Device.

If you choose Add Blank, a blank record will appear, then, on the Edit tab you may
add information or make changes to this blank record.  Many of the entry items have
associated look up windows to assist you with your entry.

You may use the TAB key, the arrow keys, the mouse, and the ENTER key to move
to the different items on the screen.  The PgUp and PgDn keys will display
information from the previous or next asset respectively.
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For your convenience when adding a new asset, you may use a template.  When Add
Template is the method of choice, select a transaction record similar to the one you
are about to add.  After selecting a similar asset record, select the Edit tab and the
asset information will be displayed and you can change the appropriate information
to reflect the new asset.  Many of the entry items have associated look up windows to
assist you with your entry.

Press the X at the top right of this screen or the ESC key to return to the Main Menu. 
Note: if you have pending additions or changes you will be prompted to save or cancel
them before you are allowed to close the Transaction table.

Hint: You must complete the inventory tab including the inventory method when
adding a new Blank Transaction.
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DELETING AN ASSET

This feature will remove assets from the Transaction table. Obviously, caution should
be exercised when using this feature.

Often you will find assets which have the error message "duplicate Asset Number"
associated with them. This is common because it is simple to record an asset twice,
or record the same asset number for two different assets.

The "duplicate asset number" message may indicate two different situations.  The
same asset number may appear twice in the Transaction table, or the asset number of
a TAGged asset in the Transaction table may correspond to an existing asset in the
Asset table of the Bar|Scan system.

Before you use the Delete feature to remove a "duplicate" asset from the Transaction
table, consider carefully.  You will want to make sure the "duplicate" is not actually
a second asset which has had the same asset number assigned by mistake.

You may identify a group of asset records which can be removed from the Transaction
table all at once. You can use the SET feature to first identify a particular group of
assets that you wish to remove and then select a Range using the Range feature.

To delete an asset, first select it in by using the  Range feature, press Enter, then select
the Delete button from the tool bar, or you may use the Main Menu Panel pull down
to select Delete.

You will be shown a dialog box asking you to confirm your choice for deletion. 
Choose Yes on this box to execute the deletion.  You will be shown a dialog box that
will tell you that the Deletion is complete.

Note: Confirmation displays can be turned off.  This feature is available in the
Housekeeping section.

Hint: Print a Transaction Report ordered by Asset Number prior to deleting duplicate
assets.  It will be very helpful in identifying reasons for duplication.  Bar|Scan supplies
a System Transaction Report ordered by Asset Number.

Transaction Table Page 12-27



Transaction Table

If the duplicate assets are due to duplicate scans by the Mobile Device, and the two
are identical, it does not matter which asset is deleted.  If, however, the scans are
different, i.e., the Catalog number is different, you must be careful to delete the
incorrect item, and to ensure that it is not two items in reality.

If you are working on transactions ordered by asset number only, the first asset in the
pop-up selection window is always the first asset scanned by the Mobile Device.

Deleting a Large Number of Duplicate Transactions

Someday, you may upload a Mobile Device twice by accident.  Or, a  Mobile Device
may not get cleared before someone chooses it, and continues on with the inventory
process.  When either of these two things happen, you will find that you will have
many exact duplicates in your Transaction table.  Bar|Scan has made resolving these
errors fast and easy.  

With the Transaction table open, you can go to the Main Menu, and select Transaction
. . . <, Range Duplicates.  You have two choices.  Bar|Scan will highlight all of the
items that it finds, that are exact duplicates, with the exception of the upload Mobile
Device file number and with ‘Same Items’, the inventory time, so that they may be
deleted with just the click of the delete button on the toolbar.

Note: this will not range duplicates where any other item is different, i.e., if the person
scanning does a chair, then a minute later does the same chair, Bar|Scan would not
consider that an exact duplicate, as the time has changed.  In this case, you would
choose ‘Same Items’.
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CHANGING ASSET INFORMATION

This feature permits you to correct records in the Transaction table and prepare
records for transfer into the Bar|Scan Asset table.  If you intend to make a group
change, you can use the SET feature to sort your assets and then use the Range feature
to select the asset records you wish to change as shown below.

On the Browse tab, move the highlight bar to the desired asset.  Select the Panel pull
down range, or press F4 and the transaction that you are currently on will change
colors; the default color is green, to show that it has been selected.  You can then use
your up and down arrow keys, the PgUp and PgDn keys, Ctrl + Home or Ctrl + End
key combinations, or your mouse to select additional transactions for your range. 
Once the items that you have selected are all highlighted, press Enter, and then select
the Edit tab in order to make your change(s).

Remember to be careful when ranging that you observe how many items are included
in your range, displayed in the top right-hand portion of the Browse tab.  While it is
a nice feature, being able to start and stop a range, and go to a new item, and continue
a range, it makes it easier to change items accidentally.  

After you have made your changes, press the Save icon on the toolbar, or press the
Ctrl + S key combination to save the changed information.  

Transaction Table Page 12-29



Transaction Table

If you have selected a Range of assets for a specific change, you will see a message
similar to the following when you attempt to save the change.

The information displayed in the message above will change according to how many
items you have ranged.  

If you select the Yes button on the previous dialog box, Bar|Scan will save the
changes to all of the transactions that you have ranged.

Be careful to always clear your range, after saving your changes.

To clear all of the ranges, press and hold the Ctrl + F4 key combination.  The
alternative method of clearing the range can be activated only with the Transaction
table active.  Go to the Main Menu, select Panel, when the drop down menu appears,
select Range, then Clear All.
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Understanding the Validation Process in the Bar|Scan Transaction Table

Bar|Scan processes all TAGS then TAKES.  The system will check for many different
types of errors. 

Note: When Bar|Scan points out an error, it is only a way of showing you that the
information does not match existing data in your Bar|Scan system, i.e., Catalog
number is not on file.  The information in this transaction may be correct, but the
Catalog had never been created before, and the Catalog number has not been entered
into your database, yet.  To correct this error, simply verify that it is a new Catalog,
and then enter the new Catalog into the Catalog table.  Re-validate the Transaction,
and the error disappears.

For instance, when checking Tags, the system will give the “Duplicate Asset #” error
when there are duplicate TAGS in the Transaction table, or if the asset number already
exists in the Asset table.  Note that “Duplicate Asset #” errors do not occur when there
are multiple TAKES for a particular asset number.  Multiple TAKES are updated by
date and time.

For instance, when checking TAKES, the system should verify that the asset is in the
asset table since it will not process the TAKE unless the TAG was processed first. 
If the asset is being created by a TAG in the transaction table, it is not necessary to
determine if the TAG is in the asset or transaction table. 

Both TAGs and TAKEs of the same asset number can be processed simultaneously. 
Bar|Scan will process them in the correct order.

You may view a list of the items that Bar|Scan checks for when doing a validation, in
Housekeeping under Set Transaction Validation Messages.
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Types of Problems in the Problem Handler Tab

This item is provided as part of the Problem Handlers tab, and is used to identify any
problems with an asset record in the Transaction table.  One of two different messages
will appear when you select an asset record as follows.

T A Description of the Problem(s)
T No Problems or Warnings in List

If there is at least one description of a problem that Bar|Scan detected during the
validation process, then the problem(s) needs to be corrected before this record can
be transferred into the Asset table.

To view the problems, select the Problem Handlers tab as shown below.

There are many possible messages which may appear in this window.  Each message
may require a different corrective action.  In some cases, you might only have to
correct an obvious misspelling, in others you may have to remove the asset record
from the Transaction table (a duplicate).  

You may correct an error only to find (when you Save the changes) different errors
are now presented.  Bar|Scan does extensive checking to prevent you from entering
the wrong information into, or destroying good information in the system.
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As long as any of the problem descriptions appear, the asset record may NOT be
transferred into the Asset table.  You will have to first correct the problem(s), and then
print the Transactions before being allowed to move them to the Asset table.

The message No Problems or Warnings in List indicates that Bar|Scan has found no
problems with the asset record and it may be transferred into the Bar|Scan system.
You may however, need to make changes or corrections even if this message is
displayed. 

When you make a change to a transaction that previously had no problems, the record
is automatically validated, but it MUST be printed BEFORE it can be transferred to
the Asset table.

In order to disable the mandatory printing, you can uncheck the “require print” option
on the Company Setting Screen as shown below.
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The following is a list of the error messages that you may encounter, and the main
causes for these error messages.  Some of these items are very rare, and will only be
gotten if you are doing imports, or through malfunctions, or if you need to Reindex. 
Some of these items are human errors and it is hard to cover all of the reasons you
might get the error, but the most common reasons are listed.  If you are getting a
message that you do not understand how to correct, please call your Bar|Scan
representative for assistance.

01 - Unknown Type of Transaction.

This message is very rarely seen.  You will get this message only when Bar|Scan
cannot determine if the transaction was done as a Tag or a Take.  

To correct this error, view the transaction, and see if you can determine the inventory
method, then change the field to reflect either Tag or Take.

02 - Invalid Asset number length.

This means that you have a “set number” for your asset number length, and the
information was entered into the Mobile Device incorrectly.

To correct this error, the asset must be found, and the asset number must be re-entered
into the system correctly.  The only exception to this is when  the Mobile Device is
configured to scan a variable asset number length.  Variable asset number lengths
must have the corresponding padding and justification features set to Yes in Company
under the Housekeeping menu. 

03 - Could not read Asset Number.

This message is very rarely seen.  You will get this message only when a number that
was uploaded could not be read by the computer.  You would have to verify the asset
number by physically going to that piece, and then correct it in your Transaction table.

04 - Duplicate Asset #.  Already in Asset or Transaction Databases.

This message appears when the item has been officially Tagged twice, or possibly
three times.  The duplicated tag will either be in the transaction file (most common)
or may have been moved to the asset file (less common--more complex to correct).
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You must identify which tag is correct and proceed to delete the incorrect tag(s). 

When the asset already exists in the asset database, you must discern why the item
was re-tagged and decide whether the existing tag is correct or if the new tag should
be used instead.  If existing tag is correct - delete the new tag in the transaction table. 
If the new tag is correct, you can update the information in the Transaction table, by
placing the old asset number in the old Asset number field in that transaction,
therefore retaining the old inventory information.

05 - Asset # is not in the Asset Table.

This can happen when you are doing a Take and the asset was never properly Tagged,
but the item had a bar code label placed on it.  Or it can happen when performing a
Tag, with the Mobile Device in a Take mode.

To correct this error the asset should have a Tag performed on it, using the existing
asset number.

If you collected the Catalog Number in your TAKE configuration then you can change
the  TAG or TAKE setting to TAG and revalidate as shown in the example below:
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06 - Catalog Number is not on file.

The catalog developed for that item has not yet been entered into the database.

To correct error, enter all new catalog entries into the database.  If that does not
correct the error, the Mobile Device user entered the number into the Mobile Device
incorrectly, and some analysis is required.  When the correct catalog number is
unearthed, select the transaction, then select the Edit tab, and make corrections to the
catalog.

07 - Catalog Code is not on file.

This can occur when the information is entered into the Mobile Device incorrectly,
such as entering FP1012 instead of EP1012.

To correct this error, you need to find the asset, and figure out what the code should
be, and enter the correct code into the system.  This error is also displayed in
conjunction with error #5.

08 - Condition Code should be G, F, P, or NA, etc.

This can occur when the responses for condition have been changed in the Mobile
Device’s configuration, and not changed on the computer.

The new responses (Condition Codes) have to be entered into the computer to correct
this problem.  You may use the hyperlink feature to access the Condition Code by
clicking on the underlined Condition Code on the Transaction table, then add a new
code.  You may also have to enter a blank condition code as blank can be a legitimate
response.

09 - Status Code should be IU or IS (in use/storage) etc.

This may occur when the responses to the status have been changed in the Mobile
Device’s configuration, and not changed in the computer.

The new responses (Status Codes) have to be entered into the computer to correct this
problem.  You may use the hyperlink feature to access the Status Code table, then  add
a new code.  You may also have to enter a blank status code as blank can be a
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legitimate response

10 - Asset may not be accessible.  Bad HANDHELD COMPUTER response.

This message is very rarely seen.  You would only see this message if you are
experiencing difficulties with your Mobile Device.

If you ever see this message, call your Bar|Scan representative for assistance.

11 - Location is not accessible.

This is a valid remark most of the time.  It is used when an area cannot be accessed
when the inventory crew is actually performing the inventory.

The inventory crew responded with “No” to the question “Is Space Accessible?”

To correct this message, examine why the area was not inventoried, and if it was not
inventoried, use this message as a reminder for the inventory crew until the inventory
is fully performed.

Once the location has been inventoried, simply delete this transaction.

12 - Location not noted.

This message is very rarely seen.  This error will show up on any transaction that does
not list a location or room tag for the asset.  

To correct this error, go to that transaction, and enter the correct location.

13 - Could not read Room Tag.

This message is very rarely seen.  You will only see this error message if you are
experiencing trouble with your Mobile Device.  After uploading the information, the
computer could not read the Room Tag.

To correct this error, you may have to physically visit the room, and write down the
Room Tag number.  Go to the appropriate transaction(s) and enter the Room Tag.  
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14 - Bad tag/take initials. Should be 1 to 3 letters.

Most of the time this will mean that someone just made a typo when entering their
initials into the Mobile Device, but it can also mean there is a communications or
Mobile Device failure.  Check to see if the field for the initials is blank on the
Transaction.

To correct this error, type in the correct initials on the Transaction(s), and save your
change.

15 - Bad Date.

The date is a future date.  This can happen when the date was typed into the Mobile
Device incorrectly.  

To correct this error, go to the date field for the appropriate transaction(s), and correct
the dates. 

16 - Bad Time.

Bar|Scan does not recognize the time listed for the asset.  More than likely, someone
made a typo.

To correct this error, go to the proper transaction(s) and correct the time shown.

17 - Unknown Organization Code.

This happens when the Organization Code that was entered into the Mobile Device
does not match any of the Organization Codes that exist in the computer. 

Both of the Organization codes need to be examined.  If the one in the Transaction file
is correct, it needs to be added to the Organization table.  If the one in the Transaction
table is incorrect, then it needs to be changed to the correct one already existing in the
Organization table.

18 - Invalid Room Tag length. Should be 0 or XX long.

This may occur when the room tag length was set to a specific number in the company
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on the computer, and then the Mobile Device’s user entered a tag number with a
different length, probably a typo.  

If the tag lengths change in reality, the company on the computer needs to be set up
so that it will allow a varied tag length by selecting zero as the length.  Note: The
Mobile Device has a similar feature, under Configure, to allow for compatibility.  
To correct this problem, research the Room Tag by physically going to that room if
necessary.  When you know the correct length, either change the Transaction, or
change the Location, or change the Room Tag length.  

19 - Purchase Order # Missing.

This error message is currently inactive.  You should not receive this message.

20 - Purchase Order # Mismatch.  Asset in Asset table uses a different PO #.

The transaction has a PO # in it that is different from its counterpart in the Asset table.

To correct the error, go to the Asset table and check the PO # there against the PO #
in the Transaction table.  Possibly a typo.  Or, it may be a different asset.  Make the
corrections according to your findings.

21 - Location not in Location Table.

This may mean that the Mobile Device’s user entered the location wrong, or that an
additional location was added, and needs to be entered into the Location table.  

To correct the error, check the Location table to see if you have a location that should
match the entry.  If not, and it is a valid location, you would need to add it to the
Location table, and re-validate.  

If it was entered incorrectly, go to the transaction(s) with this location.  Right click on
the location, select the Look up Value, then select the correct location from the look
up list.  The item(s) will validate when you save your correction(s).
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22 - Room Tag not in Location Table.

This can occur when the location prompt was turned off in the Mobile Device, and a
Room Tag was scanned, but the Room Tag had never been entered into the Location
table (no association exists between the Location and the Room Tag, so Bar|Scan does
not know where the Room Tag exists when it is scanned).

To correct this error, the location of the asset must be verified, and then the Location
table needs to be updated.

23 - Room Tag/Location Mismatch.

This means that the Mobile Device user entered a location that has a room tag in the
Location table, and it does not match the one in the Transaction table.

Verify the actual location of the assets, and check the room tag.  If the location is
correct in the Transaction table, the Room Tag was incorrectly typed into the  Mobile
Device rather than having been scanned, or less likely, the room has two Room Tags. 

Also, a room tag could have been replaced with a different tag due to damage and the
Location table was not updated.

If the actual location is different from the one that was entered, then the room tag may
be correct.  To correct this, a new location assignment is made.  Enter the new
location into the Location table, using the Room tag from the Transaction table.  

Remember that right clicking on the location field on the Transaction table, and
selecting Look up Value,  will list all valid locations and their corresponding room
tags.  Pressing F5 at the Room Tag item will display the same list in room tag order.

24 - Replacement Asset # already exists in the Asset Table.

This error is caused when doing Takes with the Mobile Device, and the user responds
Yes to the prompt, Replace Asset Label?  This error most often occurs when the
operator of the Mobile Device responds Yes (to replace the Asset label), after
scanning the Old Asset number, then scans the New Asset number, as it should be
done in the opposite order.  When label replacements are necessary, the New Asset
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number needs to be scanned first.

This error can also occur when the Mobile Device operator does not apply a New
Asset label to replace the old one, i.e., if the item has two Asset labels on it, and one
label is intended for deletion, but both Asset labels are in the system.

To correct this error, view the Asset label that has been removed from the piece.  If
this number is listed in the Transaction table as the New Asset number, and there is
a different one listed as the Old Asset number, you simply need to reverse the two
numbers, changing also the Asset number field, and save your changes.  If there were
two labels, and both appear in the Asset table, you will have to check both Assets in
the Asset table, and view their Catalog information.  You may have to add a Take
moving one of these Assets to a “Deleted” location, and do another label replacement
for the other label.

25 - Old Asset # is not in the Asset Table. 

View information on error # 24, to see the types of things that can cause this error.

26 - Old Asset # in neither the Asset nor Transaction Tables.

View information on error # 24, to see the types of things that can cause this error.

27 - Purchase  Order # Mismatch.  Tag Asset in Transaction table uses a
different PO #.

There are two transactions with this Asset number, but both of them have a different
PO #.  This may be a typo.

To correct this error, view both transactions’ PO # information.  If there was a typo,
simply correct the wrong one.  On rare occasions, the numbers are totally different,
and you may have to retrieve the PO # from the original paperwork to see which is
correct.

28 - Unable to update corresponding Location table record.

This error message is currently inactive.  You should not receive this message.
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29 - Requires (re)validation or not validated yet.

This item will appear on all transactions that have never been
validated.  To correct this error message, simply validate the
transaction by pressing the button.

30 - Serial # mismatch.  Asset Serial # does not match Transaction Serial #

This message will appear to let you know that the Serial number for the same asset,
is listed two different ways.  This is most often caused by someone scanning the serial
number, while someone else hand typed it.  Some Serial numbers that can be scanned
include the model number, and sometimes a manufacture date.  When hand entering
the serial number, the model number is not listed as part of the Serial number.  

To correct the error, you will need to view both the Asset Serial number and the
Transaction Serial number.  If one of the Serial numbers contains the other, simply
delete the shorter one.  If the Serial numbers are vastly different, someone needs to go
back to view the actual asset, and see which number is correct.  (Sometimes there is
more than one Serial number listed on an asset, one being just for a part).

Check that the Catalog numbers are the same.  If the Catalogs are the same, the Serial
Numbers may be different but it may be the correct asset.  View the differences in the
Serial Number, and see if during one of the inventories the Serial Number was
inaccessible, and on the other inventory it was accessible.  There may have been a
typo where the Serial Numbers appear very similar, but someone thought a 5 was an
S.  In this case, viewing the piece may be the only way to see which was right. 
Determine the correct Serial Number, and change the wrong one to make both Serial
Numbers the same.

31 - Could not read Previous Location Room Tag.

This message is very rarely seen.  You will only see this error message when Bar|Scan
cannot read a Previous Location Room Tag that was uploaded from a Mobile Device,
or through an import.

To correct this error, investigate the information on the items inventoried both before
and after this transaction to help establish where this item was inventoried.  Normally,
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you will be able to determine what the Room Tag was supposed to be without
revisiting the room.  Change the transaction’s Previous Room Tag according to your
findings.

32 - Previous Location Room Tag/Location mismatch.

This can happen when you are using both Previous and Current Locations and
someone makes a typo on the Previous Location.  Or, the Previous Location is listed
incorrectly in the Location table.  Or, when someone accidentally scans a different
Room Tag without changing the location that is already in their Mobile Device.

To correct this error check the information in the Transaction table and the Location
table.  You may have to revisit the actual location to determine which entry is correct. 
Correct the information in the Transaction or Location table, according to your
findings.

33 - Unable to update Previous Location corresponding Location table record.

This error message is currently inactive.  You should not receive this message.

34 - Previous Location Room Tag not in Location table.

This can happen when you are using both Previous and Current Room Tags when
inventorying your transactions.  The Room Tag that was entered into the Previous
Room Tag field does not match anything in the Location table.  Someone may have
hand typed the Room Tag incorrectly.  Or, the Room Tag was never in the Location
table or has since been deleted.  

To correct this error, you may have to revisit that room to see if the Room Tag number
is correct.  If it is correct, check the Location table to see if the location exists at all,
or if it exists with no Room Tag or a different Room Tag.  Correct the information on
the transaction or in the Location table based on your findings.

35 - Previous Location not in Location Table

This error can occur when Assets are entered at the keyboard directly into the Asset
table with an incorrect Location, or if a Location was previously valid, and has since
been deleted from the Location table.
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To correct this error, view the Prior Location.  If the correct Location exists in the
Location table, select it.  If not, add the Location into the Location table.

36 - Invalid Previous Location Room Tag length.

The Room Tag is set to a specific length for this company.  The Room Tag
information in the Previous Room Tag field is not the correct length.

To correct this error, make sure that the information in the Previous Room Tag field
is a valid Room Tag.  It may be that someone accidentally scanned the wrong field or
hand entered the information incorrectly.  Look at the Location fields that are equal
to this Room Tag.  Check the Location table to see if you can simply select the correct
location and Room Tag.  The item will be re-validated when your changes are saved. 

37 - Not enough [Z] Assets matching Catalog and Previous Location.

When Z number assets are recorded for a move, you enter both a previous location
(for a move from location) and a current location (for a move to location).  This
message will appear when you do not have enough items in the Asset table to
complete the transaction as stated.  

To correct this error, you may have check how many items you are trying to move, it
may be a typo.  Correct the quantity on this transaction and save your change.

Or, you may have added Z number assets to the total that will be your move from
location, but they are not yet in the Asset table.  Move your previous additions to the
Asset table, and re-validate.

If you add additional fields to the Company Settings Screen, Quantity Asset Tab, these
are taken into account when looking for matching Z number assets.  So for example,
if you add PO#, then do a take without the PO# prompt, this error will appear.

38 - The previous valid TAKE moves this Asset out of the Previous Location.

This Transaction was recorded with both a Previous Location and a Current Location. 
There is already a Transaction that shows this item being moved from the Previous
Location.  Probably, this information was accidently recorded twice.  But, if both
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moves seem to be valid, more investigation is necessary, and on rare occasions you
may have to physically go to the Current Locations listed on both transactions to view
the Asset numbers.

To correct this error, check to see if the item was simply recorded twice, and if there
was something missing on the first one.  If there second recording of the move is more
accurate, you can delete the first one, and re-validate the second.

If both moves seem valid, you may have to view the Current locations on both
Transactions to see if the Asset number itself was incorrectly entered on one of these
items.  Change the Transaction according to your findings, and save your change.

39 - Location Mismatch: Previous Location not equal to corresponding Asset’s
Current Location.

This item was recorded with both a Current and a Prior location in the Transaction
table.  When the corresponding Asset information in the Asset table was checked, the
Current Location in the Asset table should be the same as the Prior Location in the
Transaction table.  For this item, they do not match.

To correct this error view both the Prior Location in the Transaction table, and the
Current Location on this Asset number in the Asset table.  It may be that the Location
is the same, but was entered differently.  Or, it could be that a move made in between
these was not recorded, or the recording of the move has not yet been uploaded.  Make
sure that all of your Mobile Devices have been uploaded.  If all of the Mobile Devices
have been uploaded, and the information is correct, you may have to record a move
as having happened prior to the move with the error.  Once this move is recorded and
has been saved, re-validate the transaction with the error.

40 - A preceding TAKE’s Location Mismatch prevents update of this Asset.

This error message is currently inactive.  You should not receive this message.

41 - Bad Move date.

This error message is currently inactive.  You should not receive this message.

42 - Bad Move time.
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This error message is currently inactive.  You should not receive this message.

43 - Asset # Quantity changed.  Re-validation required.

The movement of Z number assets can cause this message.  

To correct this error, simply re-validate the transaction. 

44 - Asset # should start with a [Z].

This error message is currently inactive.  You should not receive this message.

45 - Previous location is missing.

This error message is currently inactive.  You should not receive this message.

46 - Quantity <> Quantity in Asset table for current Catalog and Location.

This error message is currently inactive.  You should not receive this message.

47 - Serial # mismatch in corresponding TAG Asset in Transaction table.

There are two Transactions listed that have the same Asset number, but both list
different Serial Numbers.  This may be because the first item was recorded without
finding a Serial Number, and then re-scanned when a Serial Number was found.

To correct this error, view both transactions, and both Serial Numbers.  You may be
able to tell why the item was re-inventoried.  If the asset information appears to be
good, and they were not inventoried one right after the other, it may be that someone
made a typo.  If this instance, you may have to physically go to the asset and view the
Serial Number and correct the data according to your findings.
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48 - Work Order # not found in Work Order table.

A transaction lists a Work Order # in the Work Order field, but it does not have a
corresponding Work Order in the Work Order table.  It may be a typo.

To correct this error, view the Work Order number in the Transaction table.  It may
be that someone mistakenly entered the wrong information into this field, or they
simply made a typo.  View the Work Orders in the Work Order table, and see if you
can tell what the actual Work Order number is.  Correct the transaction according to
your findings, and save your changes.

If your company does not use the Work Order table, but you want to store data in the
Work Order field, you may want to change this validation message to view this as a
warning or disable this message.  Before disabling a message, contact your Bar|Scan
representative, there may be a reason you should not do this.

49 - This Asset not requested in this Work Order.

This transaction was recorded with a valid Work Order number in the Work Order
field.  But, when the information was compared with the information in the Work
Order, this transaction was not specified in this Work Order.

To correct this error, view both the Transaction and the Work Order.  It may be that
someone mistakenly added the Work Order number to the wrong transaction, or to too
many transactions (to 5 chairs not 4) or that a specific asset was requested in the Work
Order, and the transaction is the same type, but not that specific asset.  Correct your
transaction according to your findings, and save your changes.
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50 - Duplicate Serial #.  In use by another Asset in the Transaction table.

This item was recorded using a Serial Number that was already being used by another
transaction.  This can happen if an item was tagged twice, when someone did not see
the first tag on it.  Sometimes, someone may have misread the serial number and it
matches another item (in this case both items would have to be looked at).  In some
cases, the different manufacturers may have actually used the same Serial Number,
although this is very rare, it can happen on Serial Numbers of a short length.

To correct this error, view both Transactions and both Serial Numbers.  It may be that
the item was re-scanned only moments after the first item, because of a mistake in
another field.  If not, you will probably have to go to each asset, and view the Serial
Numbers.  Correct the data according to your findings, and save your changes.

51 - Asset and Transaction Location Types must be the same (DOS only).

This error message is currently inactive.  You should not receive this message.

52 - Invalid location type.

This can happen on an item that was imported.  The location type field may have
erroneous data in it, or it may just be a typo.

To correct this error, view the location, and correct the type according to the
information in the location.
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53 - Not Validated - Belongs to another company

This error is caused by the information in the Company Code field of the Asset not
matching the Company database Company Code.  If you have a multiple company
version of Bar|Scan, you may have uploaded to the wrong company, and the
information needs to be transferred to the correct company.  If you do not have a
multiple company version of Bar|Scan, you do not need to use a Company Code.

To correct this error, check to make sure you have uploaded to the proper Company. 
If you only have one company, or if you know you have uploaded to the correct
company, you will need to go to the Transaction table.  Select an asset with the error,
and choose the Edit tab, and then select the second tab which says Inventory.  On the
right-hand side of the Inventory tab, you will see the field listed as Company.  Place
your cursor inside the Company field, right click, and select Look up Value.  If you
see only what is in your field, and a blank, select the blank.   If there is another
Company Code listed, you may have to select the other Company Code.  Save your
change.  If the item now validates correctly, go back to the Browse panel, and Range
all of the items that have this error, and repeat the process.  To avoid this error next
time you upload, find the Mobile Device that has a Company Code listed, and clear
that field, or change it to the proper Company Code.

54 - Completed Work Orders may not be updated.

This can happen when a Work Order was marked as completed, and then the Work
Order number was used on a transaction.  

To correct this error, view the transaction’s Work Order number, and if it appears to
be a valid Work Order number, you may have to view the Work Order.  It may be that
it was a typo.  On rare occasions, part of the Work Order may have been verbal, and
you may have to add a new Work Order and change the Work Order number on the
transaction accordingly. 
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55 - Data exists in one of the location fields not used by this Location Type.

This error may appear when you use more than one Location Type, i.e., Site, Pallet,
or Vault.  When creating the Locations in the Location table, you have the option of
using a template of a current Location.  For instance, you may select a Site location
as the one to use as your template, when you are actually creating a Pallet location. 
The Site Location contains fields that are not in the Pallet Location, i.e., Region.  If
there is data in the Region field of the Site Location that you chose as your template,
and you switch the type to Pallet, you will not see the Region listed, but the
information is still listed in the Region field.

To correct this error, go to the Location table, view the Location which is used by the
Transaction(s) with the error, and remove the information in the field which does not
show up as part of the Location Type which you have selected, in this case Pallet.  In
this example, there is an MP that shows up in the Region field of a Pallet Location as
shown below.  Pallet Locations do not use the Region field.  You would remove the
information in the Region field while on the Browse panel, and save your change.

Then, return to the Transaction table, and  re-validate the Transaction(s) which had
this error.
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56 - Missing Location History entry.

There is a Missing Location History entry for this asset number in the Asset table.

To correct this error, go to the corresponding asset in the Asset table, and view the
Location History.  See if you can reconstruct the missing Location History entry.  You
may need assistance from your Bar|Scan dealer to correct this information.

57 - ‘Z’ Asset #, Catalog and Location do not belong to each other.  Re-validate.

This Z number already exists in the Asset table, but the current record in the
Transaction table (although it has the same Z number) has specified either a different
Catalog or a different Current Location.  

To correct this error, please re-validate.

58 - Inventory date/time matches existing Location History or Transaction item.

In most cases this is due to not clearing the handheld after a synchronization.  First,
try the Range Duplicate feature below:

If the date and time in the Transaction Table matches the date and time in the Asset
Table Location History then this Transaction would be a duplicate.  You can delete
this transaction as you already have it in the Asset Table.

If there are a lot of items with this message, you may have uploaded a Mobile Device
twice, and changed some of the data on one set of these items.  In this case, Bar|Scan
no longer views them as exact duplicates, and will not Range them during a scan for
duplicates.  It may be that you can use a Housekeeping feature to force Bar|Scan to
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adjust the times for you, so that you don’t have to do this manually.

59 - Label replacement already exists for this Asset in the Transaction table.

This can happen when someone re-enters the take and label replacement in a Mobile
Device on purpose, and one of the entries has to be deleted.  On rare occasions, it can
happen when an item has two new asset tags on it (because someone did not see one
of them).

To correct this error, view both items in your database.  You may have to physically
go to the asset in question.  Change the transaction according to your findings.

60 - Label replacements may only be performed on a TAKE.

This can happen when an item has been changed from a Take to a Tag, and label
replacement information was previously recorded on this transaction.  Or it can
happen when you try to do a label replacement using a TAG in the Transaction table.

To correct this error, view the old and new label information on the Problem Handlers
tab.  If this information is correct, make sure that the item is a Take, not a Tag.  Save
your changes. 

61 - Duplicate Serial #.  In use by another Asset in the Asset table.

This item was recorded using a Serial Number that was already being used by another
asset.  This can happen if an item was tagged twice, when someone did not see the
first tag on it.  Sometimes, someone may have misread the serial number and it
matches another item (in this case both items would have to be looked at).  In some
cases, the different manufacturers may have actually used the same Serial Number,
although this is very rare, it can happen on Serial Numbers of a short length.

To correct this error, view both the Asset and the Transaction and both Serial
Numbers.  You will probably have to go to each asset, and view the Serial Numbers. 
Correct the data according to your findings, and save your changes.

62 - Negative Qty not allowed for a Move.  Make positive, swap locations.

This error message is currently inactive.  You should not receive this message.
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63 - Not enough [Z] Assets in Asset table during Move.

This Transaction is moving a quantity of Z Assets from one location to another.  The
source location does not have enough Z Assets in the Asset table to cover the size of
this move.  

Note: This message will not appear during a normal validation of the Transaction
table, but only during a Move.

64 - Date+Time+Catalog+Prior Location duplicated in another Transaction.

The current Transaction is a TAG done at a specific location and time of a specific
Catalog.  All of the information regarding the Date, Time, Catalog, and Prior Location
are duplicated exactly in another Transaction. 

To correct the error, look at both Transactions.  More than likely, this information was
uploaded more than once, and the correction can be made by using the Range
Duplicates feature, and deleting the duplicate.  

Note: This will only range exact duplicates, so if something has been changed in one
of the items since the upload, that item will not be considered an exact duplicate.

65 - Date+Time+Catalog+Current Location duplicated in another Transaction. 

The current Transaction is a TAG done at a specific location and time of a specific
Catalog.  All of the information regarding the Date, Time, Catalog, and Current
Location are duplicated exactly in another Transaction. 

To correct the error, look at both Transactions.  More than likely, this information was
uploaded more than once, and the correction can be made by using the Range
Duplicates feature, and deleting the duplicate.  

Note: This will only range exact duplicates, so if something has been changed in one
of the items since the upload, that item will not be considered an exact duplicate.
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The entire list of errors that Bar|Scan will print an error in the Transaction table for,
can be viewed by going to the Main Menu, File, then Company . . . <, Housekeeping
. . . <, Set Transaction Validation Messages.

Validate, print, mark the Transactions as printed, then from the Main Menu, select
Transactions . . . <, Move . . . <, All.  All Transactions that have no error messages
will be transferred into the Asset table, with one exception; those with the "Hold"
feature described in the next section.

66 - Quantity is Out of Range.  Must be -9,999,999 through 9,999,999.

Bar|Scan will only accept ‘Z’ numbers (and quantities) with the range delineated
above.  This is because in most cases any number outside of this range is a data entry
error.  If you are really recording quantities in excess of these boundaries, you can
disable the Error.

67 - More than one corresponding ‘Z’ asset in Asset Table.  Run Table Integrity 
‘Correct Z Asset #s and Merge Duplicates’.

Bar|Scan allows only one ‘Z’ number per Catalog, Location and PO combination. 
There can be times, especially when an index has been corrupted, that two ‘Z’
numbers are created when only one is desired.  Running the Table Integrity function
mentioned in the message will properly combine the ‘Z’ numbers and their associated
quantities to correct the problem.

68 - Data was truncated in 1 or more columns during import or handheld
computer upload.

Bar|Scan allows you to change the length of many fields.  Usually fields are
lengthened to accommodate more information.  If you shorten fields that are used in
your Mobile Device, you should do so only after you have synchronized your Mobile
Device and clear the data out of it.  Otherwise your Mobile Device may contain
information that will be truncated during the upload.  In you loose critical data,
lengthen the field again and import the Mobile Device data again from the Mobile
Device backup file located in your Company Reader Folder on your PC.
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69 - Comments may not be blank.

By default, Bar|Scan allows blank comments.  This can be changed on the Accounting
Tab of the Catalog Screen to make Comments a mandatory response.  Mandatory
comment responses are useful when collecting certain Catalog information. For
example, you could Range all of your Printer Catalogs and force the operator to place
information such as “networked” or “freestanding” in the comment field during an
inventory.  This means that the Catalog can control whether a comment response is
required.

70 - Serial # length does not match those specified in the Catalog.

Similar to the Error 69 above, Bar|Scan allows you to create some additional rules
based on the Catalog.  Most manufacturers have serial numbers of a particular length
on a particular model of equipment.  By setting serial number rules, you can limit the
number of incorrect scans.  For example, certain laptop computers have multiple bar
codes.  Some of these bar codes are product number or service tags.  By allowing only
particular serial number lengths, you can usually identify when the wrong bar code
such as a service tag was scanned in error.

71 - Asset number must consist of only numeric digits

By default, this Error message is set to “Disabled”.  You can enable this validation so
that all transactions must have numeric asset numbers. 

72 - Tags require a Serial Number entry

By default, this Error message is set to “Disabled”.  You can enable this validation so
that all Tag transactions must have serial numbers. 
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73 - Take-Catalog Mismatch.  Disabled= Overwrite .... Transaction Catalog

The complete message is “Take-Catalog Mismatch.  Disabled=Overwrite Transaction
with Asset Catalog.  Warning/Op#1=Overwrite Asset with Transaction Catalog.”

Transaction message #73 is a 4 state for TAKE's:  it flags mismatches between the
Transaction Catalog and the Asset Catalog. Default value is DISABLED, changing
the Asset catalog (using the Transaction catalog).

Error(Enabled) -Move prevented, warning message issued, No change to Asset or
Transaction catalogs.

Disabled -Move allowed. No warning message. Asset catalog changed (to
Transaction catalog). Transaction catalog unchanged.

Warning -Move allowed. Warning message. Asset catalog changed (to Transaction
catalog). Transaction catalog unchanged.

OP#1 -Move allowed. No warning message. Transaction catalog changed (to Asset
catalog). Asset catalog unchanged.

Note that THE DIFFERENCE IS THAT THE FUNCTION OF ‘DISABLED’ AND
‘OP#1’ HAVE BEEN SWITCHED.  The old default (i.e. message was DISABLED)
 was to overwrite the Transaction catalog with the Asset catalog. The NEW default
(no change in the default setting, it is still DISABLED) overwrites the Asset catalog
with the Transaction catalog.

By default, this Error message is set to “Disabled”.  This means that on a  TAKE
inventory, the Catalog Number (XX9999) is obtained from the corresponding asset
in the Asset Table.   You can enable this validation if you wish to do a TAKE and
prompt for Catalog.   The Catalog Number collected in the Mobile Device then has
priority.  You would perform this type of inventory if you did not have confidence in
the existing Catalog Numbers being previously collected for your Assets or you wish
to change the Catalogs, for example to either add or remove Catalog detail.
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74 - Reserved Bill of Materials not found

The Mobile Device has collected and uploaded a Reserved Bill of Material Number
that does not exist in the Reserved Bill of Materials Table.  See the indicated location
for this field in the example below.

This error can occur because of a typo or the Reserved Bill of Material Number
existed but was deleted in the Table.

75 - Reserved Bill of Materials complete.  Once completed, no .... added.

The complete message is “Reserved Bill of Materials complete.  Once completed, no
more items may be added.”

The Mobile Device has collected and uploaded more items than specified for a
Reserved Bill of Material Number.
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76 - Assets currently reserved by a different Bill of Materials Reservation

The current transaction specifies a “Reserved BOM#”. However, the specified number
is not the Bill of Material actually reserving this asset, it is another.

77 - Both Reserved .... Work Order does not use this Reserved Bill of Materials

The complete message is “Both Reserved Bill of Materials # and Work Order #
specified, but Work Order does not use this Reserved Bill of Materials #”

By default, this Error message is set to “Disabled”.  You can enable this validation so
that all Tag transactions must have serial numbers.
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78 - Unable to reserve Asset

The current transaction specifies a Reserved BOM# that exists, but that BOM does
not yet have this asset in its list. An attempt was made to add it to the list during the
move from the Transaction table to the Asset table, but for some unknown reason it
was not successful.

79 - This asset is a component ... it must be in the same location as its parent

You can specify whether or not you would like the components to be in the same
location as their parents.  This is specified on the Asset’s Bill of Material Tab by
check marking ‘Keep Together’ as shown below.

If a component is then inventoried by a handheld and found in a different location
than the parent asset, you will receive this error.

In a warehouse, this might not be the case and you might consider changing this
message to either a Warning or Disable the message.  Your selection is dependent on
your situation. 
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80 - This asset is a component ... It’s master asset must be in the Transaction
Table also

The complete message is “This asset is a component asset.  It’s master asset must be
in the Transaction Table also.

81- Aux Z field value mismatch.  TAG asset in Transaction Table uses a different
set of AUX Z field values.

You determine which combination of fields will make a Z number.  This is done on
the Company Settings Screen on the Qty Assets Tab.  This error means that existing 
quantity items do not have the same combination of fields that were just used.  The
most common reason for this is that the fields were changed on the Company Settings
Screen on the Qty Assets Tab.  There are several different ways to correct this issue. 
It would be best to obtain further guidance from your Bar|Scan Dealer before
proceeding.

82- Different AUX Z field values already in use by this Asset.

You determine which combination of fields will make a Z number.  This is done on
the Company Settings Screen on the Qty Assets Tab.  This error means that existing 
quantity items do not have the same combination of fields that were just used.  The
most common reason for this is that the fields were changed on the Company Settings
Screen on the Qty Assets Tab.  There are several different ways to correct this issue. 
It would be best to obtain further guidance from your Bar|Scan Dealer before
proceeding.
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83- Prior Organization not allowed in a ‘TAG’.

For inventories that require an Asset Number.  Bar|Scan does not allow you to collect
historical information such as Prior Organization, Prior Location, Name etcetera.  
Quantity inventories do allow Prior Location and Prior Organization.

84- Org Code Blank, Prior is not blank.  Not allowed.

You cannot enter a Prior Organization Code and leave the Current Organization Code
blank.  In any case, only Quantity inventories allow you to enter a Prior Organization
Code.

85- Unknown Prior Org Code.

This happens when the Prior Organization Code that was entered into the Mobile
Device or the desktop computer does not match any of the Organization Codes that
exist in the Organization Table. 

Both of the Organization codes need to be examined.  If the one in the Transaction file
is correct, it needs to be added to the Organization table.  If the one in the Transaction
table is incorrect, then it needs to be changed to the correct one already existing in the
Organization table.

86- Prior Location not allowed in a ‘TAG’

You cannot enter a Prior Location in TAG Mode under any scenario.  Bar|Scan does
not allow you to collect historical information such as Prior Location for any Asset
or Quantity that you are just entering for the first time.   
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87- Name not in Personnel table.

The Name that was entered does not match any Names in the Personnel Table.  You
must change the name to match.  You can right click and then select a name from the
list or type the correct Name.  If you prefer not to validate Names against the
Personnel Table, you can select NONE as the Name Validation in the Company
Settings Screen as shown below. 
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88- One or more target Asset fields is shorter or has fewer decimals than the
source Transaction field.  Data may be lost during move.

Using the User Defined Fields Module, you can modify existing Bar|Scan fields by
stretching or shrinking their length as well as changing their formatting by using an
input mask.  For example, you can create a field in the Transaction Table called
Freight and have the data in this field move to the existing standard Bar|Scan Freight
field in the Asset Table.  The default length for Freight in the Asset Table is 16,2
(sixteen with two decimal places).  If you create a field in the Transaction Table that
is longer then there is a possibility of data being lost when moved from the
Transaction to the Asset Table.

If you receive the message then you will need to examine all UDF’s on both the Asset
and Transaction screens (including those that you have decided to hide) and to
visually compare them to verify that they are the same length and decimal length. 
Bar|Scan doesn’t mind if something shorter moves into something longer (e.g. a
Transaction field sized as 99.99 moving into an Asset field sized as 999.999 is ok),
but otherwise all fields must match.  This should also include retargeted Transaction
fields, where a UDF moves into a different field. (In this case, whether the field is
retargeted or not, the Asset and Transaction characteristics of the UDF still have to
match.)

Finally, there are three tables that are being compared, the Asset, Location History and
Transaction Table, so you will need to perform a Table Integrity after making your
adjustments.
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89- Prior Name not found in Personnel Table 

If you receive the message, this is a validation error for the Asset Table’s Location
History.  Enabling this as an ‘error’ will check not only the current name in the current
location in the asset table, but also the prior name in the prior location in the location
history whenever the Location History is saved.  In summary, if this is set as an error
it will check the name in both the current and prior location. If it is not set as an error,
it will only check the current location.

90- Asset received date before purchase date

If you receive the message, then your Receive Date is older than your Purchase Date
for this Transaction.  Typically, assets cannot be received prior to being purchased. 

91- Purchase Order # does not match Purchase Order # in related Work Order

If you receive the message, then the Purchase Order collected in the handheld is
different that the Purchase Order already entered for this Asset.  You will need to
verify which one of the two Purchase Orders are correct and change the other to
match.

92- Xml in Extra Field has a problem or MSXML 4.0 SP1 or later not installed

If you receive the message then the data collected in the handheld device may include
fields which do not exist in the Transaction table. To hold this data it is stored in
XML format in the TR_XTRA field. To retrieve this data, whether for validation or
to move it to its appropriate table and field, there are two basic requirements: 

(1) Bar|Scan’ s internal XMLAdapter class must be available. This class requires
MSXML 4.0 or later be installed on the workstation. This is normally installed with
the Bar|Scan Workstation installer.
(2) The data must be well formed. There are a variety of factors that contribute to
XML being well formed (See http://en.wikipedia.org/wiki/XML). A violation of any
will cause an error. Some of these are:

a. The document contains only properly encoded legal Unicode characters
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b. None of the special syntax characters such as < and & appear except when
performing their markup-delineation roles
c. The begin, end, and empty-element tags that delimit the elements are correctly
nested, with none missing and none overlapping
d. The element tags are case-sensitive; the beginning and end tags must match
exactly.
e. Tag names cannot contain any of the characters !"#$%&'()*+,/;<=>?@[\]^`{|}~,
nor a space character, and cannot start with -, ., or a numeric digit.
f. A single "root" element contains all the other elements.

The most likely causes of this error are (1) MSXML 4 was removed or not installed
or (2) the data is not well formed because either some of it is missing due to a
problem during transmission from the handheld or because it was inadvertently edited
by the user.

93- Work Order Line Item not found

This error occurs when a work order line item specified in the transaction table was
not found. This will occur when a work order line item has been sent for editing to the
handheld but has been deleted within Bar|Scan after being sent to the handheld device.
When the data is returned marked as edited, it cannot find the original Work Order
line item.

94- Work Order Line Item already exists

This error is the converse of # 93. The handheld device has added a new line item to
a work order, but someone else has already created such a line item within Bar|Scan
after the Work Order was sent to the handheld.

95- Work Order already exists

The handheld device has created a new Work Order, but someone else has already
created a work order with the same number before it was moved from the handheld
to Bar|Scan.
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96- Missing Asset #

This error occurs when the TAG or TAKE process is a service order operation
(“SERVICE”) rather than a TAG or a TAKE and no Asset number has been specified.
Asset numbers are required.

97- Invalid Move Action

This error occurs when the TAG or TAKE process is a service order operation
(“SERVICE”) rather than a TAG or a TAKE and the “Service Move Action” field
(TR_MVACT) does not have a valid value. It must be either “A” (add),”C” (change),
or “D” (delete).

98- Non-z asset quantity must be 1

This error occurs when the Quantity field (below the asset# field) has any quantity 
entered other than the number 1.  Assets are not allowed to have multiple quantities. 
Only quantity inventories (Z numbers) will allow multiple quantities.

98- No Asset in Asset table and Transaction TAG asset has problems.

This error occurs when the current transaction is a TAKE. However, there is no
corresponding asset with the same Asset number in the Asset table. There is, however,
a corresponding TAG in the Transaction table, but it has problems. This prevents an
attempt to move this valid TAKE to the Asset table until the TAG can be corrected
and moved first.  Correct the TAG and revalidate.
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VALIDATING AN ASSET

You may use the Validate icon on the Transaction table toolbar to Validate all of your
Transactions, or in conjunction with a Range (F4) of assets.  

PRINT TRANSACTION FILE

This feature provides important aspects of the process of preparing the Transactions
for their move into the Asset table.

T By default, all assets must be printed  before they are permitted to be transferred
into the Asset table.  This report is used as an audit trail.  This feature can be
disabled in the Company Settings Table.

T Second, each asset record may be printed, sorted by location or other pertinent
information for auditing your work.

T Third, you can produce reports containing groups of assets with problems so they
can be handled and corrected more efficiently.

After asset record information is transferred from the Mobile Device into the Bar|Scan
Transaction table, it must stay there until it is correct and validated for accuracy, and
printed.  You may end up printing some of your Transactions several times, on
different reports.

When asset records are first transferred from the Mobile Device, you will want to
print (and validate) a list of all asset records for review.  You will also want to print
a complete list of asset records containing problems.  

After asset records have been validated and a report containing the validated assets
has been printed, you may use the Move Selected Transaction Data to The Asset table
icon to transfer the new asset information into the Bar|Scan system.  All of the
Transactions will be moved if none of them are selected (Ranged).
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USEFUL TYPES OF REPORTS

Correcting and validating the Transaction table is in many ways more common sense
than a scientific method.  Obviously, familiarity with the assets is an important factor. 
There are three basic types of Transaction Reports that are needed to correct most
types of errors as follows:

All Transactions ordered by Location (for auditing) - useful to carry around post-
inventory to correct errors that require a revisit of the asset.  This is the most
commonly used report. 

All Transactions ordered by Asset Number - useful to correct duplicate asset scans
since each duplicate asset numbers are printed one after the other. 

All Transactions ordered by Inventory Initials, Inventory Date, Inventory Time -
useful for most other types of corrections since the order matches the order in which
the inventory was performed.  Reviewing assets in this order, shows exactly the order
in which the inventory crew scanned the assets.

Report filters are very useful when printing reports.  To define or change a filter, go
to the Report table, and select the report, then the Edit tab.  You may then add or
change the filter on the filter tab.

Page 12-68 Bar|Scan 



Chapter 12

PRINTING THE REPORT

When you want to print the Transactions, simply go to the Main Menu, select File,
then Open . . . <, Reports . . . <, then Bar Code Transaction (or All).  On the Browse
panel, select the Report that you would like to print.  Or, if you have the Reports
toolbar on your Main Menu, you may click on the Bar Code Transaction Report icon
that is shown below.  

You can also print by clicking on the print icon on the Transaction Table toolbar, or
right-click the print button to select or change the desired report to print as shown
below. 

Bar|Scan provides a choice of several different System Reports.  The first of these
reports lists all the Transactions by asset number.  The second report lists all
Transactions by Inventory Initials, Inventory Date, and Inventory time.  The third
report lists only asset records with problems.

The last report lists only asset records which have no problems.  Whenever you intend
to transfer asset records from the Transaction table to the Asset table, it is
recommended you run this report.  

You can always make your own reports in addition to the ones listed as system
reports.  

You may have additional reports in the selection window.  These are reports that were
created using Bar|Scan as described in Chapter 10 - Report Table.
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MOVE SELECTED TRANSACTIONS TO THE ASSET TABLE

This feature actually transfers the good asset records from the Transaction table into
the Bar|Scan Asset table.  When the move is complete, the asset records which have
been transferred will be removed from the Transaction table.  

You may select this feature by using the Main Menu Transaction pull down, and
select Move, All or Selected, or you may use the Move Selected Transactions to the
Asset table icon on the tool bar.

Once this process is completed, and further changes or corrections are required, you
will have to access the Bar|Scan Asset table.

Just prior to selecting this feature, we recommend you print a complete list of
Transactions which you will transfer.

When you select Move Transactions to the Asset table, whether selected or all, you
will see a dialog box similar to the one below.

As shown above, you may see that none of the transactions have been printed. 
Bar|Scan may require that you validate and print the transactions before they can be
moved.  This requirement can be turned off on the Company Settings Panel.
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Once you have validated and printed the transactions, any of those that have no errors
that Bar|Scan detects, and any that are not on hold, will be available to move to the
Asset table, as shown below.

Bar|Scan does additional testing of data when the transactions are being moved to the
Asset table.  Data is checked in both the items that are being moved, as well as their
counter parts that are already in the Asset table.  To move the transactions that are Ok
for Update, select Begin.  If you are not ready to move the transactions, select Close.

If you do not wish to print a Transaction Report prior to a move, this feature can be
unchecked in the Company Settings screen.

If you encounter errors during a Move, the entire Move will be cancelled, and the
changes to the items will “roll back” to the way they were before the change.  If the
error was on the Transaction rather than the Asset, check the Problem Handlers tab
on the item(s) where problems were found before you validate.

If errors are found during a Move, or if you think you might have errors that will
affect your Move, select the check box next to “Allow Partial Moves” shown above. 
If this item is checked, the move will go a lot slower.  But, if there is an error found,
all of the Move will take place except for the item(s) with error(s).  Then, you can
investigate the error(s) and correct the data.  Once corrected, validated, and printed,
you can Move the remaining transactions to the Asset table.
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USB SYNCHRONIZATION 

This section provides the instructions for transferring the asset information from the
Mobile Device to the Bar|Scan Transaction Table.

You will also want to review the chapter on the Mobile Device for instructions on the
proper set-up of the Mobile Device.  Some of those instructions will be repeated in
this section for your convenience.

From the Main Menu, select File, then Open . . . <, Handheld Computer. . . <, then
Synchronize as shown in the example below. 

Or, if you have the Import toolbar selected on your Main Menu, you can simply click
on the Sync Handheld icon which is shown below.
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When you select File . . . <, then Open . . . <, Handheld Computer. . . <, then Upload,
you will be shown the following dialog box.

Note: You can also reach the above window by going to the Main Menu, then
selecting File . . . <, Import . . . <, Handheld Computer. . . <, Synch.

PREPARING FOR USE WITH THE USB CABLE

Make sure the USB cable is plugged into the computer, and plug the other end of the
cable into the Mobile Device Cradle.

You should always begin the synchronization process on the computer before
beginning the process on the Mobile Device.

You may need to use the down arrow to the right of the User Configuration box to
select the correct Configuration, as shown above.  Select {System} Default Pocket PC 
Connection if you have not yet created your own Configuration.
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When you are ready to synchronize, you should set the Mobile Device into the cradle,
ensuring that the cradle’s cable is connected to the USB port on your  computer.  On
the Mobile Device, go to the Bar|Scan Main Menu.

You should initiate the synchronize from the computer by clicking on the Synch
Handheld icon on the Bar|Scan Main Menu as illustrated below.

Or select File, then Open . . . <, Handheld Computer. . . <, then Synchronize as shown
in the example below.
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Select either of the two methods and you should be shown the dialog box below.

Select the Use Configuration field, and select the {SYSTEM} -DEFAULT POCKET
PC Connection as shown above.  Then, click on the Begin button.  The words “Ready
to Begin” that are shown on the dialog box below will change to say “Waiting for
Connection,” and then the TCP address will display as in the example below.
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Once the words Waiting for Connection appear, tap on the Tools then Synch Menu
on the  Handheld’s Bar|Scan Main Menu.

Bar|Scan will perform all bi-directional communication necessary.  When completed,
you will be shown a dialog box on the Mobile Device that looks similar to the one
below.

As you can see from the following message, Bar|Scan verifies that the data went into
your Transaction table.
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The Bar|Scan message below can serve as your confirmation.  The number of items
will vary according to your inventory.  

Then, tap on the Yes button only if you want to erase all of your information.  Tap on
the No button to be returned to the Main Menu.

The computer will remain ready for another upload.  If you do not wish to upload
another Mobile Device, click on the Cancel button to cancel the impending upload,
and then click on the Close button to close the upload dialog box.

If you remove the handheld or USB Cable during the synchronization, you might see
the following message on the handheld. 
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An error message similar to the above will be displayed if there is a problem
synchronizing the Mobile Device to the desktop’s Bar|Scan database.

This error message will be displayed if something interrupts the transfer of data from
handheld to PC, for example a disk write fail or an anti-virus scan and the data file is
not completely transferred from the handheld to the PC.

Try synchronizing the handheld to the Bar|Scan database again.  If the message
reappears, contact Bar|Scan or your Dealer for support.
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Special Notes on Handheld Synchronization

Introduction

&& Synchronizing Bar|Scan data on your handheld with Bar|Scan on your desktop is
integral to getting the full functionality out of your Bar|Scan system. However,
synchronization may at times be confusing. This can be because Bar|Scan supports
two different methods of transferring data between the handheld and your
workstation. The first method is called ‘Network Sync’. The second is called ‘USB
Sync’. 

How to Choose

We recommend that you perform your synchronization using ‘Network Sync’. This
is the default and requires no customization on the desktop or the handheld.

It’s advantages are:
The  advantages to ‘Network Sync’ are:

1. This method is supported across all Bar|Scan handheld models.

2. If you have more than one handheld model there is no need to reconfigure the sync
every time a different handheld model is cradled.

3. It establishes a direct Tcp/Ip network connection between the handheld and the
Bar|Scan workstation or server receiving the inventory data. The handheld can sync
with any computer accessible over the network, not just the computer it is physically
attached to. 

4. It is the quickest and most reliable method of data transfer with a lower chance of
needing retransmission of data.

It’s drawbacks are:

1. It requires Microsoft’s Windows Mobile Device Center (WMDC) software to be
installed on the workstation. At times, this can be difficult to install due to security
or remote access restrictions at your organization.  In addition, ‘USB Sync’ can only
be used if a very specific set of circumstances are true. The requirements are:
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a. You must be using a recent Zebra MC3200 or MC55 series handheld with a
recent version of Bar|Scan installed. This is the only series that supports ‘USB
Sync’.  We may support others in the future. 

2. Your session of Bar|Scan running on your network workstation must be allowed to
show you with the option of using ‘USB Sync’. If you do not see the drop down box
with ‘Network Sync’ and ‘USB Sync’ options then you do not have the ‘USB Sync’
option available from your workstation. This option will normally display as follows:

 

If you meet the above requirement then you can consider using ‘USB Sync’ if you find
yourself facing one of these situations:

a. Your company firewall is  preventing communications with the handheld.
b. You are using a Remote Desktop application to access Bar|Scan on the PC and
there is no way to network into the server hosting Bar|Scan.
c. Your company policy does not allow desktop customization (i.e. you can’t
install WMDC installed on your desktop).
d. Any other reason the WMDC cannot be installed on the workstation.
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‘USB Sync’ is supported by the MC3200 and MC55 handheld series.  The handheld
can only transfer data to the computer to which it is physically attached. It requires a
setup on both the handheld and on the PC, since USB is not the default Sync mode.
It does not require that WMDC be installed on the Workstation.  However, your
computer security settings must be configured to allow the attachment of USB
devices.

There are many Tips available that describe various aspects of the Synchronization
process using Tcp/Ip i.e., ‘Network Sync’.

If you need TCP/IP Synchronization without WMDC

All supported Bar|Scan handhelds support a Sync with Tcp/Ip using a connection into
the local network.  The method of creating such a link is using the Windows Mobile
Device Center (WMDC) software from Microsoft.  However, that is not the only way
a handheld can be connected into your network. There are other ways, but they are 
unsupported by Bar|Scan, Inc.   However, you are free to use these unsupported
methods.  For example:
1. If the handheld supports Wi-Fi, then a Wi-fi connection can be created to the local
network. Once the connection is configured and made, then the Bar|Scan program on
the handheld can communicate over Tcp/Ip with Bar|Scan on the PC.
2. There is hardware both from Zebra and third parties that assists in making a
connection into the local network.  In general, drivers and software may have to be
installed on the handheld in addition to configuring your handheld for your network.
For example:
a. If you already have a handheld and cradle, there are “USB to Ethernet” adapters
available from third parties.  Installation of a driver on the handheld and network
setup on the handheld are required.  For example, PortSmith Technologies has a
‘dataPort’ adapter:
http://www.portsmith.com/product/daptaport that allows some handhelds to connect
through its cradle into your network. 
b. You can purchase an Ethernet ready cradle. These are offered by Zebra, but the
smallest contains four (4) slots for four handhelds. If you need a cradle with only one
handheld slot, PortSmith Technologies has single handheld Ethernet cradles that are
compatible with the MC55:
http://www.portsmith.com/product/motorola-mc67mc65mc55-ethernet and the
MC3200 http://www.portsmith.com/product/motorola-mc3100mc3000-ethernet.  
Also  check their website for your specific handheld.
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If you decide on using the ‘USB Sync’ method

Only the MC3200 and MC55 handheld supports the USB method of synchronization
as of this publication date.  There are specific setup requirements on both Bar|Scan
running on the PC (see above) and on the Handheld.  However, once these have been
satisfied, a Sync can be performed between the handheld and Bar|Scan on the PC, but
without WMDC. This synchronization method essentially causes the handheld to look
and act like a removable USB drive. To use ‘USB Sync’ you must configure both the
handheld and Bar|Scan on the PC.

USB Sync, PC configuration
 
Configuring the PC to use the ‘USB Sync’ is simple.   Select the ‘USB Sync’ option
in the ‘Synchronize Handheld’ screen BEFORE starting the sync operation with the
‘Begin’ button.  Here you can see what a sample screen looks like. It has had the
‘More…’ button selected to display all of the ‘USB Sync’ screen. Note that the screen
differs in both appearance and instructions from the ‘Network Sync’ screen. Also note
the steps listed to perform the ‘USB Sync’ below.

USB Sync, Handheld Configuration

Configuring your handheld for ‘USB Sync’ requires configuration in both the
operating system on the handheld and within the Bar|Scan application.  First configure
the handheld operating system, then configure the Bar|Scan application.
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Configuring your Handheld Operating System

To configure your handheld for USB synchronization, perform the following steps:
1. Select the ‘Start’ or ‘Home’ icon on your handheld.
2. Select ‘Settings’ (This will be either an icon or a menu item).

 

3. Select ‘System’ on Windows Mobile 6x handheld, ‘Control Panel’ on Windows
Mobile 5.x handheld.
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4. Select the ‘UsbConfig’ icon.

 

5. Select the ‘USB Port Mode’ tab. Within this tab select ‘USB OTG Mode’. This is
the default. This should also be the value for both USB and Tcp/Ip network mode.
This setting will allow automatic switching between host and client mode.
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6.Select the ‘USB Client’ tab. Within this tab select ‘Mass Storage’, then select
‘Platform’.

This concludes special notes. For more information contact us
at techsupport@barscan.com
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Chapter 13

INTRODUCTION

The following section contains information about features that don't fall into any
other category.  Some of the selections are used for setup and will usually only be
selected once, for example “Settings.”  Other selections are used occasionally, for
example “Miscellaneous”

There is a set of videos on our website that can provide you with additional in
operating Bar|Scan.  These are titled Quickstart Overview Videos and can be
found on this page: https://www.barscan.com/support-videos

Please consider viewing or downloading these as part of your learning experience.

When you wish to select Housekeeping, go to the Main Menu.  Select File  . . . <,
then Company  . . . <, then Housekeeping as shown on the following example.
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TABLE INTEGRITY

The first of the items in the Housekeeping drop down menu is Table Integrity. 
When you select this item, you will be shown a window similar to the one below.

You will see one or more Company Databases that are open and three buttons at
the bottom of the window.  Table Integrity is very important, as it maintains the
file structure for all of your information in Bar|Scan.

Warning: Many items on the Table Integrity panel require that no other users are
currently using the company that you select.  In other words, no one else can be
logged into that company.  If you have a single company version, make sure that
no one else has Bar|Scan open.

Also, if you are upgrading to a new version of Bar|Scan, you must be a Bar|Scan
administrator (master user) to complete the Table Integrity.
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Normally, you click on the Ok button and allow Bar|Scan to perform the Table
Integrity.  You will see a screen such as below.

This process may take from several minutes to several hours depending on the
size of your Company database, which modules you are using and the memory
and speed of your computer.

When completed, you will see a dialog box similar to the one below.

And that is all there is to the process.  
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If you receive any unusual messages similar to that below, it generally indicates
that there may be a shared table that has conflicting field information.  

For example, if the Location Table is set to shared (Table Properties Screen) but
in each company, the Room Tag length is set to a different length, then an error
message similar to that below will appear.  Correct the discrepancy and then
perform the Table Integrity again. 

If you are asked by your Bar|Scan Dealer to perform a more advanced version of
Table Integrity, click on the Advanced Settings Button.
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When you click on the Advanced Settings Button, you will see a screen similar
to the one below.

Restructure

When you receive a new version of the Bar|Scan program, it may be necessary to
perform a Restructure in order to update your database files to the new version.

In a much rarer occasion, you may also want to use this item periodically to check 
the files.  Normally this would only be done if you feel that the computer may
have experienced a hardware problem.
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Warning:  Do not select this feature if your free disk space is less than two times
the space of  your Bar|Scan company folder.  The Bar|Scan company folder is in
the directory created by you.  In any case, if you perform a Restructure with
insufficient disk space, you may not be warned ahead of time that you do not have
enough disk space to complete the process, rather you will get an error message
indicating Insufficient Disk Space.  See Appendix A - In Case of Trouble for
more information on error messages.

If you select Verify operations on each Table, you will be able to view any
changes that Bar|Scan finds and wishes to make, and accept or reject the
change(s).  Normally, you will always want to accept the change(s).  Below is an
example.

When you select the ok, the restructure window will close and you will be shown
an additional dialog box that looks similar to the one below.
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Pack

On rare occasions you will want to select this feature to condense the data files. 
When you delete something, Bar|Scan removes the visible copy, but holds a ghost
copy which it marks for later removal, rather than physically removing it at that
time.  This feature physically removes the ghost copies that are marked for
deletion.

We recommend that you perform a Pack at least once every year, more often if
your assets are constantly moving.

On occasion, Bar|Scan might also suggest that you perform a Pack as in the
example below:

While not mandatory, you will continue to see the message until you perform the
Pack operation.

Important: Do not Pack if you are experiencing any Bar|Scan errors or error
messages of any kind.  Contact your Bar|Scan Dealer for support.  This is because
Pack creates new database files and compound indices every time it is used.
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When you select Pack, you will see a dialog similar to the one below:

Warning:  Do not select this feature if your free disk space is less than two times
the space of  your Bar|Scan company folder.  The Bar|Scan company folder is in
the directory created by you.  In any case, if you perform a Pack with insufficient
disk space, you may not be warned ahead of time that you do not have enough
disk space to complete the process, rather you will get an error message indicating
Insufficient Disk Space.  See Appendix A - In Case of Trouble for more
information on error messages.

If you allow Bar|Scan to Select All the tables, which all are selected (or
highlighted) when you select this feature, Bar|Scan will pack all of your files
without stopping.

Hint: If you have a small number of assets, less than 20,000, it is most convenient
to Select All the tables for packing.   Also leave all tables highlighted if you are
not familiar enough with Bar|Scan file groups to determine which tables need to
be packed.
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If you have a large number of assets and you know what specific table(s) you are
interested in packing, select only those that you wish to Pack by selecting Pack
and the Select Individual Tables option.  You will then be allowed to highlight
only the tables you wish to pack.

You want to be careful at this point, select to Pack all tables only if you do not
know exactly which files need to be packed.  This is especially true if you have
very large tables.  If for instance you have more than 100,000 assets, it could take
up to one hour to pack all of your files over a network.  If you know that only two
tables need to be packed, it may only take ten minutes to pack these two tables. 
But, you have to know exactly which two to pack in order to do this.

If you are unsure which of the Individual User Data tables to pack, you should
choose to pack all of your tables.
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After Bar|Scan has finished packing the Individual User Data tables, all of them
or only the ones you selected for packing, you will see a dialog box similar to the
one below.

Reindex

Reindexing is a process by which Bar|Scan reorganizes its files.  The main
purpose of this item is to reindex the sort data files after a  problem has occurred
on the hard disk or memory.  This is most often a damaged index file due to
Bar|Scan terminating abnormally (such as turning off your computer while
Bar|Scan is still running).  

It is also necessary when you have had to restore your data files from a backup.

Hint: When you select the Reindex feature, Bar|Scan will highlight all of the
tables to be Reindexed.  You will almost always want to leave all of them
highlighted.  If you have a small number of assets, less than 20,000, it is most
convenient to allow Bar|Scan to reindex all of the tables in your system.   Also
leave all of the tables highlighted for reindexing if you are not familiar enough
with Bar|Scan tables to determine which tables need to be reindexed.
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If you have a large number of assets and you know what specific tables you are
interested in reindexing, select only those tables that you wish to have reindexed
by selecting both Reindex and the Select Individual Tables option.  Bar|Scan will
stop and you can then select the Tables individually as shown in the screen below
where the Catalog Table was selected.

You want to be careful at this point, select only specific tables to be reindexed if
you know exactly which tables need to be indexed.  This is especially true if you
have very large tables.  If, for instance, you have more than 100,000 assets, it
could take one hour to index all of your files over a network.  If you know that
only two tables need to be indexed, it may only take five or ten minutes to index
these two tables.  But, you have to know exactly which two to index in order to
do this.

If you are unsure which tables to index, you should leave all of the tables
highlighted, and let Bar|Scan index all of them.  

Bar|Scan will index all of the tables or only those that you ask to have indexed,
depending on your choices.  
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When you select to Reindex your company(s), Bar|Scan will immediately begin
the process, and when finished will display a message similar to the one below.

How can I log everyone out of Bar|Scan so that I can perform a Table Integrity?

Sometimes you cannot perform Table Integrity because other Users are logged in
and have Tables open.  How can you log everyone out of Bar|Scan so that I can
reindex?

First, check to see if there
are any others currently
logged in.  From the
Bar|Scan Main Menu select
Help- < About Bar|Scan for
Windows. Click on the
‘Current Users’ icon. The list
will display any others
currently logged in. You can
then contact these people to
log out.

A sample of the panel is
displayed at the right:
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You can also have Bar|Scan lock everyone out with a Global Lock Feature. Open
the User Table and then select ‘User-< Global Lock’ from the Main Menu.
Everyone other than your password will be disabled until you unlock. If the user
is currently logged in, it will not log the user out, rather it will prevent them from
logging in the next time. See the image below:

There are two mechanisms for locking out users so that they cannot login. The
first is the individual User table record, where the Lock field is set. The second in
the global lockout accessed through the main menu bar system when the User
screen is the current screen. You are familiar with the single user field. Here is
how to unlock the global field if the user forgets who the key master user (ie, the
only user allowed to log back in if they should log out while the global lock is
active).

What if I am the Administrator and my access is denied?

This can occur under some circumstances, for example, the prior Bar|Scan
Administrator is no longer responsible for Bar|Scan and you were not setup by that
person to be the new Administrator.  Or, the Administrator is temporarily
unavailable and access is urgently required.

You might be presented with the message below.
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Your only option is to remove the global lock.  However, any individual locks will
not be affected.

Open Windows explorer and Look in BARSCANW\SYSUSER for a file named
BSLOCK.TXT. If it exists then all users are locked out except one.  Delete the
BSLOCK.TXT file. This removes the global lock. However, any individual locks
will not be affected. 

Options

When you select one or more of the Restructure, Pack, and Reindex features in
Bar|Scan the items to their immediate right will go from being “greyed out” to
being accessible, as shown below.

Select Individual Tables

The Select Individual Tables option will become available when you select to
Restructure, Pack, or Reindex features for one or more companies.  When it
becomes available, clicking on the white box beside this option before clicking
on the Ok button, will allow you to select which tables you Restructure, Pack, or
Reindex.  This is extremely important if your database is very large, and time is
critical.  You can select only the table(s) that require a Restructure, Pack, or
Reindex and skip those that are not affected.  This feature requires a thorough
knowledge of the Bar|Scan system, and is normally selected by advanced users.

Build New or Missing Index Tags Only

When you select to Reindex one or more companies, the option Build New or
Missing Index tags only will become available.  As the title suggests, this will
allow you to Reindex your company, and have it build only new or missing index
tags.  This is important when you have indexed your company before, but have
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upgraded or added new fields that produce a message saying that there is a
missing index tag.  This does not take as long as a full Reindex.

Verify Operations on Each Table

The Verify Operations on each Table option should be selected if you want to
check every change that the Restructure or Reindex may cause, before the change
is made.  In this way, you could keep some changes from taking place.  You
should only select this option if you are very familiar with the changes that will
be made, or if you are instructed to select this option by Bar|Scan technical
support.

 Refresh

The second Tab, Refresh, is a way to update and correct possible problems with
your company tables.
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Sometimes, when updating your program to a new version, or if you are having
very specific problems with your tables, we may ask you to choose one or more
of the options listed under the Refresh heading.

Refresh System Reports

Bar|Scan provides a set of standard set of System Reports and Set commands. 
These were provided when Bar|Scan was first installed on your computer.  When
you receive a new version of the Bar|Scan program, additional System Reports or
Set commands may be provided to you. 

The Refresh Files feature incorporates these new system reports (provided as part
of your Bar|Scan update) into your companies.  If you have one or more
companies selected and you select to refresh the System Reports, Bar|Scan will
immediately begin the process.  You will see messages updating the progress. 
When the process has completed, you will see a dialog box similar to the one
below.
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Refresh System Sets

The next item that you can choose to refresh, is the System Sets.  Similar to
updating System reports, from time to time your Bar|Scan updates may include
new System Sets.  This refresh item will incorporate the new Systems Sets into
your existing list if you select your companies, and select this item.  Select all of
your companies, and select to refresh the System Sets, and Bar|Scan will start the
refresh process.  When done, you will see a dialog box like the one below.

Refresh System Handheld Computer Configurations

The next item that you can choose to refresh, is the System Handheld Computer
Configuration.  This will place Legacy Handheld Computer Communication
Configurations into your selection of Configurations.  Since 2006, Bar|Scan
installs only Pocket PC configurations.  Since 2022, Bar|Scan installs only
Android configurations.  If you still have older style Handheld Computers, they
are still supported and you might need to  perform this refresh to load their
Communication Configurations.

Refresh Asset and Location Histories, Accounting

The next item that you may choose under Refresh is Asset Location Historys and
Accounting.  

This item may be required if you have a bad index.  Bar|Scan technical support
will tell you if you need to select this item.

Bar|Scan keeps a complete history of all locations scanned or entered with the
Mobile Device, as well as those entered at the keyboard.
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Since Location History is kept in a different database than asset information, there
may be times when the information in these databases differs.  This is especially
true of you have experienced computer hardware problems.

Finally, you can use this option to initialize Accounting Information as discussed
previously under “Transfer Cost information from Catalogs to Assets”

Bar|Scan can compare and correct problems associated with location history if you
select the Refresh Asset Table Locations from Location History option.

When you choose this feature Bar|Scan  will begin replacing the current and prior
locations in the Asset Table with those in the Location History Table.  

Important: Do not perform this action unless you have confirmed that the
problem is in your Asset table or you have contacted your Bar|Scan Dealer.

If you have selected one or more companies, and have selected the (Refresh)
Asset and Location History Locations, Bar|Scan will begin the refresh process. 
When finished, you will be shown a dialog box similar to the one below.
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Refresh Location History Names

This item will replace blank Location History Names with the oldest recorded
name.  If you had a name in the Location History Name field, i.e., John Q. Public,
but for next few (newer) edits, the Name field appeared blank.  If you did not
intentionally make this item blank, you could select this Refresh item to force
Bar|Scan to replace the blank field with the name that had appeared in this field
on previous location histories, John Q. Public.  

Please use caution when selecting this item.  The Location History Name field
may have been blank on purpose.

Bar|Scan can only use Names that have appeared in older Location History items
to replace a blank Location History Name field.  Older Location Histories are
listed under the newer ones in the Asset table.  

If you select this item, while having one or more companies selected, the process
will begin immediately.

Refresh Table Properties

This feature is rarely used.  It ensures that the table names are set properly in the
file list.  This is needed only when the actual names of the tables have changed,
and the tables display the older names.

If you select this item, while having one or more companies selected, the process
will begin immediately.

Refresh Displayable Field Lists

This item will be used only when you get an update to your Bar|Scan program,
and the items in any available field lists have changed.  You would see this type
of list when you select to add a column to a report.  These lists do not always
change during an update, but at no time would it be harmful to use this item.  This
item will only allow you to view new or changed items in your list, and will not
overwrite any old data.
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If you select this item, while having one or more companies selected, the process
will begin immediately. 

Names Referencing Personnel table

Rebuilds the Personnel Table and all related uses of the Names field according to
current rules located in the Company Settings Table,  Key Fields Tab.  For
example, you can use this feature to change all names from First Name/Last Name
to Last Name/First Name.

Transfer Cost information from Catalogs to Assets

This option can only be used in conjunction with “Refresh Assets, Location
Histories Accounting” which is discussed in the following Refresh Section.  This
option will initialize all blank costs on the Basis Tab of the Asset Panel with the
Accounting Initialization Costs on the Accounting Tab of the Catalog Panel.

You should only select this option if you are very familiar with the changes that
will be made, or if you are instructed to select this option by Bar|Scan technical
support.

Update Location History Location Description with current Location Description

This option can be used to replace any text that may have been entered into the
Asset’s Location History Description with the corresponding description
contained in the Location History Table.

You should only select this option if you are very familiar with the changes that
will be made, or if you are instructed to select this option by Bar|Scan technical
support.

Refresh Asset Prior Organizations from the Asset Log if available

This option should not be used without first consulting Bar|Scan technical
support.
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The next tab contains Initialize features as follows:
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Initialize Blank Organization Codes

The Table Integrity panel also has a feature which allows you to fill in blank
Organization Codes in your Asset or Transaction table, with the referenced
Organization Codes from the Location table, when one exists in the Location
table.

Assets

This procedure will check all assets in the Asset Table that have blank
Organization Codes.  If the current location of the Asset has a Reference
Organization Code in the Location table then the Organization Code of the Asset
will be changed to match the Reference Organization code in the Location table.

A sample location is displayed below.

                Reference 
               Organization
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The Organization Code is displayed “referenced” here.  If the Location History
Organization field is blank, yet an Organization is displayed here for that same
Location, you can make Bar|Scan fill in the Organization Code for you.

When you select to Initialize Blank Organization Codes, Assets, Bar|Scan will
begin checking all Assets that have a blank Organization code, and then filling in
the blank spaces with the referenced Organization Code from the Location table. 
When finished, you will see a message similar to the following.
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Handheld Computer Transactions

You may select to Initialize Blank Organization Codes, Handheld Computer
Transactions.  This will replace all the blank Organization Codes in the
Transaction table with the referenced Organization Code from the Location table. 

When you select this feature, Bar|Scan will begin to check all of your
Transactions for blank Organization codes, and replacing them with the referenced
Organization Codes listed in your Location table.  Bar|Scan will replace any blank
organizations in your Transaction table with those new ones, using the locations
as a guide.  When finished with this process, you will be shown a dialog box
similar to the one below.
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Miscellaneous

There are more items on the Miscellaneous tab, as shown below.

Rebuild Reference Attribute Look up Window

After adding and deleting many Catalogs, you may no longer have accurate Look
up lists for your Types, Descriptions, and Attributes.  This feature allows you to
create new lists for your Catalog table.

The new lists will contain all the choices which already occur in your Catalog
database, and the default items from the original lists sent with your Bar|Scan
program.  See Attributes in Chapter 7 - Catalogs if you are not sure if you wish
to rebuild the lists for your Catalog Attributes.  
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When you select one or more Companies, then select to Rebuild Catalog
Attributes from the Table Integrity window, Bar|Scan will start the process of 
rebuilding your lists for Catalog Attributes.

Bar|Scan will replace the old lists with the new ones.  When done, you will be
shown a dialog box similar to the one below.

Correct Duplicate ‘Z’ Asset Numbers and Merge Duplicates

The next item Miscellaneous item is Correct Duplicate ‘Z’ Asset Numbers.  When
you select one or more companies then select this item,  Bar|Scan will begin the
renumbering and consolidating your Z number assets. 

Note: Be careful when selecting this feature that you actually need this process to
be done, as any new numbers generated will not match previous reports.  If you
are unsure if you need to use this feature, please contact Bar|Scan for technical
support before selecting this item.

Remember ‘Z’ asset numbers are only associated with the “Quantity Mode” in the
Mobile Device, so this feature is only applicable if you are using the Quantity
Mode.  See Chapter 11- Bar|Scan Mobile for more information regarding the
“Quantity Mode.”
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Add Extra Asset Locations to Location History

If locations were inadvertently removed from the Location History Table, the
Current and Prior Locations can be recovered from the Asset Table.  You can have
Bar|Scan perform these functions by selecting this feature.  Bar|Scan will
immediately begin checking the Asset table for additional locations, and you will
see dialog messages displaying the progress.  When the process has been
completed, you will see a message similar to the following.

Please contact your Bar|Scan dealer before performing this operation.

Adjust Location History Duplicate Time Entries

This feature checks all time entries in the Location Histories for items that appear
as exact duplicates.  When exact duplicates are found, the time on one of these
items will be changed by one minute, so they are no longer exact duplicates.

Note: Be careful when selecting this feature, as items that appear on earlier reports
can be affected.  If you are unsure if you should use this feature, please contact
Bar|Scan technical support, prior to selecting this item.
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Realign ‘Z’ Number Locations

This feature is only used if there has been a problem with the database, and more
than one location exists for a given Z number.

This item is used to review all of the location information for the Z number assets,
to ensure that there is only one location listed for each Z number.  If more than
one location is detected, then the oldest location is used, and the other locations
are modified to match it.

Fix bad record and memo block counts

Contact us or your Bar|Scan Dealer for support before using this feature.

During a Table Integrity, you may receive a message similar to ‘Unable to
restructure table ... \\tablename has been corrupted.  The table will need to be
repaired before using again.

This feature is used when Tables appear to be corrupted.  Table corruptions
involves a table header miscount of the actual number of records in the file. 
Because of the miscount, the table cannot be read. Using this option sets the
record count in the header to the nearest accurate count of actual records in the
file. This will sometimes allow access to the table so that the data can be
examined.

This option should be run alone, meaning uncheck all other items before checking
this.  When completed, run a regular Table Integrity again to make sure that the
message does not appear again.

This is just the start of analysis. Data may have already been lost, or corrupted.
Use of this feature is recommended only when there is no available, acceptable,
backup of the damaged table. Even if the damaged table is fully restored to use 
with this function, data may still have been lost or damaged so it will need to be
examined.

Create Report Sets

Indexes are constantly used by the system to make queries.  You use queries to
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perform look ups and to perform sorts.  These queries are also used for reports. 
Because you can run queries and reports on such a variety of things, there are
many items that can require inordinately long query times, i.e., a report that asks
for assets with a specific range of purchase cost.  When printing this report, the
query may take a long time without having its own index built, as the program
would have to check every single asset for the requested information, filter out all
of those that you do not want to see, and display those that you do want to see.

Bar|Scan is installed with only those indexes that are necessary for the system to
run.

Using this feature will allow you to select an item from a report, and build a new
index, or Set, for that item.  This will substantially reduce the query time
necessary for your report.  

To access this feature, simply select Create Report Sets, and click on the Ok
button.  You will see a panel similar to the one below.
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In the above example, you would first pick your report, then double click the
eligible field that you want to build a Set for.  When you double click an Eligible
Field on the left, it will be sent to the Selected Field list on the right.  Keep adding
fields to the list of Selected Fields until you are satisfied that your list is complete.

When your list of Selected Fields is complete, Click on the Create ‘Sets’ button. 
This will create the optimizing Set commands, and this dialog will disappear.

You then have to Reindex this company so that the index is created.

Later, when running the report, rather than checking every single asset for this
information, the Bar|Scan program only has to check the pre-made index.  This
will substantially reduce the time necessary for the query, and your report will
print much faster.

Care should be taken when selecting this feature.  Do not index too many fields
in the database.  Remember, each index or ‘Set’ you add can slow other processes
down, i.e., each Set you add will add an item to your Reindex.  Each time you
Reindex, it will take a longer period of time.  

Correct Duplicate Record Id’s

This item will check for, and correct any duplicate record identification numbers
that it finds. 

Record identification numbers are used internally by Bar|Scan, and you never see
them.  But, if there are duplicates, it could cause problems such as duplicated
items within your program, i.e., duplicated Work Orders, where you cannot access
the duplicate, only view it.

Please contact Technical Support if you think you may have this problem before
you select this item.   

Check for Some Types of Indexing Problems

This item will check the validity of the indices in most cases.  

Care should be used when accessing this feature, however, as this feature will
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probably take longer to run then the actual reindex process.

It will not hurt your system to select this item.  But, there may be times when you
will need to reindex your system that may not show up when using this item to
check the indices.  
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Purge Asset Location History Entries

This item will remove unwanted Location History Information from Bar|Scan. 
When selected, you will be presented with the following screen. 

This option should only be considered if you have had Bar|Scan for a long period
of time, say more than five years,  or you have a very frequent movement of asset
or both.

This is not a mandatory function and Bar|Scan will work properly even if you
never perform this function.  However, on large databases with over 100,000
assets or a warehouse implementation of Bar|Scan, you can accumulate tens of
thousands of Location History entries which you will not need.

If you select “Purge if inventory date is prior to” then the bottom portion of the
screen will present additional Work Order option as follows.
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Build Field list table BSFLDS.DBF

This option will create a current list of all user accessible fields in your Bar|Scan
database, including User Defined Fields and update the Bsflds.dbf file located in
the Company folder.  

This list is not used by Bar|Scan, but can be useful for ODBC access or use by
other applications outside of Bar|Scan that may require the information to properly
link to or extract data from Bar|Scan.

Remove Orphaned Records

This option will scan the Asset Location History and Work Order Detail as well
as component tables such as the Asset Component Table and remove records that
do not have a parent record in the Asset or Work Order Master Table.

Clean up Universal Date/time values

Bar|Scan marks records with Universal Date Time (UDT) if it is available from
your computer.  On occasion your computer may not provide the local time zone 
information to Bar|Scan, such as when a firewall is blocking the query.  This
option will convert  all Log Dates and Log Times to Universal Date Time and fill
in any missing values.

Clean up Text Data

This message can occur if you receive an invalid ASCII character, sometimes call
high order bits.  There are other ASCII characters such as control characters that
are also not allowed.  These characters sometimes inadvertently appear due to a
bad handheld scan, a bad disk write, or an import.  The error screen may look like
this screen.  

Performing a Table Integrity
with ‘Clean up text data’
marked on the Advanced
Settings Screen will usually
successfully repair these invalid
ASCII characters.
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SETTINGS

You will use the Settings feature under Housekeeping, to set up the properties for
any new company that you add.  On this table you can determine the Company
Code, and length of the bar code asset number and it’s justification, the length of
the bar code Room tag. 

There are many options that you can also choose from to customize your
Company.  For example, these include options for  the Default First Fiscal Month,
to strip a Serial Number prefix, whether or not to Round Calculated Depreciation, 
whether or not to Use Plain Organization Codes, and whether or not to Round
Calculated Currencies, to strip Label Check Digits, several items about your Work
Order numbers, and the input mask for the telephone numbers.
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Standard Options Page 1

These options should be filled in when you first create a new company in
Bar|Scan.

Company Code

A Company Code is required for each company entered into the Bar|Scan system. 
The Company Code is only used in conjunction with the Mobile Device (in order
to upload to more than one Company’s information simultaneously) and has no
effect on how Bar|Scan is used on your Computer.  However, each company must
have a unique code.

Type in any numbers or characters to establish a company code.  Spaces can also
be used.  Press the BACKSPACE or left-arrow key to edit your work.

When completed, press ENTER.  You can use the up-arrow at any time prior to
saving your work to return to the Company Code for editing.

You may press the ESC key at any time to return to the Housekeeping menu
without any changes.

Asset # Length

Indicate the new length of the bar code asset number that you will be using for
this Company.  Any number from 5 to 75 is acceptable.  

If you select variable width as the asset number length, Bar|Scan recognizes that
you wish to accept varied asset number lengths, and will not validate the asset
number length.  In this case, you should set the length to the largest number that
you expect to use.
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Room Tag Length

Indicate the length of the bar code Room Tag number that you will be using for
this Company.  Any number from 4 to 10 is acceptable.

If you select variable width as the asset number length, Bar|Scan recognizes that
you wish to accept varied asset number lengths, and will not validate the asset
number length.  In this case, you should set the length to the largest number that
you expect to use.

If you do not plan to use the Room Tag feature, you can leave the length to the
default.  There is no need to adjust it.

Default First Fiscal Month

If you have the Accounting module, you may use this field to tell Bar|Scan the
Default First Fiscal Month for your company.  Click on the down arrow next to
the field, and select the proper month.  

Serial # Prefix to Strip

Serial numbers that are printed on the shipping labels of boxes often have a
leading character(s) at the beginning of the actual serial number.  Type into this
field any leading charter(s) that you want Bar|Scan to ignore and remove.  When
the information is uploaded and validated, this item will make Bar|Scan ignore
and remove the character(s) that you have typed into this field.  This will allow
you the option of scanning these serial numbers without opening the boxes.  The
Serial Number can only be stripped during an import of a Mobile Device File, or
during the validation of an upload into the Transaction table.

Calculate Unit of Measure

You can change the method that Bar|Scan uses to display measurement.  Your
selection is either Inches or Millimeters.  There are very few places where
Bar|Scan displays measurement.  One example is in the Catalog Table.  Again this
is only a display function and not a calculation function.

Page 13-36 Bar|Scan



Chapter 13

Background Color

This is a useful function for those who maintain more than one Company
database.  Each Database can have a theme color.  This makes it easier to
recognize which Company is in use.  For example, you can make your Active
Company Theme Red and your Salvage Company Green.

Telephone Input Mask

The input mask that is shown in this field will allow you to enter the telephone
number without having to press the parenthesis or the dashes.  

You can change the input mask to a different format, but in most cases this is not
necessary.

Range of Valid Years

You can tell Bar|Scan to perform additional validation on every date that you
enter.  This prevents the accidental entry of obvious errors such as a Depreciation
Start Date of 1886.  Be careful to not set the Range too narrow as this is a global
feature.

Location History Validation Level

Bar|Scan maintains a history of all of your asset inventories including manual
changes.  This asset location history is validated against multiple supporting tables
such as the Location Table.  If you have a high level of scan activity or have a
large number of edits to the supporting tables, activities such as creating new Set
Commands or performing a Table Integrity may take a long time, or you may just
not be concerned with older location information.  

For example, in an inventory stock room situation, assets may be scanned in and
scanned out with such frequency that hundreds of location histories are generated
daily - and you may only be concerned about where the asset is at the current time.

You can choose one of three amounts of validation that you wish Bar|Scan to
perform. 
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Maximum # Day Inventory date’s in the future

You may occasionally wish to enter a future inventory date into the handheld or
desktop in order to process scheduled work, e.g. a Work Order.  Bar|Scan would
normally flag a future inventory date as an error unless this value is set to be
greater than 0.  The number of days in the future is determined by you.

Standard Options Page 2

This tab presents additional Company Settings.

Right Justify Asset #

Check this item only if your bar code asset labels have variable length asset
numbers and you wish to append leading characters.  If you wish to append
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trailing characters, respond “N.”

Normally, right justify only if you have bar codes of various lengths.

Note:  All asset numbers in Bar|Scan must be of the same length, even if the bar
codes are various lengths.

Pad Asset # With Zeroes

This option works in connection with Right Justify Asset Number above.  In most
cases you will need to check this item, if you checked the item above.  

For example, if you had one bar code label of five characters 00463 and a six-digit
bar code label 000682, if you used this feature the first bar code label would be
changed to 000463, and the other would stay the same 000682 (assuming that the
asset number length is set to six).

Use Plain Organization codes

Normally, Bar|Scan’s Organization codes are six characters long.  Checking the
Use Plain Organization Codes item allows you to enter any combination of letters
or numbers, up to six characters in length.  If you want to enter a simpler
Organization code such as AP or 503, you could if this item is checked.

If you do not check Use Plain Organization Codes, Bar|Scan will allow only
formatted data to be entered as follows:  two numeric, two alpha, then two
numeric. 

Round Calculated Currencies

Check this option if you want Bar|Scan to round the currency figures up and down
to the nearest whole dollar in all of the calculations.  

In Transaction Table on ‘Add Template’ Set Inventory Time to Now

Check this option if you want Bar|Scan to use the current inventory time and date
rather than the time and date from the transaction that you are adding a template
from.
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Initialize Work Order ‘Taken by’ with User Name

Check this item if you use the Work Order module, and want Bar|Scan to
automatically fill in the Taken By field with the initials that were used to log into
the Bar|Scan program.

Prompt for Deletion on Company Export

This option is only for use with the Multiple Company Module.  Check this item
if you want to normally delete asset information after you copy it to a new
Company.  For example, if you are moving Assets from your Active Company to
your Archive Company, you would want to use this setting.

Use Locations Within Locations

Use Locations within Locations on Work Order Shopping Form has a checkbox
next to it.  You only need to address this item if you are using the Work Order
Shopping form.  If you are using the Work Order Shopping Form, clicking on this
item will allow you to specify partial locations.  I.e., if you have a real location
that is Region = CA, Building = 1900, Floor = 01, Room = 100, you could check
this item and specify on the shopping form only Building = 1900, with no region,
floor, or room noted, and it would be considered a valid location without adding
it to the location table separately.

Strip Label Check Digits

On occasion, Code 39 font has an optional check digit at the end to increase the
scan accuracy.  These can be stripped as they are not necessary for operation of
Bar|Scan. Selecting the Strip Label Check Digits will strip this additional
character from the Asset Tag or Room Tag fields.

Prompt for Work Order #

Check this item if you want to manually enter the Work Order Number.  Bar|Scan
will prompt you for the Work Order Number, rather than assigning the next
available number for you.

Page 13-40 Bar|Scan



Chapter 13

Add Year to Work Order #

Check this prompt only if you have not checked Prompt for Work Order #. 
Checking this prompt will make Bar|Scan add a four-digit year to the beginning
of the Work Order Number that it is assigning.

Add Month to Work Order #

Check this prompt only if you have not checked Prompt for Work Order #. 
Checking this prompt will make Bar|Scan add a two-digit month to the beginning
of the Work Order Number that it is assigning.  

Note:  If you have checked to add both the Year and the Month to the Work Order
Number, the four-digit year will appear, then the two-digit month, followed by the
sequential numbers for the Work Orders.

Automatically generate Organization Codes

Check this prompt only if you would like Bar|Scan to generate numeric
organization codes.  Once done, a newly added Organization entered in the
Organization Edit screen will have a numeric organization automatically
generated when saved.

Require Print before Transaction can be moved

Uncheck this prompt only if you wish to turn on the feature that requires a printed
Transaction report prior to moving the items to the Asset Table.  By default, this
feature is checked on.

Tag/Take/Service visible outside of Transactions

The Tag/Take field is an editable field in the Transaction table and is critical in
determining how the transaction moves from the Transaction table to the asset and
Location History tables. However, once the move is complete the Tag/Take
operator is only needed for historical purposes hence is not displayed. If this
setting is selected, a Tag/Take column is displayed in the Asset Location History. 

The field indicates what kind of inventory operation was performed (either ‘Tag’
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or ‘Take’ or ‘Service’), which is important in the Transaction table but once
moved to the Asset Location History is only needed for logging or historical
purposes. The Default is to not show this information in the Asset Location
History.

Special characters to blank Asset fields

By default, when Bar|Scan imports information either from a handheld or an
external file or a keyboard, Bar|Scan does not overwrite existing data in a field
with a blank.  For example, if your handheld prompts for Purchase Order Number
and you leave the response blank, whatever previously exists in the Asset Table
will remain.  In other words, by default, there is no process to remove data and
replace it intentionally with a blank.

This option allows the intentional replacement of data with a black.  The details 
on how this is accomplished is documented on the screen.
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Standard Options Depreciation/Currency

This tab presents additional Company Settings related to Accounting.

These Company Settings are only applicable if you have the Accounting Module. 
Some countries have different costs that can be included in their depreciation
calculation.  This is where the selection of which costs are depreciable can be
made.

Typically, you will need to consult with your Fixed Asset Accounting Manager
before making any changes to this page.
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Standard Options Reminders

This tab presents additional Company Settings related to Table Integrity
reminders.

We recommend that perform a Table Integrity at least every 6 weeks.  You may
adjust the reminder schedule.
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Quantity Assets

Bar|Scan will allow you to track assets without the need to apply individual bar
code labels.  The Mobile Device can perform an inventory prompting for Quantity
instead of Asset Number.  This tab presents additional Company Settings related
to Quantity Assets.

You determine which combination of fields will make a Z number.  This is done
on this Screen.  It is important to decide this combination before entering your
first quantity items.

For more information on using the Quantity prompt with the Mobile Device, see
Chapter 11 - Bar|Scan Mobile.
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Display Fields

This tab contains options for you to select Catalog and Organization fields to
display on your Asset table.  The tab you will see will be similar to the one below.

Select Auxiliary Display Fields

For instance, if you would like to be able to view the Manufacturer of the Catalog
items on the Asset table, you could select Catalog, then select the Add button,
then select the Manufacturer.  Save your change.  There is no message, but the
change is immediate, and the top of the Asset Edit tab would change similar to the
one below.
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As you can see, there are many fields from the Catalog and Organization tables
that you could select, but you should try to limit your choices to approximately
three fields, because of available space on the Asset table.

Note: These are not additional fields.  If you look at the portion of the Asset table
that is displaying the Manufacturer, you will notice that the Catalog Type and
Description are both gone.  You could select all three items from the lists, and all
three will display. 

When you wish to display a Catalog field on your Asset table, you may select a
field by choosing the Add button.  When you click on the add button, you will see
a look up list similar to the one below.

You may choose to display any of the 48 fields listed here.  Highlight the desired
field, and click on the Add button.  The field will be added to the list of auxiliary
Catalog fields to display.  Once you have saved your change(s), the change will
be immediate, and there will be no additional message.  Note: If you have a panel
open, i.e., the Asset table Edit panel, you will not see the changes until you close
and reopen the panel.
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Once you have at least one item in the list, you may highlight that item, and then
select to either change that field or to delete that field, by clicking on the
respective buttons.

If you wish to display an Organization field, you can click on the Organization
tab, and then click on the Add button.  You will see a pick field list similar to the
one below.

You may choose to display any of the 11 fields listed here.  Highlight the desired
field, and click on the Add button.  The field will be added to the list of auxiliary
Organization fields to display.  Once you save your changes, the field will be
displayed on your other tables.  

Note: The fields that are selected here are not additional fields.  Organization
fields are already displayed on the Asset table.  If you select fields here, the fields
that are automatically displayed will be replaced with the ones you select here. 
For example, Division, Department, and Unit are automatically displayed on the
Asset table.  If you select only Division to be displayed on your Asset table, the
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display will change to say only Division. 

Once you have at least one item in the list, you may highlight that item, and then
select to either change that field or to delete that field, by clicking on the
respective buttons.

Location Field Validation

The next tab, Location Field Validation is displayed below.

This tab will give you the option of entering Location and Work Order Location 
fields that will not be validated by the system.  For instance, you may want
Bar|Scan to validate only the Region and Building fields, and not check the Floor
and Room fields.
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By clicking on only the Region and Building fields, you can enter Floor and
Room  locations that are not in the Location table, and Bar|Scan would not
consider this an error.

For example, you may want to create a Work Order that says to deliver conference
chairs and tables to the South side patio of your building.  Yet, you do not have
a location in Bar|Scan that specifies this patio.  Using this feature, you could be
specific about where to place the furniture, and Bar|Scan would accept it as a valid
location.

If you do not use a field, such as Region, making sure the system does not validate
that field is of no advantage.

When you click on the box next to a field to remove the check, you will see a
message similar to the following.

If your change was intentional, simply click on the Yes button.

After you have finished making all of the changes that you intend to make, you
need to save your changes by selecting the Save icon from the tool bar, or by
pressing the Ctrl + S key combination.  You will be shown a dialog box similar
to the following.
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As the dialog box says, you need to immediately exit Bar|Scan, reopen Bar|Scan,
and perform a Reindex on the Location table of this company, before this feature
will work.  

You can later go back to checking any items that you have selected to not be
validated by returning to this screen and clicking to add check marks to the proper
fields.  Be careful, though, as Bar|Scan will check Transactions as well as the
current location for your Assets, as well as all new Assets being added to the
system.  This may cause you to have errors on Assets that were previously
considered to have no errors.
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Company Synchronization

Introduction

Bar|Scan allows you to actually maintain a single company over a wide-area
network or Internet server while still maintaining much of the speed associated
with having your company on your local server.  This is done by synchronizing
two working company databases which can reside on separate servers.  Changes
can be made to both company databases concurrently.  The changes made to one
database appear on the other database on a regular interval determined by you.

Bar|Scan keeps track of the changes made in a company, considering which
Bar|Scan Tables were used, then sending those changes to a specific set of email
accounts.  In turn, when the data arrives at those accounts via email it is picked
up by a separate Bar|Scan license in the receiving location and applied to the
target company.  From Bar|Scan’s perspective the number of companies that can
be involved in these transfers is unlimited, but in reality they are limited by the
practical considerations related to the email system itself, and by the actual
number of company databases and tables desired and the time it takes to prepare
and send the emails.

Requirements for Company Synchronization

Your computer requirements for synchronization include network access when the
timed or scheduled synchronization begins.  Additional requirements are:

T  Sufficient disk space for your Company, emails, etc. 

T Both computers are using the same version of the Bar|Scan application

T Import/Export Module for implementation of Bar|Scan Logging feature

T Multiple Company Module for implementation of Bar|Scan Company
Synchronization feature

T A valid anti-virus program recognized by Microsoft Windows
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T Microsoft Windows 8, 10 or 11.  As of this document date, Windows 8, 10 or
10 allow client programs to access Outlook without sending multiple messages
to the user if there is a valid anti-virus program installed and recognized by the
operating system.

T Microsoft Outlook 2016 or newer, installed on all workstations either sending
or receiving synchronization emails.

Steps to Implement Company Synchronization

Since Company Synchronization requires two separated companies, it is assumed
that all sites already have the Bar|Scan application properly installed. The detailed
steps required to setup synchronization between companies differ slightly
depending upon the type of synchronization desired, but the overall outline is the
same for all sites.

1. Configure user access to the Company Synchronization screen and functions.

2. In the Bar|Scan Company Synchronization screen create and configure a
synchronization configuration. This will control how data comes in to and goes
out from the company specified in the configuration. 

3. Decide to do synchronization manually or on an automated timed basis. If
automated, set up the appropriate Bar|Scan user account, ‘ .bini’ file (Bar|Scan
initialization file) and Windows Task Scheduler item.
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Allowing Access

The default configuration of Bar|Scan does not allow access to the Company
Synchronization screens. You will have to allow access to users who will be
involved in either sending or receiving company data. To allow access to
Company Synchronization do the following:

1. From the main menu access the User Screen. (File... < Open... < Users).

2. Select the user whom you want to give the option of accessing one or more of
the Company Synchronization features.  If you do not yet have any users, see the
section on how to add new users.

3. Select the ‘Edit’ tab, then select the ‘Page 1’ tab. You will see a screen similar
to the one in below. Note that the line where you see ‘Company Synchronizations’
is unchecked.  See the example below for reference to the User Screen with
Company Synchronization unchecked.
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4. Put a check mark next to ‘Company Synchronizations’.   This will allow access
to the other options related to this function. Depending upon the role that your
user is going to play, select the functions that this user will be allowed to perform
once they have accessed the Company Synchronization screen and then press the
‘Save’ button.

Here are some typical users:

User Role Items checked ON Items UNCHECKED

Master User All None

Typical PC User None All

Typical Handheld Only User None All

Synchronization Administrator All None

Synchronization Timed Update User Activate Add, Change, Delete, Set

The first  recommended typical user is the ‘Synchronization Administrator’, a user

with all synchronization access, able to add, change and deleted synchronizations,

as well as send and receive data. This is typical because generally there will be

only one user involved in these activities at any particular site.

The second recommended user is the ‘Synchronization Timed Update User’. This

is not a real user per se, but is generally used when automatic updates are desired

on a timed basis by using Windows Task Scheduler. This account is used for

logging in to Bar|Scan and performing the synchronization automatically  (See the

section on how to use the Task Scheduler).
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Below is a completed user screen with all synchronization options turned on and

accessible by the user. This is typical for the Synchronization Administrator.
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Once a user has been allowed access to Company Synchronization, their menu

system will change from disallowing to allowing access as shown below.

This menu no longer has the Synchronize item greyed out and is therefore

accessible.
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Setting Up a Company Synchronization Configuration

When creating a Company Synchronization configuration, keep in mind that you

are configuring how data flows between the currently open company and the

target company specified in the configuration. Company Synchronizations should

not be shared between companies (such as catalogs might be shared) or else

unpredictable results may occur.

The general steps for setting up a new configuration are:

1. Navigate to the Company Synchronization Screen.  From the Main Menu select 

File.. < Company... < Synchronize.

2.  Add a new Company Synchronization configuration by selecting  ‘Add Blank’

or ‘Add Template’.
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3.  Give the Company Synchronization configuration a unique name in the

‘Name’ field. This will be used to identify this particular configuration.  See

below where a sample descriptive name has been entered.

 

Important Note: If you are going to automate this synchronization configuration,

this is the name that will be used in the ‘.bini’ file to specify which configuration

to use. So if you change this name, you must also change it in your related ‘.bini’

file or the automated synchronization will fail.

Next, specify the target company and email accounts (See Synchronization

Setup).
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Specify which tables will be involved in the data exchange and in what direction

the data will flow. Note that data can flow one way or two ways, depending upon

the type of synchronization desired (See Data Flow Setup).

Clear all log entries to guarantee the initial data exchange contains all desired data

(See Synchronization Log).

Save you work by selecting the ‘Save’ button.

Synchronization Setup

To create a successful Company Synchronization configuration, you must fill in

all of the fields within the ‘Synchronization Setup’ tab.  Here are some guidelines

in filling in these fields. At the bottom of the list is a sample figure with all of the

fields filled in. Do not use the samples; you must determine the values you must

use for your own installation.

“Company to Synchronize With” Company Description Field - This is a

freeform text field used to describe the company. You can enter a generic

description or you can use the lookup function (right click on the field, select

‘Look Up Value…’) and navigate to the target company on your network, if it is

available, and once selected, it will fill in the full company name and path for you.

Of course, if you are using the synchronization functions it is quite likely that your

target company will not be available on your network. In either case, we 

recommend that you use a description that helps you locate the targeted company

on your company/worldwide network.
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Company Code Field - Enter the actual Company Code of the company that you

will be synchronizing with. Note that all companies have a company code and

these should be unique to the company. To determine the company codes of any

company navigate to the Company Settings screen (File... < Company... <

Housekeeping... < Settings) after that company has been selected as the current

company.  Note the company code displayed in the example below.

If you have access to the targeted company over your network, you can also use

the lookup function (in the Company Synchronization screen right click on the

Company  Code field then select  ‘Look Up Value…’) to navigate to the company

on the network, and Bar|Scan will attempt to determine and enter the correct

Company Code for you.
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“When Sending Data” Max File Size (Bytes) field - If you are not sure about

what to enter here, start conservatively with 3,000,000 bytes. This will break up

your data transfers into multiple emails, each with a maximum size of about 3 Mb.

The larger the number, the fewer emails in each Email set. See below for some of

the factors that affect what number should be entered here.

Most email systems have a maximum attachment size. This value is not constant

because it depends upon many factors. The most important is the route that the

email takes to get to its target.  Emails hop from server to server over the internet

until they reach the server that services the targeted email account. Each server

will have its own maximum attachment size, generally as a set policy of the  the

servers owner.  If the attachment is larger than allowed, the server will reject the

email and you may get a ‘not deliverable’ message.  The maximum file size is

determined by the smallest of these allowed sizes. It may take some testing to

determine the maximum size. Note that if you can keep the email within a known

service provider (i.e., bother sending and receiving accounts belonging to the

same vendor with the email being transferred over its own servers) that will

generally give you the largest possible maximum file size. For example, as of this

writing Google Gmail allows a maximum attachment size of approximately 25

megabytes (MB).

To: (Email Address) field - Enter the target email address. This is the address at

the other site that will receive all of the transferred data from this company.  

This is usually an account that has been setup specifically for this purpose at that

site. Note that all companies synchronizing with each other, even if the data flow

is all one way, will each have a Company Synchronization configuration pointing

to the other company. If there is some two way data flow, then it is likely that the

‘To’ and ‘From’ email address of the two configuration will be the same except

they will be swapped. The source ‘To’ will be the same as the target’s ‘From’ and

vice versa.
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Bar|Scan does test for email format.  It does not verify that the email accounts are

actually valid.  

From: (Email Address) - Enter the address that you want to use as the source of

the emails. Usually this is an email account that has been specifically setup for this

purpose.

Bar|Scan does test for email format.  It does not verify that the email accounts are

actually valid.  See the note under ‘To’ above for some further guidelines.

Important: With recent security updates from Microsoft, the ability to specify the

‘From’ email address within Outlook has been restricted. No matter what email

address is entered into this field, Outlook will only use the default Outlook email

address for outgoing email generated by Bar|Scan.  Additionally, if you are using

both Outlook and Microsoft Exchange, Exchange specifies the value of this

default email account upon the user logging in.  So if you decide that the receiving

Bar|Scan installation has a requirement that it receive emails from a specific

account (this is not recommended by the way) then you will have to setup unique

logins for each desired account.  Generally this would be used when using

automated synchronization using the Windows Task scheduler.

“When Receiving Data” - Inbox Email Folder Field - Enter the INBOX folder

in your Outlook client where Bar|Scan should look for incoming emails for data

coming into this company.

Microsoft Outlook allows the creation of folders within its INBOX, as well as

allowing the creation of rules to determine what folder receives what incoming

mail. A typical outlook user has several different folders that receive e-mail. In

this field you specify the exact folder that you have designated to hold Bar|Scan

incoming data for this company. In the example we have been using, data is

flowing between company DEMOCO and XXX. An example Outlook email

folder designed to accept incoming data may be ‘INBOX\XXX-Incoming’. You

would have to create this folder as well as create a rule to redirect Bar|Scan data

to this folder when it comes in.
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If you have no subfolders, you can accept the default value of ‘INBOX’ and

Bar|Scan will look for incoming data there.

Technical Note: Microsoft Outlook can have several Personal Folder Files (with

extension .PST) active simultaneously.  Additionally, it can also pick up e-mail

for several email accounts as well. Each email account has a default folder that

serves as its ‘inbox’.

In Outlook 2016 a custom folder can be set by selecting ‘Tools/Account

Settings…’, then selecting the ‘Email’ tab, then clicking on the ‘Change Folder’

button. This button changes the default delivery location for the highlighted email

account.  This does not have to be the actual ‘Inbox’ folder for each Personal

Folder File, but it is by default. If you have specified a folder different from

‘Inbox’ as your default delivery location, then you must use that folder name as

the basis for specifying the folder that Bar|Scan will look in.

For example, if you have specified the folder ‘CustomInbox’ as your delivery

folder instead of the default ‘Inbox’ folder name and one of your rules redirects

Bar|Scan to one of its subfolder, .e.g. ‘CustomBarScanIncoming’ then the path

specified should be ‘CustomInbox\CustomBarScanIncoming’.
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Below is a sample figure with all of the fields filled in.  Do not use these actual

values; you must determine the correct ones for your installation.
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Data Flow Setup

Bar|Scan allows you to control which of its tables participate in the

synchronization of data between companies.  The ‘Data Flow Setup’ page is

where you specify two things: what data gets moved and what direction it goes.

You are presented with a list of available tables. Some tables are grouped together

automatically. In other words, if you assign a data flow, related tables will

automatically be assigned the same flow.  Below you can see a sample screen

where no tables have yet been selected.
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The idea is simple.   First select the table and then click on the button on the right

that controls how you want data to flow for that table. If you want data only to be

sent out from the current company, click on the ‘Data Out’ button. If you only

want data coming in, click on the ‘Data In’ button. If you want data going both

ways, select the ‘Data in and Out’ button.

Here are a few things to keep in mind.

Some tables are automatically linked, so they will always have exactly the same

data flow. For example, the Asset and Location History tables are linked. If you

want one, you must accept the others.

Some tables, although not linked, should, under most circumstances be grouped

together. The reason they are not linked automatically is that there ARE

circumstances where they are not needed. Here is a list of highly suggested

groupings. Unless you are aware of a reason not to select any of these related

tables, it is suggested that you include them all together. Note also that this list

may change with time and is not exclusive. Finally, you will note that the

CATALOG table is in two groups, but not all of one is in the other. Here is a

circumstance where the intent of the synchronization comes into play. If you are

emphasizing the synchronization of assets, select the group in ‘A’ below. If you

are emphasizing Catalogs without assets, select the group in ‘B’ below.

A Group - If you select ANY in this group strongly consider including all of the

others:

Asset / Catalog / Condition / Manufacturer / Organization / Status

B Group - If you select ANY in this group strongly consider including all of the

others:

Catalog / Catalog Category / Depreciation Method / Manufacturer

C Group - If you select ANY in this group strongly consider including all of the

others:

Handheld Computer / Handheld Computer Configuration
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If a table is going to be included in the synchronization list, with data flowing

either IN or OUT, it must have LOGGING enabled for that table.  See the section

in the Bar|Scan User manual on how to setup logging for a table. In short, you

must enable logging in the ‘Table Properties’ screen, exit Bar|Scan, login again,

and then do a Restructure to create the log tables.  Bar|Scan will check this when

you try to save your Company Synchronization configuration. If you must make

modifications you will see a message similar to that found in The image below.

VERY IMPORTANT: When setting up logging for the specified tables, make

sure that you select ALL logging actions: Adds, Deletions, Changes, and ‘All

Fields’.  Not doing so will prevent the Company Synchronization from working

properly.

You will be able to save the invalid Company Synchronization configuration if

you are not ranging and the ‘Sync Enabled’ field is UNCHECKED. Until you fix

the problems you will not be able to put a check mark on the ‘Sync Enabled’ field.
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Most situations do not require a wholesale copy of all data back and forth between

companies. For example, a common scenario is where several independent

Bar|Scan installations have been installed in several locations around the world,

each managing the assets at their own location. However, corporate headquarters

wants to create some reports incorporating all of the data from all installations.

There are a few ways this can be done, but one way is to do a one-way

synchronization of asset related data from each of the Bar|Scan locations to a roll

up company at headquarters, where a report is printed of the merged data. In this

situation, the Company Synchronization configuration may have a limited set of

tables involved, all going ‘Out’. Note the setup shown on below.
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The only data they are interested in is the data that will show up in their reports.

Data flow is one way, and most of the tables related to the Asset table are not

included, such as the ‘Status’ table, as the code itself in the asset table is sufficient

in the report.

Under most circumstances it is recommended that you do NOT include the

following tables in your Company Synchronization configurations unless you have

a compelling reason to do so and have considered the consequences. Generally,

the only time these tables may be allowed to be included is if the target company

is a one way (out) and it is for reporting purposes only.

User Table. Sharing the user table essentially allows all installations to see,

change and even delete users at any other installation. This is generally not

acceptable! 

Transaction Table. Transactions are generally local to the installation, have not

been vetted as accurate or even valid. Sharing these will generally create a lot of

confusion when ‘mysterious’ transactions begin showing up.

Synchronization and Synchronization History. Including these may cause

problems for the Synchronization itself.
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Synchronization Log

The ‘Synchronization Log’ tab contains information that performs two functions.

First, it is a record of the data flow available for reporting purposes. It can be

printed using the Bar|Scan reporting functions. Second, it is used during the

synchronization process itself to help determine what data to send to the target

company, so that not all data has to be sent with every transmission.  Below you

can see a sample one-way transmission of essential asset data contained in

DEMOCO.

The most recent successful sync of each table will always stay in the log history

list.  Also, if ‘Log Unsuccessful Ops’ is checked, line entries for unsuccessful

operations will also be added if they occur.   When this is checked, no

‘unsuccessful’ entries are added, for a sync, and there are no messages in the

‘Operation Log’ field, then it was successfully completed.
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Important: the most recent synchronization might not have been successful just

because there is a ‘successful’ entry for a table in the log.  It is very important to

check the date and time, because that is what tells you when the last successful

synchronization occurred. You will only see unsuccessful synchronizations by

checking the ‘Operations Log’ field for messages. When a successful

synchronization occurs, this field will be blank.

If ‘Log Most Recent Only’ is checked, the log entries will only show the most

recent successful sync as mentioned above.  If this option is ‘checked’, whenever

a sync is done it purges old log entries and add new entries for the current sync. 

If this item is UNCHECKED, it will not purge and will keep accumulating

history.

Over time, the Synchronization Log may contain thousands of records of history 

since every sync operation will add a set of entries matching the number of tables

being synced.  If you choose to keep this history, we recommend that it be

reviewed and cleared on a regular basis by putting a check mark next to ‘Log

Most Recent Only’ and performing a manual synchronization, then performing a

Company Housekeeping ‘Pack’ operation only on the specific table

‘Synchronization History’. You may be tempted to press the ‘Clear Entries’

button, but this is not recommended for this purpose. If you press the ‘Clear

Entries’ button it will clear all of the log entries but it will also send ALL of the

company data across on the next synchronization.
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This transmission corresponds to the following Data Flow Setup.

 

Note that each line in the log corresponds to an operation on a given table. It

records the table alias, when the In/Out operations took place, how long they took

and what kind of changes resulted. It also lets you know the ‘Part Count’, i.e., how

many parts the data had to be broken up to fit the email file size limit.

There are some options and operations that can be performed from this page.

1. Log Unsuccessful Ops (a checkbox). This is checked ON by default. If

unchecked, you will not see any unsuccessful synchronization operations. This is

generally not recommended.
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2. Log Most Recent Only (a checkbox). The log list can continue to accumulate

entries for each attempted synchronization or it can be set to keep only the results

of the last relevant attempt. Unless you have a specific need, this value is checked

ON by default.

3. Clear Entries button. Clicking this button will cause a prompt to clear all of the

Synchronization Log entries. The result of this is two-fold. First, there is no longer

any log history of any past synchronization attempts. This is desirable if you have

been accumulating a synchronization log history (by having ‘Log Most Recent

Only’ unchecked and want to delete a log that is growing too big.) Second, it

forces the next transmission of data to include ALL data in the current tables that

are participating in the synchronization. This is necessary since Bar|Scan no longer

knows the success or failure of any past synchronization.

If you do not want to resend all of the data in all tables selected for outgoing

synchronization, then do not use this button but put a check mark next to ‘Log

Most Recent Only’ and performing a manual synchronization, then performing a

Company Housekeeping ‘Pack’ operation on the table ‘Synchronization History’.
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Reconciling Synchronization Data Conflicts

On occasion, edits will be made to the same fields within the same tables within

the working companies.  For example, the same asset has information entered into

the Remark field in both companies.  Bar|Scan does not determine which edits

take priority, rather, the user will need to decide which edit takes priority.

After a synchronization is completed, these types of data conflicts can occur if the

same fields are edited in both companies.

If these data conflicts are occurring often, this can be alleviated by synchronizing

the working companies more frequently.

In any case, when synchronization data conflicts occur, a message will be

displayed when the Table is opened as shown below:

As the message states, you can choose to open the Table with the pending edits,

or reply ‘No’ to open the Table without the pending edits.  If you reply ‘No’, the

pending edits will remain in the queue for editing the next time you open the table,

they are not abandoned.

Housekeeping Page 13-75



Housekeeping

If you reply ‘Yes’ to open the Table with the pending edits, you will be presented

with the following screen.

As stated in the message above, the synchronization edits have been placed into

the Table.  Changes and additions have been ranged so the you can move quickly

through them by using the Panel...< Range...< Find Next Command.  Here is an

example of a Ranged Asset that requires a review and edit.
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Keep in mind that the Find Next Command looks for the next Range from the

record that you are on, not the next item within the current range.  For example,

assume you have 5 assets that have changed, three at the top and two at the bottom

with several thousand unchanged assets in between. If you look carefully, you will

see that the top three have been ranged. Also, the bottom two have been ranged.

There is a large unranged gap in-between. If you are on the first asset at the top

and then select the ‘Find Next’ command, you will move to the top of the bottom

range, not the second asset.  Also, it does not search for Ranges above the cursor. 

So, it is always best to use the First Item Icon before beginning your search for

Ranges.

Unless the field that requires the edit is displayed as a column on your Browse

Panel, you will need to click on the Edit Tab to see which field requires attention.
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In this case, the Remarks #1 field has a pending edit.  This edit is the one

performed on the other company, not yours.  You can now decide to keep the new

edit by making no changes and moving on to the next item, or abandoning it by

selecting the ‘Restore Original Value’ pop-up menu item.

To see what information was in the Remark #1 field prior to the synchronization,

right Click on the Field as shown above and select ‘Field information’.
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As you can see from the above panel, the item ‘Old Value’ contains the prior

information. In this case, the Remark #1 field contained the text ‘Ready to

Salvage’.

If you wish to keep the prior information use the ‘Restore Original Value’ choice.

The ‘Restore Original Value’ choice will undo only the edit to the single field.

When you save your edits, you will be presented with the following screen. 

Respond ‘Yes’ only if you have completed all of your edits.

This confirmation message states that it will clear all ranges.  If there have been

many items (such as Assets) changed, then likely there will be many ranges as

well.  Other than clearing all ranges first, the Save button works exactly the same

as a regular ‘Save’.  Since all ranges are cleared automatically prior to saving,  you

cannot copy values from one item to another by using a range. When you say

‘Yes’ to this verification screen, Bar|Scan will turn off all of the ranging (so that

nothing get accidentally copied from one record to any others) and then it will

save all of the edits you have done on each individual item. If you should

manually turn off ranging, you will still get this message as a reminder that you

are in the special edit mode for synchronization.
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Once the Synchronzation values have been saved, you will get a confirmation

message telling you that the Manual Sync files have been removed also. In short,

after the manual Synchronziation changes have been saved, there is no longer any

need for them in the SYNC folder, where they have been stored until now. The

message is telling you that it was able to successfully remove them. If for any

reason it cannot remove these files, it will also inform you of this fact as seen

below.

Page 13-80 Bar|Scan



Chapter 13

Manual Synchronization Conflicts

The process below is only necessary when Bar|Scan identifies that there are

synchronization conflicts.

Begin by logging in as a Master User.  A Master User log in is required to do a

manual synchronization reconciliation.  This is because important decisions about

data may have to be made that might not be in the job scope of a Non-Master

User.

Remember that a Master User login is not required to perform the automatic

synchronization operation.

After a manual synchronization is completed in the Sync screen use the menu

option to list Pending Manual Sync Updates for the Current Company.  This will

tell you where manual updates are needed.

For convenience, the manual synchronization conflicts can also be accessed from

the Housekeeping Menu.

When updates come in using the synchronization, the user does not know which

screens may have manual updates unless they examine the synchronization log. 

Even then, the log may not have all of the pending updates, since one of the

options for the log is to keep only the most recent entries.  So if the user wants to

know what screens they have to make manual edits on, they need a list. This lists

the manual sync screens that need attention.  These are also what might be called 

conflicts.  But also may include any complementary changes from other fields that

changed prior to the most recent edits of any particular record.
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As shown below, after a manual synchronization is completed in the Sync screen

(File-> Company-> Synchronization), use the menu option File-> Company->

Housekeeping-> Miscellaneous->  List Pending Manual Sync Updates for the

Current Company.  This will tell you where manual updates are needed.
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The ‘Panel’ Sync menu item will appear when you have a Screen Open.  It

performs the same function as the Housekeeping Syc Pending described on the

previous page, but is more easily accessible when doing edits.

From the Main Menu select Panel-> Sync-> List Pending Manual Sync Updates

for the Current Company as shown below.
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List Pending Manual Sync Updates

Bar|Scan will inform you which Tables have pending manual synchronization

updates that you will have to apply.  As shown in the example below, there are

pending updates in the Asset Table.

Open each of the Tables listed that need manual reconciliation.  In this example,

open the Asset Table.

Bar|Scan will load all of the changes that apply to the Asset Table including

location history.  Reply ‘All’ when asked what to information to load.  Bar|Scan

may actually determine there is nothing to load. 

Most of these reconciliations will be ‘old’ data. That is NOT BAD data, just data

that was entered before the most recent entries.  For example, if someone changes

the catalog one day, sends it to you, but in the mean time you have changed the

manufacturer’s part number. The catalog change will be ‘old’ data that needs to

be applied.

Do the pending edits to the Table carefully.  Review each edit and determine

which ones should be saved.  Do not just accept all edits and press save unless you

are sure that the current database’s edits take priority over the other database(s). 

If you complete the edits and save the information, then the manual

synchronization files will be deleted by Bar|Scan.

If you decide to cancel the edits, the manual synchronization files will be saved

and reloaded next time you open the Table.
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Look for Pending Edits

When in sync mode, holding the mouse over a field with pending synchronization

edits will display the information before the  synchronization and the pending

values if it has changed. No need to click first.

‘Cur value’ is the colored value seen on the screen. ‘Orig Value’ is its original

value, what it was before the sync edits were applied. The ‘Orig value’ has been

written over and is not currently visible. It can be returned by right clicking on the

field and selecting ‘Restore Original Value’.

Do the pending edits to the Table carefully.  Review each edit and determine

which ones should be saved.  
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Set Commands Are Not Compatible with Sync Edits

If a Table has a SET Command applied with a Filter, then Bar|Scan will not load

manual synchronization files.  This is to prevent filtered reconciliation errors.

However, if you attempt to load the manual synchronization files, Bar|Scan warns

you that you have a filtered SET Command.

In other words, if there are pending sync edits and the user opens a screen that has

a filter in its SET, a message stating to select a SET without any filters as in the

example screen below.

Reports can be synchronized like any other data.  However, you must select the

‘All Reports’ icon and then choose the report.  This be because the other kinds of

reports, e.g. Asset, Location, etc. are actually filtered  lists based on different work

areas.
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Remove Manual Synchronization Files

The ‘Panel’ Sync menu item will appear when you have a Screen Open.  It can

also be used to remove Manual Synchronization files.  This allows you to remove

the Sync Files manually if they were created only for testing, sent to the wrong

email address, or other mistakes.

From the Main Menu select Panel-> Sync-> remove manual Synchronization files

related to the Current Screen as shown below.

You will then be presented with the screen below.

Respond YES if you are sure that you wish to delete the files.

The other way for the sync updates to be removed is to load them, then save the

edits. This assumes that the number of edits is small.
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For Advanced Users: The pending Sync Files are located in the SYNC folder. 

You can also do it outside of Bar|Scan within windows by manually deleting files

in the Sync folder.) This option is especially valuable if someone accidentally

reloads an old set of Sync files and the user knows it. It still must be used with

care though. It should only be used when the user is SURE that it is ok to delete

them.  Only master users have access.
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Setting up Automatic Company Synchronization

Bar|Scan can be synchronized on a timed basis by using the Windows Task

Scheduler.  To do so the Bar|Scan administrator must understand several concepts.

1. How to use and set up a working Bar|Scan initialization file.

2. How to use and set up Windows Task Scheduler to run Bar|Scan.

How to Set-Up the Bar|Scan Initialization File (.bini)

“.Bini” files (Bar|Scan Initialization Files) are explained in detail in the Tip/Hint

entitled “Scripting Feature in Bar|Scan”. These text based script files allow

Bar|Scan commands to be executed when Bar|Scan starts up. The ‘SYNC’

command is one of these commands. It causes the execution of one of the

Company Synchronization configurations.  A sample of simplest possible .bini file

that on startup will login, open the desired company, run the desired Company

Synchronization configuration, then shutdown is provided in the Knowledge Base

portion of the Bar|Scan website at www.barscan.com

Where should the .bini file be placed? 

The .bini file can be placed anywhere accessible by the Windows Task Scheduler

and by specifying a full path accessible by Bar|Scan. However, it does make

technical support easier if they are in one of the Bar|Scan folders. Try to keep

them together in the same folder, giving them different names depending upon

their function, but keeping the .bini extension. For example, perhaps you make a

special subfolder called ‘Scripting’ and put there all of your .bini files. For

example, if you have two companies you are syncing with you may have:

SyncDemocoToXXX.bini

SyncDemocoToYYY.bini
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Setting Up Windows Task Scheduler

Within Windows Control Panel, Administrative Tools you will find the ‘Task

Scheduler’ applet. Once you activate this you will get a screen similar that shown

below.

To create a scheduled task to run the Company Synchronization, perform the

following steps:

1. Click on the ‘Create Basic Task…” option in the Actions list, or select from the

menu Action/Create Basic Task…
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2. You will start the ‘Create Basic Task’ Wizard. Fill in the ‘Name’. Give it

anything desired that you will understand when picking it out of a list of other

scheduled tasks. In this sample we give it the name “BarScan Sample Company

Synchronization=Democo To XXX”, then click on ‘Next’.

Housekeeping Page 13-91



Housekeeping

3. Select how often we want to do the Company Synchronization. In this case we

select ‘Daily’. When completed, click on ‘Next’.
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4. Now select when the task should be triggered. Since we have selected daily, it

will be triggered at the same time every day. In this example we are starting it at

1 am every night. When completed, click on ‘Next’.
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5. We want to start Bar|Scan, so select ‘Start a program’. When completed, click

on ‘Next’.

6. Now enter the Program, the path to the .bini file, and the root folder of the

Bar|Scan executable. Note that you need to specify the full path of both the

program and .bini file. The ‘Start In’ location MUST be entered. It is the folder

where the ‘Program’ is located.

a. Program C:\BARSCANW\BARSCANW.EXE

b. Add arguments C:\BARSCANW\SampleSyncDemoToXXX.bini

c. Start In C:\BARSCANW
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Note that the wizard may cut of some of the viewable portion to the right of the

field, but it will still use all of the characters entered. Note what it looks like

below.

When completed, click on ‘Next’.

7. Click on ‘Finish’ at the final dialog. This default setup is basic. It will run as

long as the user is logged in at the time that the Synchronization was scheduled.

Note that there are some more advanced options available, such as automatic

login, what Windows User account to use, even turning on a computer to run the

task if it is off at the scheduled time. Please consult your in-house technical

support and the Task Scheduler documentation for implementing some of these

options.
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Some Notes on Email Usage

Note that data is sent in groups of emails. Bar|Scan attempts to minimize the

number of emails sent, but is limited by the maximum attachment size. When data

is incoming, Bar|Scan will not load a partial set of emails. It will wait until it finds

all of the emails in a set, then load them all at once. Once it has done this it will

trigger the status of the emails and mark them as ‘Read’. Emails that have a status

of ‘Unread’ are considered, whereas if it is marked as ‘Read’ it is ignored by

Bar|Scan. Be careful to not accidentally mark an unloaded email in a set as ‘Read’

or else the whole set will never get read.

What is Available for Reports

The introduction of Company Synchronization by Email added some new fields.

One of these fields is the LogCoCode field. This field has been added to all tables.

It reflects the company code under which the last operation was performed on a

record. For example, if an asset is changed in the Democo its LogCoCode field

will be assigned the value of ‘DEMOCO’. When that update is sent by Company

Synchronization to another company, it will keep that value until it is updated

again in the new company.

Another field is ‘LogUDT’. This is a ‘datetime’ field that contains the Universal

DateTime equivalent of the combined LogDate and LogTime fields. The UDT or

Universal DateTime is equivalent to GMT or Greenwich Mean Time.
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Key Field Length

There are some Bar|Scan Fields that we call Key Fields.  This is because they are

located in more than one Table in Bar|Scan or have specific reasons for their

length, e.g. the Room Tag is normally length checked when scanned to minimize

the error of scanning the wrong bar code label.  This Tab makes it easier to change

the length of these field by also adjusting the length in all the correct Tables.

While it is also possible to change the length of the fields in the individual Tables,

using this feature is much faster.

You can change the length of as many fields as you like, then press the Save key. 

A Restructure and Reindex is required after you have made your selection.
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Reserved Bill of Material

You can restrict your Reserved Bill of Materials by using one or more filters.  In

the example below, the filter Catalog Category equal to ‘EP’ restricts the Assets

that can be used to fulfill reservations to those categorized as ‘EP’, the code

commonly used for Computers. 

You can also create restrictions by location, organization, or even other asset

qualities.
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Images

You can restrict your recognized image types by checking one or more image

formats.  In the example below, the ‘Common Only’ button has been pressed

selecting only those formats that you see as checked as being recognized by the

Bar|Scan Imaging Module. 

The more image types that you check on, the longer it takes to process image

related functions such as displaying or printing images as Bar|Scan will need to

search for more image files.
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THE MISCELLANEOUS DROP DOWN MENU

When you select Miscellaneous, you will see another menu list like the one

below.

You will not need to use most of these items every day, and you may never need

a couple of them.  
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VALIDATION

Validation is the action of checking the accuracy of your asset information based

on rules.  For example, one rule is that two different assets cannot have the same

serials number.  This feature allows the user to create a list of custom validation

rules for the Main Tables in the Bar|Scan Desktop Application.  These Rules apply

to specific fields.  By default, all Bar|Scan tables have validation rules that fields

must met.    There are two mechanisms to control these rules.

#1.) For the Transaction Table Only, select the ‘Set Transaction Validation

Messages’ panel.  In this panel, you can enable, set to warning or disable a

specific validation.  These are the most common validations for the Transaction

Table and are robust enough for most users.

#2.) There is a more advanced ‘Universal Validation’, whereby Bar|Scan

administrators can establish a single set of custom validation rules per company

database for most tables, including the Asset and Transaction tables.  It verifies

data when it is saved.  Values can also be assigned just they can be assigned in the

handheld devices with Advanced Handheld Validation.

When you select Validation, you are presented with the two menu options as

shown below.
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Set Transaction Validation Messages

The Set Transaction Validation Messages Display Screen allows you to select

how errors are treated when Bar|Scan checks the Transaction table for validation.

This feature will allow you to see the list of items that Bar|Scan will check for

when you choose the Validate the Transaction feature.

When you use choose to validate the Transactions, Bar|Scan will have the ability

to check the Transactions in your Transaction table according to the items listed

here, and will check for all of those that are set to Enabled.

This table will allow you to view the types of items that Bar|Scan checks the

Transaction table for, and all of those that make an error message.  It also will

allow you to reset the severity of the validation messages, so that they create only

a warning message and not an error, or so that they are disabled which creates

neither an error nor a warning message.
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Change the severity of the error message by highlighting the message, and double

clicking it.  

Selecting the Ok button will save any changes that you have made to the severity

of the messages, and then take you back to the Housekeeping Menu.

The Enable All mode will set all of the messages to Enable, therefore Bar|Scan

will check all of the Transactions for all of the items listed here during the

validation process.  Each time that Bar|Scan finds a Transaction that does not

follow the central idea of the message, it will consider that Transaction invalid. 

When the Transactions are printed out, any of the Transactions that are found to

be invalid, Bar|Scan can print an error message for.  Transactions that are found

to be invalid cannot be moved to the Asset file.  Invalid Transactions have to be

changed to make them valid, the validation process needs to be done again, and

then the Transactions will have to be printed again before Bar|Scan will allow you

to move them to the Asset file.

The Next Different mode will instruct Bar|Scan to search through the list to find

the next message that is set to a different severity.  Bar|Scan will start at the first

message and scroll the messages.  When Bar|Scan finds a message that has a

different severity setting, the pointer (which appears on the left-hand side of the

messages) will stop and point to the first severity that is different.  If Bar|Scan

does not find any messages that are set to a different severity, you will see a pop-

up message that will say “All messages are set to Enable,” or “All messages are

set to Warning,” or “All messages are set to Disabled.”

The Cancel mode will simply cancel any changes that you have made to the

severity of the messages, and will take you back to the Housekeeping menu.

Selecting a Message

You can choose a message by clicking on it with your mouse, using the arrow

keys to scroll down the list until the highlight bar is over this selection, or by

simply typing the hot key, in this case the letter “v.”
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On this table, you may choose a message simply by using the arrow keys to scroll

up and down the list, or click on one of the messages with your mouse.

You may change the severity of the message by either double clicking it with your

mouse, by moving the highlight bar over the message that you want to change and

pressing the space bar or the <Enter> key.

Note: There is an exception to the check for Duplicate Serial Number.  If the

Serial Number field is left blank, or if the field is filled with NA for Not

Applicable or FU for Follow Up, Bar|Scan will not consider these duplicates. 

Therefore, you can use NA or FU in the Serial Number field for many Assets, and

Bar|Scan will not consider this an error.

The default for the Severity for each message is set to Enabled.  Therefore,

Bar|Scan would check for all of the messages, and consider each Transaction not

following these guides invalid, and therefore not movable to the Asset file.

There are times you may want to change the severity of the message, or to disable

it completely.

For example: You may not have the Work Order module, or you may have the

Work Order module and may not be using it for this particular company.  If this

was the case, you may have used the Work Order Number field to store a number

that was not a legitimate Work Order Number.  If so, you would not want

Bar|Scan to check the Work Order table for that number, which is what it does

when the Work Order Message is enabled.

Or, when you are doing equipment, there are some types of larger pieces that are

actually separated into two or three pieces that have the same serial number. 

Bar|Scan does by default check the Serial # Message to see if any of the Assets

have the same serial number.  If some of the items that you are inventorying

legitimately have the same serial number, you may want to set the Serial #

Message to warning only.
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When you set the message to warning only, Bar|Scan would place a warning

message on your printed report under each transaction that has the same serial #,

but would not consider these items invalid.  Thus, when you look at the report,

each transaction that has the same serial number would be marked for you making

them easier to check for validity.  When you have checked the serial number

duplicates, and you know that they are correct, you could use the move feature to

move these items without printing them out again.

This feature can be very helpful when you validate and print your Transaction file,

and Bar|Scan does not consider the information in the file valid, and you know

that it is.  Be careful when using this feature, as Bar|Scan was designed to check

for errors, it is usually best to let it check for as many as possible.

When done making any changes that you wish to make, simply select the Ok

button, and you will see a dialog box like the one below.

When you select Yes, Bar|Scan saves your changes.  If you select the No button,

you will be returned to the Housekeeping drop down menu.
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Universal Validation Rules

This feature allows the user to create a list of custom validation rules for the Main

Tables in the Bar|Scan Desktop Application.  These Rules apply to specific fields. 

By default, all Bar|Scan tables have validation rules that fields must met such as

the Asset Table cannot have two Assets with the same Asset Number.

In this section, we discuss a more advanced ‘Universal Validation’, whereby

Bar|Scan administrators can establish a single set of custom validation rules per

company database for most tables, including the Asset and Transaction Tables. 

It verifies data when it is saved.  Values can also be assigned just they can be

assigned in the handheld devices with Advanced Handheld Validation.

There is an accompanying Messages Tables for Universal Validation.  This table

can be accessed, for example, to add the error messages to reports or exports for

any Assets or Transaction.

There are a few types of fields that are excluded from this feature.  They are:

T  All log fields

T  All Recid fields (these are the primary keys in the database and do not

contain any user data)

T  All Key fields (these are special fields in company configurations)

T  Work Order Line Number field

T  All Yes/No (logical) fields

There is no handheld component to this Universal Validation feature.  However,

there is a separate Advanced Handheld Validation feature for handhelds.   It is

documented Chapter 11 of this User Manual. 
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Beginning at the Bar|Scan Main Menu and with the selected Company Database

open, select File-> Company-> Housekeeping-> Miscellaneous-> Validation->

Universal Validation Rules.  A panel similar to the following will appear.

As you can see, there are two examples shown for the DEMOCO.  

The first Sample Universal Validation Rule performs the following task: If the

Current Room is ‘STORAGE’ and the Status Code is ‘IS’, this rule inserts the

current date into the Asset’s Disposal Date field.

The second Sample Universal Validation Rule performs the following task: In the

Catalog Table, the field Manufacturer Part # must be unique.  In other words, it
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cannot be duplicated.  However, the rule does allow the field Manufacturer Part

# to be blank.  

Note the three fields added to the Browse Panel.  This assists you in determining

the field that the rule applies to and the order in which that validations will apply

to the table. 

Click on the Edit Tab, you will be presented with the following panel:

Page 13-108 Bar|Scan



Chapter 13

Rule Name

Enter a descriptive name for this rule.  It can be any name of your choosing.  The

rule name can be up to 100 characters long so it is best to be as descriptive as

necessary.

Rule Field

Select the Table and Field that you wish to have your rule apply to.  In the

example above, we have selected the Catalog (CA Table Alias) Manufacturer Part

Number.

Rule Enabled

You can Enable or Disable your validation at any time by checking or unchecking

this item.

Locked (Prevents Edits)

If the rule is unlocked, anyone with privileges to modify a rule can do so. Locking

the rule prevents accidental edits.

Error Setting

You can select either ‘Error’ or ‘Warning’ as the Error Type.  An ‘Error’ will not

allow you to save your work.  A ‘Warning’ will display a message based on your

rule but you will be allowed to save your work.
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The Rule Information Tab

As shown below, you may enter a descriptive note describing the rule that was

created.  We recommend doing this as rules can become quite complex and this

can be very helpful.

Validation Order

You can enter in a number so that your validation rules are applied in the correct

order.  Most validations do not require a specific order but at times this can be

important, especially if you have more than one rule for a particular rule field. 

Each Table can have the same numbers entered.  For example, you can have order

1, 2 and 3 for the Asset Table and also order 1, 2 and 3 for the Catalog Table.  If

you leave this field blank, the next available number will be entered for you.  

When you require two or more rules to be performed in a specific order, enter the

order number here.   For any particular table, you can enter an order.  For

example, you may have validation rules labeled “1” and “2” for the Asset table

and also have rules labeled “1” and “2” for the Catalog table.
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The Activation Criteria Tab

As shown below, you may need to enter one or more criteria.  Criteria is not

always needed when creating a new validation.  If there is nothing entered into

this tab then the rule is always applied.  In other words, it is always active.

Note that the Activation Criteria is a logical AND for all three categories.  In short

the Activation Criteria = Operation Criteria AND User Criteria  AND Value

Criteria.  If any one of these is false, then the final result is also false.

So the Activation Criteria can only be true if:

Operation Criteria. At least one of ADD/CHANGE/DELETE or SAVE is

checked.

User Criteria. At least one of Master User or Standard User is checked.

Value Criteria. If nothing is entered (making it true) or if the specified criteria

filter is true.

In the following example, this validation is not always active but it is contingent

on the asset’s current room being ‘STORAGE’ and the asset’s Status being ‘IS’

(In Storage).  These are the criteria to begin the Universal Validation process.
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As you can see from the panel above, creating an Activation Criteria is similar to

creating a filter on report.  For more detail on this process, visit Chapter 10 –

Reports.

On the left side of the panel is the Operation Criteria.  You can choose none, one

or more.  For example, if you choose ‘Add’ then the rule applies only when

adding a new item (using Add or Add Template).

If you choose ‘Save’, then the rule also applies when performing a Bar|Scan

upgrade to a new version or when performing a Table Integrity.

You can also select whether the rule is activated for a Master User (Bar|Scan

Administrator), a Standard User (not an Administrator) or both.
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The Validation Tab

As shown below, you will need to enter four items in the validation Tab as

discussed in the following section. 

The criteria conditions are shown below.  These are similar to the selections used

in Advanced Validation for the handheld.  The value in the Rule Field must satisfy

the criteria specified in the contents of this tab page.  Starting at the top you will

select the Validation Rule.

Do Validation – this takes the activation criteria from the previous tab and then

uses the additional instructions on this tab to add more detail to the rule. 

Always Pass – this takes the activation criteria from the previous tab and always

passes validation if true.  No other criteria is necessary. 

Always Fail – this takes the activation criteria from the previous tab and always

fails validation if true.  No other criteria is necessary.  
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Can have any value – the value in the Rule Field can have any information

entered, including blank.

Must have 1 or more characters – the value in the Rule Field must have

information entered.  A blank is not acceptable.

Must fill entire field – the value in the Rule Field must have information entered

that matches its field length.  For example, a Catalog Category field must have

two characters.

Must be blank – the value in the Rule Field must be blank. For non-character

fields it must be an empty field, e.g. an empty date, a zero-value number, False/No

for a logical Boolean, etc.

Must pass table lookup test – the value in the Rule Field must match/not match

at least one value in a field in the same table or another table.  For example, a

UDF (User Defined Field) titled Department must have the same information

entered as the Organization Table’s Department field.   This type of validation is

different (not related) to the Pop-up fields Table (accessed in the Housekeeping->

Miscellaneous section of Bar|Scan).   When you select ‘Must pass table lookup

test’ the panel changes and you can enter a comparison operator (IN/NOT IN) and

the field that will be checked as shown in the section below.  
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There are only two choices for the Operator, “IN” the Lookup Field or “NOT” in

the Lookup Field.  After you select one of these, you must then select the Lookup

Field that contains the list of value that the value in the Rules Field will be

compared to.

Must pass value test – the value in the Rule Field must satisfy the comparison

criteria that you enter. When you select this option a set of fields appears where

you can enter the operator and the Lookup Value(s). The Operators are the same

as those used and documented in other areas of Bar|Scan including Sets and

Reporting.

These operators will change depending on the type pf Rule Field.  For example,

‘Contains’ and ‘Does Not Contain’ will not be seen for date fields but you will see

these for Character fields.
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Blanks-Special Handling

The panel below displays the choices available when treating blanks as a special

case.

This is independent of the Criteria condition above it and there are three choices

as described below.

Always allow blank values even if not allowed elsewhere – This selection means

that the value in the Rule Field can have a blank value, no matter what else any

of the other validation tests imply. This case allows ignoring any blanks

previously entered.  For example, suppose that you want to start entering the

Manufacturer Part # in the Catalog table, but all of the existing catalogs have a

blank value in the field. If this case is selected all of the Manufacturer Part #’s

may start all blank, but gradually be entered. Fewer and fewer blanks will exist.

However, if during this process a user enters a duplicate non-blank, it will not be

allowed.

Never allow blank values even if allowed elsewhere – Once all records have a

value entered into the Rule Field, this rule can be used to force users to always

enter a value.  For example, if a Personnel UDF, such as ‘Position’ is created then

the user must always fill it in.
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Ignore special handing of blanks – this is the default option.  It means that there

is no special handling of blanks.  Blanks are treated just like any another values. 

For example, if the user has specified that all values are unique then only one

blank value will be allowed.  Many Bar|Scan tables do something similar, where

blanks are allowed, but only one, e.g. the Status Table.

Finally, at the bottom of the tab, enter the validation message that you would like

Bar|Scan to display when the edit does not pass the Universal Validation rule.

Similar to the built-in validation rules, any violation of the validation displays a

dialog box prior to a save.  This message may also be printed on reports or part of

your export.
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The Actions Tab

On this tab, there are multiple items to consider.  On the left side you have the

Field, Button and Tab states and on the right side, you have the Assignment

Action.

Field, Button and Tab states - for the selected field, there are several choices

including disabling, hiding the field, or changing the color of the field. 
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For each field selected, the functions just discussed will affect standard fields as

well as User Defined Fields (UDFs) and those states will apply on both the

Browse Screen as well as the Edit and UDF Screens.  For example, marking the

field as hidden will remove the field from any and all of the screens.

Color is useful in that the color will apply to the field only when the field passes

the validation criteria. 

Subtabs and Buttons can be either enabled or disabled.  To disable any subtab,

you select a field in that tab as the Rule Field and then on the subtab item select

‘Disable’.  For example, to disable the subtab ‘Lease’ on the Asset Panel, select

any field on the subtab, e.g. Lease Number, Duration, Ending, etc.

‘Buttons’ are present on a few panels.  For example, on the Asset Panel, Edit Tab,

there are three buttons on the Asset Location History section.  These are ‘Add

Blank’, ‘Add Template’ and ‘Delete’.  As an example , these can be hidden for

non-Master Users.  You will need to select ‘Disable’ (or ‘Hidden’) and then check

mark ‘Add’ and ‘Delete’.
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On the right side of this tab, there are two choices, keep the original value or

assign a new value to it (change the field).  An example of each is shown below.

As you can see in the example above, no change is made to the Catalog’s

Manufacture Part Number field.  This is because we are only checking to see that

the field is unique, not making any changes.
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In the example below, we are replacing the Disposal Date with the computer’s

date when you save the item.

The TODAY and NOW functions are described in more detail in Chapter 11 –

Bar|Scan Mobile.

When this rule wants to replace the <Rule Field> with a new value, ask the user

of this is OK – Normally you will not want to check this item.  When this is

checked it means that in normal use, a dialog box will be presented to the user

before a change is saved.  For example, when saving a change to an asset on the

Asset Screen.

The Dialog will indicate, for example, the value that will be assigned by the

Universal Dialog rule.  Normally you will want to select ‘Yes’ so that the

validation rule takes effect.  If ‘No’ is selected, then the change will not pass the

internal test (which is the same as the Validation failing).
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Care should be exercised with checking this item this if there are any Bar|Scan

Scripts (bini processes) that automatically try to change the data (such as an

import) since validation will be run during the import and a dialog prompt may

appear.  For more information on Scripts, see the Bar|Scan User Manual Chapter

14 ‘Scripting Feature’.

Universal Validation Messages in the Transaction Table 

The regular ‘Set Transaction Validation Messages’ will be applied to the

Transaction Table when the transactions are validated.  Universal Validation

Messages will now be displayed in addition to these.  They are not numbered,

rather they will be indicated with a ‘##’ in the message number.  Below is an

example of how they are displayed on the Browse Tab.  
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Printing or Exporting Universal Validation Messages in Asset and Transaction

Reports 

For printing or exporting of Universal Validation on your Asset or Transaction

reports, you must select the fields from the Universal Validate Rule Message

Table as shown below.  The field that you should select is ‘Message’.  You may

also select additional fields for informational use.
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Run a Universal Validation on the Asset Table

For all tables, including the Asset Table, prior to printing Universal Validation

Messages, you will need to run the table’s ‘Panel’ menu option

‘Panel/Range/Problem Items/From Top. You should perform this step each time

you wish to print or export a report containing the latest validation information

because the information can change often.

To perform this step, open the desired table, such as the Asset Table.  From the

‘Panel’ menu select ‘Range…’, then submenu ‘Problem Items’ then submenu

‘From the Top’ as show in the image below.

This process can take some time on larger databases so leave sufficient time for

processing  If you begin this process and you are out of time, press ESCAPE to

end the process.
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POP-UPs

On any Table in Bar|Scan, pop-ups can have custom lookup values.  Pop-up

Values are company wide for all users accessing that company.

Access to this area of work is controlled by User security fields for the Pop-ups

in the User Table, Page 2.  For users that will be managing the list values, make

sure that all checkmarks are set to allow full editing of the Pop-up lists.

To add pop-up values for any field, add a new Pop-up entry, set the desired field,

then add values in the Pop-up Selections list, then Save.

Pop-ups are available to download into your Mobile Device.  If you choose to do

so, you must use filter in the Handheld Configuration.  To recap, here is a detailed

explanation for why filters are needed when configuring handheld fields to use

pop-ups.

The list of all Pop-up values is kept in the Pop-Up (PUD) table. Since ALL values

for ALL fields are contained in this table, we must set filters when trying to get

a specific list of pop-up values for a certain field. Every pop-up list is uniquely

specified by two values, its work area Alias (such as ‘AS’ for the Asset table) and

it raw Field name (such as OW_NAME for the Asset Name). You may recall that

even when making reports, first you must select the work area alias then the field

within it.

Chapter 11 - Bar|Scan Mobile and our website Tips page provides more

information on this subject.
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Linked Field Tab

Linked fields are very useful when there are more than two separate fields that use

the same list of popup values. Rather than duplicating all of the values again in the

second or third field you can ‘link’ the other fields to the values listed in the first

field.

For example, in the Asset table there are three (3) Remark fields called ‘Remark

#1’, ‘Remark #2’ and ‘Remark #3’. First enter the list of allowed remarks in the

Popup screen for ‘Remark #1’.
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List of Values Tab

Below is a screen showing a custom Pop-up selection for the Priority Field in the

Work Order Master table created in the List of Values tab.
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List pending Manual Synch Updates for the Current Company

During the Sync process, Bar|Scan imports and update as much information from

your sync partner as possible without manual involvement.

There may be times when the synch decision is too complex, so Bar|Scan asks you

for manual involvement.  This happens when Bar|Scan detects that there have

been multiple updates to the same item, both by you and your Sync partner. For

example, you might change the Catalog Number of an asset after your last Sync

operation. Your Sync partner may do the same, but changes it to a different

Catalog.  Which one should be kept?  Only you can decide.  How does Bar|Scan

present you with the data so that you can make that decision?  Bar|Scan displays

the following prompt when you open the Table for which there are pending

updates:

Normally, you should select ‘Load All’.  This will load all of the pending edits

that your Sync partner has performed.  Then you must make decisions on which

of your Sync partner’s edits to keep and which to discard.

You must keep up to date on these edits since the more time that passes without

a Sync, the harder it becomes to make the decisions needed.  When you select

‘Load All’, the edits from your Sync partner will be set and all items with changes

will become part of a range.  Start at the top of the browse list and  press ALT+R

to move to the next range group. Examine the data item by item,  field by field

using the ‘right click’ pop-up menu item ‘Field Information’.  If you do not want
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to keep your Sync partner’s edit on a particular field then use the ‘Restore Original

Value’ option to undo the change and move to the next field or item.  See the

Bar|Scan User Manual for more details.

After selecting ‘Load All’ and after you are done doing the reconciliation then

Save the changes.  If all of the data is reconciled then the changes will be saved

and the pending Sync updates will automatically be removed.  The prompt will

not appear the next time you access that screen until there are more updates to

reconcile.

The ‘New Only’ option loads only those edits from your Sync partner marked as

being done after your own most recent edits.  It ignores edits from your Sync

partner that are older than your own edits.  It does this by comparing the Log

Universal Date/Time (LOGUDT) field in your record with the same field in your

Sync partners record.  If yours is older, then Bar|Scan will load the ‘New’ values

from your Sync partner.  This has value when you need to quickly get the most

recent changes from your Sync partner and have confidence in your own changes

are generally the most recent and don’t have time to do the reconciliation.  You

still MUST do the ‘Load All’ option at a later time, but if you are keeping up to

date with the Sync process the ‘New Only’ option can be valuable, as most times

it only requires selecting the ‘Save’ button after loading the new items.  Also,

when selecting the ‘New Only’ option Bar|Scan does not automatically remove the

Sync  files, they will stay (displaying the above prompt) until you either do a

‘Load All’ and a successful save or manually remove them.  See the Bar|Scan

User Manual for information on how and when you might do this.

In summary, you should normally select the ‘Load All’ option to load and then

accept or reject your Sync partners edits.  Select the ‘New Only’ option if you are

have confidence in your current data, since you still must eventually do a ‘Load

All’.
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BATCH  OPERATIONS

You can use the Batch Operations feature under Housekeeping to instruct

Bar|Scan to process some Operations based on the Computer’s clock or execute

a series of commands sequentially like a script.

After you have created the Batch Operations, you will need to keep Bar|Scan

running in Windows in order to have it execute any timed task.  Timed tasks are

those operations that you have set to start based on a future time.

We recommend that you create a separate User ID and Password and using this

ID, start Bar|Scan and minimize the program.  If you are on a network, it also may

be best to run this session of Bar|Scan on your server rather than a workstation.

Timed tasks are executed according to the local Date and Time Properties settings

of the computer that is running Bar|Scan.  So if the server is located in another

time zone, you will need to keep this in mind.
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When you start Batch Operations, you are presented with the following panel.
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In the previous example, two Batch Operations have been added to Bar|Scan. 

When you want to see the detailed information that has been entered into the

Batch Operations table, you will need to select the Edit tab.  When you do, you

will be shown a screen similar to the one below.

Note that the Edit Panel has three tabs on it, Setup, Operations and Log.

Each of these tabs contains information on the Batch Operation.  The first tab, the

Setup tab, is open as a default.
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Operations Tab

There are two areas that can be initialized with Batch Operations, Work Orders

and Company Synchronization as shown below on the Operation Tab.

Since Batch Operations is an advanced function, it is best to contact your

Bar|Scan Administrator before modifying or creating any new Batch Operations.

As an example, a Batch Work Order could be used to Find Problems if Work

Orders are imported from another system.
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Log Tab

It is important that Bar|Scan provides you with feedback on any Batch Operation

to confirm that the operation was successful.

As you can see from the screen above, you can customize the Operation Log to

present all Batch information or limit the information to either the last batch log

and/or Problems.

We recommend that you record all Batch information until you are satisfied that

the Batch instruction is working as desired.
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COMPARE COMPANY STRUCTURES

You can use the Compare Company Structures feature under Housekeeping to

compare the properties of any Bar|Scan company to another.

Only two Companies can be compared at one time.  When you select Compare

Company Structures, a panel similar to the following will appear.

There are two Tabs.  The first is to compare Tables.  Companies may have

different tables.  For example, if you are Logging Assets (Activity Logging) in the

Democo but not in another Company, the Log Asset Table would not exist in

Company #2.
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The second Tab is the Fields Tab.  Use this tab to compare fields within each of

the Tables. 

In the above example, we have compared The Democo (Company #1) to a Sample

Company (Company #2).

Note that there are differences in the UDFs (User Defined Fields).  Why is this

important?  If Assets were to be exported from the first company to the second

company, important UDF information would be lost unless we make the two

Company databases identical.  There are several other comparisons we may be

interested in such as differences in the lengths of standard Bar|Scan fields.
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LOG FILE MAINTENANCE

Since Activity Logging can record and keep a very comprehensive audit trail, the

Log Tables can become very large over time.  At some point, usually after several

years, they will require Archiving.

The Archive Process is called Log File Maintenance.  Basically, a portion of the

Activity Log File is copied to an Archive File based on an Archive Date that you

select.  It is not necessary to perform a Log File Maintenance until the Percent

Slide approaches 80% full.  This Slide is displayed in both graphical and

numerical form next to the Log File Name.

For more information on Activity Logging, refer to Chapter 14 - Import and

Export.
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INTERACTIVE MODE

This is a technical support feature, and is therefore password protected. 

Normally, you will never have to access this feature.  If there would ever be a

need for you to use this feature, your Bar|Scan dealer will be able to give you the

password, and explain it’s uses and features.
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RESTORE DELETIONS

If you are a Master User (administrator) then Bar|Scan will permit you to restore

any deletions from any table prior to a Pack operation.  Instructions are on the

panel as shown in the example below:
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EDIT TEXT FILE

The Edit Text File feature, under Housekeeping, is much like a notepad, only

inside Bar|Scan.  You may use it to view any text file with a .txt extension, such

as a text file that you have exported from Bar|Scan.

If you have selected Edit Text File from the Housekeeping drop down a menu,

you will be shown a Look up Window similar to the one below. 

From this window, you may select the folder and/or file that you wish to view,

and edit.
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INTRODUCTION

The Import and Export features of Bar|Scan can provide you with three important
features.

% The ability to record and export asset information to other computer
applications such as a GIS Tool or  Fixed Asset Depreciation System.  Or if
you have a multiple company system, you can export (or data transfer)
information to another company, i.e., catalogs, locations, organizations, and
reports.

% The ability to import information into Bar|Scan from another application
database either as  a method to initially populate the assets, or as part of an
ongoing process of obtaining new information and updating Bar|Scan.

% The ability to set up and use the Activity Log for every table which records
events as they occur so that you have an Audit Trail.  These events can then
serve as an audit trail and printed, or, if desired can be exported.   The Activity
Log Export Files created for your use can be in a number of different formats
including ASCII comma delimited, or Microsoft Excel. 

In addition to the Import and Export feature, you may also export information
using the Bar|Scan Report Feature.  The process is discussed in the second section
of this Chapter.  For more information on the Bar|Scan Report Feature, see
Chapter 10 - Report Table.

There is a set of videos on our website that can provide you with additional in
operating Bar|Scan.  These are titled Quickstart Overview Videos and can be
found on this page: https://www.barscan.com/support-videos

Please consider viewing or downloading these as part of your learning experience.

The Chapter concludes with a section which documents a complete File Structure
list for all tables in Bar|Scan.  This will assist you in interfacing Bar|Scan with
other computer applications.
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EXPORTING FROM BAR|SCAN

When you want to select Export from the Main Menu, select File  ...<, then Export 
 as shown on the following example.  When you select Export from the File drop
down menu, you will be shown three choices, as illustrated below.

The first item, Data Transfer File, will appear as “greyed out” until you have
selected items to export.  The second choice listed under Export, is Formatted
Data.  The third option says To Company, and will also appear as “greyed out”
until you have selected an item, or range of items, to export.

The “Data Transfer File” option is used to export an item from one company, as
a file, so that it may be imported to another company, which is not on the same
network or system.  This is also useful as a way to send information to your
Bar|Scan Dealer to assist in technical support.  for By default, when exporting,
Bar|Scan only exports a copy of the items, therefore the original items remain in
tact in the first company.  This default option can be changed by you on your
Company Settings Screen.
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The “Formatted Data” option actually creates the specifications for the export file. 
This is used to create a structure which defines what the file you wish to export
should look like.  You can have one or more export files, each containing different
information in different formats.

The “To Company” option actually creates an export of information that is to be
placed into another Bar|Scan Company.  For instance, you may use this feature to
create an exact copy (some or all) of your Locations, Catalogs, Assets,
Transactions, Organizations, or any information that exists in your first Company
and place it into the second Company. 
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EXPORTING TO ANOTHER BAR|SCAN COMPANY

Bar|Scan makes it easy to export items to another Bar|Scan company that is on the
same server.  You can export Assets, Catalogs, Locations, Organizations, Reports,
Transactions, as well as miscellaneous tables such as Condition and Status.

In order to complete this process, first open both the company that you wish to
export from and the company or companies that you wish to export the items to. 
Select the Company you are going to export from.  Go to the items that you wish
to export, i.e., if you wish to export a report, open the type of report, and highlight
the report you wish to export on the Browse panel using the Range feature.

Note:  All of the different items listed, Assets, Catalogs, Locations, etc, can be
exported in a similar manner.  You can either export one item or place a number
of items into a range.

Then, go to the Main Menu, and select File ...<, Export ...<, then To Company, as
shown below.

Page 14-4 Bar|Scan



Chapter 14

When you have selected the To Company option, you will see a window similar
to the one below.

The items in the above box will change according to which and how many
companies you have open.  Select the Company (or Companies) you wish to
export the report to, and click the Ok button.  You will be shown the following
message.
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EXPORTING USING THE DATA TRANSFER FILE

If you need to export items to a computer that is not networked to the first
computer or you cannot open it in your installation of Bar|Scan, you will need to
use the Export, Data Transfer File feature.

In order to use this feature, you would go to the company you want to export
information from.  You would highlight, with the Range feature, the information 
that you want to export.  Then, you would go to the Main Menu, and select File
. . .<, then Export . . .<, Data Transfer File as shown below.

When you select the Data Transfer File, you will see a message asking if you
really want to export the items that you have highlighted.  For our example, we
have highlighted 16 Transactions, as shown below.  You are not limited to
Transactions for your export.
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If you select the Yes, that you do want to export the items shown, Bar|Scan will
begin the process, and show you a window where you can name the export file.

Bar|Scan appends the current date and time to the filename.  If desired, you can
change the file name shown in the above window to be a name that you will
remember easily.  If you do change the name and do not include the date and time,
you may get the message if you export the file more than once, as shown below.

This message lets you know that a file with the same name already exists, and
asks if you want the existing file to be overwritten.  When you select the No
button, you will see another dialog box like the one below.
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This message appears to let you know that the Export was not completed.  If you
had intended to export these Transactions to a file, please choose a different
filename, and attempt the export again.

Always selecting a new file name will alleviate this problem.

If you want to give your file a new name, and perhaps place the file in a different
path, you can push the folder button that is next to the file name field, and browse
to the new location.  

When you press on the file folder, you will be shown a window similar to the
following.
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You may select a different destination on this window, and then click the Ok
button.  The new path will appear in the file name field.

In some cases such as Reports, a single Data Transfer requires 2 files that contain
different parts of the data.  The file names are the same and the file extensions are
.dbf and .fpt.  When you import a Data Transfer, Bar|Scan automatically imports
both.  If both files are not available, Bar|Scan will indicate this to you.

To finish the process, you would need to import the file on the other computer. 
Following our example from the Export section, you would now have to go to the
Main Menu, and open the Company that you want the Transactions to be imported
to.

Then, go to the Main Menu, and select File . . .<, Import . . .<, then Data Transfer
File as shown below.
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If you have any other tables open (with the exception of the Main Menu), you will
be shown a dialog box like the one below.

Simply close the open table, and then select File . . .<, Import  . . .<, then Data
Transfer File again.  You will see a dialog box like the one below.

If you are unsure of the name of the file, you may click on the file folder button
to the left of the empty field.
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You will be shown a window like the one below, where you will be able to select
the path and filename of the file you wish to import.

Choose the correct filename and click the OK button, and the filename will be
placed in the previous dialog box as shown below.
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If you select the Ok button, you will see a dialog box similar to the one below.

Note: The message in the above dialog box will change to reflect the filename that
you have selected.

If you choose No, the dialog box will simply disappear and Bar|Scan will do
nothing.  If, however, you select the Yes button, you will see another dialog box
similar to the one below.
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This dialog box simply wants to know if it should use the Company Code field to
determine which Company the Transaction should go into.  If you are using the
Company Code on your Transactions, you may select to only import the
Transactions that belong to This Company.  

You have just been through the entire process of selecting, exporting, and
importing Transactions between companies on separate computers.  This process
is the same for the export and import of Locations, Organizations, Assets,
Catalogs, and Reports.

Note: in some, but not all, circumstances the Bar|Scan Data Transfer Table may
consist of more than one file.  The prefix file name will always be the same,
however, the suffix may end in a .FPT as well as the usual .DBF.  

If Bar|Scan attempts to import only the .DBF file, and the .FPT file is not present
in the same directory, you will receive an error message.  You cannot do the
import if the second file is missing.

If you need to send a Bar|Scan Data Transfer Table via email or some other
means, remember to see if the Bar|Scan Data Transfer Table may consist of two
files and attach both files to your email.

Typically the Data Transfer File will look like this:
name-that-you-typed.dbf

and 
name-that-you-typed.fpt
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EXPORTING BY USING THE
BAR|SCAN REPORT FEATURE

The Bar|Scan Report feature provides you with the ability to create files
containing Bar|Scan data which can be transferred and used by different
applications and computer systems.

The file can be created to contain any of the information items (fields) you desire. 
Then, you can direct the report output to a file (rather than to a printer) using one
of several industry standard formats.

Creating a Report

A file is created by defining a report using the Bar|Scan Report table, then directing
the output to a file (rather than the printer), and selecting one of the file formats.

As with any report you create using Bar|Scan, you can select any of the different
fields, identify sorting sequence, and limit the number of records using the "filter"
feature.

The Destination feature may include a particular file name, or you may use the
Prompt For feature to enter a file name when the report is printed.

There are several file formats available to choose from.  These are discussed in
detail in Chapter - 10 Report Table.
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EXPORTING TO OTHER SOFTWARE

There are two types of exporting that can be accomplished by Bar|Scan.  The first
is an export of one or part of the tables, i.e., Assets, Catalogs, Locations.  The
second is one of the Activity Log tables.  Normally, you would export directly
from one of the tables in Bar|Scan, however, some external systems, such as an
accounting system, may require only specific changes to be imported.  In this case,
you would export an Activity Log table.

If you are using a Network version of Bar|Scan, the EXPORT feature requires
exclusive use of the Bar|Scan tables during the actual time of the export.

While the Bar|Scan Activity Log keeps track of events as they occur, it does not
create an Export file until you request it to do so by selecting the EXPORT feature.

Important:  The length of time your computer will take to EXPORT the table or
the Activity Log is dependent on the amount of Activities that have to be
processed.  Processing may take several minutes or longer for a large file of several
thousand Activities.  Do not interrupt the process by turning off the computer,
rather start the Activity Log Export when you will not be needing your computer
for some time.

Upon verification of a completed Export format file, the Activity Log is not
emptied.
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To export a table or Activity Log, you would first need to create an export format
file.  Go to the Main Menu, then select File . . .<, Export  . . .<, Formatted Data,
and when done, you will see a browse panel similar to the one below.

When you first open this Browse tab, you will not have any Exports or Imports
listed, and you will have to start your process by Adding a Blank.  Once you have
added at least one Export or Import, you may select one of the them, select it and
then select the Add Template button from the tool bar.

Whether you are adding from a blank or from a template, you can now select the
Edit tab and make changes to the panel to create a new Export.  
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Then, select the Edit tab, and you will see a panel similar to the one below.

The Files tab is automatically selected when the Edit tab is shown.

Notice in the close up of the tool bar shown below, there are two new buttons on
the far right.  

The second to last button is used to start the actual Import/Export.  When the
cursor is placed over this button, it will say, Import/Export using ranged items.  If
none are ranged, then use all items in the current SET command.

The last button is used to View, Edit and Print the Import/Export Log file, showing
what did or did not happen during the Import/Export.
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You may delete an Export of an Activity Log so that you do not inadvertently
export the same information twice.   For example, you export and clear the Activity
Log at the end of every month.  The Bar|Scan Activity Log is used to record events
that occur to your assets.   Recording events was done by using the LOG and the
FIELDS features.  The items exported are only those items that had activity during
the month, based on your Log and Field criteria.  

The Format File feature actually creates the specifications for the export file.  This
is used to explain to Bar|Scan what the file you wish to export should look like. 
You can have one or more export file formats, each with different information in
a different format.
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The Files Tab

There are four tabs that are accessible while in the Export mode on this Edit panel. 
The tabs which appear as greyed out are used for Import Format files.  The first tab
available in creating an Export Format is the Files tab, looks similar to the one
below.

There are seven items on this screen, the File Format, the Import Method, File
Name (including the path), an optional Procedure, Group Name, Group Order, and
a checkbox that will allow use of this Import/Export Operation.

Additionally, for an ODBC import only, there is an optional area to create a
specific SQL query to assist in data extraction.   

Let us begin by choosing a file format.  You may click on the down arrow next to
the File Format field, to see a drop down menu to select from.
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Available File Formats

DELIMITED - ASCII comma, quote delimited is the most popular personal
computer export and import format.  The information is converted to ASCII format
which means that it can be read by even a word processor.  The items are separated
by commas.  Alpha numeric items (which can contain both letters and numbers)
are also enclosed with quotation marks.  Choose from Delimited with Blank,
Delimited, or Delimited with Tab.

CSV - The (Comma Separated Value ) file format is a simple format that is
supported by many Microsoft Programs such as Excel.  It is also support by many
database systems and programming languages.  It is also a delimited data format
that has fields separated by the comma character and records separated by
newlines. Fields that contain a comma, newline, or double quote character, or
which start or end with whitespace that is to be preserved, must be enclosed in
double quotes. If a line contains a single entry which is the empty string, it must
be enclosed in double quotes. If a field's value contains a double quote character
it is escaped by placing another double quote character next to it. The CSV file
format does not require a specific character encoding, byte order, or line terminator
format.

DIF - Use DIF to import a .DIF (Data Interchange Format) file.  This format was
used by VisiCalc and is often still used by programs running on AS/400 and other
midrange computers.  Vectors (columns) and tuples (rows) are created from
records and fields in the FoxPro .DBF.  The export file name is assigned a .DIF
extension if you do not include an extension in the filename.

FOXPLUS/DBASE - Foxplus is format compatible with FoxBASE+ and dBase
III.  If you are using Clipper or dBase IV, import your data from dBase III after the
Bar|Scan export is complete.

FOXPRO - FoxPro is compatible with FoxPro version 2.x for DOS, and FoxPro
version 3.0/5.0 for Microsoft Windows.

WK1 - Use WK1 to export to a Lotus 1-2-3 revision 2.x spreadsheet.  Each
column in the spreadsheet refers to a field; each row in the spreadsheet refers to a
record.
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XLS - Use XLS to export a Microsoft Excel version 2 spreadsheet.    Each column
in the spreadsheet refers to a field; each row in the spreadsheet refers to a record. 
A .XLS extension is assigned if you do not include a file extension.

XL5 - Use XLS to export a Microsoft Excel version 5 spreadsheet.    Each column
in the spreadsheet refers to a field; each row in the spreadsheet refers to a record. 

XL8 - Use XL8 to export a Microsoft Excel 97 spreadsheet.    Each column in the
spreadsheet refers to a field; each row in the spreadsheet refers to a record.  

SDF - System Data Format - txt -  is an industry standard for file formats and
could be used when sending the report to a file which will be transferred to a
different computer.  

SDF puts the different fields into a disk file one field after another; the lengths of
the individual fields determine the position of the field on each line in the file. 
Each line (record) in the file can contain number fields.  However, the total number
of characters in one line may not exceed 253.  One line in the file (a record) can
contain only the information associated with a single Asset number (with one
exception, see the Attributes Fields section below).

The Bar|Scan system contains many fields, all of which cannot be included in a
single SDF report file.  You may select fields which, when all of the characters for
each field are totaled, contain less than 253 characters.

The number of characters for each field is shown in the table below.  Note that the
field lengths may be changed as new features are added to Bar|Scan. 
Consequently, we recommend you allow some flexibility regarding field length in
programs that will use the information.

Some fields will contain fewer characters than are allocated to the field.  These
fields will be filled with trailing space characters (ASCII character number 32). 
The first character in a field will be left justified.
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SIF - This is Standard Interchange Format.  It’s derivative, CAPSIF, is sometimes
used in the furniture sales industry.  Each line of the CAPSIF begins with a two-
character op-code, followed by an equal sign (=). followed by the data associated
with the code.  In all cases with Bar|Scan the data associated with these codes is
less than 60 characters long.  Only one type of information is specified for each
line in the CAPSIF file.

The following is a detailed description of each of the CAPSIF codes used by
Bar|Scan.  The first five are used to define the specification file as a whole.

SF= Specification File name (drive:\path\filename.ext) as saved in Bar|Scan
ST= Specification Title, saved in Bar|Scan as the optional destination description
L1= User Label 1, saved in Bar|Scan as the Report Title # 1 line
L2= User Label 2, saved in Bar|Scan as the Report Title # 2 line
L3= User Label 3, saved in Bar|Scan as the Report Title # 3 line
PN= Product Number, saved in Bar|Scan as the Manufacturers Part #
PD= Product Description, saved in Bar|Scan as the Catalog Type and Description
MC= Manufacturer Code, saved in Bar|Scan as the Manufacturer Name
QT= Quantity, saved in Bar|Scan as the Quantity
TG= Tag #, saved in Bar|Scan as Manufacturers Tag #
GC= Catalog Number, saved in Bar|Scan as Catalog      
ON= Attribute Numbers 1 through 7, saved in Bar|Scan as the Attribute Names
OD= Attributes 1 through 7, saved in Bar|Scan as the Attributes

For a more complete discussion on SIF format, refer to Chapter 10 - Reports.

Choose one of the available file formats by a clicking on it with your mouse, or
pressing the associated hot key, or use TAB to move to the button and press
ENTER.

If you are not sure which format is required for your application, choose ASCII
Comma/quote delimited.
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The Import Method

This feature is only used during an Import Format session and is discussed later.

The File Name

Bar|Scan will create and write the export file to the file name that you enter here.
You may enter any valid Windows file name preceded by an optional path.

If no path is specified, the file will be created in your company subdirectory.  

The file extension is optional.  Bar|Scan will assign the extension based on the file
format that you select.

Any existing file will be overwritten, so make sure it is not needed.

Procedure

This feature is optional, but using it, you can customize your export by calling a
Procedure at the time of the export.  A Procedure is a custom program written be
a computer programmer to perform a special task.  The program must be a FoxPro
program.  If a Procedure is entered, Bar|Scan will use it.

Most likely, you will not need a Procedure.  Almost all exports can be completed
without this process.

If you require a Procedure, see your Bar|Scan Dealer for more information

Group Name

Group Name is optional, but allows you to group Imports, range them, and then do
one import after the other.
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Group Order

Group Order is optional, but allows you to decide which import needs to be
completed first, and the order of the rest of the imports. I.e., if you are importing
both Catalogs, Assets, Organizations, Locations, you could use this feature to make
the import proceed in logical order importing first the Organizations, then
Locations, then Catalogs, and finally Assets. 

SQL Query

This area is for an ODBC import only and not used for exporting. 
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The External File Structure Tab

You complete this screen to tell Bar|Scan the structure of the file that you will be
exporting.  A sample External File Structure tab is shown below.

There are two types of information that a file contains.  The first is records. 
Records are the number of items in the file.  For example a file can contain 100
records corresponding to 100 assets.  Records are also the equivalent of rows in a
spreadsheet.  The second type of information in a file are the fields.  For example,
an asset number, purchase order, and purchase price, are three fields of an asset. 
Fields are the  equivalent of columns in a spreadsheet.

On this display screen, you will tell Bar|Scan what fields you wish to have in the
file that you wish to export.
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Before we proceed with the mechanics of describing the structure of the export file,
we must distinguish between a structured file and a non-structured file.

% A native structured file is an Excel, or MS SQL.  Structured files can have their
structure imported into Bar|Scan.  This kind of import requires the support of
software packages, drivers and providers, depending upon the nature of the
data being imported. Additionally, since Bar|Scan is a 32 bit program often
existing in a 64 bit context, being aware of how this will impact the import of
your specific data is a requirement.

% A native or non-structured file is all other formats including SDF, delimited
and CSV.  Non-structured files are easy to create, but they have to be entered
one field at a time.  Their structure cannot be imported.

Now going back to the display screen, the screen is separated into two areas.  To
the left is the list of fields and to the right are the actions.  The mouse or TAB key
will move from selection to selection.

Double click an item with your mouse, or if it is selected, press ENTER to
complete the selection process.

The left side of the display screen is either empty or displays one or more
previously created fields.  All Bar|Scan fields can be entered for export.  You may
use the arrow or TAB key to move from field to field.

You may also change the order of the fields by dragging them up or down.  This
is done by placing it on the up-down arrow symbol at the left of the format file
name and moving the mouse up or down while depressing the left mouse button.
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Adding a New Field

Normally you will select “Add Bar|Scan Fields,” and you will be shown a look up
window like the one below.

The Look up Window will list the fields in the appropriate table in Bar|Scan. 
Choose the Bar|Scan field in which you wish to export.  If the table listed at the top
of this window does not contain the information that you wish to export, you may
use the down arrow next to the table name, and select the fields from a different
table.

You can export from any of Bar|Scan’s tables.  Each Bar|Scan table and it’s fields,
field names, and default field sizes are listed at the end of this Chapter.

Or, to add a new field, you may select the Add Blank button, or the Add Template
button.
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If you select blank, you will see a line appear on the left-hand side, Blank0000,
Blank0000, C, 10, 0 as shown below.

You will then need to change the line to say what you want it to. 

Normally, you will select a blank field if your external file contains one or more
fields that you do not wish to export from Bar|Scan.  For example, if the first field
of the export file should be blank.

Bar|Scan will give it a default Field Name, Type, and Length.  These can be
adjusted by you.  For example, if the field width is 8, you can change the length 
to 8 also instead of the Bar|Scan default of 10.

 
When you can select a line, and then select Add Template, a duplicate of the line
you selected will appear, and you may change it to say what you want it to.
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Changing an Existing Field

To Change an existing field, select the Change button.  When you select Change,
you will see a window like the one below.

You can change any field, as required.  For example, if you wish to have your
export file’s serial number length to be 20, you will change the length on this
screen from 25 to 20 (Bar|Scan’s serial number field is 25 and will display as the
default length).

Note on Bar|Scan’s Time fields:  Bar|Scan exports all time fields in the following
character string format HH:MM:SS.  Since it is a character string, it cannot be
changed to a different format.  If you are exporting th a Delimited format, quote
marks will be added.

Import and Export Page 14-29



Import and Export

Importing a File Structure

Importing a file structure avoids the task of having to manually add each field to
the display screen.  Instead, you will let Bar|Scan complete the screen for you
based on a file structure you would like to match.  The file you wish to match must
be an Excel,  FoxPro, or dBase compatible file.  These normally have the file
extension .DBF.

To Import a File Structure to match, select the Import Structure button, and you
will see a Look up Window like the one below.

Select the folder which contains the file structure that you wish to use, and
Bar|Scan will automatically import the list of the file structure for you.

You will need to tell Bar|Scan where the file that contains the structure is on your
computer’s hard drive or network.
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You might also need to adjust the File Type to “All Files (*.*) to locate the file you
wish to import, otherwise only those files with a .DBF extension are displayed.

  
To complete your selection, click on the highlighted file name to select it and then
click on the  < Select > to return to the Export File Structure tab.

After selecting the file to import the structure from, you will see the file structures
are filled in automatically.

Deleting an Existing Field

To Delete an existing field, select the field that you wish to delete, and then click
the delete button with your mouse.  You can delete any field, as required.

Check for Problems

Bar|Scan checks the fields on this Tab, and then provides a message if problems
exist such as duplicate field names or invalid field sizes.  You can then edit any
field, as required.
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The Values Tab

When you select the next tab, you will see the Values tab as shown below.

Use Quick Add button to check titles for Import field names to see if they match
those you selected in the external file structure tab.  If they match, this table will
be filled in automatically. 

This tab allows you to specify how to fill in the values of each field.  For instance,
you may want to specify that you do not want serial numbers exported if the serial
number is not currently a blank, by using the Add button.  Or, you may want to use
the Add If button, to specify an external filter, so that you will not import any
information from any asset whose total cost is less than $200.00.
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Note: If you use the Add If button, additional values will be indented.  Each
indented value after your Add If value will be filtered by the Add If criteria.

You may also use the Change and Delete buttons to alter or omit any items that
were previously entered into this table.

The Filters Tab

When you select the last tab, you will see the Filters tab as shown below.

On this tab, you may add a filter, change a filter, or delete a filter for your export,
i.e., you may wish to export only items from a certain Catalog Category, so by
simply adding a filter on this tab saying that you want to filter on only the Category
of EO, all other items will be eliminated from your export.

The External File Filters tab appears as greyed out, as it is used for Imports only.
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Executing the Export

When you have completed your Export Format File, you are ready to execute the
export instructions contained within it.

Notice in the close up of the tool bar shown below, there are two new buttons on
the right. 

 

The second to last button is used to start the actual Import/Export.  When the
cursor is placed over this button, it will say, Import/Export using ranged items.  If
none are ranged, then use all items in the current SET command.

The last button is used to View, Edit and Print the Import/Export Log file.

Simply select the Format File that you want to export, and then select
Import/Export icon on the tool bar.
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You are asked if you want to go ahead and do the export.

If you answer NO, you will be returned to the Import/Export Format File Menu.

If you did a previous export and did not delete the file, you will notified that the
file will be overwritten.

If you answer NO, you will be returned to the Import/Export Format File Menu

If you answer YES, the file will be created and the following dialog box will
appear.

Click on OK, and your file is ready to be accessed by your other system. 
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IMPORTING INTO BAR|SCAN

When you want to select Import from the Main Menu, select File  ...<, then Import 
 as shown below.

When you select Import from the File drop down menu, you are shown four
choices, as illustrated above.  The three choices for your import are: Handheld
Computer, Data Transfer File, and Formatted Data.
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The first choice under Import is the Handheld Computer is shown below.

1. The Handheld Computer has three selections of it’s own.  They are:
Synchronize, File and Email.

Handheld Computer Synchronize is used to communicate with the
Handheld Computer.

Handheld Computer File is used to import a previously Synchronized
Handheld Computer file.

Email Inbox is used to import Handheld Computer synchs that were
sent to your Microsoft Outlook email inbox.

2. The second selection, Data Transfer File, is used to import the previously
exported data transfer file created, see the file created in this chapter under the
Export section.

3. The third selection, Formatted Data, is used to import information into
Bar|Scan using the specific criteria established in the Bar|Scan Format table,
i.e., use to create structure for importing from another system or software.

4. The last selection, Image Files, is used to import images and is discussed in
detail in Appendix B - Images.
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IMPORTING FROM OTHER APPLICATIONS

Importing into Bar|Scan can originate from many different computer applications. 
 For each of your imports, you will need to create an Import Format in Bar|Scan. 
The Import Format provides detailed instruction to Bar|Scan so that it can properly
structure the external file that you wish to import and how the file will populate the
corresponding Bar|Scan Table.

Once you have created your Import format instructions, you can use it over and
over again.  This is especially useful if you import information regularly, i.e. on a
regular monthly basis.

You can even use Bar|Scan’s XML Instruction File feature to execute  imports in
a fully automated timed manner.

Do not use an ODBC link to change Bar|Scan data as we cannot provide technical
support for your Bar|Scan system. A better way to import is to use the
Import/Export Module, as Bar|Scan will automatically check all data for
compatibility prior to doing the import.  Importing data directly into Bar|Scan
using methods other than the Formatted Data is not encouraged and is not
supported.

Creating an Import Format

You can only import to one Bar|Scan table at a time, however, it is not uncommon
to import to several Bar|Scan tables as part of one import process.  For example,
to add a new asset, you will import to either the Transaction Table, or the Asset
and Location History Table.  To import into the Asset and Location History Table,
you will create an Import Format for each table.

Bar|Scan will not allow you to import information if it means that the information
creates an incomplete asset record.  For example, Bar|Scan will not allow you to
import new asset information into the Asset Table if you are not also importing the
corresponding Location History, Catalog, Location, and Organization information. 
Of course, you can import new asset information if the corresponding Catalog,
Location, and Organization information already exists in their respective tables.

For this reason, it is often easier to import new asset information into the
Transaction Table as the import rules are less restrictive.
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How do I know which tables I need to update?  Since almost all situations are
unique, consult the Knowledge Base on our website or your Bar|Scan Dealer for
guidance on which tables need to be updated.

When you want to use the Import feature to import a file, you would need to go to
the Main Menu, then select File  ...<, Import  ...<, Formatted Data, and when done,
you will see a browse panel similar to the one below.

If you have not yet created an import format, select the Add Blank button from the
tool bar, or select an Import file from the list, and then select the Add Template
button from the tool bar.  When you have selected your choice of Add functions,
click on the Edit tab.

Each import file format is given a file name, and selected drive and directory where
Bar|Scan will expect to see the file.
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You may also delete an existing format, by selecting the desired file format, Range
the format using the F4 Range feature, and then selecting the Delete button.

As mentioned before, format actually creates the specifications for the file which
you will be importing into Bar|Scan.  This is used to explain to Bar|Scan what the
file you wish to import looks like.  You can have several import files update one
Bar|Scan table such as the Asset Table.  In either case, you must tell Bar|Scan what
the file looks like and what information and under what conditions you wish to
import.

When you select the Edit tab, you will be shown a panel similar to the one below.

The above screen allows you to create your import format.
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The Files Tab

After selecting the Edit tab, you will be presented with seven tabs that make up the
format process for the import.  While this may seem like a lot of information to
complete, in almost all cases it is much easier than having a computer programmer
write a special program to import the information.  The first of those tabs, the Files
tab, is shown below.

There are five things to complete on this screen, the File Format of the file to be
imported, the Import Method, the File Name - including the path, an optional
Procedure, the Optional Group Name, and the optional Group Order.  Let us begin
by choosing a file format.  Each format is explained in the following section.
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Available File Formats

DELIMITED - ASCII comma, quote delimited is the most popular personal
computer export and import format.  The information is converted to ASCII format
which means that it can be read by even a word processor.  The items are separated
by commas.  Alpha numeric items (which can contain both letters and numbers)
are also enclosed with quotation marks.  Choose from Delimited with Blank,
Delimited, or Delimited with Tab.

CSV - The (Comma Separated Value ) file format is a simple format that is
supported by many Microsoft Programs such as Excel.  It is also support by many
database systems and programming languages.  It is also a delimited data format
that has fields separated by the comma character and records separated by
newlines. Fields that contain a comma, newline, or double quote character, or
which start or end with whitespace that is to be preserved, must be enclosed in
double quotes. If a line contains a single entry which is the empty string, it must
be enclosed in double quotes. If a field's value contains a double quote character
it is escaped by placing another double quote character next to it. The CSV file
format does not require a specific character encoding, byte order, or line terminator
format.

DIF - Use DIF to import a .DIF (Data Interchange Format) file.  This format was
used by VisiCalc and is often still used by programs running on AS/400 and other
midrange computers.  Vectors (columns) and tuples (rows) are created from
records and fields in the FoxPro .DBF.  The export file name is assigned a .DIF
extension if you do not include an extension in the filename.

FOXPLUS/DBASE - Foxplus is format compatible with FoxBASE+ and dBase
III.  If you are using Excel or dBase IV, export your data to dBase III before
importing into Bar|Scan.

FOXPRO - FoxPro is compatible with FoxPro version 2.x for DOS, and FoxPro
version 3.0/5.0 for windows.
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ODBC - Open Database Connectivity (ODBC) provides a standard software API
method for using database management systems (DBMS). ODBC is aimed to make
it independent of programming language, database system and operating system.

This means that Bar|Scan can import from many different databases as long as they
are ODBC compliant.  In other words, the software provides a database driver that
interprets the data in a standardized way. 

WK1 - Use WK1 to import a Lotus 1-2-3 revision 2.x spreadsheet.  Each column
in the spreadsheet refers to a field; each row in the spreadsheet refers to a record.

XLS - Use XLS to import a Microsoft Excel version 2 spreadsheet.    Each column
in the spreadsheet refers to a field; each row in the spreadsheet refers to a record. 
A .XLS extension is assigned if you do not include a file extension.

XL5 - Use XLS to import a Microsoft Excel version 5 spreadsheet.    Each column
in the spreadsheet refers to a field; each row in the spreadsheet refers to a record. 

XL8 - Use XL8 to import a Microsoft Excel 97 spreadsheet.    Each column in the
spreadsheet refers to a field; each row in the spreadsheet refers to a record.  
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An Important Note about Importing from Excel into Bar|Scan

The following are some important Excel format issues.  They are not Bar|Scan
import issues.

If the column width in your spreadsheet is narrow enough to hide data, the hidden
data will be cut off when you convert your Excel file to a .DBF format (Bar|Scan
compatible file).  Excel is exporting your data based on what you see on your
screen.  This problem exists in all versions of Excel including Excel 97 and Excel
2000.  Stretching the columns to display all of the data while you are still in Excel
resolves this problem.

In order to avoid other potential problems, it is important to Format all of your
Columns in your spreadsheet as either “Text”, “Date” or “Number”.  Do not leave
them in the Excel default “General”.

While not formatting your columns may have no impact, it is always a good habit
to take this extra step.  For example, if you do not change a column containing
dates to be a “Date” field, internally Excel saves the information as a number and
would also export the information as a number rather than a date.  Bar|Scan will
not import a number into a date field and you would be unexpectedly left with a
blank date.

It is best to keep titles, boxes, graphics, calculations, totals, and other formatting
out of spreadsheets that you will be importing into Bar|Scan.  Keep you
spreadsheet as simple as possible.
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The Import Method

The are two Import Methods supported, File and OLE (Object Linking and
Embedding.  Since OLE is a Microsoft standard, it is only supported in imports
from Microsoft Excel or ODBC (Open DataBase Connectivity).

ODBC is a standard database access method developed by Microsoft Corporation. 
The goal of ODBC is to make it possible to access any data from any application,
regardless of which database management system (DBMS) is handling the data.
ODBC manages this by inserting a middle layer, called a database driver , between
an application and the DBMS. The purpose of this layer is to translate the
application's data queries into commands that the DBMS understands. For this to
work, both the application and the DBMS must be ODBC-compliant  that is, the
application must be capable of issuing ODBC commands and the DBMS must be
capable of responding to them. Since version 2.0, the standard supports SAG SQL.

If you select ODBC, the Files tab will change as shown below.
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After selecting ODBC, for example, you will need to create a data source.

The File Name

Bar|Scan will read the import file that you enter here. You may enter any valid
Windows file name  preceded by an optional path.

If no path is specified, Bar|Scan assumes the file is in your company subdirectory. 

The file extension is optional.  Bar|Scan will assign the extension based on the file
format that you select.

You can right-click on the field and a menu will be presented to you.  You can
select Open and Windows File Explorer can be used to locate your file as shown
in the example below:

Page 14-46 Bar|Scan



Chapter 14

If you setup an ODBC, you will need to connect to a data source.  Right-clicking
in the File Name field will start this process and you will see a window similar to
the one below. 

The data sources available on your computer may be different than the ones in the
above list.  The list is dependent on what applications you have installed on your
computer.

If the data source that you are interested in connecting to is not in the list, it may
be available for download from Microsoft or another vendor.

Once you have selected your data source, you can continue to setup the link as
shown in the screen below.
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In the above example, we have selected Microsoft Access, and we need to tell
Bar|Scan where the files are located.  Note: Each Access database is stored as an
mdb file and cannot be imported as a flat file such as a text file.

Once you have told Bar|Scan where the file is located, you will be asked additional
questions such as which file contained in the mdb you wish to import from.   Since
there are many different ODBC compatible file formats, we have chosen not to
display all of the permutations.

Procedure

This feature is optional, but using it, you can customize your import by calling a
Procedure at the time of the import.  A Procedure is a custom program written be
a computer programmer to perform a special task. The program must be a FoxPro
program.  If a Procedure is entered, Bar|Scan will use it.

Most likely, you will not need a Procedure.  Almost all imports can be completed
without this process.

If you require a Procedure, see your Bar|Scan Dealer for more information.

Group Name

Group Name is optional, but allows you to group Imports, range them, and then do
one import after the other.

Group Order

Group Order is optional, but allows you the option of deciding which import needs
to be completed first, and then the order of the rest of the imports, i.e., if you are
importing both Catalogs, Assets, Organizations, Locations, you could use this
feature to make the import proceed in logical order importing first the
Organizations, then Locations, then Catalogs, and finally Assets. 
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Allow use of this Import/Export Operation

Normally enabled, you can disable the ability of this format file to be used.

Optional SQL Query

This is a free-form data entry area where you can specify a SQL query to obtain the
correct data as a table.  You will need to match the External Structure to the
query’s columns.  Here is an example of a SQL Query to obtain the correct data.
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The External File Structure Tab

Select the second tab, the External File Structure tab, and you will see a table like
the one below.

You complete this screen to tell Bar|Scan the structure of the file that you will be
importing.

There are two types of information that a file contains.  The first is records. 
Records are the number of items in the file.  For example a file can contain 100
records corresponding to 100 assets.  Records are also the equivalent of rows in a
spreadsheet.  The second type of information in a file are the fields.  For example,
an asset number, purchase order, and purchase price, are three fields of an asset. 
Fields are the equivalent of columns in a spreadsheet.
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On this tab, we will tell Bar|Scan what fields are in the file that you wish to import.

Before we proceed with the mechanics of describing the structure of the import
file, we must distinguish between a structured import file and a non-structured file.

% A structured file is an Excel, or dBase III file.  If you are using Excel or other
applications that can create a dBase file, export your data first to a dBase III
compatible file prior to importing into Bar|Scan.  Structured files can have their
structure imported into Bar|Scan.  A structured file is easier to import than a
non-structured file, as we will see later, because the structure can be imported
instead of manually entered.

% A non-structured file is all other formats.  Non-structured files are converted
by Bar|Scan into a structured file, but they have to be described to Bar|Scan one
field at a time.  Their structure cannot be imported.

Now going back to the display screen, the screen is separated into two areas.  To
the left is the list of fields and to the right are the actions.  The mouse or TAB key
will move from selection to selection.

Double click on your mouse, or press ENTER to pick a selection.

The left side of the display screen is either empty or displays one or more
previously created fields.  There are an infinite number of fields that can be
created.  You may use the arrow or TAB key to move from field to field.

You may also change the order of the fields by dragging them up or down.  This
is done by placing it on the up-down arrow symbol at the left of the format file
name and moving the mouse up or down while depressing the left mouse button.
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Adding a New Field

Normally you will select “Add Bar|Scan Fields.”  You will be shown a look up
window like the one below.

The Look up Window will list the fields in the appropriate table in Bar|Scan. 
Choose the Bar|Scan field in which you wish to export.  If the table listed at the top
of this window does not contain the information that you wish to import, you may
use the down arrow next to the table name, and select the fields from a different
table 

You can export from any of Bar|Scan’s Tables.  Each Bar|Scan Table and it’s
fields, field names, and field sizes are listed at the end of this Chapter.

To add a new field, you may select the Add Blank button, or the Add Template
button.

If you select blank you will see a line appear on the left-hand side, Blank0000,
Blank0000, C, 10, 2 ---and you will then need to change the line to say what you
want it to. 
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Normally, you will select a blank field if your import file contains one or more
fields that you do not wish to export from Bar|Scan.  For example, if the first field
of the export file should be blank.

Bar|Scan will give it a default Field Name, Type, and Length.  These can be
adjusted by you.  For example, if the field width is 8, you can change the length 
to 8 also instead of the Bar|Scan default of 10.

 
When you can select a line, and then select Add Template, a duplicate of the line
you selected will appear, and you may change it to say what you want it to.

Changing an Existing Field

To Change an existing field, select the Change button.  When you select Change,
you will see a window like the one below.

You can change any field, as required.  For example, if your import file’s serial
number length is 20, you will change the length on this screen from 25 to 20
(Bar|Scan’s serial number field is 25 and will display as the default length).
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Importing a File Structure

Importing a file structure avoids the task of having to manually add each field to
the display screen.  Instead,  you will let Bar|Scan complete the screen for you. 
The import file must be an Excel, FoxPlus, or dBase III compatible file.  These
normally have the DOS file extension .DBF.

To Import a File Structure, select the Import Structure button, and you will see a
Look up Window like the one below.

Select the folder which contains the file structure that you wish to use, and
Bar|Scan will automatically import the list of the file structure for you.

You will need to tell Bar|Scan where the file that contains the structure is on your
computer’s disk drive.
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Only those files with an extension matching the File Name are displayed.  If your
file is a compatible but has a different file extension, you will need to click on the
All Files button.  For example, if the File Format is ODBC, you may see the
following screen instead of the one on the previous page.

To complete your selection, click on the highlighted file name to select it and then
click on the  < Select > to return to the Export File Structure tab.

After selecting the file to import the structure from, you will see the file structures
are filled in automatically.

Deleting an Existing Field

To Delete an existing field, select the field that you wish to delete, and then click
the delete button with your mouse.  You can delete any field, as required.

With a structured file, deleting IS NOT required since Bar|Scan will know at what
position in the record one field ends and the next field begins and fields that you
do not wish to import will be ignored.  There are a few non-structured files such
as a delimited file where this is also true.

Import and Export Page 14-55



Import and Export

Check for Problems

When you select this button, Bar|Scan checks for logic problems on this tab.  An
internal table is built (what we refer to the XX table).  If it can’t create it properly
then neither the export nor import can work.  Doing this test can avoid some types
of messages that would otherwise show up when the import/export was attempted.

For example, forcing a Date field to anything other than 8 characters long does not
make sense since Bar|Scan stores dates in only this format.

The Values Tab

Select the next tab, the Values tab, and you will see a table like the one below.

You complete this screen to tell Bar|Scan which fields in Bar|Scan to replace with
the information contained in the fields of the import File.

Even if you are adding new Assets, Catalogs, Locations, etc. you must complete
this screen.   No fields are automatically replaced.
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You may also use the Change and Delete buttons to alter or omit any items that
were previously entered into this table.

Use Quick Add button to check titles for Import field names to see if they match. 
If they do, it imports the information automatically.

Add If

You can also create individual Field Filters for each replacement.  This allows
even more flexibility that the Record Filters described in the previous section Page
Five of the Import Format Screen.

How do Field Filters Work, and How is it different than a Record Filter?   Field
Filters will only reject the individual Bar|Scan field for update by the Import File
while a Record Filter will reject the entire Bar|Scan record.

This means that using a Field Filter allows other information in the Bar|Scan
record will be updated and only the field affect by the Field Filter will not be
updated.

Here is an example, suppose you wish to update the Bar|Scan Secondary Numbers
as well as the Purchase Cost (as described on Page 36).  Suppose also that even if
the purchase cost is not updated because it is less than $500.00, you wish to import
the Secondary Number.  Using a Field Filter will allow you to preform the import
successfully.

This tab allows you to specify how to fill in the values of each field.  For instance,
you may want to specify that you do not want serial numbers imported if the serial
number is not currently a blank, by using the Add If button.  Or, you may want to
use the Add If button, to specify an external filter, so that you will not import any
information from any asset whose total cost is less than $200.00.

This tab is separated into two areas.  To the left is the list of fields to replace and
to the right are the actions.  The mouse or TAB key will move from selection to
selection.

The left side of the display screen is either empty or displays one or more
previously created fields to replace.  You may use the arrow or TAB key to move
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from field to field.

You may also change the order of the fields by dragging them up or down.  This
is done by placing it on the up-down arrow symbol at the left of the format file
name and moving the mouse up or down while depressing the left mouse button.

Adding a Replace Bar|Scan Field

When  you select the Add, Add If, or Change button from the Values tab, you will
see a Look up Window like the one below.

Make your selection, and then select the Add button, and when you have finished
creating all or the replace field filters, select the close button, and you will be
returned to the Values tab. 

Here are four more complex replacements shown to illustrate the flexibility of the
replace feature.  To import blank asset numbers and replace item with
automatically generated ‘Z’ numbers, you would enter the following expression in
the enter value section:

IF(EMPTY(XX.ASSET_NO), ZNUMNEXT(),XX.ASSET_NO)
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Converting a six character text date such as “012495" to the date field can be done
with the following expression:

X_CTOD(XX.INV_DATE,”MMDDYY”)

In general, converting text dates can be done by following the variations of the
X_CTOD() Expression below:

Depending upon the field type of the field being converted:

XX = Work area of the imported data
YEAR = Raw field name of the field being imported (the field name in the
external structure).
M = One digit of that portion of the string making up the Month number.
D = One digit of that portion of the string making up the Day number.
Y = One digit of that portion of the string making up the Year number.

For each of the MDY digits, use as many as needed to fully specify that portion of
the date. For example, if only the year is provided in a field, specify the month and
day with constants and use the field that specifies the year:

If the Year is numeric (type=N) WITH the century (e.g. 2016)
X_CTOD(“0101” + STR(XX.YEAR,4), “MMDDYYYY”)

If the Year is numeric (type=N)  WITHOUT the century (e.g. 06)
X_CTOD(“0101” + STR(XX.YEAR,2), “MMDDYY”)

If the Year is a string (type=C) WITH the century (e.g. “2016”)
X_CTOD(“0101” + LEFT(XX.YEAR,4), “MMDDYYYY”)

If the Year is a string (type=C) WITHOUT the century (e.g. “06”)
X_CTOD(“0101” + LEFT(XX.YEAR,2), “MMDDYY”)

If there are embedded slashes
X_CTOD(“01/01/” + LEFT(XX.YEAR,2), “MM/DD/YY”)

To make Bar|Scan assign Catalog Numbers, Organization codes, etc.  You can use
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the following function.  The function will look for the largest existing number and
then generate a new, larger number for each item during the import.  A sample that
creates new Organization Codes is below:

TRANS(X_NEXTNO(“OW_ORG”,”ORG”),”@L 99999")

TRANS is the FoxPro Transform function that turns the number into a character, 
X_NEXTNO is the actual Bar|Scan function, OW_ORG is the field name, ORG
is the Table that contains the field name and @L 99999 is the mask that will
produce the number, in this case a sequence like 00001, 00002, 00003.

As you can see from our examples, you can create almost any type of filter you
wish.  However, this flexibility also means that you may need to know Bar|Scan
field names but also some of our language conventions.  Consult your Bar|Scan
Dealer if you find that creating filters may be beyond your level of experience.

You have now completed all seven tabs that make up the Import Format.  Press the
Ctrl + S key combination, or click on the Save button in the tool bar to save your
work.

In any case, we recommend that you do a back up of your Bar|Scan data if you are
unsure of the results of your import.  Refer to the section Backing-Up And
Restoring Bar|Scan Data in Chapter 3 - Installing Software for more information.
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The Links Tab

Select the next tab, the Links tab, and you will see a table like the one below.

You can complete this screen to tell Bar|Scan which file to import to as well as
which key fields to use when trying to find a match. 
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What are key fields and why would I use them?  First, key fields are special
because they are the fields in both the import file and the Bar|Scan Table that
contain the same information.  Second, they are not required for all types of
import.  Each of these important issues will be explained on the following page.

Let us proceed with the mechanics of a key field and when it is necessary and when
it is not necessary.

% A key field is a field in both the import file and the Bar|Scan table.  We assume
that you have an understanding of the structure of the import file.  All of
Bar|Scan’s table structures are documented at the end of this Chapter.  You will
need to match the fields based on the information in the fields.  The field
names do not need to be the same.

% Key fields are required when you wish to change or add new information to
existing asset, catalogs, etc.  Unless you are doing a global change, Bar|Scan
needs to know which assets to change.

% Key fields are required when you are adding new assets, catalogs, etc. and you
do not wish to inadvertently add duplicates of items already in Bar|Scan. 
Duplicates in your import file can also be eliminated by using key fields.

% The case of the information is important.  Lowercase must be identified when
you import by use of the UPPER command, which is explained later.  

% The field type, i.e., character, numeric, or date, must also be the same in both
files.

% A key field is not required when you are adding new asset, locations, catalogs,
etc. and you are sure that these items do not already exist in the Bar|Scan
Tables.  It is also not required for global changes which affect all items in a
Table.
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Selecting the Bar|Scan File Key Field

When you select the Add or Change button to add or change a Bar|Scan Key Fields
item, you will see a Look up Window similar to the one below.

You are presented with the choice of Bar|Scan fields that you wish to use as keys.
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Selecting the Import File Key Fields

When you wish to select the Import File Key Fields, simply select the Add button,
or select a key field already listed, and then select the Change button, and you will
be shown a list of files like the one below.

You may select up to four key fields to match records in the import file and
Bar|Scan table. 

The match is successful when each of the completed keys are matched.  For
example, if you wish to update the Bar|Scan Catalog Table based on Manufacturer
and Manufacturer’s Part Number, the update will only occur if both matches are
successful.  It will not update the Catalog Table only if one of the two is matched.
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If necessary, you can use the Expression Button to create a custom link.  For
example, if your external data contains an asset number of 9 digits, but only the
first 6 digits were in the barcode, you could build an expression like the one below
that would truncate the number.

There are many reasons to use expressions when Bar|Scan and the external data
source do not have a close match.  It is best to contact your Bar|Scan Dealer for
more information in order to build an accurate expression.
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The Operations Tab

Select the next tab, the Operations tab, and you will see a table like the one below.

You complete this screen to tell Bar|Scan what you would like to do when it finds
a match and when it does not find a match.  In addition, you have the opportunity
to review the import file format after it has been converted to a Bar|Scan data file,
but prior to actually being imported.

The items are in the form of pull downs.  You can make your selections by clicking
your mouse on the down arrow, TAB or RETURN key to move from item to item. 
 
You become familiar with how the import process works, it is recommended that
you select Examine and Verify Import File before Updating.
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Since the Bar|Scan Asset Table maintains the current location information and the
Bar|Scan Location History Table maintains the asset history, when a new asset is
added, it must be added to both Tables.  By check marking “automatically Transfer
a new Current Location into the Asset Location History”, the import will transfer
location history as required.  This makes it easier to import Assets.

The Filters Tab

Select the next tab, the Filters tab, and you will see a table like the one below.

You complete this screen to tell Bar|Scan what existing items in the Bar|Scan
tables or the Import File can affect the import.  For example, you may wish to
import asset purchase cost information for only those items that Bar|Scan shows
as Capital Assets but not those that Bar|Scan shows as Expenses.  But our import
file contains costs for all items, both Capital and Expenses.
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How is this done?  Assume that Bar|Scan’s general ledger field contains G/L codes
which represent both Capital and Expenses items.  Assume also that all Capital
Assets have a general ledger number that begins with “C” and that all Expended
items do not.  You can now create a filter stating that items in Bar|Scan whose
general ledger number does not begin with “C” will be ignored and no update will
take place.

As you can see from the previous example, filters can be based on any field in
Bar|Scan, not just the fields that you are importing.

You can also filter on items in the Import File.  For example, your import file
contains purchase costs for all items but you wish to  import asset purchase costs
only if the purchase cost is greater than $500.00.  Assume that there is no purchase
cost information already in Bar|Scan, you must filter by the purchase cost in the
Import File.

Looking at the display screen, the screen is separated into two areas.  To the left
is the list of Bar|Scan record filters and to the right are the actions.  The mouse or
TAB key will move from selection to selection.

Double click on your mouse, or press ENTER to pick a selection.

The left side of the display screen is either empty or displays one or more
previously created filters.  There are an infinite number of fields that can be
created.  You may use the arrow or TAB key to move from field to field.

The Filter tab has two tabs of its own.  The first tab, Bar|Scan Table Filters looks
like the one below.
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This tab will allow you to put filters on the import, so that only those Bar|Scan
fields that match the filters listed can have their values changed during the import.

When you select the Add button, or select a previously created filter, and select the
Change button, you will see a table like the one below.

The second tab, External File Filters, looks like the one below.

This tab allows you to place a filter on the data that you are going to import, so that
only the records that meet the filter will be imported.
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When you select the Add button, or select a previously created filter, and select the
Change button, you will see a table like the one below.

 

 

Assuming we select Bar|Scan’s General Ledger Number, as mentioned in the
example.

We now complete the line by typing the rest of the filter.  The filter line now looks
like this:

AS.GeneralLedger#=’C’

This is the Bar|Scan field name for the General Ledger Number.  The AS. in front
of the field name is called the file alias.  The file alias’ as well as field names are
listed at the end of this Chapter.

We have now completed a filter.  All assets whose General Ledger Numbers begin
with the letter “C” will not be  affected by the import.

As you can see from our simple example, you can create almost any type of filter
you wish.  However, this flexibility also means that you may need to know
Bar|Scan field names but also some Microsoft language conventions.  Consult your
Bar|Scan Dealer if you find that creating filters may be beyond your level of
experience.
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Hint: Additional information is available on our Support Knowledge Base page on
our website at www.barscan.com

When you select the fields that will complete the filter, select the Add button. 
When you have finished creating all of the necessary filters for this import, select
the Close button.  You will be returned to the Filters tab.  

The Logging Tab

Select the fifth tab, the Logging tab, and you will see a table like the one below.

Looking at the display screen, the screen is separated into two areas.  At the top is
the option to backup the Bar|Scan Table before you perform the import.  At the
bottom are the options for the Import Log File.

You complete this screen to tell Bar|Scan if you wish to backup the Bar|Scan file
and what information you wish to record in the optional Import Log File.

The mouse or TAB key will move from selection to selection.

Double click on your mouse, or press ENTER to pick a selection.
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Back Up Prior to Import

Bar|Scan will create a back up copy every time you perform the import using the
Import Format created in this section.  The backup will be located in the your
companyname\backup folder.

When you import onto a BarScan Table, two new files are created in the form:
BXfilename YYYY-MM-DDTHH_MM_SS.DBF
BXfilename YYYY-MM-DDTHH_MM_SS.DBF

Where filename is the original BarScan Table Name, YYYY-MM-YY indicates
the date and where HH_MM_SS indicates the time of the archive.

If you have preformed the import before, and are confident that the import will be
successful, you may wish to not back up the Bar|Scan Table since it does require
additional time and disk space.

Import Log File

The Import Log File will record information on what events occurred when you
performed the import.  

After you perform the import, by pressing the Log Button, you can
review the Import Log File which will contain the results of the import
based the buttons selected on this Display Screen.  After opening, you
can instruct that the file be written to your computer’s drive for backup
by selecting Fil-> Save As.  The file is an ASCII text file and can be
opened by many different text editors, word processors or readers.

Since you control what information will be recorded, the import Log File can be
either a very large file containing very detailed information, or a small file
containing a minimal amount of information.

If all selections are set to (N)o, the Import Log File will contain only header
information documenting the file updated and when it occurred.

By default, only the prompt’s Problems and Exceptions for matches and no
matches are recorded.
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Executing the Import

When you have completed your Import Format File, you are ready to execute the
import instructions contained within it.

Notice in the close up of the tool bar shown below, there are two new buttons on
the right. 

The second to last button is used to start the actual Import/Export.  When the
cursor is placed over this button, it will say, Import/Export using ranged items.  If
none are ranged, then use all items in the current SET command.

The last button is used to View, Edit and Print the Import/Export Log file.

The Simply select the Format File that you want to export, and then select
Import/Export icon on the tool bar.

You are asked if you want to go ahead and do the import.

If you answer NO, you will be returned to the Import/Export Format File Menu.
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The information that you wish to import can optionally be visually validated, if you
instructed Bar|Scan to do so.  You will then be presented with the following dialog
box.

You will now be presented with the import file as seen by Bar|Scan.  A sample is
shown below.
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If the information presented to you appears erroneous or incorrectly structured, you
will be presented with an opportunity to abandon the import.

The Import/Export Log File records the events that occurred during the import. 
You control which events were written to this file when you created the import
Format file.  The report can be viewed on the screen as well as printed to your
printer.  The following is a sample view.

The Import/Export Log file can become very large if you instructed it to record all
events. 
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Each Import will create a new Log file and the previous file is overwritten,
however you are warned when the old Log file will be replaced.

The dialog box will look like this.

Usually you will select YES.

The final Import Dialog Box informs you that the Import was completed.

You will be presented with the following dialog box.

The Import Operation is completed.  It is always a good idea to review the Asset
tables after the import operation has been completed.

Also consider printing the results of the import by clicking on the Import/Export
Log File button.

Page 14-76 Bar|Scan



Chapter 14

Import problems

There can be many reasons why an import is not successful.  Some are related to
the data itself, others related to the import rules Bar|Scan follows.

Based on the severity of the problems, Bar|Scan will decide if the items being
imported can be edited after the import, which will then complete the import, or
of the import is rejected in it’s entirely.

For example, on your Company Settings Screen, you determine the Range of Valid
Years that you want Bar|Scan to work within.  By default this is 1920 through
2080.  Bar|Scan will reject any import (or data entry) of any dates that fall outside
of this range.

When attempting an import with invalid dates, you will be presented with the
following dialog box.

In the above example, this is most likely caused by the data in the spreadsheet.
Using Excel, sort the date column. Next look at the earliest and latest date. You
might find a year such as 3019 Instead of 2019. 

Because the file you are importing is not tested for validation until the import
begins, the import problems are usually presented at the very last stage of the
attempted import.
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IMPORTING FROM A MOBILE DEVICE 
DATA FILE OR EMAIL

There are three ways to select the upload feature for a Handheld Computer.  The
first is to go to the Main Menu then select File . . .<, Open . . .<, Handheld
Computer. . .<, Synchronize or File or Email inbox as shown below.
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When you select Synch Handheld, you will see one of the following types of dialog
boxes.

The dialog box above is for Mobile devices running Windows Mobile or Windows
CE.  There are Legacy configurations in Bar|Scan that can also be used for for
serial connections such as those used by legacy Handheld Computer models SPT,
PDT, etc.

On this box you should select the type of connection that you are going to be using
by using the down arrow next to the Use Configuration field.

If the selection shown is not the correct selection, simply click on the down arrow
next to the field that contains the connection, and you will see a drop down menu
list, as shown below.
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When you have determined the correct connection, simply select the Begin button. 
The IP address should be selected, automatically. 

The message of the display panel will change to say initializing, then to “Waiting
for Connection” as you can see below.

If the Handheld Computer is connected correctly to the computer, and you begin
the Tools -> Synch function on it, the bottom of the above box should change
again to display how many bytes have been received.  The box  will display a
Cancel button for you to cancel the synch if you deem necessary.

When the synch is complete, Bar|Scan will inform you that the items have been
placed into the Transaction table.  You have now completed the synchronization
process.
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When you want to import a Handheld Computer file, go to the Main Menu, then
select File . . .<, Import . . .<, Handheld Computer. . .<, File, as shown below.

You can now browse to your Company’s Reader folder (barscanw\your company
name\reader) and import any previously synchronized Mobile Device File. 
Usually, you can determine which file you wish to import based on the file’s time
and date stamp.

On Handhelds prior to the MC3200 model, you can also browse directly to the
Handheld’s SD card if the handheld is connected.  However, call your Bar|Scan
Dealer for technical support  prior to attempting any imports this way.

The default format for Pocket PC is XML, so these files can also be accessed with
an editor.
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As previously discussed in this Chapter, Bar|Scan cannot only get transactions
from a Handheld Computer, it can also get transactions from a file which looks like
a Handheld Computer or a file that was previously uploaded but not put in the
Transaction table.  The required file structure for both TAG and TAKE mode is
documented at the end of this chapter. 

When you have selected to import a file, you will see a Look up Window like the
one below.

You will need to tell Bar|Scan where the file that contains the transactions is on
your computer’s disk drive.  Select the proper drive, and folder that contains the
file.

To complete your selection, click on the highlighted file name to select it and then
click on the Import button.
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Bar|Scan will evaluate the file format to determine if it really matches the Mobiel
Device format as required.  See the Mobiel Device TAG and TAKE formats at the
end of this Chapter for more information.

When you want to import a Mobiel Device file, go to the Main Menu, then select
File . . .<, Import . . .<, Handheld Computer. . .<, Email Inbox, as shown below.

If you have configured your compatible Mobiel Device to synchronize using email
accounts and have collected and sent inventory information to your account, you
will have one or more emails waiting for Bar|Scan in your Outlook inbox.

Note: Outlook does not need to be open to perform the import.
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When you select Email inbox, you will be presented with the following message.

Reply Yes to allow Bar|Scan to check your Email Inbox.  If inventory information
is successfully imported, you will be presented with the following message:

When all of your emails have been completed, you will be presented with a
message similar to the following:
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If no emails are waiting, you will see a message similar to the one below.
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THE ACTIVITY LOGS

INTRODUCTION

There are many ways to use the Activity Log Export Feature.  It can serve as an
additional audit trail of your work.  It can be used to create detailed Asset Reports
which take changes to the data over time into effect.  It can even be used to track
employee mistakes, since it records any changes including asset deletions made in
error.  It can also be used as a tool to interface with other software applications. 

For example, lets say that you want to use the Activity Log Export feature to
inform your enterprise asset depreciation application when a new asset has been
acquired, moved to a new location or cost center, or retired.  You may wish to
consult with your accounting department regarding proper procedures in handling
these issues.

You and your accounting department will want to establish guidelines concerning
the creation of the Activity Log Export file before you start using this feature.  We
recommend that you thoroughly review this entire chapter before setting up your
procedures.

An important feature of the Activity Log Export feature is that it records and keeps
a history of changes to your assets, either from the Mobiel Device or keyboard
entry or an import.  Once the Activity Log is set up, this collection is done without
the need of any action on your part.  This is what is referred to as event driven
processing.

Both the Activity Log and the Bar|Scan Report feature can be used to create an
export file, in one of many different formats, to other systems, but the Activity Log
is event driven while the Bar|Scan Report feature is not.
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The Activity Log feature can easily be set to record only those events or actions
that are of interest to your other system.  The Log, however, always exports the
information in the same, uniform manner that you specify.  In other words, the
export file is always in the same format no matter what events were recorded.  This
uniformity is so that your other system can rely on the format for import even if
you wish to export certain information today and different information in the
future.  It also means less computer programming to create a bridge between unlike
platforms and applications..

You may wish to consult with your IT Department to determine the exact method
of interface to your other system, both hardware and software.  Most fixed asset
depreciation systems have the software in place to import file information such as
the Bar|Scan Activity Log Export file.  However, some computer programming
may be required.

You can select which Table you wish to Log.  The Activity Log will record all
fields in the Table that is being Logged for export. 

INFORMATION RECORDED

The Bar|Scan Activity Logs will not begin recording events until you instruct it to
do so.  Recording events is done by using the LOG and the FIELDS Operating
Modes which are discussed later.

There is an Activity Log file for each major table in your system, i.e., Asset,
Catalog, Location, etc.  Each Log file must be individually set up to record
information for it’s corresponding table.
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As previously mentioned, the Activity Logs can track additions, changes and
deletions, behind the scenes, for export to and import from your personal computer
or main frame based fixed asset accounting system.  You can control what types
of actions (add, delete or change) and which fields will trigger an entry in the
Activity Log.  

You can use the Bar|Scan Report Generator or the Import/Export Module to print
or export the Activity Log.  The Activity Log can be generated as frequently as
desired.

As you have seen in Chapter 10 - Reports as well as this Chapter, the output is a
flexible listing of the asset record, in a variety of formats, with optional control
field to identify fields changed within the record, the type of action, and a time and
date stamp.  Format options include: Delimited, ASCII, CSV, PDF, Microsoft
Excel,  and System Data Format (Fixed fields).

For example, the information being saved in the Activity Log consists of the entire
Asset file plus 5 extra Activity log fields. One field contains the bar code asset
number prior to a change in the asset number, two fields hold a time and date
stamp for the recorded Activity.  A fourth field holds what type of Activity
generated the Activity log record, and the last field contains a list of which asset
items were changed.  You select which of these fields you wish to export at the
time the export file is generated.  

Depending on the amount of use, it may be possible to generate a large number of
Activities very quickly.  For example, adding a General Ledger number to 100
assets will generate 100 new Activities.  Care should be taken to avoid specifying
the logging of unnecessary fields as this may produce more Activities than wanted.

 Selecting the proper fields to record as Activity events will be your responsibility
and should be considered part of the overall set of asset management procedures
implemented as part of the Bar|Scan System.

As discussed, in Chapter 13 - Housekeeping, you can Archive the Activity Log. 
This is a housekeeping function that does not need to be performed very often.
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TRANSFER TO ANOTHER APPLICATION

Actual transfer of the Activity Log Export file information to your other software
application is not actually done from within Bar|Scan.  It should however, be done
as soon as possible after Bar|Scan generates the Export file.

The transfer can be done anytime, e.g., weekly, monthly, quarterly, etc. and will
probably be dependent on the exact procedures you and your accounting
department develop.

We recommend a weekly transfer when hundreds of Activities are taking place on
a weekly basis.

While there is no way to calculate the exact size of the Log Export file, you can
experiment to see what size of a file your combination of event triggers will
generate.
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DEFINING AN ACTIVITY LOG ENTRY

When you want to select which activities to log, you will need to open the Bar|Scan
File Lists.  To do this, go to the Main Menu, select File . . .<, Open . . .<, Table
Properties, as shown below.
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When you do this, you will see the following table.

This panel shows you a list of all of the tables that can be selected to log.  It
permits you to define which items will trigger an event. 

Select one of these items listed on the Browse panel, and then select the Edit tab. 
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You will be shown a panel similar to the following.

This panel allows you to access a list of fields to log for each company.  You may
choose to Add, Change, or Delete fields to log.  As shown you may also choose
whether or not to allow imports, exports, and reports of the items logged. 

The Bar|Scan Activity Log allows the generation of a continuous series of Activity
records based on the occurrence of a limited number of user specified events for
each table.  These events are: the addition of a record to the table, the changing 
information in a record, or deletion of a record from the table.

You can control which of the above events will generate a record in the Activity
Log.   Additions and Deletions will automatically generate an Activity record if
you specify these as events that you wish to Log.
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As mentioned before, in addition to keyboard entry, imports and uploads from the
Mobiel Device via the Bar|Scan Transaction Table will also generate an Activity
record.

There  are several special fields in the every table in Bar|Scan including the Log
Tables that can be used to query about what type of change took place to the
record.  They are: Log Add-Edit-Delete, Log Event Code, Log Date, Log Time,
and Log User.

There are 3 possible entries into the Log Add-Edit-Delete Field.  They are:

“A” - Addition of a new record
“E” - Edit of an existing record
“D” - Deletion of a record

The “A” and “D” codes can only be created once for each record while the “E”
code can be created multiple times.

Keep in mind that the “D” code refers to deletes in the Table being Logged. 
Normal activity does not delete records in the Log Table.

You can create simple filters on the reports or exports from any Activity Log
Table.  For example the filter “Log Add-Edit-Delete = ‘A’” would print only the
new additions to the Log Table.  The addition of the Log Date can be used to
narrow the data to only Adds that meet the Date Filter.

The Most important field is called the Log Event Code and it is one character long. 
Your other computer application may use this code to assist in processing the
import.  You may also wish to use the Log Event Code in combination with the
Log-Add-Edit-Delete field to obtain a more detailed picture of Logging.

In summary, Logged events occur when a record has been added, changed or
deleted and they will have an event code due to one or more of the following
events:

"S" - User has selected a company. This will occur when logging in and when the
user manually selects a new company from the company list. This entry is in the
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Bsuser Table.

"E" -  User has performed a manual edit upon the record or a change was made to
the record. Note: Adds and deletes in supporting tables are marked as an edit in the
master record if such affects the master. This is the default entry unless another
entry used.

"D" - Record deleted.

"M" - Record modified, added or deleted during a Transaction Move.

"W" - Record modified, added or deleted during a forced change in inventory from
a Work Order Shopping form line item. 

"V" - Record was modified or added during a transaction validation.

"P" - Record marked as printed.

"T" - One of the housekeeping table integrity functions has made an adjustment to
this record, eg, duplicate date/time fix., realign z number locations, renumber
duplicate z numbers. Note: Not all housekeeping functions will have this entry.

"R" - Entry generated as a result of  a Work Order Reorder operation.

"Y" - Record modified, added or deleted due to a company synchronization.

"I" - Record present due to an import operation.

"L" - Present only in Asset location history records.  Location history record was
added to location history from the asset table.

The following log entries are currently related to activity in Work Orders only and
will be found in the log note field.

"D" - The line item was added as a dynamic Work Order line item from the
Transaction Table.
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"R" - The record was added due to a ranged addition (a base record had a detail
line added to it, a copy of which was added to all records in a range.)

"M" - An Add Template was performed.  The newly created detail will all have
this entry in the Log note field.

"S" and "2" - A work order line item was split automatically into two or more line
items, the total of which equals the original line item. The original record will have
an 'S', the new split out records will have a '2'.

 
"B" and "T" and "C" and "U" - The user did a manual entry of a line item by
pushing one of the 'Add blank', 'Add Template', or 'Add Credit' buttons or entered
a line item by entering a UPC value in the UPC scanner field.
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FIELD LENGTH CHART

ASSET TABLE (ALIAS AS)

No. Field Name Variable Name Type Field Length Comment

1 Accumulated Depr. AC1ACC N 12,2 999,999,999.99

2 Additional Cost PL_ADD N 12,2 999,999,999.99

3 Additional Cost in Basis AB_ADD L 1

4 Archive Record Id ARCRECID C 10

5 Asset # ASSET_NO C 12

6 Beg. Depr. Accumulated AS_PMAMT N 12,2 999,999,999.99

7 Beg. Depr. Book Value Remaining AS_PMRBOOK N 12,2 999,999,999.99

8 Beg. Depr. Currency AS_PMCRNCY C 3

9 Beg. Depr. End Date AS_PMEDAT D 8

10 Beg. Depr. Method AS_PMDTYP C 5

11 Beg. Depr. Note AS_PMREM C 50

12 Beg. Depr. Start Date AS_PMSDAT D 8

13 Book Value Remaining AC1RBOOKV N 12,2 999,999,999.99

14 Catalog Category (xx) CAT_CODE C 2

15 Catalog Number (9999) CAT_NUM C 4

16 Condition COND C 2

17 Currency CRNCY C 3 USD

18 Current Bay L_XLO07 C 5

19 Current Building L_BLDG C 5

20 Current Comments L_NOTE C 30

21 Current Cost per Unit L_CPERU N 12,2 999,999,999.99

22 Current Floor L_FLOOR C 5

23 Current Inventory Date L_MOVEDAT D 8
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24 Current Inventory Initials L_MOVEBY C 3

25 Current Inventory Time L_MOVETIM C 6 99:99:99

26 Current Level L_XLO09 C 5

27 Current Location Descrip. L_DESC C 30

28 Current Location Type L_XLTYP C 8 SITE

29 Current Name L_NAME C 20

30 Current Quantity Added L_QTY N 9 99,999,999

31 Current Region L_PRJREG C 2

32 Current Room L_RM_AREA C 6

33 Current Room Tag L_RM_TAG C 8

34 Current Row L_XLO06 C 5

35 Current Slot L_XLO08 C 5

36 Current Tag Or Take L_TAGTAK C 7 "UNKNOWN"

37 Current Vault L_XLO05 C 5

38 Current Work Order # L_MOVENUM C 12

39 Depr. Adjusted Base Amt AS_ABA N 12,2 999999999.99

40 Depr. Adjusted Start Date AS_ASD D 8

41 Depr. Base Amount AC1COST N 12,2 999999999.99

42 Depr. Calc Date AC1LCDATE D 8

43 Depr. End Date AS_DEDAT D 8

44 Depr. Fully Depreciated AS_DEPCOM L 1 Y or N

45 Depr. Life (mo) AC1DELIFE N 4 9999

46 Depr. Method AC1DEPTYP C 5

47 Depr. Monthly Amount AC1MODEP N 12,2 999,999,999.99

48 Depr. Start Date AC1RECDAT D 8

49 Depr. Org Code 1 AS_ORG01 C 6

50 Depr. Org Code 1 % AS_ORG01P N 8,4

51 Depr. Org Code 2 AS_ORG02 C 6
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52 Depr. Org Code 2 % AS_ORG02P N 8,4

53 Depr. Org Code 3 AS_ORG03 C 6

54 Depr. Org Code 3 % AS_ORG03P N 8,4

55 Depr. Org Code 4 AS_ORG04 C 6

56 Depr. Org Code 4 % AS_ORG04P N 8,4

57 Depr. Org Code 5 AS_ORG05 C 6

58 Depreciation Org Count AS_ORGCNT N 2

59 Depreciation Org Total % AS_ORGTP C 16

60 Depreciation Org Total % Req AS_ORGTPR N 8,4

61 Disposal Buyer AC_DISBYR C 16

62 Disposal Date AC_DISDAT D 8

63 Disposal Gain (or Loss) AC_DISGAIN N 12,2 999,999,999.99

64 Disposal Type AC_DISTYP C 1

65 First Fiscal Month AS_1STFM N 2 99

66 Freight PL_FRGT N 12,2 999,999,999.99

67 Freight in Basis AB_FRGT L 1 Y or N

68 Fund Number AS_FUNDNO C 15

69 General Ledger # AC1GLNUM C 15

70 General Ledger #2 AC1GLNUM2 C 15

71 General Ledger #3 AC1GLNUM3 C 15

72 Installation PL_INST N 12,2 999,999,999.99

73 Installation in Basis AB_INST L 1 Y or N

74 Inventory Comments COMMENTS C 30

75 Keep Components Together KEEPCPT L 1

76 Lease # PL_NUM C 20

77 Lease Accumulated Cost PL_ACCOST N 12,2 999,999,999.99

78 Lease Amount PL_LAMT N 12,2 999,999,999.99

79 Lease Calc Method PL_CMETH C 4 NONE
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80 Lease Duration(mo) PL_DUR N 4 9,999

81 Lease Ending Date PL_END D 8

82 Lease Factor PL_FACTOR N 7,5 9.99999

83 Lease Lessor PL_LESSOR C 25

84 Lease Payment/Month PL_LPYMT N 12,2 999,999,999.99

85 Lease Placed in Service Date PL_START D 8

86 Lease Revision Date PL_REVDAT D 8

87 Lease Year To Date Cost PL_YTD N 12,2 999,999,999.99

88 Log Add-Edit-Delete LOGAED C 1

89 Log Alias LOGALS C 8

90 Log Company Code LOGCOCODE C 8

91 Log Date LOGDATE D 8

92 Log Event Code LOGEVENT C 1

93 Log Time LOGTIME C 8

94 Log User LOGUSER C 3

95 Log Universal Datetime (UDT) LOGUDT T 8

96 Name OW_NAME C 20

97 New Or Used PL_NEWUSE C 1

98 Organization Code OW_ORG C 6

99 Ownership Method OW_METHOD C 5

100 Period # AC_PERCUR N 4 9,999

101 Period End Date AC_PEREDAT D 8

102 Period Start Date AC_PERSDAT D 8

103 Period Type AC_PERTYP C 10 Month

104 Periods Depreciated AC_NPDEP N 4 9,999

105 Periods Idle AC_NPIDL N 4 9,999

106 Periods Remaining AC_NPLEFT N 4 9,999

107 Prior Accumulated Depreciation AC_PADEP N 12,2 999,999,999.99
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108 Prior Bay O_XLO07 C 5

109 Prior Building O_BLDG C 5

110 Prior Comments O_NOTE C 30

111 Prior Cost per Unit O_CPERU N 12,2 999,999,999.99

112 Prior Floor O_FLOOR C 5

113 Prior Inventory Date O_MOVEDAT D 8

114 Prior Inventory Initials O_MOVEBY C 3

115 Prior Inventory Time O_MOVETIM C 6 99:99:99

116 Prior Label AS_NOOLD C 12

117 Prior Level O_XLO09 C 5

118 Prior Location Descrip. O_DESC C 30

119 Prior Location Type O_XLTYP C 8 SITE

120 Prior Name O_NAME C 20

121 Prior Organization Code POW_ORG C 6

122 Prior Periods Depreciated AC_PNPDEP N 4 9,999

123 Prior Periods Idle AC_PNPIDL N 4 9,999

124 Prior Periods Remaining AC_PNPLEFT N 4 9,999

125 Prior Quantity Added O_QTY N 9 99,999,999

126 Prior Region O_PRJREG C 2

127 Prior Remaining Book AC_PRBOOK N 12,2 999,999,999.99

128 Prior Room O_RM_AREA C 6

129 Prior Room Tag O_RM_TAG C 8

130 Prior Row O_XLO06 C 5

131 Prior Slot O_XLO08 C 5

132 Prior Tag Or Take O_TAGTAK C 7 "UNKNOWN"

133 Prior Vault O_XLO05 C 5

134 Prior Work Order # O_MOVENUM C 12

135 Purchase Cost PL_COST N 12,2 999,999,999.99
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136 Purchase Cost in Basis AB_COST L 1 Y or N

137 Purchase Date PL_DATE D 8

138 Purchase Order # PL_PO C 20

139 Quantity Of Assets AS_QTY N 9 999,999,999

140 Received Date PL_RECDAT D 8

141 Record Id RECID C 10

142 Record Id-Location History-Current L_RECID_LH C 10

143 Record Id-Location History-Prior O_RECID_LH C 10

144 Record Id-Location Reference-Current L_RECID_LO C 10

145 Record Id-Location Reference-Prior O_RECID_LO C 10

146 Remark #1 AC_DISRM1 C 40

147 Remark #2 AC_DISRM2 C 40

148 Remark #3 AC_DISRM3 C 40

149 Sales Value AC_SALAMT N 12,2 999,999,999.99

150 Salvage Value AC_DISAMT N 12,2 999,999,999.99

151 Salvage Value in Basis AB_DISAMT L 1 Y or N

152 Secondary # PRIOR_NO C 14

153 Serial # SERIAL_NO C 25

154 Status STATUS C 2

155 System # SY_NO C 12

156 Tax PL_TAX N 12,2 999,999,999.99

157 Tax in Basis AB_TAX L 1 Y or N

158 Telephone Number OW_T_NO C 14 (###)###-####:####

159 Total Cost PL_TOT N 12,2 999,999,999.99

160 Transfer Date AS_XFERD D 8

161 Transfer Depreciation AS_ACCDEP N 12,2 999,999,999.99

162 Use Depreciation History AC_USEDH L 1 Y or N

163 Use Half Year Averaging Convention AC_HYAC L 1 Y or N
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164 Vendor VENDOR C 16

165 Year To Date Depr. AC1YTD N 12,2 999,999,999.99

CATALOG TABLE (ALIAS CA)

No. Field Name Variable Name Type Field Length Comment

1 Additional Cost PL_ADD N 12,2 999,999,999.99

2 Attribute #1 ATTR_1 C 20

3 Attribute #2 ATTR_2 C 20

4 Attribute #3 ATTR_3 C 20

5 Attribute #4 ATTR_4 C 20

6 Attribute #5 ATTR_5 C 20

7 Attribute #6 ATTR_6 C 20

8 Attribute #7 ATTR_7 C 20

9 Autocalc Charge Per Unit CA_CALCMUP L 1 Y or N

10 Catalog Attribute Set ATTR_SET N 2 99

11 Catalog Category (xx) CAT_CODE C 2

12 Catalog Description DESC C 25

13 Catalog Number (9999) CAT_NUM C 4 9999

14 Catalog Type TYPE C 10

15 Charge per Unit CA_CPERU N 12,2 999,999,999.99

16 Comments required (in Transactions) CA_RQCMT L 1 Y or N

17 Default Depr. Life (mo) AC1DELIFE N 4

18 Default Depr. Method AC1DEPTYP C 5

19 Default Period Type AC_PERTYP C 10

20 Depth DEPTH C 7

21 Freight PL_FRGT N 12,2 999,999,999.99

22 Height HEIGHT C 7

23 Installation PL_INST N 12,2 999,999,999.99
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24 Log Add-Edit-Delete LOGAED C 1

25 Log Alias LOGALS C 8

26 Log Company Code LOGCOCODE C 8

27 Log Date LOGDATE D 8

28 Log Event Code LOGEVENT C 1

29 Log Time LOGTIME C 8

30 Log Universal Datetime (UDT) LOGUDT T 8

31 Log User LOGUSER C 3

32 Manufacturer MV_NAME C 16

33 Manufacturer Line MV_LINE C 20

34 Manufacturer Part No. MV_PARTNO C 20

35 Manufacturer Tag No. MV_TAGNO C 20

36 Mark up Percent CA_MUPCT N 8,4 999.9999

37 Purchase Cost PL_COST N 12,2 999,999,999.99

39 Record Id RECID C 10

39 Revision Date (last) REV_DATE D 8

40 Revision Initials REV_BY C 3

41 Tax PL_TAX N 12,2 999,999,999.99

42 Transaction Allowed Serial # Sizes CA_RQSERNO C 20

43 Transaction Comments required CA_RQCMT L 1 Y or N

44 Unit of Issue CA_UOFI C 5 EACH

45 Width/Radius WIDTH C 7

Import and Export Page 14-103



Import and Export

COMPANY TABLE (ALIAS CO)

No. Field Name Variable Name Type Field Length Comment

1 Add Month to Work Order # CO_WMNOM L 1 Y or N

2 Add Year to Work Order # CO_WMNOY L 1 Y or N

3 Additional Cost in Basis - Default Value AB_ADD L 1 Y or N

4 Allow CUSTOM Work Order screen CO_EDCCUS L 1 Y or N

5 Allow SHOPPING Work Order screen CO_EDCSHP L 1 Y or N

6 Allow STANDARD Work Order screen CO_EDCSTD L 1 Y or N

7 Allow fully blank locations CO_ABLOC L 1 Y or N

8 Asset # field length COM_ANL N 2 12

9 Asset #-Right Justify CO_ASNORJ L 1 Y or N

10 Asset #-Spaces To Zeroes CO_ASNOSZ L 1 Y or N

11 Asset Depr History-Default ON CO_ASDHON L 1 Y or N

12 Auto generate Org Codes CO_ORAUTO L 1 Y or N

13 Auxilliary Catalog Fields CO_AUX_CA M 4

14 Auxilliary Organization Fields CO_AUX_ORG M 4

15 Basis Checkboxes - Visible AB_BASVIS L 1 Y or N

16 Bay field length CO_KBAY N 2 5

17 Building field length CO_KBLDG N 2 5

18 Catalog Attribute field length CO_KATTR N 2 20

19 Catalog Code field length CO_KCCODE N 2 2

20 Catalog Number field length CO_KCNUM N 2 4

21 Catalog Units of Measure CO_UOFM C 7 INCHES

22 Catalog field length CO_KCANO N 2 6

23 Company Background Color CO_BCOLOR N 12

24 Company Code COMCODE C 8

25 Company Name COMNAME C 30
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26 Condition field length CO_KCOND N 2 2

27 Currency - Default Value CRNCY C 3 USD

28 Currency - Visible AB_CURNCY L 1 Y or N

29 Default Reserved Bill of Materials Filter RVM_FILTER M 4

30 Default to Half Year Averaging
Convention

AC_HYAC L 1 Y or N

31 Depr. Min Life (mo) DEP_ML N 4

32 Depr. Threshold DEP_TH N 12.2

33 Depreciation Method field length CO_KDMETH N 2 5

34 Email Address length CO_KEMAIL N 2 0

35 First Fiscal Month-Default CO_1STFMD N 2 1

36 Floor field length CO_KFLOOR N 2 5

37 Freight in Basis - Default Value AB_FRGT L 1 Y or N

38 Initialize Work Order with UserName CO_WMITNAM L 1 Y or N

39 Installation in Basis - Default Value AB_INST L 1 Y or N

40 Inventory Comments length CO_KASNOTE N 2 30

41 Last Synchronization Date CO_SLDATE D 8

42 Last Synchronization Time CO_SLTIME C 6 99:99:99

43 Lease # field length CO_KLEASE N 2 20

44 Length of Last Synchronization (minutes) CO_SLDUR N 4 9,999

45 Level field length CO_KLEVEL N 2 5

46 Location Type field length CO_KLOCTYP N 2 8

47 Log Add-Edit-Delete LOGAED C 1 ?

48 Log Alias LOGALS C 8

49 Log Company Code LOGCOCODE C 8

50 Log Date LOGDATE D 8

51 Log Event Code LOGEVENT C 1

52 Log Last Synchronization Only CO_SLLONLY L 1 Y or N
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53 Log Time LOGTIME C 8

54 Log Universal Datetime (UDT) LOGUDT T 8

55 Log User LOGUSER C 3

56 Manufacturer field length CO_KMVNAME N 2 16

57 Name Format NAME_ALG C 20

58 Name Validation NAM_VLDTN C 10

59 Sets Inventory Time on Add/Template CO_TRITIM L 1

60 Organization Code field length CO_KORG N 2 6

61 Owner Name length CO_KOWNAME N 2 20

62 Ownership Method field length CO_KOWMETH N 2 5

63 Plain Org Code CO_PLNORG L 1 Y or N

64 Prompt For Delete on Company Export CO_P4DOCE L 1 Y or N

65 Prompt for Work Order # CO_WMP4NO L 1 Y or N

66 Purchase Cost in Basis - Default Value AB_COST L 1 Y or N

67 Purchase Order # field length CO_KPONO N 2 20

68 Record Id RECID C 10

69 Region field length CO_KREG N 2 2

70 Reminder-About Restructure RMDSTRUC L 1

71 Reminder-About Restructure # of Week RMDSTRUCE N 2

72 Reminder-About Restructure Start Week RMDSTRUCB N 2

73 Require Print before moving Transactions CO_RPB4M L 1 Y or N

74 Room Tag field length COM_RTL N 2 8

75 Room Tag(s) to exclude for cost averaging CO_RTAVGX C 8 OUT%

76 Room field length CO_KROOM N 2 6

77 Round Calculated Currency CO_RNDMNY L 1 Y or N

78 Row field length CO_KROW N 2 5

79 Salvage Value in Basis - Default Value AB_DISAMT L 1 Y or N

80 Deprec. Split Among Org Codes Visable CO_ASDS L 1 Y or N
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81 Slot field length CO_KSLOT N 2 5

82 Status field length CO_KSTAT N 2 2

83 Strip Label Check Digit CO_STRIPCD L 1 Y or N

84 Strip Label Serial # Prefix CO_STRSER C 5

85 Synchronization Company #1 CO_SSDSN C 250

86 Synchronization Company #1 Sysuser
Folder

CO_SSSYSU C 250

87 Synchronization Company #2 CO_STDSN C 250

88 Synchronization Company #2 Sysuser
Folder

CO_STSYSU C 250

89 Synchronization Enabled CO_SACTIVE L 1 Y or N

90 Synchronization Frequency-Days CO_SFREQD N 2

91 Synchronization Frequency-Hours CO_SFREQH N 2

92 Synchronization Log CO_SLOG M 4

93 Synchronization Password #1 CO_SSPSWD C 20

94 Synchronization Password #2 CO_STPSWD C 20

95 Synchronization Start Date CO_SSDATE D 8

96 Synchronization Start Time CO_SSTIME C 6 99:99:99

97 Synchronization State CO_SSTATE C 13 Ready

98 Synchronization Table List CO_STABLES M 4

99 Synchronization User ID #1 CO_SSID C 20

100 Synchronization User ID #2 CO_STID C 20

101 Synchronize How Often CO_SFREQ C 12 Once

102 Synchronize When CO_SWHEN C 12 Now

103 Tax in Basis - Default Value AB_TAX L 1 Y or N

104 Telephone Input Mask CO_PHONMSK C 25 (###)###-####:####

105 Time Zone Shift (Hrs) CO_SSHIFT N 3

106 UPC Code field length CO_KUPC N 2 30

107 Use locations in locations-W.O. Shopping CO_WMLILO L 1 Y or N
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108 User ID length CO_KUSNO N 2 3

109 Valid Year - First CO_VYR1ST N 4 1920

110 Valid Year - Last CO_VYRLST N 4 2080

111 Validate Bay X_XLO07 L 1 Y or N

112 Validate Building X_BLDG L 1 Y or N

113 Validate Floor X_FLOOR L 1 Y or N

114 Validate Level X_XLO09 L 1 Y or N

115 Validate Region X_PRJREG L 1 Y or N

116 Validate Room X_RM_AREA L 1 Y or N

117 Validate Row X_XLO06 L 1 Y or N

118 Validate Slot X_XLO08 L 1 Y or N

119 Validate Vault X_XLO05 L 1 Y or N

120 Validate Work Order Bay WX_XLO07 L 1 Y or N

121 Validate Work Order Building WX_BLDG L 1 Y or N

122 Validate Work Order Floor WX_FLOOR L 1 Y or N

123 Validate Work Order Level WX_XLO09 L 1 Y or N

124 Validate Work Order Region WX_PRJREG L 1 Y or N

125 Validate Work Order Room WX_RM_AREA L 1 Y or N

126 Validate Work Order Row WX_XLO06 L 1 Y or N

127 Validate Work Order Slot WX_XLO08 L 1 Y or N

128 Validate Work Order Vault WX_XLO05 L 1 Y or N

129 Variable Asset Number Length CO_VANL L 1 Y or N

130 Variable Catalog Number Length CO_VCANUM L 1 Y or N

131 Variable Room Tag Length CO_VRTL L 1 Y or N

132 Vault field length CO_KVAULT N 2 5

133 Work Order # field length CO_KWRKO N 2 12

134 Z Asset bucket Auxiliary Fields CO_ZB M 4
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CONDITION TABLE (ALIAS CN)

No. Field Name Variable Name Type Field Length Comment

1 Condition Code CN_CODE C 2

2 Condition Description CN_DESC C 25

3 Condition Expression CN_EXPR C 4

4 Condition Reference CN_REF C 4

5 Log Add-Edit-Delete LOGAED C 1 ?

6 Log Alias LOGALS C 8

7 Log Date LOGDATE D 8

8 Log Event Code LOGEVENT C 1

9 Log Time LOGTIME C 8

10 Log Universal Datetime (UDT) LOGUDT T 8

11 Log User LOGUSER C 3

12 Record Id RECID C 10
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DEPRECIATION HISTORY TABLE (ALIAS DH)

No. Field Name Variable Name Type Field Length Comment

1 Accumulated Depreciation AC1ACC N 12,2 999,999,999.99

2 Archive Record Id ARCRECID C 10

3 Asset # ASSET_NO C 12

4 Book Value Remaining AC1RBOOKV N 12,2 999,999,999.99

5 Currency CRNCY C 3 USD

6 Depr. End Date AS_DEDAT D 8

7 Depr. Fully Depreciated AS_DEPCOM L 1 Y or N

8 Depr. Method AC1DEPTYP C 5

9 Depr. Monthly Amount AC1MODEP N 12,2 999,999,999.99

10 Fund Number AS_FUNDNO C 15

11 General Ledger # AC1GLNUM C 15

12 General Ledger #2 AC1GLNUM2 C 15

13 General Ledger #3 AC1GLNUM3 C 15

14 Log Add-Edit-Delete LOGAED C 1 ?

15 Log Alias LOGALS C 8

16 Log Date LOGDATE D 8

17 Log Event Code LOGEVENT C 1

18 Log Time LOGTIME C 8

19 Log Universal Datetime (UDT) LOGUDT T 8

20 Log User LOGUSER C 3

21 Master Record Record Id MASRECID C 10

22 Organization Code OW_ORG C 6

23 Period # AC_PERCUR N 4 9,999

24 Period End Date AC_PEREDAT D 8

25 Period Start Date AC_PERSDAT D 8

26 Period Type AC_PERTYP C 10 Month
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27 Periods Depreciated AC_NPDEP N 4 9,999

28 Periods Idle AC_NPIDL N 4 9,999

29 Periods Remaining AC_NPLEFT N 4 9,999

30 Prior Accumulated Depreciation AC_PADEP N 12,2 999,999,999.99

31 Prior Organization Code POW_ORG C 6

32 Prior Periods Depreciated AC_PNPDEP N 4 9,999

33 Prior Periods Idle AC_PNPIDL N 4 9,999

34 Prior Periods Remaining AC_PNPLEFT N 4 9,999

35 Prior Remaining Book AC_PRBOOK N 12,2 999,999,999.99

36 Record Id RECID C 10

37 Status STATUS C 2

38 Transfer Date AS_XFERD D 8

39 Transfer Depreciation AS_ACCDEP N 12,2 999,999,999.99

40 Year To Date Depr. AC1YTD N 12,2 999,999,999.99
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LEASE TABLE (ALIAS LE)

No. Field Name Variable Name Type Field Length Comment

1 Calc Method PL_CMETH C 4 NONE

2 Date Placed in Service PL_START D 8

3 Duration(mo) PL_DUR N 4 9,999

4 End Date PL_END D 8

5 Lease # PL_NUM C 20

6 Lease Factor PL_FACTOR N 7,5 9.99999

7 Lessor PL_LESSOR C 25

8 Log Add-Edit-Delete LOGAED C 1

9 Log Alias LOGALS C 8

10 Log Date LOGDATE D 8

11 Log Universal Datetime (UDT) LOGUDT T 8

12 Log Event Code LOGEVENT C 1

13 Log Time LOGTIME C 8

14 Log User LOGUSER C 3

15 Record Id RECID C 10

16 Total Cost PL_LTOT N 12,2 999,999,999.99

17 Total Payment/Month PL_LPYMT N 12,2 999,999,999.99
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LOCATION TABLE (ALIAS LO)

No. Field Name Variable Name Type Field Length Comment

1 Bay XLO07 C 5

2 Building BLDG C 5

3 Floor FLOOR C 5

4 Level XLO09 C 5

5 Location Description LOC_DESC C 30

6 Location Type XLTYP C 8 SITE

7 Log Add-Edit-Delete LOGAED C 1 ?

8 Log Alias LOGALS C 8

9 Log Date LOGDATE D 8

10 Log Event Code LOGEVENT C 1

11 Log Time LOGTIME C 8

12 Log Universal Datetime (UDT) LOGUDT T 8

13 Log User LOGUSER C 3

14 Record Id RECID C 10

15 Reference Organization OW_ORG C 6

16 Region PRJREG C 2

17 Room RM_AREA C 6

18 Room Tag RM_TAG C 8

19 Row XLO06 C 5

20 Slot XLO08 C 5

21 Square Footage SQFT N 7,2 9,999.99

22 Vault XLO05 C 5
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ASSET LOCATION HISTORY TABLE (ALIAS LH)

No. Field Name Variable Name Type Field Length Comment

1 Archive Record Id ARCRECID C 10

2 Asset # ASSET_NO C 12

3 Bay O_XLO07 C 5

4 Building O_BLDG C 5

5 Comments O_NOTE C 30

6 Cost per Unit O_CPERU N 12,2 999,999,999.99

7 Description O_DESC C 30

8 Floor O_FLOOR C 5

9 Handheld Computer File RDRFILE C 12

10 Handheld Computer File Record # RDRREC N 4

11 Handheld Computer ID RDRID C 50

12 Inventoried By O_MOVEBY C 3

13 Inventory Date O_MOVEDAT D 8

14 Inventory Time O_MOVETIM C 6 99:99:99

15 Level O_XLO09 C 5

16 Location Type O_XLTYP C 8 SITE

17 Log Add-Edit-Delete LOGAED C 1 ?

18 Log Alias LOGALS C 8

19 Log Date LOGDATE D 8

20 Log Event Code LOGEVENT C 1

21 Log Time LOGTIME C 8

22 Log Universal Datetime (UDT) LOG UDT D 8

23 Log User LOGUSER C 3

24 Master Record Record Id MASRECID C 10

25 Name O_NAME C 20

26 Quantity Added O_QTY N 9 999,999,999
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27 Record Id RECID C 10

28 Record Id-Location O_RECID_LO C 10

29 Record Id-Work Order Line Item O_RECID_WD C 10

30 Region O_PRJREG C 2

31 Room O_RM_AREA C 6

32 Room Tag O_RM_TAG C 8

33 Row O_XLO06 C 5

34 Slot O_XLO08 C 5

35 Tag Or Take TAGTAK C 7 "UNKNOWN"

36 Update Date UPDDATE D 8

37 Update Initials UPDUSNO C 3

38 Update Operation UPDOP C 1

39 Update Time UPDTIME C 8

40 Vault O_XLO05 C 5

41 Work Order # O_MOVENUM C 12
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MANUFACTURER TABLE (ALIAS MA)

No. Field Name Variable Name Type Field
Length

Comment

1 Alternate Address 1 MV_2ADDR1 C 25

2 Alternate Address 2 MV_2ADDR2 C 25

3 Alternate City MV_2CITY C 15

4 Alternate Fax/Telex MV_2FAX C 14 (###)###-####:####

5 Alternate State MV_2STAT C 2

6 Alternate Telephone MV_2TELE C 14 (###)###-####:####

7 Alternate Zip MV_2ZIP C 10

8 Catalog Category List MV_CATS C 60

9 Contact MV_CONTCT C 20

10 Contact Address 1 MV_1ADDR1 C 25

11 Contact Address 2 MV_1ADDR2 C 25

12 Contact City MV_1CITY C 15

13 Contact Fax/Telex MV_TELEX C 14 (###)###-####:####

14 Contact State MV_1STAT C 2

15 Contact Telephone MV_1TELE C 14 (###)###-####:####

16 Contact Zip MV_1ZIP C 10

17 Log Add-Edit-Delete LOGAED C 1 ?

18 Log Alias LOGALS C 8

19 Log Date LOGDATE D 8

20 Log Universal Datetime (UDT) LOGUDT T 8

21 Log Event Code LOGEVENT C 1

22 Log Time LOGTIME C 8

23 Log User LOGUSER C 3

24 Manufacturer MV_NAME C 16

25 Record Id RECID C 10
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ORGANIZATION TABLE (ALIAS ORG)

No. Field Name Variable Name Type Field Length Comment

1 Department OW_ORGL2 C 12

2 Division OW_ORGL1 C 12

3 Log Add-Edit-Delete LOGAED C 1 ?

4 Log Alias LOGALS C 8

5 Log Date LOGDATE D 8

6 Log Event Code LOGEVENT C 1

7 Log Time LOGTIME C 8

8 Log Universal Datetime (UDT) LOGUDT T 8

9 Log User LOGUSER C 3

10 Organization Code OW_ORG C 6

11 Record Id RECID C 10

12 Unit OW_ORGL3 C 12
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PERSONNEL TABLE (ALIAS PER)

No. Field Name Variable Name Type Field Length Comment

1 Current Bay L_XLO07 C 5

2 Current Building L_BLDG C 5

3 Current Floor L_FLOOR C 5

4 Current Level L_XLO09 C 5

5 Current Location Descrip. L_DESC C 30

6 Current Location Type L_XLTYP C 8

7 Current Region L_PRJREG C 2

8 Current Room L_RM_AREA C 6

9 Current Room Tag L_RM_TAG C 8

10 Current Row L_XLO06 C 5

11 Current Slot L_XLO08 C 5

12 Current Vault L_XLO05 C 5

13 Email Address PEREMAIL C 50

14 First Name F_NAME C 15

15 Full Name FULLNAME C 20

16 Initials INITS C 5

17 Last Name L_NAME C 15

18 Log Add-Edit-Delete LOGAED C 1

19 Log Alias LOGALS C 8

20 Log Company Code LOGCOCODE C 8

21 Log Date LOGDATE D 8

22 Log Event Code LOGEVENT C 1

23 Log Time LOGTIME C 8
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No. Field Name Variable Name Type Field Length Comment

24 Log Universal Datetime (UDT) LOGUDT T 8

25 Log User LOGUSER C 3

26 Middle Name M_NAME C 15

27 Organization Code OW_ORG C 6

28 Primary ID PRIID C 15

29 Record ID RECID C 10

30 Secondary ID SECID C 15

31 Telephone Number OW_T_NO C 14

32 Tertiary ID TERID C 15

33 Uniqueness Value UNIQER C 10
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STATUS TABLE (ALIAS ST)

No. Field Name Variable Name Type Field Length Comment

1 Log Add-Edit-Delete LOGAED C 1 ?

2 Log Alias LOGALS C 8

3 Log Date LOGDATE D 8

4 Log Event Code LOGEVENT C 1

5 Log Time LOGTIME C 8

6 Log Universal Datetime (UDT) LOGUDT T 8

7 Log User LOGUSER C 3

8 Record Id RECID C 10

9 Status Code ST_CODE C 2

10 Status Description ST_DESC C 25

11 Status Expression ST_EXPR C 4

12 Status Reference ST_REF C 4
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TRANSACTION TABLE (ALIAS TR)

No. Field Name Variable Name Type Field Length Comment

1 Asset # ASSET_NO C 12

2 Catalog Category (xx) CAT_CODE C 2

3 Catalog Number (9999) CAT_NUM C 4 9999

4 Company Code COMCODE C 8

5 Condition COND C 2

6 Cost per Unit TR_CPERU N 12,2 999,999,999.99

7 Current Bay L_XLO07 C 5

8 Current Building L_BLDG C 5

9 Current Floor L_FLOOR C 5

10 Current Level L_XLO09 C 5

11 Current Location Type L_XLTYP C 8 SITE

12 Current Region L_PRJREG C 2

13 Current Room L_RM_AREA C 6

14 Current Room Tag L_RM_TAG C 8

15 Current Row L_XLO06 C 5

16 Current Slot L_XLO08 C 5

17 Current Vault L_XLO05 C 5

18 Currently Accessible TR_ACCESS L 1 T for True

19 Errors treated as Warnings TR_E2W L 1

20 Handheld Computer File RDRFILE C 12

21 Handheld Computer File Record # RDRREC N 4

22 Handheld Computer ID RDRID C 50

23 Inventory Comments COMMENT C 30

24 Inventory Date INV_DATE D 8

25 Inventory Initials INV_BY C 3
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26 Inventory Time INV_TIME C 6 99:99:99

27 Log Add-Edit-Delete LOGAED C 1 ?

28 Log Alias LOGALS C 8

29 Log Date LOGDATE D 8

30 Log Universal Datetime (UDT) LOGUDT T 8

31 Log Event Code LOGEVENT C 1

32 Log Time LOGTIME C 8

33 Log User LOGUSER C 3

34 Name OW_NAME C 20

35 New Asset # NEW_RMAS C 12

36 Old Asset # RM_AS_GS C 12

37 On Hold HOLD L 1 Y or N

38 Organization Code OW_ORG C 6

39 Ownership Method OW_METHOD C 5

40 Printed PRINTED L 1 Y or N

41 Prior Bay O_XLO07 C 5

42 Prior Building O_BLDG C 5

43 Prior Floor O_FLOOR C 5

44 Prior Level O_XLO09 C 5

45 Prior Location Type O_XLTYP C 8 SITE

46 Prior Region O_PRJREG C 2

47 Prior Room O_RM_AREA C 6

48 Prior Room Tag O_RM_TAG C 8

49 Prior Row O_XLO06 C 5

50 Prior Slot O_XLO08 C 5

51 Prior Vault O_XLO05 C 5

52 Problem Indicator PROBLEM C 80
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53 Purchase Order # PL_PO C 20

54 Quantity Of Assets TR_QTY N 9 99,999,999

55 Reader File RDRFILE C 12

56 Reader File Record # RDRREC N 4 9,999

57 Reader ID RDRID C 36

58 Record Id RECID C 10

59 Replace Asset Label TR_REPAS L 1 Y or N

60 Reserved Bill of Material # RVNUM C 12

61 Secondary # PRIOR_NO C 14

62 Serial # SERIAL_NO C 25

63 Status STATUS C 2

64 System # SY_NO C 12

65 Tag Or Take TR_TAGTAK C 7 "UNKNOWN"

66 Telephone Number OW_T_NO C 14 (###)###-####:####

67 Transaction # TRANS_NUM C 3

68 UDF Reader Field #1 CUS_01 C 40

69 UDF Reader Field #2 CUS_02 C 40

70 UDF Reader Field #3 CUS_03 C 40

71 UDF Reader Field #4 CUS_04 C 40

72 Work Order # L_MOVENUM C 12
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UPC TABLE (ALIAS UPC)

No. Field Name Variable Name Type Field Length Comment

1 Catalog Category (xx) CAT_CODE C 2

2 Catalog Number (9999) CAT_NUM C 4 9999

3 Log Add-Edit-Delete LOGAED C 1 ?

4 Log Alias LOGALS C 8

5 Log Date LOGDATE D 8

6 Log Event Code LOGEVENT C 1

7 Log Time LOGTIME C 8

8 Log Universal Datetime (UDT) LOGUDT T 8

9 Log User LOGUSER C 3

10 Record Id RECID C 10

11 Upc Code UPC_NO C 30
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WORK ORDER DETAIL TABLE (ALIAS WD)

No. Field Name Variable Name Type Field Length Comment

1 Activity Date WD_ADATE D 8

2 Activity Time WD_ATIME C 6 99:99:99

3 Asset # ASSET_NO C 12

4 Catalog (xx9999) CA_NO C 6

5 Catalog Description WD_DESC C 25

6 Charge per Unit WD_CPERU N 12,2 999,999,999.99

7 Complete-Line Item COMPLETE L 1 Y or N

8 Date Qty Received Last Changed WD_RCVDD D 8

9 Deliver To Bay L_XLO07 C 5

10 Deliver To Building L_BLDG C 5

11 Deliver To Floor L_FLOOR C 5

12 Deliver To Level L_XLO09 C 5

13 Deliver To Location Type L_XLTYP C 8 SITE

14 Deliver To Region L_PRJREG C 2

15 Deliver To Room L_RM_AREA C 6

16 Deliver To Room Tag L_RM_TAG C 8

17 Deliver To Row L_XLO06 C 5

18 Deliver To Slot L_XLO08 C 5

19 Deliver To Vault L_XLO05 C 5

20 Hours-Actual WD_LHRSA N 12,2 999,999,999.99

21 Hours-Estimated WD_LHRSE N 12,2 999,999,999.99

22 Labor Cost-Actual WD_LCOSTA N 12,2 999,999,999.99

23 Labor Cost-Estimated WD_LCOSTE N 12,2 999,999,999.99

24 Labor Rate per hour WD_LRATE N 12,2 999,999,999.99

25 Line # L_LINENO C 3
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26 Line Item Note L_DESC C 60

27 Log Add-Edit-Delete LOGAED C 1 ?

28 Log Alias LOGALS C 8

29 Log Copied Line # LOGCITEM C 3

30 Log Date LOGDATE D 8

31 Log Date when first Added LOGDATEA D 8

32 Log Event Code LOGEVENT C 1

33 Log Note LOGNOTE C 10

34 Log Time LOGTIME C 8

35 Log Time when first Added LOGTIMEA C 8

36 Log User LOGUSER C 3

37 Log User when first Added LOGUSERA C 3

38 Log Universal Datetime (UDT) LOGUDT T 8

39 Master Record Record Id MASRECID C 10

40 Msg Displayed-Insufficient Qty WD_ENUFMSG L 1 Y or N

41 Purchase Order # PL_PO C 20

42 Quantity Received L_QTYRCVD N 10 999,999,999

43 Quantity Requested L_QTYRQST N 10 999,999,999

44 Quantity Reserved L_QTYRSVD N 10 999,999,999

45 Record Id RECID C 10

46 Ship From Bay O_XLO07 C 5

47 Ship From Building O_BLDG C 5

48 Ship From Floor O_FLOOR C 5

49 Ship From Level O_XLO09 C 5

50 Ship From Location Type O_XLTYP C 8 SITE

51 Ship From Region O_PRJREG C 2

52 Ship From Room O_RM_AREA C 6
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53 Ship From Room Tag O_RM_TAG C 8

54 Ship From Row O_XLO06 C 5

55 Ship From Slot O_XLO08 C 5

56 Ship From Vault O_XLO05 C 5

57 Supplies Cost-Actual WD_SUPLYA N 12,2 999,999,999.99

58 Supplies Cost-Estimated WD_SUPLYE N 12,2 999,999,999.99

59 Time Qty Received Last Changed WD_RCVDT C 8

60 Total Cost-Actual WD_TOTALA N 12,2 999,999,999.99

61 Total Cost-Estimated WD_TOTALE N 12,2 999,999,999.99

62 Unit of Issue WD_UOFI C 5

63 UPC code WD_UPCNO C 30

64 Work Order # L_MOVENUM C 12
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WORK ORDER MASTER TABLE (ALIAS WM)

No. Field Name Variable Name Type Field Length Comment

1 Account AC1GLNUM C 14

2 Assigned To WM_CREW C 20

3 Batch Operations-Allowed WM_BATOK L 1 Y or N

4 Batch Operations-Batch Id WM_BATID C 10

5 Batch Operations-Date WM_BATJD D 8

6 Batch Operations-Error Messages WM_BATERRM M 4

7 Batch Operations-On Hold WM_BATHOLD L 1 Y or N

8 Batch Operations-Operation Was Done WM_BATDONE L 1 Y or N

9 Batch Operations-Time WM_BATJT C 6 99:99:99

10 Batch Operations-Work Order Has Errors WM_BATERR L 1 Y or N

11 Complete-Whole Work Order COMPLETE L 1 Y or N

12 Completed By WM_BCMPLT C 20

13 Created-Work Order WM_CREATD L 1 Y or N

14 Date-Completed WM_DCMPLT D 8

15 Date-Created WM_DATE D 8

16 Date-Deliver To L_MOVEDAT D 8

17 Date-Follow Up WM_FUDATE D 8

18 Date-Printed WM_DPRN D 8

19 Date-Requested WM_RBDATE D 8

20 Deliver To Bay L_XLO07 C 5

21 Deliver To Building L_BLDG C 5

22 Deliver To Floor L_FLOOR C 5

23 Deliver To Level L_XLO09 C 5

24 Deliver To Location Type L_XLTYP C 8 SITE

25 Deliver To Org Code WM_DOWORG C 6
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26 Deliver To Region L_PRJREG C 2

27 Deliver To Room L_RM_AREA C 6

28 Deliver To Room Tag L_RM_TAG C 8

29 Deliver To Row L_XLO06 C 5

30 Deliver To Slot L_XLO08 C 5

31 Deliver To Vault L_XLO05 C 5

32 Dynamic Work Order WM_DYNAM L 1 Y or N

33 Edit Form EDITFORM C 10 STANDARD

34 Follow Up Notes WM_FOLLUP M 4

35 Hold WM_HOLD L 1 Y or N

36 Instructions/Notes WM_OTHER M 4

37 Log Add-Edit-Delete LOGAED C 1 ?

38 Log Alias LOGALS C 8

39 Log Copied Work Order LOGCITEM C 12

40 Log Date LOGDATE D 8

41 Log Event Code LOGEVENT C 1

42 Log Time LOGTIME C 8

43 Log Universal Datetime (UDT) LOGUDT T 8

44 Log User LOGUSER C 3

45 Manufacturer MV_NAME C 16

46 Name-Requested By OW_NAME C 20

47 Name-Taken By WM_TBNAME C 30

48 Organization Code OW_ORG C 6

49 Printed (work Order) PRINTED L 1 Y or N

50 Priority WM_WPNO C 2

51 Purchase Order # PL_PO C 20

52 Record Id RECID C 10

Import and Export Page 14-129



Import and Export

53 Requested By Bay WM_RXLO07 C 5

54 Requested By Building WM_RBLDG C 5

55 Requested By Floor WM_RFLOOR C 5

56 Requested By Level WM_RXLO09 C 5

57 Requested By Locatn Type WM_RXLTYP C 8 SITE

58 Requested By Region WM_RREG C 2

59 Requested By Room WM_RRM C 6

60 Requested By Room Tag WM_RRMTAG C 8

61 Requested By Row WM_RXLO06 C 5

62 Requested By Slot WM_RXLO08 C 5

63 Requested By Vault WM_RXLO05 C 5

64 Telephone Number OW_T_NO C 14 (###)###-####:####

65 Time-Completed WM_TCMPLT C 6 99:99:99

66 Time-Created WM_TBTIME C 6 99:99:99

67 Time-Follow Up WM_FUTIME C 6 99:99:99

68 Time-Printed WM_TPRN C 6 99:99:99

69 Work Order # L_MOVENUM C 12
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ACTIVITY LOG TABLES

The Activity Log Tables can be useful if you wish to select items that have
changed over time.  Their  structures are identical to their representative data table.

Instead of containing all records, the Activity Log tables only contain records for
items that have changed.  More than one entry for the same item can exist.

Since their structure is the same as their representative data, the structures are not
repeated here.
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SCRIPTING FEATURE

Introduction

Scripting functions are designed to help the Bar|Scan administrator control startup
settings and actions in a Bar|Scan initialization (.bini) file. The .bini file can
literally login, change some of the system’s default folder, perform some actions
(such as print a report or do an import), issue a message to the user then either turn
over control to them as normal or automatically logout. It can also force a logout
after a fixed time period of inactivity.

Overview

The Bar|Scan initialization file (.bini) can be used in two major scenarios.
A. All users will execute the instructions of a common .bini file.

B. Individual .bini files can be specified to perform specific actions (such as being
associated with a desktop shortcut).

Filenames

A. The default filename is BSYSPATH.BINI. Bar|Scan will look for this filename
in the same folder as the application file. If present, it will load it and run it.

B. Bar|Scan can also take a filename as a line item parameter. Line item parameters
can be specified in the COMMAND box (CMD for Windows XP, 2003 server and
Vista) or in shortcuts. These can be any legal filename and reside anywhere on
your computer or network as long as it is accessible.

For example, assume that you want to create a special operation set to be executed
each night. This you can do with Windows Task Scheduler. Since you want a
different set of operations to be done than what is normally done by your users you
must create a separate .bini file. In Task Scheduler there is a line to enter your
program, so you would enter c:\Bar|Scanw\Bar|Scanw.exe. For your argument you
would enter the path to the .bini file, such as c:\Bar|Scanw\users\bsyspath_mas.bini
(don’t use this path, but the actual path to your actual .bini file).
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In Windows, there is an actual text box to enter the argument, which is the fully
qualified path+filename of the .bini file.  If you have any spaces in the path or .bini
filename then you need to enclose it in quote marks.

                  e.g. C:\Barscanw\Barscanw.exe “m:\other folder\bsyspath.bini”

Interaction

There can be interaction between the desktop user and the scripting.  For example,
Bar|Scan will display the amount of time remaining to a shutdown because of user
inactivity as shown in the example below:

Contents

A. The bini file is structured similar to many initialization files. It is broken up into
major sections, with line item parameters or instructions within each section.

B. There are three major sections. Section titles are specified by a section name
enclosed in square brackets. No spaces are allowed and they must be uppercase.

i [LOGIN]
This section is where you specify the user initials and password.

ii. [PATHS]
This section is where you override system paths.
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iii. [ACTIONS]
This section is where you specify any startup processes that you want
performed before the user gets control.

C. [LOGIN]

i. The [LOGIN] section specifies the information needed to login to Bar|Scan.
ii. There are two parameters available. The parameter name is specified then
followed by an ‘=’ sign, then the value. Do not include the angle brackets (<>).
                     1. ID=<User Initials>
                     2. PASSWORD=<Password>
iii. For example:
                      [LOGIN]
                      ID=MAS
                    PASSWORD=MASTER

D. [PATHS]

i. The [PATHS] section is used to override the default paths used by Bar|Scan upon
startup and operation. For example, the SYSHOME path name redirects ALL paths
so that Bar|Scan will look for all of its system folders below the specified folder.
This is normally used to place the Bar|Scan executable program on a remote
workstation but have it look at a server for its system files. This increases remote
startup speed.
ii. There are several path names available. First specify the path name, then an
equal sign, then the new path.
                     1. SYSHOME=<newpath>
                     2. SYSUSER=<newpath>
                     3. SYSDBF=<newpath>
                     4. READER=<newpath>
                     5. TEMPLATE=<newpath>
                     6. TEMP=<newpath>
                     7. REPORTS=<newpath>
                     8. USER=<newpath>
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iii. With the exception of SYSHOME, the path name is the same as the Bar|Scan
system folder name that is being redirected. Note that SYSHOME needs to go first
if it is specified or else previously specified paths will be reset.

E. [ACTIONS]

i. The [ACTIONS] section specifies a set of operations to be performed upon
startup. There are a number of commands that can be used, so startup can be quite
extensive. This is especially useful if you want to have all users start up with a
common set of operations. For example, you can specify a startup message that all
users will see every time they login. Commands also have parameters to control
their operation. See the explanation of each command for how to use it and its
parameters.
ii. The following commands are available. Please note that all commands start with
the left angle bracket (greater than sign), this is part of the text of the command and
serves to differentiate it from the parameter lines. In alphabetical order they are:
                     1. >ENABLED
                     2. >GOTO
                     3. >IMPORT
                     4. >INACTIVITYTIMEOUT
                     5. >LABEL
                     6. >MOVE
                     7. >MSG
                     8. >OPEN COMPANY
                     9. >PACK

       10. >REINDEX
       11. >REPORT
       12. >RESTRUCTURE

                   13. >SHUTDOWN
                   14. >VALIDATE

iii. >ENABLED
1. This command, anywhere in the list of commands, will specify whether or not
the entire [ACTION] section is ignored. If enabled is true, commands in the
[ACTIONS] section are executed as specified. If enabled is false, no commands
are executed, the entire section is ignored. ENABLED TRUE is the default setting
if not present, causing all commands to be executed starting at the first command.
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2. This is a single line command. The format is:
                      >ENABLED TRUE
                      >ENABLED FALSE

iv. >GOTO
1. This command is paired with the LABEL command. A label name is specified
and control moves to the command immediately following the label.
2. This is a single line command. The format is:

                            >GOTO <labelname>

                     3. For example:

                            >GOTO ALLDONE
                            …<MISCELLANEOUS OPERATIONS>
                            >LABEL ALLDONE
                            >MSG All Operations have been completed.
v. >IMPORT
1. This command will perform the formatted import or export specified.
2. This is a multiline command. Each of the parameters should be on its own line.
It has two possible parameters. The first (NAME) is required.
          1. NAME=<EXACT NAME OF THE FORMATTED IMPORT/EXPORT>
        2. ONERROR=<label name>
3. For example: Assume you have a formatted import entitled ‘MY SPECIAL
IMPORT FROM MY HR SYSTEM’

>IMPORT
NAME=MY SPECIAL IMPORT FROM MY HR SYSTEM                           
ONERROR=BADIMPORT
>MSG “The import was successful.”
>GOTO Alldone
>LABEL BADIMPORT
>MSG “The import didn’t work”
>LABEL ALLDONE
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vi. >INACTIVITYTIMEOUT
1. This command sets the inactivity timeout. In other words, if Bar|Scan has no
user interaction for the specified number of minutes, Bar|Scan will attempt to
logoff and shutdown. There are some situations where this may not be possible.
Additionally, the timing is only approximate.
2. This is a multiline command. Each of the parameters should be on its own line.
It has one parameter. It is required.
                           1. MINUTES=<Number of minutes>
3. For example:
                            >MSG “Your station will logout after 30 minutes of inactivity”
                            >INACTIVITYTIMEOUT
                            MINUTES=30
                            >LABEL ALLDONE 
vii. >LABEL
1. This command gives a name to a location in your command list so that other
commands can jump to this location immediately, such as by using the GOTO
command or an ONERROR parameter.
2. This is a single line command. It’s format is as follows:

                           >GOTO <labelname>

3. For example, in the following script the MSG command will be skipped.

                            >GOTO ALLDONE
                            >MSG THIS LINE IS SKIPPED
                            >LABEL ALLDONE

viii. >MOVE 
1. This command MOVES assets from the Transaction table to the Asset table. 
2. This is a multiline command. Each of the parameters should be on its own line.
It has two possible parameters. By default ALL eligible assets are moved. If there
are any errors then none of them are moved (i.e., this is the same as progressive
commit being turned off). If you use the PARTIAL command, you can activate
partial moves (i.e., this is the same as progressive commit being turned on). In this
case, each transaction is moved independent of any errors in other transactions.
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a. ONERROR=<label name> 
b. PARTIAL=<TRUE or FALSE>
3. For example: Assume you have a company called ‘COMPANY.DBC’ 

>OPENCOMPANY 
DBC=C:\BARSCANW\COMPANY\COMPANY.DBC 
ONERROR=BADOPEN 
>MSG “The company opened successfully.” 
>MOVE
ONERROR=BADMOVE 
PARTIAL=TRUE
>GOTO Alldone 
>LABEL BADOPEN 
>MSG “The open didn’t work” 
>GOTO ALLDONE
>LABEL BADMOVE 
>MSG “The MOVE didn’t work” 
>LABEL ALLDONE 

viii. >MSG
1. This command issues a dialog that will be read by the user logging in. The user
will have to press the ‘Ok’ button to continue. The content of the message can be
anything that will fit on a single line of text. It is displayed ‘as is’. If you enclose
it in quotes the quote marks will also be displayed.
2. This is a single line command. Its format is as follows:

                      >MSG <MSG TO DISPLAY>

3. For example:

                       >MSG THIS DISPLAYS A DIALOG BOX WITH AN OK.
                          >MSG “THIS DISPLAYS THE ENCLOSING QUOTE MARKS” 

ix. >OPEN COMPANY
1. This command opens and sets the current company. Any command that logically
follow this one will be working on this company.
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2. This is a multiline command. Each of the parameters should be on its own line.
It has two possible parameters. The first (DBC) is required.
                           1. DBC=<Fully qualified name of the company .dbc file>
                           2. ONERROR=<label name>
3. For example: Assume you have a company called ‘COMPANY.DBC’

                            >OPENCOMPANY
                            DBC=C:\BARSCANW\COMPANY\COMPANY.DBC
                            ONERROR=BADOPEN
                            >MSG “The company opened successfully.”
                            >GOTO Alldone
                            >LABEL BADOPEN
                            >MSG “The open didn’t work”
                            >LABEL ALLDONE 
xi. >PACK 
1. This command packs all of the company tables. In other words, it removes
all of the items that have been deleted. (When an item is deleted in Bar|Scan, it is
still present but cannot be seen.). This command has an optional DBC parameter.
If specified, any command that logically follows this one will be working on the
new company. 
2. This is a multiline command. Each of the parameters should be on its own
line. It has two possible parameters. Both parameters are optional. 
a. DBC=<Fully qualified name of the company .dbc file> 
b. ONERROR=<label name> 
3. For example: Assume you have a company called 'COMPANY.DBC' 

>PACK 
DBC=C:\BARSCANW\COMPANY\COMPANY.DBC
ONERROR=BADPACK 
>MSG "The company was packed successfully."
>GOTO Alldone
>LABEL BADPACK
>MSG "The PACK didn't work"
>LABEL ALLDONE
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xii. >REINDEX 
1. This command Re-Indexes all of the company tables. This command has
an optional DBC parameter. If specified, any command that logically follows this
one will be working on the new company. 
2. This is a multiline command. Each of the parameters should be on its own
line. It has two possible parameters. Both parameters are optional. 
a. DBC=<Fully qualified name of the company .dbc file> 
b. ONERROR=<label name> 
3. For example: Assume you have a company called 'COMPANY.DBC' 

>REINDEX 
NDBC=C:\BARSCANW\COMPANY\COMPANY.DBC 
ONERROR=BADREINDEX 
>MSG "The company was reindexed successfully." 
>GOTO Alldone 
>LABEL BADREINDEX 
>MSG "The REINDEX didn't work" 
>LABEL ALLDONE

x. >REPORT
1. This command runs the specified report. Please note that the report must be
setup ahead of time to behave as desired. For example, if this startup is part of an
automated process, be sure that the report will not require any human interaction
such as a print preview or prompted filter.
2. This is a multiline command. Each of the parameters should be on its own line.
It has two possible parameters. The first (NAME) is required.
                           1. NAME=<Unique report name>
                           2. ONERROR=<label name>
3. For example: Assume you have a report called ‘MY REPORT’. If you are
running interactively the following would be ok.

                            >REPORT
                            NAME=MY REPORT
                            ONERROR=BADOPEN
                            >MSG “The report printed successfully.”
                            >GOTO Alldone
                            >LABEL BADOPEN
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                            >MSG “The report had a problem”
                            >LABEL ALLDONE 

xiv. >RESTRUCTURE 
1. This command performs a RESTURCTURE operation on all of the
company tables. This command has an optional DBC parameter. If specified, any
command that logically follows this one will be working on the new company. 
2. IMPORTANT: The Restructure is performed as it is when doing a
Restructure from the Table Integrity screen when Verification of Tables is NOT
checked. When Restructuring, it is always possible that something will come up
that requires human intervention. There are several operations that require human
intervention, such as when a table needs to be created. If this happens, the
restructure operation will pause waiting for human interaction. 
3. This is a multiline command. Each of the parameters should be on its own
line. It has two possible parameters. Both parameters are optional. 
a. DBC=<Fully qualified name of the company .dbc file> 
b. ONERROR=<label name> 
4. For example: Assume you have a company called 'COMPANY.DBC' 

>RESTRUCTURE 
DBC=C:\BARSCANW\COMPANY\COMPANY.DBC 
ONERROR=BADRESTRUCTURE 
>MSG "The company was restructured successfully." 
>GOTO Alldone 
>LABEL BADRESTRUCTURE 
>MSG "The Restructure didn't work" 
>LABEL ALLDONE

xi. >SHUTDOWN
1. This command attempts to perform an immediate logoff and shutdown. It must
be understood that there are some circumstances where it will not be able to do so,
for example, during a currently running operation.
2. This command is a single line command without any parameters.
3. For example, assume that an automated process is desired to be run every night.
Windows can start Bar|Scan at the desired time. It might run the following startup
script.
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This script will open the target company, perform an import, print a report on what
was imported, then exit.

                     >OPEN COMPANY
                     DBC=C:\BARSCANW\COMPANY\COMPANY.DBC
                     ONERROR=HADAPROBLEM
                     >IMPORT
                    NAME=MAINFRAME IMPORT
                    ONERROR=HADAPROBLEM
                    >REPORT
                    NAME=LIST OF ITEMS IMPORTED OVERNIGHT
                    ONERROR=HADAPROBLEM
                    >GOTO ALLDONE
                    >LABEL HADAPROBLEM
                     >MSG WARNING. OVERNIGHT PROCESS HAD A PROBLEM.
                    >LABEL ALLDONE 

xvi. >VALIDATE 
1. This command validates assets in the Transaction table to prepare them for
movement to the Asset table. 
2. This is a multiline command. Each of the parameters should be on its own
line. It has one possible parameter. 
a. ONERROR=<label name> 
3. For example: Assume you have a company called ‘COMPANY.DBC’ 

>OPENCOMPANY 
DBC=C:\BARSCANW\COMPANY\COMPANY.DBC 
ONERROR=BADOPEN 
>MSG “The company opened successfully.” 
>VALIDATE
ONERROR=BADVALIDATE 
>MOVE
ONERROR=BADMOVE 
>GOTO Alldone 
>LABEL BADOPEN 
>MSG “The open didn’t work” 
>GOTO ALLDONE
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>LABEL BADMOVE 
>MSG “The MOVE didn’t work” 
>LABEL BADVALIDATE 
>MSG “The VALIDATE didn’t work” 
>LABEL ALLDONE 

Samples

The following are some sample scripts. Please note that some of the parameter
values may continue on to the next line, but in reality they must all be on a single
line.
a. Sample #1
            [ACTIONS]
            This script will issue a message to all users logging in.

            >MSG MESSAGE TO ALL USERS. DON’T FORGET TO LOGOUT
BEFORE GOING HOME.

b. Sample #2
            [ACTIONS]
This script will issue a message to the user starting Bar|Scan, force them to use a
specific company, then set an inactivity timeout just in case they don’t logout at
night.

            >OPEN COMPANY
            DBC=C:\BARSCANW\COMPANY\COMPANY.DBC
            ONERROR=HADAPROBLEM
            >INACTIVITYTIMEOUT
            MINUTES=30
            >MSG Until further notice, all users must use the COMPANY company.
            >LABEL ALLDONE

c. Sample #3
This script will LOGIN, open the target company, perform an import print a report
on what was imported, then exit. If there was a problem it will display a dialog box
and sit there until someone notices it.
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            [LOGIN]
            ID=MAS
            PASSWORD=MASTER
            [ACTIONS]
            >OPEN COMPANY
            DBC=C:\BARSCANW\COMPANY\COMPANY.DBC
            ONERROR=HADAPROBLEM
            >IMPORT
            NAME=MAINFRAME IMPORT
            ONERROR=HADAPROBLEM
            >REPORT
            NAME=LIST OF ITEMS IMPORTED OVERNIGHT
            ONERROR=HADAPROBLEM
            >GOTO ALLDONE
            >LABEL HADAPROBLEM
            >MSG WARNING. OVERNIGHT PROCESS HAD A PROBLEM.
            >LABEL ALLDONE

d. Sample #4
This script will LOGIN, open a company, then restructure it, pack and reindex (full
Table Integrity), then logout. 

[LOGIN] 
ID=MAS 
PASSWORD=MASTER 
[ACTIONS] 
>OPEN COMPANY 
DBC=C:\BARSCANW\COMPANY\COMPANY.DBC 
ONERROR=HADAPROBLEM 
>RESTRUCTURE
>PACK
>REINDEX
>GOTO ALLDONE
>LABEL HADAPROBLEM
>MSG WARNING. UNABLE TO OPEN COMPANY FOR PACK, ETC.
>LABEL ALLDONE 
>SHUTDOWN
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How to Use the Task Scheduler

Bar|Scan Scripting is designed to work with the Windows Task scheduler to handle
the timing of the startup. Note that there are two ways to use the task scheduler.

Begin by launching Tash Scheduler.  The Task Scheduler desktop application
should appear as shown below.
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Under ‘Actions’ , select ‘Create Basic Task’.  You can also use ‘Create Task’ if
you want more control over the options.  This will guide you through all of the
field that you need to fill out. Select the ‘Next’ button when you are done with
each screen.

Specify the Bar|Scan program without putting in any arguments. i.e.,
“C:\BarScanw\BarScanw.exe” in the ‘Program/script” field, and nothing in the
‘Add arguments(optional)” field. In this case the barscanw.exe program
automatically looks for the file “bsyspath.bini” in its same folder. If found, it will
execute its contents.  For example, the schedule panels specifying the program and
arguments might look like this: 
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In this case the full path to the .bini file is specified, “c:\barscanw\bsyspath.bini”,
in the Bar|Scan folder.

Other supported versions of Windows can do the same thing, but their entry fields
vary a bit.

Note that it is important that the path for ‘Start in’ be specified and be the same
path specified (without the filename) under ‘Program/script’.

You can also have multiple .bini files, all with different names. For example: 

MidnightOrgImport.bini 
Bsyspath.bini 
NightlyReport.bini

Each of these would have to have its own startup scheduled in windows, and each
of these files would perform their own expected actions.

For example, here is a script that runs a report. If the Windows Task scheduler
‘argument’ points to this file, then the report will be run whenever the scheduler
says it should.
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[LOGIN]

ID=MAS

PASSWORD=MASTER

[ACTIONS]

>Enabled=TRUE

>OPENCOMPANY

dbc=C:\BarScanw\DEMOCO\DEMOCO.DBC 

>REPORT 

NAME=SAMPLE ASSET DEPRECIATION SPLIT

BETWEEN ORGANIZATIONS 

>GOTO ALLDONE 

>LABEL ALLDONE 

>SHUTDOWN
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INTRODUCTION

Work Order Feature

The Work Order feature provides you with a high level of control over your list
of assets.  Work Orders generated by Bar|Scan, in conjunction with the Mobile
Device, allow you to control both the movement of your assets as well as their
cost, repair, and scheduled pick-up or delivery.

The Work Order feature allows you to place orders for various assets either
specifically, by asset number, or generally, by catalog.  Each Work Order has a
unique number, the name and telephone number of the person requesting the
order, crew assigned the task, the division, department and unit to charge, deliver
to location, and notes/instructions regarding the order.

As the Work Order is filled, each asset is then scanned with its related Work
Order number by the Mobile Device.  When this information is synchronized with
the Bar|Scan desktop and the assets are moved to the Asset table, Work Order
status is updated.  If all items on the Work Order are completed, the Work Order
status is set to completed.  The Work Order status will also identify what portion,
if any, is still incomplete.

There is a set of videos on our website that can provide you with additional in
operating Bar|Scan.  These are titled Quickstart Overview Videos and can be
found on this page: https://www.barscan.com/support-videos

Please consider viewing or downloading these as part of your learning experience.

The Work Order feature of Bar|Scan provides you with the ability to enter new
Work Orders, view selected Work Orders or groups of Work Orders, change
existing information on a Work Order, and remove a Work Order.

You can also use the Work Order Templates Panel to create recurring Work
Orders such as monthly scheduled work.
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Component Feature

Optionally, you can use a set of features to allow you to create, modify and move
groups of assets by selecting them using both a Catalog Component List or an
Asset Bill of Materials (BOM) List.  

With these features, you can move these groups as a whole, perform work on
these groups by means of a Work Order, reserve the components of these groups
by means of a Reserved Bill Of Material so that they will not be available for use
to build other groups or be moved to other locations.

You can also create Bar|Scan reports detailing these special catalogs, assets, and
components and their relationship.

Catalog Components, Asset Bill of Materials, Reserved Bill Of Materials and
Reporting are all discussed in more detail in the following sections.

Important: In order to get maximum utilization from the Work Order feature, you
must tag your assets and build your asset file prior to implementation of Work
Orders.  It would be difficult to receive and process orders for assets if they were
not yet in your asset table.  The original entry of new assets into the system is
usually accomplished using the Mobile Device.
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RESERVED BILL OF MATERIALS

The Reserved Bill of Materials is optional.  A Work Order does not require the
use of the Reserved Bill of Materials.

The Reserved Bill Of Material is used so that assets will not be available for use
to build other groups or be moved to other locations.

When you want to view, change, add, or delete Reserved Bill of Materials you
will need to open the Reserved Bill of Materials table.  From the Main Menu,
select File, then Open ...<, then Work Orders...<, then Reserved Bill of Materials.

You are now presented with the Reserved Bill of Materials Screen similar to the
one below.
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When you want to see the detailed information that has been entered into the
Reserved Bill of Materials table, you will need to select the Edit tab.  When you
do, you will be shown a screen similar to the one below.

There is a fixed area at the top, two tabs as well as an area for Line Items.

The Reservation Number is not auto generated, you must enter this number.  The
Reserved Bill of Materials cannot be saved without a number.  The Completed
and Released items are auto generated.

The Filter Tab is very important.  It contains the criteria that Bar|Scan must follow
when selecting the assets to fulfill the reservations.  In the above example, only
assets currently located in Building 500 can be used to fulfill the Reservation.  In
other words, if your warehouse is designated as ‘500', only items in your
warehouse can be reserved.  This is shown in the example below.
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Items are Assets or Quantity items from your Asset Table.  They can be entered
individually.  If you Add an Asset that has Asset Components, these will
automatically be entered when you add the Asset.  A column titled ‘Master Item’
identifies whether the added Asset was entered individually or because it was
added automatically as an Asset Component.

Line Item available for selection can be filtered as in the example above.  Filters
can be any criteria, e.g. only items in your warehouse location such as Building
= ‘WHSE’.

Asset Components cannot be deleted from the Line Items list.  Only assets with
the Master Item check mark can be deleted.  You cannot delete a component asset. 
When a Master Item is deleted then all of its components will also be deleted.

When you have created a Reserved Bill of Materials, you can have a Work Order
automatically created for your assets so that they may be pulled, shipped or moved
as a group.  To begin this process, you must Range the appropriate Reservation
Numbers.  Keep in mind that by resorting the Browse Panel columns using the Set
Command, you quickly select a large Range.
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When the Reserved Bill of Materials Table is open, a new item will appear
between the Panel and the Help Features on the Main Menu as shown below.
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PROCESSING WORK ORDERS

When you want to access the Work Order feature, simply go to the Main Menu,
and select File ...<, Open ...<, Work Orders as shown below.

Or, if you have selected the table icons to appear on your Main Menu, you can
simply click on the Work Order table icon which is shown below.
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When you select Work Orders from the Main Menu, a Browse panel similar to the
following appears.

When the Work Order table is first opened, you will not have any Work Orders
listed, but you can add your first one by selecting the Add Blank button from the
tool bar.  

We have entered several Work Orders as examples.  Once you have at least one
Work Order entered into your Bar|Scan system, you can add more Work Orders
by selecting the Add Template button from the tool bar. 
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THE SET BUTTON

On the Work Order table, the Browse panel is selected by default.  The Work
Order information on the Browse panel can be sorted by any field.  Place your
cursor in the first column on the left, and then press your right mouse button, and
select the Order By that will pop-up, or select the Set button on the tool bar as
shown below.

This feature will give you the ability to look at all of the Work Orders, pre sorted
the way you specify.  If you do not specify another sort, the default sort is by
Work Order number.

CREATING AN ORDER AND FILTER

The SET feature allows you to order and identify a smaller, more manageable
group of Work Orders from which to select, e.g., only those Work Orders that are
not closed, or sort them by Work Order number, etc.

As the number of Work Orders on your system increases, it becomes more time
consuming to look through the entire list on a look up window.

SET permits you to “order” your Work Orders by any item in the table.  This
makes it easier to find information on the Work Orders.

Because SET offers almost endless possibilities for identifying groups of Work
Orders, we strongly recommend that you experiment with different specifications
to become familiar with this feature.  Experimentation with SET will NOT cause
any change to the information recorded for any Work Order.  It merely specifies
the sequence of Work Order selection lists.
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When you want to view your Work Orders sorted by any field other than the
default, select the Set button from the tool bar.

This button activates the Set feature, and the following screen will appear.

This Set Order and Filter tab, shows a list of Sets that are pre defined in the
Bar|Scan system.  You can, however, define additional Sets.  Simply click on the
Add/Change/Delete button shown above, and the Sets table will open.  

SET permits you to define a "filter" which will reject the Work Orders which do
not meet your specifications.

Further, you can define a "range" for a filter item by selecting and marking a block
when you are presented the list.
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Finally, you can identify more than one filter and/or range to further reduce the
number of Work Orders to search.

Because SET offers almost endless possibilities for identifying groups of Work
Orders, we strongly recommend that you experiment with different specifications
to become familiar with this feature.  Experimentation with SET will NOT cause
any change to the information recorded for any Work Order.  It merely specifies
the amount and the sequence of Work Order selection lists.

However, if you would like to browse the fields that are available for the
predefined Sets, add a field, or remove a field, select the Browse Fields tab.
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When you select the Browse Fields tab, you will be shown the following screen.

On the left side of this screen there is a list of all of the available fields for the
Work Order table that you may display on your browse tab.  On the right side of
this Browse Fields tab, you will see the current fields that are displayed for each
Set.  These fields are displayed for all of the different Sets, with the Set pertaining
to only the column by which the list is sorted.  Respectively, each individual Set
can have a filter set up to filter out items that you do not wish to see.

The Set feature is a powerful tool, and should be experimented with.  Notice that
the items that are chosen to be displayed from the right side of the above screen
can be moved to any order you desire while being displayed.  
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WORKING WITH WORK ORDERS

The tool bar at the bottom of the Work Order table is displayed below.

You may press the PgDn key, or the Next Item button to view the next Work
Order from the selection list. The PgUp key or the Prior Item button will display
the previous Work Order.  Ctrl  + Home key combination or the First Item button
will display the first Work Order on the selection list,  and the Ctrl + End key
combination or the Last Item button will display the last.  

You may use any of the following: Add Blank, Add Template, Delete the Selected
Item, Save Selected Items, and the Cancel Changes on the Edit tab.

Shopping Screen

The last item shown on the Work Order table tool bar says Shopping, and has a
down arrow next to it.  It is displayed below.

For most of our customers, this item can remain at the default. But, by pressing
the down arrow, you will see the words Shopping.  This item is used mainly by
retail or warehouse check-out areas.  We will cover the Shopping Screen in more
detail later in this Chapter.

Work Orders Page 15-13



Work Orders

ENTERING A NEW WORK ORDER

You may need to add Work Orders to your Bar|Scan system on an ongoing basis. 
In order to add a Work Order, you may select the Add Blank Item or the Add
Template Item button from the tool bar.  

If you are using the Work Order Templates, then you can also Generate a Work
Order from a Template as shown below.

If you generate from a template, you will see the following dialog:
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What is the difference between Add Blank Item, and Add Template Item?  You
need to select Add Blank, for your first Work Order entry, as you will not have
any Work Orders to use for a template.  If you choose Add Blank Item, and then
select the Edit panel, you will be shown the Work Order panel and with no
information displayed in any of the entry fields except for the Created Date as
shown below.

Adding from a template Work Order is a time saver.  Often you can choose a
Work Order of a like item for your template, and only have to change the
information that is different for your new item.
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If on the Browse panel, move through the list of Work Orders until you find the
Work Order that you wish to use for a Template.  When the desired Work Order
is found, move the highlight bar over it and press ENTER or click on the Work
Order with your mouse.  Select the Add Template Item, and then select the Edit
tab.

You will see all of the information that has been entered for this Work Order. 
Simply change all of the fields to match the information for your new Work
Order, and Save the new Work Order.  

You may choose Add Blank Item or Add Template Item from the Edit Screen
without returning to the Browse screen.  

You may use the arrow keys, the TAB key, the mouse, or the ENTER key to move
to the different items on the screen.  The PgUp and PgDn keys, as well as the
Previous Item and Next Item buttons, will display information from the previous
or next Work Orders respectively.

The Work Order is where individual asset requests are entered.  You can enter an
unlimited number of individual asset requests on each Work Order.  You can also
produce a Work Order without asset requests.  

Many of the entry items have associated look up windows to assist you with your
entry.  The following section will describe each item on the Work Order Edit
panel and the associated look up windows.
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When we have selected a Work Order from the Browse panel, and clicked on the
Edit tab, you will see the following panel.

The Edit tab has six tabs of its own.  The first of these five tabs, the Master tab,
opens as the default, and is displayed above.

The top of the panel and the line items are separate from the tabs, and will be
shown no matter which of the three tabs you choose.  The top of the Edit tab is
shown below.
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Work Order Number

A unique Work Order Number is required for each Work Order entered into the
Bar|Scan system.

The number is automatically generated when you save the Work Order. 
Alternatively, you can enter your own Work Order number.  In most cases it is
easier to let Bar|Scan generate the Work Order number for you.

The Work Order number can be printed in bar code form on your Work Order
report for scanning with the Mobile Device.

After you have selected a similar Work Order for display, the cursor will be
positioned for you to enter the new Work Order number.

When you right click with your mouse on the Work Order number field or press
F5, select Look up Value, and a Look up List similar to the one below will appear.

Bar|Scan is designed to monitor the new Work Order number as you enter it to
make sure you do not duplicate an existing number.  Most often, you will be
entering a Work Order number which is similar to an existing number.  This is
because most new Work Order numbers are assigned sequentially, i.e., the next
Work Order number assigned will differ only in the last one or two digits.

By default, Bar|Scan will set the Work Order Number to be the same number of
digits as your asset number.
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Assigned

This is to whom the Work Order is assigned to.  Normally this is the crew, team,
or individual who will actually perform the tasks entered on the Work Order. 
Since it is an optional item, it can also be left blank.

Enter Assigned by moving the cursor to the entry,  type in the characters and press
the TAB key.

Printed

These items identify when the Work Order was printed.  It consists of three parts,
Printed Yes or No, the date printed, and the time printed.

In most cases, you will not want to enter information here unless you wish to
reprint the Work Order, and even then, only if you are using printed as a filter on
your report.

When you print a new Work Order, Bar|Scan automatically enters these fields. 
Printed is set to Yes and the date and time are taken from the date and time of
your computer.  These can, however, be manually changed by you.

If you wish to change these items, move the cursor to the entry, type in the
characters and press the TAB key.

Completed

These items identify when the Work Order was completed.  It consists of three
parts, Completed Yes or No, the date completed, and the time completed.

In most cases, you will not want to enter information here unless you wish to
change the Work Order.

When you synchronize the Mobile Device, validate the Transaction Table and
move the assets to the Asset Table, Bar|Scan then completes each line item
(discussed later) if the assets were properly scanned.  The Work Order is changed
to Completed when all of the line items on the Work Order are set to Completed. 
Completed is set to Yes and the date and time are taken from the date and time of
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your computer when the last line item is completed.  Completed can, however, be
manually changed by you.  For example, you will want to change the Work Order
to not completed if you wish to reprint the Work Order after the Mobile Device
synchronization.

If you wish to change these items, move the cursor to the entry, type the characters
and press the TAB key.

Line Items Screen Size

The Edit Screen has three areas, the Top Panel, the Tab Area, and the Line Items. 
The line items area can be adjusted to suit your requirements by placing your
mouse on the line between the Tab Area and the Line Items.  You can then move
the Line Items area up or down while holding your mouse button down.

If you typically enter many line items for each Work Order, you might find it
useful to increase the area for your work.  Below is an example of moving the
Line Items area up to display a larger area for data entry.
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THE MASTER TAB

Taken By

This item identifies a person or group that documented, “took” the Work Order
request or call, and entered the Work Order information into Bar|Scan.  Since it
is an optional item, it can be left blank.

Enter Taken By, by moving the cursor to the entry,  typing the characters and
pressing the TAB key. 

Account

Your company may control work through the use of billing or customer account
numbers.  If the Work Order is to be charged to an account number, you can add
it here.

Remember that there is only one account number for each Work Order.  If the
Work Order has several line items that may be charged to more than one account,
you may wish to create more than one Work Order.  Since it is an optional item,
it can also be left blank.

Enter Account by moving the cursor to the entry,  type in the characters and press
the TAB key.

Priority

This is the relative priority or importance of performing the tasks on the Work
Order.  Normally a letter or numbering scheme is used.  For example, an ‘A’
priority could mean that the Work Order needs to be done immediately, a ‘B’
could mean that the Work Order needs to be done in no more than four hours, etc. 
Since it is an optional item, it can also be left blank.

Enter Priority by moving the cursor to the entry,  type in the characters and press
the TAB key.
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Purchase Order Number

This item identifies a Purchase Order associated with the Work Order request. 
Since it is an optional item, it can be left blank.

Enter a Purchase Order by moving the cursor to the entry,  typing the characters
and pressing the TAB key. 

Manufacturer

This item identifies a Manufacturer associated with the Work Order request.  Do
not use this field if the Work Order contains many line items associated with
different manufacturers.  You can also click on the Manufacturer hyper-link to
open the Manufacturer Table for reference.  Since it is an optional item, it can be
left blank.

Enter the Manufacturer, by moving the cursor to the entry,  typing the characters,
or selecting a Look-up and pressing the TAB key. 

Created

These items identify when the Work Order was created.  It consists of three parts,
Created Yes or No, the date created, and the time created.

When you create a new Work Order, Bar|Scan automatically enters these fields. 
Created is set to Yes and the date and time are taken from the date and time of
your computer.  These can, however, be manually changed by you.

If you wish to change these items, move the cursor to the entry, type in the
characters and press the TAB key.

Completed By

This is also an optional field, but can be used to keep track of who actually
completed the work for each Work Order.
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Dynamic Work Order

You may not know in advance which assets (or catalogs) will be required to fill
the Work Order.  In this case, you can click on the Dynamic Work Order box and
leave the line items blank.  Any assets scanned in the Mobile Device with the
corresponding Work Order number that is a Dynamic Work Order will be placed
into the line item fields when they are uploaded.  Normally, the line items are
considered complete after one Mobile Device is uploaded.   This can also be
changed (see Hold Entire Work Order below).  Dynamic Work Orders can be very
useful both in Standard and Shopping mode.  You can also “mix and match”, that
is you can add line items in advance as well as use the Dynamic Work Order box.

Hold Entire Work Order

You may wish to keep a Work Order from being completed even though all the
line items have been completed.  For example, in the Dynamic Work Order
example above, you may need to synchronize a second Mobile Device.  Click on
the Hold Entire Work Order box to do this.

The bottom of the Edit panel displays the line items, and their details.

Line Items

Each Line Item refers to one or more assets requiring action.  These assets are
scanned with the Mobile Device.  The Work Order Number prompt in the Mobile
Device is used to record the Work Order Number associated with each Asset and
must be turned on.  For more information in the Work Order Number Prompt in
the Mobile Device, refer to Chapter 11 - Bar|Scan Mobile.

Work Orders are normally completed when assets scanned with the Mobile
Device are synchronized and successfully moved from the Transaction Table to
the Asset Table.  Work Orders are not affected simply by synchronizing the
Mobile Device.
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Inserting and Deleting Line Items

When you select the Edit tab, the Work Order line items will be displayed.  There
is no limit to the number of line items that can be added to a Work Order.  Line
items can be a combination of different assets or catalogs.

To add new line items, press the Add Blank or the Add Template button.  The
system will automatically supply a line number.  There are two basic types of line
items which can be entered -- a quantity of items by catalog, or a specific asset by
asset number.

You could create line items by catalog if you were not concerned about specific
assets, but rather, only that the correct type of asset was moved or delivered.

As the Work Order is filled, each asset is scanned with its related Work Order
Number using the Mobile Device.  When this information is uploaded to Bar|Scan
and moved from the Transaction table to the Asset table, it automatically updates
the Work Order Line Items Display Screen identifying what portion, if any, is still
incomplete.

To delete a line item, place your cursor on the line item, and select the delete
button.
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When items are requested by quantity and catalog number, the system compares
the asset scanned to the line items by catalog number to determine which line item
to update.  The system then checks whether the current location matches the
deliver to location on the Master Work Order panel.  If it matches, the system
increases the Quantity Received total by 1 and if the Quantity Received matches
the Quantity Requested, it updates the line item as Complete as shown below.

Important: Even though we have the option of selecting assets by quantity, this is
different from configuring the Mobile Device to use the Quantity Prompt.  Do not
configure the Mobile Device for Quantity in order to use this feature.

When you are completing the Work Order line items by Catalog, you have the
ability to access the Catalog table information by placing your cursor on the
Catalog field, and then right clicking and selecting Look Up Value.  You will see
a Look up Window similar to the one below.

You have the ability to look for and select a catalog from this Look up Window.
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When you have selected a Catalog, you can then go to the Asset number column,
and right click on that field.  You will see a list of assets that are the same Catalog
as the one you selected in the Catalog column. 

This can be extremely helpful, as you can use the scroll bars to view the rest of the
information about these assets, such as where they are located, if not already
displayed.

Remember, if the columns that you need to see in the look up window are not
displayed, you can scroll to find them, and then move them as was done in the
above look up in order for the location columns to show.  To move a column,
click on the highlighted title for each column.  When the cursor turns to a black
downward arrow,  continue to hold the mouse button down, and drag the column
to the right or left.
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Line items can be ordered by Asset number alone, without filling out the Catalog
information.  When this method is chosen, you still have the ability to right click
on the Asset number column.  However, the list of assets that will be shown
includes all of the Assets, not just those using a specific Catalog, as shown below.

When items are requested by specific asset number, the system compares the
current location of the asset to the deliver to location on the Master Work Order
Screen.  If they match, the system increases the Quantity Received to 1 and
updates the line item as complete.  If the location does not match, it increases the
Quantity Reserved to 1 and the line item remains incomplete.

Once Work Orders have been scanned with a Work Order Number and the Mobile
Device uploaded, their current status, Asset Number, Catalog Number and
Location can be viewed by clicking your mouse on the Reserved/Received Assets
button on the Master Work Order tab.
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You will see a Look up Window similar to the one below.

The actual assets scanned by the Mobile Device to complete the Work Order will
be uploaded to the Transaction table, moved to the Asset table, and then the Work
Order line items will display that the line item is complete.

Add Credit Button

There may be cases where Work Order line items need to be changed or adjusted
and the Work Order has already been issued (printed).  For example, a quantity
of 5 items was entered erroneously instead of 3 items.  You can use the Add
Credit Button to make a new line item with a -2 items (negative two).

Obviously, you can also just adjust the original line item by changing the 5 to a
3, but there would be no audit trail, or history, that this change was made. 
Additionally, there may be a cost associated with a credit (or customer return),
which you would want to record.

The credit is applied to the line item which you click on.  It is not applied to the
last line item.  For example, lets say that you have 6 line items in your Work
Order and the credit needs to be applied to the 3rd line item.  Click on the 3rd line
item and press the Add Credit button.  A new line item is added as a credit with
the description, cost, and other associated information from the 3rd item.
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Columns Button

You can make a wide variety of customization to what fields are displayed for
each Line Item by clicking on the Columns button.  When you click on the
Columns button, the following Window will be displayed.

Clicking Standard will display the following fields.
Line Number
Asset Number
Catalog Number
Catalog Description
Quantity Received
Quantity Requested
Quantity Reserved
Completed
Line Item Note

Clicking on Standard Extra will display the following additional fields.
Activity Date
Activity Time
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Clicking on Estimated Costs will display the following fields.  They can be
manually completed either before the Work Order is issued, or after the Work
Order is completed by the Mobile Device operator.

Quantity Requested
Charge per Unit
Labor Rate per Hour
Hours Estimated
Supplies Cost - Estimated
Labor Cost - Estimated
Total Cost - Estimated
Line Item Note

 Clicking on Actual Costs will display the following fields.
Quantity Requested
Charge per Unit
Labor Rate per Hour
Hours Actual
Supplies Cost - Actual
Labor Cost - Actual
Total Cost - Actual
Line Item Note

Clicking on ‘Deliver To’ Location can be used when one Work Order has multiple
delivery locations.  If you use this option, consider leaving the Deliver To Tab
blank.  The following fields will be displayed.

Deliver to Region
Deliver to Building
Deliver to Floor
Deliver to Room
Deliver to Vault
Deliver to Row
Deliver to Bay
Deliver to Slot
Deliver to Level
Deliver to Room Tag
Deliver to Location Type
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Clicking on ‘Ship From’ Location can be used when one Work Order has multiple
Pick up locations.  If you use this option, consider leaving the location
information on the Requested By Tab blank.  The following fields will be
displayed.

Ship From Region
Ship From Building
Ship From Floor
Ship From Room
Ship From Vault
Ship From Row
Ship From Bay
Ship From Slot
Ship From Level
Ship From Room Tag
Ship From Location Type

Clicking on ‘Log information’ can be used when Work Orders have multiple
changes and you would like to view when the line items were last updated.  If you
use this option, make sure that every user has a different password.  The Log
Event Codes are documented in Chapter 14 - Import & Export.  The following
fields will be displayed.

Log Date When First Added
Log Time When First Added
Log User When First Added
Log Notes
Log Alias
Log Event Code

For all of the columns mentioned above, keep in mind that you can customize
your screen display by resizing each field and reordering the fields by dragging the
column header.  Your changes will be memorized for your password and will
remain in place every time you access Bar|Scan.
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Once all line items are complete, Bar|Scan will update the Master Work Order tab
“Completed” item at the top of the panel by changing it to having a checkmark.

Bar|Scan will also allow you to identify which Work Orders have been printed --
see “Printed” field as shown below.

You may wish to consider deleting completed Work Orders after some determined
time has passed, for example one year.  Remember, you can order Work Orders
by completion date using the SET command.  This will make it easy to use the
Delete feature to remove old Work Orders.
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Look Up Available Quantities

It is often useful to know what you have available when you are adding line items. 
For this reason, there is a special function that can assist you in obtaining this
information.  When you right click on the Quantity Requested, you will be
presented with the following Pop-up.

When you select Look Up Available Quantities, you will be presented with a
Window like the one below.

This Window shows the quantity of assets that are located in each Building
Location in the Asset Table.  The information can be very useful, for example, It
can prevent you from creating a Work Order requesting more items than you can
ship.
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Reserved Received Items

In the middle of the Master panel, there is a Reserved/Received button.  When you
select this button, you will see a Look up Window like the one below.

This Window shows the assets that were scanned with the Mobile Device to
complete the Work Order.  In the example listed, six assets were required to
complete the order.  

Important: This Window only displays asset information after the Mobile Device
has been uploaded, and the assets have been moved to the Asset table.  As you
may create a Work Order without requesting assets, e.g., for adjusting the
temperature control in a room within your building, this Window can also remain
empty.
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THE REQUESTED BY TAB

When filling out the information for the Work Order, you will need to fill out the
information on the rest of the tabs.  Click on the second tab, or press the F3 key,
and you will be shown a tab similar to the following.

Requested By Name

This entry is most often used to identify the name of the person using (or
responsible for) the asset.  Some companies prefer to use the name of a supervisor
or department head.

When you right click on the desired field or press F5, the following Look up
Selection Window will appear.
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You may select one of the names, or press ESC to leave the entry blank.

Requested By When

This item identifies the date when the Work Order was requested.  When you
create a new Work Order, Bar|Scan automatically enters the date from your
computer into this field.  This can, however, be manually changed by you.

If you are entering Work Orders based on telephone requests, you would probably
not manually change this item.  If you are entering Work Orders based on
facsimile or paper transmittals, you may wish to change the date to the date on the
paperwork.

If you wish to change this item, move the cursor to the entry, type in the characters
and press the TAB key.

Requested By Phone

Bar|Scan permits you to enter the area code, telephone number, and extension
number of the individual responsible or using the asset.  You may enter any or all
of the numbers.

Move the cursor to the desired part of the entry and type in the numbers.  When
complete, press the TAB key.

Requested By Organization

The Ownership information identifies the organization and individual responsible
for the asset, and how the asset was obtained; leased, purchased, customer
furnished, etc.  To help identify specific asset locations, the name and telephone
number of the person using the asset can be entered.

The Division, Department, and Unit entries are provided to permit you to identify
the different organizations which have possession and responsibility for the asset. 
You may identify from zero to three different organizational levels.  Your choice
for these entries will depend on the nature and structure of your particular
company.
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For example, the organization responsible for a particular Personal Computer
might be the West Coast Division, the Accounting Department, and the Accounts
Payable Section.

These entries permit you to describe Work Orders for which the physical location
may not coincide with the organizational responsibility for the asset.  Using the
example above paragraph, the Accounts Payable Section may have the use of a
mainframe computer terminal which is the responsibility of the Data Processing
Department.

Requested By Location

The Location information identifies the current location of the Work Order.  It
may not identify the location of the assets associated with the Work Order, this is
done in the Line Item section.

The Region, Building, Floor, Room, and Room Tag entries are provided to permit
you to identify the location of the Requester, or, the first asset, etc.  Your choice
for these entries will depend on the nature and structure of your particular
company.

These entries permit you to describe Work Orders for which the physical location
may not coincide with the organizational responsibility for the asset, i.e., a
mainframe computer terminal may be located in an unusual location, or the
Requestor may not be in the Department listed in the Organization listed.

Site, Pallet, or Vault Location

Move the cursor to enter the location type, and then right click on any of the
location fields, and you will see a Look up Window, that lists all of the locations
that are in your Bar|Scan system.  Selecting one item will cause additional items
to be entered.

All Look up Window selections are based on the Location described in Chapter
9 - Locations.  New locations cannot be entered on the Work Order Display
Screen, they must be added to the Location table.
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THE DELIVER TO TAB

Next, you will want to fill in the Deliver To information.  Click on the Deliver To
tab, or press the F3 key, and you will be shown a tab similar to the following.

These items identify when the Work Order and Line Items are to be delivered.

In most cases, you will want to enter information here unless the Work Order does
not involve moving the assets, i.e., a repair Work Order.

Deliver To Date

When you create a new Work Order, Bar|Scan automatically enters the current
date into this field. The date is taken from the date of your computer.  This can be
manually changed by you to some future date as specified by the Requestor.

If you wish to change this item, move the cursor to the entry, type the desired
characters and press the TAB key.

Follow Up Date & Follow Up Time

These items identify when and if the Work Order requires a follow up.  If you
enter a follow up date, you will be able to create reports ordered or filtered by this
date and/or time.

You may wish to use Follow Up Time if the Requestor indicates a specific time
of day.  Remember that time is saved as Military Time, e.g., 14:00 hours is 2:00
p.m.
If you wish to add these items, move the cursor to the entries, type the desired
characters and press the TAB key.
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Organization Code

This code is used to identify the different combinations of Division, Department,
and Unit. 

When you place your cursor on the Organization Code field and right click, or
press F5, and select Look up Value, the following Look up List will appear.

Move the cursor to the desired Organization Code, and press the Ok button.

When you select a code, the associated Division, Department, and Unit will be
automatically displayed below the Organization Code.
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Deliver To Location

Deliver To is similar in appearance to the Requested By section.  It identifies the
completion organization and location of the Work Order.

These are optional fields, and are not required to complete the Work Order.

Move the cursor to enter the location type, and then right click on any of the
location fields, and you will see a Look up Window, that lists all of the locations
that are in your Bar|Scan system.  Selecting one item will cause additional items
to be entered.

All Look up Window selections are based on the Location described in Chapter
9 - Locations.  New locations cannot be entered on the Work Order panel.  They
must be added at the Location panel.

Depending on your own procedures, you can leave this entry blank and add your
deliver to information separately for each line item.  In this way, you can create
several delivery locations on a single Work Order.
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INSTRUCTIONS/NOTES TAB

This tab is used to document any notes or instructions as well as follow up notes
in the Work Order.  Both fields are a free form item of no particular length.  This
means that if you get to the end of the entry, you can continue typing and the item
will continue to scroll.  Information  is not lost when it is scrolled off of the
screen.  Select the Instruction/Notes tab by clicking on it, or by pressing the F3
key, and you will see a tab similar to the one below.

Enter any notes or instructions, as appropriate.  Avoid using the ENTER key
because the notes will automatically wrap around to the next line.  You will also
wish to avoid using the ENTER key because the notes will be spaced to fit the
Work Order report, which is different that the Display Screen.

Use the arrow keys to move your cursor around within the text.  If you wish to add
notes, move the cursor to this entry, type in the characters.

Hint: If you are not specifying assets on the line items, you will probably need to
provide more specific instructions.

Bar|Scan provides a Note Table where you can store notes that you expect to use
on a regular basis.  A key field is assigned to each note and then used to Paste the
complete note into the Instructions or Follow up Field.
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To open the Note Table, right click, or press F5, and select Look up Value as in
the example below.

Select Look up Value.  The Notes Table will appear as in the example below.

Pressing the Paste Button will insert the Notes into the Work Order.
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BATCH

The Batch tab of the Work Order feature is a special case of entering Work Orders
not used by most of our customers.  For that reason, it is discussed at the end of
this Chapter.
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BOM

BOM is short for Bill of Material.  When you select Reserved BOMs ...<, Create
Work Orders, all your Ranged Reserved Bill of Material items are used to
generate the appropriate Work Orders.

There is one Work Order generated for each Reserved Bill of Material.

When completed, you can open your Work Orders to review them.  The example
below was created from the Reserved Bill of Material example on the previous
page.

Note that all Line Items and other previously entered information was copied 
from the selected Reserved Bill of Material.
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When you choose the Edit Tab of the Work Order, you will see a Tab called
‘BOM’.   If you used the Reserved Bill of Materials Screen to generate the Work
Order, the Reserved Bill of Materials Number will be displayed on this tab as
shown on the following screen.

You can process these Work Orders in the same manner as your manually created
Work Orders.
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Service Tab

This tab is used in conjunction with the Service Orders feature in the handheld.

If you are not using Service Orders in the handheld, you will want to leave this
screen blank.

Basically a Service Order is an instruction to perform a task or group or tasks
associated with one asset.  In other words, for each asset that is listed on the
Service Order, you can perform and record multiple tasks.

When you select Service, you are presented with the following screen.

Here you can  choose a Work Order Template and enter in relevant Service Order
information.

For more information on the handheld portion of this feature, see Chapter 11,
section titled “Service Orders”.  
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Completing the Work Order

Work Orders do not need to refer to assets.  For example, you may create a Work
Order to adjust a temperature control in a room within your building.

If the Work Order is complete, save your work now by selecting the Save icon
from the tool bar, or pressing the Ctrl + S key combination.  If you will be
referring to assets on the Work Order proceed with the following section.

Refer to Chapter 10 - Reports to print your Work Orders.

CHANGING WORK ORDER INFORMATION

From time to time you will want to change, correct, or add information associated
with Work Orders currently existing in the Bar|Scan system.

Move the highlight bar to the desired Work Order on the Browse panel.  Select it,
and then select the Edit tab.  On the Edit panel, you may add or change
information at will.  Remember to save your changes by selecting the Save icon
from the tool bar, or pressing the Ctrl + S key combination.

Keep in mind that there may be changes that will affect your work order
processing cycle.  For example unchecking the ‘Completed’ item will affect
reporting as well as future use of the handheld if updating line items.
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DELETING A WORK ORDER

This feature completely removes Work Orders from the Bar|Scan system. 
Obviously, caution should be exercised when using this feature.

Removing Work Orders from the system is most often done due to erroneous
entries.  We generally recommend that, when Work Orders are disposed of, the
Work Orders remain in the Bar|Scan system for an extended period of time,
identified by some method you devise to indicate a “disposed of” Work Order.

Bar|Scan permits you to identify a group of Work Orders which can be removed
from the system all at once.  Use the SET feature to first identify a particular
group of Work Orders that you wish to remove.

To select the Delete feature, highlight the desired Work Orders by using the Range
feature, press the ENTER key, and then select the Delete button from the tool bar. 
You will be asked to confirm your choice.  If you do confirm that you want to
delete these Work Orders, they will immediately be removed from your Bar|Scan
database.
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Changes to Assets

Once the line items have been marked as completed, Bar|Scan still monitors the
items in the Asset Table.  At some point, you may be changing information about
different assets in your Asset table.  You may see a message like the one below.

This message says that Work Order [00002] is flagged as being complete, yet you
are trying to update it.  Updating a completed Work Order forces a recalculation
of all line items.  THIS MAY CAUSE LOSS OF HISTORICAL INFORMATION
ABOUT FULFILLMENT OF LINE ITEMS if any of the specified assets have
moved or changed in quantity since completion of Location History information
has been removed as time has passed.

Basically, this message is a warning that you are changing information that you
have specified in a completed Work Order.  Therefore, if for instance your asset
has since moved to a new location, rather than changing the existing location in
the Location History, simply add a new location.
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WORK ORDER REPORTS

In addition to the regular system reports available, you have access to an
additional feature to further customize your reports.  You can create a custom
report.  Custom reports are generally created by a BarScan administrator who has
knowledge of BarScan’s report designer.  This is an end user tool, there is no
computer programming needed to accomplish this.  We have created two custom
reports: The GFS Work Order report, and the Warehouse Pick List.  You can view
and print these reports, and although you cannot change the format, you can
change the order, and the way they print.

In many cases Bar|Scan Work Orders are used as replacements to manual Work
Order systems.  These custom reports are designed to appear like generic Work
Orders. 

This feature can save you a lot of time, as you can have these reports customized
to your exact specifications, using information such as: complete, incomplete, the
Work Order number, the delivery location, including filters, specific dates, any
other Work Order item.

If you are not familiar with the report designer and are interested in having a
custom report created for your business, please contact your Bar|Scan dealer.
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SHOPPING SCREEN

The last item shown on the Work Order table tool bar says Standard, and has a
down arrow next to it.  It is displayed below.

For most of our customers, this item can remain at the default. But, by pressing
the down arrow, you will see the words Shopping.  This item is used mainly by
retail or warehouse check-out areas.

The Shopping mode was designed to only track Takes, with a minimal amount of
information.  When Shopping is selected, the Edit tab will change to the
following.
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There are two major differences between a Shopping Screen and the regular Work
Order Screen.  The first is the addition of a UPC Code field, and the second is the
addition of the Add Credit Button.  Both of these are normally found only in a
retail environment.

UPC Code

The UPC Code is short for Uniform Product Code.  This is the bar code
symbology that is used for most retail products, from a soft drink can to a case of 
motor oil.  By placing the cursor on the UPC Scanner field and scanning the item
with a fixed station scanner (attached to the computer), you can quickly add line
items based on these bar codes.  You will, however, need to tell Bar|Scan what
these UPC codes mean.  This can be done on the Catalog Screen.  Each item you
expect to scan must have a Catalog created for it, in advance.  Refer to Chapter
7 - Catalogs, for more information on creating Catalogs.

Add Credit

It will also be more common for items to be returned in a retail setting than a
Corporate or Fixed Asset Warehousing environment.  The Add Credit button can
be used to facilitate these returns.

Placing you cursor on the Line Item that is being returned and then clicking on the
Add Credit button creates a new Line Item which reverses the Number of Items
requested.

All other fields on this screen are identical the fields already discussed in this
Chapter.

If you need additional details on the Shopping Screen features, consult your
Bar|Scan Dealer for more information.
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CUSTOM SCREEN

The last item shown on the Work Order table tool bar says Standard, and has a
down arrow next to it.  It can be changed to Custom as is displayed below.

For most of our customers, this item can remain at the default Standard Mode.
But, by pressing the down arrow, you will see the words Custom.  This allows you
to create a new Work Order Panel of your own design.  The User Defined Fields
Module is required to create your panel.

When you first change to Custom, the following Panel will be displayed.
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You can now add User Defined Fields to customize your Work Order Screen. 
Make sure that you place a check mark in the “Visable on UDF Tab” properties
icon  when you create your user defined fields. Below is a sample of a completed
Custom Work Order. 
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BATCH OPERATION

This section is part of the standard Work Order screen but is discussed here, at the
end of this Chapter, since most users will not require it’s features.

This tab is used to perform Batch operations in the Work Order.  Select the Batch
tab by clicking on it, or by pressing the F3 key, and you will see a tab similar to
the one below.

Batch operations in the Work Order feature are not necessary unless you are
interfacing the Work Order Feature to another software application and you are
communicating with the other application using ODBC connectivity.  Sometimes
the Batch operation is also useful if you are importing from a flat file.

Here is how it works.  Suppose your other software application was a web based
Work Order system which was constantly generating Work Orders and placing
them into the Bar|Scan Work Order Table using ODBC connectivity.  How would
you know that new Work Orders exist for printing or if changes were made to
other Work Orders?  It would be very difficult, unless there was a field in
Bar|Scan that could tell you that the Work Order was updated by this other
software application and Bar|Scan constantly searched the Work Order table
looking for these additions or changes.  The Batch operation does both of these.
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The process begins by setting up a Batch operation schedule so that Bar|Scan
knows how often to search through the database for changes.  To do this, simply
go to the Main Menu, and select File ...<, Company ...<, Housekeeping ...<
Miscellaneous ...< Batch Operation as shown below.
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When you have selected Batch Operation, a Screen similar to the following will
appear.

Notice that there are three tabs to Batch Operation.  The first of these three tabs,
the Setup Tab, opens as the default, and is displayed above.  This is the primary
Tab used to schedule the Batch Operation.  You can constantly scan the Work
Order Table, as shown above, or you can set it to scan by selecting the Repeat pull
down.  When you select the pull
down, you will see a Look up List
similar to the one at the right.
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The actual increment that you use depends on the volume of activity that you
anticipate.  If your web application is only generating one Work Order an hour,
you may want to select hourly or daily.  Scanning does take computer resources,
and can slow down Bar|Scan if you set it too frequently.

Additionally, you can give each Batch operation a name and a Label.  Labels are
used to link two or more Batch operations together so when the first Batch
operation finishes, the second will automatically begin.

The second tab, Operations, is displayed below.

Use this tab to select which Batch operation should be performed and which
Company to perform the operation on.
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The third tab, Log, simply records when a Batch Operation takes place and if any
errors occurred during the operation.

Unless you have previous experience with the Bar|Scan Syncronization feature,
as discussed in Chapter 13 - Housekeeping, it is best to consult your Bar|Scan
Dealer for more information prior to completing this feature.

After you and your associate have completed all three tabs, you are now ready to 
activate the Batch operation.  To do this you must click on the Batch icon at the
bottom right of your screen as shown below.

The Batch use of Company Synchronization is not discussed in this Chapter since
it is not related to Work Orders.
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INTRODUCTION

The User Defined Fields module allows you to easily add new fields that will
customize your Bar|Scan system to suit your needs.  The User Defined Fields
(UDF) module is an optional module, and was designed to allow the user to add
fields that are not in the Bar|Scan system.  These fields can be added to the
handheld and you can also stretch or shrink any existing Bar|Scan Character based
field with this module.  This module can be very useful, and can save you valuable
time in data entry as well as reporting.

The User Define Fields tab allows you to design a detailed data entry screen by
choosing the field type you want, shape and size them onto the screen, give them
a new name, and select the size of the field.  Many field types are available,
including text, date, numeric, logical, memo, and Bar|Scan text fields (used to
modify the size of an existing Bar|Scan field).

Also, the user has the option of choosing the tab order of the fields, aligning the
fields, as well as selecting an input mask that formats the data entry later on. 
Finally, you can enhance and organize your UDF Screen with the additional text
and graphics.

There is a set of videos on our website that can provide you with additional in
operating Bar|Scan.  These are titled Quickstart Overview Videos and can be
found on this page: https://www.barscan.com/support-videos

Please consider viewing or downloading these as part of your learning experience.

KEY FIELDS

There are many Bar|Scan fields that can be lengthened or shortened without using
the UDF Module.  This list of commonly adjusted fields are located on the Key
Fields tab of the Company Settings Screen.  Before you adjust any field, check to
see if it is on this tab.  It will be faster and easier to make the length adjustment
here than by using the UDF module.

THE USER DEFINED FIELD TAB

The creation of User Defined Fields works in the same manner for all of the
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different tables in Bar|Scan.  Therefore, no matter which table you choose to add
fields, you may create the User Defined Fields in the same way.

First, open a company, and then open a table.  For our example, the table that will
be used will be the Organization table.

From the Main Menu select File . . .<, Company . . .<, Open . . .<, (select a
company from your system).  Then, select File . . .<, Open . . .<, then, any table
such as Organizations.

When you first open a company table that does not contain any User Defined
Fields in it, you will not see the User Defined Fields tab.  If you wish to create a
User Defined field for this table, you can do so by simply going to the Main
Menu, and selecting Panel, then at the bottom of the drop down list select Design
Mode-User Defined Fields as shown below.
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When you do this, you will see a table similar to the one below.

Notice that there is now a new tab labeled UDF.  There is also a red outline of this
table, indicating that you are now in the Design mode.  While in the Design mode,
you can add, modify, and place the new fields.
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There are two ways to begin the process of adding a new field.

1. You may go to the Main Menu, there is now a Feature Category called User
Defined Fields.  Select the User Defined Fields, and you will see a drop down
menu list like the one below.

2. You may also use your mouse to access a similar list by simply right clicking
on the grey area of the UDF tab as shown below.
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No matter which way you prefer to access the UDF drop down menu, the options
and operations are the same.  The options are shown below.

As you can see, the options are: Add, Delete, Align, Save All, Undo All, and Edit
Mode.  First, we want to look at the Add option.

When you select Add, you will see another drop down menu list as shown below.

The options for the different types of fields are: Text Field, Date Field, Numeric
Field, Logical (Yes/No) Field, Memo Field, and existing Bar|Scan Text Field.

Shape and Caption are screen design tools and are discussed later..  
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You may choose any of the different types of fields listed; their uses are outlined
below.

Text Field - This field may be used for alpha characters or a combination of alpha
and numeric characters.

Date Field - This field is used for a standard date field.  The date field will
automatically appear using the 99/99/9999 format.

Numeric Field - This field is used for Numeric input only, characters 0-9.

Logical (Yes/No) Field - This field is used for simple Yes and No responses.

Memo Field - This is a “notes” type of field, complete with scroll bars, so that
your field may actually be larger than it appears on the screen.

Bar|Scan Text Field - This field is used to adjust the widths of Bar|Scan’s standard
text fields.  Almost every field can be changed, but the exception to the rule is the
Location Histories, as they have no table of their own.  

Don’t forget that you can use the Company Settings Screen to stretch many
standard fields.  The advantage to this is that stretching a field like ‘Building’ will
make the requested changes in all corresponding tables for you, which can be
much easier that adjusting the building field in all the tables manually.  For more
information on this topic, see Chapter 13 - Housekeeping. 
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ADDING A FIELD

When you select Add, then a field type such as Text field, the new field will be
placed on the tab and you will be immediately prompted for information about the
UDF as shown below.

This box has several fields inside of it, which will help you in giving your new
UDF field the balance of its properties.  

The first item listed is the Field Name.  This is the internal name that Bar|Scan
will give the field.  Every UDF Field name has to start with UD_, followed by no
more than six more characters consisting of alpha, underscores, or numbers.  For
our example, we will call our field SAMPLE.  Do not give the UDF a name that 
already exists in your Bar|Scan system.

The second item listed is Report Title, Screen Caption.  This is the name that
will appear next to your new field.  For our example, we will choose the
description Sample Field.
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The next item is Tab Order.  If you have several UDFs, the tab order is very
important to the person doing the data entry.  For instance, if you have five UDFs
and the top left hand field is listed with a blue number four, then it will be the
fourth item that the cursor goes to when the tab button is pushed.  Obviously,
depending on how your screen is set up, you will want your tab order to go in a
logical fashion, either left to right, or top to bottom.

The next item listed is the Input Mask.  An Input Mask specifies the data entry
rule each character entered must follow.  If you are not familiar with what an input
mask is, it is the items that are already there when you enter a field, to format the
data entry process.  

One example is the brackets and dashes often seen in a field where a phone
number is to be entered (999) 999-9999.  This allows the brackets, space,  and
dash to be there without having to be typed by the data entry person.  

For instance you could set the Input Mask property to 999,999.99 to limit the user
to input to numeric values numeric values less than 1,000,000 with two decimal
places.  The comma and the period would be displayed in the text box before the
user entered any values.  If the user pressed a character key, the character would
not be displayed in the text box.  Below is an example of numeric formattng.

If you have a logical field and want a user to be able to type “Y” or “N” but not
“T” or “F,” set the Input Mask to “Y.”

There are many different types of characters that are acceptable for input masks. 
You may you use the following:
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X Any character can be entered.

9 Digits and signs, such as a minus (-) sign can be entered 

(999)999-9999

# Digits, blanks, and signs can be entered.

$ Displays the current currency symbol in a fixed position.

For example: $99,999,999.99

$$ Displays a floating currency symbol that is always adjacent to the digits 

For example: $$99,999,999.99

* Asterisks are displayed to the left of the value.

. A period specifies the decimal point position.

, Commas can be included to separate digits to the left of the decimal point.

! Allows only Uppercase

R Excludes the formatting characters (such as brackets and a dash in the

telephone number) when saving the data.  These characters are not counted

as part of the field length, but are still displayed and printed.  This can be

used in any type of character field.

The default input mask for a character field is “@!”, which means allow only
uppercase for the entire field.

The standard Bar|Scan input mask for the telephone number field is: 

(###)###-####:#### 

It is 14 digits long.  

If you need to change the input mask so that you can collect a five digit telephone
extension, you would want to change the input mask to add a @!R and a space at
the beginning of the mask.  It would look like this: 

@!R (###)###-####:##### 

Change the length to 15 digits.  

You need to make an equal and like UDF for both the Transaction and the Asset
table.  
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There is still one more step before Bar|Scan will acknowledge your change. 
Bar|Scan has an input mask for the telephone number listed in the Company
Settings table as well.  You have to go to the Company Settings table in
Housekeeping to make the same change on the telephone input mask.  

Restructure the company, and Bar|Scan will allow you to collect the additional
character in the telephone number field.

The next item is the Field Length.  The largest field length allowed depends on
the type of field you are using.  The maximum length for a text field is 100
characters long.  Note: You will want to make sure that the actual space allowed
for your field is similar to that of the field length.  If you want the field to be 15
characters long, the field should be about an inch and a half long, with a depth for
only one line of characters.  If you want  your field to be 75 characters long, make
sure that you have a depth equal to at least two lines of text.

The next item is Field Type.  The field types are: Text, Date, Numeric, Logical,
and Memo.  Once you create a new UDF, you cannot change the field type.  If you
created the UDF with the wrong field type, you must delete the UDF and create
it again.

Next is the Default Value. 
Any text entered into this field
will be placed into the record
whenever a item is added.  For
example, if you type
“unassigned” then the text
unassign will appear in the
field ever time you add a new
Organization as shown in the
example to the right.
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Reset.  All Bar|Scan fields have a default value, both UDF’s and standard
Bar|Scan fields. It is possible for a user to change the default value for a standard
Bar|Scan field using this UDF dialog. This button will restore the original default
value of the field.

Caption on Top.  Normally the caption text will appear to the left of the UDF
field.  If you check this box, then the caption text will appear above the UDF field.

Caption Font.  You can change the Font of the Caption being displayed on the
UDF panel by entering a new font or size here.  You may find this useful to
emphasis important UDF fields.  You can select a new font by entering the
information directly or Right-clicking and selecting the font as shown on the
following example.

Next is the Caption Color.  You can change the Color of the Caption being
displayed on the UDF panel by entering a new color here.  You may find this
useful to emphasis important UDF fields.
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Next is the Visible on UDF Tab.  In some cases, you may not wish to have the
UDF field display on the UDF tab.  For example, if you are stretching an existing
Bar|Scan field such as the Organization Division, it is already displayed on the
Edit Tab.  It may not be necessary to display this again on the UDF tab.  Click on
this check box to hide the field on the UDF tab.

Next is the Visible on Smart Client.  You can choose which fields will be
displayed on the Edit Panel of the Bar|Scan Smart Client Application.  The fields
that are displayed are global for all users.

Next is the Read Only.  You can control which fields cannot be edited on the
UDF tab.  Our example of a filled out UDF Property Box is shown below.

Last is the No duplicate values allowed.  This prevents saving duplicate values
within the UDF field within the table that you have selected. It is not for the
handheld, only the desktop. If you attempt to save a record in any table other than
the Transaction table where the value in this field already exists in some other
record, then a validation error message appears. 

For example, if you wanted to make sure that the Manufacturer Part numbers were
genuinely unique within the catalog table, then you could create a UDF for the
Manufacturer Part number field and select ‘No duplicate values allowed’. If you
create or edit a catalog that has the same Manufacturer Part number as in any other
catalog, it will not allow you to save it.

The option is not offered in the Transaction table, for Yes/No fields or for
non-data UDF’s, such as a label.

Page 16-12 Bar|Scan



Chapter 16

See the following example:

Remember, if you make the field hold many characters, you may have to widen
the field in order to be able to see all of the characters.  Bar|Scan starts with a
conservative initial field length to conserve file space.
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Adding UDFs to the Asset Location Table

You can add User Defined Fields (UDF’s) to Asset’s Location History. These are
specified the same way as regular UDFs  for the Asset table.  A typical work flow
for a location history field UDF can be a little more complicated that the normal
one for a standard UDF. The reason is that there are Current and Prior location
history items that must be accounted for and there is a more complicated data
flow.  Here is an example of a Service Tag. To create a Transaction table field that
is filled out in the handheld device, then is moved to the Location History and
Asset table:

1. Create a Transaction table UDF called ‘Service Tag’.   Bar|Scan will prompt
and you will allow it to create a matching Asset UDF.  When done, there will be
two UDF’s created, one in the Transaction table and one in the Asset table. The
Asset UDF will later be used and renamed as the ‘Current Service Tag’ value.
 
2. Open the Asset table and go into the edit mode for UDF’s on the UDF tab.

3. Modify the ‘Service Tag’ field previously created, renaming it as ‘Current
Service Tag’.

4. Add a new Asset UDF in the Asset table named ‘Prior Service Tag’. This will
hold a copy of the Service Tag from the PRIOR Location history record.

5. Save all UDF work by right clicking on the UDF screen and selecting ‘save all’.
This will make sure that the newly added fields will be available for the next step.

6. Add a new LOCATION HISTORY UDF. Call it ‘Service Tag’. To create this
UDF, add a UDF in the Asset screen UDF panel as normal, but  In the new UDF
where you will see  listed the Asset table, click on it and a choice of either ASSET
or LOCATION HISTORY is presented. Change it to Location History. When you
pick Location History two sets of combo boxes will appear. Here you will specify
the previously created Current and Prior Asset fields to hold those values as
moved from the Location History.

7. Save all UDF work by right clicking on the UDF screen and selecting ‘save all’.

8. Finally, do a Table Integrity to create the fields.
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The Mobile Device UDFs

The Transaction Table has a special type of UDF Properties screen to control
UDFs collected in the Mobile Device.  The screen is displayed below.

There is one additional information to complete the UDF properly, ‘Move’ target
field.
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The ‘Move’ Target Field is optional.  If you create a UDF with the same Field
Name in the Asset Table, then the Asset field is automatically updated when the
Asset moves from the Transaction Table to the Asset Table.  You can also select
alternative Asset Fields to “redirect” fields from the Transaction Table to other
existing fields in the Asset Table.’

By using this feature you can collect Accounting or Date fields in the Mobile
Device and move them to existing Asset Fields such as Purchase Cost or Disposal
Date.

Here is an example of creating a field ‘Disposal Buyer’, which is not a standard
Transaction Table field, and moving it into the Asset Tables ‘Disposal Buyer’
field, which is a standard Asset Table field.

Remember, you need to perform a Table Integrity before your changes will take
effect.

Page 16-16 Bar|Scan



Chapter 16

EDITING OR DELETING A FIELD

You can now Edit or Delete the newly created field.  If you choose Edit, you will
begin the process by selecting “Design Mode-User Defined Files” from the Panel
Pull-down on the Main Menu.  The red outline that appears will indicate that you
are now in Design mode as shown in the sample below.
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As shown in the previous screen, the field that we added was a text field.  Use
your mouse to left click on the title of the field, click on the word Sample Text. 

Note that this new dialog box has four options, Edit, Delete, Send to Back, and
Bring to Front.  

Edit allows you to make changes to the UDF such as stretching or shrinking the
field, or changing the Caption or Font.

Delete allows you to delete the UDF field from the database.  Under normal
circumstances, Bar|Scan makes the field invisible after a restructure but does not
actually delete the UDF from the Table.  Most often, this is the preferred method
of deleting.

If you are sure that you no longer wish to use the UDF , you must  select “Verify
operations on each Table” on the Table Integrity screen to actually delete the field.

Send to Back is used when you are designing a screen with additional shapes
such as boxes, underlines, etc.  This is especially useful when you are moving
fields into a box or resizing the box.  Because shapes can be placed over fields or
other shapes, this assists you in selecting the correct UDF or shape to edit.
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Bring to Front is the opposite of Send to Back and is also used when editing 
your work.

Moving a Field

When you left click on the title, the appearance of the field will change as shown
below.

Notice the title is now greyed out, there is a number one in the center, and there
is a dotted box around the field with small boxes on the end.  You may now move
or resize this field.
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The blue number one shown in the center of the field denotes the tab order.  So,
with this field being number one, your cursor  will be placed in this field first. 
When you add more fields, their tab numbers will increase.  When the screen is
done, the tab order denotes in which field your cursor will be placed when you
press the tab key.

You can change the tab order at any time.

The dotted line symbolizes the actual appearance size of the field, and may be
modified by placing your cursor on the small boxes until you see a double headed
arrow.  When your cursor becomes a double headed arrow, you may left click and
drag the boxes, making the rectangle shown larger or smaller, as shown below.

The size of the field does not affect how many characters the field can hold.  It is
for display purposes only.
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You also have the ability to move the field, by left clicking on the grey area
(inside the dotted line), holding the mouse button down, and dragging the field to
a new area.

Now you know how to add a field, move it, and size it.

We will now show how you can move a number of fields as a group.
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MOVING ITEMS ON THE PANEL

The next item that you see on the original drop down menu as shown below is
Delete.

When you want to delete the field before you save it, you can select the field, then
select this item.

Align is the third choice.  When you select Align, you will see a drop down menu
as shown below.

You can align items by the Caption or the Field.  Your choices for each are Left
and Top.
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You can align the items so that words outside of your field are aligned, and the
fields are not, or, you can align the fields, and the wording will not be aligned.  An
example of aligning the fields to the left, is shown below.

As shown, the words are not aligned on the left, but the fields are.  In contrast, you
could choose to align the words on the left, but, the boxes would be uneven.
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Before you can align any of the items, you must select them.  Click in the grey
area outside of the fields.  Hold your left mouse button down, and drag your
mouse to create a rectangle or square (made of dotted lines) around the fields that
you wish to align.
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Selecting the items that you want to align is easy.  Simply use your left mouse
button to click slightly outside of the area you want to align, hold the mouse
button down, and drag your mouse so that the rectangle that you are creating
encloses the items that you want aligned.  After you have highlighted these items,
they will appear differently, as shown below, the top two fields have been
selected.

You can now right click on the blank grey area, and you will see the drop down
menu, where you can select align.  For this example, we will select align Caption.
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On the example below, we left the first three fields highlighted.  Then, we clicked
inside one of the fields, and dragged them (collectively) to a new location.

As this window shows, you can move the items, and align the items in portions,
until you believe the screen appears perfect.  Remember to check your tab order,
so that when you hit your tab key, it will access the fields in a logical order.
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The next items two items on the pull down are Save All and Undo All, as shown
below.  These items are self-explanatory.

The last item is Edit Mode.  When you click on this item, the red edit box will
disappear, and you will no longer be in the Edit Mode.
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Numeric Fields

There is one slight difference when you select a Numeric field over any of the
other types of fields.  Bar|Scan will allow you to select the number of decimal
places that you wish as shown below.

On this window, you will need to fill out the Field Name, and place a description
in the Description field.  Check the Tab Order, and change if needed.  Then,
decide if you want your field to be only numeric or to appear as a dollar amount,
and fill in the fields as necessary.

For instance,  if you wish your item to appear as a dollar amount of less than one
million dollars, you may place a mask of $999,999.99 in the input mask field, and
click on the up arrow to change the field length and the decimal places from zero
to two.
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Changing Standard Bar|Scan Fields

There may be a time when you want to change the length of a standard Bar|Scan
field, i.e., perhaps you need the Catalog Description field to be four characters
longer.  Making the field longer is possible, by selecting Add, and then Bar|Scan
Field as shown below.

When you select the Bar|Scan Field, you will be shown a standard field, that you
will have to edit.
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When you right click and select Edit, you will see a window similar to the one
below.

On this tab, you will select the field that you want to change the length of.
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There is a down arrow next to the field titled Field Name.  If you click on this
down arrow, you will be shown a list of the fields that are available for the table
that you are in as shown below.

Immediately behind the field name, there is a letter for the type of field C is for
character, N for Numerical, etc.) and a number in parenthesis to tell you how
many characters the field can now hold.
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After you have selected the Division field, you may proceed to change the length
of the field from 12 to a different length.  In the example below, we have changed
the length of the field from 12 to 25.

Depending on where the field resides in your table, you may want to change the
tab order, but note that this is not a field that you will have to be accessing each
time you fill in the other UDFs, so it is best to have this field appear either first or
last.

The Input Mask field has one exclamation point for every character in the field. 
If you are making the field larger by five characters, add five exclamation points.

Alternatively you can use the Mask @! means all upper case, which is usually the
easiest format for any Character Field.

Remember, if you are making the field hold more characters, it does not
automatically make the field wider in size.  You may need to stretch to size of the
field in order to be able to see all of your new characters.
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Shape and Captions

You can add additional shapes and captions to improve the organization and
readability of your UDF Panel.  These are design elements only and have no effect
on the data.  To Add a new Shape, right-click on the grey area of the UDF Tab and
select Shape as shown below.

There are several shapes
to choose from.  The most
popular are the Rectangle
and the Vertical Line. 
After you select your
desired shape, you are
presented with a  new
prompt as shown at the
right.
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The tab order is not important since the user will not be tabbing to a shape.  The
boarder width controls the thickness of the lines used to make the shape.

If you select Caption, then you are presented with a new prompt as shown below.

Captions are text displays only and have no effect on your data.
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SAVING YOUR WORK

After you have selected the Ok button on the above window, you will have to
Save your changes to the UDF tab.

From the Main Menu select User Defined Fields . . .<, Save All as shown below.
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Then, to get out of the Edit Mode for the User Defined Fields, go to the Main
Menu and select Panel . . .<, Edit Mode-User Defined Fields as shown below.

You must perform a Table Integrity on this company before these changes will be
permanent.
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TABLE INTEGRITY

After you have created the UDF fields, even though they appear on the screen, you
must perform a Table Integrity in Housekeeping before they will work.  Below is
the Table Integrity screen.
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IMPORTANT POINTS ABOUT USER DEFINED FIELDS

There are a couple things that you need to remember.  

1.  You CAN change the size of any Location History field.  This is done on the
Asset Table UDF Panel.  Don’t forget to also change the size on the Location
Panel.  In most cases, this is easier to do by using the Company Settings Screen,
Key Fields tab.

2.  If you make a UDF in the Transaction table, you MUST add or change an
EQUAL and LIKE UDF in the Asset table, and vice versa.  If you do not do this,
the information will be lost when you move the valid assets from the Transaction
to the Asset Screen.

Bar|Scan will warn you about this when you save your new Transaction table
UDFs and will automatically create it for you if you reply ‘Yes’.  We recommend
that you reply ‘Yes’.

If you add a UDF to the Asset table to stretch the name field, you need to also add
an exact copy of that UDF to the Transaction table.  Even if you do not plan to use
the field in the other table, you must make a UDF for both.  These two UDFs must
be alike in every way, with the exception of the field in the Transaction UDF that
states where you want the information from a Mobile Device field to upload to,
which is discussed in the next
section.

3. As shown on the screen to the
right, when adding a UDF in the
Asset table, you have three
Tables to choose from.  First,
you have the Asset table but you
can also choose to have UDFs
added to the Asset Location
History and the Asset
Depreciation History as these are
accessed from the Asset Panel. 
Lets see on the following screens
where these UDFs will appear.
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4.  Stretching the size of a Bar|Scan field does allow you to enter more characters,
but may not change the size of the display in the Bar|Scan table because of the
Mask (formatting).  In some instances, you may not be able to view all of the
characters without placing your cursor on that field and moving your cursor to the
right.  The information will, however, print on a report.  To correct this you can
change the formatting.

5. UDFs can be displayed on the Browse Tab but they cannot be added to the Edit
Tab, they can only be added to their own UDF Tab.
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MULTIPLE COMPANY DATABASE FEATURE

The Multiple Company Database feature allows Bar|Scan to maintain as many
independent asset databases as required by intensive users.  We define intensive
users as  those with either a need for several databases, a large database that would
be more effective if made into several databases, a large database that can be split
between active and salvage (assets that have been disposed of), and/or a high level
of activity.

The Multiple Database feature can serve both a single company with a large
number of assets, typically 50,000 or more, as well as Bar|Scan Dealers who
provide Bar|Scan services to their Clients as part of their support services, or
warehouse managers with many clients.

The Multiple Database Feature creates a totally separate group of tables for each
company or a mix of separate and shared tables.

Optionally, your Bar|Scan Dealer can advise you on how you can customize your
system to have shared resources.  Resources such as the Catalog table, Location
table, Organization table, and Look up Windows can be shared across several
databases.  This is explained in more detail toward the end of this chapter.

When you have multiple databases, the Bar|Scan User Profiles are shared by all
Companies that you create.  However, a Master User can restrict any or all other
users’ access to various companies, according to the users log in.  For more
information on this feature, please see the User section at the end of this chapter.

There is a set of videos on our website that can provide you with additional in
operating Bar|Scan.  These are titled Quickstart Overview Videos and can be
found on this page: https://www.barscan.com/support-videos

Please consider viewing or downloading these as part of your learning experience.
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REASONS TO USE A MULTIPLE COMPANY DATABASES

Ease of Use

Intensive users of large databases may require the fastest possible processing
speed and ease of use.  By splitting up your database, work on each database can
be accomplished faster.  For example, queries and reporting will be faster and
simpler.

The Multiple Database Feature allows a single computer to access more than one
asset database.  It is not Local Area Network "LAN" software.  A LAN version of
Bar|Scan can be purchased separately.

Partition Your Database

You may wish to separate your assets into logical groups with separate lines of
responsibility.  You may consider physically partitioning your asset database
according to one or more criteria.  For example, you could separate all equipment
assets from furniture and fixtures.  Other means of separating the database could
be according to:

%  Organizational ownership.
%  Location, if your company is dispersed among several buildings or regions.
% Other logical methods that do not interfere with the way your company would

take a physical inventory.  All of the current Mobile Device models can update
more than one database with an upload.

Use of Bar|Scan In a Service Capacity

Bar|Scan Dealers who provide Bar|Scan services to their clients as part of their
Facility Management support services utilize the Multiple Database feature to
maintain ongoing projects.  Because of the ability to import Catalogs from one
company to another, separate Catalog tables can be developed for each furniture
line that the Dealer provides.  Bar|Scan Dealers are specially trained in project
applications of Bar|Scan.  Individual companies are trained to maintain only their
assets and are NOT encouraged to provide Bar|Scan services to others.  Bar|Scan,
Inc. will not provide technical support for these companies.
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USING THE MULTIPLE COMPANY DATABASE OPTION

If you have not purchased the Multiple Company version of Bar|Scan, and have
only a single company version of Bar|Scan, you cannot access the File . . . <,
Company . . . <, New feature, nor can you access the File . . . <, Company . . . <,
Save As feature.  You have the ability to access one company.  You may change
the name of that company, and the drive or path where it is stored, but you cannot
create a new company.  

As discussed in the beginning of this Chapter, the Multiple Database Feature
allows Bar|Scan to maintain as many independent databases “or companies” as
required, subject to the amount of disk space on your computer.

Once you have more than one company in your system, you have the ability to
open more than one company at a time, and compare tables.  For instance, you can
access two companies, and open both of their Catalog tables side by side.

Important: Both the Single Company and the Multiple Database version of
Bar|Scan allow you to open the same table in the same company several times. 
For instance, you can put several screens of the same Catalog Table side by side
as long as it is the same company.
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Adding a Company - The New Feature

This feature is not available if you are using a Single Company Bar|Scan system. 
It is only available in the Multiple Database version of Bar|Scan.

When you have the Multiple Database Feature, you can select File . . . <,
Company  . . . <, New, and add your new company.
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When you select File . . . <, Company  . . . <, New, you will be shown a dialog box
similar to the one below.

This dialog box allows you to name your new company by editing the path shown
above, or you can select the open folder button to browse to the path you would
like to use.

Once the edits are complete, as shown in RED, the path that you select is shown,
you can select the Add Blank button.

The path that you select and the name of your new company will vary from the
one shown above.  
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In the previous example, we have named the new company “Warehouse A”.  Each
company also requires a unique code, up to eight characters, to identify the
company to the Mobile Device.  This code is only used when you prompt the
Mobile Device for “Company”.  If you never plan on uploading one Mobile
Device to several Company’s Transaction Tables, you will not need to remember
this code.

The “Company” prompt in a Mobile Device is useful in a warehouse environment,
where the assets in storage belong to several customers and you wish to keep each
Customer’s data in separate companys.

When you select the Add Blank button, you will be shown another dialog similar
to the one below.

The dialog in the above box will vary, according to the path that you have chosen
for your new Company, but should be similar to that shown.  If you select No, you
will see a dialog box similar to the one below.
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This dialog appears to let you know that you cannot create the new company
without creating the directory.  When you select the Ok button, this dialog will
disappear, and you will see the Main Menu.

If you had selected Yes, to create the new directory, Bar|Scan will create the new
directory, and the new company for you.  You will be shown a dialog box similar
to the one below.

Notice that the above dialog box tells you that you are currently using the new
company.  The new company has been created, but you are not done setting it up.

Note: Each company that you create must be placed in its own subdirectory.  You
cannot have more than one company in a subdirectory.
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You should go to Settings, and finish setting up your new company.  You can get
to Settings by selecting File . . . <, Company  . . . <, Housekeeping . . . <, Settings
as shown below.
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You will see the Settings table similar to the one below.

You should read the items in this table, especially the items on the Standard
Options tab shown above.  Change any items that need to be changed, and save
your changes. 

Note: The most significant items to check are the Asset # Length and the Room
Tag Length.  These fields should display the number of human readable digits that
are displayed on your bar code labels.  If you are not using Room Tags, you may
leave the setting at the default length of eight characters. 
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Page 1 - Company Code

A Company Code is required for each company entered into the Bar|Scan system. 
The Company Code is used only for password and Mobile Device sychronizing
control. Each company must have a unique code.  

Type in any numbers or characters to establish a company code.  Spaces can also
be used.  Press the BACKSPACE or left-arrow key to edit your work.

When completed, press the TAB key.

Important: When a Mobile Device synchronizes information to the Transaction
table, the Company Code will assist in directing the information to the correct
company.  If you have only one company or you are communicating with only the
company that you currently have open, the Company Code in the Mobile Device
can be left blank.

Asset # Length

Indicate the length of the bar code asset number that you will be using for this
Company.  Any number from 0 to 14 is acceptable.

The asset number length should already have been finalized before adding this
company.  See Chapter 2 - Suggested Procedures for more information on
determining the asset number length.

Room Tag Length

Indicate the length of the bar code Room Tag number that you will be using for
this Company.  Any number from 1 to 8 is acceptable.

If you do not plan to use the Room Tag feature, enter the length of 8 characters.

As with the Asset Number length, the Room Tag length should already have been
finalized before adding this company.  If it has not, press ESC to abandon the
ADD mode now.
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Default First Fiscal Month

If you have the Accounting module, you may use this field to tell Bar|Scan the
Default First Fiscal Month for your company.  Click on the down arrow next to
the field, and select the proper month.  

Telephone Input Mask

The input mask that is shown in this field will allow you to enter the telephone
number without having to press the parenthesis or the dashes.

You can change the input mask to a different format, but in most cases this is not
necessary.

Range of Valid Years

Bar|Scan will only accept dates which fall within the Range of Valid years listed. 
The default settings are acceptable for most customers.  This helps reduce the
amount of erroneous data entry.   If you are depreciating fixed assets such as land
and other long term capital items, you may need to adjust these dates.

Location History Validation Level

Bar|Scan maintains a history of all of your asset inventories including manual
changes.  This asset location history is validated against multiple supporting tables
such as the Location Table.  If you have a high level of scan activity or have a
large number of edits to the supporting tables, activities such as creating new Set
Commands or performing a Table Integrity may take a long time, or you may just
not be concerned with older location information.  You can choose one of three
amounts of validation that you wish Bar|Scan to perform. 

Max # Months Inventory date’s in the future

This option applies to the Inventory Date field and allows you to control how
many months a future date can be valid.  For example, you may wish to enter a
future move into the Asset Table’s Location History.  This option controls how
far in advance you may specify the inventory date.
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Serial # Prefix to Strip

Serial numbers that are printed on the shipping labels of boxes often have a
leading character(s) at the beginning of the actual serial number.  Type into this
field any leading charter(s) that you want Bar|Scan to ignore and remove.  When
the information is uploaded and validated, this item will make Bar|Scan ignore
and remove the character(s) that you have typed into this field.  This will allow
you the option of scanning these serial numbers without opening the boxes.  The
Serial Number can only be stripped during an import of a Mobile Device File, or
during the validation of an upload into the Transaction table.

Catalog Unit of Measure

The Catalog Table defaults to Inches as the unit of measure for Catalog
dimensions ( width - depth - height).  Should you require Metric unit of measure,
this can be changed by selecting “MM” for millimeters.

Background Color

If you have several companies, you may wish to create a background color scheme
for each of them.  This will help distinguish each company.  After selecting a
color and pressing save, the color will appear  the Table Toolbar as in the example
below.
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Selecting Page two will display additional settings as seen below:

Right Justify Asset #

Check this item only if your bar code asset labels have variable length asset
numbers and you wish to append leading characters.  If you wish to append
trailing characters, respond “N.”

Normally, right justify only if you have bar codes of various lengths.

Note:  All asset numbers in Bar|Scan must be of the same length, even if the bar
codes are various lengths.
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Pad Asset # With Zeroes

This option works in connection with Right Justify Asset Number above.  In most
cases you will need to check this item, if you checked the item above.  

For example, if you had one bar code label of five characters 00463 and a six-digit
bar code label 000682, if you used this feature the first bar code label would be
changed to 000463, and the other would stay the same 000682 (assuming that the
asset number length is set to six).

Use Plain Organization codes

Normally, Bar|Scan’s Organization codes are six characters long.  Checking the
Use Plain Organization Codes item allows you to enter any combination of letters
or numbers, up to six characters in length.  If you want to enter a simpler
Organization code such as AP or 503, you could if this item is checked.

If you do not check Use Plain Organization Codes, Bar|Scan will allow only
formatted data to be entered as follows:  two numeric, two alpha, then two
numeric. 

Round Calculated Currencies

Check this option if you want Bar|Scan to round the currency figures up and down
to the nearest whole dollar in all of the calculations.  

Strip Label Check Digits

On occasion, Code 39 font has an optional check digit at the end to increase the
scan accuracy.  These can be stripped as they are not necessary for operation of
Bar|Scan. Selecting the Strip Label Check Digits will strip this additional
character from the Asset Tag or Room Tag fields.
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Initialize Work Order ‘Taken by’ with User Name

Check this item if you use the Work Order module, and want Bar|Scan to
automatically fill in the Taken By field with the initials that were used to log into
the Bar|Scan program.

Prompt for Deletion on Company Export

When Ranging and exporting information from one Company to another, the
information is copied from the source company to the destination Company and
the item or Range of items remain in the source after the export.  Check this item
if you would like Bar|Scan to prompt you to delete the item from the source.

Prompt for Work Order #

Check this item if you want to manually enter the Work Order Number.  Bar|Scan
will prompt you for the Work Order Number, rather than assigning the next
available number for you.

Add Year to Work Order #

Check this prompt only if you have not checked Prompt for Work Order #. 
Checking this prompt will make Bar|Scan add a four-digit year to the beginning
of the Work Order Number that it is assigning.

Add Month to Work Order #

Check this prompt only if you have not checked Prompt for Work Order #. 
Checking this prompt will make Bar|Scan add a two-digit month to the beginning
of the Work Order Number that it is assigning.  

Note:  If you have checked to add both the Year and the Month to the Work Order
Number, the four-digit year will appear, then the two-digit month, followed by the
sequential numbers for the Work Orders.
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Automatically generate Organization Codes

Check this prompt if you would like Bar|Scan generate a numeric organization
code.  Once done, a newly added Organization entered in the Organization Edit
screen will have a numeric organization automatically generated when saved.

Require Print before Transaction can be moved

Check this prompt if you would like Bar|Scan to require the user to print the items
in the Transaction Table prior to moving them to the Asset Table.  This provides
a hard copy trail of your inventory.  In order to move the Asset Table,
Transactions that have not been validated or still have errors will need to be
printed again once they have been corrected. 

Use Locations Within Locations

Use Locations within Locations on Work Order Shopping Form has a checkbox
next to it.  You only need to address this item if you are using the Work Order
Shopping form.  If you are using the Work Order Shopping Form, clicking on this
item will allow you to specify partial locations.  I.e., if you have a real location
that is Region = CA, Building = 1900, Floor = 01, Room = 100, you could check
this item and specify on the shopping form only Building = 1900, with no region,
floor, or room noted, and it would be considered a valid location without adding
it to the location table separately.

Special characters to blank Asset fields

By default, when Bar|Scan imports information either from a handheld or an
external file or a keyboard, Bar|Scan does not overwrite existing data in a field
with a blank.  For example, if your handheld prompts for Purchase Order Number
and you leave the response blank, whatever previously exists in the Asset Table
will remain.  In other words, by default, there is no process to remove data and
replace it intentionally with a blank.

This option allows the intentional replacement of data with a black.  The details 
on how this is accomplished is documented on the screen.
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Selecting Depreciation/Currency will display additional settings as seen below:

This Tab contains settings that are useful for anyone who depreciates assets in
multiple currencies as well as those who might require more depreciation settings. 
For example, if you have some assets in the United States and other assets in
Canada, you can depreciate them in the local currency.

This feature can also be used to change the Default Currency to a currency other
than United States Dollars.  This does not mean that the assets can be depreciated
in multiple currencies.

The multiple currency feature is not activated until you check “Allow asset by
asset changes”.
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Contact your Accounting Manager or review Chapter 13 - Housekeeping for more
information.  The remaining tabs including the Location Field Validation and Key
Field Lengths Tabs are also discussed in Chapter 13- Housekeeping.

Once you save your changes, you will be shown a dialog box similar to the one
below.

As the dialog indicates, you must immediately close all tables and perform a Table
Integrity which includes a restructure.  Once the Table Integrity has finished, your
new company is ready to use.

Page 17-18 Multiple Database



Chapter 17

OTHER MULTIPLE COMPANY FEATURES

There are more features to the Multiple Company system that are explained
below.  These features can be reached on the Main Menu.  

The Close Feature

To use the Company Close feature, go to the Main Menu choose File . . . <,
Company . . . <, Close, and then from the drop down menu, choose the desired
company, or select All (to close all open companies).

The Save As Feature

This feature is only available on the Multiple Company version of Bar|Scan.  This
is used when you have a company open, and wish to save it as a different company
(and company folder), virtually saving a copy of the entire folder, under a new
name.  Caution should be used when using this feature.

The Rename Feature

This feature is used to rename a company.  Caution should be used when using
this feature.

Selecting a Company

Because you may have changed the drive that your Bar|Scan company is on, you
have the ability to access the Select feature in Bar|Scan, whether you have the
Multiple Company Database or not.  

To access the Company Select feature, go to the Main Menu choose File . . . <,
Company . . . <, Select, and then from the drop down menu, choose the desired
company.
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The Company Toolbar

You may use the Company toolbar to open or switch between companies.  To add
the Company toolbar to the Main Menu, go to the View feature (on the Main
Menu), and select Toolbars, and then select the Company toolbar.  The Company
toolbar is shown below.

You may use the two icons shown here to open a company, or to close the close
the company that is shown in the field immediately below the icons.  If you have
more than one company open, you can activate the other company by selecting the
down arrow, and highlighting a different company as shown below.

If you often switch between different Companies in your Bar|Scan system, this
toolbar can save you a lot of time.
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Find Company

The Global Find feature is also listed under File . . . <, Company . . . <, Find. 
When you select the Find feature, you will see a new window which is shown
below.

Using this feature will allow you to search for specific items within one or more
of your companies.  This can be useful if you have only limited information, e.g.,
a serial number, and many companies to search in.
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If you have more than one Company, and have more than one Company open
when you select the Find feature, all of the companies that you have open will be
displayed.  In this manner, you can search for items in the Company of your
choice, or choose to search for an item in all of the companies that you have open
as shown below.

Choose the Select All button, to look in all of the companies that are listed in the
companies box.  Or, if you want to search for an item in only one of the
companies listed, you can highlight that company with your mouse, and choose
the Select Company button.

To find an item, select the table that you would like to search in, then select the
field that you would like to search for.  Then fill out the operator and the value
information, and click the Find button.  
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Once Bar|Scan has searched the respective database(s), the number of items that
it finds will be displayed next to the respective company.

To view the items that Bar|Scan has found, if any, you will need to go to that
specific Company and look for that specific information.
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TABLE PROPERTIES

In order to make changes to the default Bar|Scan installation, there is a Table
Properties table.  When you need to access this feature, go to the Main Menu,
select File  . . . <, Open   . . . <, Table Properties, and you will see a Browse Panel
like the one below.

The first column is labeled  Description.  The information listed in the Description
column is the name of the table.  The second column, Location, lists whether the
information for the table is listed in the \Company folder (not shared) or the
\Sysuser folder (shared).
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Select a table from the ones shown on the Browse tab, and then select the Edit tab,
and you will see a tab like the one below.

By selecting the Directory Name field, you can specify where the information is
stored.  You may select to store the information in the Company, or in the
\Sysuser directory.  By storing the information in the Company, only that
Company can use the information.  By storing the information in the \Sysuser
directory, you are sharing the information with any other Company that also stores
their same table in the \Barscanw\Sysuser directory.  

For instance, if you want to share Catalogs between two Companies, both
Companies should specify the Sysuser directory as the directory where they want
to store their Catalog table.  In this manner, each Catalog that you add in either
Company will appear in the Catalog table for both.

The Catalog is only one example of tables that can be shared.
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In summary, There are three item you must decide on prior to setup of a new
company database.

The first is what Tables do you wish to share. You have to make this decision
independently for each database that you wish to create. Typical Table choices for
sharing are:

    Location Table
    Organization Table
    Catalog Table
    Catalog Category
    Manufacturer Table

The second item to consider is if you want to duplicate the UDF fields or not.
Again, you have to make this decision independently for each database that you
wish to create.

The third item is if you want to use the Bar|Scan SmartClient for other databases.

Lastly, if you plan on creating many Companies with shared tables, custom
reports, User Defined Fields, etc., consider modifying the BarScan Template
Company first.  Then using the Company-> Save As menu item to copy this
company.  Is this way you will reduce the amount of work needed.
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INTRODUCTION

The Microsoft ClickOnce deployment technology makes the Bar|Scan Smart
Client application installation easy to distribute throughout your network using
Internet Explorer or Microsoft Edge.  It can also be deployed outside of your
network via the Internet.  The user navigates to a web page which is provided by
the Bar|Scan Smart Client installation and hosted on your web server.  The user
then selects the ‘Install’ button.  They are then asked for installation permissions. 
The Bar|Scan Smart Client then installs on their desktop with all of the required
prerequisites. 

There is a set of videos on our website that can provide you with additional in
operating Bar|Scan.  These are titled Quickstart Overview Videos and can be
found on this page: https://www.barscan.com/support-videos

Please consider viewing or downloading these as part of your learning experience.

Once the Bar|Scan Smart Client is installed, the user can start the application any
time from their ‘Start’ menu or desktop shortcut without accessing the web page
again.  Updates are also easy to distribute.  Once installed, any new version of the
Bar|Scan Smart Client can be placed on your web server and are automatically
deployed to your user groups.

Administrator requirements:

The Bar|Scan Smart Client is an augment to the Bar|Scan Asset Management
System which must be previously installed.  The Bar|Scan Smart Client shares this
database with the main Bar|Scan application.

Your Administrator will need to setup two components on your website, one for
the Bar|Scan service, the other for the Microsoft ClickOnce distribution.  Each of
these require a separate virtual directory, one pointing to the Bar|Scan Service and
the other to the ClickOnce files.

Bar|Scan, Inc. has a separate Bar|Scan Smart Client Installation Manual to assist 
your Administrator.
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FIRST TIME USE 

When you click to or enter the internet address of the Bar|Scan Smart Client in
Windows Explorer you will be presented with a screen similar to the following.

If you already have the .NET Framework installed, you can press the ‘launch’
hyperlink as shown in the example above to begin the Bar|Scan Smart Client.

If you do not have the .NET Framework installed, select the Install button.

Microsoft supports other Browsers unofficially.  You will have to test your
preferred browser, if you are not using Windows Internet Explorer.
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If you are not sure, press the launch hyperlink.  If you see the following screen
then you need to go back and select the Install button.

 

You may be asked to save the setup.exe file.  If you see the following screen,
select ‘Save File’.
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Once the .NET is installed, you will see the following screen.

Select Install to continue the Bar|Scan Smart Client installation.

After the installation is completed, you can start the Bar|Scan Smart Client at any
time by selecting it from your Start Menu as shown below.

You can also drag or copy a shortcut to your desktop.
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When launched, the Bar|Scan Smart Client always begins with the following
screen.  The length of time that this screen is displayed is determined by your IT
Infrastructure.

When the verification is completed, the Bar|Scan Smart Client Log In Screen will
appear on your desktop.

You will also see a new shortcut to the Smart Client as shown below.
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THE LOG IN SCREEN

When the verification is completed, the Bar|Scan Smart Client Log In Screen will
appear on your desktop.

The default Log in is:
Customer Code: <blank>
Company Code: DEMOCO
User ID: MAS
Password: MASTER
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Contact your Bar|Scan Administrator for the four login items that you will need
to complete.  Your User ID and Password may be the same as given to you to
access the main Bar|Scan application as all passwords are stored centrally in
Bar|Scan.

The Customer Code and Company Code do not necessarily have to match the
corresponding codes in the Bar|Scan database.

The information is not case sensitive.  When completed press the Ok icon.

If you receive the message “This account does not allow remote logins”, it means
that your password does not allow you to use the Smart Client.  Contact your
Bar|Scan administrator for further instructions.  The settings for remote login are
on the User Screen, Account Management, User Rights Tab as shown below.
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THE MAIN MENU

You are now presented with the Bar|Scan Smart Client Main Menu Screen similar
to the one below.

The icons that display are dependent on which modules and version of Bar|Scan
is installed on your server.

Immediately below the Title bar, the Feature Categories are listed.  These Features
Categories allow you to access all of the primary features of the Bar|Scan Smart
Client.

As with most Windows compatible programs, simply click on the desired  Feature
Category, and a drop down menu will appear, listing the Features.
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When you select File, you will see a drop down menu.  You can select any of the
Features that are highlighted, such as Open, Close, or Exit.  Some of the Features
have additional menus that will appear when that Feature is highlighted  signified
by an arrow ( ...<) located to the right of the Feature, i.e., select File, then Open
...<, then Asset ...<, Assets.

The ‘Clear Local File Cache’ choice is used to clear up some data access and
screen appearance problems.  The Local File Cache is always cleared when you
exit the Bar|Scan Smart Client.
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When you select Help, you will see a drop down menu with the Help Feature. 
When selected, a panel similar to the following will appear.

On this drop down, the Bar|Scan Smart Client support information is presented. 

You may review our support terms at our website.  Visit www.barscan.com and
click on the Support Button.

Your Bar|Scan Administrator may also have a formal process for support of this
software.

Page 18-10 Bar|Scan® Smart Client

http://www.barscan.com


Chapter 18

THE ASSET PANEL

When you select File, then Open ...<, then Asset ...<, Assets or click on the Assets
Icon, a panel similar to the following will appear.

In the above example, six columns are being displayed.  To change the Sort Order,
simply click on the Column Title.  For example, to sort by Current Building, click
on the light grey box above that column.  The data will then resort.

An arrow along the left side of the Panel indicates which asset you are editing. 
An example is shown below.
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You can change the Filter and Columns that you wish to have displayed.  This is
done by selecting a new ‘Set’ as in the example below.

In this example, the asset information presented can be changed based on two
different ‘Set’ commands.  The list of ‘Set’ commands can be viewed by selecting
the pull down button to the right of the bar.

Page 18-12 Bar|Scan® Smart Client



Chapter 18

To edit any individual asset record, select the record by clicking anywhere on the
row followed by clicking on the ‘Edit Current Asset’ Tab.  A Panel similar to the
following will appear.

The asset fields that are displayed on your Panel are controlled by your Bar|Scan
Administrator.  Your Administrator can add, change and remove fields at any
time.

There is no Global or Mass editing feature available such as the Range Command
in the Bar|Scan Application.  Edits can only be made to one item at a time.

The Smart Client field widths cannot be adjusted.  Sizing is done automatically
by the browse component based on the width of the visible data in the column.

When the editing is completed, you need to press the Save (disk) Icon to save your
work.

The Save and Undo Icons are displayed below.

Bar|Scan® Smart Client Page 18-13



Introduction

If you encounter the following screen after pressing save, it means that either your
User ID does not allow you to write data or you do not have the Read/Write
version of the Smart Client installed.

Contact your Bar|Scan Administrator if you believe that you are getting this
message in error.
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THE SET PANEL

Set is the most useful feature of Bar|Scan.  It allows you to order, filter, and
display any field related to assets in your database.  You can add customized Sets
to perform extensive review and editing quickly.  Review the Set Panel carefully,
it will be your most effective editing tool.

When you sort any of the information in any of your tables, you will be using the
Set feature.

When you select File, then Open ...<, then Sets  or click on the Sets Icon, a panel
similar to the following will appear.

Sets in the Bar|Scan Smart Client are independent of and different than Sets in the
main Bar|Scan Application.  That is, when a Set is created in the Bar|Scan
Application, it will not appear in the Bar|Scan Smart Client.

Sets are user based and not shared among different users.  Therefore a Set that you
create is not available for use by others.  However, your Administrator can make
Sets that are available for use by all other users.  This is discussed in more detail
in the Smart Client Installation Manual, section 14. Configuration Notes.
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To create a new Set, you press the Add button on the Set Browse panel.  The
button is on the toolbar and looks like the following.

A new blank Set is create with no title.  Now click on the ‘Edit Current Set’ Tab. 
A To edit any individual Set record, select the record by clicking anywhere on the
row followed by clicking on the ‘Edit Current Set’ Tab. 

A Panel similar to the following will appear.  
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You can select the Add button to begin adding columns and filters.  A pop-up like
the one will appear

Notice that the ‘Select a Field’ pop-up has 2 areas.  The top area has a pull down
button like the example below to the right of the area.  This is where you can
change the Table from which to choose your fields.

Some fields that you would like to display are probably not in the Asset Table. 
In the example below we have chosen the Catalog Type, Catalog Description, and
Manufacturer.  All three of these fields are located in the Catalog Table.
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Important: the order that you place the columns in the list is the alphabetical order
that they will be displayed and printed in.  To change the order, click on any of the
column titles in the Browse Screen.

The filters that you create can be very simple like ‘Current Building = 500'.  This
will display all Assets that are located in your Building as of the last inventory.

The filters that you create can also be more powerful.  In the following example,
the filter shows all Assets that are located in your Building as of the last inventory
but were not there before.

Obviously, the filtering capability is quite robust making it useful to display only
assets that are in your charge that are in locations relevant to you.

Finally, you can add subtotaling as well as Sum, Count, Max, Min and Average
to your Set.   
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Common fields to subtotal include location, manufacturer, etc.  Financial Fields
will automatically total as in the following report example of subtotaling on
Catalog Type:
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REPORTING

The Bar|Scan Smart Client can print reports based on your Set Commands.  While
not as extensive as the reporting capability in the main Bar|Scan Application, they
are usually sufficient for most Smart Client users.

To create a report, first select the Set Command that defines your sort, filter, and
fields that you would like to see on the report.  Then press the Print button on the
Asset Browse or Asset Edit screen.

A Print Preview similar to the above will appear.  You can now choose to print
or abandon the report.  The Smart Client can print preview up to 1,000 pages. 
However this will not affect printing.

As mentioned earlier, reports can contain subtotals.  Subtotals are added in the Set
Panel as described in the previous section.
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DESKTOP UNINSTALL

The Bar|Scan Smart Client can be uninstalled from your desktop at any time.  This
is done by accessing the ‘Programs and Features’ within Control Panel in
Windows.

Once you click on the Name ‘Bar|Scan Smart Client’ a window like the one below
will appear.

Click on ‘Ok’ to remove the Bar|Scan Smart Client.
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Chapter 19

INTRODUCTION

This chapter is designed to help you better understand Bar|Scan in less time than
reading the whole Bar|Scan User Manual by giving you an overview of many of
its features.  By going through this chapter, you will have more information
available to help you make very important decisions regarding how you will be
taking your inventory.  The more you know about Bar|Scan and its available
features, the clearer your implementation choices become.

There is a set of videos on our website that can provide you with additional in
operating Bar|Scan.  These are titled Quickstart Overview Videos and can be
found on this page: https://www.barscan.com/support-videos

Please consider viewing or downloading these as part of your learning experience.

WHO SHOULD READ THIS CHAPTER?

This chapter addresses the needs of persons actually doing the physical inventory
as well as operating the software.  Unless you are directly involved with taking the
inventory or operating Bar|Scan, you do not need to review this chapter.

If you are unfamiliar with Bar|Scan, you will also need to review Chapter 5 -
Operating the Bar|Scan System, and refer to it in order to operate the software and
proceed with the tutorial examples in this chapter.  You may need to rely on the
instructions in the other parts of this User Manual for the details on operating the
software as well as the Mobile Device. 

Before you proceed, we recommend that you read Chapter 4 - System Overview. 

CHAPTER ORGANIZATION

The tutorial contained in this Chapter is divided into two sections.  The topics they
contain are different and distinct.  You can review either part independently of the
other.  The following is a brief description of the contents of this chapter.

Section 1 - Demonstration Database Tutorial uses a real asset database to
instruct you in how to use Bar|Scan.  We suggest you familiarize yourself with this
database before you begin working with your company's actual assets.
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Section 2  - Mobile Device Tutorial provides instruction to demonstrate how to
use the Mobile Device in conjunction with the Bar|Scan system.

SECTION - 1 DEMONSTRATION DATABASE TUTORIAL

OPENING BAR|SCAN WINDOWS

Double click on the Bar|Scan Windows icon, and you will see a window to
Welcome you to Bar|Scan as shown below.

Please type your User ID and press <Enter>, then type your Password and press
<Enter>.  Then press <Enter> again, or click on the Ok button.  You will then see
the Bar|Scan Windows Main Menu.

If you have just installed your system, or if you have not been given your own
User ID and Password by your Bar|Scan administrator, the default User ID and
Password are MAS, and MASTER.  Simply type mas in the User ID field, and
press the Enter key.  Type master in the Password field, and then press the Enter
key.  Then select the OK button by pressing Enter again, or click on it with your
mouse.  Bar|Scan Passwords are not case sensitive.

If you click on your Bar|Scan shortcut and are taken immediately to the Main
Menu, then Single Sign On is enabled. 

Note: The version number for the software is listed at the top of this screen, as
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well as on the Help drop down menu, under About Bar|Scan for Windows.
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INTRODUCTION TO DEMOCO COMPANY

If you have just installed Bar|Scan, the Main Menu will not list a Company name
on the title bar.  If your system has no company name listed, or a name of a
company other then Democo, you will need to open the Democo company.  The
way to do this is demonstrated below.  Simply select File . . . <, Company . . . <,
Open.
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When you have selected to Open a Company, you will see a Look up Window
similar to the one below.

Make sure the Look in Field displays the BarScanw folder, and your list should
look similar to ours.  Click on the folder called Democo so that it is highlighted,
and then select the OK button.

Tip: If you have trouble locating the BarScanw folder, right click on the shortcut
to BarScan on your desktop and select Properties.  This should show the location
where BarScan is installed on your computer or network. 
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You will be shown another Look up Window as displayed below.

You will see the democo.dbc folder in this window.  Click on it to highlight it,
and the field next to the word company will change to say Democo.  Select the
OK button.  Your Democo company will now be open, and the blue title bar at the
top of the Main Menu should display the word Democo.

Bar|Scan includes at least two databases, your own and a demonstration database. 

By selecting File  . . . <, Company  . . . <, Close, then selecting the Company, you
may close the current company.  Then, by selecting File  . . . <, Company  . . . <,
Open, you may select a different company from the Main Menu.  You can switch
back and forth between the two companies at any time, making sure that you have
only one company open at a time.  If you have the Multiple Company version of
Bar|Scan, you can keep both companies open at the same time.
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If you have already used the demonstration database, you may need to
reinstall it.  This tutorial relies on exact step by step instructions through the
demonstration database.  Changes you or a previous user made to the
demonstration database may have altered the expected responses.

The Bar|Scan CD contains a demonstration copy of BarScan with a democo asset
database that can be installed on your computer.  Please consult Bar|Scan, Inc. or
your Bar|Scan Dealer before attempting to reinstall the demonstration database.

We have provided a demonstration database to help you become more familiar
with the system as well as provide a memory refresher if you have not used
portions of the system for a while.

The demonstration database is only an example of how you may organize your
assets.  It is not designed to be the model of how you should implement your
system.

You may decide to not track as much information as supplied in the
demonstration, or you may decide to keep the information differently.  For
example, your Catalogs may not need to be as  detailed as our examples are.

While you may not need all of the detail that we have put into the demonstration,
it is good to know that you have the option of utilizing these features in the future.

Training With Demo Page 19-7



Training With Demo

TUTORIAL SUMMARY

The tutorial consists of step by step instructions to experiment with the different
features.  It is in order in which we recommend learning the features of Bar|Scan.

Our objective is to show you features that we want you to be familiar with. 
You may not use some of these features in your asset management program, but
you should be aware of them.

We will be reviewing the following topics in this tutorial.

%  Beginning the Tutorial
%  Organizations
%  Locations
%  Catalogs
%  Transactions
%  Assets

INSTALLING THE DEMONSTRATION DATABASE

Installing the demonstration database will NOT affect or erase real asset
information unless you have entered real asset information into the demonstration
tables by mistake.

To check if you are currently using the demonstration database for real assets,
look for the word Democo on the title bar on the Main Menu of your Bar|Scan
system as shown below.
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If it says "DEMOCO" on the line, you may proceed with the demonstration.  If
not, refer to the previous section  to learn how to open a new company.

If you have accidentally used the demonstration database for real assets, DO NOT
PROCEED with this tutorial.  Call for technical support so that we can help you
correct this situation.

The demonstration database contains:

% An Organization Table with about 22 organizations
% A Location Table with about 56 locations
% A Personnel Table with about 48 personnel
% A Catalog Table with about 80 catalogs
% A Work Order Table with about 6 work orders
% A Transaction Table with about 50 transactions
% An Asset Table with about 550 assets
% A Catalog Table with about 80 catalogs
% A full set of System Reports
% Four Mobile Device Configurations
% Relevant entries in supporting tables such as the Condition Table

All of these Tables will be installed as part of the demonstration.  You cannot
select specific Tables because they share common information and will not work
individually.

BEGINNING THE TUTORIAL

If you have accidentally used the demonstration database for  real assets, DO
NOT PROCEED with this tutorial.  Call for technical support so that we can help
you correct this situation.

After you have installed the demonstration database and wish to begin the tutorial,
click on the Bar|Scan Demo shortcut on your desktop.

We have arranged this tutorial to work with the tables in the order in which you
will probably be creating your real database.
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TOOLBARS

There are almost always two or more ways to do anything in any Windows
program.  Your Bar|Scan program includes two ways to open any of your
programs, any of your reports, any company, two ways to import information from
your Mobile Device, and two ways to exit the program.

To reach any of the items listed above, you need to go to the Main Menu in
Bar|Scan.  You can use the File drop down menu, or you can access one of the
toolbars in Bar|Scan.  Toolbars are simply shortcut icons that you can add to your
Main Menu.  To access the toolbars, go to the View drop down menu, and select
toolbars as shown below.

We have selected Icons without Captions. 

The first toolbar listed is the Synchronize Toolbar.  This
toolbar is used to synchronize a Mobile Device.  The toolbar
looks like the one at right.

Page 19-10 Bar|Scan



Chapter 19

Although there is only one icon in this toolbar, it may be helpful to you, if you 
regularly synchronize Mobile Devices.

The second toolbar, the Company toolbar looks like the one below.

This toolbar includes two shortcut icons.  The first icon opens a company.  The
second icon closes a company.  Below the two icons there is a drop down field,
where you can select the company that you wish to open or close.  

Obviously, because this toolbar deals only with opening and closing companies,
you would only benefit from this toolbar if you have a Multiple Company version
of Bar|Scan and your work involves switching between the various companies.

The third toolbar, the Reports toolbar is shown below.

This toolbar allows you to open any of the respective types of reports, with just
a click on the proper icon.  The icons from left to right open reports for: assets,
transactions, catalogs, locations, miscellaneous, all types, location history,
organizations, and work orders.

You do not need to memorize the order, as using them will soon allow you to
know them by heart, and placing your cursor over them will show you a balloon
pop-up that will say what they will open.
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The fourth toolbar, the Table toolbar is shown below.

This toolbar will allow you to open any of the major tables by simply clicking on
the respective icon.  The icons from left to right represent tables for: assets,
catalogs, locations, organizations, transactions, personnel and work orders.

You do not need to memorize the order, as using them will soon allow you to
know them by heart, and placing your cursor over them will show you a balloon
pop-up that will say what they will open.

The last toolbar listed, the Exit toolbar is shown below.

Clicking on this icon will close the Bar|Scan program.

The last two items on the View drop down menu will turn all of the toolbars on,
or turn all of them off with just a click beside the proper option.

The use of icons is optional, but can save you a great deal of time.  You can also
arrange your icons on your Main Menu by dragging the outside edges of the icons
to the area of your choice.  Your Main Menu might look slightly different from
ours because of this.
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The ‘Show Current Company’ item is shown below.

It is located at the bottom of the Bar|Scan Main Menu and displays the Company
Name of the selected database.  Using your mouse scroll wheel will adjust the
size.

The last two items on the View drop down menu will turn all of the toolbars on,
or turn all of them off with just a click beside the proper option.
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OVERVIEW OF THE SYSTEM

The Bar|Scan system was designed to include as much information as possible
about each of your fixed assets.

In order to make the system easier to use and maintain, the information is broken
up into separate tables.  Let us now explore briefly what type of information each
table was designed to contain, in the order of what is to be entered first, and why.

Organization Table

The Organization table is an optional feature, and was designed to hold
departmental information or cost centers.  Therefore, if your company tracks
assets according to which department is responsible for them, you may want to
collect this information.  

The Organizations (or departments) may be “linked” to a location, or to individual
assets.

If it is not necessary for your company to track this type of information, you may
decide to not use this feature, but we will demonstrate how to add Organizations
to your table in our demonstration for those who wish to use this feature.

Location Table

Most of the items in the Location table are optional, but we suggest that you take
full advantage of all of the options in this table, as it can make tracking your assets
much easier in the future.

The Location table will hold three different types of locations: Site locations,
Pallet locations, and Vault locations.  Each of these different types of locations
can be used by any given company, but the most widely used are Site locations,
designed for office type buildings.  For more information on the Pallet and Vault
locations, please see the Locations chapter of this User Manual.
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Let us review the type of information that the Site locations were intended to hold.
There are fields for: Region, Building, Floor, Room, Room Tag, Location
Description, Referenced Organization, and Square Footage.  The first four fields
listed here, have a hierarchy from largest to smallest, and while consisting of five
fields, are considered “one” location.

The Region field was designed to make it easier to track assets for Large areas. 
Therefore, if you have assets in several different cities or states, you could easily
separate the assets by designating a two-digit abbreviation for the separate areas,
i.e., CA for the state of California.  You can also stretch the length of the Region
field as well as the other text fields to accommodate a longer text.

The Building field was designed to make it easier to track more than one building
full of assets.  This way, you could make an abbreviation for the building, or use
the building’s address number for its designation.  Unless you stretch the length
of the field, the building field can hold up to five characters.

The Floor field was designed to make it easier to track your assets by designating
which floor they exist on.  If your building has more than one floor, we suggest
that splitting the locations into separate floors is not only logical, but can make
finding each asset easier in the future.    Unless you stretch the length of the field,
the floor field can hold up to five characters.

The Room field was designed to make it easier to track your assets by designating
which room the assets exist in.  The Room field is usually filled with a room
number.  As mentioned before, unless you stretch the length of the field, the 
Room field may contain up to six characters.

The Room Tag field is an optional field, but was designed to assist those doing the
inventory by making a single unique bar code for each location that would
eventually represent the Region, Building, Floor, and Room.  This field can hold
up to eight characters.

The Location Description field is an optional field, but was designed to hold
additional information about the location, which may include things like the entire
address of the building, or something as simple as a description of the room, i.e.,
Conference Room or Cubicle.
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The Referenced Organization field is designed so that once the Organization table
is filled out with the departmental information from your company, you can
designate an entire room or location with its corresponding department.  This field
should ONLY be used in this scenario if the ENTIRE location is filled with assets
from ONLY this department.  Therefore, if a room is filled with only items that
belong to the Accounting department, you can safely add the Accountings
Organization to this field.  If, however, the assets in the room belong to two or
more departments, or if that information frequently changes, you should leave this
field blank, and associate the department information to the actual Assets during
the inventory process.

The last field is Square Footage, and is optional.  This field was designed for
companies that track the number of square feet in any given location, mainly for
billing purposes.

Personnel Table

The Personnel table is an optional feature, and was designed to hold information
about persons to whom your assets are assigned to.  Therefore, if your company
tracks assets according to which person is responsible for them, you may want to
collect this information.  

The Names (or users) are “linked” to individual assets.

If it is not necessary for your company to track this type of information, you may
decide to not use this feature, but we will demonstrate how to add Names to your
table in our demonstration for those who wish to use this feature.
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Catalog Table

The Catalog table was designed to hold all the descriptive information about your
fixed assets.  Think of the Catalog table as you would a retail catalog book from
your favorite store.  When you look in the catalog book from your favorite store,
you might notice that it is divided into Categories.  Within each category, there are
various types of items.  Within each type of item, there are descriptions of each
of these items, and perhaps even a picture, i.e., if you are looking for a new drill,
you would go to the tool section, go to the drills, and then look through the
descriptions to find the specific drill that you want.

The Catalog table within Bar|Scan is designed to work in exactly the same way. 
We have divided each Category by Catalog Types, and each type by Catalog
Descriptions.  Then, there are spaces for the Manufacturer, Manufacturer’s part
number, extra Manufacturer’s information, and then, in addition to these fields, 
there are up to seven fields available for each Category for additional information. 
If you had a Catalog of a drill from Bar|Scan, with this many fields of information
filled in, you should be able to go into any room filled with drills, and pick out the
specific type and model of drill described in the catalog.  

As with any catalog, the information in the catalog only points to the type of item
(like the type of drill).  The store may have fifty of these drills, and you may order
as many of these them as you want.  The catalog gives you only information about
the type of item.  If you want to know the serial number of the drill, you wouldn’t
expect the store to list that information in their catalog.  Bar|Scan does not put that
type of information in the Catalog table, either.  Any information definitive to a
specific Asset, will be linked to the actual Asset in the Asset table.

There is an optional Imaging module for Bar|Scan.  This module would allow you
to add a digital picture to each Catalog.  
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Transaction Table

The Transaction table was designed to hold the information that is collected with
the Mobile Device.  When the Mobile Device is synchronized, the information is
placed into the Transaction table.  Once the information is in the Transaction
table, you can check all of the information to ensure that it is correct before
moving that information into the Asset table.

Asset Table

The Asset table is where all of the information from every table of Bar|Scan
comes together.  Each Asset can contain: an Organization, a Location, a Catalog,
and any other information that is specific to that particular information, such as
a Serial Number, an old inventory number, even the date and time that the asset
was inventoried.  Depending on the modules that you purchased with your
Bar|Scan system, you may even store Accounting and Work Order information
about each asset in the Asset table.

Using the System

Now that you have an idea of the types of information that each table was
designed to hold, you can begin the tutorial in order to learn in a practical manor
how this information comes together.  Even if you do not plan on using a specific
feature, we suggest that you go through the entire tutorial so that you will feel
more comfortable with your system when you start using your own company.  

During this tutorial, you will see that all of the different tables work in the same
manor.  Each of the tables have a toolbar of their own (located at the bottom of the
table) making it easier for you to use the table efficiently.

You will learn how to Change Organization information, Add a Template
Location, and Add a Blank Catalog, move around and check problems in the
Transaction table, and move columns, and sort the database by different
information in the Asset table.
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ORGANIZATIONS

Let's proceed with our step by step tutorial now.

Select Organizations from the Main Menu.  If you are not at the Main Menu, you
can probably get there by closing a panel, or by backing out of a feature by
pressing the ESC key.  Select File . . . <, Open . . . <, Organizations as shown
below.

Optionally, if you have added the table toolbar to your Main Menu, you can
simply click on the Organization icon as shown below.
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You will see the Organization table.  The Browse panel should be selected when
it first opens.

Notice that there is a Tool Bar located at the bottom of the Panel as pictured
below.  Each button is explained in more detail in Chapter 4- System Overview.

The tool bar is displayed at the bottom of each of the tables.  Each button on the
tool bars has a balloon description that will appear when you hold your mouse on
top of it.

We can perform several actions including Find, Add, Delete, and Set.  
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We now want to experiment with moving around inside of the Browse panel.  To
do this we will use many of the cursor movement keys on your PC keyboard.

Press the Page Down key to scroll down in the window.

Press the Page Up key to scroll up in the window.

Press the Control key and the End key to go to the very end of the file.

Press the Control key and the Home key to go to the very beginning of the
file.

Press the Up and Down arrow keys.

Now use the First Item, Next Item, Last Item, and Prior Item buttons
from the Tool Bar.

As you can see, we can move through the entire database by simply using the
cursor movement keys.  As with your choices so far, you may also use your mouse
to click on your choice, or to click on the scroll bar at the right of the Browse
window.

You will want to refer to Chapter 5 - Operating the System for more information
on how to use the mouse with the windows. 
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Most of your work will start with the display of a Table, showing the Browse
panel.  The information contained in a Table’s Browse panel can be changed
easily by using the Panel feature on your main menu.  

Without going to the Main Menu, you can change the order that the information
is presented in by changing the Order By (it will sort differently) and you can
change the order of the columns as well.  In addition, Browse panels can be
scrolled.  You can use the tab key to view columns past the right side of your
panel.  You can also resize the panels, by placing your cursor on the edges, and
when it turns to a two-headed arrow, left click and drag the screen.  

A sample window is displayed below.

Use your mouse to experiment with the above browse features.
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Select the Organization Code 01B 1 from the Browse window, and then select the
Edit tab, you will see an Edit panel similar to the one below.
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At this point, you are Editing (or Changing) the information shown on this
Organization.  

Use the down arrow key on your keyboard or Enter key, move your cursor down
to "dept.".

When your cursor is in the department field, use your mouse to right click, and
select the Look up Value as shown below.
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A Look up Window will appear, presenting you with a list of available
Departments to choose from.

You should already know how to move around inside of this window.  If not,
review Chapters 4 and 5 of this User Manual.  

By using the Page Down and/or down arrow keys, scroll down the list of
Departments until you are on Production.

Place your cursor on this item, to “highlight” it, as shown below.
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Let us change the Organization by selecting to use the Production Department
from the Look up Window. 

Place your cursor on the word Production, and then select to use it by clicking on
it twice, pressing the <Enter> key on your keyboard, or clicking on the OK button.

Your Organization should now look similar to the one below.

It is important to note that you have just created a new structure titled
"Admin/Production/App. Suprt" by changing the Organization’s Department  to
Production.

Page 19-26 Bar|Scan



Chapter 19

If you were going to save the change to the Organization, you would press the
Save button (the icon that looks like a floppy disk) from the tool bar, or press the
Ctrl + S key combination to save the change to the new Organization.  Click on
the Save icon.

A final prompt will appear to verify your request.  

You may respond Y for yes or N for no.  We recommend that you respond N so
that you can redo this portion of the tutorial without having to reinstall the
demonstration database.

You are now finished with this portion of the tutorial.  

Select the Cancel Changes (to Select Organizations) icon from the toolbar.  It
looks like the icon below.

You will be asked to confirm your choice to cancel the changes.

Press the X at the top of the Organization table to close it.  You should again be
at the Main Menu.
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PERSONNEL

You have changed an Organization, now Add a Name.

Open the Location table from the Main Menu, select File ... <, Open ... <,
Personnel as shown below.

Or, if you have the Table toolbar on your Main Menu, you can simply click on the
Location table icon, shown below, to open the Location table.
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When you open the Personnel table, the Browse panel will be selected by default
as shown below.

Click on the Edit tab.  Then, in order to add a new name, select the Add Blank
button from the toolbar as shown below.

You will be shown a dialog box that will ask you to confirm your choice to add
a blank Personnel.  Select Yes.
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You will be shown a window similar to the following.

There are several fields that together create the Full Name.  You can enter a First
Name, Middle Name or initial and Last Name.

Page 19-30 Bar|Scan



Chapter 19

You can also add a Uniqueness Value.  This may be necessary when you have two
or more personnel with the same Names, e.g. Ronald W Meyers.  Notice below
that the Full Name get completed for you as you type.

The Full Names are completed according to a specified format.  The format is
displayed on the screen below.

The format L,F,MI,U means that the Full Name will be (L)ast, (F)irst, (MI)ddle
Initial and (U)niqueness Value.  The Current Name Format can be changed in the
Company Settings Screen.
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Select the Save button from the toolbar or the Ctrl + S key combination to Save
the changes to the Location.  You will be shown a dialog box similar to the one
below.

You may respond Y for yes or N for no.  We recommend that you respond N so
that you can redo this portion of the tutorial without having to reinstall the
demonstration database.  Select the Cancel Changes to Select Locations icon from
the toolbar.  It looks like the icon below.

You will be asked to confirm your choice to cancel the changes.  Press the X at
the top of the Location table to close it.  You should again be at the Main Menu.
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LOCATIONS

You have added a Name, now Add a Location.

Open the Location table from the Main Menu, select File ... <, Open ... <,
Locations as shown below.

Or, if you have the Table toolbar on your Main Menu, you can simply click on the
Location table icon, shown below, to open the Location table.
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When you open the Locations table, the Browse panel will be selected by default
as shown below.

Place your cursor on the MP-500-09-0900C Location.  Then, in order to add a
new Location, select the Add Template button from the toolbar as shown below.

You will be shown a dialog box that will ask you to confirm your choice to add
a Template Location.  Select Yes.
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Then, select the large Edit tab, and you will be shown a window similar to the
following.

There is an exact duplicate of the Location that you chose as a template listed on
this panel.  

If you were adding your first Location in your own company, you would not have
one to use as a template.  During this instance, you would need to select the Add
Blank Location button from the toolbar, it looks like the one below.  But, for this
tutorial, there are already Locations listed in the Location table, and you may
simply Add a Template Location, and make changes to it.

Until the Locations have been added, more than likely the information that you
use to add them will be displayed for you on maps of your buildings.  When you
made changes to the Organization, you right clicked while inside the field and
selected Look up Value when it appeared.  You can use this same technique for
all fields, but the information that you need to add may not be in the Look up
Window.
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If you were adding Locations for your own building(s), you would want to add
from a template after adding your very first location from a blank location.  By
using a template to add from, you would only need to change the fields that affect
the Location you are trying to add.  In our example, you selected the MP-500-09-
0900C Location for your template.  If the next Location that you were adding was
the same Region, Building, and Floor the only Location fields that you might have
to change are the Room, (Referenced) Organization, and the Square Footage.

Place your cursor in the Room field, and change the 0900C to 0900D by simply
typing over the old Room, as shown below.
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The Location Description can be changed by placing your cursor into the Location
Description field, and right click.  Select Look up Value, and you will be shown
all of the Location Descriptions that were entered into the Location table as shown
below.

Select Budgeting - Closed Office from the Look up Window, and you will be
ready to fill out the Organization information.
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The Organization can be changed by placing your cursor into the Organization
field, and right click.  Select Look up Value, and you will be shown all of the
Organizations that were entered into the Organization table.  The Organization
Look up Window is shown below.

Select the O2A 2 Organization, and it will be entered into your Location Edit
panel for you.  

Select the Save button from the toolbar or the Ctrl + S key combination to Save
the changes to the Location.  You will be shown a dialog box similar to the one
below.

You may respond Y for yes or N for no.  We recommend that you respond N so
that you can redo this portion of the tutorial without having to reinstall the
demonstration database.
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Select the Cancel Changes to Select Locations icon from the toolbar.  It looks like
the icon below.

You will be asked to confirm your choice to cancel the changes.

Press the X at the top of the Location table to close it.  You should again be at the
Main Menu.
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CATALOGS

Catalogs serve two primary purposes.  First, they allow assets to be easily grouped
and fully described in a very consistent manner.

Second, Catalogs make it easier to perform the physical tagging of assets on large
projects.  By downloading Catalog into the Mobile Device for your tagging teams,
we can familiarize them with the different kinds of assets.

Optionally, by the use of a digital image attached or an image printed on the
Catalog Sheet, we can give our tagging teams a visual representation of the asset.

For more information on the Cataloging process as well as the use of the Data
Collection Sheet to help collect Catalog information, see Chapter 2 - Suggested
Procedures.

Let's proceed with our tutorial now.

Select Catalogs from the Main Menu.  If you are not at the Main Menu, you can
probably get there by closing other windows.  To select Catalogs begin from the
Main Menu, select File . . . <, then Open . . . <, then Catalog . . . <, then Catalogs
as shown on the following example.
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Or, if you have selected to add the Tables toolbar to your Main Menu, you can
click on the Catalog icon as shown below.

You are presented with the following panel.

The Browse tab will be displayed at this point. The first column in the browse
window is the Catalog, other columns may vary since they can be customized by
you. 
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There is another way to move around inside of the Browse panel.  The “Seeking”
feature in Bar|Scan will track the characters you type.  Press the E character key
on your keyboard.

Bar|Scan will find the first Catalog Item that begins with "E.”  The first match is
"EA1000 Amplifierp.”  As you have just experienced, we cannot only move in the
window, but we can also find information by pressing character and number keys.

Now press the P key.  You can see that Bar|Scan will look for the closest "fit" to
the characters you type.  The match is "EP2000 Scanner, HP ScanJet 4890.”

If your match is not "EP2000,” you probably pressed an incorrect key.  You can
easily start the seeking process over by pressing the left arrow key several times. 
This moves the cursor back to the leftmost character in the window.

Notice just under with word “Browse,” the word “Seeking” with open and close
brackets to the right.  This item displays the characters you have typed to find the 
Catalog.  For example, at this point it will say “Seeking [EP]” because you typed
“EP.”

You may try new letters on your own.  If the highlight doesn’t, do not be alarmed. 
Bar|Scan is simply trying to tell you that it cannot find any selections that match
your choice.

Notice that the list of catalogs is in alphabetical order.  The first part of any
catalog consists of two letters, followed by four numbers, followed by a type, then
a description, etc.

When you feel comfortable with the way seeking works you might notice that
Bar|Scan will only let you choose two letters at a time, and then will stop every
time you press a letter, until you use the left arrow key to move the highlight away
from your letters.  This is because all catalogs begin with only two letters.  Now
type the a four digit number, i.e., 2504.  You have now moved from the first
catalog of your category.  Because catalogs need two letters, and four numbers,
catalog numbers need to be 0001 or more, our database starts at numbers of 1000.
Hint: The ‘-’ dash is only a spacer and need not be typed.
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Like before, you may still scroll up and down the list, and you may still use the
left arrow key to move the highlight to the left away from your choice.

You can continue typing characters.  Bar|Scan will try to find a match for every
character.  When no match is found, Bar|Scan stops on the closest  match, or it
will stop to show that no catalog was found that is even close to your choice.

Press the left and right arrow keys several times.

As you can see, arrow keys move your cursor left and right and can also help you
find the Catalog match that you are looking for.

Bar|Scan has a means to pick a group of items from the Look up Window.  This
is called the Range feature.  We are not going to use it at this time but it is fully
described in Chapter 5 - Operating the System.
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Adding a New Catalog Item

We are now ready to add a new Catalog.  Pick the Add Blank button by clicking
on it with your mouse.  The Add Blank button is located on the Tool Bar and
looks like this.

You are now presented with the following message to confirm your selection.

Select Yes by clicking on it.  Note: confirmation messages can be turned off in
your Personal Program Preferences after you become more familiar with the
program.

Make sure you have the laminated training sample form titled "NEW CATALOG
DATA COLLECTION SHEET" available now.  If you do not have one, you can 
print one from the Bar|Scan Report Generator.  

Using the training sample "NEW CATALOG DATA COLLECTION SHEET,”
you will now enter a new Casegoods catalog from scratch. 
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Click on the Edit Tab with the mouse.  You will be presented with an Edit panel
that looks similar to the one below.

Entering the New Information

After selecting a blank screen, move the cursor to the first input field to the right
of the word Catalog.

Now, using the NEW CATALOG DATA COLLECTION SHEET  supplied as
part of the training, let's enter the sample Casegoods catalog "CG1000" from the
form.
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Type CG and wait.  Bar|Scan will prepare the screen for Casegoods.  Notice that
the appropriate Casegoods attribute names will be displayed.

Hint: If you are not totally familiar with the different categories and their codes,
press the right mouse button when the cursor is positioned at the first data input
field, and select Look up Value.  
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Select Look up Value and Bar|Scan will display a Look up window that will look
like the one below.  After looking them over, you may select CG by selecting CG
and double click on it, press the Enter key, or click on the OK button.

Now type 1000 at the next field titled barcode.  The cursor will be positioned in
the Type field.

Press the right mouse button when the cursor is positioned in the Type field, and
wait for a menu.  Select Look up Value and Bar|Scan will display a Look up
window will look similar to the one below.
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You are requested to enter a type for  the new Catalog item.  Usually this type is
one or two words that generally describe the Catalog item.  Further and more
detailed information is entered using the Description and Attributes entries.

Complete your selection by clicking on the word DESK, then, double click on it,
press the Enter key, or click on the OK button.

Note: if you make an incorrect choice and you have selected OK to accept it, you
can change it by placing the cursor back onto the type field, again press the right
mouse button and select Look up Value, and simply choose the correct response. 
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You are now ready to choose a description.  With your cursor on the description
field, press the right mouse button and select Look up Value again.  (The
Description entry provides space for up to 25 characters which is used to further
describe the new Catalog item.)  The following Look up Window will appear.

Select SGL PED-L/LOCK - left as noted on the NEW CATALOG DATA
COLLECTION SHEET (SGL PED-L).  You will need to scroll down in order to
see the Sgl Ped- L entry.  When finished, press OK.

For many assets, size is an important part of their description. Bar|Scan provides
space to enter the three dimensions:  Width, Depth, and Height.

Dimensions are entered in inches and fractions of an inch.  Three digits are
provided to permit entries of up to 999 inches.  Fractions are permitted, but we
recommend you use only multiples of 1/4", because getting too technical on the
measurements can cause you to have duplicate catalogs to describe the same
piece.

If you are not already on the Width field, use the tab key to go to the Width data
entry field.  Type the Width/Radius as 69, press the Enter  key.  Type the Depth
as 36, press the Tab key.  Type the Height as 29, and press the Tab key.

Hint: You may use the arrow keys to move within the fields. 
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Bar|Scan provides a list of many manufacturers from which to choose for each
Catalog Category.  You are now ready to enter the Manufacturer information.

If your cursor is not on the Manufacturer data entry field, press  the Tab key to go
there.

When you press the right mouse button and select Look up Value, the following
Look up Window will appear, as shown below.  

The list of manufacturers appearing in the above will depend on the Catalog
Category you have selected, i.e., the manufacturers are grouped according to the
Category.

Select STEELCASE from the list in the window and press OK.  Remember that
you may be able to speed up this process by typing the first couple of letters of
your selection, ST, and then using the cursor movement keys, or mouse to select
the one you want.

You may now complete the balance of the information.  Since desks rarely have
more information for manufacturer, you may use the down arrow to go past the
rest of the Manufacturer’s section of this panel.  You are ready to begin filling in
the attributes for your catalog.

Page 19-50 Bar|Scan



Chapter 19

You want to enter the left side as 2BX/1F.  (Use the right mouse button to see the
Look up Window and make your selection, remember you have to click on your
choice twice, or select it and then press the OK button).

You are now familiar with the process of picking the right mouse button to see the
Look up Value, and how to choose your information.  Try now to finish the last
five attributes, choosing Wood as the Top and Base materials, and Cherry as the
Top and Base Finish.

Hint: Since the desk has no center drawer and no right side drawer configurations,
simply press the down arrow key to find and select {N/A} for these attributes.

Optionally, if the date does not yet exist, type in today’s date in the Revised Date
field in the following formats: MM/DD/YY or MM/DD/YYYY.  Type  your
initials in the Revised By section.
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Click on the UDF Tab with the mouse.  You will be presented with a new  
Catalog Display Screen. This screen may be different in your real company
depending on your selection of User Defined Fields.  Also, if you do not have the
User Defined Fields module, or if you have not added any User Defined Fields to
your Catalog table, this tab will not appear.

This is what we call the User Definable fields.  If you purchased the User
Definable Fields module as part of your system, you could add fields for any extra
information that you want to collect.  

Since this is not necessary for this tutorial, we are not going to spend a lot of time
to explain this screen.  Simply click on the Edit Tab with your mouse, again. 
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Your new catalog should look like the one below, except the revision date and
initials should be different.
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Press the Save button on the tool bar, or press the Ctrl + S key combination  to
save your catalog.  You will then see a dialog box similar to the one below.

We recommend that you choose No, so that you can redo this part of the tutorial
without having to reinstall the tutorial database.

Note that the window above asks if you want to save “Changes” to the Catalog,
even though you were adding a Catalog.  This happens because, you added a
Blank Catalog when you pressed the icon on the tool bar, after that, you were
making changes to the Blank Catalog.

Select the Cancel Changes to Select Catalogs icon from the toolbar.  It looks like
the icon below.

You will be asked to confirm your choice to cancel the changes.

Press the X at the top of the Catalog table to close it.  You should again be at the
Main Menu.

You have now completed this portion of the tutorial.  Press the X button at the top
right of this panel to close the Catalog window.

You will again see the Main Menu.
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TRANSACTIONS

The Bar|Scan Mobile records the asset information which will be transferred to,
and entered into the Asset table.

The information transferred from the Mobile Device during synchronization is
temporarily placed in what we call a Transaction Table.  This table will hold the
information transferred from the Mobile Device until the information validates as
being correct, and optionally has been printed out and marked as printed.

Let's proceed with our step by step tutorial to correct asset information in our
Transaction table.

Select Transactions from the Main Menu.  Select File . . . <, Open . . . <, Handheld
Computer. . . <,  Transactions as shown below.

Or, if you have added the Table toolbar to your Main Menu, you could click on
the Transaction table icon, which is shown below.
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You are now presented with the Transaction table, with the Browse panel selected.

This screen displays all of the assets that information was collected with the
Mobile Device.

Since we have already experimented with how to move and select from the
Browse panel, let’s put it to the test.  Move your cursor to and select asset number
FA0000311800,  and then select the Edit tab.

Did you select the asset by typing the number or by moving your cursor with the
cursor movement keys?  Hint: in a large list it is faster to type in the asset number
to search for the matching asset.
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The Edit tab for this asset is shown below.

Bar|Scan checks for over 90 different types of logic errors.  This is done in what
is called the Validation feature.  As it checks for each of these items, Bar|Scan
will place a message in the Transaction table, on each asset.  Once validated, each
asset will have at least one message.  The message will either list the problem(s)
or it will say “No Messages or Warnings exist”.
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To Validate the entire Transaction table you can select the Validate Selected
Mobile Device Transactions, All if None Selected icon on the bottom of the
Transaction table which is shown below.

Or, with the Transaction table open, move it slightly so that you can see the Main
Menu.  Left click on  the word Transaction (between Panel and Help), and select
Transaction ... <, Validate ... <, All.

Bar|Scan will begin the validation of each Transaction, and show a small window
which displays the details of the validation.  You will see how many items were
validated, how many had warnings, how many had errors, how many did not have
errors.

When the validation has completed, return to the Edit tab of the Transaction table,
and select the Problem Handlers tab.
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The Problem Handlers tab is shown below.  This is where any and all messages
concerning the validation will appear.

This item is provided to identify many problems with an asset record in the
Transaction table.  Each Transaction can have more than one error, but most will
not have an error.

There are many possible messages which may appear in this window.  Each
message may require a different corrective action.  In some cases, you might only
have to correct an obvious misspelling, in others you may have to remove the
asset record from the Transaction table (a duplicate).  

You may correct an error only to find (when you Save the changes by choosing
the Save button) different errors are now presented.  Bar|Scan does extensive
checking to prevent you from entering the wrong information into the system, or
from destroying good information in the system.

As long as there are problems in the message box like above, the asset record may
NOT be transferred into the Asset table.  You will have to first correct the
problems.

The message “No Problems or Warnings in List” indicates that Bar|Scan has
found no problems with the asset record and it may be transferred into the Asset
table after all changes have been made, it has been printed out, and marked as
printed.  You may make changes or corrections even if this message is displayed.
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When you make a change to an asset record that previously had no problems, the
record is automatically validated, but it MUST be reprinted BEFORE it can be
transferred to the Asset table.

When you subsequently validate, print, mark the Transactions as having been
printed, then select Move, all asset records with this message will be transferred
into the Asset table, with one exception, the "Hold" feature.  We have placed all
of the Transactions in the Democo on Hold.  You can see this on the Problem
Handlers tab, as there is a check mark in the box next to Hold this Asset.  By
checking this feature, Bar|Scan will not allow the transaction to be moved to the
Asset table, until the check mark is removed.

Remember: Any correction(s) you make in your own company will not be
completed until you save your work by pressing the Save button, or until you
select any of  the other methods of saving, and respond (Y)es to save the changes. 
We are purposely avoiding use of the Save feature - as it would change the
demonstration database.  This way, you can step through the tutorial again.

When on the Edit tab, you can view the next Transaction or the prior Transactions,
simply by clicking on the Next Item and Prior Item buttons on the tool bar, or by
pressing the Page Up or Page Down keys.  Also, you can move to the beginning
or end of the transactions, by clicking on the First Transaction or the Last
Transaction buttons on the tool bar.

Try moving between Transactions by using the Next Item and Prior Item buttons.
Look at the different types of messages that appear on the Problem Handlers tab.

Find Asset number FA0000311200.  This Asset number appears twice, and each
of these transactions has a message on the Problem Handlers tab that says it is a
duplicate on both.  Someone apparently scanned this item twice.  

In order to correct these errors, the information from both transactions would have
to be reviewed, and the incorrect one should be deleted.  

Sometimes, in using the Tag mode, the duplicate Asset is in the Asset table, and
it is harder to determine why someone did the inventory of this item again.
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Look at the Asset tab, the Inventory tab, and the Location tabs as well, so that you 
get a good idea of how the information is separated by between tabs  in Bar|Scan.

Adding a Blank Transaction, Adding a Template Transaction, and making
Changes to the Transaction table works exactly like you have already done in the
other tables.  

So, practice moving around in your Transaction table and try to Add a Template
Transaction on your own.  Click on the Save button, but remember to respond No,
when asked to really save the changes to the transaction.  

Try making a change to a Transaction that has a Location that is not in the
Location database by right clicking while in one of the location fields, and
selecting Look up Value, then a real location.  Click on the Save button, but
remember to respond No, when asked to really save the changes to the transaction.

Note: In your own database, a message that appears in the Problem Handlers
section saying that the Location is not in the Location database, usually means that
someone entered the correct location by hand, incorrectly according to the
database, or that the location is correct, and needs to be added to the Location
table.  When you are working with your own locations, however, it will be much
more apparent which one is correct.  For our exercise though, it is enough to learn
that you can right click on a field, select Look up Value, and be shown a list of all
of the locations that are currently in the Location table.

You are now finished with this portion of the tutorial.  Press the X button at the
top right of the Transaction table to close this panel.
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ASSETS

At the heart of the Bar|Scan system is the list of your assets, and the associated
asset information.

We have saved working with your assets until the end of this tutorial because the
asset table is the largest and most “feature rich” portion of the system.

You should already be familiar with many of the Bar|Scan features and
conventions, having worked with Organizations, Locations, Catalogs and
Transactions.

Assuming that you understand the basics of Bar|Scan cursor movement and
editing, let's proceed with our step by step asset tutorial now.

Select Assets from the Main Menu.  Select File . . . <, Open . . . <, Asset . . . <,
Assets as shown below.
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Or, if you have added the toolbar to your Main Menu, you can simply click on the
Asset icon, which is shown below.

You are presented with the Asset table, with the Browse tab selected.  Note: the
columns that are available, and their order, are selected by the individual user, so
your table may appear slightly different from ours.

The SET feature allows you to order and identify a smaller, more manageable
group of assets from which to select, e.g., only those assets in a particular location
or only those assets made by a particular manufacturer, etc.

As the number of assets on your system increases it becomes more time
consuming to look through the entire list of assets displayed on a look up window.
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SET allows you to order or “sort” your assets by any item in the database.  This
makes it easier to find assets.

SET also allows you to change the columns seen in the browse window.

Because SET offers almost endless possibilities for identifying groups of assets,
we strongly recommend that you experiment with different specifications to
become familiar with this feature.  Experimentation with SET will NOT cause any
change to the information recorded for any asset.  It merely specifies the sequence
of asset selection lists.

When you want to view your assets in an order other than by asset number, select
SET, by clicking on the button shown below.

This button activates the Set feature, and the following screen will appear.
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This Set Order and Filter tab, shows a list of Sets that are pre defined in the
Bar|Scan system.  You can, however, define additional Sets.  Simply click on the
Add/Change/Delete button shown above, and the Sets table will open. 

If you would like to see the browse fields (these are the items that appear as
columns on your Browse tab), select the Browse tab.  When you select the Browse
tab, you will be shown the following screen.

The first field on the left side of the Browse Fields tab, says Asset and there is a
� to the right of  it.  This signifies that the fields listed below are stored in the
Asset table.  If you needed to access any of the other tables in your Bar|Scan
system, you would simply click on the down arrow, and a drop down list would
appear, revealing all of the other tables.  When you choose a different table, the
fields listed below it will change to reflect the available fields for the new table.

Again, on the left side of this screen is the list of all of the available fields for the
Asset table that you may display on your Browse panel.  On the right side of the
Browse Fields tab you will see the current fields that are being displayed as
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columns.  These fields are displayed for all of the different Sets, with the
exception of the first column, which displays what the information is sorted by.
Each individual Set can also have a filter set up to filter out items that you do not
wish to see.

The Set feature is a powerful tool, and should be experimented with.  Note: the
items that are chosen to be displayed from the right side of the above screen can
be moved to any order you desire here, as well as while being displayed.

In order to better demonstrate this concept, select one of the pre defined Sets from
the Set Order and Filter Tab.  You will see the items on your Browse tab sorted
by a different criterion, but the same columns should appear with the exception
of the first column–which displays what the table is being sorted by.

For the information displayed above, we chose the Serial Number Set.  Notice that
the first column is the Serial # and the rest of the columns are still the same as
they were when sorted by Asset number, i.e., Catalog Category, Catalog Number,
Catalog Type, Catalog Description, etc.  The only column that changed was the
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sort by column, the first column displayed.  A sort can contain more than one
column.  No matter what the sort of the list, the rest of the columns stay the same.

Changing the Order of the Columns Shown in a Set

If you don’t want to view the Serial number twice, you can move the second Serial
number column by clicking on its title with your left mouse button, holding the
mouse button down, and moving your mouse to the right or left.  The columns
will move to fill in the gaps as you move your mouse.  This is a useful tool and
much faster than respecifying the columns for a Set.  Practice moving the columns
with your mouse.

When you want to see the detailed information that has been entered into the
Asset table, you will need to select the Edit tab.  When you do, you will be shown
a screen like the one below.
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Every field on this screen can be entered at the keyboard, but most can be
collected by using the Mobile Device.  It is assumed that most of the items will
be entered by using the Mobile Device, and synchronizing to the Transaction
table.

Note that this tab has ten tabs on it as pictured below.

Each of these tabs contains fields for information about the assets.  If, however,
your company has not purchased the optional Accounting module, you will not be
able to access all of the tabs shown above.  Some of the tabs will appear with light
grey letters (called being greyed out) and you will not be able to access these tabs.

Click on each of the tabs, to review the type of information that each contains. 

Any of the items that appear in red and have a red underline are items that have
a hyperlink feature.  If you left click on these items, you will be able to view the
information for that item in a look up window. 

Practice moving from Asset to Asset using the Next Item button and the Previous
Item button from the toolbar.  

Practice selecting different Sets, seeing how the information can be sorted in
different ways.

Practice moving the columns around.

Practice adding a new column to the Browse panel.

You are now finished with the tutorial.  

Click on the X at the top right of the Asset table to close this window.  If
prompted to save any changes, remember to respond No, so that you may go
through this tutorial again, without having to make changes.
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SECTION 2 - BAR|SCAN MOBILE TUTORIAL

INTRODUCTION

In order to properly familiarize yourself with the nuts and bolts of utilizing the
Mobile Device and synchronizing information, please see Chapter - 11 - Bar|Scan
Mobile in this User Manual.

This section assumes that you have reviewed and understand the information
presented in that chapter.

Bar|Scan supports a number of different models of devices, this tutorial is
designed for the Android devices.  However, all of the concepts are the same no
matter which model you are using since each can collect the same information

If you take inventories only on an annual basis, it may be helpful to review the
materials in this section before beginning the inventory process.

There is a set of videos on our website that can provide you with additional in
operating Bar|Scan.  These are titled Quickstart Overview Videos and can be
found on this page: https://www.barscan.com/support-videos

Please consider viewing or downloading these as part of your learning experience.

TUTORIAL SUMMARY

The tutorial consists of step by step instructions for you to experience the different
features of Bar|Scan.  It is presented in the order in which we recommend learning
about the device.

Our objective is to show you features that we want you to be familiar with. 
You may not use some of these features in your asset management program, but
you should be aware of them.
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We will be reviewing the following topics in this tutorial:

%  Using the Sample Menu Reports
%  Using the Mobile Device
%  First Time Tagging
%  Taking an Inventory
% Synchronizing the Mobile Device
%  Printing and Checking the Transaction File
%  Concluding the Tutorial
%  Preparing for A Real Inventory

USING THE SAMPLE BAR CODE MENU REPORTS

The laminated Sample Menu Reports supplied with your system are useful for
training.  They ARE NOT required for an actual inventory.  Here is why.  When
you perform your actual inventory, you can download all of the information
contained on the Menu Reports into your device.  This happens automatically each
time that you Synchronize.

Our experience has shown that using printed Bar Code Menus can be an
advantage in some situations and a hindrance in others.  Once you learn the
inventory process, you will be able to determine their usefulness in your situation.

Using a location menu report can make the tagging process easier.  To create your
own location menu report requires that you have entered all of the known
locations into the Bar|Scan system prior to tagging.  Then, before the inventory
actually begins, you would print out a Location report, adding a bar code to every
field that you wish to be able to scan.  There are examples of these types of reports
already in Bar|Scan that you can later use as a template, to make creating your
own report faster and easier.  

We have added some new locations on our menu report that are not contained in
the demonstration database.  We added these new locations to the menu report just
to make this tutorial easier.

You will need to use the sample menu reports (laminated sheets) along with the
device.  We included one of each of the menu reports required for the tutorial with
your Bar|Scan system.
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You can photocopy the menu reports and use the photocopies.  Your device
should be able to read the bar codes on the copies.  If not, it may be due to the
quality of your copies.  Are the bar codes on the copies sharp and well defined?

The Menu reports are simply reports, if you would like to see how to create
similar reports, please see Chapter 10 - Report Table in this User Manual.

If you have a printer, you can print additional reports for your use.

USING THE MOBILE DEVICE

The Bar|Scan Mobile program in your device can be configured by you to prompt
or not prompt you for information.  For example, you may not want the device to
ask you for an asset's serial number if you will have no need for this information.

For this tutorial, we recommend that you use the configuration named
“{SYSTEM} ANDROID MOBILE”.  The configuration name will be displayed
on the Bar|Scan Mobile Main Menu.

It is not important for this tutorial to select particular options.  Feel free to
configure your device to the way you would when starting your actual inventory.

Please see Chapter 11 - Bar|Scan Mobile in this User Manual if you are not
familiar with your device.
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FIRST TIME TAGGING

You will need the laminated sample bar code menu reports supplied with
Bar|Scan.  These (or copies available on the installation CD) are located in the
Bar|Scan Supplemental Box supplied  with your system:

Optional: If you wish to change the optional prompts in yourdevice, you may do
so.  This configure process is shown in Chapter 11 - Bar|Scan Mobile, beginning
on Page 8.  You will want to make sure to changed both Tag and Tag at this time. 
Finally, synchronize the device with the desktop Bar|Scan so that your changes are
placed into the device.  

Note: this exercise is using a database that assumes the you are synchronizing
with the Demonstration Database.  If you are not using the Demonstration
Database when you Synchronize, then the data that is placed in your device will
not work with this tutorial.

Begin the Bar|Scan program in your device or return to the Bar|Scan Main Menu
in the device, and select Tag (New Asset Inventory).

When you come to the screen titled Tag (New Asset), you will be ready to enter
the first piece of information, your initials.

Your initials can be from 2 to 3 characters.  To enter your initials, use the
onscreen keyboard, or, if your Mobile Device has one, the external keyboard. 
When completed, press the Enter key to proceed to the next prompt.

This prompt is the “Room Tag”.
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Room Tag

Room Bar Code Tags are an alternative way of identifying your locations to the
Bar|Scan system.  Whether or not you are going to use these tags on your own
inventory, is a procedural decision that you have made or will be making.

Generally, in an office environment if you are using bar code menu lists for
entering your locations into the device, you will not be using room tags. 
Alternatively, if you are using room tags, you will not require the menu lists
except for the first time tagging process to identify to Bar|Scan the link
between Locations and the Room Tags.

When you are at the Room Tag prompt, using the Laminated Bar Code Menu
titled “TAKE 2", scan any one of the bar coded Room Tags.  This is the leftmost
bar coded column on the menu report.  You can also click on the right side of the 
screen in the Room Tag prompt to display the Pop-up.  Scroll down to a Room
Tag and select it.

You should see a screen like the one
at the right.  If you do not get this
screen, from the device’s Bar|Scan
Main Menu select the Tools then
About then click on the ‘Misc’ Tab
then check mark the item to enable
‘fill in’.
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Select Yes.  As you can see from the example below, much of the location
information that you would normally collect individually has been completed for
you.  This is because we used the Room Tag to associate all the information in
advance of your inventory.

You can see that the fields Region, Building Floor, Room and Organization have
been completed for you.

Completing the Location Fields without Room Tags

As mentioned before, you can also complete these fields manually if you are not
using Room Tags.  You would use the bar code menu  report "TAG 4" - Bar Code
Location Menu /Existing & New,” and scan any Region.  This is the leftmost bar
coded column on the menu report.

It does not matter which bar code you scan in this column as they are all the same. 
This is because the Bar|Scan Report Generator has printed a complete line for
each different (unique) location and only the Organization & Room columns are
different in this sample report.
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This is not necessarily true for most location reports.

Notice that after a successful scan, the Mobile Device’s cursor automatically goes
to the next prompt, Building.

If the cursor on the Mobile Device is not next to the word Building on the Mobile
Device, your scan of the Region was not accepted.

If you see the cursor by the word Floor on the Mobile Device, you accidentally
have made two scans!  Press the up arrow key on your Mobile Device to back up
to the previous prompt.

Now scan the column titled Bldg. on the menu report.  This is the building in
which you are going to perform the tag.

Now scan the column titled Floor on the menu report.  This is the floor on which
you are going to perform the tag inventory.

If you have not already done so, stop and view the Mobile Device’s display
screen.  You will want to make sure that the screen shows MP for Region, 500 for
Building, and 11 for floor.

If it does not, use your up arrow to go back to these fields, and scan these again.

Now scan a selection under the column titled Room on the menu report.  Each
Room on the list is unique.  This is the room in which you will be starting your
Tag inventory.

Scan the column titled Organization on the menu report ONLY if you will be
using this feature in your Bar|Scan system.  Otherwise, press the enter key on the
Mobile Device to leave this field blank.

Hint: During an actual inventory, you may sometimes come across something
unexpected, e.g., a room not previously entered into the Bar|Scan system, and
therefore you have nothing to scan.  You will need to enter the information using
the keyboard on the Mobile Device.  This makes it is easier to correct the
oversight later at the computer, and it is better than making paper notes.
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Is Space Accessible?

Respond by tapping or using the Stylus to tap on the response on the screen.

A check mark in the Accessible field means that the space is accessible.

Hint:  In an actual tagging situation, you may respond No (uncheck the box) if the
room or area is not accessible (such as a conference room that is in use).  In this
way Bar|Scan can remind you later that this room was skipped.

Hint: In a warehouse environment, you will normally not use the Accessible
Prompt since all of your locations are accessible.

At this point, you have entered all of the location information and are ready to get
down to the business of tagging the assets.

Asset Number

Now we are going to cheat just a little on our tutorial.  We do not recommend that
you use real asset labels for this tutorial.  We want to avoid even the smallest
chance of these asset numbers getting into your real asset database.

We have created fictitious asset numbers on a menu report for you to scan instead
of real labels.

Using the "TAG 1 - Bar Code Tag Asset Form /New Asset Tags" menu report,
scan the first asset number.
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Your screen should now look like the following.

You are finished with the location menu report.  

Catalog Number

For the Catalog, you can use your stylus to tap on the Catalog response to see the
pop-up window or you can use the menu report.  If you decide to use the stylus,
find SY4001 in the pop-up and select it.

If you wish to use the menu report, pick up "TAG 2" - Bar Code Catalog Menu
/Category SY.”

This is a partial list of valid Systems Furniture Catalogs for the Democo.  Your
Catalogs will be created by you during the Cataloging Phase of your Project.

In our imaginary room, you would see two Pedestals each with two box drawers
and one file drawer.  Scan the appropriate Catalog Code - but only once.  Hint: the
Catalog is near the bottom of page.
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Additional Information

The device will ask for additional information about your asset.  The rest of the
items it prompts you for, will have been determined by our default configuration. 
Answer all of the questions, then save the asset record.

You should be on the Asset Number prompt again after you have saved the record.

Notice that the device did not ask for the Catalog Number of the asset.  This is
because Bar|Scan remembers the last Catalog Number until you back up and enter
a new one.  The device will assume you are going to tag another asset with the
same Catalog Number.

Another Asset

Remember that we said that there were two pedestals in this room?  The easiest
way to tag assets in Bar|Scan is to tag all like items sequentially.  This avoids
having to enter the catalog number for each asset.

For example, if you enter a six-person conference room, tag the conference table,
then all six chairs together.

Assign the second Asset Number on your "TAG 1" menu report to the second
pedestal.

Hint: Scan the next asset number on your “TAG 1" menu report.
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Variations

Up to this point, we have tagged two new assets.  Try some variations with your
device now.

Suggestions:

% Using your finger or stylus, click on Room Tag to enter a new Room
%  Use the "TAG 3" menu report to capture some equipment
%  Go to a new location and respond NO to Is Space Accessible?
%  Scan any asset number on the "TAG 1" menu report twice.

Note: Keep in mind that you are making some intentional transaction errors for
later editing with this tutorial.

At a minimum, we recommend that you enter all thirteen asset numbers on the
"TAG 1" report.  Without enough transactions, we will not have enough to make
printing of the Transaction table interesting.

When you have completed  all thirteen assets on your "TAG 1" menu report,
return to the Bar|Scan Main Menu on your device by pressing the Cancel Button.
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You are now ready to synchronize the device to Bar|Scan on your desktop.  If you
do not have a computer or do not wish to proceed with the synchronization,
remember to clear the data in your device.

To clear data, select ‘Tools’ from the Menu then the DATA Tab.  Next, select
‘Delete Inventory’ then reply ‘YES’ to delete.  You will see a prompt like the
example below.

If you click on the Delete button, you will be shown a message that asks if you 
want to “Delete Inventory Data.”  Tap on the Yes button only if you want to erase
all of your information.  Tap on the No button to be returned to the Menu.

Note: It is very important to notice that this is what you do for a tutorial only. 
You never want to delete real assets from the device without synchronizing to
Bar|Scan on your desktop, validating, and printing the inventory information first.
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SYNCHRONIZING THE MOBILE DEVICE

Check the Transaction table prior to synchronizing the device to make sure that
it does not contain real asset information.  If your company has not yet used
Bar|Scan, the Transaction table will only contain the demonstration database
transactions.

Preparing for Synchronization

When you select File ... <, then Open ... <, Handheld Computer... <, then
Synchronize, you will be shown the following dialog box.

Note: You can also reach the above window by going to the Main Menu, then
selecting File . . . <, Import . . . <, Handheld Computer. . . <, Upload, or if you
have the Import toolbar on your Main Menu, simply click on the Synch Handheld 
icon.

You should always begin the synchronization process on the Mobile Device
before beginning the process on the desktop.
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You should now start the synchronization process on the device.  On the Main
Menu of the Mobile Device, select Synch.  The device should display information
as the synchronization takes place.

Now select the Begin button on the desktop screen.

You will see a message on the computer asking you to please wait.  The computer
will initialize the synchronization process, and when it is ready to receive data,
your window will change slightly, to look like the one below.

Notice that the bottom of the above window displays the IP address.

Note: If you select that you are not
ready to send data, you will be
shown a message asking, Clear all
data?  Yes or No.  Select No, and
you will be returned to the Mobile
Device’s Menu.  When completed,
your PC will display a message like
the one at right.
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Obviously, the number of items will change according to how much data you have
collected with your device.  

Your Mobile Device will now display a message that the synchronization is
completed and your inventory has been cleared as shown below.

We recommend that you simply turn off the Mobile Device, or let it go off by
itself, until you are sure that the information was properly synchronized.

You should go to the Transaction table, and verify that the assets have actually
been moved into the Transaction table.  Once this is done, you can return to the
Mobile Device and say Yes, to clear all data.
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PRINTING AND CHECKING THE TRANSACTION FILE

After the last asset record is transferred to your computer, you will need to print
the Transactions to check for any discrepancies that may have occurred while you
were collecting your inventory information.

After the last asset record is transferred to your computer, you will want to print
the Transaction table information.  To print the report:

% Select File ... <, Open ... <, Reports ... <, Bar Code Transaction
from the Main Menu or press the Transaction Report Icon as
shown at right.

% Select the System report, “{SYSTEM} ALL TRANSACTIONS BY INV
INITIALS, DATE & TIME ”from the Browse panel.

% A dialog box will appear to ask you if you wish to print this report, select Yes.

%  Bar|Scan will perform a validation of the Transaction File.

% After the report has printed, a dialog box will appear to ask you if you want to
mark as printed, select Yes.  Then, another dialog box will appear to say Done
Printing.

Review your Transaction Report.  

Note: There is a column titled Problem Indicator.  These are the same messages
that appear in the Transaction table on the Problem Handlers tab.

Note that the error titled "Location is not accessible" technically is not an error,
rather, it is a note to remind you that there was no inventory done at that location. 
Remember the Mobile Device prompt "Is Space Accessible?"

We will not be editing the Transaction table in this tutorial.  

For more information on the types of errors and how to correct them, please see
the Transaction Problem Handlers in Chapter 12 - Transaction Table in this User
Manual.
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CONCLUDING THE TUTORIAL

This concludes our Demonstration Database and Mobile Device Tutorial.  If you
will not be reviewing the tutorial again, you may wish to switch to your actual
database.

Choose File . . . <, Company . . . <, Open to open your own company, allowing
you to switch back to your real Company Database.

DO NOT REINSTALL Bar|Scan from your CD if you already have a REAL
ASSET DATABASE without consulting Bar|Scan technical support.

PREPARING FOR A REAL INVENTORY

There are many things to remember to have with you prior to beginning your
physical inventory.  To make it easier for you, review the following checklist
before your inventory.

Make sure that your Mobile Device does not have any assets in it,  then check the
Date and Time to make sure they are correct, put your initials into the Mobile
Device, and if you will be using the Mobile Device for more than 6 hours without
recharging, make sure you have a spare battery.

Know what type of optional asset information you will be expected to collect, i.e.,
a serial number, owner name, etc., and use this information to configure your
Mobile Device for all prompts before you start, and remember to check  the
lengths of the Asset and Room Tags.

Have your Data Collection Sheets, Catalog Lists, Location Plans, Location
Reports, etc. ready.  If you have updated Bar|Scan with new Catalog or Location
information, you should print new bar coded reports.
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You will need your Marker Boards (Catalog Numbering Easel) and markers if you
are digitally photographing your Catalogs.  And remember your camera and a
charger source for your camera.

Don't forget bar code Asset tags and Room tags, even if your taking an inventory. 
You may run across assets that are not tagged and may need to be.

Have a note pad and pencils to jot down notes.  Carry a dental or other mirror and
a flashlight to read serial numbers on equipment in those hard to reach places. 
Also, if you plan to take dimensions down, you will need a tape measurer.

You will also need room tags, if you are planning to use them during your
inventory.

Remember to synchronize your Mobile Device to your real Company and not to
the demonstration system.

Good Luck!
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APPENDIX-A

IN CASE OF TROUBLE

INTRODUCTION

If you have used a personal computer before, you know that trouble can occur in
several different ways as follows:

% If BarScan is installed on a server you may experience a network disconnect,
causing BarScan on your local desktop to fail.

% The computer or one of its components (such as the hard disk drive) can fail.

% You can experience an electrical power failure which turns off the computer
without a proper shutdown.

% Something can go wrong with the printer causing an error.

% You can experience problems when synchronizing with the .

% A problem can occur while working with the Bar|Scan system.

There is a set of videos on our website that can provide you with additional in
operating Bar|Scan.  These are titled Quickstart Overview Videos and can be
found on this page: https://www.barscan.com/support-videos

Please consider viewing or downloading these as part of your learning experience.

The following sections will discuss some of these problems and how to correct or
recover from them.
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PROBLEMS WITH THE COMPUTER

You will be most concerned with computer problems and failures that effect the
local disk drive or the server disk drive.

One of the most serious computer problems is the failure or accidental erasure of
information stored on the disk drive.  This problem is the reason you back up the
information stored on the disk drive.

If you experience a disk drive failure, you must first correct the problem by
repairing or replacing the hard disk before you reinstall the Bar|Scan system and
restore the Bar|Scan Company Tables.  See the section in Chapter 3, on
Backing-up and Restoring the Bar|Scan System.

Another problem that can affect the disk drive has become more serious in recent
years and that is infection from a computer virus or malware.  While most viruses
do not cause damage to files, some can leave your computer inoperable.  The best
prevention against computer viruses is installing and using an Anti-Virus and
Anti-Malware Program.  It is important to update and maintain current versions
of the Anti-Virus definition files for maximum protection. 

Other kinds of computer problems generally do not have a significant effect on
Bar|Scan.  The Bar|Scan program stores information on the hard disk as you enter
it.  This means, as far as Bar|Scan is concerned, the worst that can happen is the
loss of the information you were entering at the time of the problem.
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Electrical Power
Failure

Bar|Scan saves your work as you enter it.  In the event of a power failure, you will
need to restart your computer and restart Bar|Scan.

The first thing to do before reentering any information you had not saved at the
time of the power failure is to perform a Table Integrity.

If a power failure happens to occur at the precise time Bar|Scan is saving your
work, you will want to review what you were entering at the time; it could have
been corrupted. Open the Table Integrity Screen and click Ok to perform a Table
Integrity.
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If the Table Integrity stops and Bar|Scan displays any messages, contact Bar|Scan
Technical Support or your Bar|Scan Dealer.  An email hyperlink is provided on
the Bar|Scan Help Screen.

Trouble With the Printer

Any time you print a report, Bar|Scan assumes the printer is connected to your
computer or your network and is ready to go (on-line).

If a problem occurs with the printer, it is almost always due to something wrong
with the printer or Windows, rather than Bar|Scan.  This is because your printer
is controlled by Windows and not Bar|Scan.

If you are having a print problem, you may wish to check your Windows Control
Panel and see how your printer is configured.

Try printing a test page, either in Control Panel’s printer setting or with another
application such as Microsoft Word.

Once you have checked for the correct Windows printer settings, you must look
elsewhere for the problem solution.  Check your printer's status and consult the
printer manual for instructions.
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PROBLEMS WITH BAR|SCAN

Bar|Scan contains its own error checking and diagnostic routines.  If a problem
occurs, information will be displayed as to the nature of the problem.

There are several levels of Errors.  The most serious will cause Bar|Scan to stop
and display a full size error message such as the following sample:

It is important to press the E-mail Errors button to capture the information on this
screen and report the error to us.  This can be done in a number of different ways.

In Case of Trouble Page A-5



In Case of Trouble

The best way to report the error is to click on the “E-mail Errors” button at the
bottom of the screen.  Bar|Scan will open your email program and send the
information to our office.  When completed, the message “E-mail Compete” will
be displayed as in the following example:

There is no need to call our office since your email will arrive in our office
within minutes.

If your Computer does not have email or does not  allow Applications to open
your email program, you can capture the error screen and paste it into an Office
document, Microsoft WordPad or Microsoft Paint.

To capture the screen, press the ALT plus PRINT SCREEN keys simultaneously. 
Open  Paint and select Paste.  Save the file and attach it to an email.  Send the
email to techsupport@barscan.com

There are other screens that are less serious that may prevent you from using only
a portion of Bar|Scan.  They normally do not close the program.

The following is an example of the error display screen provided by Bar|Scan.
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If you see a screen similar to the prior screen, immediately, before you do
anything else, press the ALT plus PRINT SCREEN keys to capture the
information.  Then open either Microsoft Paint or Microsoft WordPad and select
paste to capture the screen.  You can save the file and attach it to an email
(preferred) or select print to send a copy of the information to the printer and fax
the error message.

This error screen provides important information about the problem and its
solution.  It should be sent to your Bar|Scan dealer.

Note: You can restart Bar|Scan and select Help About Bar|Scan to locate our
telephone number and/or fax or email address to send us the error display screen
if your Bar|Scan dealer is not available.

If You Have a Problem But BarScan Does Not Show an Error Screen

If you have a problem but BarScan does not show an Error Screen you can still
send us information so that we can help you with the problem.

Normally BarScan effectively detects serious errors and will generate an error
screen from which you can email a debug information file. However, there are
some types of errors or conditions that can occur that do not cause BarScan to stop
working. When this happens you can manually generate a debug information file
and send it to BarScan if you want technical assistance.

It is very important that the Debug Information file be generated IMMEDIATELY
after the problem occurs. Even a few extra keystrokes or mouse clicks may cause
critical information to be lost.

To manually create the Debug Information File do the following:
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Select menu item Help/Technical Support/Create Debug Information File…

A dialog will then appear that asks if you wish to email the information or for a
filename and a folder location as shown below:

This file will hold the Debug Information.

If you select Save, then you will see the location of the saved file.  The file is
named and includes the date and time in the filename as shown below.

Using Windows File Explorer, locate the file and then attach that file to an email
reply.
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Functions Which Require Exclusive Use of Tables

There are a small number of operations which require exclusive use of some parts
of the system.  This means that if you have a Local Area Network version of
Bar|Scan, it is suggested that only one user be accessing Bar|Scan.  Remember that
when you are running the program in Windows, minimizing the program is still
the same as running the program and not closing it.  The operations which require
exclusive use are:

% Maintenance on (archiving) the Activity Log
% Creating a new Set command for the very first time
% Exporting or importing information
% Table Integrity

All of the above operations require exclusive us of the Tables they affect.  If other
users are accessing Bar|Scan but are not in the same table, these functions will
most likely not be affected.

Also note that an ODBC connection from another computer application is also
considered a user.

Below is a sample information message notifying you that exclusive access is
denied. 
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Bar|Scan can provide you with a list of other users currently accessing the system.

This is done by accessing the Help Panel as shown below.

Click on the “Current Users” button to see if anyone else is using Bar|Scan. 
Normally, Bar|Scan cannot instruct your Network to log the users out of Bar|Scan. 
You will need to contact the users directly.

Bar|Scan does has a scripting feature to log users out of Bar|Scan, but this is an
optional setup and described in detail on the Knowledge Base section of our
website.
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Problems During  Synchronization

Anyone who has worked with computer communications knows that strange
things can happen when you connect two devices together.  Consequently,
Bar|Scan has completely automated this process; you normally should not be
concerned about possible these issues occurring.

Bar|Scan assumes that the Mobile Device is communicating via Wi-Fi unless you
have changed settings from within Bar|Scan.  Check to see that the your Mobile
Device has Wi-Fi access and is not being blocked by a firewall.

Other problems can occur such as an interruption during the transfer of
information.  Bar|Scan monitors the progress and provides information and
instructions to correct these problems.  See the section Get Asset Data From  in
Chapter 12 - Transaction Table for more information and instructions.

Problems may also be cause by insufficient privileges in your Windows Account. 
A quick way to test for this problem is to run BarScan as an administrator as
shown below.

If this resolves your issue then you can modify your shortcut.  Right-click on the
shortcut and select ‘Properties’.  On the shortcut tab select ‘Advanced Properties’
and select ‘Run as administrator’.
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Your anti-virus program can be the cause of slow response time of Bar|Scan

Anti-virus packages typically address the problem of detecting and dealing with
viruses using three methods:

1. Periodic scans of files.

2. Real time scans of files (whether executables or data files) when they are
activated, opened or used by a program.

3. A real time heuristic detection, where the anti-virus package is looking for
suspicious program activities to detect new viruses that have not yet been
identified.

Also, it is very typical for a network to have an anti-virus package running on the
server as well as on the workstation.

Normally BarScan has no problem with (1) and (3) above, but the Real Time
scanning (2) can cause BarScan to slow down substantially if the anti-virus
packages are not configured properly. It is especially possible for BarScan to
receive a double hit when anti-virus packages are running on both the server and
the workstation. A typical BarScan configuration has BarScan running on the
workstation but opening files on the server. If improperly configured, when
BarScan attempts to use a data file on the server, both the server and the
workstation will scan the file, each in turn, resulting is a double scan even before
BarScan is able to use the data. This can obviously substantially reduce
performance.

To prevent this your anti-virus scanning software needs some tuning. Check the
anti-virus setup on both the server and the workstation. 

The default BarScan server folder is:          

drive:\BARSCANW

Of course, your actual installation location may differ.
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Make sure that it is NOT scanning any files in the BarScan folder or any
subfolders that have the following extensions:

.DBF .CDX    .FPT    .DBC    .DCT   .DCX   .FRX    .FRT

These are simply data files, but if the scanner keeps checking them every time
they are opened, it will slow down the system considerably.

Optionally, you may see an additional improvement in speed if you remove the
Bar|Scan application (barscanw.exe) from continuous scan as well, perhaps
scanning it only when an update or change is made. However, do this only if you
believe the risk is acceptable.

In a typical BarScan network installation, there are no data or program files
installed on the workstation. It may be that performing these adjustments on the
server may cause BarScan to have acceptable performance. If not, then
configuring the anti-virus on the workstation typically involves turning off
network drive scanning and turning off scans of files with the above extensions.

Finally, you may have noticed that this tip gives no specifics on how to
accomplish the above exclusions with specific packages. BarScan cannot be
responsible for tracking all of the various anti-virus software packages, both
server and workstation, used to guard against viruses. The details vary
considerably with each package on how to accomplish the above. Your IT
department will be able to help you.

Finally, visit the Knowledge Base section of our website at www.barscan.com for
more specific information on other potential problems.
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APPENDIX-B

IMAGING

INTRODUCTION

The Imaging Feature is an optional module, but it can greatly enhance your system
by giving you the ability to view images of your assets, catalogs, signatures as
well as other images and print actual color or black and white images of your
assets directly onto your reports. 

Imaging is the process by which a previously saved image can be viewed on the
Bar|Scan display screens.  The images can be of many different formats, both
color and black & white, and can be created from digital cameras, desktop
scanners, still video, or other capture equipment.

The resolution of the input device and the file format will determine the quality
and clarity of the image.  In addition, scanning allows the placement of several
images, including photographs, scanned fabric samples, and documents.

There is a set of videos on our website that can provide you with additional in
operating Bar|Scan.  These are titled Quickstart Overview Videos and can be
found on this page: https://www.barscan.com/support-videos

Please consider viewing or downloading these as part of your learning experience.

VIEWING IMAGES

From the Asset, Catalog, Personnel, Work Order or Transaction tables in the
Bar|Scan system, you may press the imaging button, located on the tool bar, to
view an image as shown below.

This displays the image or multiple images of the asset in its own window.  Press
the X button to close the image.
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When you view an image, you will see a box similar to the following:

If the image box is blank, then you either do not have an image or it is in the
wrong location, or, it is in a format that Bar|Scan cannot display (see file formats
later in this section).

To display different images of the same item, click in the image name in the
choice area as shown below
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PRINTING IMAGES

Images can be printed on any report that can access the Catalog or Asset Table,
by choosing Catalog or Asset Picture as one of the columns to be printed.  The
column name is Asset Picture or Catalog Picture as shown below.

The default shape for the image is the
original image.  You can change the
dimensions of the image, by changing
the width of the column by selecting the
Catalog or Asset Picture and then
clicking the Properties button on the
Columns Tab.  Because the image
shape is the original image dimension,
by making the image wider, it will
automatically be resized to a larger
image.  A sample is shown to the right.
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Bar|Scan may automatically convert your images to Windows® Bitmap format in
order to print on some printers.  This means that you may have two images of each
Catalog or Asset in your images folder.

ORIGINAL IMAGE SIZE

Image size matters because there is a tradeoff between image quality and storage
and printing ability.  We recommend that images be no larger than 100,000 bytes
in size (100 kb).  Larger sizes bring very little additional quality to a viewed or
printed image at normal print size.

Larger images also may fill up the printer’s memory and may not print at all. 
There are tools available that can organizing and cleanup your images prior to
importing into the Bar|Scan image folder. Go to http://faststone.org and try their
tool. It is free but donations are welcome. Link provided with permission.

MULTIPLE IMAGES PER ITEM

You can store and display multiple images in a paging function, e.g. press page
down to see the next image.

To see an image you need to name the image as the Catalog or Asset number, e.g.
EP1045.jpg or T004949.bmp. To store multiple images, you need to add a file
extension number such as T004949.1.bmp T004949.2.bmp or EP1045_1.jpg
EP1045_2.jpg.

Note that the format of the extension is not critical as long as the filename begins
with the Catalog or Asset Number. The number of additional images which can
be displayed is unlimited. Only the first images will print using the Bar|Scan
report generator.
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You can also print images associated to other fields by selecting the Images option
in the Properties button for each column that you wish to print as shown below.
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FILE FORMATS

All images need to be saved as individual files with the same filename as the
associated Catalog or Asset in Bar|Scan.

For example, if a catalog SE1000 is created, its corresponding image may be
saved as se1000.jpg.  If you are creating an Asset image, name the image with the
Asset Number.

Images need to be saved in the same folder as the company or in a subfolder called
images.  The folder can be displayed, by selecting File   ... <, Company   ... <,
Open from the Main Menu.

For example, this is a legitimate location for images:

K:\barscanw\company3\images

Generally, you will save your scanned image as a graphic file.  There are many
different graphic file formats, all with advantages and disadvantages.  To get the
best results, become familiar with the various graphics file formats that are
compatible with your publishing software and printing equipment.  The following
is a list of file formats which are compatible with Bar|Scan’s imaging capabilities:

Although Bar|Scan is compatible with all of these formats, the suggested format
is the jpg format (file extension .jpg) since it is the most common format
supported by applications.
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You can control which images are viewable.  For optimal speed, is best to chose
only those formats that you are using to store your images.
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IMPORTING IMAGES

Images can be added to your BarScan database in one of three ways. 

T Using the Import function in BarScan
T Manually using Windows File Explorer
T By using the Signature Capture feature in the Mobile Device

Using the  Import feature in BarScan is recommended for adding a small number
of images.  For bulk addition of many images, using Windows File Explorer is
more efficient as File Explorer allows you to copy and paste multiple images at
a time.

BarScan does not resize or crop images during the import.  So before adding
images review the section titled ‘Original Image Size’ in this Appendix.

Using the Import function in BarScan

From the Main Menu select File-> Import-> Images Files as show below:
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There are two options for importing.  You can select either ‘As Shared Images’
or ‘As Company specific Images’.

Unless you are sharing Tables, select ‘As Company specific Images’.

As documented in the Chapter 17 - Multiple Company Database, BarScan Tables
can be shared between Companies.  For example, if you are sharing one Catalog
Table between two Companies, you would select ‘As Shared Images’.

DISPLAYING IMAGES

Bar|Scan can display images other than Catalogs and Asset.  One of the features
in Bar|Scan is its ability to display an image in any of the columns of the browse
screen.  The first column is always the index column used for searching and
ordering and cannot display a corresponding image.  This is true for all Screens
wherever a browse grid appears. It is also true for some lookup lists, that is, those
lookup lists that have secondary columns (this varies with the field itself, not all
fields can show the auxiliary columns).

The column must allow imaging. You can tell if imaging is enabled for a column
by right clicking on the column header text. If you are presented with a popup
menu that includes imaging being turned on or off, then it is enabled (e.g., menu
item ‘column/image/on’).  See the example below.

When imaging for a column is turned on (pop up menu item ‘column/image/on’),
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a small camera icon appears alongside the column title. If imaging in ON and
there are no images corresponding to the data in the column then you will only see
a blank, as if there is no data. The data is not gone, simply set it back to
Images/OFF and the data will reappear. Image/ON shows available images,
Image/OFF shows the data.

The image file displayed corresponds to the exact text of the data in the column. 

Unlike the full screen imaging for Assets and Catalogs, only one image can be
displayed, the image with the exact text of the data being displayed in the column. 
Pdf  images cannot be displayed, but if there is an existing PDF image file you
will see the graphical text ‘Pdf’ in the column. If there is both a graphics file and
pdf file with the same name, then the graphics file will be displayed.

Since the data in the data field is what is used to select what image file to display,
Bar|Scan cannot tell the difference different fields with the same value. For
example, if a room tag and organization code both have code 00500, the same
image will be displayed for both.

This feature allows pictures to be taken and displayed for almost any data within
Bar|Scan.  For example:

TDisplay a photo of a person in the Asset ‘Name’ column.

TTake a photo of a location and display it in the ‘Room Tag’ column.

TDisplay an image of the actual Mobile Device unit in the  Mobile Device 
Advanced Settings browse screen using the Mobile Device ID Field.

TCreate images of various condition codes to help guide users on what ‘Good’
or ‘Fair’ actually mean.

TScan logos for various manufacturers and display them in the ‘Manufacturer’
field.

TTake a picture of an asset and display it in the Asset # column.

TAssign an image to a Catalog.
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TSignature Capture in the Mobile Device.

One area that may be confusing are those fields that have multiple parts, such as
the Catalog field. The Catalog field consists of the Code (XX) and the Number
(9999).  Displaying either of these individually will not display its catalog image.
To display the catalog image one must select the full catalog field to display
(XX9999).

Signature Capture

Signature Capture is discussed in detail in Chapter 6 - Assets and Chapter 11 -
Mobile Device. 

Nomenclature of Image File

The image file is stored in Joint Photographic Experts Group (jpeg or jpg)
standard format.  Using Bar|Scan, it can be viewed, exported or printed.  The
image is always associated with the field used to capture it by its naming
nomenclature. The nomenclature is defined at the end of this section.  Here is an
example:

sig-@as-fa0000226800@per-cordovac@d-2014_10_13@t-122028.jpeg

below are the Key field types for images. They are:
AS= Asset Number 
CA= Catalog
D= Date
PER= Personnel
T= Time
WM= Work Order Number
WD= Work Order Line Number

Each of these types corresponds to one or more fields. These can be thought of as
the ‘kind of field’ associated with the signature. For example, although all names
are validated against the Personnel Table, there are many different fields in
Bar|Scan that contain names.  An example would be the Asset Current and Prior
Name.
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Likewise for the date and time fields. These correspond to the Inventory Date and
Time or the Move Date and time, depending upon which table is being accessed. 

All permanent signature image files start with ‘sig’ while temporary files start
with ‘tempsig’. 

If the user selects a field for the signature that does not correspond with one of the
key fields, then the name of the database field in the table.  For example, the serial
number database field name is SY_NO. The format will then be: 
@RawFieldName-FldValue.

For example, if a Transaction UDF is created named ‘UD_NAME’, the user
prompts for it in the Mobile Device, fills it in with ‘SMITHJ’ and also assigns a
signature, then the name fragment would be @UD_NAME-SMITHJ.  Note that
the name is based on the response, not on what is entered into the signature
capture field.

To maintain compatibility with prior versions of the Bar|Scan program, existing
image filenames that start with an asset # or catalog number without the ‘@’ are
also recognized.

If an image key field is changed, then the image file is renamed with the new key
field value added to the filename. The old value is not discarded. For example, if
a person is changed from SMITHJ to JONESK then the image filename will
change from:

                @PER-SMITHJ.JPG
To
                @PER-SMITHJ@PER-JONESK.JPG

This renaming applies only for:
AS= Asset Number 
CA= Catalog
PER= Personnel
WM= Work Order Number
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All field name values are processed so that all illegal filename characters are
either removed or translated. For example, if the name is ‘BLACK,QR’ with the
first and middle initial following the last name, then the filename fragment would
be ‘PER-BLACKQR’ since commas cannot be used in Windows filenames.

A note on Mobile Device files: All of the inventory information, including the
signature data, is in the Bstransa.xml which is transferred from the Mobile Device
to the desktop.

Finally, visit the Knowledge Base section of our website at www.barscan.com for
more specific information on images.
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Filter 4-56, 5-10, 5-22, 6-1, 6-6, 10-27,

10-38, 14-33
Filter By 10-10, 10-27
Filter By Tab 10-27
Filters (see filter)

Find
Find Button 4-16, 5-30, 17-22
Find Company 17-21
Find Feature 4-16
Find Problems 6-113

First Fiscal Month 6-77, 13-33
Fiscal YTD Depreciation 6-77
Floor Plan 2-1, 2-18, 2-26, 4-46
Formatted Data 4-72, 14-2, 14-36
Freight Costs 6-67
Fully Depreciated Flag 6-23, 6-78
Function Keys 5-14, 5-17
Fund Number 6-23, 6-94

G
   

General Ledger Numbers 6-16, 6-65 
Generate a Set 4-61, 7-12
Global Find Feature 17-21
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Government Furnished Equipment 2-38
Graphic File B-7

H
   

Hard Disk (see Hard Drive)
Hard Drive 3-11, 14-30
Hardware Requirements 3-2
Header

Header 10-10, 10-55
Header Style 10-61, 10-73, 10-83
Header Tab 10-61

Help
Help 4-2, 4-17, 4-91, 5-14
Help Drop Down 4-17

Highlight Bar 5-13, 5-35
Hold this Asset 12-24
Housekeeping 1-3, 3-38, 4-89, 13-1
Hyperlink 4-30, 6-30, 6-34, 18-2

I
   

Icon 3-18, 3-19, 3-39, 10-5
Idle 6-20, 6-23, 6-75, 6-84
Image

4-45, 5-11, 5-26
Imaging Feature B-1
Imaging Module 4-36, 4-45, 7-15,

7-49, 10-46, 13-98
Import and Export

Import and Export 14-1, 4-96, 10-89
Import and Export features 14-96
Import Format 14-19, 14-38, 14-75
Import Log File 14-72
Import Toolbar 4-37, 12-72, 19-80
Import/Export Log File 14-17, 14-75

Important Decisions 19-1, 13-80
Importing

Importing a Catalog 7-71
Importing a File Structure 14-30, 14-54
Importing and Exporting a Report 10-89
Importing into Bar|Scan 14-36

In Case of Trouble A-1
Informal Asset Moves 2-36
Initial Accumulated Depreciation 6-70
Initial Depreciation 6-18, 6-69
Initial Depreciation End Date 6-69, 6-77
Initialize Blank Organization Codes 9-19,

13-22, 13-24
Input Mask 6-52, 13-33, 16-8, 16-33
Insert Key 5-28
Install

Install the Program (see Installation)
Installation 3-4, 3-22, 3-24, 2-27
Installing Software 1-2

Insufficient Disk Space 13-6, 13-8
Internet 1-3, 3-28, 13-51, 18-1
Inventory

Inventoried By 6-61
Inventories Using Quantities 11-20
Inventory Date 3-40, 6-15, 6-61, 12-51,

12-68, 13-31
Inventory Procedures 1-2
Inventory Supplies 2-1
Inventory Tab 6-61, 12-17
Inventory Time 6-15, 6-61, 10-11, 12-12

Is Space Accessible? 12-37, 19-75

K
   

Key Field 4-67, 13-96, 14-60, 14-61, 16-1
Keystrokes 5-2, 5-31

L
   

Label Replacement 6-38, 11-62, 12-22, 
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12-52
Layout 3-41, 10-10
Layout Tab 10-60
Lease

Lease 6-21, 6-83, 6-85, 6-89
Lease Calc Method 6-87
Lease Duration 6-86
Lease Factor 6-87, 6-91
Lease Number 6-21, 6-85
Lease Table 6-21, 6-85
Leasehold 6-83, 7-32

Length of the Asset Number (see Asset #
Length) 

Lessor 6-87
Levels of Locations 4-46
Lighting (LI) 7-32
Line Spacing 10-10, 10-60
Location

Location & Organization Bar Code
Menu 2-20

Location Accessible (see Is Space
Accessible ?)

Location Code Entries 6-53, 9-16
Location Description 6-54, 6-57, 9-14,

9-17
Location Edit 9-10
Location Field Validation 13-48
Location History 6-38, 6-51, 13-21
Location History Reports 4-58, 10-3, 

10-94
Location Icon 4-47, 9-3
Location Information 6-53, 9-15, 9-20,

11-22
Location Menu Boards 9-17, 9-18
Location Reports 4-57, 10-3, 10-93
Location Table 1-2, 4-46, 9-3, 9-20

9-24
Location Type 4-49, 11-22, 15-37

Log Event Code 14-93, 15-31

Log File Maintenance 13-132
Look Up Available Quantities 15-33
Look Up Windows 5-15, 5-20, 5-31, 5-36

M
   

Macros 10-64
Main Menu 4-2, 4-5, 5-3, 11-36, 18-8
Manufacturer

Manufacturer 6-61, 7-26, 7-60
Manufacturer's Line Number 7-27
Manufacturer's Part Number 7-27
Manufacturer's Tag Number 7-27

Mark
Mark as Changed 5-21
Mark as Printed 10-82, 19-83
Mark as Unchanged 5-21

Mark up % 7-42
Marker Board 2-26, 2-30, 2-43, 19-85
Master User (Bar|Scan Administrator) 4-64,

4-91, 9-22, 10-16, 13-54
Maximize a Panel 5-34
Menu Bar 11-7
Message Severity 4-95
Method of Depreciation (see Depreciation)
Microsoft Azure 3-4, 3-27
Microsoft Excel

Excel 2-40, 3-39, 4-96, 10-11, 10-59,
10-75, 14-1, 14-20, 14-26, 14-30,
14-44

Excel Format Issues 14-44
Microsoft Windows

Windows Desktop 3-20
Windows Printer Settings 10-82

Microsoft Windows Mobile Device Center
(WMDC) 12-79
Miscellaneous Reports 4-59, 10-99
Mobile Computer

Handheld Computer 4-31, 1-3, 2-28, 3-3,
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4-30, 11-1
Handheld Computer Configurations

12-2, 4-32
Handheld Computer Transactions 4-34,

13-24
Handheld Computer Tutorial

19-2, 19-68
Handheld Computer UDFs 16-15

Modem 7-90, 11-32
Monthly Depreciation (see Depreciation)
Motorola Symbol (see Zebra)
Mouse 5-31
Move

Move a Panel 5-33
Move All (Good Transactions) 4-40,

12-70
Move By 6-57
Move Date 6-57
Move Selected Handheld Computer

Transactions 12-70, 4-36
Move Time 6-57

Multiple Company
Multiple Company 1-3, 4-67, 4-96,

10-14, 17-3, 17-19
Multiple Company version 17-3, 17-19,

19-10

N
   

Name
Last Name 8-30
Full Name 8-26
Name 6-51, 8-2, 8-30, 11-7,

11-15, 11-25, 12-4
Name entry 6-51
Rebuild Full Name 8-39

New

New (field) 6-65
New Assets 2-37, 6-66
New Attribute 7-35
New Catalog 2-46, 7-17, 19-43
New Catalog Data Collection Sheet

2-32, 2-46, 10-92, 19-43
New Location 4-9, 6-54, 9-13, 11-21,

15-49, 19-33
New Manufacturer 7-63
New Order 6-6
New Organization Structure 8-8
New Personnel 8-25
New Report 10-8, 10-10
New User 11-33, 13-53
New Work Order 15-14, 4-70
Newly obtained assets 2-35

No Duplicates 10-58
No Problems or Warnings 12-32, 19-58
Non-Structured File 14-26, 14-50
Not In List of Values 10-33
Notes 6-70, 4-83, 12-79, 13-95, 15-41

O
   

ODBC
ODBC 2-41, 3-40, 13-32, 14-19, 14-24,

14-38, 14-43, 14-45, 15-55
ODBC Linking 4-1

Old
Old Asset Label (see Old Asset Number)
Old Asset Number 6-39, 11-58, 12-22
Old Number (see Old Asset Number)

Open 
Open a Panel 5-33
Opening a Table 4-22

Order
Order By 5-22, 5-39, 6-5
Order the Columns 6-10

Organization
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Organization Code 8-10, 2-15, 4-46,
4-94, 6-23, 6-46, 8-5, 9-18

Organization Combination Field 10-44
Organization Icon 4-51, 8-3, 19-18
Organization Reports 4-57, 10-94
Organization Structure 4-48, 8-1, 9-18
Organization Structure Code 8-10
Organization Table 8-3, 1-2, 4-50, 6-46, 

12-38, 17-1, 19-13
Organization Transfer 6-22, 6-94
Organization Reports 10-3, 10-94
Reference Organization 9-18, 9-19,

13-22
Output File 10-68, 10-79
Overview 4-1, 14-132, 19-1, 19-13
Ownership

Ownership Information 6-48, 15-36
Ownership Method 6-50
Ownership Table 6-49

P
   

Pack 4-67, 4-93, 13-7, 13-73, 14-135
Pad Asset # With Zeroes 13-38, 17-14
Page

Page Break 10-50, 10-58
Page Down 5-15, 19-20
Page Up 5-15, 19-20
Pages Tab 10-81

Pallet
Pallet 2-9, 4-49, 9-2
Pallet Location 2-18, 6-37, 9-11, 9-15

Panel Drop Down 4-15
Partial Periods 6-104
Partition Your Database 17-2

Password
Password 4-2, 4-59, 4-64, 5-3, 13-13,

13-125, 14-133, 18-6

Password Protection 3-38
PDF (see Portable Document Format)
Period

Period End Date 6-23, 6-77
Period Start Date 6-23, 6-77
Period Type 6-23, 6-45, 6-75
Periods Depreciated 6-23, 6-84
Periods Idle 6-23, 6-84
Periods Remaining 6-23, 6-84

Personal Program Preferences 4-11, 5-7,
5-14

Personnel Table 4-52, 6-51, 8-20
Physical Condition 6-40
Physical Inventory 2-1, 2-25, 19-1, 19-84
Physical Location 2-18, 4-46, 6-47, 6-53,

9-1
Polyester (See Bar Coded Labels)
Pop-ups

Pop-ups 2-31, 11-5, 13-104
Portable Document Format B-6
PPI Accumulated Depreciation 6-102
Previous Location 6-53, 13-19, 10-44, 13-19
Print

Print 10-10
Print Preview 5-11, 10-80, 18-20
Print Screen A-7
Print Tab 10-67
Print the Bar Code 10-49
Print the Report 10-11, 10-80, 10-86
Printing an Image 10-46

Prior
Prior Label 6-38
Prior Locations (see Previous Location)

Problem
Problem Handler Tab 12-32
Problems 2-41, 4-35, 4-93, 6-103, 6-113,

10-39, 12-6, 12-13, 12-20, 13-15,
A-1, A-2

Processing Work Orders 15-7
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Project Manager 2-2, 2-25, 2-29
Prompts 4-12, 10-82, 11-10, 11-16, 11-27,
19-84
Prompts Tab 4-12, 10-82
Properties Box 10-51
Properties Button 10-51, 11-30
Purchase

Purchase Cost 6-66, 6-101, 7-39, 12-16
Purchase Date 6-65
Purchase Order Number 6-36, 6-64,

11-25, 12-16, 15-22
Purchasing Department 2-38

Purge 13-31

Q
   

Quantity
Quantity 4-85, 6-36, 7-74, 11-20, 11-23,

12-21, 13-26, 13-44
Quantity Field 6-31
Quantity Inventory 6-36
Quantity Prompt 6-36, 13-44

R
   

Range
Range 4-24, 5-18, 5-37
Range Duplicates 4-42, 12-11, 12-28
Range Feature 4-36, 5-37, 6-26, 12-11

Realign 'Z' Number Locations 13-28
Rebooting (See Hard Boot)
Received Date 6-65
Receiving Department 2-37
Record Locking 3-37
Reference Organization (see Organization)
Refresh

Refresh Asset and Location History
Locations 13-17

Refresh Displayable Field Lists 13-19
Refresh Location History Names 13-19
Refresh System Reports 13-16
Refresh System Sets 13-17
Refresh Tab 4-94
Refresh Table Properties 13-19

Reindex 4-66, 4-91, 4-93, 13-10
Remarks 6-15, 6-63
Removing Organization 8-15
Rename a company 4-67, 17-19
Replace Asset Label 12-22, 12-40
Report

Report error 10-87
Report feature 10-2
Report Justification 10-60
Report Name 10-14
Report Titles 10-61
Reports Tool Bar 10-5
Reports 2-40, 4-54, 10-2

Reserved Bill of Material (See Bill of
Material)

Reserved Received Items 15-34
Resetting the Handheld Computer 11-96
Residual Value 6-68
Restore (data) 3-31, A-2
Restore Deletions 13-139
Restore Original Value 5-21
Restructure 3-37, 4-67, 4-92, 7-71, 13-5
Revise

Revised By 7-37
Revised Date 7-37
Revision History 7-37
Revision in Depreciation Rates 6-104

Right Justify Asset # 13-37, 17-13
Roll Back 12-71
Room Tag

Room Tags 2-1, 2-8, 2-9, 2-14, 9-20,
11-20, 12-20, 19-72

Room Tag Labels 2-44, 10-93
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Room Tag Length 3-40, 11-55, 13-35

S
   

Sales Tax 6-67
Sales Value 6-62
Salvage Value 6-68
Save

Save (Ctrl +S) key 5-10
Save Assets 6-40
Save Icon 6-27, 19-26

Scan Information 6-15, 6-61
Scripting Feature 14-132, 2-41, 5-5, 13-88

(We also recommend our online
Knowledge Base for the most current
information)

Scroll a Panel 5-34
Search 4-16, 5-30, 11-54, 17-21
Seating (SE) 2-25, 7-32, 7-103
Secondary Asset Number 2-6, 6-39
Security Control 3-38
Seeking Feature 4-26, 5-13, 5-37, 19-41
Select Another Printer 10-67
Selecting Attributes 7-34
Send 3-37, 11-44, 12-1
Serial Number 2-6, 6-39, 7-36, 11-24, 12-12

13-35
Serial Port 11-15
Serious Computer Problems (see Problem)
Server Console 3-4
Service Order (see Work Order)
Set

Set Feature 4-25, 4-60, 5-10, 5-39, 6-6,
7-4, 9-5, 18-15

Set Icon 6-6, 6-11
Set Transaction Validation Messages

4-95, 12-31, 13-101
Sets (see Set Feature)

Settings 13-33, 4-90, 8-29, 11-39, 11-2, 11-7

Setup.exe 18-3
Shopping

Shopping Mode 15-23, 15-51
Shopping Screen 15-13, 15-51

SIF 10-73, 14-22
Signature Capture 4-36, 5-11, 12-8, B-10
Single Sign On (SSO) 4-2, 4-82, 19-2
Site

Site Location Combination Field 10-44
Site Locations 2-18, 9-2, 9-15

Size a Panel 5-33
Smart Client (see Bar|Scan Smart Client)
Smart Numbering System 2-7
Sort

Sort 4-60, 5-10, 5-22, 6-4
Sort By Tab 10-21
Sort Your Report 10-11

Sound 4-12, 4-26, 11-6
Space Bar 5-28
Specially Formatted Work Orders 10-96
Speed 3-32, 4-20, 4-71, 5-44, 6-1, 11-6,

13-51, 17-2
SQL (Structured Query Language)

SQL 10-22, 10-28, 10-52, 11-15, 14-24,
14-49

SQL Group By 10-29, 10-58
SSO (see Single Sign On)
Standard Bar|Scan Fields 13-131, 16-30
Standard Interchange Format (see SIF)
Starting Bar|Scan 4-2
Status Table 6-43
Stock Levels 7-72
Straight Line Depreciation 6-79, 6-97, 6-102
Straight Line Method 2-41, 6-72
Structured File 14-26, 14-51
Structured Query Language (see SQL)
Subtotal

Subtotal 10-10, 10-54, 18-19
Subtotal Tab 10-10, 10-54
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Suggested Procedures 2-1
Sum Feature 10-50
Summary Report 10-58, 10-82
Supplies (SU) 7-32
Support (see Technical Support)
Symbol (see Zebra)
Synchronization

Synchronization 2-25, 3-29, 11-39, 11-7,
11-63, 12-72, 12-79, 13-51

Synchronization Handheld Computer
Icon 4-37

Synchronization Log 13-70
Synchronization Conflicts 13-80
Synchronization Toolbar 5-4

System Failure 3-38
System Furniture 2-12
System Number 6-39
System Reports 4-54, 10-1, 10-91
Systems Furniture Components (SY) 7-32
SysUser Directory 3-31, 4-63, 17-25

T
   

Table
Table Integrity 13-2,  3-38, 4-90
Table Properties 4-62, 7-70, 17-24
Table ToolBar 4-34, 4-51, 17-12, 19-11
Tables 4-23, 5-2, 5-9, 6-113
Tables (TA) 7-33, 7-120

Tag
Tag inventory 11-21, 11-38, 11-57
Tag Placement 2-22
Tagging Process 2-18, 2-28, 6-61

Take
Take 11-6, 11-17, 11-21
Take Inventory 11-38, 11-59

Tax 6-67
Tax Reporting 2-40, 6-19, 6-100
Team Leaders 2-26, 2-31

Technical Support 3-34, 4-18, A-4
Teflon Labels 2-12
Telephone 6-52, 7-29, 11-25, 13-33, 16-9,

17-11
Text Color 10-57
Tilde Symbol (~) 10-64
Time Zone

Time Zone 11-66, 13-32, 13-125
Universal Datetime (UDT) 4-81, 13-32

Title Bar 4-5
Title Page 10-10, 10-66
To Company 10-89, 13-53, 14-2
Tool Bar 4-28, 5-2, 10-7, 19-19
Total Cost 6-67
Training with Demo 1-3, 19-1
Transaction

Transaction Reports 2-34, 4-58, 10-92
Transaction Table 1-3, 2-10, 4-34, 12-1,

19-17, 19-54
Transactions 4-34

Transfer Date 6-23, 6-94
Transfer Depreciation 6-23, 6-94
Type 6-34, 7-23
Type of Location 2-18, 4-49, 9-10, 11-10

U
   

UDF (See User Defined Fields)
UDT (See Time Zone)
Uniform Product Code 7-77, 11-20, 15-52 
Unit 2-15, 6-46, 7-42, 8-11
Universal Datetime (See Time Zone)
UPC (See Uniform Product Code)
Updating a Completed Work Order 15-49
Used 6-65
Useful Types of Reports 12-68
User

User 3-10, 4-2,  4-63, 19-2
User Feature 4-64
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User ID 4-2, 4-65, 13-125, 18-6
User Password 3-23, 4-59, 4-64

User Defined Fields (UDF)
16-1, 1-3, 4-15, 4-92, 6-35, 6-112, 7-55,

11-26
User Defined Fields Tab 16-2
User Defined Fields Module 5-21, 16-1

Using a Filter 7-6, 10-12

V
   

Validate
Validate Selected Handheld Computer

Transaction Button 4-35, 19-57
Validate the Transaction Table 2-33,

15-18
Validation 4-40, 7-36, 12-1, 12-29
Validation Messages 4-95, 12-33,

13-99
Validation Process 6-38, 12-20, 12-33

Valuation 6-66
Value 6-62, 10-30
Vault locations 2-18, 9-2, 9-12, 9-15, 11-19
Vendor 6-64, 7-60
Version Number 4-2, 4-19, 19-2
View Drop Down 4-13, 19-9
View Feature 4-22, 5-3, 10-5

W
   

Walk Through 2-2
Warehouse 2-9, 6-37, 11-19, 15-13, 15-48,

19-75
Window Drop Down 4-14
Windows (See Microsoft Windows)
Work Order (also see Bill of Material)

Dynamic Work Order 14-94, 15-22
Service Order 12-26

Work Order 15-1, 4-57, 4-69, 4-83
Work Order Edit Panel 4-85, 15-15
Work Order Icon 4-84
Work Order Module 4-57, 4-83, 10-95
Work Order Number 6-56, 12-49,

13-38, 15-17
Work Order Reports 4-57, 10-3, 10-95,

15-48
Work Order Table 1-3, 5-6, 15-7
Work Orders Browse Screen 4-84

Work Plan 2-1, 2-3
Workstation 2-9, 3-2
Workstation Installation 3-4, 3-41

X
   

XML 2-40, 3-44, 4-96, 10-70, 14-38, 14-81

Y
   

Year of Acquisition 2-8

Z
   

Z Numbers (See Inventories Using
Quantities)
Zebra Technologies

Motorola Symbol 3-3, 12-66
Symbol PDT3100 3-3, 12-4
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